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About this document
This document is a printable version of the NetApp Management Console Help for the NetApp
Management Console data protection capability and the NetApp Management Console provisioning
capability. It is intended to be used for offline searches when you do not have access to the Help on a
management station. The Help contains administrative tasks, as well as conceptual and reference
material that can be useful in understanding how the NetApp Management Console data protection
and provisioning capabilities work.
Note: Many Help topics occur in more than one place. For example, many of the topics about

datasets and hosts occur in both the Protection Help and Provisioning Help sections. In dynamic
Help, this structure increases usability by making information easier to find. In a static document,
such as this one, this same structure can make searches more confusing, because a search might
result in multiple hits to the same topic.
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Welcome to NetApp Management Console Help
This Help includes information about all applications and capabilities installed on NetApp
Management Console.
By using the table of contents and index or the search tool, you can find information about features
and how to use them. This Help is structured as follows:
•

•
•
•

General information about NetApp Management Console and tools common to all applications
and capabilities of the NetApp Management Console, such as alarms, events, and administrative
user access (RBAC)
Information about the NetApp Management Console data protection capability
Information about the NetApp Management Console disaster recovery capability
Information about the NetApp Management Console provisioning capability

Help is also available from every window and its respective tabs. To learn about a specific window
parameter, click

or click the Help menu in the task bar and select Help For This View.

You can also print selected Help topics.
Related concepts

NetApp Management Console window layout and navigation on page 10
Related tasks

Printing Help topics on page 14
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About NetApp Management Console
NetApp Management Console is used by administrators to complete management tasks aided by the
DataFabric Manager server, but it runs on a Windows or Linux system separate from the server on
which the DataFabric Manager server is installed.
NetApp Management Console enables storage, application, and server administrators to perform
management tasks such as data backup protection, space management, resource provisioning, data
migration, and performance tuning, without having to switch between separate user interfaces.
The DataFabric Manager server provides infrastructure services (such as discovery, monitoring, rolebased access control (RBAC), auditing, and logging for products in the storage and data suites) for
NetApp Manageability Software client consoles. The DataFabric Manager server software runs on a
separate server and is managed through the Operations Manager console, the Web-based user
interface of the DataFabric Manager server. For more information about the DataFabric Manager
server and Operations Manager console, see the Operations Manager Administration Guide.
Related information

Documentation on the NetApp Support Site: support.netapp.com

What NetApp Management Console is
NetApp Management Console is a client platform that supports NetApp Manageability Software
capabilities. Together, NetApp Management Console and the associated OnCommand Unified
Manager console, enable you to implement both policy-based and on-demand protection,
provisioning, migration, and restoration of data contained in your physical and virtual storage
systems.

Applications and capabilities supported by the NetApp Management
Console
The NetApp Management Console supports Performance Advisor, data protection capability, and
provisioning capability.
Performance
Advisor

This application provides a single location from which you can view
comprehensive information about the performance of storage systems, vFiler
units, storage nodes and Vservers, and perform short-trend analysis. The
application also helps you identify the data infrastructure causes and potential
causes of reduced performance.
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The NetApp
Management
Console data
protection
capability

The NetApp Management Console data protection capability provides a policybased management tool to help you unify and automate backup and mirroring
operations. This capability uses a holistic approach to data protection. It
provides end-to-end, workflow-based design and seamless integration of
SnapVault, SnapMirror, and Open Systems SnapVault to enable you to manage
large-scale deployments easily.
The disaster recovery feature of the NetApp Management Console data
protection capability enhances your data protection services by enabling you to
continue to provide data access to your users, even in the event of mishap or
disaster that disables or destroys the storage systems and V-Series systems in
your primary data node. You can quickly enable your secondary storage
systems to provide primary data storage access to your users with little or no
interruption, until your primary storage systems are reenabled or replaced.

The NetApp
Management
Console
provisioning
capability

The NetApp Management Console provisioning capability helps you simplify
and automate the tasks of provisioning and managing storage. It provides
policy-based provisioning and conformance of storage in datasets. This
capability also enables you to manually add volumes or qtrees to a dataset at
any time, provides manual controls for space and capacity management of
existing storage and newly provisioned storage, and enables you to migrate
datasets and vFiler units to a new storage destination.
The deduplication feature of the NetApp Management Console provisioning
capability enhances your data provisioning services by enabling you to
eliminate duplicate data blocks to reduce the amount of storage space used to
store active data.

NetApp Management Console window layout and navigation
You can use NetApp Management Console to navigate between capabilities, to display Help, and to
log out of the console.
Learning about the
NetApp Management
Console data
protection capability

The Get Started section of the user interface provides an overview of the
NetApp Management Console data protection capability, a short tutorial
that demonstrates how to set up protection, and a list of frequently asked
questions (FAQs).

Learning about
disaster recovery

The Get Started section of the user interface provides an overview of
disaster recovery, a short tutorial that demonstrates how to set up disaster
recovery, and a list of frequently asked questions (FAQs).

Learning about the
NetApp Management
Console provisioning
capability

The Get Started section of the user interface provides an overview of the
NetApp Management Console provisioning capability, a short tutorial that
demonstrates how to set up provisioning, and a list of frequently asked
questions (FAQs).
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Moving back and
forth between panes

The Back and Forward arrow buttons helps you toggle between your last
and previous panes.

Toggling between
capabilities

•

•

To use the NetApp Management Console data protection capability or
the NetApp Management Console provisioning capability, select Tasks
> Manage Data or go to the Tasks Bar and click
.
To use Performance Advisor, select Tasks > Manage Performance or
go to the Tasks Bar and click

Displaying help

•
•

.

To display the Help for all applications and capabilities on NetApp
Management Console, click Help > Help Contents.
To display Help for the specific window that is currently displayed,
click Help > Help For This View or click

.

Logging out

•
•

Viewing product
license information

To view information about the product licenses you have installed, click
Help > About > Licenses. Removed or added licenses are reflected in the
license list after you restart NetApp Management Console.

To log out, select File > Log Out or click the logout button.
To log out and close NetApp Management Console, select File > Exit.

Capabilities that run in NetApp Management Console vary in their window layout. However, the
windows are generally divided into two panes:
•
•

Use the menu bar on the left to move within NetApp Management Console.
Use the content pane on the right to view and manage data.
The content pane is generally divided into two areas: lists of selectable data and details of the
selected data. Click

, when it is displayed, for additional details.

Note: Some applications or capabilities might have additional navigation features not described in

this section. In addition, software version incompatibility might result in some reduced
functionality, which might cause some menu options or buttons to be disabled.
Related concepts

NetApp Management Console window customization on page 11
NetApp Management Console data filtering on page 12

NetApp Management Console window customization
NetApp Management Console includes features that you can use to customize the console window
layout. By customizing the console windows, you can control which data is viewable or how it is
displayed.
Note: You cannot perform all the following customizing tasks for every window.
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Hiding or
redisplaying the
Tasks Bar

You can hide the Tasks Bar to increase the space available for the content
pane. (The overall width of the window remains the same when the bar is
hidden.) You use the View menu to hide or display the bar.

Selecting columns
to display

In content panes that include a list divided into columns, you can choose
which columns you want to display. To display or hide a column, you can
click the column-selection icon in the upper-right corner above the scroll bar
( ), and then click the name of a column heading from the selection list.
Columns that are already displayed are identified with a check mark.
Note: The default version of a list does not necessarily include all the
available columns. You might find additional columns available in the
column selection list.

Readjusting column In content panes that include a list divided into columns, you can adjust the
width of individual columns by horizontally dragging the vertical line
widths
between the column headings. If accommodating all the columns you want
to include results in column widths that obscure data, you can still see the
entire value of a column field by placing your cursor over the field. A tool
tip opens, displaying the entire value of the field. You can maximize data
visibility across all the columns by clicking the column selection icon (
and selecting Pack All Columns.

)

Rearranging the
column order

In content panes that include a list divided into columns, you can rearrange
the column order for a session by dragging and dropping column headings
horizontally within the table. The arrangement persists until you exit the
console.

Reapportioning a
content pane

A splitter bar divides a content pane list area from the details area. You can
move the splitter bar to increase or decrease the proportion of the content
pane that displays the list of selectable data.

Related concepts

NetApp Management Console window layout and navigation on page 10
NetApp Management Console data filtering on page 12

NetApp Management Console data filtering
You can use the data filtering features to display only data meeting the criteria you specify.
In large-scale environments, the content pane might list so much data that it becomes difficult to
locate the information you want. Filtering the data by specified criteria helps you focus on the issues
most important to you.
Note: Not all filtering features are available for every window.
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Filtering by
group

The Group selection list in the toolbar enables you to display only the data that
pertains to objects in a selected group. This setting persists until you log out or
choose a different group.

Filtering by
regular
expression

You can filter columns displaying site-specific values, such as storage system
names or dataset names, by regular expression. To filter a column by regular
expression, click the filter icon in the column heading ( ) and specify the
regular expression to match against values in the column field. Headings of
filtered columns are highlighted to remind you that some data is not currently
displayed.
NetApp Management Console uses Java regular expression syntax for filtering
data, for example:
•
•

•
Filtering by
column values

Filtering by
column view
Sorting by
column values

To view only items beginning with the letters "sch," type sch in the filter
field, which matches Schedule but not SnapMirror.
To view only items containing "space" somewhere in their string,
type .*space in the filter field, which matches strings such as Volume Space
Normal.
To view only items ending with the string "ok," type *ok in the filter field,
which matches strings such as SnapMirror: Date Ok.

When a column displays a set of predefined possible values, you can choose to
display only the rows of data that include a selected value. To filter a column by a
specific, predefined value, click the filter icon in the column heading ( ) and
select one or more of the predefined values from the drop-down list. Headings of
filtered columns are highlighted to remind you that some data is not currently
displayed. Click "All" to select or clear all the values.
You can click
in the upper-right corner of the list to select the columns you
want displayed.
You can click the column header to change the sort order of the column entries.
When you click the column header, the sort arrow appears for that column.

Related concepts

NetApp Management Console window customization on page 11
NetApp Management Console window layout and navigation on page 10
What groups are on page 67
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Viewing NetApp Management Console configuration details
You can view information about NetApp Management Console, DataFabric Manager, the operating
system, and other details from the Help menu.
About this task

When troubleshooting issues with your system, it can be helpful to know about some of the system
details, such as the software version, the operating system version, installation directory, memory
availability, and so forth.
Steps

1. In NetApp Management Console, from the Help menu, click About.
2. In the About NetApp Management Console dialog box, select the information you want to view.
a) Click Configuration to view details about software versions, installation directories, memory,
and so forth.
b) Click Licenses to view a list of the applications enabled in NetApp Management Console.
3. Click OK to close the dialog box.

Printing Help topics
You can print one or more topics from the online Help.
Before you begin

You must have the online Help displayed.
Steps

1. In the online Help Table of Contents, select the topic or topics you want to print.
To print a single topic, select the topic.
To print multiple topics, use the Shift key to select multiple topics in a sequence. You can also
use the Ctrl key to select multiple topics that are not in a sequence.
Note: Selecting a Table of Contents heading does not automatically select all the topics under
that heading.

2. Click the print icon above the Help Table of Contents.
The print range in the Print dialog box indicates the number of print pages required for the
selected topic or topics.
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Note: For online Help, there is no distinction between the All and Pages options; both options
print only the selected topic or topics.

Events and alarms
All applications and capabilities on NetApp Management Console share the alarms and events
functions.
Information in this Help about events and alarms applies to all applications and capabilities on
NetApp Management Console.

What events are
Events are generated automatically when a predefined condition occurs or when an object crosses a
threshold. These events enable you to take action to prevent issues that can lead to poor performance
and system unavailability. Events include an impact area, severity, and impact level.
Events are categorized by the type of impact area they encompass. Impact areas include availability,
capacity, configuration, or protection. Events are also assigned a severity type and impact level that
assist you in determining if immediate action is required.
You can configure alarms to send notification automatically when specific events or events of a
specific severity occur.
Events are automatically logged and retained for a default of 180 days.
Event types are predetermined. You can manage event notification, but you cannot add or delete
event types. However, you can modify the event severity by using the command-line interface.
Related concepts

What alarms are on page 42
Descriptions of severity types
Each event is associated with a severity type to help you determine priorities for taking corrective
action.
Note: Performance Advisor uses only the Normal and Error events.

Severity type

Description

Normal

A previous abnormal condition for the event source returned to a normal
state and the event source is operating within the desired thresholds. To
view events with this severity type, you select the Normal option from
the filters.

Information

The event is a normal occurrence. No action is required.
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Severity type

Description

Warning

The event source experienced an occurrence that you should be aware of.
Events of this severity do not cause service disruption, and corrective
action might not be required.

Error

The event source is still performing; however, corrective action is
required to avoid service disruption.

Critical

A problem occurred that might lead to service disruption if corrective
action is not taken immediately.

Emergency

The event source unexpectedly stopped performing and experienced
unrecoverable data loss. You must take corrective action immediately to
avoid extended downtime.

Unknown

The event source is in an unknown transitory state. To view events with
this severity type, you select the All option.

Unmanaged

The event source is not managed by the NetApp Management Console
data protection and provisioning capabilities. No action is required.

Configuring events
You can learn about event occurrences by viewing the event log or by configuring alarms to
automatically notify you when events occur.
•

•

Viewing the event log
You can use the Events window to view a list of all the events that occurred and to view detailed
information about any selected event.
Configuring alarms
You can use the Alarms window to add an alarm that sends notifications automatically when an
event occurs.

Related tasks

Monitoring events on page 40
Adding alarms on page 48
List of events and severity types
You should be aware of all the events generated by the NetApp Management Console data protection
and provisioning capabilities and Operations Manager and the associated event severity types.
You can use the links in the following table to move directly to the events for that object. Events are
listed in alphabetical order by object type.
Note: Performance Advisor uses only the Normal and Error events.
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Event categories

High Availability
Configuration Controller on
page 17
High Availability
Configuration Interconnect on
page 18
High Availability
Configuration Partner on page
18
Agent on page 18
Aggregate on page 19
Alarm on page 19
CFO Interconnect on page 20
CFO Partner on page 20
CFO Settings on page 20
Cluster on page 20
Cluster Port on page 21
Comment Field on page 21
Configuration Changed on page
21
CPU on page 21
Data Protection on page 21
Database on page 22
Dataset on page 22
Dataset Backup on page 23
Dataset Conformance on page
23
Disks on page 24
Enclosures on page 24

Fibre Channel Switch Port on
page 25
Fans on page 24
Filer Configuration on page
25
Global Status on page 25
HA State on page 25
HBA Port on page 26
Host on page 26
Host Agent on page 27
Inodes on page 27
Interface Status on page 27
Logical Interface on page 27
LUN on page 27
Management Station on page
28
Migration on page 28
NDMP on page 29
Network on page 29
Network Services on page 29
No Schedule Conflict on page
30
NVRAM Battery on page 30
OSSV on page 30
Performance Advisor on page
30
Power Supplies on page 31
Primary on page 31

HA configuration Controller
Event name

Severity

Can Take Over

Normal

Cannot Takeover

Error

Dead

Critical

Protection Policy on page 31
Protection Schedule on page
31
Provisioning Policy on page
31
Qtree on page 32
RPM on page 32
Resource Group on page 32
Resource Pool on page 32
SAN Host LUN on page 33
Script on page 33
SnapMirror on page 33
Snapshot(s) on page 34
SnapVault on page 35
SNMP Trap Listener on page
36
Space Management on page
36
Storage Services on page 36
Sync on page 37
Temperature on page 37
Unprotected Item on page 37
User on page 37
vFiler Unit on page 38
vFiler Unit Template on page
38
Vserver on page 38
Volume on page 39

18 | Provisioning and Data Protection Online Help
Event name

Severity

Takeover

Warning

HA configuration Interconnect
Event name

Severity

Down

Error

Not Present

Warning

Partial Failure

Error

Up

Normal

HA configuration Partner
Event name

Severity

Dead

Warning

May Be Down

Warning

OK

Normal

HA configuration Settings
Event name

Severity

Disabled

Normal

Enabled

Normal

Not Configured

Normal

Takeover Disabled

Normal

This Controller Dead

Warning

Agent
Event name

Severity

Down

Error

Login Failed

Warning

Login OK

Normal

Up

Normal
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Aggregate
Event name

Severity

64-bit Upgrade

Information

Almost Full

Warning

Almost Overcommitted

Warning

Deleted

Information

Discovered

Information

Failed

Error

Full

Error

Nearly Over Deduplicated

Warning

Not Over Deduplicated

Normal

Not Overcommitted

Normal

Offline

Error

Online

Normal

Overcommitted

Error

Over Deduplicated

Error

Restricted

Normal

Snapshot Reserve Almost Full

Warning

Snapshot Reserve Full

Warning

Snapshot Reserve OK

Normal

Space Normal

Normal

Alarm
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Test

Information
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CFO Interconnect
Event name

Severity

Down

Error

Not Present

Warning

Partial Failure

Error

Up

Normal

CFO Partner
Event name

Severity

Dead

Warning

May Be Down

Warning

OK

Normal

CFO Settings
Event name

Severity

Disabled

Normal

Enabled

Normal

Not Configured

Normal

Takeover Disabled

Normal

This Node Dead

Warning

Cluster
Event name

Severity

Cluster Discovered

Information

Cluster Reachable

Normal

Cluster Not Reachable

Critical

Cluster Renamed

Information

Cluster Node Added

Information

Cluster Node Removed

Information
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Cluster Port
Event name

Severity

Port Status Up

Normal

Port Status Down

Error

Port Status Undefined

Normal

Port Status Unknown

Normal

Port Role Changed

Information

Comment Field
Event name

Severity

Created

Information

Modified

Information

Destroyed

Information

Configuration Changed
Event name

Severity

Config Group

Information

CPU
Event name

Severity

Load Normal

Normal

Too Busy

Warning

Data Protection
Event name

Severity

Job Started

Information

Policy Created

Information

Policy Modified

Information

Schedule Created

Information

Schedule Modified

Information
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Database
Event name

Severity

Backup Failed

Error

Backup Succeeded

Information

Restore Failed

Error

Restore Succeeded

Information

Dataset
Event name

Severity

Backup Aborted

Warning

Backup Completed

Normal

Backup Deleted

Information

Backup Failed

Error

Backup Prematurely Deleted

Warning

Created

Information

Deleted

Information

DR State Ready

Information

DR State Failover Over

Warning

DR State Failed Over

Information

DR State Failover Error

Error

DR Status Normal

Information

DR Status Warning

Warning

DR Status Error

Error

Initializing

Information

Job Failure

Warning

Member Clone Snapshot Discovered

Information

Member Clone Snapshot Status OK

Information

Member Dedupe Operation Failed

Error

Member Dedupe Operation Succeeded

Normal
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Event name

Severity

Member Destroyed

Information

Member Destroy Operation Failed

Information

Member Resized

Information

Member Resize Operation Failed

Information

Modified

Information

Protected

Normal

Protection Failed

Error

Protection Lag Error

Error

Protection Lag Warning

Warning

Protection Suspended

Warning

Protection Uninitialized

Normal

Provisioning Failed

Error

Provisioning OK

Normal

Space Status: Normal

Normal

Space Status: Warning

Warning

Space Status: Error

Error

Write Guarantee Check - Member Resize Required

Warning

Write Guarantee Check - Member Size OK

Normal

Dataset Backup
Event name

Severity

Dataset Backup: Deleted

Information

Dataset Backup: Prematurely Deleted

Warning

Dataset Conformance
Event name

Severity

Conformant

Normal

Conforming

Information
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Event name

Severity

Initializing

Information

Nonconformant

Warning

Disks
Event name

Severity

No Spares

Warning

None Failed

Normal

None Reconstructing

Normal

Owner changed

Warning

Some Failed

Error

Some Reconstructing

Warning

Spares Available

Normal

Enclosures
Event name

Severity

Active

Information

Disappeared

Warning

Failed

Error

Found

Normal

Inactive

Warning

OK

Normal

Fans
Event name

Severity

Many Failed

Error

Normal

Normal

One Failed

Error
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FC (Fibre Channel) Switch Port
Event name

Severity

Faulty

Error

Offline

Warning

Online

Normal

Filer Configuration
Event name

Severity

Changed

Warning

OK

Normal

Push Error

Warning

Push OK

Normal

Global Status
Event name

Severity

Critical

Critical

Non Critical

Error

Non Recoverable

Emergency

OK

Normal

Other

Warning

Unknown

Warning

HA State
Event name

Severity

Can Take Over

Normal

Cannot Take Over

Error

Dead

Critical

Takeover

Warning
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HBA Port
Event name

Severity

Offline

Warning

Online

Normal

Port Error

Error

Traffic High

Warning

Traffic OK

Normal

Host
Event name

Severity

Cluster Configuration Error

Error

Cluster Configuration OK

Normal

Cold Start

Information

Deleted

Information

Discovered

Information

Down

Critical

Identity Conflict

Warning

Identity OK

Normal

Login Failed

Warning

Login OK

Normal

Modified

Information

Name Changed

Information

SNMP Not Responding

Warning

SNMP OK

Normal

System ID Changed

Information

Up

Normal
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Host Agent
Event name

Severity

Down

Error

Up

Normal

Host Agent: Login Failed

Warning

Inodes
Event name

Severity

Almost Full

Warning

Full

Error

Utilization Normal

Normal

Interface Status
Event name

Severity

Down

Error

Testing

Normal

Unknown

Normal

Up

Normal

Logical Interface
Event name

Severity

Logical Interface Status Up

Normal

Logical Interface Status Down

Error

Logical Interface Status Unknown

Normal

Logical Interface Migrated

Warning

LUN
Event name

Severity

Offline

Warning

Online

Normal
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Event name

Severity

Snapshot Not Possible

Warning

Snapshot Possible

Normal

Management Station
Event name

Severity

Enough Free Space

Normal

File System File Size Limit Reached

Error

License Expired

Error

License Nearly Expired

Warning

License Not Expired

Normal

Load OK

Normal

Load Too High

Warning

Node Limit Nearly Reached

Warning

Node Limit OK

Normal

Node Limit Reached

Error

Not Enough Free Space

Error

Provisioning Manager Node Limit Nearly Reached

Warning

Provisioning Manager Node Limit Ok

Normal

Provisioning Manager Node Limit Reached

Error

Protection Manager Node Limit Nearly Reached

Warning

Protection Manager Node Limit Ok

Normal

Protection Manager Node Limit Reached

Error

Migration
Event name

Severity

Dataset Not Migrating

Normal

Dataset Migrating

Normal

Dataset Migrated With Errors

Warning
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Event name

Severity

Dataset Migrated

Normal

Dataset Migrate Failed

Error

vFiler Unit Not Migrating

Normal

vFiler Unit Migrating

Normal

vFiler Unit Migrated With Errors

Warning

vFiler Unit Migrated

Normal

vFiler Unit Migrate Failed

Error

NDMP
Event name

Severity

Credentials Authentication Failed

Warning

Credentials Authentication Succeeded

Normal

Communication Initialization Failed

Warning

Communication Initialization Succeeded

Normal

Down

Warning

Up

Normal

Network
Event name

Severity

OK

Normal

Too Large

Warning

Network Services
Event name

Severity

CIFS Service - Up

Normal

CIFS Service - Down

Warning

NFS Service - Up

Normal

NFS Service - Down

Warning
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Event name

Severity

iSCSI Service - Up

Normal

iSCSI Service - Down

Warning

FCP Service - Up

Normal

FCP Service - Down

Warning

No Schedule Conflict
Event name

Severity

Between Snapshot and SnapMirror Schedules

Normal

Between Snapshot and SnapVault Schedules

Normal

NVRAM Battery
Event name

Severity

Discharged

Error

Fully Charged

Normal

Low

Warning

Missing

Error

Normal

Normal

Old

Warning

Overcharged

Warning

Replace

Error

Unknown Status

Warning

OSSV (Open Systems SnapVault)
Event name

Severity

Host Discovered

Information

Performance Advisor
Event name

Severity

Enough Free Space

Normal
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Event name

Severity

Not Enough Free Space

Error

Power Supplies
Event name

Severity

Many Failed

Error

Normal

Normal

One Failed

Error

Primary
Event name

Severity

Host Discovered

Information

Protection Policy
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Protection Schedule
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Provisioning Policy
Event name

Severity

Created

Information

Deleted

Information

Modified

Information
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Qtree
Event name

Severity

Almost Full

Warning

Files Almost Full

Warning

Files Full

Error

Files Utilization Normal

Normal

Full

Error

Growth Rate Abnormal

Warning

Growth Rate OK

Information

Space Normal

Normal

Remote Platform Management (RPM)
Event name

Severity

Online

Normal

Unavailable

Critical

Resource Group
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Resource Pool
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Space Full

Error

Space Nearly Full

Warning
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Event name

Severity

Space OK

Normal

SAN Host LUN Mapping
Event name

Severity

Changed

Warning

Script
Event name

Severity

Critical Event

Critical

Emergency Event

Emergency

Error Event

Error

Information Event

Information

Normal Event

Normal

Warning Event

Warning

SnapMirror
Event name

Severity

Abort Completed

Normal

Abort Failed

Error

Break Completed

Normal

Break Failed

Error

Date OK

Normal

Delete Aborted

Warning

Delete Completed

Information

Delete Failed

Error

Deleted

Information

Discovered

Information

Initialize Aborted

Warning
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Event name

Severity

Initialize Completed

Normal

Initialize Failed

Error

Modified

Information

Nearly Out of Date

Warning

Not Scheduled

Normal

Not Working

Error

Off

Normal

Out of Date

Error

Possible Problem

Warning

Quiesce Aborted

Warning

Quiesce Completed

Normal

Quiesce Failed

Error

Resume Completed

Normal

Resume Failed

Error

Resync Aborted

Warning

Resync Completed

Normal

Resync Failed

Error

Unknown State

Warning

Update Aborted

Warning

Update Completed

Normal

Update Failed

Error

Working

Normal

Snapshot(s)
Event name

Severity

Age Normal

Normal

Age Too Old

Warning

Count Normal

Normal
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Event name

Severity

Count OK

Normal

Count Too Many

Error

Created

Normal

Failed

Error

Full

Warning

Schedule Conflicts with the SnapMirror Schedule

Warning

Schedule Conflicts with the SnapVault Schedule

Warning

Schedule Modified

Information

Scheduled Snapshots Disabled

Information

Scheduled Snapshots Enabled

Normal

Space OK

Normal

SnapVault
Event name

Severity

Backup Aborted

Warning

Backup Completed

Information

Backup Failed

Error

Host Discovered

Information

Relationship Create Aborted

Warning

Relationship Create Completed

Information

Relationship Create Failed

Error

Relationship Delete Aborted

Warning

Relationship Delete Completed

Information

Relationship Delete Failed

Error

Relationship Discovered

Information

Relationship Modified

Information

Replica Date OK

Normal

Replica Nearly Out of Date

Warning
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Event name

Severity

Replica Out of Date

Error

Restore Aborted

Warning

Restore Completed

Normal

Restore Failed

Error

SNMP Trap Listener
Event name

Severity

Alert Trap Received

Information

Critical Trap Received

Information

Emergency Trap Received

Information

Error Trap Received

Information

Information Trap Received

Information

Notification Trap Received

Information

Warning Trap Received

Information

Start Failed

Warning

Start OK

Information

Space Management
Event name

Severity

Space Management Job Started

Information

Space Management Job Succeeded

Information

Space Management Job Failed

Information

Storage Services
Event name

Severity

Storage Service Created

Information

Storage Service Modified

Information

Storage Service Destroyed

Information
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Event name

Severity

Storage Service Dataset Provisioned

Information

Storage Service Dataset Attached

Information

Storage Service Dataset Detached

Information

Sync
Event name

Severity

SnapMirror In Sync

Information

SnapMirror Out of Sync

Warning

Temperature
Event name

Severity

Hot

Critical

Normal

Normal

Unprotected Item
Event name

Severity

Discovered

Information

User
Event name

Severity

Disk Space Quota Almost Full

Warning

Disk Space Quota Full

Error

Disk Space Quota OK

Normal

Disk Space Soft Limit Exceeded

Warning

Disk Space Soft Limit Not Exceeded

Normal

E-mail Address OK

Normal

E-mail Address Rejected

Warning

Files Quota Almost Full

Warning

Files Quota Full

Error
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Event name

Severity

Files Quota Utilization Normal

Normal

Files Soft Limit Exceeded

Warning

Files Soft Limit Not Exceeded

Normal

vFiler Unit
Event name

Severity

Deleted

Information

Discovered

Information

Hosting Storage System Login Failed

Warning

IP Address Added

Information

IP Address Removed

Information

Renamed

Information

Storage Unit Added

Information

Storage Unit Removed

Information

vFiler Unit Template
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Vserver
Event name

Severity

Vserver Discovered

Information

Vserver Deleted

Information

Vserver Renamed

Information

Vserver Status Down

Error

Vserver Status Up

Normal
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Volume
Event name

Severity

Almost Full

Warning

Automatically Deleted

Information

Clone Deleted

Information

Clone Discovered

Information

Destroyed

Information

First Snapshot OK

Normal

Full

Error

Growth Rate Abnormal

Warning

Growth Rate OK

Normal

Maxdirsize Limit Nearly Reached

Information

Maxdirsize Limit Reached

Information

Nearly No Space for First Snapshot

Warning

Nearly Over Deduplicated

Warning

New Snapshot

Normal

Next Snapshot Not Possible

Warning

Next Snapshot Possible

Normal

No Space for First Snapshot

Warning

Not Over Deduplicated

Normal

Offline

Warning

Offline or Destroyed

Warning

Online

Normal

Over Deduplicated

Error

Quota Almost Overcommitted

Warning

Quota Overcommitted

Error

Restricted

Normal

Snapshot Deleted

Normal

Space Normal

Normal
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Event name

Severity

Space Reserve Depleted

Error

Space Reserve Nearly Depleted

Warning

Space Reserve OK

Normal

Related references

Descriptions of severity types on page 15

Managing events
You can view, respond to, acknowledge, and delete events.
Monitoring events
You can view a list of all the events that occurred and view detailed information about any event.
You can also view events that are marked for deletion.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. You can monitor events from the NetApp Management Console or Performance Advisor.
To monitor events from...

Do this...

The NetApp Management Console

From the menu bar, click Notifications > Events.

Performance Advisor

From the menu bar, click Monitor > Events.

2. Optional: Customize the Events window in one of the following ways:
•
•
•

Select an event to view details about that event.
Click
in the column header to control the event entries that you want displayed.
Click the sort arrows in the column header to change the sort order of the entries in that
column.

•
•

Click
in the upper-right corner of the list to select which columns are displayed.
Drag the bottom of the events list area up or down to resize that area.

3. Optional: View the events that are marked for deletion by displaying hidden columns and
removing a text filter, as follows:
a) Click
in the upper-right corner of the list and select the Deleted By and Deleted Time
columns.
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b) Click

in the Deleted By column header and delete the default search string.

The default filtering of deleted events is stopped and the deleted event entries are displayed in
the list.
Related references

Administrator roles and capabilities on page 54
Responding to and acknowledging events
When an event occurs, you must take appropriate action to acknowledge and manage it and correct
the problem. Responding to an event includes viewing it, acknowledging it, and correcting the
problem.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Notifications > Events. For Performance Advisor, from the menu bar,
click Monitor > Events.
2. In the Events window, select an event to view the details about it.
3. Select an event and click Acknowledge to indicate that you are taking responsibility for
managing that event.
4. In the Acknowledge Events dialog box, click Yes to acknowledge the selected event.
Your user name and the time are entered in the Events list for the selected event.
5. Find the cause of the event and take corrective action.
Related references

Administrator roles and capabilities on page 54
Deleting events
You can delete an event from the event list. Typically, you delete an event only after you
acknowledge it and resolve the problem. However, you can also delete unacknowledged events if
they are not important.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Steps

1. For protection, provisioning, or disaster recovery events, from the menu bar, click Notifications
> Events. For Performance Advisor events, from the menu bar, click Monitor > Events.
2. In the Events window, select an event and click Delete.
3. In the Delete Events dialog box, click Yes to delete the selected event.
4. Verify that the event is deleted by viewing the Events window.
After you finish

You can view events that are marked for deletion by clicking

in the corner of the list.

Related references

Administrator roles and capabilities on page 54

What alarms are
Alarms are configured notifications that are sent whenever a specific event or an event of a specific
severity type occurs, not necessarily related to a specific user. Alarms are used to monitor and
manage datasets and resources.
Alarms are not the events themselves, only the notification of events. Alarms are not the same as user
alerts. For a complete description of user alerts, see the Operations Manager Administration Guide.
You can create alarms for any defined resource group for which you want automatic notification of
events. You use the Alarms window to add, monitor, and edit alarms.
Related information

Operations Manager Administration Guide - http://support.netapp.com/NOW/knowledge/docs/
DFM_win/dfm_index.shtml
Differences between alarms and user alerts
Configured event notifications provided by alarms are not the same as the automatic user-alert
threshold messages sent to users.
You can configure alarms to notify specific recipients when specific events occur or when events of a
specific severity type occur.
In contrast, alerts are notifications sent automatically to users who exceed space quotas. Whenever a
user event related to disk or file quotas occurs, DataFabric Manager sends an alert to the user who
caused the event. The alert is in the form of an email message that includes information about the file
system (volume or qtree) on which the user exceeded the threshold for a quota. You can disable the
alerts either for all users or for the users who have quotas.
The following list summarizes the differences between alarms and user alerts.
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Configuring Alarms: You must configure alarms before notification is sent to the specified
recipients.
User alerts: User alerts are sent by default.
Recipients

Alarms: Alarms can be sent to one or more of the following recipients:
•
•
•
•

An email address
A pager email address
An SNMP trap host
A script that you write

User alerts: User alerts are sent to the user who exceeds the user quota thresholds.
User alerts can be only in the form of an e-mail message.
Trigger

Alarms: You can configure alarms for any event, any event class, or any severity
level.
User alerts: User alerts can be sent only when the following user quota events occur:
•
•
•
•

User Disk Space Quota Almost Full
User Disk Space Quota Full
User Files Quota Almost Full
User Files Quota Full

Alarms triggered from related objects
When you create an alarm for a specific resource group, the alarm can be triggered by events that
occur on resources that are related to the resource group, but that are not part of the resource group.
For example, if you create an alarm for a dataset that uses volumes, an alarm notification is also
triggered when the storage system hosting one of the volumes goes down, even though the storage
system itself is not a member of the resource pool for the dataset.
If one object is related to another object belonging to a resource group and is related closely enough
to appear in the reports for that group, events on the related object might trigger alarms on that group.
Guidelines for using alarms
You can optimize the use of alarms by following the guidelines listed below.
•

•

Configure alarms for resource groups, not individual objects.
You can configure an alarm only for a defined group. If you want to create an alarm for a specific
object, you must first create a group with that object as the only member and then create an alarm
for that group.
Select an appropriate event or severity level to trigger an alarm.
Not all events are severe enough to require alarms. Events that occur frequently might not be
useful alarm candidates. Select only those events (or an event class) that are important enough to
warrant special event notification.
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•

•

Make sure business-critical events are acknowledged.
Typically, alarms are set for business-critical events that must be acknowledged to establish a
responsibility audit trail. Configure the Repeat Notify function to ensure that an event is
acknowledged.
Avoid multiple responses to the same event.
Not all alarms are important enough to require acknowledgment: for example, events of severity
Normal or Information. By not configuring the Repeat Notify function, you avoid multiple
responses to the same event.

Alarm properties
You can configure or change alarm properties when you add or edit an alarm. The properties you can
configure or change are listed in the order in which they appear in the Add Alarm wizard.
•
•
•
•
•
•

Group on page 44
Event Name or Severity on page 44
Recipients on page 45
Active Range on page 47
Repeat Notify on page 47
Enabled on page 47

Group

The resource group the alarm is associated with. The default group is Global. You can
associate an alarm with any resource group that is defined.

Event
Name or
Severity

Specifies what triggers the alarm: either when a specific event occurs, or when an
event in an event class occurs, or when any event of a specified severity type occurs.
If no specific event or severity type is selected when the alarm is added, the alarm
applies to all events or severity types.
By Event

The event that triggers an alarm. When configuring an alarm, you can
select a single event from the displayed list. For multiple events to
trigger an alarm, you must first create an event class and then select that
event class to trigger the alarm.

By
Severity

The severity type that is the lowest severity level that triggers an alarm.
All events that occur with the specified severity level trigger event
notification. When configuring an alarm, you can select one of the
following severity types:
•
•

•

Unknown
The event is in an unknown state.
Normal
A previous abnormal condition for the event source returned to a
normal state and the event source is operating within the desired
thresholds.
Information
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•

•

•

•

•

Event
Class

The event is a normal occurrence. No action is required.
Unmanaged
The event source is not managed by the NetApp Management
Console data protection and provisioning capabilities. No action is
required.
Warning
The event source experienced an occurrence that you should be
aware of. Events of this severity do not cause service disruption,
and corrective action might not be required.
Error
The event source is still performing; however, corrective action is
required to avoid service disruption.
Critical
A problem occurred that might lead to service disruption if
corrective action is not taken immediately.
Emergency
The event source unexpectedly stopped performing and experienced
unrecoverable data loss. You must take corrective action
immediately to avoid extended downtime.

The event class that triggers an alarm. When configuring an alarm, you
can specify a previously defined event class; the occurrence of any
event in the event class triggers the alarm. If you specify an event class,
you can optionally specify a severity type; only the occurrence of an
event in the event class with the specified severity type triggers the
alarm. Use a regular expression to specify an event class: for example,
env\.temp.
You define event classes using Operations Manager. For information
about event classes, see the Operations Manager Administration Guide.

Recipients

Specifies where the event notification is to be sent. Although all fields are optional,
you must specify at least one recipient in one field.
E-mail
recipients

Administrator
user names

One or more user names, separated by commas,
of administrators who will receive the event
notification by e-mail.
Note: Do not specify the e-mail address—that

information is automatically obtained from
the administrator profile information, which is
configured using Operations Manager.

46 | Provisioning and Data Protection Online Help

Pager
recipients

NonAdministrators

One or more e-mail addresses, separated by
commas, of any other users who will receive the
event notification by e-mail. Because there is no
profile information available for nonadministrators, you must specify the full e-mail
address, in the following format:
name@domain.suffix.

Administrator
user names

One or more user names, separated by commas,
of administrators who will receive an event
notification message at a pager e-mail address.
Pager recipients receive shortened messages that
are more suitable for small paging devices.
Note: Do not specify the full pager e-mail

address—that information is automatically
obtained from the administrator profile
information, which is configured using
Operations Manager.
NonAdministrators

Script

One or more pager e-mail addresses, separated
by commas, of any other user who will receive
an event notification message at a pager e-mail
address. Pager recipients receive shortened
messages that are more suitable for small paging
devices. Because there is no profile information
available for non-administrators, you must
specify the full pager e-mail address, in the
following format: name@domain.suffix.

Script

The full path name of a script that is executed when an
alarm occurs. You can specify one script.

Run
script as

The user name to be used to run the script: for example,
root.
This feature does not function in a Windows server
environment. If a script is entered in this field, the script
runs, but is ignored.

SNMP
trap hosts

A comma-separated list of servers that contain an SNMP trap listener
to receive the event notification. Use the following
format:community@host:portnumber.
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The default for community is public. For host, you can specify
either an IP address or a name. For portnumber, you can specify a
number in the range 1 through 65535. The default value is port 162.
For more information about SNMP traps, see the Operations Manager
Administration Guide.
Active
range

Specifies the time during which the alarm can be triggered. If a specific event or an
event of a specified severity type occurs at a time at which the alarm is not active, no
event notification occurs. For example, you might want an event notification to occur
only when a specific administrator is available.
Start Specifies the time at which the alarm becomes active, based on the time zone
of the storage set to which the event notification applies.
Stop

Repeat
Notify
(min)

Enabled

Specifies the time at which the alarm becomes inactive, based on the time
zone of the storage set to which the event notification applies.

Specifies whether an alarm notification is repeated until the event is acknowledged
and how often the notification is repeated. The default is no repeat notification.
minutes value
displayed

Repeats the event notification at the interval specified,
until the event is acknowledged.

no minutes value
displayed

Event notification is sent only once and is not repeated.

Specifies whether the alarm is currently enabled (selected) or disabled (not selected).
The default is enabled.

Related information

Operations Manager Administration Guide - http://support.netapp.com/NOW/knowledge/docs/
DFM_win/dfm_index.shtml

Configuring alarms
In general, you use a wizard to add new alarms and an edit window to modify alarm properties.
Decisions to make before adding an alarm
Before you use the Add Alarm wizard to add a new alarm, you need to gather the information
required to complete the wizard.
Group

Which group will the alarm be associated with?

Event or
severity

What do you want to trigger the alarm?
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•
•
•
Recipients

Decide if a specific event should trigger the alarm and, if so, which event.
Decide if an event in an event class should trigger the alarm and, if so, which
event class. And optionally, decide which severity type within the event class.
Decide if any event of a specified severity type should trigger the alarm and, if
so, which severity type.

Who or what needs to receive the event notification?
You can specify one or more of the following recipients:
•
•
•
•

E-mails: Provide the administrator user names or non-administrator e-mail
addresses.
Pagers: Provide the administrator user names or non-administrator pager email addresses.
SNMP listener traps: Provide the host and port number of each SNMP trap.
Optionally, provide the SNMP community name.
Script: Provide the name of a script that is executed when an alarm occurs and
the user name that runs the script.

Active range

When should the event notification be active for the alarm?

Repeat
notification

Do you want the event notification repeated until the event is acknowledged?
If so, how often do you want the notification to be repeated?

Related references

Alarm properties on page 44
Adding alarms
You can add an alarm when you want immediate notification that a specified event or event class or
event of a specified severity level occurred.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Have the following information available to complete this task:
•
•
•
•
•

The resource group with which you want the alarm associated.
The event name, event class, or severity type that triggers the alarm.
Who and what you want the event notification sent to.
The time period during which the alarm is active.
Whether you want the event notification repeated until the event is acknowledged and how often
the notification should be repeated.
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Steps

1. For protection, provisioning, or disaster recovery alarms, from the menu bar, click Notifications
> Alarms. For Performance Advisor alarms, from the menu bar, click the Set Up Alarms
window.
2. Click Add to start the Add Alarm wizard.
3. On each page of the wizard, enter the appropriate information.
4. Click Finish to commit your choices and close the Add Alarm wizard.
5. Verify the creation and configuration of the alarm by viewing the results that are displayed in the
Alarms window.
After you finish

You can edit the alarm properties from the Alarms window.
Related concepts

Decisions to make before adding an alarm on page 47
Related references

Alarm properties on page 44
Administrator roles and capabilities on page 54
Testing alarms
You can test an alarm to check its configuration, after creating or editing the alarm.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. For protection, provisioning, or disaster recovery alarms, from the menu bar, click Notifications
> Alarms. For Performance Advisor alarms, from the menu bar, click Set Up > Alarms.
2. Select an alarm and click Test.
You can select any alarm regardless of whether it is enabled or disabled.
3. Click OK in the Confirm Alarm(s) Test window to begin the test.
A test event notification is sent to each configured recipient. If a script is configured, the test
notification runs the script.
4. Verify the alarm recipient configuration by checking that each recipient received a test message.
If a script recipient is configured, check that the script was successfully started.
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After you finish

You can modify any of the alarm properties from the Alarms window.
Related references

Administrator roles and capabilities on page 54
Editing alarms
You can change the configuration of an existing alarm.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. For protection, provisioning, or disaster recovery alarms, from the menu bar, click Notifications
> Alarms. For Performance Advisor alarms, from the menu bar, click Set Up > Alarms.
2. Select an alarm in the Alarms window and click Edit.
3. Use the tabs in the Properties sheet (Group, Event Type, Recipient, and Details) to change the
configured property values.
4. Click Apply to commit your changes.
5. Click OK to close the Properties sheet.
The new configuration is immediately activated and displayed in the Alarms list.
6. Verify your changes by viewing the results that are displayed in the Alarms window.
You can select an alarm to view the current property values for that alarm.
Related references

Administrator roles and capabilities on page 54
Deleting alarms
You can delete an alarm when you no longer need immediate notification of an event or severity
type.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Steps

1. For protection, provisioning, and disaster recovery alarms, from the menu bar, click Notifications
> Alarms. For Performance Advisor alarms, from the menu bar, click Set Up > Alarms.
2. Select one or more alarms in the Alarms window and click Delete.
3. Click OK in the Confirm Alarm(s) Delete dialog box to delete the selected alarms.
The alarm configurations are deleted and the alarms are removed from the Alarms list.
4. Verify your deletion by viewing the results that are displayed in the Alarms window.
Related references

Administrator roles and capabilities on page 54

Managing alarms
You can monitor, respond to, enable, and disable alarms.
Managing and monitoring alarms
You can use the Alarms window to perform all the alarm monitoring and managing tasks. When
responding to an alarm, you can use the Events window to view details about the event.
Typical alarm management tasks
Alarm management tasks that you perform most often are responding to, viewing, editing, testing,
and disabling or enabling alarms.
•

•

•

•

•

Responding to alarms
When you receive an alarm, you should acknowledge the event and resolve the condition that
triggered the alarm. If the repeat notification feature is enabled and the alarm condition persists,
you continue to receive notifications until you acknowledge the event.
Viewing the list of alarms
You can view the list of all currently configured data protection alarms when you want an
overview of what is configured for any selected group. You can control the sort order of any
column in the list. You can also control which alarms are displayed by filtering the information in
any column in the list.
Viewing the configuration values for any selected alarm
You can view the configuration details of any selected alarm when you want to know specific
information or you are considering modifying the configuration.
Editing an alarm
You can modify the configuration of an alarm when you need to accommodate changes in the
environment. For example, you might need to update a recipient email address, add another
recipient pager address, add a recipient script name, or change the hours during which the alarm
is active.
Testing an alarm
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•

You can test a new or modified alarm by having the NetApp Management Console data
protection capability or the NetApp Management Console provisioning capability send a test
message to all the recipients configured for the selected alarm.
Disabling or enabling an alarm
You can disable an alarm when you need to stop its functioning for a while but want to retain the
alarm configuration. For example, if you have an alarm configured for the SnapVault Backup
Failed event and you scheduled down time for maintenance on that host, you might disable the
alarm during the planned down time. When the host is up again, you can enable the alarm.

Infrequent alarm management tasks
Alarm management tasks that you perform only occasionally are adding and deleting alarms.
•

•

Adding an alarm
Configure a new alarm when you want notification of a specific event or any event of a specific
severity type for a group.
Deleting an alarm
Delete an alarm only when you are sure that you no longer need notification of the event or
severity type occurring for the group.

Responding to alarms
When you receive an alarm, you can acknowledge the event and resolve the condition that triggered
the alarm.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

If the repeat notification feature is not enabled, you receive the event notification only once. If the
repeat notification feature is enabled and the alarm condition persists, you continue to receive
notifications until you acknowledge the event.
Steps

1. For protection, provisioning, and disaster recovery alarms, from the menu bar, click Notifications
> Events. For Performance Advisor alarms, from the menu bar, click Monitor > Events.
2. Select an event whose details you want to view.
3. Click Acknowledge to indicate that you are taking responsibility for managing that event.
4. Click Yes in the Acknowledge Events dialog box to acknowledge the selected event.
Your user name and the time are entered in the Events list for the selected event.
5. Find the cause of the event and take corrective action.
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Related references
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Monitoring alarms
You can view a list of all the alarms configured for your application and capabilities.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. Depending on the alarms you want to view, perform one of the following actions:
•
•

For protection, provisioning, or disaster recovery alarms, from the menu bar,
click Notifications > Alarms.
For Performance Advisor alarms, from the menu bar, click Set Up > Alarms.

2. Optional: You can customize the Alarms window in one of the following ways:
•
•

•

Select an alarm to see the configured property values for that alarm.
Click
in a column header to control which alarm entries you want displayed.
The color of the column header changes to indicate that you are filtering the entries in that
column.
Some column filters display a drop-down list to select from and other column filters display a
search field in which you can enter text to select.
Click the sort arrows in a column header to change the sort order of the entries in that column.

•
•

Click
in the upper-right corner of the list to select which columns are displayed.
Drag the bottom of the alarms list area up or down to resize that area.

Related references
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Enabling or disabling alarms
You can disable an alarm when you need to temporarily stop its functioning and enable it when you
want it to start functioning again.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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About this task

Disabling an alarm enables you to retain the alarm configuration while its functioning is temporarily
stopped. For example, if you have an alarm that is configured for the SnapVault Backup Failed event
and you scheduled down time for maintenance on a host that is in the resource pool for the group
associated with that alarm, you might disable the alarm during the planned down time. When the host
is up again, you can enable the alarm to resume its functioning.
Steps

1. For protection, provisioning, or disaster recovery alarms, from the menu bar, click Notifications
> Alarms. For Performance Advisor alarms, from the menu bar, click Set Up > Alarms.
2. In the alarms list, locate the entry for the alarm you want to enable or disable.
3. Clear the Enabled check box to disable the associated alarm, or select the Enabled check box to
enable it.
The alarm is immediately disabled or enabled.
4. Verify your change by viewing the results that are displayed in the Alarms window.
Related references

Administrator roles and capabilities on page 54

What RBAC is
RBAC (role-based access control) provides the ability to control who has access to various features
and resources in the DataFabric Manager server.

How RBAC is used
Applications use RBAC to authorize user capabilities. Administrators use RBAC to manage groups
of users by defining roles and capabilities.
For example, if you need to control user access to resources, such as groups, datasets, and resource
pools, you must set up administrator accounts for them. Additionally, if you want to restrict the
information these administrators can view and the operations they can perform, you must apply roles
to the administrator accounts you create.
Note: RBAC permission checks occur in the DataFabric Manager server. RBAC must be
configured using the Operations Manager console or command line interface.

Administrator roles and capabilities
The administrator roles determine the tasks you can perform. You must specify one or more
capabilities for every role, and you can assign multiple capabilities if you want the administrator to
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have more control than a specific role provides. You can also customize a set of default global roles
and create new roles as necessary.
Default and custom roles
The following table lists the default global roles, descriptions, and capabilities associated with the
role.
Administrator role

Role description

Capabilities

GlobalAlarm

You can manage alarms.

DFMAlarmDelete
DFMAlarmRead
DFMAlarmWrite

GlobalDelete

You can view, modify, or
delete information in the
management server database,
including groups and members
of a group, monitored objects,
custom views, and primary and
secondary storage systems.

DFMAlarmDelete
DFMDatabaseDelete
DFMReportDelete

GlobalEvent

You can view, acknowledge,
and delete events and alerts.

DFMAlarmDelete
DFMAlarmRead
DFMAlarmWrite
DFMEventGenerate
DFMEventRead
DFMEventWrite

GlobalExecute

You can execute commands on
the storage system.

DFMConsoleExecute
DFMDatabaseRead
DFMDatabaseWrite

GlobalFullControl

You can view and perform any DFMCoreControl
operation on any object in the
DFMCoreDelegate
management server database
and configure administrator
accounts. You cannot apply this
role to accounts with group
access control.
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Administrator role

Role description

Capabilities

GlobalRead

You can view the management
server database, backup and
provisioning configurations,
events and alerts, performance
data, and policies.

DFMAlarmRead
DFMCoreAccessCheck
DFMDatabaseRead
DFMEventRead
DFMReportRead

GlobalReport

You can manage custom
reports and report schedules.

DFMReportDelete
DFMReportRead
DFMReportWrite

GlobalQuota

You can view user quota
reports and events.

DFMQuotaFullControl

GlobalWrite

You can view user quota
reports and events.

DFMAlarmWrite
DFMDatabaseWrite
DFMEventGenerate
DFMEventWrite
DFMReportWrite

Protection and provisioning information for AutoSupport
If you have AutoSupport enabled for the DataFabric Manager server, weekly messages that contain
protection and provisioning information are automatically sent to your internal support organization,
NetApp support personnel, or both.
If you have AutoSupport enabled for the DataFabric Manager server, the weekly AutoSupport
messages contain the following information in addition to any other protection-related information
that is sent by other applications:
•
•
•
•
•

Counts of the total volumes, qtrees, and SnapVault and SnapMirror relationships
Counts of the SnapVault and SnapMirror relationships that are managed by the NetApp
Management Console data protection capability
Counts of the volumes and qtrees that are in SnapVault and SnapMirror relationships
Counts of the volumes and qtrees that are in SnapVault and SnapMirror relationships that are
managed by the NetApp Management Console data protection capability
DataFabric Manager server API statistics

If you have AutoSupport enabled for the DataFabric Manager server, the weekly AutoSupport
messages contain the following information:
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•

•
•

Counts of the nodes, datasets, resource pools, provisioning policies, primary provisioning
requests (submitted and serviced since the current NetApp Management Console update), and
manual space management requests
Dataset names, associated resource pools, and associated vFiler units
Dataset nodes associated with provisioning policies
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Alarms window
You can use the Alarms window to view, create, configure, and disable or enable alarms.
•
•
•
•

Command buttons on page 58
Alarms list on page 58
Details area on page 59
Window customization on page 60

Command buttons
Add

Starts the Add Alarm wizard, which enables you to add alarms.

Edit

Opens the Properties sheet for modifying the configuration of the selected alarm.

Delete

Deletes the selected alarm.

Test

Tests the selected alarm by sending a test notification to all the recipients.

Alarms list
Displays a list of the configured alarms.
Event

If the alarm is configured for a specific event, displays the event that triggered the alarm.
If the alarm is configured for an event class, displays the event class for which all events
that occur in that class trigger the alarm.

Severity If the alarm is configured for a severity type, displays the severity type that marks the
lowest severity level that triggers the alarm. The default alarms list includes this column.
You can filter the column display a severity type and all the severity types worse than the
selected one.
Unknown

The event is in an unknown transitory state.

Unmanaged or
worse

The event source is not managed by NetApp Management
Console. No action is required.

Information or
worse

A normal resource event occurred. No action is required.

Warning or worse

The resource experienced an occurrence that you should be
aware of. This event severity does not cause service disruption,
and corrective action might not be required.

Error or worse

The resource is still performing, but corrective action is
required to avoid service disruption.
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Group

Critical or worse

A problem occurred that might lead to service disruption if you
do not take immediate corrective action.

Emergency

The resource unexpectedly stopped working and experienced
unrecoverable data loss. You must take corrective action
immediately to avoid extended downtime.

Displays the resource group the alarm is associated with. The default group is Global.
You can associate an alarm with any resource group that is defined.

Enabled Displays whether the alarm is enabled. The default is Yes (enabled).
Details area
Displays detailed information about the selected alarm.
Event class Displays the class of events for which the alarm is configured. Event classes can only
be selected; they are defined using the NetApp Management Console data protection
capability, the NetApp Management Console provisioning capability, or Operations
Manager.
Repeat
Notify
(minutes)

Active
range

Specifies whether an alarm notification is repeated until the event is acknowledged
and how often the notification is repeated. The default is no repeat notification.
minutes value
displayed

Repeats the event notification at the interval specified,
until the event is acknowledged.

no minutes value
displayed

Event notification is sent only once and is not repeated.

Specifies the time during which the alarm can be triggered. If a specific event or an
event of a specified severity type occurs at a time at which the alarm is not active, no
event notification occurs. For example, you might want an event notification to occur
only when a specific administrator is available.
Start Specifies the time at which the alarm becomes active, based on the time
zone of the storage set to which the event notification applies.
Stop

Recipients

Specifies the time at which the alarm becomes inactive, based on the time
zone of the storage set to which the event notification applies.

Specifies where the event notification is to be sent.
E-mails

Administrators

Displays the email address of the administrators
who receive the event notification.
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Pagers

NonAdministrators

Displays the email addresses of users to which
the event notification is sent.

Administrators

Displays the pager email address of the
administrators who receive the event
notification.

NonAdministrators

Displays the pager email addresses of users to
which the event notification is sent.

Traps

Displays the servers that contain an SNMP trap listener to receive the
event notification.

Script

Script

Displays the full path name of a script that is executed
when an alarm occurs.

Run script as Displays the user name to be used to run the script.
For more information about SNMP traps, see the OnCommand Unified Manager
Operations Manager Administration Guide.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.

Related information

OnCommand Unified Manager Operations Manager Administration Guide - http://
support.netapp.com/NOW/knowledge/docs/DFM_win/dfm_index.shtml
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Events window
You can use the Events window to monitor, acknowledge, and delete events.
•
•
•
•
•

Command buttons on page 61
View Events buttons on page 61
Events list on page 61
Details area on page 63
Window customization on page 63

Command buttons
Acknowledge Acknowledges the selected events; your user name and the time are entered in the
Event List for the selected events. When you acknowledge an event, you take
responsibility for managing that event.
Deletes the selected events from the Events summary list so that the deleted events
are not considered when calculating the status of a dataset, volume, and so on. To
view a list of deleted events, you can use the Operations Manager console interface.

Delete

View Events buttons
These filter buttons specify the range of events displayed in the events list.
1 Day

Displays events that occurred today.

1 Week

Displays events that occurred in the past seven days.

1 Month Displays events that occurred in the past 30 days.
All

Displays all events related to the NetApp Management Console client you are using.
Note: On very large or very busy systems, the Events window might be unresponsive
for long periods while loading 1 Month or All data. If NetApp Management Console
appears unresponsive for these large lists, you must select a shorter time period (such
as 1 Day).

Events list
Displays a list of the events that occurred. The list of events is updated dynamically, as events occur.
You can select an event to see the details for that event.
Note: You can download a maximum of 25,000 records in the list of events.
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Severity

Displays the severity type. The default events list includes this column, which
can be filtered to show a severity type and all severity types worse than the
selected one.
The severity types are as follows.
Unknown

The event is in an unknown transitory state.

Unmanaged The event source is not managed by the NetApp Management
Console data protection and provisioning capabilities. No
action is required.
Normal

A previous abnormal condition for the resource returned to a
normal state and the resource is operating within the desired
thresholds. No action is required.

Information A normal resource event occurred. No action is required.
Warning

The resource experienced an occurrence that you should be
aware of. This event severity does not cause service
disruption, and corrective action might not be required.

Error

The resource is still performing, but corrective action is
required to avoid service disruption.

Critical

A problem occurred that might lead to service disruption if
you do not take immediate corrective action.

Emergency

The resource unexpectedly stopped working and experienced
unrecoverable data loss. You must take corrective action
immediately to avoid extended downtime.

Event

Displays the event names. You can select an event to display the event details.
The default events list includes this column.

Triggered

Displays the time and date the event was generated. The default events list
includes this column.

Acknowledged
By

Displays the name of the user who acknowledged the event. The field is blank
if the event is not acknowledged. The default events list includes this column.

Acknowledged
Time

Displays the time the event was acknowledged. The field is blank if the event
is not acknowledged. The default events list includes this column.

Source

Displays the full object name that triggered the event. The default events list
includes this column.

Deleted By

Displays the user name that deleted the event. This column is not displayed by
default.

Deleted Time

Displays the time the event was deleted. This column is not displayed by
default.
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Details area
The area below the event list displays detailed information about the selected event, as follows:
Event

Displays the event name.

Source

Displays the full object name to which the event is associated.

Source Type

Displays the object type that triggered the event.

Severity

Displays the severity type of the event.

About

Displays the status of the counters.

Triggered

The time and date the event occurred.

Acknowledged

Whether the event was acknowledged and by whom.

Deleted

Whether the event was deleted from the Events list.

Condition

A description of the condition that triggered the event.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Overview of resource pools
You create resource pools by using the Add Resource Pool wizard, which is accessible from the
Resource Pools window. The wizard lets you select aggregates, entire storage systems, or groups of
physical resources from which to create your resource pool.
After you create a resource pool, you can associate it with one or more datasets. You can also
associate datasets with provisioning and protection policies. These tasks can be accomplished when
you add or edit datasets from the Datasets window.
When you assign a data protection policy, the NetApp Management Console data protection
capability applies the policy settings to automatically provision destination volumes from the
assigned resource pool. It then creates backup and mirror relationships from each volume and qtree
in the dataset to the newly provisioned secondary storage.
When you assign a provisioning policy to a dataset node, the NetApp Management Console
provisioning capability applies the availability characteristics and space settings in the policy to
automatically select the resources needed to fulfill a request for storage space for the primary data of
a dataset.
These relationships between physical storage units, resource pools, and datasets mean that you must
consider carefully what the impact might be of changes made to the system.
Related concepts

Dataset concepts on page 65
What groups are on page 67
Ways you might combine resources in resource pools on page 157
Related references

Advantages of using resource pools on page 157
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Dataset concepts
Associating data protection, disaster recovery, a provisioning policy, or a storage service with a
dataset enables storage administrators to automate tasks, such as assigning consistent policies to
primary data, propagating policy changes, and provisioning new volumes, qtrees, or LUNs on
primary and secondary dataset nodes.
Configuring a dataset combines the following objects:
For protection purposes, a collection of physical resources on a primary node,
Dataset of
physical storage such as volumes, FlexVol volumes, and qtrees, and the physical resources for
copies of backed-up data on secondary and tertiary nodes.
objects
For provisioning purposes, a collection of physical resources, such as volumes,
FlexVol volumes, qtrees, and LUNs, that are assigned to a dataset node. If the
protection policy establishes a primary and one or more nonprimary nodes, each
node of the dataset is a collection of physical resources that might or might not
be provisioned from the same resource pool.
Dataset of
virtual objects

A collection of supported VMware virtual objects that reside on storage systems.
These virtual objects can also be backed up locally and backed up or mirrored on
secondary and tertiary nodes.

Application
dataset

A dataset managed by an application that is external to the protection and
provisioning capabilities, such as a dataset managed by SnapManager for Oracle.

Resource pool

A collection of physical resources from which storage is provisioned. Resource
pools can be used to group storage systems and aggregates by attributes, such as
performance, cost, physical location, or availability. Resource pools can be
assigned directly to the primary, secondary, or tertiary nodes of datasets of
physical storage objects.
They can be assigned indirectly both to datasets of virtual objects and to datasets
of physical storage objects through a storage service.

Data protection A set of rules that define how to protect primary data on primary, secondary or
tertiary storage, as well as when to create copies of data and how many copies to
policy
keep.
Protection policies can be assigned directly to datasets of physical storage
objects. They can be assigned indirectly to both datasets of virtual objects and to
datasets of physical storage objects through a storage service.
Provisioning
policy

A set of rules that define how to provision storage for the primary or secondary
dataset nodes, and provides rules for monitoring and managing storage space and
for allocating storage space from available resource pools.
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Provisioning policies can be assigned directly to the primary, secondary, or
tertiary nodes of datasets of physical storage objects. They can be assigned
indirectly to both datasets of virtual objects and datasets of physical storage
objects through a storage service.
Storage service

A single dataset configuration package that consists of a protection policy,
provisioning policies, resource pools, and an optional vFiler template (for vFiler
unit creation). You can assign a single uniform storage service to datasets with
common configuration requirements as an alternative to separately assigning the
same protection policy, provisioning policies, and resource pools, and to setting
up similar vFiler unit attachments to each of them.
The only way to configure a dataset of virtual objects with secondary or tertiary
backup and mirror protection and provisioning is by assignment of a storage
service. You cannot configure secondary storage vFiler attachments for datasets
of virtual objects.

Protection or
provisioning
related objects

Snapshot copies, primary volumes, secondary volumes, or secondary qtrees that
are generated as a result of protection policy or provisioning policy protection
jobs or provisioning jobs.

Naming settings Character strings and naming formats that are applied when naming related
objects that are generated as a result of protection policy or provisioning policy
protection jobs or provisioning jobs.
Related concepts

Overview of resource pools on page 64
What a policy is on page 392
Dataset guidelines on page 77
What groups are on page 67
About storage services on page 212
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What groups are
A group is a collection of objects with common characteristics, such as location, project, or owning
organization.
Related concepts

Overview of resource pools on page 64
Dataset concepts on page 65

68 | Provisioning and Data Protection Online Help

Data ONTAP licenses used for protecting or
provisioning data
There are several Data ONTAP licensed options that you can use to protect or provision your data.
After you have purchased the software licenses you need, you can assign these licenses to your
primary and secondary storage from the Storage Systems Hosts window.
When you purchase a Data ONTAP option license, you receive a code composed of a string of
characters, such as ABCDEFG, that is unique to a particular service. You receive license codes for
every protocol and option, or service, that you purchase.
Not all purchased license codes are installed on a storage system before it is shipped from the
factory. Some licenses are installed after the system is set up. You can purchase license codes to
enable additional services at any time. If you misplace a license code, you can contact NetApp
technical support or log in to the NetApp Support Site to obtain a copy.
You must enter a software license code on a storage system to enable the corresponding service. You
do not need to indicate which license the code enables. The code is matched automatically to the
appropriate service license.
Note: The Licenses area is visible only when the selected host is a single storage system running
Data ONTAP. If you plan to use Open Systems SnapVault to back up data on a host that is not
running Data ONTAP, you select the secondary storage system to license the necessary Data
ONTAP services.

The following licenses are available for use with the DataFabric Manager server:
SnapMirror license You install a SnapMirror license on each of the source and destination
storage systems for the mirrored data. If the source and destination volumes
are on the same system, only one license is required.
SnapMirror replicates data to one or more networked storage systems.
SnapMirror updates the mirrored data to keep it current and available for
disaster recovery, offloading tape backup, read-only data distribution, testing
on nonproduction systems, online data migration, and so on. You can also
enable the SnapMirror license to use Qtree SnapMirror for backup.
To use SnapMirror software, you must update the
snapmirror.access option in Data ONTAP to specify the destination

systems that are allowed to access the primary data source system. For more
information about the snapmirror.access option, see the Data ONTAP
Data Protection Online Backup and Recovery Guide for 7-Mode.
SnapVault Data
ONTAP secondary
license

You install the SnapVault Secondary license on storage systems that host the
backups of protected data. SnapVault creates backups of data stored on
multiple primary storage systems and copies the backups to a secondary
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storage system. If data loss or corruption occurs, backed-up data can be
restored to a primary or open storage system with little of the downtime and
uncertainty associated with conventional tape backup and restore operations.
For versions of Data ONTAP 7.3 or later, a single storage system can
contain a SnapVault Data ONTAP Primary license and a SnapVault
Secondary license.
SnapVault Data
ONTAP primary
license

You install the SnapVault Data ONTAP Primary license on storage systems
running Data ONTAP that contain host data to be backed up. For versions of
Data ONTAP 7.3 or later, a single storage system can contain a SnapVault
Data ONTAP Primary license and a SnapVault Secondary license.

SnapVault
Windows Primary
License

You install the SnapVault Windows Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a
Windows-based primary storage system running the Open Systems
SnapVault agent. A Windows-based primary storage system running the
Open Systems SnapVault agent does not require a SnapVault license.

You install the SnapVault Open File Manager license on a secondary storage
SnapVault
Windows Open File system to enable the backup of open files on Windows primary storage
systems running the Open Systems SnapVault agent.
Manager license
You must install the SnapVault Windows Primary license and the
SnapVault Data ONTAP Secondary license on the secondary storage system
before installing the SnapVault Open File Manager license.
SnapVault UNIX
primary license

You install the SnapVault UNIX Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a UNIXbased primary storage system (AIX, HP-UX, or Solaris) running the Open
Systems SnapVault agent. A UNIX-based primary storage system running
the Open Systems SnapVault agent does not require a SnapVault license.

SnapVault Linux
primary license

You install the SnapVault Linux Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a Linuxbased primary storage system running the Open Systems SnapVault agent. A
Linux-based primary storage system running the Open Systems SnapVault
agent does not require a SnapVault license.

NearStore Option
license

The NearStore license enables your storage system to use transfer resources
as conservatively as if it were optimized as a backup system. This approach
is useful when the storage system on which you want to store backed-up data
is not a system optimized for storing backups, and you want to minimize the
number of transfer resources the storage system requires.
Storage systems using the NearStore license must meet the following
criteria:
•

The storage system must be a FAS30xx, FAS31xx, or FAS60xx system.

70 | Provisioning and Data Protection Online Help
•
•

The version of Data ONTAP must be 7.1 or later.
If you plan to use the SnapVault service, the storage system must have a
SnapVault secondary license enabled.

Deduplication
license

The deduplication license (a_sis) enables you to consolidate blocks of
duplicate data into single blocks to store more information using less storage
space.

SnapMirror Sync
license

The SnapMirror Sync license enables you to replicate data to the destination
as soon as it is written to the source volume. SnapMirror Sync is a feature of
SnapMirror.

MultiStore Option
license

The MultiStore Option license enables you to partition the storage and
network resources of a single storage system so that it appears as multiple
storage systems on the network. Each virtual "storage system" created as a
result of the partitioning is called a vFiler unit. A vFiler unit, using the
resources assigned, delivers file services to its clients as a storage system
does.
The storage resource assigned to a vFiler unit can be one or more qtrees or
volumes. The storage system on which you create vFiler units is called the
hosting storage system. The storage and network resources used by the
vFiler units exist on the hosting storage system.
Be sure the host on which you intend to install the MultiStore Option license
is running Data ONTAP 6.5 or later.

FlexClone license

The FlexClone license is necessary on storage systems that you intend to use
as resources for secondary nodes for datasets of virtual objects.

Single file restore
license

The Single file restore license is necessary on storage systems that you
intend to use as primary storage for datasets of virtual objects.

Related concepts

Process for determining when SnapVault and qtree SnapMirror are used to perform backups on
page 252
Related information

Documentation on the NetApp Support Site: support.netapp.com
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What the NetApp Management Console data protection
capability is
The NetApp Management Console data protection capability helps you manage your backup and
mirror relationships and perform failover operations easily and efficiently by eliminating repetitive
tasks and automating some tasks.
Typically, data and resource management is time consuming because it involves manual analysis and
management of storage capacity, network bandwidth, schedules, retention policies, and other
infrastructure variables. The NetApp Management Console data protection capability simplifies this
work by employing configuration policies, convenient wizards, and automated verification of certain
aspects of the data protection configuration. It enables you to launch a backup, restore, or failover
operation with a single click.
The NetApp Management Console data protection capability can perform the following actions:
•
•
•
•
•
•

Use policies to manage primary data, storage, and backup and mirror relationships
Manage local and remote backups and mirror copies
Discover external SnapVault and SnapMirror relationships, report on external relationship lags,
and import external relationships
Provision the secondary storage for backups and mirrored copies based on policies you assign
Enable disaster recovery capability
Automatically validate your backup and disaster recovery configuration with a conformance
checker

Anyone using the NetApp Management Console data protection capability should be familiar with
general data protection and disaster recovery concepts. The NetApp Management Console data
protection capability uses Data ONTAP data protection technologies, such as Snapshot copies,
SnapVault, Open Systems SnapVault, and SnapMirror.

Dashboards
A dashboard is a window that contains multiple information panels that provide cumulative at-aglance information about your systems.
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Overview of the NetApp Management Console dashboard
The NetApp Management Console provides an overview of various aspects of your data management
environment, including protection, provisioning, and monitoring information.
The specific dashboard panels that are displayed change according to the application or capability
that is currently selected.
Protection
dashboard

The Protection dashboard helps you to determine the current overall protection
status of your data and resources, such as the number of objects that are protected,
the number of objects that are unprotected, the longest lag times of external
relationships, and system events to be addressed. You can also gather data for
evaluating system actions and to assist in determining how to set up datasets,
policies, and schedules for the future. Disaster recovery-related failover readiness
and status information is also displayed.

Provisioning
dashboard

The Provisioning dashboard helps you to determine the current overall status of
dataset and resource pool provisioning. In addition to listing system events to be
addressed, information provided for datasets includes conformance status,
resource status, and space status. Information provided for resource pools includes
space status and overall utilization. This information can help you determine when
you need to increase available space for your datasets or when you need to
investigate out-of-conformance issues.

Monitor
dashboard

The Monitor dashboard in Performance Advisor displays information about the
current overall performance status of your systems, such as performance events,
top storage systems by the total number of operations, top storage systems by
network throughput, top storage systems by CPU utilization, Top Nodes by CPU
Utilization and Top Vservers by Total Ops. You can modify the default settings to
configure any view on the global group as a dashboard.

You can filter the content of the Protection and Provisioning dashboard panels by using the Group
selection list on the console tool bar. This option enables you to focus on information about a
particular group, such as specific datasets or resource pools.
. In the Protection
Information about the dashboard can be viewed by clicking the Help menu or
and Provisioning dashboards, there is an additional Help icon available at the top of each dashboard
panel that brings up a Help page with information about the panel.

Dashboard panel descriptions
The dashboard panels provide a cumulative at-a-glance status information about your system.
Dashboards are provided for each application or capability available in NetApp Management
Console.
•

Protection dashboard on page 73: The individual panels in this dashboard provide status on data
that is protected and managed by the NetApp Management Console data protection capability,
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•
•

data that is unprotected, and external relationships, which have protection configured but are not
managed by the NetApp Management Console data protection capability.
Provisioning dashboard on page 74: The individual panels in this dashboard provide space
management information related to datasets and resource pools.
Performance Advisor dashboard on page 74: The individual panels in this dashboard provide
information about performance.

You must be assigned the appropriate privileges to view the dashboard panels.
Protection dashboard
You can view more information about each dashboard panel and its contents by clicking
dashboard panel title bar.

in the

Failover
Readiness

Displays the number of datasets that are configured for disaster recovery
protection and in the failover ready state. This indicates that the datasets can
successfully perform failover operations, if failover operations become
necessary.

Failover Status

Appears when a failover operation is invoked. This panel lists the number of
datasets in the process of failing over and the number of datasets that have
successfully failed over.

Top Five Events Displays the five events with the highest severity levels. Events are ordered first
by severity, then by time that they occurred.
Dataset
Protection
Status

Displays the total number of datasets, grouped according to their current
protection status.

Protected Data

Displays the total number of objects that are protected and managed by the
NetApp Management Console data protection capability. Objects included in
this panel are datasets that have an assigned protection policy and have a
relationship created (the dataset has conformed to the protection policy at least
once), and volumes, qtrees, and Open Systems SnapVault (OSSV) directories
that are in a SnapVault or SnapMirror relationship, which is managed by the
NetApp Management Console data protection capability, and are not in an
external relationship.

Unprotected
Data

Displays the total number of datasets, volumes, and qtrees that are not protected.
Datasets are unprotected if they do not have an assigned protection policy or if
they have an assigned protection policy but do not have a relationship created
(the dataset has never conformed to the protection policy). Volumes and qtrees
are unprotected if they are not in a SnapVault or SnapMirror relationship which
is managed by the NetApp Management Console data protection capability, and
are not in an external relationship.
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Dataset Lags

Displays the top five datasets with the longest lags. A dataset lag occurs when a
protection component is out of date with the primary data. This panel groups
relationships according to dataset, sorts relationships according to lag, selects
the longest lag for each dataset, and displays the datasets in decreasing order of
lag.

External
Relationship
Lags

Displays the top five external SnapVault or SnapMirror relationships with the
longest lags. These relationships are not managed by the NetApp Management
Console data protection capability.

Provisioning dashboard
You can view more information about each dashboard panel and its contents by clicking
dashboard panel title bar.

in the

Dataset
Conformance Status

Displays the total number of datasets that are conforming to associated
policies.

Top Five Events

Displays the five events with the highest severity levels. Events are ordered
first by severity, then by time that they occurred.

Dataset Resource
Status

Displays the number of datasets at different levels of resource status
severity. The status represents the worst event severity on all direct and
indirect members of the dataset nodes.

Dataset Space Status Displays the total number of datasets being managed by NetApp
Management Console, grouped according to their current space status
value. The status represents the worst space status of all members in all
nodes of the dataset. Events are generated at the dataset level when the
space status of a dataset changes.
Resource Pool Space Displays the total number of resource pools that currently meet or exceed
the space thresholds.
Status
Resource Pools

Displays, by resource pool name, the total space allocated to and the space
utilization of each resource pool. Items are sorted in increasing order of
available space.

Performance Advisor dashboard
You can view more details about the Performance Advisor dashboard by clicking
dashboard panel title bar.

in the
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Dashboard panels
Top Performance
Events

Displays the five events with the highest severity levels. Items are ordered
first by severity, then by time that they occurred. More detail about each
event is provided in Monitor > Events.

Top Nodes by CPU
Utilization

Displays a bar chart of the top five nodes that are discovered and monitored
by the DataFabric Manager server, and sorted by the highest CPU
utilization. The vertical axis displays the percentage of CPU utilization for
that node. The horizontal axis displays the node name.

Top Vservers by
Total Ops

Displays a bar chart of the top five Vservers that are discovered and
monitored by the DataFabric Manager server, and sorted by the highest total
operations. The vertical axis displays the total operations per second for that
Vserver. The horizontal axis displays the Vserver name.

Dashboard panels
Top Performance
Events

Displays the five events with the highest severity levels. Items are ordered
first by severity, then by time that they occurred. More detail about each
event is provided in Monitor > Events.

Displays a bar chart of the top five storage systems, sorted by the highest
Top Storage
Systems by Network network throughput. The number above each bar chart displays the exact
value of the throughput per second from that system. The vertical axis
Throughput
displays the megabytes of throughput per second. The horizontal axis
displays the name of the storage system.
Top Storage
Systems by Total
Ops

Displays a bar chart of the top five storage systems, sorted by the highest
total operations. The vertical axis displays the total operations per second
for that storage system. The horizontal axis displays the storage system
name.

Top Storage
Systems by CPU
Utilization

Displays a bar chart of the top five storage systems, sorted by the highest
average CPU utilization. The number above each bar chart displays the
exact value of the throughput per second from that system. The vertical axis
displays the percentage CPU usage of the storage system. The horizontal
axis displays the name of the storage system.

Related references

List of events and severity types on page 16

What datasets are
A dataset consists of a collection of storage sets along with configuration information associated with
their data. The storage sets associated with a dataset include a primary storage set used to export data

76 | Provisioning and Data Protection Online Help
to clients, and the set of replicas and archives that exist on other storage sets. Datasets represent
exportable user data.

About datasets
You can use datasets to group data and use resource pools to group storage to simplify the
monitoring, provisioning, reporting, and access control of your SnapVault and SnapMirror
relationships, which enables flexible and efficient use of storage.
Dataset concepts
Associating data protection, disaster recovery, a provisioning policy, or a storage service with a
dataset enables storage administrators to automate tasks, such as assigning consistent policies to
primary data, propagating policy changes, and provisioning new volumes, qtrees, or LUNs on
primary and secondary dataset nodes.
Configuring a dataset combines the following objects:
For protection purposes, a collection of physical resources on a primary node,
Dataset of
physical storage such as volumes, FlexVol volumes, and qtrees, and the physical resources for
copies of backed-up data on secondary and tertiary nodes.
objects
For provisioning purposes, a collection of physical resources, such as volumes,
FlexVol volumes, qtrees, and LUNs, that are assigned to a dataset node. If the
protection policy establishes a primary and one or more nonprimary nodes, each
node of the dataset is a collection of physical resources that might or might not
be provisioned from the same resource pool.
Dataset of
virtual objects

A collection of supported VMware virtual objects that reside on storage systems.
These virtual objects can also be backed up locally and backed up or mirrored on
secondary and tertiary nodes.

Application
dataset

A dataset managed by an application that is external to the protection and
provisioning capabilities, such as a dataset managed by SnapManager for Oracle.

Resource pool

A collection of physical resources from which storage is provisioned. Resource
pools can be used to group storage systems and aggregates by attributes, such as
performance, cost, physical location, or availability. Resource pools can be
assigned directly to the primary, secondary, or tertiary nodes of datasets of
physical storage objects.
They can be assigned indirectly both to datasets of virtual objects and to datasets
of physical storage objects through a storage service.

Data protection A set of rules that define how to protect primary data on primary, secondary or
tertiary storage, as well as when to create copies of data and how many copies to
policy
keep.
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Protection policies can be assigned directly to datasets of physical storage
objects. They can be assigned indirectly to both datasets of virtual objects and to
datasets of physical storage objects through a storage service.
Provisioning
policy

A set of rules that define how to provision storage for the primary or secondary
dataset nodes, and provides rules for monitoring and managing storage space and
for allocating storage space from available resource pools.
Provisioning policies can be assigned directly to the primary, secondary, or
tertiary nodes of datasets of physical storage objects. They can be assigned
indirectly to both datasets of virtual objects and datasets of physical storage
objects through a storage service.

Storage service

A single dataset configuration package that consists of a protection policy,
provisioning policies, resource pools, and an optional vFiler template (for vFiler
unit creation). You can assign a single uniform storage service to datasets with
common configuration requirements as an alternative to separately assigning the
same protection policy, provisioning policies, and resource pools, and to setting
up similar vFiler unit attachments to each of them.
The only way to configure a dataset of virtual objects with secondary or tertiary
backup and mirror protection and provisioning is by assignment of a storage
service. You cannot configure secondary storage vFiler attachments for datasets
of virtual objects.

Protection or
provisioning
related objects

Snapshot copies, primary volumes, secondary volumes, or secondary qtrees that
are generated as a result of protection policy or provisioning policy protection
jobs or provisioning jobs.

Naming settings Character strings and naming formats that are applied when naming related
objects that are generated as a result of protection policy or provisioning policy
protection jobs or provisioning jobs.
Related concepts

Overview of resource pools on page 64
What a policy is on page 392
Dataset guidelines on page 77
What groups are on page 67
About storage services on page 212
Dataset guidelines
These guidelines can help you optimize the advantages of using datasets.
•

Group similar data
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•

•

For protection purposes, group primary volumes, LUNs, or qtrees that have identical data
protection requirements into one dataset.
Avoid provisioning loops
For provisioning purposes, a dataset cannot contain a storage system that is also in a resource
pool assigned to a dataset node. This constraint prevents a loop that attempts to provision an
infinite number of volumes.
Use dataset-level custom naming
When creating or editing a dataset, you can customize the naming rules that get applied to the
Snapshot copies, primary volumes, secondary volumes, and secondary qtrees that are created by
the NetApp Management Console protection and provisioning operations on that dataset.
Customized naming of these dataset-related objects offers the following management advantages:
•
•

•

Easy location of secondary and tertiary storage backup items for restore operations
Easy identification of backup data by priority, business unit, administrator, backup time,
physical container, or logical container
• Customization of formats to maintain naming used by imported protection relationships
• Easy identification of backup data related to protection, SnapManager, or SnapDrive
operations
• Easy identification of source and secondary volumes in case of application shutdown
Use custom fields
When creating or editing a dataset, you can use user-defined custom fields to identify the dataset
for a specific purpose. For example, you might associate a cost center or chargeback code with
the dataset. To use a custom field, you must create the custom field before you add or edit a
dataset.

How the NetApp Management Console data protection capability uses datasets of physical
objects
The NetApp Management Console data protection capability uses the information in a dataset to
create Snapshot copies used for backups and mirror copies, to provision storage as needed for the
copies, and to transfer the copies to backup or mirror nodes.
After you set up a dataset of physical objects for protection, you can perform the following
operations using the NetApp Management Console data protection capability:
1. The NetApp Management Console data protection capability provisions volumes and qtrees on
the destination node in several ways. For storage systems that run Data ONTAP 7.0 or later, it
automatically provisions flexible volumes and qtrees when the resource pool contains an
aggregate. For storage systems that run Data ONTAP 6.5 or earlier, you manually add secondary
storage to the destination node. If you manually select storage without using resource pools for a
SnapMirror destination node, the NetApp Management Console data protection capability
provisions traditional volumes assigned to that destination node.
2. The NetApp Management Console data protection capability creates backup relationships (either
SnapVault or SnapMirror) between volumes and qtrees in the dataset with the newly provisioned
secondary storage.
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3. The NetApp Management Console data protection capability runs the data protection schedules,
making Snapshot copies of the primary data and initiating SnapVault and SnapMirror baseline
transfers at the scheduled times.
4. The NetApp Management Console data protection capability periodically checks that the dataset
conforms to its data protection policy. If either the dataset membership or the policy changes, it
tries to bring the dataset back into conformance, or it notifies you that the conformance status
changed to nonconformant.
How the NetApp Management Console provisioning capability works with datasets of
physical objects
The NetApp Management Console provisioning capability simplifies and automates the tasks of
provisioning and managing storage for the data in datasets of physical objects.
After you add a dataset for provisioning, the NetApp Management Console provisioning capability
can provide the following services:
•

Provision the dataset of physical objects
The NetApp Management Console provisioning capability provisions volumes and qtrees (in
NAS environments) or volumes and LUNs (in SAN environments) for a dataset using the
resource pool assigned to the dataset. In SAN environments, a provisioned volume can be
delegated to SDx applications and used to create qtrees or LUNs.
The NetApp Management Console provisioning capability can provision volumes, qtrees, or
LUNs on the backup and mirror dataset nodes.
Note: You are advised NOT to use SnapDrive for Windows versions earlier than 5.0 to connect
to mapped LUNs that are provisioned using the NetApp Management Console provisioning
capability. Doing so might result in an error requiring the LUNs to be manually unmapped.

•

•

•

•

•

Configure automatic storage using policies and templates
When you create a dataset for provisioning, you can assign a provisioning policy that provides
settings for automatically configuring storage for the dataset.
Allow manual addition of storage space
You can manually add additional volumes, qtrees, or LUNs, at any time, to a dataset that has a
provisioning policy assigned.
Handle dataset-managed protocols for exporting data
Protocols for exporting data are automatically handled by the dataset.
You can also assign a vFiler template to a vFiler host. When a vFiler host is created, the vFiler
template provides default settings for automatically configuring the vFiler host.
Check for conformance
The NetApp Management Console provisioning capability periodically checks that the dataset
conforms to its provisioning policy. For example, if the data in a dataset reaches a specified
threshold level, the NetApp Management Console provisioning capability tries to create
additional space according to the provisioning policy, either by increasing the storage container
size or deleting old Snapshot copies, or both. If it cannot bring the dataset back into conformance,
it notifies you that the conformance status changed to nonconformant.
Allow manual management of storage space
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NetApp Management Console provides manual controls for viewing and resizing individual
volumes or qtrees and modifying volume data and Snapshot copy space allocations.
Overview of export protocols
You can configure NFS, CIFS, iSCSI, or Fibre Channel (FC) export protocols for client access to a
dataset. You can configure an export protocol for an entire dataset by assigning a provisioning policy
or for a specific dataset member.
You can specify support for export protocol access when you create a dataset, when you reconfigure
the primary, backup, or mirror nodes in your dataset, or when you provision a new volume, LUN, or
qtree into the dataset.
There are two ways that you can export storage in a dataset.
•

•

Enable one export protocol for an entire primary, backup, or mirror node of a dataset
Clients can access all of the storage, that is all volumes, qtrees, and LUNs, in a particular dataset
node by using the specified protocol.
To achieve this configuration, specify export settings for the primary node when completing the
Add Dataset wizard and for the backup and mirror nodes by using the Dataset Policy Change
wizard.
Assign different export protocols to each new volume, LUN, or qtree member
You can assign different export protocols to each new volume, LUN, or qtree member when you
provision the member into a dataset, rather than specifying an export protocol for the entire
dataset node. Clients can selectively access dataset members, based on the protocols enabled for
each client and each dataset member.
To achieve this configuration, do not specify an export protocol when creating the dataset.
Instead, use the Provisioning wizard to provision a new member into a dataset and select the
option to export the new member.

Related concepts

Overview of export protocol properties on page 112
Related tasks

Configuring dataset nodes for NFS protocol access on page 114
Configuring dataset nodes for CIFS protocol access on page 113
Configuring dataset nodes for FC protocol access on page 115
Configuring dataset nodes for iSCSI protocol access on page 116
When to configure datasets
You should configure datasets when you have identified which data to group for protection or
provisioning.
You can also configure datasets in the following situations:
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Protection

•
•

•

•
•
•
Provisioning •
•
•
•
•

You are setting up data protection for the first time.
You previously used Backup Manager or Disaster Recovery Manager and are
upgrading to the NetApp Management Console data protection capability, and
you want to import existing relationships that the NetApp Management Console
data protection capability discovered.
You never used Operations Manager to monitor or manage your SnapVault or
SnapMirror relationships and want to import existing relationships that the
NetApp Management Console data protection capability discovered.
A condition changed that affects the status of the dataset, and you want to change
the protection policy.
You are monitoring your storage resources by viewing the dashboard, which
displays all resources, including resources that are unprotected.
You added a storage system, or the DataFabric Manager server discovered it, and
you want to protect the data on that storage system.
You are setting up provisioning for the first time.
You want to provision an existing dataset that has not yet been provisioned.
You need to add another volume or LUN to an existing dataset.
A condition changed that affects the status of the dataset, and you want to change
the provisioning policy.
You are monitoring your storage space usage by viewing the dashboard, and it
displays a warning for a dataset member that is running out of space.

Dataset storage space management
The NetApp Management Console provisioning capability enables you to view space allocations for
volumes, LUNs, and qtrees. You can also resize individual volumes or qtrees, and modify volume
data and Snapshot copy space allocations in response to space-usage generated error or warning
events.
The space allocation changes that you make apply only to the selected volume or qtree, not to any
other volumes or qtrees in the dataset. You can specifically edit the space allocation for data and
Snapshot copies as long as the space allocation remains compliant with the provisioning policy
assigned to the associated dataset primary, backup, or mirror node.
When to manually manage storage space for a dataset
In most cases, you perform space management tasks on a volume, or qtree when a space-usage
generated warning or error event alerts you to the fact that an individual storage container in one of
your managed datasets has reached, or is close to reaching, its configured maximum capacity to hold
new data.
At this point, in many cases, the simplest and most immediate remedy is to make more data space
available for those individual volumes or qtrees.
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Note: The only management task that you can perform on a LUN is to delete the LUN.

How to view dataset storage space utilization
You can use the Resource Pools window Space breakout tab to see how much space each dataset is
currently using, which is helpful for determining when a dataset needs to be migrated to a larger
aggregate in another storage system.
The Space breakout tab lists the aggregates assigned to the resource pool that is selected in the
Resource Pools window. When you select an aggregate, all the datasets in the aggregate and the
percentage and amount of currently used space for each dataset are displayed.
Datasets that have a high percentage of utilization are good candidates for migration.
Overview of tasks for managing storage space
You can perform different data protection and provisioning tasks to manage the storage space for a
dataset.
Survey your volumes
and qtrees

You can scan the tables on the Provisioning tab to pinpoint the volumes
and qtrees that are approaching their data and Snapshot copy space
limitation.

Diagnose your space
management warning
and error statuses

You can check the diagnosis of the volumes or qtrees whose space
status is Warning or Error.

In nodes containing volumes or qtrees, you can expand a volume to
Resize your volume or
qtree data and Snapshot claim more uncommitted aggregate space or you can increase a qtree
quota to claim more uncommitted volume space. You can also
space
reallocate the space in a volume specifically reserved for Snapshot
copies and specifically used for data.
Delete Snapshot copies

You can delete individual Snapshot copies in a volume to make more
space available for data.

Delete storage
containers

You can delete unneeded volumes and return the space that they used to
the containing aggregate for reallocation. You can delete LUNs and
qtrees and return the space they used to the containing volume for
reallocation.

Related concepts

Dataset migration versus volume migration on page 671
Volume migration configuration requirements on page 671
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Space management resize options
The NetApp Management Console provisioning capability provides you with three options to resize
or reallocate space on existing volumes. It also enables you to expand hard quotas on existing qtrees.
Volume
resize
options

Qtree
resize
option

Depending on the type of volume (NAS or SAN), the NetApp Management Console
provisioning capability enables you to modify one or more of the following
parameters:
Total volume
size

You can increase the total space allowed for the selected NAS or
SAN volume within its containing aggregate. If you are not
allowing space overcommitment, you are limited by the amount of
space still available in the containing aggregate.

Snap reserve
%

The percentage of space in the selected flexible volumes reserved
for Snapshot copies. Snap reserve % is adjustable on NAS
volumes. As you adjust the percentage up or down, the NetApp
Management Console provisioning capability displays the absolute
allocation of Snapshot copy reserve space in the Snap Reserve
field.

Maximum size
limit

If the Autogrow property is enabled on a SAN or NAS volume,
you can modify the Maximum size limit.

The NetApp Management Console provisioning capability enables you to enlarge the
hard quota for a qtree if the qtree is configured with a hard quota.

About naming settings for protection or provisioning related objects
To improve recognition and usability, you can customize the dataset-level naming settings for
protection or provisioning related objects, Snapshot copies, primary volumes, secondary volumes,
and secondary qtrees that are created by default by NetApp Management Console protection and
provisioning operations on datasets.

Differences between global and dataset-level naming settings
Global naming settings apply, by default, to all objects that are generated in datasets that are not
configured with dataset-level naming settings. Dataset-level naming settings are configured for
individual datasets and apply only to the objects that are generated in those datasets.
Global naming settings
Protection-related objects are, by default, automatically named using a global naming format for each
object type.
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The OnCommand console enables you to customize the global naming settings for one or more
related object type. After you customize the global naming format for a particular object type, that
customization then applies by default to all newly generated objects of that type that do not belong to
a dataset with conflicting dataset-level naming settings.
However, if the newly generated object is part of a dataset that already has customized dataset-level
Snapshot copy, primary volume, secondary volume, or secondary qtree naming formats, then the
customized naming formats apply to that object.
Dataset-level naming settings
Both the OnCommand console and NetApp Management Console enable you to configure datasetlevel naming settings for one or more object types in a particular dataset. Those dataset-level naming
settings then apply to the naming of their object types within that dataset.
Within that dataset, dataset-level naming settings have priority over any conflicting global naming
settings.
When to customize naming of protection-related objects
To support backup tasks, storage administration tasks, and application administration tasks, you can
customize naming of NetApp Management Console protection-related objects.
Custom naming and backup tasks
If you are a backup administrator, configuration of custom naming presents you with the following
advantages:
•

•

•

•

•

Easy location of secondary and tertiary storage backup items for restoration
Custom naming applied to Snapshot copies, secondary volumes, or secondary qtrees enables you
to easily identify the backup objects in which to locate files for restoration.
Easy identification of backup data by an assortment of criteria
Custom naming, configured with specific naming conventions and applied to the backup objects,
enables you to identify those objects by priority, business unit, administrator, backup time,
physical container, or logical container.
Customization of formats to maintain naming used by imported protection relationships
Custom naming can be used by NetApp Management Console to assign naming formats for
related objects that matches the related object naming conventions originally used by imported
protection relationships.
Easy identification of backup data related to protection, SnapManager, or SnapDrive operations
A consistent naming convention enables you to easily find the right data to restore even if that
backup data is related to such disparate activities as NetApp Management Console protection
operations, SnapManager activity, or SnapDrive activity.
Easy identification of source and secondary volumes in case of application shutdown
If the database application that is generating the backed up data shuts down, the naming formats
of the associated Snapshot copy, secondary volume, or secondary qtree objects, if set properly,
enable you to identify primary volumes from the names of the secondary volumes and Snapshot
copies that are associated with that application.
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Custom naming and storage management tasks
If you are a storage administrator, configuration of custom naming enables you to specify a
company-wide naming convention for related objects at the global level or at the dataset level.
Custom naming and application management tasks
If you are an application administrator and have specified a particular dataset in which to store data
generated by a particular application, custom naming enables you to specify distinctive naming
conventions for that dataset's related object types. The distinctive naming enables you to track the
objects that are generated by that application more easily.
Naming settings by format strings
The NetApp Management Console naming settings enable you to enter custom format strings that
contain letter attributes for identifying information to include in the names of protection-related
objects.
The attributes that you can include in the format strings cause such identifying characteristics as
timestamps, storage system names, custom labels, dataset names, and retention type to be included in
the name of a protection-related object type.
Snapshot copy naming settings
Snapshot copy naming settings determine how Snapshot copies that are generated by NetApp
Management Console protection jobs are named.
Default Snapshot copy naming format
The default global naming attribute format for Snapshot copies generated by NetApp Management
Console protection operations is %T_%R_%L_%H_%N_%A (Timestamp_Retention
type_Custom label_Storage system name_Volume name_Application field).
This format applies to the naming of all Snapshot copies generated by NetApp Management Console
protection operations.
Snapshot copy naming attributes
Snapshot copy names can be configured to contain the following attributes:
%T (Timestamp)

Indicates the year, month, date, and time of the Snapshot copy. Timestamp
is in the format yyyy-mm-dd_hhmm (along with UTC offset).

%R (Retention type) Indicates whether the Snapshot copy's retention class is hourly, daily,
weekly, monthly, or unlimited.
%L (Custom label)

Enables you to specify a custom alphanumeric character, . (period), _
(underscore), or - (hyphen), to include in the names of the related objects
that are generated by protection jobs that are run on this dataset. If the
naming format for a related object type includes the Custom label
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attribute, then the value that you specify is included in the related object
names. If you do not specify a value, then the dataset name is used as the
custom label. If you include a blank space in the custom label string, the
blank space is converted to letter x in any Snapshot copy, volume, or qtree
object name that includes the custom label as part of its syntax.
%H (Storage system Indicates the name of the storage system that contains the volume from
which a Snapshot copy is made.
name)
%N (Volume name)

Indicates the name of the volume from which a Snapshot copy is made.

%A (Application
fields)

Indicates application-inserted fields. For the NetApp Management Console
data protection capability, it is a list of qtrees present in the volume from
which a Snapshot copy is made.

%1 (One-digit
suffix), %2 (Twodigit suffix), or %3
(Three-digit suffix)

Specifies a one-digit, two-digit, or three-digit suffix if required to
distinguish Snapshot copies.

Example: Snapshot copy custom naming
If a dataset has a custom label of "my_data," includes a volume named "myVol" on a storage
system named "mgt-u35," and is configured for Hourly backup, then the following Snapshot
copy format strings result in the following names for the resulting Snapshot copies:
Format string

Resulting name

%L_%R_%T_%H

my_data_hourly_2010-03-04_0330+0430_mgt-u35

%T_myunit_%L-mysection-%R 2010-03-04_0330_myunit_my_data-mysection-hourly
myunit-mydept-%R_%H_%T

myunit-mydept-hourly_mgt-u35_2010-03-04_0403-0800

%R_%T_%N_%A

hourly_2010-03-04_0330_myVol_qtree1_qtree2_qtree3

%T

2010-03-04_0330 (if no UTC offset)
2010-03-04_0330+0530 (for IST)

%L_%R_%H_%2

my_data_hourly_mgt-u35_01
my_data_hourly_mgt-u35_02

Snapshot copy naming exceptions
The following are Snapshot copy naming exceptions:
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•

•

•
•
•

•

•

•

When a SMHV plug-in creates a Snapshot copy in a host system, the plug-in creates two
Snapshot copies for every backup.
The second Snapshot copy has the string "_backup" appended to the end of the Snapshot copy
name irrespective of the order of attribute selection.
When a SMHV plug-in creates a Snapshot copy, and the Snapshot copy name exceeds the SMHV
Snapshot copy character limit, the SMHV plug-in does not truncate the name by removing the
characters of the Application fields attribute.
Instead, it truncates the name by removing characters before the Application fields
attribute, from right to left.
For Snapshot copies created by a SMHV plug-in, if the Application fields attribute is not
specified, it is added automatically at the end of the naming format.
For Snapshot copies created by a SMVI plug-in, if the Application fields attribute is not
specified, it is not added to the naming format.
For Snapshot copies created by the NetApp Management Console data protection capability, if
the Application fields attribute is not mentioned, it is not added implicitly in the naming
format.
When SMVI plug-in creates a Snapshot copy, and the Snapshot copy name exceeds the SMVI
Snapshot copy character limit, SMVI plug-in does not truncate the name by removing the
characters of the Application fields attribute.
Instead, it truncates the name by removing characters before the Application fields
attribute, from right to left.
If you want to use scripts to generate the Snapshot copy name, and if the Snapshot copy is
generated by the SnapManager plug-in in the host system, the plug-in does not use the user script.
Instead, the plug-in uses the global naming format to create the Snapshot copy name. The user
script is used only if the Snapshot copy is created by the NetApp Management Console data
protection capability.
Snapshot copies created by the host system are in the local time zone of the host system.

Snapshot copy naming restrictions
The following are Snapshot copy naming restrictions:
•
•
•

•
•
•

The timestamp attribute is mandatory.
The Application fields attribute is mandatory in the custom Snapshot copy naming for all
application datasets controlled by the SMHV plug-in Host services.
The Snapshot copy name can only display ASCII alphanumeric characters, _ (underscore), (hyphen), + (plus sign), and . (dot).
Any other characters cause errors.
If there is no custom label for the dataset, the Snapshot copy name defaults to the dataset name.
UTF-8 encoded characters are not supported.
Including four digits reserved for suffixes, a Snapshot copy name cannot exceed 128 characters.
The Snapshot copy name, excluding the suffixes, can be no more than 124 characters. If the
generated Snapshot copy name exceeds 124 characters, then the name is truncated by removing
characters from right to left.
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To avoid possible truncation of timestamp information from the Snapshot copy name, best
practice is to place the timestamp %T attribute at the left end of the format string.
Primary volume naming settings
Primary volume naming settings determine how primary storage volumes generated by NetApp
Management Console provisioning operations are named.
Default primary volume naming format
The default global naming format for primary volumes generated by NetApp Management Console
provisioning operations is %L (Custom label).
The global format applies to the naming of all NAS primary volumes generated by NetApp
Management Console provisioning operations. The default global naming format does not apply to
SAN volumes, because they are named directly at the time of provisioning.
Primary volume naming attributes
Primary volume names can be configured to contain the following attributes:
%L (Custom
label)

Enables you to specify a custom alphanumeric character, . (period), _
(underscore), or - (hyphen) to include in the names of the related objects that
are generated by protection jobs that are run on this dataset. If the naming
format for a related object type includes the Custom label attribute, then the
value that you specify is included in the related object names. If you do not
specify a value, then the dataset name is used as the custom label. If you
include a blank space in the custom label string, the blank space is converted to
letter x in any Snapshot copy, volume, or qtree object name that includes the
custom label as part of its syntax.

%D (Dataset
name)

Indicates the actual name of the dataset in which a volume is created.

%1 (One-digit
suffix), %2
(Two-digit
suffix), or %3
(Three-digit
suffix)

Displays a one-digit, two-digit, or three-digit suffix if required to distinguish
primary volumes.

Example: Primary volume custom naming
If a dataset named "mydataset" has a custom label of "mydata", and a new volume is
provisioned through NetApp Management Console, then the following primary volume format
strings result in the following names for the resulting primary volumes:
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Format string

Resulting name

%L_%D

mydata_mydataset

%L

mydata

pri_%L

pri_mydata

myunit-privol

myunit-privol

%L_%D_%3

mydata_mydataset_001
mydata_mydataset_002

Primary volume naming exceptions
The following are primary volume naming exceptions:
•
•

If the primary volume's naming format in one or more datasets is customized, then the primary
volumes generated in those datasets are named according to the dataset-level format.
For a primary volume to be provisioned, if you specify the primary volume name from the
NetApp Management Console user interface, then the name that you specify in the user interface
takes precedence over the options for primary volume naming settings.

Primary volume naming restrictions
The following are the naming restrictions of primary volume:
•
•
•
•
•

•

All naming attributes are optional.
At least one attribute must be enabled at any point of time, or there should be some free-form
text.
In case of name conflict, numerical suffixes are appended to the names.
If the Custom label attribute is included in the naming format, but no custom name exists for a
dataset, the resulting names use the actual dataset name instead.
Including four digits reserved for suffixes, a primary volume name cannot exceed 64 characters.
The primary volume name, excluding the suffixes, can be no more than 60 characters. If the
generated primary volume name exceeds 60 characters, then the name gets truncated by removing
characters from left to right.
The primary volume name can only display ASCII alphanumeric characters and _ (underscore).
Any other characters cause errors. The primary volume name cannot start with a number.
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Secondary volume naming settings
Secondary volume naming settings determine how secondary storage volumes that are generated by
NetApp Management Console protection operations are named.
Default secondary volume naming format
The default global naming format for secondary volumes generated by NetApp Management Console
protection operations is %V (Primary volume name).
This format applies to the naming of all secondary volumes generated by NetApp Management
Console protection operations.
Secondary volume naming attributes
Secondary volume names can be configured to contain the following attributes:
%L (Custom label)

Enables you to specify a custom alphanumeric character, . (period), _
(underscore), or - (hyphen) to include in the names of the related objects that
are generated by protection jobs that are run on this dataset. If the naming
format for a related object type includes the Custom label attribute, then
the value that you specify is included in the related object names. If you do
not specify a value, then the dataset name is used as the custom label. If you
include a blank space in the custom label string, the blank space is converted
to letter x in any Snapshot copy, volume, or qtree object name that includes
the custom label as part of its syntax.

%C (Type)

Indicates the connection type (backup or mirror).

%S (Primary
storage system
name)

Indicates the name of the primary storage system.

%V (Primary
volume name)

Indicates the name of the primary volume.

%1 (One-digit
suffix), %2 (Twodigit suffix), or %3
(Three-digit suffix)

Displays a one-digit, two-digit, or three-digit suffix if required to distinguish
secondary volumes.

Example: Secondary volume custom naming
If a dataset has a custom label of "mydata," includes a primary volume named "myVol1" on a
primary storage system named "myhost1," and is configured for Hourly backup, then the
following secondary volume format strings result in the following names for the resulting
secondary volumes:
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Format string

Resulting name

%L_C_%S_%V

mydata_backup_myhost1_myVol1

%C-%S-%L-destVol

backup_myhost1_mydata_destVol

%C_%L

backup_mydata

%V

myhost1

%C_%L_%1

backup_mydata_1
backup_mydata_2

Secondary volume naming exceptions
The following is secondary volume naming exception:
•

If secondary volume's naming format in one or more datasets is customized, then the secondary
volumes generated in those datasets are named accordingly.

Secondary volume naming restrictions
The following are secondary volume naming restrictions:
•
•
•
•

•
•

•

All naming attributes are optional.
At least one attribute must be enabled at any point of time, or there must be some free-form text.
In case of name conflict, numerical suffixes are appended to the names.
If the Fan-in feature is enabled for a backup destination, and two or more qtrees from different
primary volumes are backed up into the same secondary volume, then the Primary storage
system name and Primary volume name attributes of the source volumes are randomly
selected to form the names of the secondary volumes.
For example, if host1:/vol1/qtr1, host2:/vol2/qtr2, and host3:/vol3/qt3 are backed up to one
secondary volume, then all the names for the secondary qtrees in that volume include one
common <Host name> and <Volume name> attribute combination character string. That
common string is either: "host1_vol1", "host2_vol2," or "host3_vol3."
If the Custom label attribute is included in the naming format, but no custom name exists for a
dataset, the resulting names use the actual dataset name instead.
Including four digits reserved for suffixes, a secondary volume name cannot exceed 64
characters.
The secondary volume name, excluding the suffixes, can be no more than 60 characters. If the
generated secondary volume name exceeds 60 characters, then the name gets truncated by
removing characters from left to right.
The secondary volume name can only display ASCII alphanumeric characters and _ (underscore).
Any other characters cause errors. The secondary volume name cannot start with a number.
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•

When taking a backup of Open Systems SnapVault (OSSV) directories, if you include %V
(Primary volume name) attribute in the naming format, %V will be replaced with %S
(Primary storage system name).
This is because OSSV does not have the concept of volume.

Secondary qtree naming settings
Secondary qtree naming settings determine how secondary storage qtrees that are generated by
NetApp Management Console protection operations are named.
Default secondary qtree naming format
The default global naming format for secondary qtrees generated by NetApp Management Console
protection operations is %Q (Primary qtree name).
This format applies to the naming of all secondary qtrees generated by NetApp Management Console
protection operations.
Secondary qtree attributes
Secondary qtree names can be configured to contain the following attributes:
%Q (Primary qtree The name of the primary qtree.
name)
%L (Custom label)

Enables you to specify a custom alphanumeric character, . (period), _
(underscore), or - (hyphen) to include in the names of the related objects
that are generated by protection jobs that are run on this dataset. If the
naming format for a related object type includes the Custom label
attribute, then the value that you specify is included in the related object
names. If you do not specify a value, then the dataset name is used as the
custom label. If you include a blank space in the custom label string, the
blank space is converted to letter x in any Snapshot copy, volume, or qtree
object name that includes the custom label as part of its syntax.

%S (Primary
storage system)

Indicates the name of the primary storage system.

%V (Primary
volume name)

Indicates the name of the primary storage volume.

%1 (One-digit
suffix), %2 (Twodigit suffix), or %3
(Three-digit suffix)

Displays a one-digit, two-digit, or three-digit suffix if required to distinguish
secondary qtrees.

Example: Secondary qtree custom naming
If a dataset has a custom label of "mydata," includes a primary qtree named "qtree1", and
primary volume named "myVol1" on a primary storage system named "myhost1," and is
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configured for Hourly backup, then the following secondary qtree format strings result in the
following names for the resulting secondary qtrees:
Format string

Resulting name

%L_%S_%V_%Q

mydata_myhost1_myVol1_qtree1

%L_%S_%Q

mydata_myhost1_qtree1

%V_%Q

myVol1_qtree1

%L_%S_%V_%Q_%3

mydata_myhost1_myVol1_qtree1_001
mydata_myhost1_myVol1_qtree1_002

Secondary qtree naming exceptions
The following is secondary qtree naming exception:
•

If secondary qtree naming format in one or more datasets is customized, the secondary qtrees
generated in those datasets are named accordingly.

Secondary qtree naming restrictions
The following are secondary qtree naming restrictions:
•
•
•
•
•

•

•

•

•

All naming attributes are optional.
At least one attribute must be enabled at any point of time, or there must be some free-form text.
In case of name conflict, numerical suffixes are appended to the names.
If the Custom label attribute is included in the naming format, but no custom name exists for a
dataset, the resulting names use the actual dataset name instead.
Including four digits reserved for suffixes, a secondary qtree name cannot exceed 64 characters.
The secondary qtree name, excluding the suffixes, can be no more than 60 characters. If the
generated secondary qtree name exceeds 60 characters, then the name gets truncated by removing
characters from left to right.
The secondary qtree name can only display ASCII alphanumeric characters, _ (underscore), (hyphen), and . (dot).
Any other characters cause errors.
When taking a backup of Open Systems SnapVault directories, if you include the Primary
volume name attribute in the naming format, it is replaced by the Primary storage system
attribute.
When taking a backup of Open Systems SnapVault directories, if you include the Primary
qtree name attribute in the naming format, it is replaced by the path of the root directory.
The characters of the root directory path that are not supported are converted to the letter x.
When taking a backup of Open Systems SnapVault directories, if you include the Primary
qtree name attribute in the naming format, and if the directory path contains non-ASCII

94 | Provisioning and Data Protection Online Help
characters, or if the directory path is / (slash), then the Primary qtree name attribute is
replaced with the directory ID.

Configuring datasets
In general, you use a wizard to configure datasets and you use an editing window to modify property
values.
Decisions to make before adding datasets of physical storage objects (for protection)
Before you create a new dataset of physical storage objects, considering some preconfiguration
questions can help you choose a dataset name, how related objects generated for this dataset are
named, and what kind of protection and resources are assigned to the dataset's members.
Dataset
properties

•

Is there a dataset naming convention that you can use to help administrators
easily locate and identify datasets?
Dataset names can include the following characters but cannot be only
numeric:
a to z
A to Z
0 to 9
. (period)
_ (underscore)
- (hyphen)
space

•

•
•

•

Dataset
naming
properties

•

If you use any other characters when naming the dataset, they do not appear in
the name.
What is a good description of the dataset membership?
Use a description that helps someone unfamiliar with the dataset to understand
its purpose.
Who is the owner of the dataset?
If an event on the dataset triggers an alarm, who should be contacted?
You can specify one or more individual e-mail addresses or a distribution list
of people to be contacted.
If dataset members exist in multiple time zones, which time zone do you want
to use to schedule operations on the dataset?
You can specify a time zone in the wizard or use the default time zone, which
is the system time zone used by the DataFabric Manager server.
Do you want to use the actual dataset name or a custom label in your datasetlevel Snapshot copy, primary volume, secondary volume, or secondary qtree
naming?
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Group
membership

•

For customizing the naming settings of object types, do you want the current
default naming format to apply to one or more object types that are generated
in this dataset?
If you want to customize the dataset-level naming formats for one or more
object types, in what order do you want to enter the naming attributes for
Snapshot copy, primary volume, secondary volume, or secondary qtree?

•

Do you need to create a group of datasets and resource pools based on
common characteristics, such as location, project, or owning organization?
Is there an existing group to which you want to add this dataset?

•
Resources for
primary
storage

Will you assign a resource pool or individual physical resources as destinations
for your primary storage?
If using a resource pool, consider the following details:
•
•
•

For the primary node in the dataset, which resource pool meets its provisioning
requirements?
If no resource pool meets the requirements of the primary node, you can create
a new resource pool for each node at the Resource Pools window.
Verify that you have the appropriate software licenses on the storage you
intend to use.

If using individual resources, consider the following details:
•
•
Protection
policy

After you create a new dataset of physical objects, you protect it by running the
NetApp Management Console Dataset Policy Change wizard to assign a
protection policy.
•

•

Resources for
secondary or
tertiary
storage

If you prefer not to use resource pools for automatic provisioning, you can
select individual physical resources as members of your dataset.
Verify that you have the appropriate software licenses on the storage you
intend to use.

Which protection policy meets the requirements of the dataset?
Review the policies listed on the Protection Policies window to see if any are
suitable for your new dataset.
If no protection policy meets the requirements of your new dataset, is there a
protection policy that would be suitable with minor modifications?
If so, you can copy that protection policy to create a new policy you can
modify as needed for the new dataset. If not, you can run the Add Protection
Policy wizard to create a new policy for the dataset.

When you assign a protection policy, will you assign a resource pool or individual
physical resources as destinations for your backups and mirror copies?
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You do not have to assign a resource pool or physical resources to a node to create
a new dataset. However, the dataset will be nonconformant with its policy until
resources are assigned to each node, because the NetApp Management Console
data protection capability cannot perform the protection specified by the policy.
If using a resource pool:
•

•
•

For the secondary or tertiary nodes in the dataset, which resource pool meets
their provisioning requirements?
For example, the resource pool you assign to a mirror node should contain
only physical resources that would be acceptable destinations for mirror copies
created of the dataset members.
If no resource pool meets the requirements of a node, you can create a new
resource pool for each node at the Resource Pools window.
Verify that you have the appropriate software licenses on the storage you
intend to use.

If using individual resources:
•

•

If you prefer not to use resource pools for automatic provisioning, you can
select individual physical resources as destinations for backups and mirror
copies of your dataset.
Verify that you have the appropriate software licenses on the storage you
intend to use.

Related concepts

Effect of time zones on schedules on page 220
What a protection policy does on page 190
Overview of resource pools on page 64
Protection policy node prerequisites on page 195
What a provisioning policy is on page 600
Related references

Administrator roles and capabilities on page 54
Decisions to make before adding datasets of physical storage objects (for provisioning)
You must gather certain provisioning information before you use the Add Dataset wizard to create a
new dataset of physical storage objects. A dataset can have a single node or, if you assign a

Protection Help | 97
protection policy to it, a dataset can have a primary and one or more nonprimary nodes. When you
first create a dataset, you configure the provisioning for the primary node only.
Provisioning
policy for
primary node

Do you want to assign a provisioning policy to manage the storage resources, or
do you want to manually assign resources?
•

•

•

If you want to use a provisioning policy, have you already configured a
policy that meets the requirements of the data in the dataset primary node?
Review any existing policies that are listed in the Provisioning Policies
window to see if any are suitable for your new dataset.
If no current provisioning policy meets the requirements of your new dataset,
is there a policy that would be suitable with minor modifications?
If so, you can copy that policy and then modify it as needed. If no suitable
provisioning policy exists, you can run the Add Provisioning Policy wizard to
create a new policy.
If you do not want to assign a provisioning policy at the time the dataset is
created, you can assign a provisioning policy to the primary node later.
Note: After the dataset is added, whether or not it has a provisioning policy
assigned, you can also provision new members for the dataset by using the
Provisioning wizard.

•

•

If you assign a NAS-based provisioning policy, do you want to enable CIFS
or NFS export protocol access to the members of this dataset node?
You can enable one or both export protocols for all members of this node
when you configure the dataset. You can also decline to enable export
protocols at the dataset node level and later enable export protocols for
individual members as you provision them into this dataset.
However, you cannot enable CIFS export protocol access if the assigned
provisioning policy is configured for the options "Guarantee space for dataset
and Snapshot copies" (which is displayed in the Provisioning Policies
window as "Guarantee space for dataset") and ""Guarantee initial size,
allocate maximum size on-demand and allow automatic deletion of Snapshot
copies" (which is displayed in the Provisioning Policies window as "Increase
container size automatically").
If you assign a SAN-based provisioning policy, do you want to enable FC or
iSCSI export protocol access to the members of this dataset node?
You can enable either protocol for all members of this node when you
configure the dataset, or you can decline to enable export protocols at the
dataset node level and later enable export protocols for individual members as
you provision them into this dataset.

Do you want to attach a vFiler unit to the dataset to enable data migration?
vFiler unit
assignment and
Attaching a vFiler unit is necessary to support both offline migration and online
data migration
migration.
capability
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•

•

Nonprimary
dataset nodes

If you want to create a new vFiler unit for this purpose, what IP address and
network mask do you want to assign to it?
If you want to assign an existing vFiler unit to the dataset for this purpose,
what is the name of that unit?
Do you want to enable online migration on the dataset?
Online migration is migration of data from source to destination without
disrupting user access to the data being migrated.

After the dataset is created, if the dataset has a secondary backup or mirror node,
you can edit the dataset node to assign a provisioning policy to a nonprimary
node.
•

If you want to create a new vFiler unit, what IP address and network mask do
you want to assign to it?
Note: A vFiler unit created on secondary or tertiary nodes does not support
migration.

•

If you associate a vFiler unit with a nonprimary node in a dataset, any
volumes that are provisioned for that dataset must be also associated with the
vFiler unit.
Therefore, when you view a list of the dataset volumes, only volumes that are
owned by the vFiler unit are displayed.
Note: You cannot associate a vFiler unit with a nonprimary node unless it
is a disaster recovery-capable nonprimary node.

•

•
•

•

If you want to assign a NAS or SAN type provisioning policy instead of a
secondary type policy to a nonprimary node, the dataset must be disaster
recovery-capable.
The dataset must have a protection policy assigned that supports disaster
recovery, and the nonprimary node must be a disaster recovery-capable node.
The policy type (NAS or SAN) on the primary dataset node must match the
policy type assigned to the nonprimary node.
If you assign a NAS-based provisioning policy, do you want to enable CIFS
or NFS export protocol access to the members of this dataset node?
You can enable one or both export protocols for all members of this node
when you configure the dataset. Alternatively, you can decline to enable
export protocols at the dataset node level and later enable export protocols for
individual members as you provision them into this dataset.
If you assign a SAN-based provisioning policy, do you want to enable FC or
iSCSI export protocol access to the members of this dataset node?
You can enable either export protocol for all members of this node when you
configure the dataset. Alternatively, you can decline to enable export
protocols at the dataset node level and later enable export protocols for
individual members as you provision them into this dataset.

Protection Help | 99
Note: You should not use a version earlier than SnapDrive for Windows 5.0 to connect to mapped
LUNs that are provisioned through the NetApp Management Console provisioning capability.
Doing so might result in an error, after which you must manually unmap the LUNs.
Related concepts

Effect of time zones on schedules on page 220
What a protection policy does on page 190
What a provisioning policy is on page 600
Overview of resource pools on page 64
Protection policy node prerequisites on page 195
What gets migrated with a dataset on page 548
Overview of export protocol properties on page 112
Related references

Dataset migration requirements on page 547
Adding a dataset of physical storage objects
You can include multiple physical storage objects in a dataset for managing the protection
requirements or provisioning the storage space and hardware requirements of those objects as a
group.
Before you begin

•
•
•

You must have the protection information that you require to complete this task.
You must have the provisioning information that you require to complete this task.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
•
•

To assign a policy, you must be assigned a role that enables you to view policies.
To assign a provisioning policy, you also need a role that enables you to attach the resource
pools configured for the policy.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add to start the Add Dataset wizard.
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If you want to provision your node by resource pool, click the Provision and attach resources
using a policy option when it is displayed.
If you want the dataset to have online migration capability, select a provisioning policy that is
configured for that capability.
If you receive a message that the maximum number of vFiler units has been reached, to configure
an IP address and network mask that enables the migration capability on an additional dataset,
you must first disable migration capability for one or more existing migration capable datasets.
3. Complete the steps in the Add Dataset wizard to create a dataset.
Result

The new dataset is listed in the Datasets tab.
After you finish

To provide protection for your new dataset, assign it a protection policy or a disaster recoverycapable protection policy.
Related concepts

Decisions to make before adding datasets of physical storage objects (for protection) on page 94
Decisions to make before adding datasets of physical storage objects (for provisioning) on page 96
Effect of time zones on schedules on page 220
Related references

Administrator roles and capabilities on page 54
Decisions to make before assigning or changing policies
Before you assign or change a policy, you need to gather information about the dataset and policies
that you want the dataset to have.
You need to gather the following information:
Protection
policy

•

•

Which protection policy meets the requirements of the dataset?
Review the policies listed on the Protection Policies window to see if any is
suitable for your new dataset.
If no protection policy meets the requirements of your new dataset, is there a
protection policy that would be suitable with minor modifications?
If so, you can copy that protection policy to create a new policy you can
modify as needed for the new dataset. If no suitable protection policy exists,
you can run the Add Protection Policy wizard to create a new policy for the
dataset.
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Disaster
recovery
policy

•

What type of disaster recovery capable protection policy do you need?
The NetApp Management Console data protection capability provides disaster
recovery capable protection policies that function similarly to the backup
policies.
Note: When you change a policy from backup to mirror or mirror to backup,
the Dataset Policy Change wizard prompts you to establish a new baseline
for the relationship. If you do, old data is retained, and the NetApp
Management Console data protection capability makes a new copy of the
entire dataset and transfers the active file system on the secondary. After
reinitialization, you can manually delete the Snapshot copy.

•

•

Backup and
mirror node
resources

•

•

•

If you are changing the protection policy to a disaster recovery policy, do you
want to map the settings from a node in the old dataset to a node in the new
dataset?
You should copy the settings only if the path from the primary node is the same
in the new policy as it was in the old policy.
Do you plan to use a failover script to shut down processes before the NetApp
Management Console data protection capability invokes failover?
If so, you need to define the path to a failover script.
If you are changing the protection policy for a dataset with backup and mirror
nodes, do you want to use the same resource assignments that were used in the
previous policy?
For example, if you have a dataset using the Mirror policy and you want to
change to the Chain of two mirrors policy, you can choose to copy resources
used for the single mirror node in the current policy to one of the two mirror
nodes in the new policy. After you have copied resources from a node in the
current policy, you cannot copy resources from that same node to any other
node in the new policy.
If you are assigning a policy for the first time or if you do not want to copy
resources used in the current policy, is there a resource pool that meets the
provisioning requirements of the dataset?
For example, the resource pool you assign to a mirror node should contain
physical resources that would all be acceptable destinations for mirror copies
created of the dataset members. If no resource pool meets the requirements of a
nonprimary node, you can create a new resource pool for each backup and
mirror node using the Add Resource Pool wizard.
If you prefer to not use resource pools for automatic provisioning, which
physical resources would be suitable as destinations for backups and mirror
copies of the dataset?
You do not have to assign a resource pool or physical resources to a destination
node to assign or change a policy. However, the dataset will be nonconformant
with its new policy until resources are assigned to each destination node,
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because the NetApp Management Console data protection capability cannot
carry out the protection specified by the policy.
Provisioning
policy

•

•

•

On which node do you want to assign or change the provisioning policy?
Your dataset might have a primary and one or more nonprimary nodes. You
can assign the same provisioning policy to every node in the dataset, or you can
assign a different provisioning policy to each node.
Which provisioning policy meets the requirements of the dataset node?
Review the policies listed on the Provisioning Policies window to see if any is
suitable for the dataset node.
If you are changing the provisioning policy, the policy type (NAS or SAN) on
the primary dataset node must match the policy type assigned to the
nonprimary node. If you want to assign a NAS or SAN type provisioning
policy instead of a secondary type policy to a nonprimary node, the dataset
must be disaster recovery capable. This means that it must also have a
protection policy assigned that supports disaster recovery, and the node must be
the disaster recovery capable node.
If no provisioning policy meets the requirements of the dataset node, is there a
provisioning policy that would be suitable with minor modifications?
If so, you can copy that policy to create a new policy that you can modify as
needed. If not, you can run the Add Provisioning Policy wizard to create a new
policy for the dataset node.

Related concepts

What a protection policy does on page 190
Overview of resource pools on page 64
Assigning or changing a protection policy
You can assign a policy to a dataset or change the policy assigned to it. The policy specifies how the
data is to be protected.
Before you begin

•

You must have gathered the protection information that you need to complete this task:

•

• Dataset properties
• Group membership
• Protection policy
Determine which policy you want to assign to the dataset. You can review available protection
policies on the Protection Policies window.
If no policy meets the requirements of your new dataset, you can create a new policy or modify a
copy of an existing policy.
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•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

•

You can use this procedure after you have created a new dataset and want to assign a policy to it,
or when you want to change the protection policy assigned to a dataset. You can also use this
procedure to protect a dataset that is listed on the Datasets window
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Any dataset that you directly assign a protection policy or provisioning policies and resource
pools directly through NetApp Management Console is displayed as a dataset of physical storage
objects.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Protection Policy to start the Dataset Policy Change wizard.
If you want to provision your nodes by resource pool, click the Provision and attach resources
using a policy option when it is displayed.
3. Complete the steps in the wizard.
Related concepts

Decisions to make before assigning or changing policies on page 100
What a protection policy does on page 190
Related references

Administrator roles and capabilities on page 54
Assigning or changing a provisioning policy
You can assign a provisioning policy to a dataset node or change the currently assigned provisioning
policy assigned to a dataset node.
Before you begin

•

•

Have the provisioning information available that you need to complete this task:
• Provisioning policy for primary node
• Migration capability
• vFiler unit assignment
• Provisioning policy for nonprimary dataset nodes
Determine which policy you want to assign to the dataset node. You can review available
provisioning policies listed in the Provisioning Policies window.
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•

If no provisioning policy meets the requirements of your dataset node, you can create and modify
a copy of an existing policy or create a new policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Any dataset that you directly assign a protection policy or provisioning policies and resource pools
directly through NetApp Management Console is displayed as a dataset of physical storage objects.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset to which you want to assign or change the provisioning policy and click Edit.
3. In the Edit Dataset window, click Provisioning/Resource Pools for the node to which you want
to assign or change the provisioning policy.
4. On the Edit Provisioning and Resource Pools page, select a provisioning policy and click Next.
5. Continue to click Next until you reach the Preview Details page.
NetApp Management Console performs a trial run of your requested changes and generates a
report describing the impact of those changes.
6. After you are satisfied with the preview results, click Next to apply your changes to the dataset,
then click Finish.
7. Close the Edit Dataset window.
Related references

Administrator roles and capabilities on page 54
Decisions to make before provisioning additional containers for a dataset
Before you use the Provisioning wizard to provision an additional volume, qtree, or LUN to an
existing primary dataset node, you need to gather the information required to complete the wizard.
Prerequisites

Does the dataset that you are trying to provision have a resource pool assigned to
it?
If not, you need to assign a resource pool before provisioning the node. You can
check the resource pool assignment on the Datasets window Overview tab.
Does the dataset that you are trying to provision have a provisioning policy
assigned to it?
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If not, you need to assign a provisioning policy before provisioning the node. You
can check the provisioning policy assignment on the Datasets window Overview
tab.
Note: You are advised not to use SnapDrive for Windows versions earlier than
5.0 to connect to mapped LUNs that are provisioned through the NetApp
Management Console provisioning capability. Doing so might result in an error
that requires the LUNs to be manually unmapped.

Name

What is the export name of the volume or LUN that you want to provision?
The export name (NFS or CIFS protocol for NAS storage, or iSCSI or FC protocol
for SAN storage) is created with the name you specify.

Description

What is the description of this provisioning request?
This information can be useful later: for example, if you want to track
provisioning requests against IT helpdesk tickets.

Size

What is the size of the qtree, volume or LUN?
•
•

The minimum LUN size for Windows is 32 MB. For other operating systems it
is 4 MB.
The actual size that is provisioned is determined by the size that you specify in
the wizard and by the provisioning policy that is assigned to the dataset node.
•

•

NAS storage example
If you enter a maximum size of 20 GB in the wizard and the provisioning
policy that is assigned to the dataset enables the Reserve space for Snapshot
copies option, then the NetApp Management Console provisioning
capability allocates 24 GB for the newly provisioned storage. If the
provisioning policy does not enable the option for guaranteed space for
data and Snapshot copies, the NetApp Management Console provisioning
capability does not allocate space until the space is actually used. In this
case, the total size refers only to the potential size that can be used, but the
space is not guaranteed.
SAN storage example
If you enter 50 GB for the data size and 50 GB for the maximum Snapshot
copy size, and if the provisioning policy that is assigned to the dataset
enables the option to guarantee space for data and Snapshot copies, the
NetApp Management Console provisioning capability adds 50 GB for the
overwrite reserve space and allocates a total of 150 GB for the volume.

What is the maximum space for Snapshot copies?
•

If you are provisioning a LUN, what is the maximum amount of space in the
volume that Snapshot copies can use?
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•

Override
exports

If you are provisioning a volume or qtree, what is the maximum amount of
space in the resource pool that the volume or qtree can use?
When calculating the amount, include all of the LUNs, space reserves, and
Snapshot copy space that the resource pool contains.

Which, if any, export protocol access do you want to enable for the volume, LUN,
or qtree that you are provisioning?
This decision applies only if you have not already enabled an export protocol on
the entire dataset into which you are provisioning the volume, LUN, or qtree.
•
•

Resource
selection

If you are provisioning NAS storage, do you want to enable NFS export
access, CIFS export access, or both?
If you are provisioning SAN storage, do you want to enable iSCSI export
access or FC export access?

How do you want to select the resource to provision into this dataset?
•
•

Do you want the NetApp Management Console provisioning capability to
automatically provision a resource from the assigned resource pool?
Do you want to manually select the resource from the assigned resource pool?
For example, when provisioning LUNs in a SAN environment, you might need
to manually select a specific storage system from the resource pool if the host
for which you are provisioning the LUNs has access only to that particular
storage system.

Related concepts

Overview of export protocol properties on page 112
Provisioning additional containers for a primary dataset node
You can provision an additional volume, qtree, or LUN to the primary dataset node when you need to
add more containers to an existing dataset.
Before you begin

•

•

You must have gathered the provisioning information that that you need to complete this task:
• Provisioning policy for primary node
• Migration capability
• vFiler unit assignment
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
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About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. From the menu bar, click Data > Datasets > Provisioning.
2. Select the dataset that you want to provision with additional containers.
3. Click Provision to start the Provisioning wizard.
•

•

If you want to manually select a specific aggregate to provision the additional containers,
click "Manually select a resource from the attached resource pool(s)" when the wizard
displays the Resource selection panel, and select a specific storage system or aggregate from
the resource pool trees display.
If you want the wizard to automatically provision the additional containers, click "Allow the
system to automatically select a resource from the attached resource pool(s)".

4. On the Preview page, if any errors are displayed, click Back to return to previous pages in the
wizard and correct the errors.
The Preview page displays the results of a trial run of your provisioning request. Any potential
errors are described and suggestions for resolving them are provided.
5. Complete the steps in the wizard and click Next in the Preview page to commit the provisioning
request.
The provisioning request is sent to the server. The progress of the job is shown in the progress
bar. When the job completes, the Provisioning to the dataset summary page on the wizard
confirms the completion.
Result

If you do not want to wait for the job to complete, you can close the wizard and processing continues
in the background. You can monitor the progress of the provisioning job in the Jobs window.
When the job is done and the new volume is added, the NetApp Management Console provisioning
capability compares the attributes of the volume to the provisioning policy assigned to the node, if
any. If the new dataset member is out of conformance, the dataset status changes to Error and the
conformance status for the dataset member changes to Nonconformant.
Related concepts

Decisions to make before provisioning additional containers for a dataset on page 104
Related references

Administrator roles and capabilities on page 54
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When to provision an additional container with a specific aggregate or storage system
When using the Provisioning wizard to add a new volume, qtree, or LUN container in the primary
node of an existing dataset, you can provision that container with a specific aggregate or storage
system from its assigned resource pool rather than having the Provisioning wizard automatically
provision aggregates or storage systems from that resource pool.
For example, when provisioning additional LUNs in a SAN environment, you might need to
manually select a specific storage system from resource pool if the host that you are provisioning the
LUNs for has access to only that specific storage system.
Related concepts

Decisions to make before provisioning additional containers for a dataset on page 104
Related tasks

Provisioning additional containers for a primary dataset node on page 106
Related references

Administrator roles and capabilities on page 54
Decisions to make before adding or changing resource assignments
Before you add or change the physical resources assigned to an existing dataset node, you need to
gather the required information.
•

•

•

For each node in the dataset, which resource pool meets its protection or provisioning
requirements?
For example, if you have the NetApp Management Console data protection capability, the
resource pool you assign to a mirror node should contain physical resources that are appropriate
for mirrored copies of the dataset.
If you have the provisioning or protection capabilities, the resource pool you assign to a dataset
node should contain physical resources that are appropriate and large enough for the provisioning
needs of the data contained in the dataset node.
What if there are no resource pools that meet the protection or provisioning requirements of the
dataset node?
If no resource pool meets the protection or provisioning requirements of a dataset node, you can
use the Resource Pools window to create a new resource pool for each node.
If you have the NetApp Management Console data protection capability with disaster recovery,
can you choose not to use resource pools?
You can select physical resources for the backup and mirror nodes of your dataset. If you choose
to select storage outside of a resource pool, the NetApp Management Console data protection
capability does not create volumes but instead uses the volumes you select for that dataset node.
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•

You can manually provision your dataset. If you choose to provision your dataset on storage
outside of a resource pool, the NetApp Management Console provisioning capability does not
create volumes but instead uses the volumes that you select for that dataset node.
If you have the provisioning or disaster recovery, can you choose not to use resource pools?
You can manually provision your dataset. If you choose to provision your dataset on storage
outside of a resource pool, the NetApp Management Console provisioning capability does not
create volumes but instead uses the volumes that you select for that dataset node.
If you choose to associate a vFiler unit with a nonprimary node in a dataset, any volumes that are
provisioned for that dataset must be associated with the vFiler unit. (Therefore, when you view a
list of the dataset volumes, only volumes that are owned by the vFiler are displayed.)

Adding resources to a dataset
You can add physical resources to an existing dataset. Any protection, disaster recovery, and
provisioning policy assigned to the dataset node is automatically extended to the newly added
resources.
Before you begin

•

•

You must have gathered the resource information that you need to complete this task:
• Whether or not you want to use resource pools
• The node's protection or provisioning requirements
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Any dataset that you directly assign a protection policy or provisioning policies and resource pools
directly through NetApp Management Console is displayed as a dataset of physical storage objects.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Properties sheet, click Physical Resources for the node to which you want to add physical
resources.
The Edit property sheet Overview page is the starting point for several different types of tasks.
Each option on the menu starts an in-place property sheet or a wizard. Canceling or completing
an option returns you to the Edit Overview page.
4. In the Edit Physical Resources page, select each new member from the Available Resources list,
move it to the Resources in this Node list, and click Next.
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Adding resources to a dataset generates a report detailing the impact of the changes to the dataset.
5. After you are satisfied with the preview results, click Next to apply your changes, then click
Finish to return to the property sheet Overview page.
Result

NetApp Management Console adds the physical resources to the dataset.
Related references

Administrator roles and capabilities on page 54
Changing dataset node resource assignments
If the protection, failover, or provisioning requirements of your dataset change, you can add physical
resources to a dataset node or change the resources currently assigned to a dataset node.
Before you begin

•

•

You must have gathered the resource information that you need to complete this task:
• Whether or not you want to use resource pools
• The node's protection or provisioning requirements
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•
•

If your dataset is attached to a storage service, you cannot directly change a dataset node's
individual resource pool. See "Changing a storage service on datasets."
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Edit Dataset window, click Physical Resources for the node to which you want to change
the physical resources.
4. In the Edit Physical Resources page, add or remove the physical resource.
a) Add a new physical resource by selecting a resource from the Available Resources list and
moving it to the Resources in this Node list.
b) Remove a resource by selecting a resource from the Resources in this Node list and moving it
to the Available Resources list.
5. Click Next.
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NetApp Management Console performs a trial run of your requested changes and generates a
report describing the impact of those changes.
6. After you are satisfied with the preview results, click Next to apply your changes to the dataset,
then click Finish.
Result

If no resources were previously assigned to the dataset node, the dotted outline in the graph area of
the Datasets window Overview tab is replaced by an icon representing assigned storage.
Related concepts

What groups are on page 67
Related references

Administrator roles and capabilities on page 54
Removing resources from a dataset
You can remove physical resources from an existing dataset when you no longer want to protect, fail
over, or provision its data using the assigned policy.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Edit Dataset window, click Physical Resources for the node from which you want to
remove physical resources.
4. In the Edit Physical Resources page, select each resource you want to remove from the list, move
it to the Available Resources list, and click Next.
The NetApp Management Console data protection capability performs a trial run of your
requested changes and generates a report describing the impact of those changes.
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5. After you are satisfied with the preview results, click Next to apply your changes to the dataset,
then click Finish.
6. Close the Edit Dataset window.
Result

The NetApp Management Console data protection capability removes the physical resources from
the dataset.
Overview of export protocol properties
You can configure access for clients using NFS, CIFS, iSCSI, or Fibre Channel (FC) protocols when
you create or reconfigure the primary, backup, or mirror nodes in your datasets or when you
provision new volumes, LUNs, or qtrees as members into your datasets.
CIFS
access

To configure support for CIFS client access to the primary, backup, or mirror nodes in
your dataset, you enable that access when you configure each node and specify the
following:
•
•

NFS
access

To configure support for NFS client access to the primary, backup, or mirror nodes in
your dataset, you enable that access when you configure each node in the dataset and
specify the following:
•
•
•
•
•

Fibre
Channel
access

The Windows domain of the target nodes in this dataset
Specific permissions (full control, no access, or read and change) for specific users
to access the nodes in this dataset

Default permissions (Read only, read write, or root access) for all NFS hosts to
access the selected node in this dataset
Specific permissions for specific NFS hosts to access the selected node in this
dataset
The NFS security protocol (Kerberos v5 Integrity, Kerberos v5, Kerberos v5
Privacy, UNIX style, or None) that you want enforced
A default mapping for anonymous users to the selected node
Whether or not to enable superuser ID access to the selected node in this dataset

To configure support for FC client access to the SAN-based volumes, or LUNs in the
primary, backup, or mirror nodes in your dataset, you enable that access when you
configure each node and specify the following:
•
•

The operating system (Solaris, Windows, HP-UX, AIX, Linux, VMware,
NetWare) of the accessing host
The World Wide Port Names for the FC nodes, if the accessing host does not have
NetApp Host Agent installed
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iSCSI
access

To configure support for FC client access to the SAN-based volumes or LUNs in the
primary, backup, or mirror nodes in your dataset, you enable that access when you
configure each node and specify the following:
•
•

The operating system (Solaris, Windows, HP-UX, AIX, Linux, VMware,
NetWare) of the accessing host
The initiator ID for the iSCSI nodes, if the accessing host does not have a NetApp
Host Agent installed

Configuring dataset nodes for CIFS protocol access
You can configure Windows client CIFS access to all NAS volumes or qtrees contained in a dataset's
primary, backup, or mirror node if the dataset is configured to support CIFS access.
Before you begin

•
•

You must have confirmed that the dataset node on which you want to enable CIFS access is
assigned a NAS-type provisioning policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Note: Do not complete this task if you want to enable unique sets of export protocols on individual
LUNs when you provision them into this dataset node; leave this dataset node with no export
protocol enabled.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. Click Data > Datasets > Overview.
2. In the Datasets window, select the dataset you want to configure and click Edit.
3. In the Edit Dataset window, click Provisioning/Resource Pools under the name of the node for
which you want to enable or modify CIFS access.
If no provisioning policy has been assigned to this dataset, specify a NAS-type provisioning
policy.
NetApp Management Console displays the provisioning policy assigned to the dataset node, and
if that policy is a NAS-type policy, displays a CIFS Settings bar.
4. If the CIFS settings are not displayed, click the down arrow button on the CIFS Export Settings
bar to expand the display.
5. Configure the CIFS settings. If CIFS is turned off, click Turn CIFS On to enable the settings.
6. Modify any other CIFS protocol or resource pool settings. When you are finished, click Next.
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7. Modify the vFiler unit configurations, as needed, and click Next.
8. If the Preview Details page shows no warnings or errors, click Next, then click Finish.
If the Preview Details page shows errors, follow the suggestions to fix the problems. You can
click Back to change the settings on any page of the wizard.
9. Close the Edit Dataset window.
Configuring dataset nodes for NFS protocol access
You can configure NFS host access to all NAS volumes or qtrees contained in a dataset's primary,
backup, or mirror node if the dataset is configured to support NFS access.
Before you begin

•
•

You must have confirmed that the dataset node on which you want to enable NFS access is
assigned a NAS-type provisioning policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Note: Do not complete this task if you want to enable unique sets of export protocols on individual
volumes or qtrees when you provision them into this dataset node; leave this dataset node with no
export protocol enabled.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. Click Data > Datasets > Overview.
2. In the Datasets window, select the dataset that you want to configure and click Edit.
3. In the Properties sheet, click Provisioning/Resource Pools under the name of the node for
which you want to enable or modify NFS access.
If no provisioning policy is assigned to this dataset, specify a NAS-type provisioning policy.
NetApp Management Console displays the provisioning policy assigned to the dataset node, and,
if that policy is a NAS-type policy, displays an NFS Settings bar.
4. If the NFS settings are not displayed, click the down arrow button on the NFS Export Settings bar
to expand the display.
5. Configure the NFS settings. If NFS is turned off, click Turn NFS On to enable the settings.
6. Modify any other NFS protocol or resource pool settings. When you are finished, click Next.
7. Modify the vFiler unit configurations, as needed, then click Next.
8. If the Preview Details page shows no warnings or errors, click Next, then click Finish.
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If the Preview Details page shows errors, follow the suggestions to fix the problems. You can
click Back to change the settings on any page of the wizard.
9. Close the Edit Dataset window.
Related references

Administrator roles and capabilities on page 54
Configuring dataset nodes for FC protocol access
You can configure Fibre Channel protocol (FC) client access to all SAN LUNs contained in a
dataset's primary, backup, or mirror node if the dataset is configured to support FC access.
Before you begin

•

You must have confirmed that the dataset node on which you want to enable FC access is
assigned a SAN-type provisioning policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

•

Note:

•
•

FC is not supported on vFiler units.
Do not complete this task if you want to enable unique sets of export protocols on individual
LUNs when you provision them into this dataset node; leave this dataset node with no export
protocol enabled.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. Click Data > Datasets > Overview.
2. In the Datasets window, select the dataset that you want to configure and click Edit.
3. In the Properties sheet, click Provisioning/Resource Pools under the name of the node for
which you want to enable or modify FC access.
If no provisioning policy has been assigned to this dataset, specify a SAN-type provisioning
policy.
NetApp Management Console displays the provisioning policy assigned to the dataset node. If
that policy is a SAN-type policy, it displays an FCP Settings bar.
4. If the FC settings are not displayed, click the down arrow button on the FCP Export Settings bar
to expand the display.
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5. Configure the FC settings. If FC is turned off, click Turn FCP On to enable the settings.
If iSCSI is turned on, it is automatically turned off when you click Turn FCP on.
6. Modify any other protocol and resource pool settings. When you are finished, click Next.
7. Modify the vFiler unit configurations, as needed, then click Next.
8. If the Preview Details page shows no warnings or errors, click Next, then click Finish.
If the Preview Details page shows errors, follow the suggestions to fix the problems. You can
click Back to change the settings on any page of the wizard.
9. Close the Edit Dataset window.
Configuring dataset nodes for iSCSI protocol access
You can configure iSCSI client access to all SAN LUNs contained in a dataset's primary, backup, or
mirror node if the dataset is configured to support iSCSI access.
Before you begin

•
•

Confirm that the dataset node on which you want to enable iSCSI access is assigned a SAN-type
provisioning policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Note: Do not complete this task if you want to enable unique sets of export protocols on individual
LUNs when you provision them into this dataset node; leave this dataset node with no export
protocol enabled.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. Click Data > Datasets > Overview.
2. In the Datasets window, select the dataset that you want to configure and click Edit.
3. In the Properties sheet, click Provisioning/Resource Pools under the name of the node for
which you want to enable or modify iSCSI access.
If no provisioning policy has been assigned to this dataset, specify a SAN-type provisioning
policy.
NetApp Management Console displays the provisioning policy assigned to the dataset node. If
that policy is a SAN-type policy, it displays an iSCSI Settings bar.
4. If the iSCSI settings are not displayed, click the down arrow button on the iSCSI Export Settings
bar to expand the display.
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5. Configure the iSCSI settings. If iSCSI is turned off, click Turn iSCSI On to enable the settings.
If FC protocol is turned on, it is automatically turned off when you click Turn iSCSI on.
6. Modify any other resource pool settings. When you are finished, click Next.
7. Modify the vFiler unit configurations, as needed, then click Next.
8. If the Preview Details page shows no warnings or errors, click Next, then click Finish.
If the Preview Details page shows errors, follow the suggestions to fix the problems. You can
click Back to change the settings on any page of the wizard.
9. Close the Edit Dataset window.
Related references

Administrator roles and capabilities on page 54
Enabling an unprovisioned dataset for migration through a new vFiler unit
You can enable data migration on an unprovisioned dataset by editing that dataset and generating a
new vFiler unit.
Before you begin

•
•
•
•

Verify that your dataset meets the requirements for the type of automated migration (online or
offline) that you want to enable.
Verify that your dataset does not yet have any existing members provisioned to it.
Be ready to assign an IP address and netmask source location for the dataset that you want to
migrate.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•
•

The alternative method of enabling a dataset for migration is to attach an existing vFiler unit.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Edit Dataset window, select Provisioning/Resource pool.
4. Select Enable automated migration and enter the IP address and netmask for the migration
source.
5. Specify online or offline migration.
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•
•

To enable automated online data migration, select Enable automated online migration.
To enable offline data migration only, leave the "Enable automated online migration" option
unselected.

6. Click Next.
7. If your edits pass the dataset conformance check, click Finish.
Result

After the dataset is enabled for automated migration, it is listed on the Migration tab.
Enabling an unprovisioned dataset for migration through an existing vFiler unit
You can enable automated migration on an existing unprovisioned dataset by editing that dataset and
attaching an existing vFiler unit.
Before you begin

•
•
•
•

Verify that your dataset meets the requirements for the type of automated migration (online or
offline) that you want to enable.
Verify that your dataset does not yet have any existing members provisioned to it.
Be ready to assign an existing vFiler unit to your dataset.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•
•

The alternative method of enabling a dataset for migration is to automatically generate a new
vFiler unit and attach it to your dataset.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Edit Dataset window, select Provisioning/Resource pool.
4. In the vFiler unit pane, select one of the listed vFiler units.
Selecting a vFiler unit to attach enables this dataset for automated migration.
5. Specify online or offline migration.
•
•

To enable automated online data migration, select Enable automated online migration.
To enable offline data migration only, leave the "Enable automated online migration" option
unselected.

6. Click Next.
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7. If your edits pass the dataset conformance check, click Finish.
Result

After the dataset is enabled for automated migration, it is listed on the Migration tab.
Decisions to make before configuring dataset-level custom naming for related objects
Before you create a dataset or edit a dataset to apply dataset-level custom naming to its protection or
provisioning job-generated related objects (Snapshot copies, primary volumes, secondary volumes,
and secondary qtrees), you must make some decisions about the related object types that you are
considering for custom naming.
Do your related object types require dataset-level name customization?
NetApp Management Console applies default or customized global naming formats to the protection
or provisioning job-generated Snapshot copies, primary volumes, secondary volumes, and secondary
qtrees. If the default global naming of these object types causes no problems, dataset-level
customization of the naming settings is not necessary.
Do you want to use a custom label in related object naming?
A custom label is an alphanumeric string that you can specify to include in a dataset-level name if the
naming when NetApp Management Console applies custom naming to Snapshot copies, primary
volumes, secondary volumes, or secondary qtrees that are generated by protection or provisioning
operations. If the name of the dataset to whose objects you want to apply custom naming is very
long, you might consider specifying a shorter custom label to include in the names of its Snapshot
copies, volumes, or qtrees.
Are you custom naming by attribute selection and ordering?
The most common method of customizing global naming of your Snapshot copy, primary volume,
secondary volume, or secondary qtree objects is by specifying their naming attributes in the order
that you want those attributes to appear. Each object type for which custom naming is supported
supports a different set of attributes.
Snapshot
copy naming
attributes

Attributes that can be specified and ordered to customize Snapshot copy naming
include the following:
•
•
•
•
•
•

%T (Timestamp) (required)
%R (Retention type) (retention class of the Snapshot copy)
%L (Custom label) (custom label of the containing dataset, if one exists)
%H (Storage system name) (storage system of the containing volume)
%N (Volume name) (the containing volume)
%A (Application fields)
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•
Primary
volume
naming
attributes

Secondary
volume
naming
attributes

%1 (One-digit suffix), %2 (Two-digit suffix), or %3 (Threedigit suffix) (applied as necessary if naming differentiation is required)

Attributes that can be specified and ordered to customize primary volume naming
include the following:
•
•
•

%L (Custom label) (custom label of the containing dataset, if one exists)
%D (Dataset name) (actual name of the containing dataset)
%1 (One-digit suffix), %2 (Two-digit suffix), or %3 (Threedigit suffix) (applied as necessary if naming differentiation is required)

Attributes that can be specified and ordered to customize secondary volume
naming include the following:
•
•
•

%L (Custom label) (custom label of the containing dataset, if one exists)

•
•

%V (Primary volume name) (volume being backed up or mirrored)

%C (Type) (the connection type: backup or mirror).
%S (Primary storage system name) (storage system of the volume being

backed up or mirrored)
%1 (One-digit suffix), %2 (Two-digit suffix), or %3 (Threedigit suffix) (applied as necessary if naming differentiation is required)

Attributes that can be specified and ordered to customize secondary qtree naming
Secondary
qtree naming include the following:
attributes
• %Q (Primary qtree name) (qtree being backed up)
• %L (Custom label) (custom label of the containing dataset, if one exists)
• %S (Primary storage system name) (storage system of the volume being
backed up or mirrored)
• %V (Primary volume name) (volume being backed up or mirrored)
• %1 (One-digit suffix), %2 (Two-digit suffix), or %3 (Threedigit suffix) (applied as necessary if naming differentiation is required)
Adding a dataset of physical storage objects with dataset-level custom naming
When you create a new dataset of physical storage objects, to improve recognition and usability, you
can customize the naming formats that are applied to the Snapshot copies, primary volumes,
secondary volumes, or secondary qtrees that are generated by protection and provisioning jobs run on
that dataset.
Before you begin

•

You must have custom naming information available:
•

The protection-related and provisioning-related object types whose naming you want to
customize
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•

•
•
•

If you want to include a custom label for your dataset in your custom naming formats, the
character string that you want to use
• If you want to customize naming settings by selecting and ordering NetApp Management
Console-supplied attributes in the Add Dataset wizard Naming Properties page, the naming
attributes that you want to include in the naming format
If you plan to assign a policy, you must to be assigned a role that enables you to view policies.
If you plan to assign a provisioning policy, you must be assigned a role that enables you to attach
the resource pools configured for the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

If customized for the protection-related or provisioning-related object types in a dataset, datasetlevel naming properties override the global naming settings for those object types in that dataset.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add to start the Add Dataset wizard.
3. When the wizard displays the Naming Properties panel, specify how you want the dataset
reference displayed in the names for your object types:
•

•

If you want NetApp Management Console to include the name of the dataset in the names of
its generated Snapshot copy, primary volume, secondary volume, or secondary qtree objects,
select Use dataset name.
If you want NetApp Management Console to use a custom character string in place of the
dataset name in the names of its protection-related or provisioning-related object, select Use
custom label and enter the character strings that you want to use.

4. Customize the naming settings for your related object types:
•
•

If you want the current global naming format to apply to one or more object types that are
generated in this dataset, select the Use global naming format option for those object types.
If you want to customize the dataset-level naming formats for one or more object types that
are generated in this dataset, select the Use custom format option for those object types, and
type the naming attributes in the order that you want those attributes to appear.

5. When you complete your naming configuration, click Next and complete the dataset creation.
Result

After dataset creation is complete, NetApp Management Console applies the custom dataset-level
naming formats to all objects created by protection and provisioning jobs for that dataset.
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Editing a dataset of physical storage objects for dataset-level custom naming
To improve recognition and usability, you can edit an existing dataset to customize the naming
format that is applied to the Snapshot copies, primary volumes, secondary volumes, or secondary
qtrees that are generated by protection and provisioning jobs run on that dataset.
Before you begin

•

You must have the following custom naming information available:
•
•
•

•
•
•

The name of the dataset for which you want to configure custom naming
The protection or provisioning-generated object types whose naming you want to customize
If you want to include a custom name for your dataset in your custom naming format, the
character string that you want to use
• If you want to customize naming settings by selecting and ordering attributes from the
Naming Properties page, the naming attributes that you want to include in the naming format
• If you want to customize naming settings by naming a pre-authored naming script, the name
and location of that script.
If you plan to assign a policy, you must be assigned a role that enables you to view policies.
If you plan to assign a provisioning policy, you also need a role that enables you to attach the
resource pools configured for the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

Dataset-level naming properties customized for the protection-related objects override any
conflicting global naming settings that might be configured.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset whose naming settings you want to customize and click Edit to display the Edit
Dataset window.
3. Click the Naming Properties option and customize the naming settings for your selected object
type.
4. When you complete your naming configuration, click OK and complete the dataset edit.
Result

After the dataset edit is complete, the DataFabric Manager server applies the custom dataset-level
naming format that you specified to all future objects of that type that are generated by that dataset's
protection and provisioning jobs.
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Adding a dataset with dataset-level naming by using a storage service
When you create a new dataset by using a storage service, you can customize the naming formats
that are applied to the related objects (Snapshot copies, primary volumes, secondary volumes, or
secondary qtrees that are generated in that dataset by protection jobs run on that dataset).
Before you begin

•

Have the custom naming information available to complete this task:
•
•

•
•
•

The related object whose naming you want to customize
If you want to include a custom label for your dataset in your custom naming formats, the
character string that you want to use
• If you want to customize by typing naming format strings in the Add Dataset Using Storage
Service wizard Naming Properties page, the naming format strings that you want to include
If you plan to assign a policy, you must be assigned a role that enables you to view policies.
If you plan to assign a provisioning policy, you also need a role that enables you to attach the
resource pools configured for the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

Dataset-level naming properties customized for the related objects in a dataset override any
conflicting global naming settings for those objects that might be configured.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add dataset by using a storage service to start the Add Dataset Using Storage Service
wizard.
3. When the wizard displays the Naming Properties panel, specify how you want the reference
displayed in the names for your related objects:
•

•

If you want the DataFabric Manager server to include the name of the dataset in the names of
its generated Snapshot copy, primary volume, secondary volume, or secondary qtree objects,
select Use dataset name.
If you want the DataFabric Manager server to use a custom character string in place of the
dataset name in the names of its generated Snapshot copy, primary volume, secondary
volume, or secondary qtree objects, select Use custom label and enter the character strings
that you want to use.

4. Customize the naming settings for your related objects (Snapshot copy, primary volume,
secondary volume, or secondary qtree).
•

If you want the current global naming format to apply to one or more object types that are
generated in this dataset, select the Use global format option for those object types.
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•

If you want to customize the dataset-level naming formats for one or more object types that
are generated in this dataset, select the Use custom format option for those object types, and
type the naming attributes in the order that you want those attributes to appear.

5. When you complete your naming configuration, click Next and complete the dataset creation.
Result

After dataset creation is complete, the DataFabric Manager server applies the custom dataset-level
naming formats to all dataset protection job generated objects of the associated type.
Editing a dataset
You can edit the general properties of an existing dataset, as well as the dataset's physical resources,
provisioning policy, export settings, and resource pools.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

•
•

If the dataset that you want to edit is assigned a storage service, the procedure is different. See
"Changing a storage service on datasets."
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Any dataset that you directly assign a protection policy or provisioning policies and resource
pools directly through NetApp Management Console is displayed as a dataset of physical storage
objects.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that you want to modify, then click Edit.
3. In the Edit Dataset window, use the menu to click the property that you want to modify.
If you want to modify...

Then do this...

The name, description, owner, contact, and time zone

Click General Properties.

The custom label, custom naming formats (Snapshot copy,
Primary volume, Secondary volume, Secondary qtree)

Click Naming properties.

The physical resources of the dataset's primary data

Under Primary data, click Physical
Resources.
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If you want to modify...

Then do this...

The provisioning policy, export settings, or resource pools of Under Primary data, click Provisioning/
the dataset's primary data
Resource Pools.
The physical resources of the dataset's backup data

Under Backup, click Physical
Resources.

The provisioning policy, export settings, or resource pools of Under Backup, click Provisioning/
the dataset's backup data
Resource Pools.
The physical resources of the dataset's mirror data

Under Mirror, click Physical
Resources.

The provisioning policy, export settings, or resource pools of Under Mirror, click Provisioning/
the dataset's mirror data
Resource Pools.

4. Modify the dataset properties as needed, then click Finish to return to the Edit Dataset window.
Result

NetApp Management Console saves your changes. If you modified the dataset name, the new name
is displayed on the Datasets window.
Deleting a dataset
You can delete a dataset if you want to stop protection or disaster recovery for all of its members and
stop conformance checking against its assigned protection and disaster recovery policies.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that you want to delete and click Delete.
The Delete Dataset dialog box opens, requesting that you confirm the deletion.
Note: When you delete a dataset, the physical resources that compose the dataset are not
deleted.

3. Click Yes to confirm the delete request or No to cancel the request and close the dialog box.
Result

NetApp Management Console removes the dataset from the list in the Datasets window.
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Related references

Administrator roles and capabilities on page 54
Backup of multiple primary volumes to a single secondary volume
You can configure the NetApp Management Console data protection capability to support
SnapVault-based or Qtree SnapMirror-based backup of multiple volumes in primary storage to a
single volume in secondary storage.
By default, the NetApp Management Console data protection capability automatically sets up one-toone backup relationships between primary and secondary volumes when provisioning secondary
nodes in datasets. But in circumstances in which the 500-volume limit for storage systems might not
allow a one-to-one ratio of primary volumes to secondary volumes, you can configure the NetApp
Management Console data protection capability through the Operations Manager global option
dpMaxFanInRatio option (to support backup relationships between multiple volumes in primary
storage and a single volume in secondary storage).
The following limitations apply to the NetApp Management Console data protection capability
support for automatically configuring backup relationships of multiple primary volumes to a single
secondary volume when provisioning secondary storage:
•
•
•

The NetApp Management Console data protection capability does not support volume
SnapMirror-based mirroring from multiple primary volumes to a single secondary volume.
All the primary volumes and the secondary volume must be members of the same dataset.
The NetApp Management Console data protection capability implementation of Open Systems
SnapVault backup is not affected by the dpMaxFanInRatio option.

For more information on the dpMaxFanInRatio option global option, see the Operations
Manager online Help.

Configuring datasets using storage services
You can use the storage service related wizards on the Datasets window Overview tab to quickly
create or modify datasets with protection policy, provisioning policy, resource pool, and vFiler
template combinations that are specified by an administrator-defined storage service.
Decisions to make before adding a dataset by using a storage service
You can use the Add Dataset Using Storage Service wizard to create a dataset that is preconfigured
with the protection policy, provisioning policies, resource pools and template-based vFiler unit
attachment that are specified by a selected storage service. Before you begin, you must have the
relevant information required by the wizard.
Dataset
Properties

•
•

Naming
Properties

Do you want to use preconfigured global naming formats, or do you want to
customize naming formats to name related objects (Snapshot copies, primary

What is the name and description of the dataset that you want to create?
What time zone do you want to specify for this dataset?
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volumes, secondary volumes, and secondary qtrees generated by protection jobs
on this dataset)?
•
•

Do you want the names of the related objects to include a custom label
instead of the dataset name?
If you want to customize naming for related objects in this dataset, do you
want to use naming scripts or do you want to use for this, or do you want to
use Add Dataset Using Storage Service wizard settings to do so?

Service
Selection

What is the name of the storage service that you want to assign to this dataset?

Dataset level
export

What export protocol do you want to enable for this dataset?
The supportable protocols are NFS or CIFS.

Dataset Node
vFiler unit
configuration

For the primary node, take the following decisions about vFiler units:

If you are configuring a dataset of physical objects, the storage service that you
select for the task must already have a provisioning policy specified for the
primary node.

•
•

•
•

•

Do you want to attach a vFiler unit to your primary node?
If you want to attach a vFiler unit to your primary node, do you want to
attach an existing vFiler unit or specify the creation and attachment of a new
vFiler unit by the storage services feature?
If you want to attach an existing vFiler unit, which vFiler unit do you want
to attach?
If you want to specify the creation of a new vFiler unit for attachment to
your primary node, what IP address and network mask do you want to
assign?
If you attach a vFiler unit to your primary node, do you want to enable
online migration of data?

For each secondary or tertiary node that is included in the dataset, take the
following decisions about vFiler units:
•
•

•

Do you want to attach a vFiler unit to your secondary or tertiary node?
If you want to attach a vFiler unit to your secondary or tertiary node, do you
want to attach an existing vFiler unit, or create and attach a new vFiler unit
using the storage services feature?
If you want to create a new vFiler unit for attachment to your secondary or
tertiary node, what IP address and network mask do you want to assign?
Note: A vFiler unit created on secondary or tertiary nodes does not
support migration.

•

If you want to attach an existing vFiler unit, which vFiler unit do you want
to attach?
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Dataset member •
provisioning
•

Do you want to provision the dataset with volumes at the time you create it?
If you do not provision the dataset at the time you create it, you can do so
later.
If you want to provision the dataset when you create it, then for each volume
you provision what do you want to specify for the following properties:
Volume name
Volume description
Space for data

Adding a dataset by using a storage service
You can use the Add Dataset Using Storage Service wizard to create new datasets that are already set
up with a storage service specified protection policy, provisioning policies, resource pools, and
template-based vFiler unit attachments.
Before you begin

•
•

If you are creating a dataset of physical objects, the storage service that you use for this task must
have a provisioning policy assigned to its primary node configuration.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

After you create a dataset with an attached storage service, you cannot directly edit that dataset to
change its individual protection policy selection, provisioning policy selections, or resource pool
selections as long as that storage service is attached. You can only edit the attached storage service to
change the protection policy, provisioning policy, or resource pool selections for all datasets attached
to that storage service.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add > Using Storage Service to start the Add Dataset Using Storage Service wizard.
3. After you complete each property sheet in the wizard, click Next.
4. Confirm the details of the storage service and click Finish.
Result

•

The new dataset is listed in the datasets table with its attached storage service named in its storage
service column.
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•

If you also selected the option to create a new vFiler unit when you created the new dataset, that
new vFiler unit is listed in the vFiler Units window with the same name as the dataset with which
it was created.
For example, if the new dataset name is "eng_acct", then the name of the new vFiler unit that you
created with it is also "eng_acct", unless an earlier vFiler unit with that exact name already exists.
In such a case, the new vFiler unit that you just created is named "eng_acct_1". Similarly, if you
are creating a new vFiler unit on secondary or tertiary node, the new vFiler unit is named
"eng_acct_<nodename>". However, if another vFiler unit named "eng_acct_<nodename>" exists,
then the wizard names the new vFiler unit "eng_acct_<nodename>_1".

Related concepts

Decisions to make before adding a dataset by using a storage service on page 126
About storage services on page 212
Attaching a storage service to existing datasets of storage objects
You can use the Attach Storage Service wizard to attach a storage service to existing datasets.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Confirm that all datasets to which you want to attach the storage service currently use the same
protection policy or no protection policy.
About this task

The Attach Storage Service wizard allows you to select from a list of possible storage services,
presents you with possible node remappings and associated rebaselining requirements for the storage
service that you select, carries out a dry run of your request, and then implements your request upon
your approval.
After you attach a storage service to an existing dataset, you cannot directly edit that dataset to
change its individual protection policy selection, provisioning policy selections, or resource pool
selections as long as that storage service is attached. You can only edit the attached storage service to
change the protection policy, provisioning policy, or resource pool selections for all datasets attached
to that storage service.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select one or more datasets to which you want to assign a common storage service.
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For successful attachment, select datasets that currently use a common protection policy or none
at all.
3. Click Storage Service > Attach to start the Attach Storage Service wizard.
4. After you complete each property sheet in the wizard, click Next.
5. Confirm the details of the storage service and click Finish.
Result

The selected datasets are listed in the datasets table with their newly attached storage service named
in their storage service column.
Detaching a storage service from datasets
You can use the Detach Storage Service wizard to detach storage services that are currently assigned
to datasets.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Even after a storage service is detached from a dataset, the protection policy, provisioning policies,
resource pools, and optional vFiler templates that were assigned as part of that storage service remain
in effect for that dataset, although you can now directly edit the dataset to replace one or more of
those components with alternative elements or you can attach another storage service.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select one or more datasets that you want to detach from their storage services.
They do not need to be attached to the same storage service.
3. Click Storage Service > Detach to start the Detach Storage Service wizard.
4. Click Yes to confirm the detachment action.
Result

After detachment is complete, the selected datasets are listed in the datasets table with no storage
service named in their storage service column. After detachment is complete, you can edit the
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individual protection policy assignment, provisioning policy assignments and resource pool
assignments of the selected datasets.
Related concepts

About storage services on page 212
Related references

Administrator roles and capabilities on page 54
Changing a storage service for datasets
You can use the Change Storage Service wizard to change a storage service for datasets that already
have another storage service attached.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
The following conditions must exist:
•
•

The new storage service that you want to attach is available in the group in which you want to
locate that dataset.
All datasets to which you want to attach the new storage service are currently attached to the
same current storage service.

About this task

The Change Storage Service wizard allows you to select an alternative storage service, presents you
with possible node remapping alternatives along with rebaselining requirements for each alternative,
carries out a dry run of your request, and then implements your request upon your approval.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. In the datasets table, select one or more datasets whose attached storage service you want to
change.
For successful change, select only datasets that are attached to the same current storage service.
3. Click Storage Service > Change to start the Change Storage Service wizard.
4. After you complete each property sheet in the wizard, click Next.
5. Confirm the details of the storage service and click Finish.
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Result

The selected datasets are listed in the datasets table with their newly attached storage service named
in the storage service column.
Related concepts

About storage services on page 212
Related references

Administrator roles and capabilities on page 54

Managing datasets
You can monitor a dataset's status and its protection policy for possible errors, back up its content ondemand, suspend and resume protection for it, and initiate restore operations to access backed-up
data.
Overview of dataset status types
The NetApp Management Console data protection and provisioning capabilities report on each
dataset's protection status, conformance status, and resource status.
Descriptions of dataset protection status
A dataset is remotely protected only if the secondary storage system specified in the protection
relationship is successfully backing up data, and if the copies of the data can be restored. You can
monitor dataset protection status using the Datasets window Overview tab.
You should regularly monitor a dataset's protection, because the DataFabric Manager server cannot
sufficiently protect the dataset under the following conditions:
•
•

If a secondary storage system runs out of storage space necessary to meet the retention duration
required by the protection policy
If the lag thresholds specified by the policy are exceeded

The following list describes protection status values:
Baseline Failed No initial baseline data transfers have registered a backup version.
Initializing

The dataset is conforming to the protection policy and the initial baseline data
transfer is in process.

Job Failure

The most recent protection job did not succeed.
This status might result for any of the following reasons:
•

A backup from a SnapVault or Qtree SnapMirror relationship failed or could
not be registered.
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•
•
Lag Error

A mirror copy from a SnapMirror relationship failed or could not be
registered.
Local backups (Snapshot copies) failed on the primary node.

The dataset has reached or exceeded the lag error threshold specified in the
assigned protection policy. This value indicates that there has been no successful
backup or mirror copy of a node's data within a specified period of time.
This status might result for any of the following reasons:
•
•

•
Lag Warning

The most recent local backup (Snapshot copy) on the primary node is older
than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror) is older than the
lag threshold setting or no backup jobs have completed since the dataset was
created.
The most recent mirror (SnapMirror) copy is older than the lag threshold
setting or no mirror jobs have completed since the dataset was created.

The dataset has reached or exceeded the lag warning threshold specified in the
assigned protection policy. This value indicates that there has been no successful
backup or mirror copy of a node's data within a specified period of time.
This status might result for any of the following reasons:
•
•

•

The most recent local backup (Snapshot copy) on the primary node is older
than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror) is older than the
lag threshold setting or no backup jobs have completed since the dataset was
created.
The most recent mirror (SnapMirror) copy is older than the lag threshold
setting or no mirror jobs have completed since the dataset was created.

No Protection
Policy

The dataset is managed by the NetApp Management Console data protection
capability, but no protection policy has been assigned to the dataset.

Protected

The dataset has an assigned policy and it has conformed to that policy at least
once.

Protection
Suspended

An administrator has requested that scheduled backups be temporarily halted
until the administrator requests that they be resumed.

Uninitialized

This status might result for any of the following reasons:
•
•
•
•

The dataset has a protection policy that does not have any protection
operations scheduled.
The dataset does not contain any data to be protected.
The dataset does not contain storage for one or more destination nodes.
The single node dataset does not have any backup versions.
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•
•

An application dataset requires at least one backup version associated with it.
The dataset does not contain any backup or mirror relationships.

Attention: Importing an external relationship into a dataset temporarily changes the dataset's
protection status to Uninitialized. When the next scheduled backup or mirror backup job runs or
when you run an on-demand backup the protection status changes to reflect the results of the
protection job.

Descriptions of dataset conformance status
The dataset conformance status indicates whether a dataset is configured according to its protection
policy. To be in conformance, all secondary and tertiary storage systems that are part of the backup
relationship must be successfully provisioned and the provisioned volumes must match the
requirements of the primary data. You can monitor dataset status by using the Datasets window.
The NetApp Management Console data protection capability regularly checks a dataset for
conformance. If it detects changes in the dataset's membership or policy definition, the console does
one of three things:
•
•
•

Automatically performs corrective steps to bring a dataset back into conformance
Presents you with a list of actions for your approval prior to correction
Lists conditions that it cannot resolve

You can view these actions and approve them in the Conformance Details dialog box.
A dataset might be nonconformant because there are no available resources from which to provision
the storage or because the NetApp Management Console data protection capability does not have the
necessary credentials to provision the storage resources.
The following list describes dataset conformance values:
Conformant

The dataset is conformant with all associated policies.

Conforming

The dataset is not in conformance with all associated policies. NetApp
Management Console is performing actions to bring the dataset into
conformance.

Nonconformant NetApp Management Console cannot bring the dataset into conformance with all
associated policies and might require your approval or intervention to complete
this task.
Descriptions of dataset resource status
The dataset resource status indicates the event status for all resource objects that are assigned to the
dataset. The resources include those that are members of the secondary and tertiary storage systems.
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If, for example, a tertiary member's status is critical, the dataset's resource status also is displayed as
critical.
You can monitor dataset status using the Datasets window. You can troubleshoot the resource objects
using the Notifications > Events.
The following list describes the resource status values:
Normal

A previous abnormal condition for the resource returned to a normal state and the
resource is operating within the desired thresholds. No action is required.

Information A normal resource event occurred. No action is required.
Warning

The resource experienced an occurrence that you should be aware of. This event
severity does not cause service disruption, and corrective action might not be
required.

Error

The resource is still performing, but corrective action is required to avoid service
disruption.

Critical

A problem occurred that might lead to service disruption if you do not take
immediate corrective action.

Emergency The resource unexpectedly stopped working and experienced unrecoverable data
loss. You must take corrective action immediately to avoid extended downtime.
How to evaluate dataset conformance to policy
The NetApp Management Console data protection capability periodically checks that the dataset
conforms to its data protection policy. If either the dataset membership or policy changes, the
NetApp Management Console data protection capability either tries to bring the dataset back into
conformance or notifies the administrator that the dataset conformance status changed to
nonconformant.
You can view the Conformance Results from the Datasets window the by clicking
Conformance in the Status area.

next to

Why datasets fail to conform to policy
A dataset must meet several conditions to be conformant to its assigned policy.
A dataset is conformant with its policy when it meets the following conditions:
•
•
•

Its member storage systems are properly configured.
Its assigned secondary storage system is provisioned and has enough backup space.
Its protection policy includes all necessary relationships to enforce data backups or mirror copies.

Following are some of the common reasons datasets fail to conform to their protection policies:
•
•

Dataset storage service and protection policy definitions changed.
Dataset membership changed.
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•
•

Volumes or qtrees were created or deleted at the storage system (external to the NetApp
Management Console ).
The configuration of a dataset of virtual objects has been updated, but not yet communicated from
the DataFabric Manager server to the host service.
This nonconformance normally lasts only a few minutes, until the DataFabric Manager server
updates the host service with the latest configuration.

How the NetApp Management Console data protection capability monitors dataset
conformance
The NetApp Management Console conformance monitor regularly checks the DataFabric Manager
server database for configuration information to determine if a dataset is in conformance with its
assigned policy.
Conformance status is determined based on data gathered from SNMP queries by system monitors.
The monitors update the DataFabric Manager server database at scheduled intervals. The
conformance monitor queries the DataFabric Manager server database for the information, which is
then displayed in NetApp Management Console. As a result, the information displayed by the
conformance monitor is not real-time data. This can result in the conformance monitor results being
temporarily out of date with actual changes to a storage system or configuration.
Should a dataset be nonconformant, you can view the conformance details from the Datasets window
by selecting an item in the dataset list and then clicking next to Conformance in the Status area. This
opens the Conformance Results window, that displays the results of the last conformance run on the
selected dataset. The results provide a description of any problems found during the last conformance
run and suggestions for resolving the problems. Depending on the results shown, you can then either
make changes manually to your system configuration or click Conform to allow in NetApp
Management Console. to automatically make changes in an attempt to bring the dataset into
conformance.
When you click Conform, you give the protection capability full control to do whatever it can to
bring everything into conformance for the selected dataset. This could include initiating a rebaseline
of your data, which might require significant time and bandwidth. As a result, if you would not want
a rebaseline to occur, you should try manual corrections to your system to resolve conformance
issues before you choose to use the Conform option.
After making manual corrections to your system, you can return to the Conformance Results window
and click the Test Conformance button to see if any changes made to the system have brought the
dataset into conformance with the policy assigned to it. Test Conformance initiates a new check on
the dataset but does not execute a conformance run. The results of the check reflect the latest system
updates that have been identified by the monitors and captured in the DataFabric Manager server
database. Therefore, the information displayed in the Conformance Results window might not reflect
recent changes made to a storage system or configuration and could be outdated by a few minutes or
a few hours, depending on the changes made and the scanning interval for each monitor.
You can view a list of monitor intervals by using the command dfm option list | grep
Interval. Following are some common monitoring actions, the default update intervals for
standard DataFabric Manager server configurations, and the associated monitors:
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•

•

•

•

•

•

Discover new hosts
Default interval: 15 minutes
Monitor: discover
Update sizes for aggregates, volumes, and free or used space
Default interval: 30 minutes
Monitor: dfmon
Find new disks, aggregates, volumes, qtrees
Default interval: 15 minutes
Monitors: fsmon, diskmon
Find vFiler units
Default interval: 1 hour
Monitor: vfiler
SnapMirror, SnapVault, and OSSV directory discovery
Default interval: 30 minutes
Monitor: relationships
Update license capabilities on storage systems
Default interval: 4 hours
Monitor: license

Dataset conformance conditions
The NetApp Management Console data protection capability displays a dataset's conformance status
in the Datasets window Overview tab. If the dataset is nonconformant, there are several ways in
which the dataset can be brought back into conformance.
You can view the Conformance Results from the Datasets window by clicking
Conformance in the Status area.

next to

When the conformance monitor detects a change in the dataset's membership or policy definition, the
conformance monitor does one of three things:
•
•
•

Automatically performs corrective steps to bring a dataset back into conformance
Presents you with a list of actions for your approval prior to correction
Lists conditions that it cannot resolve

Conditions the monitor can resolve
The following list describes some of the conditions that the conformance monitor can detect, the
actions it can take to bring the dataset back into conformance with its policy, and whether those
actions are automatic or they require your approval for completion:
•

The NetApp Management Console data protection capability provisions a destination volume but
the aggregate in which the volume is contained is no longer a member of the assigned resource
pool.
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Corrective
action

The NetApp Management Console data protection capability creates a new
volume and moves the relationship to it.
Does the action require your approval? Yes

Corrective
action

The NetApp Management Console data protection capability moves the
relationship to an existing volume.
Does the action require your approval? Yes

•

•

•

The NetApp Management Console data protection capability provisions a destination volume but
the aggregate in which the volume is contained is no longer a member of the assigned resource
pool.
Corrective
action

The NetApp Management Console data protection capability creates a new
volume and moves the relationship to it.
Does the action require your approval? Yes

Corrective
action

The NetApp Management Console data protection capability moves the
relationship to an existing volume.
Does the action require your approval? Yes

The destination volume does not have enough backup space or it is over its "nearly full"
threshold.
Corrective
action

The NetApp Management Console data protection capability expands the
volume in an aggregate that is a member of the resource pool.
Does the action require your approval? No

Corrective
action

The NetApp Management Console data protection capability provisions the
volume and migrates the physical relationship to a new destination volume.
Does the action require your approval? Yes

The destination volume contains expired backup versions.
Corrective
action

•

The NetApp Management Console data protection capability deletes the
backup versions. The console also deletes the copies of the data if those copies
do not contain other backup versions.
Does the action require your approval? No

Policy calls for the source data to be mirrored but the source volume is not protected in a mirror
relationship.
Corrective
action

The NetApp Management Console data protection capability creates a new
relationship and performs a baseline transfer of the data. A baseline transfer is
defined as an initial backup (also known as a level-0 backup) of a primary
volume to a secondary volume in which the entire contents of the primary
volume are transferred.
Does the action require your approval? No
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•

Policy calls for the source data to be backed up but the source qtree is not protected in a backup
relationship.
Corrective
action

•

The NetApp Management Console data protection capability creates a new
relationship and performs a baseline transfer of the data.
Does the action require your approval? No

The primary volume has extra mirror relationships.
Corrective action The NetApp Management Console data protection capability deletes the
extra relationships.
Does the action require your approval? No

•

The primary qtree has extra backup relationships.
Corrective action The NetApp Management Console data protection capability deletes the
extra relationships.
Does the action require your approval? No

Conditions the monitor cannot resolve
The following list describes some of the conditions that the conformance monitor can detect but
cannot resolve. These conditions require manual intervention from an administrator to bring the
dataset back into conformance with its policy.
•

An imported relationship has been detected in which the secondary volume exceeds the
volFullThreshold.
Corrective action You must manually increase the secondary volume size. The conformance
monitor cannot resolve this condition.

•

A dataset's assigned secondary resources do not offer appropriate backup space.
Corrective
action

•

You must reconfigure the resource pool membership so that the NetApp
Management Console data protection capability can successfully continue
data protection.

The application does not have the appropriate credentials to access the assigned resources.
Corrective action You must provide the credentials for access to the hosts or storage systems.

Monitoring dataset status
You can monitor the status of your datasets and their protection policies for possible errors.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Steps

1. From the menu bar, click Data > Datasets > Overview.
2. (Optional) You can customize the Datasets window Overview tab in any of the following ways:
•

•

Select a dataset to see the configured policy for that dataset and the details about each
component in the policy.
in a column header to control which dataset entries you want displayed. The color
Click
of the column header changes to indicate that you are filtering the entries in that column.
Some column filters display a drop-down list to select from and other column filters display a
search field in which you can enter text to select.
Click the sort arrows in a column header to change the sort order of the entries in that column.

•
•

Click
in the upper-right corner of the list to select which columns are displayed.
Drag the bottom of the dataset list area up or down to resize that area.

•

Related references

Administrator roles and capabilities on page 54
Monitoring backup and mirror relationships
You can monitor backup or mirror relationships that are governed by a protection policy that is
assigned to a dataset. For example, you can monitor the lag status of each relationship or monitor that
backups are being created as scheduled.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. (Optional) You can customize the Datasets window Overview tab in any of the following ways:
•

•

Select a dataset to see the configured policy for that dataset and the details about each
component in the policy.
Click
in a column header to control which dataset entries you want displayed. The color
of the column header changes to indicate that you are filtering the entries in that column.
Some column filters display a drop-down list to select from and other column filters display a
search field in which you can enter text to select.
Click the sort arrows in a column header to change the sort order of the entries in that column.

•
•

Click
in the upper-right corner of the list to select which columns are displayed.
Drag the bottom of the dataset list area up or down to resize that area.

•
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Related references

Administrator roles and capabilities on page 54
Backing up datasets on-demand
If you want to obtain copies of your data at any time other than as scheduled, you can back up
datasets on-demand and specify a duration during which the copy must be retained.
Before you begin

•
•
•

The dataset must have a protection policy assigned.
Ensure that you are not initiating an on-demand backup operation during the migration cutover
operation as it may result in a failure.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. From the list of datasets in the Datasets window, select the dataset that you want to back up and
click Protect Now.
3. In the Protect Now dialog box, type a description for the on-demand backup.
4. Also in the Protect Now dialog box, specify the schedule type (hourly, daily, weekly, or monthly)
that specifies the duration that you want the backup copy retained.
Note: If a throttle schedule is applied to the dataset, it also applies to the on-demand backup.

5. Click OK.
The NetApp Management Console data protection capability starts a backup job to protect the
data and directs you to the Jobs window from which you can track the job's progress.
Result

If successful, the NetApp Management Console data protection capability creates backup copies for
all nodes governed by the policy.
After you finish

You can restore the backed-up data by clicking Restore to start the Restore wizard.

142 | Provisioning and Data Protection Online Help
Related references

Administrator roles and capabilities on page 54
Suspending protection and conformance checks of datasets
You can temporarily stop data protection (if a protection policy is assigned) and provisioning
conformance checks (if a provisioning policy is assigned).
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

•

Before performing maintenance on volumes used as destinations for backups or mirror copies,
you might want to stop protection and conformance checking of the dataset to which the volume
belongs to ensure that the NetApp Management Console data protection capability does not
initiate a new backup or mirror relationship for the primary data.
Note: If you suspend protection for a dataset and the lag time exceeds the threshold defined for
the dataset, no lag threshold event is generated until protection is resumed. After you resume
protection for the dataset, the NetApp Management Console data protection capability
generates the backlog of lag threshold events that would have been generated had protection
been in effect and triggers any applicable alarms.
Note: When you suspend services on application datasets, the external application continues to

perform local backups as scheduled.
•

This task suspends all policies that are assigned to the dataset. You cannot choose to suspend only
protection when both protection and provisioning policies are assigned to a dataset.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset and click Suspend.
3. In the confirmation dialog box, click Yes.
The Details area of the Datasets window shows a Protection Suspended status if the dataset has a
protection policy assigned, and a Nonconformant status if the dataset has a provisioning policy
assigned.
Result

All scheduled backups and provisioning are cancelled until service is resumed.
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After you finish

After you bring the storage system volume online again, you must wait for the DataFabric Manager
server to recognize that the volume is back online. You can check the backup volume status using
Operations Manager.
You can resume data protection from the Datasets window.
Related references

Administrator roles and capabilities on page 54
Resuming protection of datasets
You can cause the NetApp Management Console data protection capability to resume protecting
datasets and continue generating backup copies and mirroring data on schedule.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. From the list of datasets in the Datasets window, select the dataset for which protection is
suspended and click Resume.
The NetApp Management Console data protection capability resumes data protection.
Related references

Administrator roles and capabilities on page 54
Displaying export and mapping information for all members of a dataset node
You can display export protocol and physical resource mapping information for all members of a
selected dataset node.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Datasets > Overview.
The NetApp Management Console provisioning capability displays the datasets included in your
view.
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2. Select the dataset that contains the dataset node whose export and physical resource mapping you
want to display.
The NetApp Management Console provisioning capability displays the nodes of the selected
dataset.
3. Select the dataset node whose export and physical resource mapping you want to display.
The NetApp Management Console provisioning capability displays overview status information
for the selected node.
4. Locate the Exports parameter and click

next to it.

The NetApp Management Console provisioning capability displays the Exports Mapping list
which lists the path export protocol and physical resource path for every dataset member
contained on the selected node.
Related references

Administrator roles and capabilities on page 54
Displaying export properties for a specific dataset member
You can display detailed export protocol properties for a selected dataset member. The export
properties displayed are the same as those you configured for either the individual dataset member or
as those you configured for the containing dataset node.
Before you begin

•
•

Know the dataset location of the dataset member whose export protocol information you want to
display.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The export properties displayed are the properties you configured for the individual dataset member
or those you configured for the containing dataset node.
Steps

1. From the menu bar, click Data > Datasets > Provisioning.
The NetApp Management Console provisioning capability displays the names of the datasets that
you have access to in data column of the top table.
2. Select the dataset that contains the dataset member whose export protocol properties you want to
review.
The NetApp Management Console provisioning capability displays the names of the members of
the selected dataset in the storage column.
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3. Select the dataset member that has the export protocol properties that you want to display and
click the Exports tab.
The NetApp Management Console provisioning capability displays the export protocol properties
for the selected dataset member.
Related concepts

Overview of export protocol properties on page 112
Related references

Administrator roles and capabilities on page 54

Restoring data for a dataset
The NetApp Management Console data protection capability tracks where it has made copies of the
original primary data and enables you to restore the data from any of its copies.
Overview of restoring data
Using the NetApp Management Console data protection capability, you can restore files contained in
volumes, qtrees, vFiler unit directories, Open Systems SnapVault directories, and virtual machines
(VMs) that are members of a dataset.
You can initiate a restore operation by invoking the Restore wizard from the Overview tab in the
Datasets window. After you complete a restore request, you can use the Jobs window to view the
progress of the restore job and also monitor it for possible errors. You can also enable the NetApp
Management Console data protection capability to update you on job progress through desktop
messages.
Supported data restore operations
There are many data restore operations available.
You can choose to restore data to the following locations:
•

The data's original location.
If you are restoring a LUN, the following points apply:
•

•

If the NetApp Management Console data protection capability is not configured to support
non-disruptive LUN restore, the LUN in the destination location must be offline before you
start the restore operation.
• If the NetApp Management Console data protection capability is configured to support nondisruptive LUN restore, the LUN in the destination does not have to be offline unless it is
owned by a vFiler unit.
• If the destination LUN is owned by a vFiler unit, non-disruptive LUN restore is not supported.
A new location.
If you restore data to a new location that is not contained in a dataset, then your restored data is
not protected in its new location. To protect the restored data, add it to a dataset.
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The NetApp Management Console data protection capability supports the following restore
operations:
•
•
•
•
•
•

Restore data from a local backup copy
Restore data from a remote backup copy
Restore data from the backup of a mirror
Restore data from the mirror of a backup
Restore data to an Open Systems SnapVault host
For virtual machines, restore data to any location

Restore locations for virtual machines
If you are restoring a virtual machine, you have three types, rather than two types of restore location
options.
•

•

•

The virtual machine's original location
The virtual machine is restored and installed on its original location, through its original Open
Systems SnapVault host on its original ESX server.
A new location
The virtual machine image and data is stored as files in another location. If read by a virtual
machine reader, it can run as an active virtual machine.
Another ESX server
If the original Open Systems SnapVault host does not exist anymore, you can restore the virtual
machine to the original location through any other Open Systems SnapVault host on an ESX
server which can access the data store.

File overwrite and out-of-space warnings for file-level restore
Before executing a file-level restore from a storage system backup, you can enable the NetApp
Management Console data protection capability to warn about file overwrite or out-of-space
conditions during restore.
•

File overwrite warnings are issued if a file is detected in the target container with a name that
matches a backup file that was selected for restore.
In most cases, if you are restoring a file from a backup to a destination location, you intend to
overwrite the file in the destination location with its backup version. Nevertheless, the NetApp
Management Console data protection capability warns you to prevent an accidental overwrite of
the destination file version.
Attention: If you attempt to simultaneously restore several files with a common name, but

located in multiple qtrees back to a single qtree, the NetApp Management Console data
protection capability overwrites all those files except the last one and issues no warning to
prevent unintentional overwrites from occurring.
•

Out-of-space warnings are issued if the target container does not have enough free space to
accommodate restore of a selected file.
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•

•
•

The NetApp Management Console data protection capability does not issue file overwrite or outof-space warnings for volume-level restores, qtree-level restores, folder-level restores, restores
from Open Systems SnapVault backups, or restores from VMware ESX 3.5 server backups.
File overwrite warnings are not issued if the restore target storage system is running Data
ONTAP 7.2. x or earlier.
Out-of-space warnings are not issued if the restore source storage system is running Data ONTAP
7.1.x or earlier.

Restore guidelines
Review these guidelines prior to restoring data using the NetApp Management Console data
protection capability.
•

•

•

The NetApp Management Console data protection capability restores data components as small
as single files and as large as qtree units. If you want to restore a complete volume, you must
restore all its qtree members.
When restoring data to an Open Systems SnapVault host, the NetApp Management Console data
protection capability overwrites the existing destination Open Systems SnapVault directories and
their files.
In an Open Systems SnapVault relationship, if the secondary storage is in a different domain than
its Open Systems SnapVault host, the /etc/hosts files must include FQDN-IP mapping.

The restore_symboltable file
When the NetApp Management Console data protection capability restores copies of the primary
data, Data ONTAP adds a restore_symboltable file in the destination directory. The DataFabric
Manager server automatically attempts to delete this file from the destination directory after the
restore operation.
For more information about the restore_symboltable file, see the Data ONTAP man pages.
Restoring backed-up data to a new location
You can restore backed-up data to a new location if you want to preserve the current content of a
dataset. After you restore the backed-up files, you can decide whether you want to overwrite the
existing data with the backed-up files.
Before you begin

•

Before restoring backed up data to a new location, have the following information available:
•
•

•

The backup version that you want to restore.
The volumes, qtrees, directories, files, or Open Systems SnapVault directories you want to
restore.
• The new volume or qtree location to which you want to restore the files.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
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About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that includes the files that you want to restore and click Restore to start the
Restore wizard.
The wizard displays the Backup Files window.
3. (Optional) Select Warn about overwrite and out-of-space conditions on the destination.
Note: This option enables warnings only for file-level restores from storage system backups.

The Restore wizard does not issue file overwrite or out-of-space warnings for volume-level
restores, qtree-level restores, folder-level restores, restores from Open Systems SnapVault
backups, or restores from ESX server backups.
4. In the Backup Files window, select the backup copies that you want to restore.
5. Select the volume, qtrees, directories and files contained in the backup copies that you want to
restore and click Next.
You can select multiple volumes, qtrees, directories or files simultaneously.
6. In the Restore Preferences window, click Choose a location to restore the files in a new
location and click Next.
The list shows only volumes that are online.
7. In the Restore Path window, either select the volume or qtree in which you want to restore the
files or type the restore path in the Restore path field, then click Next.
The volume to which you are restoring the backup files must contain a directory.
The Restore wizard executes a trial run of your request and tests for warning conditions.
•

•

If you specified a file-level restore from a storage system backup, if you enabled warning
messages, and if file overwrite or out-of-space conditions exist, the Restore wizard displays
warning messages that list the files for which those conditions apply.
In all other cases, the Restore wizard displays no warnings.

8. If the Restore wizard displays no file overwrite or out-of-space warnings that require correction,
click Next.
The Restore wizard displays the volumes, qtrees, directories, or backup files that will be restored
and the location in which they will be restored.
9. If the Restore wizard displays file overwrite or out-of-space warnings that require correction,
cancel the Restore wizard operation, correct the conditions, and restart the Restore wizard again.
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10. (Optional) To receive desktop notifications of your job status, click Notify on job progress.
A job alert dialog box appears in the lower right-hand corner of the window.
11. Click Finish to end the wizard and begin the restore operation.
After you finish

•
•

You can use the Jobs window to track the progress of the restore job and monitor the job for
possible errors.
After the NetApp Management Console data protection capability restores the data, you must add
it to a dataset to protect the data.

Related references

Administrator roles and capabilities on page 54
Restoring backed-up data over current data
You can overwrite current data with their restored copies. You can restore backed-up data over
existing data if you suspect that the current files in a dataset are corrupted.
Before you begin

•

Before restoring backed-up data over current data, have the following information available:
•
•

•

The backup version that you want to restore.
The volumes, qtrees, directories, files or Open Systems SnapVault directories you want to
restore.
Ensure that the following conditions are true:

•

•

If you are restoring a LUN, and the NetApp Management Console data protection capability is
not configured to support nondisruptive LUN restore, the LUN in the destination location is
offline.
If the NetApp Management Console data protection capability is configured to support nondisruptive LUN restore and you are restoring to a LUN that is owned by a vFiler unit, that
vFiler unit is a primary vFiler unit.
Note: Performing nondisruptive restore to a LUN owned by a vFiler unit restores the
backed-up LUN without its original LUN mappings. Therefore, you must map the restored
LUN again.

•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
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Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that includes the files that you want to restore and click Restore to start the
Restore wizard.
The wizard displays the Backup Files window.
3. (Optional) Select Warn about overwrite and out-of-space conditions on the destination.
Note: This option enables warnings only for file-level restores from storage system backups.

The Restore wizard does not issue file overwrite or out-of-space warnings for volume-level
restores, qtree-level restores, folder-level restores, restores from Open Systems
SnapVault backups, or restores from ESX server backups.
4. In the Backup Files window, select the backup copy that you want to restore.
5. Select the volumes, qtrees, directories and files contained in the backup copies that you want to
restore and click Next.
You can select multiple volumes, qtrees, directories, or files simultaneously.
6. In the Restore Preferences window, click Original location to overwrite current data with the
restored data and click Next.
7. The Restore wizard executes a trial run of your request and tests for warning conditions.
•

•

If you specified a file-level restore from a storage system backup, enabled file overwrite or
out-of-space warnings, and file overwrite or out-of-space conditions exist, the Restore
wizard displays warning messages that list the files for which those conditions apply.
In all other cases, the Restore wizard displays no warnings.

8. If the Restore wizard displays no file overwrite or out-of-space warnings that require correction,
click Next.
The Restore wizard displays the volumes, qtrees, directories, or backup files that will be restored
and the location in which they will be restored.
9. If the Restore wizard displays file overwrite or out-of-space warnings, that require correction,
cancel the Restore wizard operation, correct the conditions, and restart the Restore wizard again.
10. (Optional) To receive desktop notifications of your job status, click Notify on job progress.
A job alert dialog box appears in the lower right-hand corner of the window.
11. Click Finish to end the wizard and begin the restore operation.
After you finish

•
•

You can use the Jobs window to track the progress of the restore job and monitor the job for
possible errors.
If you performed a nondisruptive LUN restore to LUNs owned by a vFiler unit, you must restore
the LUN mappings that were lost during the restore.
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Related references

Administrator roles and capabilities on page 54
Restoring selected portions of a dataset
You can start the Restore wizard and initiate restoring portions of a dataset.
Before you begin

•

Before restoring portions of a dataset, have the following information available:
•

•

The backup version that you want to restore. All backup copies are displayed by their backup
dates and dataset descriptions.
• The files and directories you want to restore.
• The location to which you want to restore backups.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that includes the files that you want to restore and click Restore to start the
Restore wizard.
The wizard displays the Backup Files window.
3. Complete the steps in the Restore wizard.
After you finish

•
•

You can use the Jobs window to track the progress of the restore job and monitor the job for
possible errors.
To receive e-mail notifications of your job status, click Notify on job progress on the
Completing the Restore Wizard window of the Restore wizard.

Related references

Administrator roles and capabilities on page 54
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Restoring a virtual machine to its original Open Systems SnapVault location
You can restore a virtual machine that was backed up from an Open Systems SnapVault host to its
original location. When the restore completes, Open Systems SnapVault returns power to the virtual
machine.
Before you begin

•

Before restoring a virtual machine to its original Open Systems SnapVault location, have the
following information available:
•
•

•

The backup version that you want to restore.
Whether you want to restore the entire virtual machine including its configuration, or just the
data.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that includes the virtual machines that you want to restore and click Restore to
start the Restore wizard.
The wizard displays the Backup Files window.
3. In the Backup Files window, select the backup copy that you want to restore.
Note: Do not enable the "Warn about overwrite and out-of-space conditions on the destination"

option. The Restore wizard does not issue file overwrite or out-of-space warnings for restores
from Open Systems SnapVault backups.
4. From the list of backup files on the right, select the type of information you want to restore and
click Next.
If you select Data, the restored information includes the data (VMDK) files. If you select
Configuration, the restored information also includes the configuration files,
including .vxm, .vmsd, .vmxf, .nvram, and vmware.log. You cannot restore the configuration files
without also restoring the data files.
5. In the Restore Preferences window, click Original location to overwrite current data with the
restored data and click Next.
The Restore wizard displays the backup files to be restored.
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6. Click Finish to end the wizard and begin the restore operation.
After the restore operation is finished, Open Systems SnapVault restarts the virtual machines.
After you finish

You can use the Jobs window to track the progress of the restore job and monitor the job for possible
errors.
Related references

Administrator roles and capabilities on page 54
Restoring a virtual machine file system backed up from an Open Systems SnapVault host
to any location
You can restore a virtual machine backed up from an Open Systems SnapVault host as files to any
location. You can restore virtual machine file systems to a new location if the original data store that
hosted the virtual machine does not exist anymore or if you want to test the file system when it is not
installed on a server. At the completion of the restore, you need to use VMware tools to configure
and power on the virtual machine.
Before you begin

•

Before restoring virtual machine file systems backed up from an Open Systems SnapVault host to
a new location, have the following information available:
•
•

•

The backup version that you want to restore.
Whether you want to restore the entire virtual machine including its configuration, or just the
data.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that includes the virtual machine files that you want to restore and click
Restore to start the Restore wizard.
The wizard displays the Backup Files window.
3. In the Backup Files window, select the backup copy that you want to restore.
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Note: Do not enable the "Warn about overwrite and out-of-space conditions on the destination"
option. The Restore wizard issues file overwrite or out-of-space warnings only for file-level
restores from storage system backups.

4. From the list of backup files on the right, select the type of information you want to restore and
click Next.
If you select Data, the restore process includes the data (VMDK) files. If you select
Configuration, the restore process also includes the configuration (vmx) files. You cannot restore
the configuration files without also restoring the data files.
5. In the Restore Preferences window, select Choose a location to save the virtual machine as files
to a new location and click Next.
6. In the Restore Path window, either select the directory path in which you want to restore the files
or type the directory path in the Restore path field, then click Next.
The Restore wizard displays the backup files to be restored and the location to which the files are
restored.
7. Click Finish to end the wizard and begin the restore operation.
After the restore operation is finished, you must use VMware tools to configure and power on the
virtual machine.
After you finish

You can use the Jobs window to track the progress of the restore job and monitor the job for possible
errors.
Related references

Administrator roles and capabilities on page 54
Restoring a virtual machine backed up from an Open Systems SnapVault host to its
original location through another ESX server
You can restore a virtual machine backed up from an Open Systems SnapVault host to its original
location through another ESX server as long as the new ESX server has access to the same data
stores as the original ESX server.
Before you begin

Before restoring data backed from an Open Systems SnapVault host to its original location through a
different ESX server, ensure that the following conditions are true:
•

Before restoring a virtual machine to its original location, have the following information
available:
•
•

The backup version that you want to restore
Whether you want to restore the entire virtual machine including its configuration, or just the
data
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•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

•

You can restore a virtual machine using another ESX server if the original Open Systems
SnapVault host that backed up the virtual machine does not exist anymore. You can also restore a
virtual machine using another ESX server if the original ESX server is heavily loaded and you
want to distribute the workload. If the original ESX server is not online when the virtual machine
is restored, you must register the virtual machine to the new ESX server and power on the virtual
machine using VMware tools.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that includes the backup files that you want to restore and click Restore to start
the Restore wizard.
The wizard displays the Backup Files window.
3. In the Backup Files window, select the backup copy that you want to restore.
Note: Do not enable the "Warn about overwrite and out-of-space conditions on the destination"

option. The Restore wizard does not issue file overwrite or out-of-space warnings for restores
from Open Systems SnapVault backups.
4. From the list of backup files on the right, select the type of information you want to restore and
click Next.
If you select Data, the restored information includes the data (VMDK) files. If you select
Configuration, the restored includes the configuration (vmx) files. You cannot restore the
configuration files without also restoring the data files.
5. In the Restore Preferences window, click Choose an ESX Server to restore the files to a new
ESX server and click Next. (The list shows only ESX hosts that can be used for restoring.)
6. In the ESX Server window, choose the ESX server to which you want to restore the virtual
machines and click Next.
Only ESX servers that have access to all the data stores used by all the virtual machines you want
to restore are available for selection.
The Restore wizard displays the backup files to be restored and the location to which the virtual
machines are restored.
7. Click Finish to end the wizard and begin the restore operation.
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Restoring a virtual machine to a new ESX server does not assign that virtual machine to that ESX
server. You must reassign the virtual machine through VMware VirtualCenter.
After you finish

•
•

You can use the Jobs window to track the progress of the restore job and monitor the job for
possible errors.
After the NetApp Management Console data protection capability restores the data, you must add
it to a dataset to protect the data.

Related references

Administrator roles and capabilities on page 54

What a resource pool is
A resource pool is a collection of unused physical storage resources, such as aggregates and disks,
grouped together based on a user-defined set of common attributes.

About resource pools
You might pool your resources based on attributes such as performance, cost, physical location, or
availability. By grouping related resources into a pool, you can treat the pool as a single unit for
monitoring, provisioning, reporting, and role based access control (RBAC). This simplifies the
management of these resources and allows for a more flexible and efficient use of the storage.
Overview of resource pools
You create resource pools by using the Add Resource Pool wizard, which is accessible from the
Resource Pools window. The wizard lets you select aggregates, entire storage systems, or groups of
physical resources from which to create your resource pool.
After you create a resource pool, you can associate it with one or more datasets. You can also
associate datasets with provisioning and protection policies. These tasks can be accomplished when
you add or edit datasets from the Datasets window.
When you assign a data protection policy, the NetApp Management Console data protection
capability applies the policy settings to automatically provision destination volumes from the
assigned resource pool. It then creates backup and mirror relationships from each volume and qtree
in the dataset to the newly provisioned secondary storage.
When you assign a provisioning policy to a dataset node, the NetApp Management Console
provisioning capability applies the availability characteristics and space settings in the policy to
automatically select the resources needed to fulfill a request for storage space for the primary data of
a dataset.
These relationships between physical storage units, resource pools, and datasets mean that you must
consider carefully what the impact might be of changes made to the system.
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Related concepts

Dataset concepts on page 65
What groups are on page 67
Ways you might combine resources in resource pools on page 157
Related references

Advantages of using resource pools on page 157
Advantages of using resource pools
Resource pools enable you to simplify physical storage resource management.
Creation and use of resource pools gives you the following advantages:
•
•
•
•
•
•
•

You can group various resources with similar attributes, providing a quick view of similar storage
objects.
Resource pools provide a single logical unit for provisioning.
You can simplify physical resource management by managing a pool of resources as a single
entity.
You can configure your system to automatically provision storage from resource pools, without
your intervention.
You can create resource pools in advance of allocating them to datasets, so that the resource pools
are available when needed.
You can enable event generation on resource pools so that when a set threshold is crossed, an
event is generated to alert the resource pool owner.
You can assign a label to resource pools or members of resource pools.
This allows you to filter the resources available for provisioning to only those that have a specific
label assigned to them.

Ways you might combine resources in resource pools
Prior to creating resource pools, consider how you will be using the available storage. This will help
you to determine how you want to combine those resources into resource pools to meet your setup's
replication needs.
Following are examples of ways that you might combine your physical resources to make the most
efficient use of your resource pools:
•

•

•

A set of aggregates composed of inexpensive, slow, ATA drives
This pool is suitable for archival or compliance purposes, but it is not appropriate for missioncritical, high-performance database applications.
A set of high-performance aggregates composed of 15K Fibre Channel disk drives in a RAID-DP
configuration
This pool is suitable for enterprise-critical applications.
A set of resources categorized based on cost or performance
This pool might be given a simple designation, such as Gold, Silver, or Bronze.
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•
•

A set of storage systems that are suitable for provisioning for certain departments within an
organization
A set of homogenous resources grouped together as a way of restricting access to highperformance storage

Sequence for selecting backup destination volumes
If an existing backup relationship already has a volume assigned to contain backup data, the NetApp
Management Console data protection capability tries to use it. Otherwise, the NetApp Management
Console data protection capability selects an existing volume that meets certain requirements or, if
necessary, provisions a new destination volume.
By default, the size requirement for destination volumes that are provisioned by the NetApp
Management Console data protection capability are dynamically sized either to 1.1 x 2 x the
currently used primary volume storage or to 1.1 x 1.2 x the primary volume size, whichever is
greater. However, if the DataFabric Manager server dynamic secondary sizing option,
dpDynamicSecondarySizing, is disabled, the new volume is thin provisioned to be the same size as
the aggregate in which it resides.
Note: Whenever possible, the NetApp Management Console data protection capability uses

FlexVol volumes when provisioning backup destination volumes. The NetApp Management
Console data protection capability implements aggregate overcommitment, observing the
Aggregate Overcommitted and Aggregate Nearly Overcommitted thresholds specified in
Operations Manager. For more information about aggregate overcommitment, see the Operations
Manager Administration Guide and the Data ONTAP 7-Mode Storage Management Guide. For
information about the aggregate overcommitment thresholds, see the Operations Manager online
Help.
For data residing on Open Systems SnapVault clients, the NetApp Management Console data
protection capability uses a projected size of 10 GB for the destination volume.
To be considered as a destination for backups, a volume must be on a storage system configured with
the appropriate Data ONTAP licensing to store backups.
From the pool of volumes that meet these requirements, the NetApp Management Console data
protection capability takes the following steps to select a destination volume for backups:
1. The NetApp Management Console data protection capability looks for secondary volumes
associated with the dataset that already have a relationship originating from the primary volume.
However, if a secondary volume has too many relationships, the NetApp Management Console
data protection capability excludes that volume from the selection process. The default maximum
number of relationships is 50.
2. Of the secondary volumes associated with the dataset that have a preexisting relationship with the
primary volume, the NetApp Management Console data protection capability looks for a
destination that has enough space to satisfy the projected space requirement of the primary data.
3. If none of the secondary volumes with preexisting relationships with the primary volume can
satisfy the space requirement, the NetApp Management Console data protection capability scans
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the destination systems for an existing FlexVol volume with adequate space and no SnapVault or
Qtree SnapMirror relationships.
4. If the NetApp Management Console data protection capability cannot locate an existing FlexVol
volume with adequate space and no SnapVault or Qtree SnapMirror relationships, it scans the
destination systems for existing traditional volumes with adequate space and no SnapVault or
Qtree SnapMirror relationships.
5. For systems running Data ONTAP 7.0 or later, if the NetApp Management Console data
protection capability cannot find a volume with adequate space and no existing SnapVault
relationships, it attempts to provision a FlexVol volume.
6. If the NetApp Management Console data protection capability cannot provision a FlexVol
volume, it generates an error.
Related information

Operations Manager Administration Guide - http://support.netapp.com/NOW/knowledge/docs/
DFM_win/dfm_index.shtml
Sequence for selecting mirror destination volumes
To find a suitable destination to contain mirrored data, the NetApp Management Console data
protection capability tries to use the same volume used for an existing mirror relationship, if there is
one. Otherwise, the NetApp Management Console data protection capability selects an existing
volume that meets certain requirements or, if necessary, provisions a new destination volume.
If the NetApp Management Console data protection capability needs to provision a new volume to
contain mirrored data, by default the new volume is provisioned to be the same size as the source
volume being protected. However, if the DataFabric Manager server dynamic secondary sizing
option, dpDynamicSecondarySizing, is disabled, the new volume is thin provisioned to be the same
size as the aggregate in which it resides.
Note: If the NetApp Management Console data protection capability provisions a mirror
destination volume on a tertiary node, the new volume is provisioned to be the same size as the
secondary volume even if the secondary volume is larger than the tertiary aggregate. Space
guarantees for the new volume are disabled.

The NetApp Management Console data protection capability takes the following actions to select a
destination volume for mirror copies:
1. If there is no existing mirror relationship, the NetApp Management Console data protection
capability scans the destination systems for an existing volume that meets the following
requirements:
•
•
•

It is located on a storage system running the same version as or a later Data ONTAP version
of the storage system containing the data to be mirrored.
It is located on a storage system on which the SnapMirror license is enabled.
It is of the same type (FlexVol or traditional volume) as the volume containing the data to be
mirrored.
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•
•
•

It is the same size as or larger than the source volume
It has no SnapVault or SnapMirror relationships.
It is within an aggregate of the same block type as the aggregate containing the source volume
unless both source and destination storage systems use Data ONTAP-v8.1 or later.
If both source and destination volumes are on systems using Data ONTAP-v8.1 or later,
matching block types are not required.

2. If the NetApp Management Console data protection capability cannot locate an existing volume
that meets the preceding requirements, it attempts to use available space in the resource pool to
provision a new volume of the same type as the volume containing the data to be mirrored.
For the NetApp Management Console data protection capability to provision a new volume, the
aggregate or spare disk where the new volume is created must meet the following requirements:
•
•
•
•

It belongs to a storage system running the same version as or a later Data ONTAP version of
the storage system containing the data to be mirrored.
It belongs to a storage system on which the SnapMirror license is enabled.
It has adequate space to contain the data in the source volume.
It is within an aggregate of the same block type as the aggregate containing the source volume
unless both source and destination storage systems use Data ONTAP-v8.1 or later.
If both source and destination volumes are on systems using Data ONTAP-v8.1 or later,
matching block types are not required.

3. If the NetApp Management Console data protection capability cannot provision a new volume for
the data to be mirrored, it generates an error.
Resource pool guidelines
Before adding or modifying a resource pool, you should make sure your plans follow the guidelines
that can help you optimize the advantages of using resource pools.
The status of a resource pool is equivalent to the worst status of any event associated with any
member of that resource pool.
Guidelines for the content and structure of resource pools
Resource pools cannot nest and cannot overlap (that is, storage in one resource pool cannot be in
another resource pool).
The following guidelines can help you optimize the advantages of using resource pools:
•
•
•

•
•

Resource pools can be members of DataFabric Manager groups, but resource pools cannot
contain DataFabric Manager groups.
Resource pools can be created from entire storage systems or from aggregates.
Adding a storage system to a resource pool implies that all existing aggregates and spare disks on
the storage system are included as part of that pool, along with any new aggregates that are
created.
Members of a resource pool do not all need to reside on the same storage system or HA pair.
A storage system can be designated as a resource pool that contains a mixture of resources with
various attributes.
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•
•

A storage system or an aggregate can only belong to one resource pool at a time.
Individual aggregates within the same storage system can belong to different resource pools as
long as the storage system as a whole has not been assigned to a resource pool.

Guidelines for selecting storage to include in resource pools
When creating a resource pool, you determine which storage elements to include in the pool based on
one or more common properties, such as "all storage in the same building" or "all storage delivering
the same level of performance."
The following guidelines can help you optimize the advantages of using resource pools:
•

•

•

•

Adding an aggregate to a resource pool allows the NetApp Management Console provisioning
capability to create new volumes by using the aggregate's free space.
When provisioning resources, the aggregate's preexisting volumes are not used.
When provisioning resources for primary data, you can choose to increase the available space in
an existing volume by deleting Snapshot copies or by assigning additional space for the volume.
LUNs cannot be resized.
In a NAS environment, you can grow space and delete Snapshot copies only manually. In a SAN
environment, these tasks can be done manually, but they can also be done automatically by using
a provisioning policy.
Access to a resource pool is controlled via role-based access control (RBAC).
Therefore, in some deployments you might want to group homogeneous resources together as a
way of restricting access to high performance storage. In other deployments you might construct
resource pools with a mix of storage attributes as a means of providing better storage utilization
across an organization.
Systems running on Data ONTAP versions earlier than 7.0 cannot use the aggregate or flexible
volume features.
This impacts how you assign destination resources for mirrored copies and backups.
Mirrors If you are mirroring data, you can only select entire storage systems to include in
resource pools. The NetApp Management Console data protection capability uses the
spare disks on the storage systems to provision traditional volumes for the mirrored
copies.
Backups The NetApp Management Console data protection capability cannot provision
resources for backup jobs. You must, manually create the volumes to add to the
dataset's secondary node. When you assign resources to a dataset, only the volumes
are available for selection.

Guidelines for provisioning from resource pools
When a resource pool contains a storage system, all aggregates on the storage system are available
for provisioning.
The following guidelines can help you optimize the advantages of using resource pools:
•

Both traditional and flexible volumes can be created from a resource pool.
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•

•

However, flexible volumes are available only on storage systems that are running Data ONTAP
7.0 or later.
Aggregates are used for provisioning of flexible volumes for Data ONTAP 7.0 or later. Spare
disks are used for provisioning of traditional volumes by the administrator, for Data ONTAP
versions prior to 7.0.
When using the NetApp Management Console data protection capability, you cannot control how
specific volumes are provisioned from resource pools.
The NetApp Management Console provisioning capability evaluates available resources for a
number of criteria, such as valid login credentials, working NDMP, Data ONTAP version, and so
forth. From the aggregates that pass those filters, the NetApp Management Console provisioning
capability picks the aggregate with the most free bytes as the one to hold the backup.

Guidelines for naming and labeling resource pools
You should name resource pools according to the characteristics of the storage each resource pool
contains.
The following guidelines can help you optimize the advantages of using resource pools:
•

•

The name is limited to 64 characters.
However, for readability, it is advised that names be no longer than 25 characters. You can use
any combination of letters, numbers, or special characters in resource pool names.
Use a label name that has significant meaning.
A label should only be used when you want to more narrowly control the resources being
provisioned. For example, if you want to restrict the provisioned resources by their cost and
performance, you might assign a label of Tier-1, Tier-2, or Tier-3. If a Tier-1 resource label is
selected for a provisioning policy and a provisioning action occurs, only those resources assigned
to the dataset and labeled as Tier-1 is considered for provisioning.

How resource labels work
You can assign a resource label as a way to narrow the available resources to be considered for a
provisioning request.
The resource label can be assigned when you create a resource pool. This is an optional custom
property that you can assign to a resource pool or to the individual storage systems or aggregates that
comprise the resource pool. You might assign a resource label based on factors such as cost,
reliability, or specific configurations. The resource label essentially functions as a filter. It allows you
to identify specific resources to be used to fulfill a provisioning request, so that only those resources
that have the label assigned to them are considered. This allows finer control when matching
provisioning requests with available resources.
When you create a provisioning policy, you can specify a resource label to be associated with the
policy. If a label is specified for a policy, only the resource pools and resource pool members that
match the label are used when a provisioning request is fulfilled using that policy. However, storage
that has an assigned resource label can still be used to fulfill provisioning requests that do not specify
a label.
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For example, assume an administrator assigns a resource label of Tier-1 to a resource pool
containing the highest-cost, most reliable storage. The administrator also creates a provisioning
policy named prov-pol-1, with the resource label Tier-1 specified. When a provisioning request is
made on a dataset that has the prov-pol-1 policy assigned to it, the NetApp Management Console
provisioning capability searches for storage that uses the Tier-1 label. If no resources with that
resource label are available, the provisioning request fails. For this reason, you should use resource
labels with care.

Configuring resource pools
In general, you use a wizard to configure resource pools and you use an editing window to modify
property values.
Decisions to make before configuring a resource pool
Before creating a resource pool by using the Add Resource Pool wizard, or modifying a resource
configuration by using the Edit properties option, is useful to have all the resource pool configuration
information ready.
Name
(required)

What name do you want to assign to the resource pool?
•

•

Description
(optional)

How do you want to describe the resource pool, so the intended use of the resource
pool is clear?
•

•
Owner
(optional)

Provide a meaningful description of the resource pool, such as an explanation of
the intended use of the resource pool, the type of storage contained in the
resource pool, or some other common attribute that identifies why the storage
was grouped into a resource pool.
The limit is 255 characters, but for readability, it is advised that you keep the
description under 40 characters.

Who should be contacted regarding problems with the resource pool?
•
•

Contact
(optional)

Provide a meaningful name that briefly describes the storage or the intended use
of the storage in the resource pool.
An example of a name that describes the storage path is: server1_homedirs,
tier1_mktg, or china_eng.
Special characters and spaces are permitted in names.
The limit is 64 characters, but for readability, it is advised that you keep the
name under 25 characters.

Provide the name of the person or people responsible for maintaining this
resource pool.
You can list multiple owners, delimited by commas. There is no formatting
restriction.

Who should be alerted regarding problems with the resource pool?
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•
•
•

Provide the e-mail addresses or e-mail aliases to which notifications, alerts, and
so forth should be sent concerning the resource pool.
The e-mail addresses listed here might be the same ones used for receiving
alerts regarding the resource pool.
You can have multiple e-mail contacts, delimited by commas.

Time Zone
(required)

Will you use the default time zone for the resource pool or change the time zone?

Physical
Resources
(required)

How will you determine which storage to include in the resource pool from the list
of physical resources available?

•

•
•
•

•

The resource pool must have a time zone selected. You can retain the default
setting or change it.
To select a time zone, you can either scroll through the entire list or type a time
zone designation in the Filter Time Zone text box.

Decide on which properties you want to base the creation of the resource pool:
for example, location, cost, performance, reliability, or access privileges.
Decide whether the resource pool will contain individual aggregates, an entire
storage system (all the aggregates in a storage system), or a combination.
Decide which version of Data ONTAP will run on the systems in this resource
pool.
Systems running Data ONTAP versions earlier than 7.0 cannot use the
aggregate or flexible volume features. This impacts how you later assign
destination resources for mirror copies and backups.
Decide if you want to use traditional volumes or flexible volumes in the
resource pool.
•
•

•
•
Labels
(optional)

Flexible volumes are available only when running Data ONTAP 7.0 or later.
Aggregates are used for provisioning of flexible volumes, and spare disks
are used for provisioning of traditional volumes.
• If you intend to associate a resource pool with a dataset in a mirror
relationship, the volumes on the primary node and those on the secondary
nodes must be of the same type. You cannot combine traditional volumes
and FlexVol volumes on nodes that are part of a mirror relationship.
Decide how much available storage space you need for the resource pool, based
on the resource pool's intended use.
Verify that you have the appropriate software licenses on the storage you intend
to use.

When a provisioning request is processed, do you want to restrict the resources
available for provisioning to only those with a specific label assigned to them?
•

A label set on an individual member of a resource pool takes priority over a
label applied to the entire resource pool. It essentially functions as a filter,
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•

Space
Thresholds
(optional to
modify
default)

allowing you to identify specific resources to be considered when fulfilling a
provisioning request.
The labels can be edited inline in the table. For both resource pool and
members, an existing label can be selected from the drop-down list or a new
label can be typed in. A resource label is a text string of any length.

At what point do you want to receive notification regarding consumption of space
in the resource pool?
•

•

Resource Pool Nearly Full threshold and Resource Pool Full Threshold
These thresholds can be used to track the amount of space that is consumed in a
resource pool. Events are generated when these thresholds are reached. The
default thresholds are: Nearly Full = 80%, Full = 90%.
Aggregate Nearly Overcommitted threshold and Aggregate Overcommitted
threshold
These thresholds can be used to track the sum of committed space of all the
aggregates that belong to the resource pool. Events are generated when these
thresholds are reached.
Tracking these thresholds in an environment in which the aggregates are
overcommitted (thin provisioning) is particularly important, because in such an
environment administrators commit more storage than is physically available.
The default thresholds are: Nearly Overcommitted = 300%, Overcommitted =
400%.

Related concepts

Effect of time zones on schedules on page 220
Protection policy node prerequisites on page 195
Decisions to make before adding or changing resource assignments on page 108
Related references

Resource pool guidelines on page 160
Adding a resource pool
You can create resource pools from collections of unused physical storage resources. Resource pools
are associated with one or more datasets, providing the physical resources for provisioning primary
storage by using a provisioning policy and also for backup or mirror protection on nonprimary nodes.
Before you begin

•
•

Ensure that the hosts you are adding to the resource pool have the proper configuration and
licensing for their intended use.
Have the information available that you need to complete this task:
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•

• Resource pool name (required)
• Description (optional)
• Owner (optional)
• Contact e-mail address for alerts (optional)
• Time Zone (optional)
• Physical Resources (required)
• Resource Pool Label (optional)
• Space Thresholds (optional to modify the default)
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Data > Resource Pools.
2. Click Add to open the Add Resource Pool wizard and then complete the wizard.
3. Verify the creation and content of the resource pool by viewing the results that are displayed in
the Resource Pools window.
After you finish

You can use the Datasets window to associate the new resource pool with a new or existing dataset.
•
•

If you want to associate a resource pool with a new dataset, use the Add Dataset wizard.
If you want to associate a resource pool with an existing dataset, use the Edit Dataset window.

If you want to modify any of the properties of a resource pool, click Edit in the Resource Pools
window.
Related concepts

Decisions to make before configuring a resource pool on page 163
Effect of time zones on schedules on page 220
Related references

Data ONTAP licenses used for protecting or provisioning data on page 68
Resource pool guidelines on page 160
Administrator roles and capabilities on page 54
Impact of modifying resource pool properties
Before making changes to the properties of a resource pool, you need to understand the potential
impact of those changes on your data protection setup.
Editing the Name, Description, Owner, or Contact properties for a resource pool does not impact the
functioning of a resource pool; it only modifies the information viewed about the resource pool.
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However, editing the members or the time zone of a resource pool can have a significant impact on
your data. The impact of modifying the membership of an existing resource pool depends on whether
the resource pool is already associated with a dataset.
Modifying a resource pool that is not associated with a dataset
Editing any of the properties of a resource pool that is not associated with a dataset does not impact
any protected data. However, if you are modifying the resources or time zone of a resource pool,
consider the potential result before making the change.
•
•

Will the new size and number of aggregates be adequate for the intended use of the resource
pool?
Will a time zone change affect the schedule synchronization between the primary storage data
and the secondary storage backup or mirror copy?

Modifying a resource pool that is associated with a dataset
Modifying the
members of a
resource pool

•

•

•

Modifying the
time zone of a
resource pool

•
•

Adding or removing the resources of a resource pool might affect the size
and number of aggregates available for provisioning, once the resource pool
is associated with a dataset.
Removing resources: If an entire storage system is assigned to a resource
pool, as aggregates are added to or removed from that storage system, the
aggregates are automatically added to or removed from the resource pool
that the storage system is associated with. You do not need to perform any
additional tasks to have the aggregates available for provisioning.
Adding resources: Verify that any resource you plan to add to a resource
pool is online, properly configured, and licensed for the purpose you intend
for it.
Adding a resource that is not available for provisioning can result in lack of
conformance. For example, if an aggregate you plan to add is nearly full, the
NetApp Management Console data protection and provisioning capabilities
cannot provision from that aggregate and jobs involving that aggregate will
fail.
Does not affect data that is already protected.
Might affect whether the replication schedule on the primary dataset
synchronizes as expected with the schedule on secondary or tertiary
destination storage in the resource pool.

Related concepts

Effect of time zones on schedules on page 220
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Editing resource pool properties
You can edit the properties of an existing resource pool by using the Edit properties option,
accessible from the Resource Pools window.
Before you begin

Have the information available that you need to complete this task, depending on which properties
you intend to edit.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Resource Pools.
2. In the list of available resource pools, select the resource pool that you want to modify.
3. Click Edit to open the Properties sheet.
4. Modify the properties that you want changed.
5. Click OK.
6. Verify the changes to the resource pool properties.
You can verify the changes by viewing the information displayed in the Resource Pools window.
Result

The resource pool's properties configuration is modified and saved.
After you finish

Verify that any dataset associated with the modified resource pool is still in conformance with any
assigned provisioning or protection policies.
Related concepts

Impact of modifying resource pool properties on page 166
Decisions to make before configuring a resource pool on page 163
Related references

Resource pool guidelines on page 160
Administrator roles and capabilities on page 54
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What external relationships are
An external relationship is a SnapVault or SnapMirror relationship that is not managed by the
NetApp Management Console data protection capability. These relationships are discovered by
Operations Manager and listed separately by the NetApp Management Console data protection
capability.
Although a volume or qtree in an external relationship might be in a protected dataset and managed
by the NetApp Management Console data protection capability, the external relationship is not
managed by the NetApp Management Console data protection capability.

About external relationships
You can import external relationships into a dataset. After the relationships are imported, the data is
protected by the NetApp Management Console data protection capability as defined in the protection
policy and are no longer displayed in the External Relationships window. The datasets containing the
newly imported relationships are displayed either in the Datasets window or in the Unprotected Data
window, depending on the protection status of the dataset.
When you first set up the NetApp Management Console data protection capability, or add storage or
vFiler units to systems using the NetApp Management Console data protection capability, the data
and protection relationships from the imported systems are displayed in the External Relationships
window.
After importing an external relationship to a dataset, the NetApp Management Console data
protection capability adds the source qtrees, volumes, and directories, and the destination volumes
and qtrees, to the destination node.
•

•

Importing into an unprotected dataset
If you import an external relationship into a dataset that does not have an assigned protection
policy or has a protection policy but no relationship is created yet, the data from that external
relationship is not protected. Unprotected datasets are listed in the Unprotected Data window.
Importing into a protected dataset
If you import an external relationship into a dataset that has a protection policy and has a
relationship created, the data is protected when the next backup is performed on the dataset.
Protected datasets are listed in the Datasets window.
Attention: Immediately following importation the dataset's protection status temporarily

changes to Job Failure; however, the status changes after the next scheduled or on-demand
protection job is run.
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Where to view external relationships
The External Relationships window lists all SnapVault or SnapMirror relationships (external
relationships) that are not managed by the NetApp Management Console data protection capability.
From this window, you can select one or more discovered relationships to import into a dataset.
When to import external relationships
You can use the External Relationships window to import a discovered relationship when you have
identified that the relationship is not managed by the NetApp Management Console data protection
capability.
After you import external relationships, the NetApp Management Console data protection capability
takes over the management of data protection schedules and policies, and it disables the schedules
and policies that were previously managed by other applications.
If you import a Volume SnapMirror relationship into the NetApp Management Console data
protection capability, the original mirror schedule is preserved. The NetApp Management Console
data protection capability monitors the relationship but does not execute the schedule.
You can also import external relationships in the following situations:
•
•
•

You installed the NetApp Management Console data protection capability and are setting up data
protection for the first time.
You added storage resources to resource pools.
You added existing SnapVault or SnapMirror relationships to datasets.

There are two additional ways of handling existing SnapVault relationships. In both cases, these
relationships are listed in the External Relationships window.
•

•

Storage system controls protection the DataFabric Manager server discovers the SnapVault
relationship but does not manage it. In this case, the storage systems involved in the protection
relationship control the protection schedule and retention policy.
Operations Manager controls protection the DataFabric Manager server discovers the relationship
and you decide to manage the protection schedule and retention policy from the Operations
Manager Web-based user interface. In this case, you must create the protection schedule and
policy using Operations Manager and assign them to the relationship.

Managing external relationships
You must import an external relationship into a dataset if you want the NetApp Management Console
data protection capability to manage protection of the data.
Decisions to make before importing external relationships
Before you use the Import Relationships wizard to import external protection relationships into a
dataset, you need to decide which dataset, if any, meets the requirements of the relationships,
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whether you need to create a new dataset, and which connection to associate with each external
relationship.
Selecting the
dataset

•

Is there an existing dataset that meets the requirements of the external
relationships you want to import?
Review the existing datasets listed on the Datasets window Overview tab to
see if any are suitable. Consider the policy applied to each dataset and the
protection schedule used by the policy. Do the protection requirements of the
other members of the dataset match the protection needs of the external
relationships that you want to import?
Note: You cannot import an Open Systems SnapVault host or directory

into a dataset when a local backup schedule is already defined on the
primary node. You can import them only into datasets that have policies
specifying either no protection or remote backups only.
•

•
•

Determining
•
which
connection to
associate with a
relationship

When selecting a relationship to associate with a policy connection, did you
take into consideration that the NetApp Management Console data protection
capability adds the source and destination storage objects to the dataset?
For example, when importing a SnapVault relationship, you select the source
qtree or directory to be added to the source node, and the NetApp
Management Console data protection capability adds the destination volume
to the destination node. If the user adds a volume SnapMirror relationship,
the source and destination volumes are added to the corresponding datasets.
If no existing dataset meets the requirements of the external relationships that
you want to import, create a new dataset.
If the selected dataset is an application dataset, with a "Mirror, then back up"
protection policy, any external Qtree SnapMirror relationship that gets
imported is converted to a SnapVault relationship.
Does the dataset that you selected have more than one connection to which
you can import an external relationship?
For example, a dataset protected by the "Chain of two mirrors" policy has
two mirror connections into which you might import a SnapMirror
relationship.
Review the policy settings for each connection and node and the resources
assigned to each node to help you decide which connection is the better
match for the external relationship.
•

•

To review the policy settings for each connection and node in the dataset,
go to the Protection Policies window, select the policy applied to the
dataset, and then click Edit > Nodes and Connections.
To review the resources assigned to each destination node in the dataset,
go to the Datasets window Overview tab, select the dataset, and then in
the Graph area, click the node that you want to check.
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Importing
similar
relationships

Do you want to import additional, similar external relationships in this same
request?
If you select this option, the NetApp Management Console data protection
capability looks for relationships that are directly connected to the selected
external relationship in the data's backup and recovery topology, based on the ID
of source or destination volume.

Importing discovered external relationships
Existing external SnapVault and SnapMirror relationships are discovered using the NetApp
Management Console data protection capability. If you choose to manage an existing relationship
using the NetApp Management Console data protection capability, you must import it into an
existing dataset.
Before you begin

•

•
•

Have the relationship information available that you need to complete this task:
• An existing dataset that meets the requirements of the external relationships
• The connection to which you will associate the relationship
Ensure that you have determined the dataset to which you will import the external relationships
and the connections in that dataset that you will associate with each external relationship.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

When you import an external relationship into a dataset, the dataset protection status changes to
"Uninitialized." When the next scheduled backup or mirror backup job runs, or when you run an ondemand backup, the protection status changes to reflect the results of the protection job.
Steps

1. From the menu bar, click Data > External Relationships.
2. Select one or more relationships from the list and click Import to start the Import Relationships
wizard.
3. Complete the steps in the wizard to import the relationships into an existing dataset.
Result

The selected SnapVault or SnapMirror relationships are imported into the dataset using the NetApp
Management Console data protection capability. These relationships are now treated as though the
NetApp Management Console data protection capability created them.
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Related concepts

Decisions to make before importing external relationships on page 170
When to import external relationships on page 170
Related references

Administrator roles and capabilities on page 54

What unprotected data is
In the NetApp Management Console data protection capability, data is listed as unprotected if it is
not in a resource pool or if it is not in a dataset that has both an assigned protection policy and a
backup or mirror relationship created. Therefore, if data is in a dataset but the dataset has never
conformed to a protection policy, then that data is listed as unprotected.

Detailed descriptions of when data is protected or unprotected
When the NetApp Management Console data protection capability generates statistics and lists of
protected and unprotected objects, it determines whether data in an object is protected or unprotected
by using criteria that is appropriate for that type of object.
Although the NetApp Management Console data protection capability is designed to help you
manage the protection of your data, there are also valid reasons why you might want to leave some
data unprotected. The following list includes examples of different types of data that you might not
want to protect:
•
•
•

A host that contains data that you do not intend to protect.
Open Systems SnapVault directories that you do not want to back up.
Data that is in the process of being migrated.

The following describes the criteria that is used to determine whether data in that object is protected
or unprotected:
•

•

Datasets
A dataset is protected if the dataset has an assigned protection policy and has a SnapVault or
SnapMirror relationship created (the dataset has conformed to the protection policy at least once).
If a dataset has an assigned protection policy but the dataset has never conformed to that policy,
the dataset is unprotected.
A dataset that is assigned either the "No protection" or "Local Snapshot copies only" protection
policy is defined as protected. An empty dataset (a dataset with no data) or a dataset with only a
primary node is defined as protected if it has a protection policy assigned.
Hosts
A host is protected if it meets any of the following requirements, otherwise it is unprotected:
•
•

The host is in a resource pool.
The host is in a dataset that has an assigned protection policy, whether or not that dataset has a
SnapVault or SnapMirror relationship created. In this case, the presence or absence of a
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•

relationship is not relevant because a host cannot have a relationship created directly from a
host.
Aggregates
An aggregate is protected if it meets any of the following requirements, otherwise it is
unprotected:
•
•

•

The aggregate is in a resource pool.
The aggregate is in a dataset that has an assigned protection policy, whether or not that dataset
has a SnapVault or SnapMirror relationship created. In this case, the presence or absence of a
relationship is not relevant because an aggregate cannot have a relationship created directly
from the aggregate.
• The aggregate is in a protected host.
Volumes and qtrees
A volume or qtree is protected if it meets any of the following requirements, otherwise it is
unprotected:
•

•

•

The volume or qtree is in a dataset primary node, and is in a SnapVault or SnapMirror
relationship that is managed by the NetApp Management Console data protection capability,
and is not in an external relationship.
The volume or qtree is in a secondary or tertiary node of a dataset that is protected.

If a volume or qtree is added to the primary node of a protected dataset, that volume or qtree is
not backed up until a SnapVault or SnapMirror relationship is created according to the dataset's
policy.
External relationships
In the NetApp Management Console data protection capability, external relationships are
SnapVault or SnapMirror relationships that are not managed by the NetApp Management
Console data protection capability. Therefore, the NetApp Management Console data protection
capability does not include these in statistics or lists of protected or unprotected data.

Where to view unprotected data
The two tabs on the Unprotected Data window provide information about unprotected datasets and
resources.
Datasets tab

The Datasets tab lists datasets that do not have protection policies assigned to them
and datasets that have assigned protection policies but have never conformed to the
policy.
From this tab, you can select a dataset and assign a protection policy and
destination resources to that dataset.

Resources
tab

The Resources tab lists hosts, aggregates, volumes, and qtrees that are not protected
by the NetApp Management Console data protection capability. The View
Resources buttons determine which resource type is displayed: hosts, aggregates,
volumes, or qtrees.
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From the each resource list, you can assign the selected resource to a new or
existing dataset.
Related concepts

Detailed descriptions of when data is protected or unprotected on page 173

Managing unprotected data
The NetApp Management Console data protection capability only manages data that it is protected
by the NetApp Management Console data protection capability. You can protect unprotected data by
adding it to a new or existing dataset. You can also import discovered external relationships.
Adding unprotected data to an existing dataset
You can add unprotected data to an existing dataset, even if the dataset is currently unprotected. You
can browse and add an entire host, or individual aggregates, volumes, qtrees, virtual machines, or
Open Systems SnapVault directories on the host.
Before you begin

•
•

Determine the name of the dataset to which you want to add the resource.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

When you add an unprotected qtree or volume to a dataset that has an assigned protection policy,
the NetApp Management Console data protection capability starts an initial baseline transfer of
the data from the primary to the secondary node of the dataset.
Note: An initial baseline transfer of existing qtree or volume data might require many times
more bandwidth and time than subsequent incremental transfers of that data will require.

•

•

If you add an unprotected resource to a dataset that does not have an assigned protection policy,
the data is unprotected until you assign a protection policy to the dataset and the dataset conforms
to that policy.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.

Steps

1. From the menu bar, click Data > Unprotected Data > Resources.
2. Select the resource that you want to add to a dataset:
a) Select one or more hosts that contain the data that you want to protect.
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The aggregates, volumes, and qtrees contained in that host are displayed in the bottom left
pane, in a hierarchical list.
b) (Optional) Use the View Resources buttons to select which resource type to display, then
select the specific aggregates, volumes, qtrees, hosts, or Open Systems SnapVault directories
that contain the unprotected data that you want to add to a dataset.
3. Click Add to existing Dataset.
A dialog box opens, from which you can select an existing dataset. This list includes both
protected and unprotected datasets.
4. Verify that the existing dataset contains the new resource by viewing the dataset member list in
the Datasets window Overview tab.
Result

The qtrees, volumes, aggregates, or hosts that you added to the dataset are displayed in the Datasets
window and are no longer displayed in the hierarchy or host lists in the Unprotected Data
window Resources tab.
After you finish

To protect the data in the dataset, you must assign a protection policy to the dataset.
Related concepts

Decisions to make before adding a protection policy on page 200
Related tasks

Protecting unprotected datasets on page 177
Backing up datasets on-demand on page 141
Related references

Administrator roles and capabilities on page 54
Adding unprotected data to a new dataset
If there is no existing dataset that meets the requirements of your unprotected data, you can create a
new dataset. You can browse and add an entire host, or individual aggregates, volumes, qtrees,
virtual machines, or Open Systems SnapVault directories on the host.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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About this task

•

When you add an unprotected qtree or volume to a dataset that has an assigned protection policy,
the NetApp Management Console data protection capability starts an initial baseline transfer of
the data from the primary to the secondary node of the dataset.
Note: An initial baseline transfer of existing qtree or volume data might require many times

more bandwidth and time than subsequent incremental transfers of that data will require.
•

If you do not assign a protection policy to your new dataset, the data is unprotected until you
assign a protection policy and the dataset conforms to that policy.

Steps

1. From the menu bar, click Data > Unprotected Data > Resources.
2. Select the resource that you want to add to a dataset:
a) Select one or more hosts that contain the data that you want to protect.
The aggregates, volumes, qtrees, and virtual machines contained in that host are displayed in
the bottom pane, in hierarchical form.
b) (Optional) Use the View Resources buttons to select which resource type to display, then
select the specific aggregates, volumes, qtrees, virtual machines, or Open Systems SnapVault
directories that contain the unprotected data that you want to add to a dataset.
3. Click Add to new Dataset to start the Add Dataset wizard.
4. Complete the steps in the wizard to create a new dataset for the data.
Result

The qtrees, volumes, aggregates, virtual machines, or hosts that you included in the dataset are
displayed in the Datasets window and are no longer displayed in the hierarchy or host lists in the
Unprotected Data window Resources tab.
Related concepts

Decisions to make before adding a protection policy on page 200
Related tasks

Protecting unprotected datasets on page 177
Backing up datasets on-demand on page 141
Related references

Administrator roles and capabilities on page 54
Protecting unprotected datasets
You do not have to assign a protection policy when you create a dataset, but a dataset without an
assigned policy is not protected by the NetApp Management Console data protection capability.
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When you are ready to configure protection for a dataset, you can assign a protection policy to it and
assign resources to the dataset nodes.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Unprotected Data > Datasets.
2. Select the dataset that you want to protect and click Protect.
3. Click Protection Policy to start the Dataset Policy Change wizard.
4. Complete the steps in the wizard to assign a policy to the dataset.
Related references

Administrator roles and capabilities on page 54

What jobs are
In the context of the NetApp Management Console, a job is any operation that is initiated within the
NetApp Management Console.

Managing jobs
You can view the current status and other information about all jobs that are currently running as
well as jobs that have completed in the Jobs panel.
Monitoring jobs
You can monitor for job status and other job details using the Jobs window.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Jobs.
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Only jobs for the selected resource group are displayed.
2. (Optional) Customize the Jobs window in any of the following ways:
•
•
•
•
•

Select a resource group to see the jobs for that group.
Select a job in the jobs list to see the details about that job.
Use the View Jobs filter buttons to control the range of jobs you want displayed.
in a column header to control which job entries you want displayed.
Click
Click the sort arrows in a column header to change the sort order of the entries in that column.

•
•

Click
in the upper-right corner of the list to select which columns are displayed.
Drag the bottom of the jobs list area up or down to resize that area.

Canceling jobs
You might need to stop a job: for example, if a job is taking too long to complete, if a job is
encountering too many errors, or if a job was started manually but is no longer needed.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Jobs.
Only jobs for the selected resource group are displayed.
2. From the list of jobs, select one or more jobs that are currently running.
The status in the Progress column must be Running.
3. Click Cancel.
4. In the Cancel Jobs dialog box, click Yes to stop the selected job.
Result

The Cancel Job Request Process Monitor window displays the progress of your cancel request and
detailed information about any errors that occurred during the cancellation process.
Related references

Administrator roles and capabilities on page 54
Where to view reports and logs
In general, you use your NetApp Management Console to monitor jobs, events, and alarms
associated with that application, and you use Operations Manager to monitor logs.
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•
•

•

•

To view reports of jobs, events, or alarms associated with most NetApp Management Console
capabilities, use the NetApp Management Console System window.
To view jobs, events, or alarms associated with your NetApp Management Console disaster
recovery feature, use the Operations Manager Reports menu.
After displaying the disaster recovery report, you can use the spreadsheet or print buttons to
export the report to .XLS format or send it to the printer.
To view DataFabric Manager or Operations Manager logs, use Operations Manager Reports
menu.
After displaying the report, you can use the spreadsheet or print buttons to export the report
to .XLS format or send it to the printer.
To view syslog HA pair messages, use the tools available on the Operations Manager Cluster
Console.

What groups are
A group is a collection of objects with common characteristics, such as location, project, or owning
organization.
Related concepts

Overview of resource pools on page 64
Dataset concepts on page 65

About groups
Combining objects in groups allows you to filter data for the objects in the group. Grouping datasets
and resource pools also enables you to see consolidated reports of information in Operations
Manager.
You can create single-type groups of objects, or you can create groups that include combinations of
object types. You can create groups of objects such as datasets, resource pools, storage services,
storage systems, hosts, vFiler units, aggregates, volumes, and qtrees. Objects can be members of
more than one group.
The groups you create using the protection and provisioning capabilities are the same as the resource
groups you create in Operations Manager. See the Operations Manager online Help for detailed
descriptions of the default views for datasets and resource pools and the custom catalogs you can use
to create your own reports.
If necessary, you can use Operations Manager to specify chargeback settings or to create groups
containing other types of objects such as LUNs.

What the Global group is
By default, a group called Global exists in the DataFabric Manager database. All objects in the
database (datasets, resource pools, storage services, agents, aggregates, volumes, qtrees, Open
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Systems SnapVault hosts, and NetApp storage systems) belong to the Global group, whether they are
discovered, like storage systems, or created, like resource pools.
If you create a new group, you assign objects to the new group from the Global group. If an object is
reassigned from one group to another, the object is still a member of the Global group.
You cannot delete or rename the Global group. However, you can use Operations Manager to delete
objects from the Global group and add previously deleted objects to the Global group. When you
delete an object from the Global group, the DataFabric Manager server stops monitoring and
reporting data for the object. Data collection and reporting is not resumed until the object is added
back into the database (“undeleted”).

Configuring groups
You can add, modify, and delete groups.
Decisions to make before adding groups
Before you use the Add Provisioning Policy wizard to create a new group, you need to decide what
storage objects to include in this group and which people you want to give access to these storage
objects.
Note: This topic applies only to the NetApp Management Console data protection and

provisioning capabilities. You cannot add groups with Performance Advisor.
Group
properties

•

•

•
•

Group
membership

•
•

What is the name of the new group?
Group names can contain any printable ASCII character except the forward
slash character. The maximum name length is 64 characters. Group names
cannot be the reserved names "all" or "global" or fully numeric. If a group has a
parent group, the name of the group must be unique only among the subgroups
of its parent.
Who is the owner of the group?
Determine the name and the e-mail address of the person who should be copied
on all e-mail or pager alerts for this group.
What is the parent group of the group?
Determine the name of the group that is the parent to this group.
Who are the members of the group?
Obtain the e-mail address of each individual or group that you want to have
access to the storage objects in this group.
What storage objects do you want accessed by the same person or group?
How granular do you want to be in selecting storage elements for membership
in your group?
You can add specific aggregates, volumes, qtrees, storage services, storage
systems, LUNs, resource pools, datasets, and so on to a group. If you add a
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storage element to a group, all the elements contained in that storage element
can be accessed by the owner of this group.
Note: To assign any of the objects mentioned, you need view permission for
those objects.

Adding groups
You can add a group directly under the Global group or create a subgroup to a parent group you
already created.
Before you begin

When you add a group, you can add an object to the group membership only if you have permission
to view that object. You must be authorized to perform all the steps of this task; your RBAC
administrator can confirm your authorization in advance.
Have the information available that you need to complete this task:
•
•
•
•

Name of the group
Owner of the group
E-mail address of the owner
Members to add to the group

About this task

You cannot add groups using Performance Advisor.
Steps

1. From the menu bar, click Data > Groups.
2. Click Add to start the Add Group wizard.
3. Complete the steps in the wizard to create the new group.
Result

The new group appears in the Group Name list.
Related concepts

Decisions to make before adding groups on page 181
Related references

Administrator roles and capabilities on page 54

Protection Help | 183

Editing groups
You can edit the name, membership, or contact information for a group. This topic applies only to
the NetApp Management Console data protection and provisioning capabilities.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

If you rename a group, you are also changing the names of its subgroups, if any. The full name of
any subgroup includes the names of groups in its parentage, so changes to the names of parent groups
affect their subgroups as well.
You cannot edit groups with Performance Advisor.
Steps

1. From the menu bar, click Data > Groups.
2. In the Groups window, select the group you want to edit.
You might need to expand the Group Name list to select the group you want.
Current information about the selected group appears in the Details area.
3. Click Edit.
4. In the group's Properties sheet, modify the group as needed.
5. Click Apply to save your changes or OK to save your changes and exit the dialog box.
Result

The modified information about the selected group appears in the "Group name" or "Details" areas.
Related concepts

Decisions to make before adding groups on page 181
Related references

Administrator roles and capabilities on page 54
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Deleting groups
You can delete groups that you no longer find useful. Deleting a group removes only the group
container from the DataFabric Manager database. The objects contained in the deleted group are not
removed from the database.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

This topic applies only to the NetApp Management Console data protection and provisioning
capabilities. You cannot delete groups using Performance Advisor.
When you delete a group, you also delete all its subgroups, if any. If you want to preserve the
subgroups, you must move them to a different parent group before deleting the current parent group.
You can move one subgroup at a time using the NetApp Management Console data protection and
provisioning capabilities, or you can use Operations Manager to move multiple subgroups
simultaneously. See the Operations Manager online Help for instructions.
Steps

1. From the menu bar, click Data > Groups.
2. In the Group Name list, select one or more groups that you want to delete.
3. Move any subgroups you want to retain.
Use the edit properties dialog box to move one subgroup at a time, or use Operations Manager to
move multiple groups.
4. Click Delete to remove the group.
A confirmation dialog box appears, asking whether you want to delete the selected groups.
5. Click OK.
Result

Each selected group (and any subgroups) is deleted from the DataFabric Manager database. The
Group name list is refreshed and no longer displays the deleted groups.
Related tasks

Editing groups on page 183
Related references

Administrator roles and capabilities on page 54

Protection Help | 185

What custom fields are
Custom fields are user-defined fields that provide space for you to input custom information for
individual objects.

About custom fields
When you add a custom field, it is automatically added to the properties page of each object of the
type that is configured for the custom field.
Valid object types are datasets, protection policies, and provisioning policies. For any given
individual object, you can enter values that are appropriate for the custom fields to provide additional
information for managing your data.
For example, you might create a custom field named "Cost Center" and assign it to all datasets.
When you create a new dataset, you can specify the cost center code number for that dataset. You
can also add the cost center code to an existing dataset by editing the dataset properties.
Or, you might create a custom field named "Chargeback" and assign it to all protection policies to
help you track mirror copy costs for a particular backup schedule. You can then create a new
protection policy or edit existing policies and enter the appropriate chargeback codes.

Configuring and managing custom fields
You can add, modify, and delete custom fields.
Adding a custom field
You can use the Custom Fields window to add custom fields to specified object types.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Custom Fields.
2. Click Add to open the Add Custom Field dialog box.
3. In the Name field, type a name for the custom field.
A maximum of 255 characters is allowed; however, only the first 64 characters are displayed.
Names that exceed what is displayed in the window are displayed in a popup window when you
hold the cursor over the name. Names can include any characters but cannot be positive or
negative numbers (for example, the string "2ab" is valid but the strings "23" and "-23" are not
valid).
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4. In the Object Types list, select one or more object types to which you want this custom field to be
assigned.
5. Click OK to create and add the custom field.
After you finish

After you create a custom field, it is automatically added to the properties page of all of the objects of
the type that you specified. To enter a value in the new custom field for an object, you must edit the
object properties. When adding a new object, you can specify a custom field value in the appropriate
wizard.
Related concepts

What custom fields are on page 185
Related tasks

Adding a value in a dataset custom field on page 188
Adding a value in a protection policy custom field on page 188
Adding a value in a provisioning policy custom field on page 189
Related references

Administrator roles and capabilities on page 54
Provisioning policy properties on page 603
Editing custom fields
You can use the Custom Fields window to make global modifications to custom fields.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Changes made to a custom field name or the object types in which it is allowed globally affect that
custom field in all the current object types, regardless of whether a value is entered in the field. For
example, if you change the name of a custom field, that name is changed in every object of the type
for which the custom field is configured. Values entered in that custom field for a given object do not
change.
Steps

1. From the menu bar, click Data > Custom Fields.
2. Select a custom field and click Edit to open the properties page.
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3. Modify the custom field properties, as needed.
If you modify the custom field name, a maximum of 255 characters is allowed; however, only the
first 64 characters are displayed. Names that exceed what is displayed in the window are
displayed in a popup window when you hold the cursor over the name. Names can include any
characters but cannot be positive or negative numbers (for example, the string "2ab" is valid but
the strings "23" and "-23" are not valid).
4. Click Apply to apply the changes and continue making additional changes or click OK to apply
the changes and close the window.
5. In the confirmation dialog box, click OK to apply the changes. and close the properties window.
After you finish

The changes to the custom field are applied to all object types that are configured for that custom
field.
Related references

Administrator roles and capabilities on page 54
Deleting custom fields
You can use the Custom Fields window to globally delete custom fields.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Custom Fields.
2. Select a custom field and click Delete.
3. Click Yes in the confirmation dialog box.
After you finish

The custom field is deleted from all objects.
Related references

Administrator roles and capabilities on page 54
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Adding a value in a dataset custom field
After a custom field is created, you can edit a dataset to enter an appropriate value in that custom
field.
Before you begin

The custom field must be already configured for datasets.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that you want to modify, then click Edit.
3. In the Edit Dataset window, click General Properties.
4. Type the information in the appropriate custom field, then click Finish to apply the changes.
You can enter a maximum of 1024 characters.
5. Click Close to close the Edit Dataset window.
After you finish

You can view the custom field values for all datasets in the Datasets window Overview tab.
Related tasks

Adding a custom field on page 185
Related references

Administrator roles and capabilities on page 54
Adding a value in a protection policy custom field
After a custom field is created, you can edit a protection policy to enter an appropriate value in that
custom field.
Before you begin

•
•
•

The custom field must be already configured for protection policies.
If the custom field value applies to datasets that use the protection policy, confirm that the
information you want to enter is acceptable for all the datasets that use the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
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Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that you want to modify, then click Edit.
3. In the Properties sheet, click General Properties.
4. Type the information in the appropriate custom field, then click OK to apply your changes and
close the Properties sheet.
You can enter a maximum of 1024 characters.
Related tasks

Adding a custom field on page 185
Adding a value in a provisioning policy custom field
After a custom field is created, you can edit a provisioning policy to enter an appropriate value in that
custom field.
Before you begin

•
•
•

The custom field must be already configured for provisioning policies.
Confirm that the information you want to enter in a custom field for a provisioning policy is
acceptable for all the datasets that use the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Provisioning.
2. Select the provisioning policy that you want to modify, then click Edit.
3. In the Properties sheet, click General Properties.
4. Type the information in the appropriate custom field, then click OK to apply your changes and
close the Properties sheet.
You can enter a maximum of 1024 characters.
Related tasks

Adding a custom field on page 185
Related references

Administrator roles and capabilities on page 54

190 | Provisioning and Data Protection Online Help

What protection policies are
Protection policies define how protection relationships should be structured and the property settings
for each component of the structure. Disaster recovery capable protection policies can also define
how to fail over to secondary storage on the disaster recovery node when disaster occurs.

About protection policies
Protection policies specify the types of protection to be applied, and schedules and retention times for
backups.
What a protection policy does
When a protection policy is applied to a dataset, it defines how data stored in dataset members should
be backed up or mirrored. You can configure a protection policy that specifies a single protection
method (local backup, remote backup, or mirroring) or a combination of those methods.
For example, a protection policy might specify that the primary data is backed up to a secondary
location and that the secondary copies are mirrored to a tertiary location.
Disaster Recovery capable protection policies that use Qtree SnapMirror to back up data can also
invoke your site's disaster recovery script. After the problem is resolved, you can move dataset
member access manually from the secondary storage back to the primary storage.
Related concepts

Types of data protection on page 191
Protection policy nodes and connections on page 192
Protection policy node prerequisites on page 195
Allowable lag times on page 199
Protection schedules, time zones and datasets of physical storage objects on page 199
Migration operations on page 551
Related references

Protection policy types (not disaster recovery capable) on page 193
Administrator roles and capabilities on page 54
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Types of data protection
The protection policies provided by the NetApp Management Console data protection capability
enable you to select a combination of three types of data protection: local backup, remote backup,
and mirror copy.
Local backup protection
Local backup protection (also referred to as Snapshot copy protection) is the periodic capture of
active data on a NetApp storage system in backup images and the storage of those images on that
same system.
If active data on the local system is accidentally deleted or corrupted, it can quickly be restored with
the most recent image stored locally from the last local backup job.
Local backup operations are typically employed on the primary storage systems, in which data is
actively updated and, in event of accidental data loss, data restoration from the last hour or two might
be required.
Local backup protection is based on Snapshot technology.
Note: Local backup protection is not available for datasets that include Open Systems SnapVault
directories.

Remote backup protection
Remote backup protection is the periodic capture and copying of active data from a source storage
system to a remote secondary or tertiary storage system.
If data in the source storage system is lost and unrecoverable from its local backup (for example, if
the source system is damaged) then data can still be restored quickly from the remote backup site.
Remote backup operations are employed from primary to secondary storage and from secondary to
tertiary storage, in circumstances in which secure storage of backup data at a remote site might be
required.
The NetApp Management Console data protection capability enables you to supplement remote
backup operations with additional failover instructions that transfer the primary storage function to a
secondary storage site if disaster or mishap disables or destroys the original primary storage site.
Remote backup protection is based on SnapVault technology and Qtree SnapMirror technology.
Mirror protection
Mirror protection is the periodic exact mirroring of all volume data (both active and protected) from
a source storage system to a destination storage system.
If data in the source storage system is lost or made unavailable (for example if the source system is
damaged) then that same data can quickly be made available from the destination mirror-copy site.
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Mirror operations are employed from primary to secondary storage and from secondary to tertiary
storage, in circumstances in which secure mirroring of that data, and in event of breakdown at the
source site, quick availability of that data from a second site might be required.
The NetApp Management Console data protection capability also enables you to supplement mirror
operations with additional disaster recovery-related failover instructions that transfer the primary
storage function to a secondary storage site if disaster or mishap disables or destroys the original
primary storage site.
Mirror protection is based on Volume SnapMirror technology.
Attention: Mirror operations that are scheduled and applied to a storage system through the

NetApp Management Console data protection capability replace and cancel any other SnapMirror
operations or jobs that were configured locally on that storage system by other means. Backup
operations that are scheduled and applied to a storage system through the NetApp Management
Console data protection capability run in addition to any other SnapVault operations that were
configured locally on that node by other means.
Protection policy nodes and connections
When you select a protection policy from the list on the Protection Policies window, the NetApp
Management Console data protection capability displays a diagram of that policy that represents its
primary storage node, any backup node, any mirror node, and the backup or mirror connections
between them.
In the diagram, the primary, backup, or mirror nodes are labeled either with default names, ("Primary
Data," "Backup," or " Mirror") or user-assigned names if they have been assigned. You define the
policy settings by clicking user-assigned or system-generated names and setting parameters for your
protection policy's nodes and connections.
If you edit an existing policy, the NetApp Management Console data protection capability displays a
list of the nodes and connection components that you can configure. You can modify one, two, or
three nodes and zero, one, or two connections, depending upon the complexity of the protection
policy and the methods of protection it employs.
Primary data The protection policy primary data node is the component on which you specify
local backup schedules, retention times, optional allowable local backup lag times,
node
and optional DFPM-based backup scripts to be applied to the primary data location.
Initially the NetApp Management Console data protection capability names this
node "Primary data." You can specify another name.
Note: Local backup schedules and retention times do not apply to Open Systems
SnapVault Windows, UNIX, or Linux-based primary storage systems.

Backup
connection

The protection policy backup connection is the component on which you specify
remote backup schedules, optional throttle schedules, and optional allowable
backup lag times if you are configuring a policy that uses remote backup
protection. The NetApp Management Console data protection capability generates
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a name for this connection based on the names of the backup source and target
nodes, for example: Primary data to Backup.
Backup node The protection policy backup node is the component on which you specify
retention times for data backed up to a backup node. Initially the NetApp
Management Console data protection capability names this node "Backup." You
can specify another name.
Mirror
connection

The protection policy mirror connection is the component on which you specify
mirroring schedules, optional throttle schedules, and optional allowable mirroring
lag times. The NetApp Management Console data protection capability generates a
name for this connection based on the names of the mirror-copy source and target
nodes, for example: Primary data to Mirror.

Mirror node

The protection policy mirror node is the component on which you can modify the
name of the mirror-copy destination if you are configuring a policy that uses
mirror-copy protection. Initially the NetApp Management Console data protection
capability names this node "Mirror." You can specify another name.

Protection policy types (not disaster recovery capable)
Protection policies are the backup instructions that you assign to your datasets. These policies
describe the type of backup to carry out, the Snapshot copy retention count, what preconfigured
Snapshot copy, backup, and throttle schedule to follow, and what scripts to execute. The same policy
can be assigned to multiple datasets.
The NetApp Management Console data protection capability provides templates for you to configure
the following types of backup setups. The Disaster Recovery feature on your protection server
provides additional disaster recovery capable protection policies.
Back up

A dataset is backed up locally and also backed up from primary storage to
secondary storage on a SnapVault or SnapMirror storage system.

Back up, then
Mirror

A dataset is backed up from primary storage to secondary storage on a
SnapVault or SnapMirror storage system and from there mirrored to a
SnapMirror partner.

Mirror then Mirror A dataset is mirrored from primary storage to secondary storage on a
SnapMirror partner and from there mirrored to an additional SnapMirror
partner.
Local Snapshot
copies only

A dataset uses only local Snapshot copies in primary storage to protect data.
No backup to secondary storage is implemented.

Mirror

A dataset is mirrored from primary storage to secondary storage on a
SnapMirror partner.

Mirror and back up A dataset is mirrored from primary storage to secondary storage on a
SnapMirror partner and is also backed up to secondary storage on a
SnapVault or SnapMirror storage system.
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Mirror to two
destinations

A dataset is mirrored from primary storage to secondary storage on two
different SnapMirror partners.

Mirror then back
up

A dataset is mirrored from primary storage to secondary storage on a
SnapMirror partner and from there backed up to tertiary storage on a
SnapVault or SnapMirror storage system.

No protection

A dataset is left with no Snapshot copies, backups, or mirror-copy protection
of any kind.

Remote backup
only

Data on a storage system is backed up remotely to secondary storage on a
SnapVault or SnapMirror storage system. The NetApp Management
Console data protection capability carries out no local backup on the
primary storage. This is the protection policy to assign to third party systems
with Open Systems SnapVault installed.

Related references

Disaster recovery capable protection policies on page 396
Description of backup schedule classes
The NetApp Management Console data protection capability provides four classes of backup
schedules (Hourly, Daily, Weekly, and Monthly), that you can configure. For each class you can
specify different minimum retention durations when you assign a backup schedule to your primary
data storage or a backup connection.
Although the backup schedule classes are named "Hourly," "Daily," "Weekly," and "Monthly," they
are named for convenience and are not restricted to those time increments.
Hourly
backups

Backup copies are retained in the target storage for at least the duration that you
specify for the Backup Retention Duration: Hourly parameter of the primary node or
backup node of the protection policy.
Common retention durations for backup copies in this schedule class are for short
durations of a day or two if you are also maintaining daily, weekly, or monthly
backups of this data for longer durations.

Daily
backups

Backup copies are retained in the target storage for at least the duration that you
specify for the Backup Retention Duration: Daily parameter of the primary node or
backup node of the protection policy.
Common retention durations for backup copies in this schedule class are from five
days to several weeks.

Weekly
backups

Backup copies are retained in the target storage for at least the duration that you
specify for the Backup Retention Duration: Weekly parameter of the primary node or
backup node of the protection policy.
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Common retention durations for backup copies in this schedule class are from one
month to several months.
Monthly
backups

Backup copies are retained in the target storage for at least the duration that you
specify for the Backup Retention Duration: Monthly parameter of the primary node or
backup node of the protection policy.
Common retention durations for backup copies in this schedule class are from five
months to several years.

Backup copy retention strategies
You can schedule four classes of backup (Hourly, Daily, Weekly, Monthly) for retention purposes.
When you assign a schedule to a protection policy, you can specify different minimum retention
durations to preserve each class of backup on your primary, secondary, or tertiary storage. You can
only specify retention durations for backup copies, not mirror copies.

Retention duration is the minimum length of time that you want your backup copies to be preserved
and protected from deletion in your primary, secondary, or tertiary storage.
To guarantee preservation of the most recent successful backups, the NetApp Management Console
data protection capability always retains copies of at least the last two successful backups even if
those copies are older than their specified minimum retention duration.
How long you decide to retain a particular backup copy depends on the original purpose of that
backup.
•

•

Local backup copies of data, for example, at the primary storage location, executed every hour for
the purpose of ensuring quick restoration of recent data that was deleted or corrupted by accident,
might not need to be retained beyond a 24-hour duration.
On the other hand, a daily remote backup copy, of data to a secondary storage location, carried
out after working hours to ensure data preservation, and if necessary, restoration to its state on
this particular date, might require a retention duration of a week or a month or longer.

A usual practice is to schedule frequent local data backups with short retention durations at the
primary storage source, and less frequent remote backups of that data with longer retention duration
to the secondary storage location. Backups of data from secondary storage to tertiary storage are
usually scheduled least frequently but are stored with the longest retention duration in the tertiary
storage location.
Protection policy node prerequisites
Before you attempt to implement a protection policy on your dataset nodes, ensure that the storage
systems in the datasets or physical resource pools that make up that node meet the correct
configuration and licensing requirements.
•

Storage that is the source of a backup connection (to a NetApp storage system not disaster
recovery capable)
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•

•

•

Configuration requirements are either of the following:

•

• Volume, qtree, or OSSV directory if it is not an application dataset
• A host, aggregate, or volume containing one of the above
Storage system licensing requirements are either of the following:

• SnapMirror
• SnapVault Data ONTAP Primary (for remote backup protection)
Storage that is the source of a backup connection configured for nondisruptive LUN restore (to a
NetApp storage system not disaster recovery capable)
•

Configuration requirements are either of the following:

•

• Volume or qtree
• A host, aggregate, or volume containing one of the above
Storage system licensing requires both of the following:

• Data ONTAP Primary
• Data ONTAP 7.3 or later
Storage that is the source of a disaster recovery capable backup connection (to a NetApp storage
system)
•

Configuration requirements are all of the following:

•

Qtree, volume (possibly containing qtrees), aggregate (possibly containing volumes) or an
entire storage unit (possibly containing aggregates or volumes)
• Dataset not configured for non-disruptive LUN restore
• Storage system licensing requirements: SnapMirror
Storage that is the source of a backup connection (Open System)

•

• Configuration requirements: Open Systems SnapVault directory
• Storage system licensing requirements: Open Systems SnapVault client
Storage that is the destination of a backup connection (not disaster recovery capable)

•

•

Configuration requirements are either of the following:

•

• Volume
• Qtree
• Storage system or aggregate containing volumes and qtrees
Storage system licensing requirements are either of the following:
•
•

•

SnapMirror
SnapVault Data ONTAP Secondary (for remote backup protection)
If the source is Windows, Linux, or UNIX, then SnapVault Windows, SnapVault Linux, or
SnapVault UNIX is also required.
Storage that is the destination of a backup connection configured for nondisruptive LUN restore
(not disaster recovery capable)
•

Configuration requirements are either of the following:
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•
•
•

•

Qtree or volume
Storage system or aggregate containing volumes and qtrees. Provisioning policy type
(SAN or NAS) matches primary provisioning policy type or does not export storage.
Storage system licensing requirements are all of the following:

• SnapVault
• Data ONTAP Secondary
• Data ONTAP 7.3 or later
Storage that is the destination of a disaster recovery capable backup connection (to a disaster
recovery node)
•

•

Configuration requirements:
Volume (possibly containing qtrees), aggregate (possibly containing volumes) or an entire
storage unit (possibly containing aggregates or volumes). No qtree on same storage system as
the primary qtree. Provisioning policy type (SAN or NAS) matches primary provisioning
policy type.
• Storage system licensing requirements: SnapMirror
Storage that is the source of a mirror connection (not disaster recovery capable)
•

•

Configuration requirements are any of the following:

• Volume
• Qtree
• Storage system, or aggregate, containing one of the above
• Storage system licensing requirements: SnapMirror
Storage that is the source of a disaster recovery capable mirror connection
•

Configuration requirements are all of the following:

Volume (possibly containing qtrees), aggregate (possibly containing volumes), or an entire
storage unit (possibly containing aggregates or volumes)
• Nothing that is in another dataset
• Storage system licensing requirements: SnapMirror
Storage that is the destination of a mirror connection (not disaster recovery capable)
•

•

•

•

Configuration requirements are any of the following:

• Volume
• Qtree
• Storage system, aggregate, or volume containing volumes and qtrees
• Storage system licensing requirements: SnapMirror
Storage that is the destination of a disaster recovery capable mirror connection (to a disaster
recovery node)
•

Configuration requirements are any of the following:
•
•

Volume
Qtree
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•

•

Storage system, aggregate, or volume containing volumes and qtrees. No volume on the
same storage system as the primary volume. Provisioning policy type (SAN or NAS)
matches primary provisioning policy type.
• Storage system licensing requirements: SnapMirror
Any node

•

• Configuration requirements: Nothing that is in a resource pool used by this dataset
• Storage system licensing requirements: None
Primary (root) node with local backup schedule
•

•

Configuration requirements: No Open Systems SnapVault directories or Open Systems
SnapVault hosts included
• Storage system licensing requirements: None
Non-root node
•
•

Configuration requirements: No Open Systems SnapVault directories or hosts and nothing
that is in a non-root node of any other dataset and nothing that is in any node of this dataset.
Storage system licensing requirements: None

Protection policy guidelines
Before configuring or modifying a protection policy, consider these guidelines.
•

•

If you are using SnapMirror
If you plan to use SnapMirror with the NetApp Management Console data protection capability,
you must update the snapmirror.access option in Data ONTAP to specify the destination systems
that are allowed to access the primary data source system.
The snapmirror.access option specifies which SnapMirror destination systems can initiate
transfers and which network interfaces they can use. For security reasons, the NetApp
Management Console data protection capability does not modify the snapmirror.access option for
you.
If you are using SnapVault
A single storage system licensed as both SnapVault primary and secondary storage locations can
be included in a dataset. Therefore, you can use SnapVault to perform host-to-host backups of
primary and secondary dataset nodes within the same storage system.
Note: Backups of data on one aggregate to the same aggregate and backups of volumes within
the same aggregate are not supported.

•

If you use vFiler units, you cannot have both SnapVault primary and secondary locations on the
same vFiler unit. You cannot use a vFiler unit as the secondary dataset node.
If you are restoring a LUN, the following points apply:
•

If the NetApp Management Console data protection capability is not configured to support
nondisruptive LUN restore, the LUN in the destination location must be offline before you
start the restore operation.
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•

•

If the NetApp Management Console data protection capability is configured to support nondisruptive LUN restore, the LUN in the destination does not have to be offline unless it is
owned by a vFiler unit.
If the destination LUN is owned by a vFiler unit, nondisruptive LUN restore is not supported.

Allowable lag times
The lag time settings in a protection policy specify acceptable differences between the current time
on a source node's system clock and the timestamp of the last successful backup or mirror copy of
source data on the target node.
You can configure the NetApp Management Console data protection capability to issue warning or
error messages if the lag between the current time on a source node's system clock and the timestamp
of the last successful backup or mirror operation to the target node differ enough to indicate failed or
successively failed data protection operations.
•

•

When the lag settings are applied to the primary node component of a protection policy
The lag settings instruct the NetApp Management Console data protection capability to issue
warning or error messages if successive local backup operations fail to the point that the time
difference between the timestamp on the last successful local backup and the current time on the
primary node system clock exceeds a user-specified threshold.
On primary data nodes, warning or error messages related to lag settings might indicate that the
local backup instructions, often transmitted from a controlling node, did not get sent, read, or
executed.
When the lag settings are applied to the backup connection or the mirror connection component
of a protection policy
The lag settings instruct the NetApp Management Console data protection capability to issue
warning or error messages if successive remote backup or mirror operations fail to the extent that
the time difference between the timestamp on the last successful remote backup or mirror copy
and the current time on the target node system clock exceed a user-specified time period.
On backup or mirror nodes, warning or error messages related to lag settings might indicate that
transmission speeds between the source and target nodes are too slow to allow remote backup or
mirror operations to successfully finish within their scheduled times.

Protection schedules, time zones and datasets of physical storage objects
If the DataFabric Manager server that hosts the NetApp Management Console data protection
capability is located in a time zone different from the primary data node, backup node, or mirror
node, the difference in time zone settings for the dataset of physical storage objects or physical
resource pool elements of those nodes might affect the execution of the protection or throttle
schedules that you assign in your protection policy.
If a policy node's dataset or physical resource pool elements are not assigned a time zone setting,
then by default the NetApp Management Console data protection capability executes the protection
schedule for that node or its backup or mirror connection in accordance with the clock and time zone
setting on the DataFabric Manager server.
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For example, without time zone settings on the primary data node datasets, a daily backup scheduled
for 9 p.m. (Eastern Standard Time) from a NetApp Management Console and a DataFabric Manager
server in New York will, by default, execute at 6 p.m. (Pacific Standard Time) on a primary data
node in Los Angeles, or at 2 a.m. (GMT) at a primary data node in London.
However, if those Los Angeles and London datasets are assigned Pacific Standard Time and GMT
time zone settings respectively, then the NetApp Management Console adjusts the schedule to
execute daily backups at 9 p.m. (Pacific Standard Time) in Los Angeles and at 9 p.m. (GMT) in
London.
Related concepts

Effect of time zones on schedules on page 220

Configuring protection policies
In general, you use a wizard to configure protection policies and you use an editing window to
modify property values.
Decisions to make before adding a protection policy
Before you use the Add Protection Policy wizard to add a new policy, you must make some decisions
about the policy, node component, and connection component configuration information that you
need to input for the wizard.
Protection policy decisions
Policy name
and
description

What name do you want to assign to the policy? What is the description for this
new policy?

Custom fields

If one or more custom fields have been configured for protection policies and if
you want to use those fields, what information do you need to enter in those
fields? You can view the list of custom fields that are configured for protection
policies in the Custom Fields window.
Custom fields can contain a maximum of 1024 characters and can include any
character.

Base policy
operation

What base configuration do you want to use for the new policy (for example:
Backup, or Backup then mirror, Local backup only, or Disaster Recovery
Backup)?
•
•

The NetApp Management Console data protection capability provides 10 base
combinations of data protection operations for you to select from.
The NetApp Management Console data protection capability also provides an
additional six disaster recovery-capable base protection policies.
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Primary node decisions
Node name

What name do you want to assign to the primary storage node?

What is the optional schedule to apply if you want to implement local backup of
Local backup
data on the primary storage node?
schedule (for
local backup of
This schedule applies to local backup operations on primary data storage only.
primary
storage)
Backup
retention
durations (for
local backup of
primary
storage)
Backup script

Do you want to perform local backups of primary storage data?
If so, what is the minimum length of time (in hours, days, or weeks) you want to
retain your scheduled hourly, daily, weekly, or monthly local backup copies on
this primary storage node before they are deleted? These settings apply only to
local backups in primary data storage.
Do you want to run an optional user-defined protection (dfpm) backup script on
the DataFabric Manager server?
If so, what are the parameters needed to run the script? Backup scripts can invoke
preprocesses and postprocesses for backup or mirror operations (for example,
quiescing data application activity on protection policy nodes prior to remote
backup operation and restarting application activity after backup finishes).

Failover script
(for disasterrecovery
capable
protection
policies)

If you are providing disaster-recovery protection, do you want to use an optional
user-defined protection (dfpm) failover script?
Failover scripts can invoke processes to take place before and after the failover
mirror relationship break if those processes are necessary. If you provide a
failover script, what is its name and path location in relation to the DataFabric
Manager server? What are the parameters needed to run the script?
Note: If the DataFabric Manager server is running on Windows, and if the
failover script is located on a network share, the failover script location must
be specified by the full UNC path (no drive mapping).

Lag

What is the maximum acceptable lag between the current time at the primary
node and the timestamp of the last successfully completed local backup? Lags
that exceed the specified period trigger either warning or error messages.
•

•

Warning threshold: What is the number of minutes, hours, days, or weeks of
lag that triggers a warning?
Decide on a number that specifies a lag time that might cause concern. For
example, if you follow a schedule that attempts a local backup operation
every hour, specifying a two-hour Warning Threshold triggers a warning
message in the event of two successive local backup failures.
Error threshold: What is the number of minutes, hours, days, or weeks of lag
that triggers an error message?
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Decide on a number that specifies an acceptable lag time that might cause
concern. For example, if you follow a schedule that attempts a local backup
operation every hour, specifying a three-hour Error Threshold triggers an
error message in the event of three successive backup transfer failures.
Note: If you specify an Error Threshold shorter than the Warning
Threshold, the NetApp Management Console data protection capability
disables lag-related warning messages.

Backup or mirror connection decisions
Backup
schedule

What is the daily, weekly, or monthly schedule that you want applied to your backup
operations to secondary or tertiary storage?

Mirror
schedule

What is the daily, weekly, or monthly schedule that you want applied to your mirror
operations to secondary or tertiary storage?

Throttle

What is the bandwidth throttle schedule that you want to apply to your backup or
mirror connections to secondary or tertiary storage?

Lag

What is the maximum acceptable lag between the current time at a backup or mirror
source node and the timestamp of the last successfully completed backup or mirror
copy on the target node? Lags that exceed the specified period trigger either warning
or error messages.
•

•

Warning threshold: What is the number of minutes, hours, days, or weeks of lag
between backup data being sent and successfully backed up or mirrored at the
target that triggers a warning?
Decide on a number that specifies a lag time that might cause concern. For
example, if you follow a schedule that attempts a backup or mirror operation every
hour, specifying a two-hour Warning Threshold triggers a warning message in the
event of two successive backup or mirror transfer failures.
Error threshold: What is the number of minutes, hours, days, or weeks of lag
between backup data being sent and successfully backed up or mirrored at the
target that triggers an error message?
Decide on a number that specifies an acceptable lag time that might cause concern.
For example, if you follow a schedule that attempts a backup or mirror operation
every hour, specifying a three-hour Error Threshold triggers an error message in
the event of three successive backup transfer failures.
Note: If you specify an Error Threshold shorter than the Warning Threshold, the

NetApp Management Console data protection capability disables lag-related
warning messages.
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Backup or mirror node decisions
Node Name

What name do you want to assign to the secondary or tertiary backup or mirror
node?

Backup
retention
duration

If your policy includes backups to secondary or tertiary storage, what is the
minimum length of time (in minutes, hours, days, or weeks) you want to retain
scheduled hourly, daily, weekly, or monthly backups on a secondary or tertiary
storage node before they are deleted?

Related concepts

Effect of time zones on schedules on page 220
Adding a protection policy
You can use the Add Protection Policy wizard to create new protection policies. After you create a
protection policy, you can apply it to datasets to manage the backup or mirror operations that are
executed on those datasets.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Have the information available that you need to complete this task:
•
•
•
•
•

Policy name, base configuration, name for each node
Custom field information
Primary node information
Backup or mirror connection information
Backup or mirror node information

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Click Add to start the Add Protection Policy wizard.
3. Type a policy name and description and click Next.
4. Select a base policy and click Next.
5. Complete the policy property sheets for the primary node and any backup connection, mirror
connection, secondary storage, or tertiary storage node that is required for the policy. After you
complete each property sheet, click Next.
After all property sheets are completed, the Add Protection Policy wizard displays a summary
sheet for the policy.
6. Confirm the details of the policy and click Finish.
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Result

Your new policy is listed on the Protection Policies window Overview tab.
Related concepts

Decisions to make before adding a protection policy on page 200
Related references

Administrator roles and capabilities on page 54
Editing a protection policy
You can edit a protection policy by selecting it in the Protection Policies window and clicking the
Edit button.
Before you begin

•
•

Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy you want to modify.
A diagram is displayed using the NetApp Management Console data protection capability,
showing the primary node, backup node, or mirror node components that are included in the
selected policy. By default the node types are labeled Primary Data, Backup, and Mirror, but they
might also be labeled with alternative user-assigned names.
Note:

•
•

If the primary, backup, or mirror nodes have user-assigned names rather than their default
Primary Data, Backup, or Mirror labels, note the user-assigned names.
As a shortcut, you can directly display and edit the properties of any policy node or
connection component by clicking it in the diagram.

3. If the diagram notes that dependencies exist for the selected policy, click the Dependencies tab to
ensure that you apply the policy edits to the all the datasets in the Dependencies list.
4. Click Edit.
5. In the Properties sheet, click Nodes and Connections and note the selectable node and
connection names that are displayed in the list.
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A policy's backup connection or mirror connection components are listed by labels that are
generated from the names of the source and target nodes: for example, "Primary to Backup" or
"Primary to Mirror."
6. Click each node or connection in the list to display and edit the properties for that component.
7. After you complete your modifications, click Preview.
8. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

Editing a policy's primary data node
You can edit the local backup schedule, backup script, allowable lag, retention durations, and node
name specifications on a policy's primary data node.
Before you begin

•

•
•

Have the policy information available that you need to complete its primary node specifications:
• Node name
• Local backup schedule
• Backup retention duration (of the local backup)
• Backup script (if any)
• Failover script (if the policy is disaster recovery capable)
• Lag warning thresholds and Lag error thresholds
Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the primary data node you want to modify and click Edit >
Nodes and Connections.
3. Select the primary node.
The node is named either "Primary node" or the user-assigned name for that node.
The primary data node properties are displayed in the properties area.
4. Modify the primary node properties, as needed, and click Preview.
5. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.
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Related references

Administrator roles and capabilities on page 54
Editing a policy's backup connection
You can edit the backup schedule, throttle schedule, and lag allowance specifications on the backup
connection of a protection policy.
Before you begin

•

•
•

Have the policy information available that you need to complete its backup connection
specifications:
• Backup schedule
• Throttle schedule
• Lag warning thresholds and Lag error thresholds
Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the backup connection you want to modify and click Edit >
Nodes and Connections.
3. Select the backup connection.
4. Modify the backup connection properties, as needed, and click Preview.
5. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

Related references

Administrator roles and capabilities on page 54
Editing a policy's backup node
You can edit the hourly, daily, weekly, or monthly backup retention durations on the backup node of
a protection policy.
Before you begin

•

Have the policy information available that you need to complete its backup node specifications:
•

Node name
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•
•

• Backup retention duration (of the backups to the backup node)
Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the backup node you want to modify and click Edit > Nodes
and Connections.
3. Select either "Backup" or the user-assigned name for that node.
4. Modify the backup node properties, as needed, and click Preview.
5. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

Related references

Administrator roles and capabilities on page 54
Editing a policy's mirror connection
You can edit protection schedule, throttle schedule, and allowable lag specifications on a protection
policy's mirror connection.
Before you begin

•

•
•

Have the policy information available that you need to complete its mirror connection
specifications:
• Mirror schedule
• Throttle schedule
• Lag warning thresholds and Lag error thresholds
Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the mirror connection you want to modify and click Edit >
Nodes and Connections.
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3. Select the mirror connection.
4. Modify the backup node properties, as needed, and click Preview.
5. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

Related references

Administrator roles and capabilities on page 54
Editing a policy's mirror node
You can edit the name the backup node of a protection policy.
Before you begin

•
•
•

Have the policy information available that you need to the mirror node name.
Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the mirror node you want to modify and click Edit > Nodes
and Connections.
3. Select either Mirror or the user-assigned name for that node.
4. Modify the mirror node properties, as needed, and click Preview.
5. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

Related references

Administrator roles and capabilities on page 54

Protection Help | 209

Assigning or changing schedules in a protection policy
You can assign or change protection and throttle schedules for the primary node, backup connection,
or mirror connection of a protection policy.
Before you begin

•
•

•

Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
Confirm that time zone differences and settings on the DataFabric Manager server, and the
dataset or physical resource pool elements of the policy nodes support the new schedule
assignment.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the local backup, remote backup, or mirror schedule
assignment you want to modify and click Edit > Nodes and Connections.
3. Select the primary node, backup connection, or mirror connection that you want to modify.
4. Locate the appropriate schedule in the Properties area (Local Backup Schedule, Backup Schedule
Name, Mirror Schedule Name, or Throttle Schedule Name) and select a new schedule from the
schedule drop-down list.
5. After you complete your modifications, click Preview.
6. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

The modifications take effect immediately.
Related references

Administrator roles and capabilities on page 54
Changing retention times in a protection policy
You can vary and modify the minimum duration that the scheduled backup copies of your protected
data are retained on the target nodes before they are deleted.
Before you begin

•

Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
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•
•

Make sure that the resource pools for the secondary storage contain sufficient capacity to support
the retention durations that you want to specify.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the primary or backup node on which you want to assign or
modify the retention times and click Edit > Nodes & Connections.
3. In the Nodes and Connections list, select the primary or backup node on which you want to assign
or modify the retention times.
4. Locate the retention duration (Hourly, Daily, Weekly, or Monthly) in the Properties area and
assign or modify the values.
5. After you complete your modifications, click Preview.
6. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

The modifications take effect immediately.
Related references

Administrator roles and capabilities on page 54
Changing lag thresholds in a protection policy
You can modify the lag time allowed between transmission of protected data from a backup or mirror
source node to its successful reduplication at a target node. Lag times that exceed your specifications
trigger either a warning or an error message for the backup or mirror operation during which they
occur.
Before you begin

•
•

Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the primary node, backup connection, or mirror connection
on which you want to modify the lag times and click Edit > Nodes & Connections.
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3. In the Nodes and Connections list, select the primary node, backup connection, or mirror
connection you want to modify.
4. Specify the new lag times.
5. After you complete your modifications, click Preview.
6. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

The modifications take effect immediately.
Related references

Administrator roles and capabilities on page 54
Changing a node name in a policy
You can edit the name that labels the primary data node, backup node, or mirror node object in a
protection policy diagram.
Before you begin

•
•

Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy. If it is not, then you might want to add a new protection policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the primary, backup, or mirror node that you want to modify
and click Edit > Nodes & Connections.
3. In the Nodes and Connections list, select the primary, backup, or mirror node that you want to
modify.
4. In the Node Name parameter, specify the new name for that node.
5. After you complete your modifications, click Preview.
6. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

The modifications take effect immediately.
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Related references

Administrator roles and capabilities on page 54
Deleting a protection policy
You can delete an existing protection policy if that policy is not currently applied to any existing
dataset.
Before you begin

•
•

You can use the Dependencies tab to confirm that the protection policy that you want to delete is
no longer assigned to any existing datasets.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. In the Policies list box, select the protection policy that you want to delete.
3. Click Delete, then click Yes on the confirmation prompt.
The Delete button is not enabled for policies still attached to datasets.
Result

The selected protection policy is deleted from the protection policies list.
Related references

Administrator roles and capabilities on page 54

About storage services
A storage service is a user-defined combination of a protection policy, provisioning policies, resource
pools, and an optional vFiler template that you can assign as a package to a dataset or a class of
datasets with common protection, provisioning, or vFiler unit attachment needs.
You can preconfigure one or more combinations of protection, provisioning, resource pool, and
vFiler unit attachment services into specialized bundles that authorized administrators can readily
assign to datasets that require those specific bundles of storage service.
What you can do with storage services
By preconfiguring frequently used combinations of protection policies, provisioning policies,
resource pools, and optional vFiler templates for your datasets, you can simplify configuration of
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new datasets and their administration for yourself, your co-workers, or outside storage service
subscribers.
•
•
•
•
•
•

Dataset creation is simplified because your protection, provisioning, and vFiler information is
mostly predesignated.
You can preconfigure different levels of storage services for different classes of applications to
support.
You can preconfigure different levels of storage services for different levels of storage service
subscribers.
You can edit an existing storage service configuration and apply that single change to all the
datasets to which this storage service is attached.
You can use the storage service feature to test the validity of the changes that you want to make,
before you actually implement them.
You can support automatic assignment of appropriate storage service configurations through
subscriber-friendly orchestration tools.
Storage services example
For example, a storage administrator might want to configure several classes of storage
services to support different types of applications.
•

•

•

Storage Service A might provide support for applications that require high-end data update
and retrieval performance, and disaster recovery capable mirror protection and data
availability.
The administrator, therefore configures Storage Service A with a "DR Mirror, then mirror"
protection policy, a provisioning policy that specifies high performance storage systems,
and resource pools that contains high performance storage systems in sufficient numbers.
Storage Service B might provide support for applications that require mid-range data
update and retrieval performance and remote backup protection.
The administrator therefore configures Storage Service B with a "Backup" protection
policy, a provisioning policy that specifies mid-range storage systems, and a resource pool
that contains mid-range storage systems in sufficient numbers.
Storage Service C might provide support for applications producing a lot of primary data
that might require frequent migration to other physical storage sites.
The administrator therefore configures Storage Service C with a "Backup" protection
policy, and a vFiler template that supports the creation of a vFiler unit that accommodates
migration of data to other physical storage sites.

Related concepts

About protection policies on page 190
About provisioning policies on page 600
About resource pools on page 156
About vFiler templates on page 626
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Ways that storage services might be selected and attached
After you have configured a range of storage service configurations, the NetApp Management
Console provisioning capability enables alternative means to select and attach those configurations to
your datasets.
•

•

•

You can select a storage service through which to create a new dataset.
The NetApp Management Console provisioning capability interface allows you to select a storage
service and create a dataset with that service's protection policy, provisioning policies, resource
pools, and vFiler template already applied.
You can attach a storage service to an existing dataset.
If a protection policy, provisioning policies, resource pools, and a vFiler template is already
assigned to that dataset, the storage services feature suggests the most efficient ways to remap
your dataset nodes to the new protection policy.
Orchestration tools can be enabled to select your storage services. The NetApp Management
Console provisioning capability supports storage service selection through properly enabled and
authorized third-party orchestration tools. In a cloud service provider environment, this feature
might enable a cloud service subscriber to request a storage service offering that is automatically
implemented by the NetApp Management Console provisioning capability.

Storage services support for vFiler unit creation and attachment
The storage services feature allows you to specify creation of a template-based vFiler unit attached to
a node when you create a dataset using the Add Dataset Using Storage Service wizard. It also allows
you to attach an existing vFiler unit to the dataset's primary, secondary, or tertiary nodes.
Uses of storage services supported vFiler unit creation and attachment
When you use a storage service to create a dataset, you might want to attach vFiler units to your
dataset's primary nodes for purposes of multi-tenancy support or automated data migration support.
•

•

Multi-tenancy support
Specifying vFiler unit creation for your dataset's primary, secondary, or tertiary node enables you
to provide storage services for multiple subscribers on separate virtual storage systems that share
common physical storage.
For example, an administrator can create multiple datasets for Subscriber_X (named x_data,
x_data_2, x_data_3) that are accessed through a subscriber-specific vFiler unit (also named
x_data) attached to their primary nodes.
Then, on the same physical storage systems, the administrator can create multiple datasets for
Subscriber_Y (named y_data, y_data_2, y_data_3) that are accessed through another subscriberspecific vFiler unit (also named y_data) attached to their primary nodes.
Automated online or offline data migration support
Creating a vFiler unit and attaching it to a dataset's primary node also allows you to enable
automated online or offline migration of that dataset's primary data.
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Related concepts

About vFiler templates on page 626
Storage services vFiler unit creation
Configuring a storage service to include a vFiler template enables you or other authorized operators
to specify automatic creation of a vFiler unit attached to primary, secondary, and tertiary nodes
respectively when you use that storage service to create a dataset.
To support template-based vFiler unit creation on a node, you first assign an existing vFiler template
when you use the Add Storage Service wizard or Edit Storage Service wizard to create or edit a
storage service.
Later, if you or other authorized operators use this storage service to create a dataset and an optional
vFiler unit at the same time, the Add Dataset Using Storage Service wizard uses the storage services
assigned vFiler template to configure the NIS, DNS and admin host information for the new vFiler
unit. All you need to specify is an IP address (and network mask, if necessary).
Note: If the storage service specifies no vFiler template on a node, then the new vFiler unit set up
is determined by the hosting storage system.

The wizard attempts to give the new vFiler unit the same name as the dataset that it is concurrently
creating. For example, if the wizard is creating a new vFiler unit on primary node as part of creating
a dataset named "eng_acct", it attempts to name the new vFiler unit "eng_acct" also. However, if
another vFiler unit named "eng_acct" exists, then the wizard names the new vFiler unit "eng_acct_1".
Similarly, when creating a new vFiler unit on secondary or tertiary node, it attempts to name the new
vFiler unit "eng_acct_<nodename>". However, if another vFiler unit named
"eng_acct_<nodename>" exists, then the wizard names the new vFiler unit
"eng_acct_<nodename>_1".
After that vFiler unit is created, you or other authorized operators can attach it as an existing vFiler
unit to the nodes of succeeding datasets that you create using this storage service.
Related concepts

About vFiler templates on page 626
Storage services attachment of existing vFiler units
You can attach vFiler units that you created when using the Add Dataset Using Storage Service
wizard to any new dataset that you create. For example, if you previously used the wizard to create
dataset "eng_acct" and vFiler unit "eng_acct," you can use the wizard again to create the dataset
"eng_acct_b" and attach its primary node to the previously created vFiler unit "eng_acct."

Configuring storage services
You use the Add Storage Service wizard to specify the protection policy, provisioning policy,
resource pool, and vFiler template components of a new storage service. You use the Edit Storage
Service wizard to change those components in an existing storage service.
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Decisions to make before adding a storage service
Before you start the Add Storage Service wizard you must gather the information that you need to
complete the wizard.
Service
Properties

•
•

What is the name and description of the storage service?
What is the name and email address of the owner of this storage service?

Group Selection To which user groups do you want this storage service available?
Assignment of a storage service to a particular group makes that storage service
available to all storage administrators who have access to that group. Including
the storage service in the global group makes it available to all users of the
NetApp Management Console provisioning capability.
Which protection policy do you want this storage service to support?
Protection
Policy Selection
The storage services feature can offer any protection policy or disaster-recovery
capable policy that is supported by the NetApp Management Console data
protection capability.
No Protection is also an option if you do not want to use this storage service to
provide data protection.
Service Node
configuration

For each primary, secondary, or tertiary node that is included in the protection
policy that you want, decide the following:
•

•

Which provisioning policies do you want to assign to your primary,
secondary, or tertiary nodes?
If you are configuring a storage service to assign to a dataset of physical
storage objects, you must assign either a NAS or SAN type provisioning
policy to the primary node.
Storage services assigned to datasets of virtual objects require no
provisioning policy assigned to the primary node.
If you want to assign a provisioning policy to a disaster recovery node, the
policy type must either be default or the same as that assigned to the primary
node.
If you want to assign a provisioning policy to a non-disaster recovery
secondary node, the policy type must either be secondary or default.
Any storage service that you select for the task of creating a dataset through
that storage service must already have a provisioning policy specified for the
primary node.
Which resource pools do want your primary, secondary, or tertiary nodes
provisioned from?
Except for the primary nodes of datasets of virtual objects, each node
requires one or more resource pools assigned to it.
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•

Which vFiler template do you want to assign to your primary, secondary, or
tertiary nodes?
You have the option of specifying the vFiler template on which the optional
vFiler unit creation will be based.
Later, if you or other authorized operators use this storage service to create a
dataset and select the Add Dataset Using Storage Service wizard option to
create a new vFiler unit, the wizard uses the assigned vFiler template to
configure the NIS, DNS, and administrator host information for the new
vFiler unit. All you need to specify is an IP address (and network mask, if
necessary).
Note: If the storage service specifies no vFiler template, then the new
vFiler unit set up is determined by the hosting storage system.

The wizard attempts to give the new vFiler unit the same name as the dataset
that it is concurrently creating. For example, if the wizard is creating a new
vFiler unit on the primary node as part of creating a dataset named
"eng_acct," it attempts to name the new vFiler unit "eng_acct" also.
However, if another vFiler unit named "eng_acct" already exists, then the
wizard names the new vFiler unit "eng_acct_1". Similarly, when creating a
new vFiler unit on secondary or tertiary node, it attempts to name the new
vFiler unit "eng_acct_<nodename>". However, if another vFiler unit named
"eng_acct_<nodename>" already exists, then the wizard names the new
vFiler unit "eng_acct_<nodename>_1".
Related concepts

About protection policies on page 190
About provisioning policies on page 600
About resource pools on page 156
About vFiler templates on page 626
Related references

Administrator roles and capabilities on page 54
Adding a storage service
You can use the Add Storage Service wizard to create and add new combinations of storage services.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Confirm that the protection policy, provisioning policy, resource pools, or vFiler template that you
want to specify for the new storage service are available in the group in which you intend to add that
storage service.
About this task

After you create a storage service, you can apply it as follows:
•

•

You can use it to quickly create datasets with the protection policy, provisioning policies,
resource pools, and template-based optional attached vFiler units that are specified by the storage
service.
You can also apply it to existing datasets, automatically assigning them a predefined
configuration.

Steps

1. From the menu bar, click Policies > Storage Services.
2. Click Add to start the Add Storage Service wizard.
3. After you complete each property sheet in the wizard, click Next.
4. Confirm the details of the storage service and click Finish.
Result

Your new storage set is listed in the Storage Services window.
Related concepts

Decisions to make before adding a storage service on page 216
Related references

Administrator roles and capabilities on page 54
Decisions to make before editing a storage service
Before you start the Edit Storage Service wizard you need to gather the information to complete the
wizard.
Service
Properties

•
•

Protection
•
Policy Selection

Do you want to change the name or description of the storage service?
Do you want to change the name and email address of the owner of this
storage service?
Do you want to change the protection policy that this storage service
supports?
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•

•
Service Node
configuration

•

If you change the protection policy, how do you want to map the data in the
current policy's secondary or tertiary nodes to the replacement policy's
secondary or tertiary nodes?
In case of node remapping, the storage service feature applies the original
node's assigned provisioning policy, resource pools, and vFiler template to
the new node whenever possible.
Are you prepared for rebaselining of data to newly mapped secondary or
tertiary nodes if the new protection policy requires that?
For each node (primary, secondary, or tertiary) that is included in the new
protection policy, do you want to change the provisioning policy, resource
pool, or vFiler template assignment?
Note: Some protection policy node remappings require you to modify
provisioning policy and resource pool assignments.

•

If you are configuring a storage service to assign to a dataset of physical
storage objects, you must assign either a NAS or SAN type provisioning
policy to the primary node.
Storage services assigned to datasets of virtual objects require no
provisioning policy assigned to the primary node.

Related concepts

About protection policies on page 190
About provisioning policies on page 600
About resource pools on page 156
About vFiler templates on page 626
Editing a storage service
You can use the Edit Storage Service wizard to edit the protection policy, provisioning policy,
resource pool, or vFiler template selections of an existing storage service.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Confirm that any new protection policy, provisioning policy, resource pool, or vFiler template that
you want to include in the modified storage service are available in the group in which that storage
service is located.
Confirm that you want the changes to apply to all the datasets that currently use this storage service.
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About this task

If you change the protection policy, the Edit Storage Service wizard shows you alternative ways to
remap your secondary or tertiary nodes and the rebaselining effort required for each alternative. After
you edit the storage service, all the changes that you made to that service will apply to every dataset
that uses that storage service.
Steps

1. From the menu bar, click Policies > Storage Services.
2. In the Storage Services list, select the storage service you want to edit.
3. Click Edit to start the Edit Storage Service wizard.
4. After you complete each property sheet in the wizard, click Next.
5. Confirm the details of the storage service and click Finish.
Related concepts

Decisions to make before editing a storage service on page 218
Related references

Administrator roles and capabilities on page 54

What protection and throttle schedules are
Protection schedules specify times to carry out data backup and mirror operations and retention
periods for those backup and mirror copies. Throttle schedules specify periods of unlimited, limited,
or zero network bandwidth availability for those operations.

About time zones
Understanding how time zone settings can affect your protection schedules is important to be sure
your backups and mirror copies are functioning as intended.
Effect of time zones on schedules
You determine the time zone to be used for a protection schedule when you set up your resource
pools and your datasets. You have a choice of using the DataFabric Manager server's default time
zone, creating a new default for datasets and resource pools, or selecting a different time zone each
time you create or edit a dataset or resource pool.
Before selecting a schedule for a replication job, you need to know the time zones associated with the
primary data and destination storage for that job. That information helps you determine when you
want your local backups to occur, and when you want the remote replication to take place to achieve
your data protection goals.
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When the NetApp Management Console data protection capability interprets a scheduled replication
from primary data in a dataset to secondary destination storage, it uses the time zone of the primary
data. When interpreting a scheduled replication from secondary storage to tertiary storage, the
NetApp Management Console data protection capability uses the time zone of the secondary node.
If you misapply time zones, unexpected and unwanted results could occur. For example, a weekly
mirror copy to tertiary storage might occur before completion of the daily backup that you want to
capture, or replication jobs might occur at a time of day when network bandwidth is already servicing
a heavy load, and so forth.
Note: Some time zones observe daylight saving time (DST) and some do not. The NetApp

Management Console data protection capability automatically observes the local time zone and
adjusts for daylight saving when appropriate. As a result, backups scheduled during the DST
transition, between 1:00 am and 3:00 am local time, might not perform as intended.

Related concepts

Impact of modifying resource pool properties on page 166
Protection schedules, time zones and datasets of physical storage objects on page 199
Ways to set the time zone
There are three ways you can set the time zone you want the NetApp Management Console data
protection capability to use when interpreting schedules for dataset replication jobs: use the
DataFabric Manager server's system default time zone, set a new default time zone, or use the
NetApp Management Console data protection capability to set the time zone.
•

•

Operations Manager system default
By default, the NetApp Management Console data protection capability uses the DataFabric
Manager server's system time zone setting when interpreting the times and dates in a protection
schedule. The system time can be viewed in the DataFabric Manager user interface.
You might use the server's system time zone if your primary data and the server are both in the
same time zone.
DataFabric Manager timezone option
You can change the default time zone available for datasets and resource pools. Use the command
dfm option set timezone=timezone on the DataFabric Manager server's command line to
specify the new default.
If this global time zone value is left empty, the original system default time zone is used. If the
global time zone value is set by using dfm option set timezone, that value becomes the new
default time zone for datasets and resource pools. You can use the dfm option list
timezone command to display the current system default time zone, if one is set.
You might set a new default with the timezone option if most of your primary data is collocated
in a single time zone, but in a different time zone than the server.
Note: Setting a new default by using the timezone option only affects the default time zone
for datasets and resource pools. It does not impact the DataFabric Manager server's system
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default time zone setting. More information about this command option is available in the
related man page in the online Help.
•

The NetApp Management Console data protection capability interface
You can override the original or the modified default Time Zone setting by using the time zone
selection lists when you add or modify a dataset or resource pool.
The protection dataset and resource pool time zone lists provide options for how you can display
the time zone you want to use. You might want to have each time zone identified by the city in
which the data is located; or perhaps you prefer to use the official abbreviation for a time zone.
Some examples of the choices offered in the time zone lists include the following:
Region/City

Example: Europe/Istanbul
Example: America/Montreal

City or Country

Example: Turkey
Example: Canada/Eastern

Time zone abbreviation Example: EET (Eastern European Time)
Example: EST5EDT (Eastern Standard Time/Eastern Daylight Time)
The selected time zone appears highlighted in the time zone list, whether it is a default value or a
user-selected value.
You might use the NetApp Management Console data protection capability to override the
server's time zone under the following circumstances:
•
•

Most of your data is spread out across a number of different time zones.
You want a replication job for a particular dataset or a particular resource pool to occur in a
time zone other than the default.

Related references

Example of a schedule using local time zones on page 224
Example of a schedule using a default time zone on page 227
Guidelines for using time zones with resource pools
When creating or editing a resource pool, you can select a time zone to associate with the resource
pool. Review these guidelines to help you determine whether to use the default time zone, or select a
new one, for your resource pool.
•

Using the NetApp Management Console data protection capability, you can select a time zone
other than the default for any resource pool, but you do not have to.
You select a time zone for an individual resource pool from the Resource Pools window. Click
the Add button to access the Add Resource Pool wizard, or click the Edit button to open the
Properties sheet.
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•

•
•

•

•

•

If you do not select a time zone, the NetApp Management Console data protection capability uses
either the DataFabric Manager server's system default value, or the default value set with the dfm
option set timezone=<timezone>, as described under "Ways to Set the Time Zone".
When you assign a time zone to a resource pool, any policy node associated with that resource
pool will use the resource pool's time zone.
When you set a time zone for a resource pool using the NetApp Management Console interface,
the time zone applies only to the data on the secondary destination node. It does not impact the
primary data in a dataset. Different time zones can be selected for replication of primary data to a
secondary resource and for the replication of data from a secondary to a tertiary resource.
For two-node policies, the NetApp Management Console data protection capability uses the time
zone of the primary data to interpret schedules for data transfers.
This is true even if a resource pool is associated with the dataset, and that resource pool has a
time zone assigned to it that is different from the dataset's time zone.
You might want to change the default time zone for a resource pool when working with a threenode policy.
If you want data transfers from the second node to the third node to be scheduled in the "local
time" of the second node, you specify a time zone for the resource pool that contains the second
node.
If you change the default time zone by using the dfm option set timezone=<timezone>
command, then all resource pools that use that default setting begin using the new default value.
Be sure any changes to the time zone are thoroughly evaluated for potential impact to schedules,
as changes could disrupt the intended schedules for future jobs.
Datasets and resource pools for which the time zone is set by using the user interface of the
NetApp Management Console data protection capability will not be affected by changes made
using the timezone option. This is because the NetApp Management Console data protection
capability setting overrides any default setting.

Related references

Example of a schedule using local time zones on page 224
Example of a schedule using a default time zone on page 227
Guidelines for using time zones with datasets
When creating or editing a dataset, you can select a time zone to associate with the dataset. Review
these guidelines to help you determine whether to use the default time zone, or select a new one for
your dataset.
•

•

You can select a time zone other than the default for any dataset, but you do not have to.
You select a time zone for an individual dataset from the Datasets window. Click Add to access
the Add Dataset wizard, or click Edit, to open the Properties sheet.
If you do not select a time zone, the NetApp Management Console data protection capability uses
either the DataFabric Manager server's system default value, or the default value set with the dfm
option set timezone=<timezone>, as described under "Ways to Set the Time Zone."
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•

•

•

•

If you associate a time zone with a dataset, the NetApp Management Console data protection
capability uses the time zone you selected, rather than the server's system default, to interpret
schedules affecting data in that dataset.
When you set a time zone for a dataset using the NetApp Management Console interface, the
time zone applies only to the primary data in the dataset. It does not impact any destination nodes
or resource pools.
The start and end time of a local or a remote replication is determined by the time zone selected
for the primary data in the dataset. The time zone selected for any resource pool associated with
the dataset does not impact the time of the replication event starting on the primary.
When you might want to change the default time zone:
•

•

If most of the primary data is in a different time zone than the DataFabric Manager server,
you might want to set the DataFabric Manager global command, dfm option set
timezone=<timezone>, to specify which time zone the NetApp Management Console data
protection capability should use for interpreting all schedules.
If most of your datasets are distributed across different time zones, and you want the
schedules interpreted in the "local time" for each dataset, you specify each dataset's time zone
in the user interface using the NetApp Management Console data protection capability.

Related references

Example of a schedule using local time zones on page 224
Example of a schedule using a default time zone on page 227
Example of a schedule using local time zones
This example describes the setup and results of selecting local time zones for the dataset and resource
pools, rather than using the server's system default.
There are three parts to this example.
Related concepts

Effect of time zones on schedules on page 220
Time zone assignment (local)
This example shows how the administrator sets up a local time zone for the server, dataset, and
destination storage.
Assume the following:
•

•

A DataFabric Manager server is located in Hong Kong, China.
The administrator selected the Hong Kong time zone (GMT +8 hrs.) for the server.
From this server in the Hong Kong time zone, the administrator used the NetApp Management
Console data protection capability to create the resource pools, datasets, and protection schedules.
A dataset containing primary data is located in Lagos, Nigeria.
The administrator selected the Africa/Lagos time zone (GMT +1 hr.) for the dataset.
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•

•

The administrator overrode the server's default time zone with the Lagos time zone when creating
the dataset that contains the primary data. Therefore, the NetApp Management Console data
protection capability interprets the times and dates of the protection schedule in the Lagos time
zone.
Resource pools provisioned as backup destination storage are located in the city of Los Angeles
in the United States.
The administrator selected the PST8PDT time zone (GMT -8 hrs.) for the resource pool.
The administrator overrode the server's default time zone with the PST8PDT time zone when
creating the resource pool for the secondary destination storage. Therefore, the NetApp
Management Console data protection capability interprets the times and dates of the protection
schedule in Los Angeles time for replicating data from the secondary storage to the tertiary
storage.
Resource pools provisioned as tertiary destination storage for mirroring are located in Lima, Peru.
The administrator selected the America/Lima time zone (GMT -5 hrs.) for the tertiary storage.
The administrator overrode the server's default time zone with the Lima time zone when creating
the resource pool for the tertiary destination storage.
Destination storage

Destination storage

Resource pool
in Los Angeles
time zone
(GMT -8 hrs)

Resource pool
in Lima
time zone
(GMT -5 hrs)

DataFabric
Manager server
in Hong Kong
time zone
(GMT +8 hrs)

(Monitor and control
datasets, schedules,
and resource pools
from here)

Plan your
protection
strategy

Weekly mirror to
tertiary storage

Daily remote backup to
secondary storage

Dataset in
Lagos
time zone
(GMT +1 hr)

Daily local backup on primary

Primary data

Time zone selection for protection schedules (local)
This example shows how the administrator selects the local time zone for the protection schedules.
From the DataFabric Manager server in the Hong Kong time zone, you schedule the following:
•
•

A Daily local backup of the primary data at 8:00 p.m. Monday
8 p.m. Hong Kong = 1:00 p.m. Lagos = 4:00 a.m. Los Angeles = 7:00 a.m. Lima
A Daily remote backup of the primary data in Nigeria to secondary storage in the U.S. at 11:00
p.m. Monday
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•

11 p.m. Hong Kong = 4:00 p.m. Lagos = 7:00 a.m. Los Angeles = 10:00 a.m. Lima
A Weekly mirror copy of the secondary storage from the U.S. to tertiary destination storage in
Peru at 6:30 p.m. Monday
Create resource pool,
select local Los Angeles Resource pool
in Los Angeles
time zone
time zone
(GMT -8 hrs)
DataFabric
Manager server
in Hong Kong
time zone
(GMT +8 hrs)

Create dataset,
select local Lagos
time zone

Create all
resource pools,
datasets, and
schedules from
here

Resource pool
in Lima
time zone
(GMT -5 hrs)

Create resource pool,
select local Lima
time zone

Dataset in
Lagos
time zone
(GMT +1 hr)

Results of scheduled jobs (local)
This example shows the results of protection jobs using the local time zone for the protection
schedules.
The following actions occur, assuming that the replication jobs all succeed:
•

•

•

The NetApp Management Console data protection capability interprets the Daily local backup
schedule in the time zone of the primary data, therefore, the backup starts at 8:00 p.m. Monday,
Lagos time.
The NetApp Management Console data protection capability interprets the Daily remote backup
schedule in the time zone of the primary data, therefore, the remote backup starts at 11:00 p.m.
Monday, Lagos time. the NetApp Management Console data protection capability starts the
backup, replicating primary data in Nigeria to backup destination storage in Los Angeles.
The NetApp Management Console data protection capability interprets the Weekly mirror
schedule in the time zone of the secondary storage, therefore, remote mirroring starts at 6:30 a.m.
Monday, Los Angeles time. The NetApp Management Console data protection capability mirrors
the data, replicating the backed-up data on the secondary storage in the U.S. to tertiary storage in
Lima.

The location and time zone of the tertiary destination storage does not impact the schedule.
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Destination storage

Destination storage

Resource pool
in Los Angeles
time zone
(GMT -8 hrs)

Resource pool
in Lima
time zone
(GMT -5 hrs)

DataFabric
Manager server
in Hong Kong
time zone
(GMT +8 hrs)

Create schedule using
local time zone settings:
- Daily local backup 8 PM
- Daily remote backup 11 PM
- Weekly mirror 6:30 PM

Weekly mirror to
tertiary storage Starts at 6:30 PM
Los Angeles time

Daily remote backup to secondary
storage - Starts at 11:00 PM Lagos time

Dataset in
Lagos
time zone
(GMT +1 hr)

Daily local backup on primary Starts at 8:00 PM Lagos time

Primary data

Example of a schedule using a default time zone
This example describes the set up and results of selecting the DataFabric Manager server's default
time zone for the dataset and resource pool associated with a protection schedule.
There are three parts to this example.
Related concepts

Effect of time zones on schedules on page 220
Time zone assignment (default)
This example shows how the administrator sets up a default time zone for the server, dataset, and
destination storage.
Assume the following:
•

•

An DataFabric Manager server is located in Hong Kong, China.
The administrator selected the Hong Kong time zone (GMT +8 hrs.) for the server.
From this server in the Hong Kong time zone, the administrator used the NetApp Management
Console data protection capability to create the resource pools, datasets, and protection schedules.
A dataset containing primary data is located in Lagos, Nigeria.
The administrator selected the Africa/Lagos time zone (GMT +1 hr.) for the dataset.
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•

•

The administrator selected the server's default time zone when creating the dataset that contains
the primary data. Therefore, the NetApp Management Console data protection capability
interprets the times and dates of the protection schedule in the Hong Kong time zone.
Resource pools provisioned as backup destination storage are located in the city of Los Angeles
in the United States.
The administrator selected the PST8PDT time zone (GMT -8 hrs.) for the resource pool.
The administrator selected the server's default time zone when creating the resource pool for the
secondary destination storage. Therefore, the NetApp Management Console data protection
capability interprets the times and dates of the protection schedule in the Hong Kong time zone
for replicating data from the secondary storage to the tertiary storage.
Resource pools provisioned as tertiary destination storage for mirroring are located in Lima, Peru.
The administrator selected the America/Lima time zone (GMT -5 hrs.) for the tertiary storage.
The administrator selected the server's default time zone when creating the resource pool for the
tertiary destination storage.
Destination storage

Destination storage

Resource pool
in Los Angeles
time zone
(GMT -8 hrs)

Resource pool
in Lima
time zone
(GMT -5 hrs)

DataFabric
Manager server
in Hong Kong
time zone
(GMT +8 hrs)

(Monitor and control
datasets, schedules,
and resource pools
from here)

Plan your
protection
strategy

Weekly mirror to
tertiary storage

Daily remote backup to
secondary storage

Dataset in
Lagos
time zone
(GMT +1 hr)

Daily local backup on primary

Primary data

Time zone selection for protection schedules (default)
This example shows how the administrator selects the default time zone for the protection schedules.
From the DataFabric Manager server in the Hong Kong time zone, you schedule the following:
•
•

A Daily local backup of the primary data at 8:00 p.m. Monday
8 p.m. Hong Kong = 1:00 p.m. Lagos = 4:00 a.m. Los Angeles = 7:00 a.m. Lima
A Daily remote backup of the primary data in Nigeria to secondary storage in the U.S. at 11:00
p.m. Monday
11 p.m. Hong Kong = 4:00 p.m. Lagos = 7:00 a.m. Los Angeles = 10:00 a.m. Lima
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•

A Weekly mirror copy of the secondary storage from the U.S. to tertiary destination storage in
Peru at 6:30 p.m. Monday
Create resource pool,
select server default
time zone

DataFabric
Manager server
in Hong Kong
time zone
(GMT +8 hrs)

Create dataset,
select server
default time zone

Resource pool
in Los Angeles
time zone
(GMT -8 hrs)

Create all
resource pools,
datasets, and
schedules from
here

Resource pool
in Lima
time zone
(GMT -5 hrs)

Create resource pool,
select server default
time zone

Dataset in
Lagos
time zone
(GMT +1 hr)

Results of scheduled jobs (default)
This example shows the results of protection jobs using the default time zone for the protection
schedules.
The following actions occur, assuming the replication jobs all succeed:
•

•

•

The NetApp Management Console data protection capability interprets the Daily local backup job
in the time zone of the DataFabric Manager server, therefore, the backup starts at 1:00 p.m.
Monday, Lagos time (8:00 p.m. Hong Kong time).
The NetApp Management Console data protection capability interprets the Daily remote backup
job in the time zone of the DataFabric Manager server, therefore, the remote backup starts at 4:00
p.m. Monday, Lagos time (11:00 p.m. Hong Kong time). The NetApp Management Console data
protection capability starts the backup, replicating primary data in Nigeria to backup destination
storage in Los Angeles.
The NetApp Management Console data protection capability interprets the Weekly mirror copy
job in the time zone of the DataFabric Manager server, therefore, remote mirroring starts at 2:30
a.m. Monday, Los Angeles time (6:30 p.m. Hong Kong time). The NetApp Management Console
data protection capability mirrors the data, replicating the backed-up data on the secondary
storage in the U.S. to tertiary storage in Lima.

The location and time zone of the tertiary destination storage does not impact the schedule.
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Destination storage

Destination storage

Resource pool
in Los Angeles
time zone
(GMT -8 hrs)

Resource pool
in Lima
time zone
(GMT -5 hrs)

DataFabric
Manager server
in Hong Kong
time zone
(GMT +8 hrs)

Create schedule using
server default time zone:
- Daily local backup 8 PM
- Daily remote backup 11 PM
- Weekly mirror 6:30 PM

Weekly mirror to
tertiary storage Starts at 2:30 AM
Los Angeles time

Daily remote backup to secondary
storage - Starts at 4:00 PM Lagos time

Dataset in
Lagos
time zone
(GMT +1 hr)

Daily local backup on primary Starts at 1:00 PM Lagos time

Primary data

About protection schedules
You can configure reusable protection schedules (that specify times to carry out data backup and
mirror operations) and throttle schedules (that specify periods of unlimited, limited, or zero network
bandwidth availability for those operations).
Protection and throttle schedules are assigned to protection policies to determine when the backup or
mirror operations that are specified in the policies are carried out.
Summary of schedule features
The NetApp Management Console data protection capability provides a set of protection and throttle
schedule features:
For complex scheduling and retention purposes, you can schedule Hourly,
Hourly, Daily,
Daily, Weekly, and Monthly classes of backup or mirror operations (also called
Weekly, and
Monthly backup events).
or mirror
Note: Despite their labels, Hourly, Daily, Weekly, and Monthly backup or
operations
mirror operations do not necessarily take place once an hour, once a day,
once a week, or once a month.
Hourly events can also be scheduled at intervals that are greater or less
than an hour.
Daily events can be scheduled multiple times a day.
Weekly events can be scheduled multiple times a week.
Monthly events can be scheduled multiple times a month.
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Daily, Weekly,
or Monthly
protection
schedules

You configure Daily, Weekly, or Monthly protection schedules to contain your
backup or mirror operations.
•
•

•

Daily protection schedules specify all backup or mirror operations to take
place in a day. They can include both Hourly and Daily operations.
Weekly protection schedules specify your Weekly operations and also
incorporate the Hourly and Daily operations in one or more existing Daily
protection schedules.
Monthly protection schedules can specify your Monthly operations and also
incorporate the Weekly, Daily, and Hourly operations in any existing
Weekly or Daily schedule.

Hourly, Daily,
Weekly, or
Monthly backup
copy retention

Your Hourly, Daily, Weekly, or Monthly backup operations produce Hourly,
Daily, Weekly, or Monthly classes of backup copies. For retention purposes,
you can assign different retention times to each of these classes of backup
copies when you configure the protection policy. For example, you can choose
to retain your Hourly backup copies just a short duration of 24 hours, and retain
your Daily backup copies for a longer 7 day duration.

Bandwidth
throttle periods

You can specify periods of unlimited, limited, or no network bandwidth
availability to carry out remote backup or mirror operations.

Reusability

You can reuse protection and throttle schedules. When you configure protection
policies, you can apply the same schedule to multiple primary data nodes,
backup connections, or mirror connections in multiple policies.

Planning schedules for protection policy nodes and connections
You can assign schedules to the primary data node, backup connection, or mirror connection of a
protection policy. The NetApp Management Console data protection capability uses the assigned
schedules to carry out the configured data protection operations (local backup, remote backup, or
mirror) appropriate to that node or connection.
Related concepts

Effect of time zones on schedules on page 220
Planning a schedule for the primary data node
On the primary data node, protection schedules specify the times to perform local backups.
Typically, schedules assigned to the primary data node specify times for Hourly local backups at
regular intervals. These backups are good for quick restoration of recent data that might have been
deleted or corrupted by accident. Consider the following questions:
Note: Primary data nodes containing Open Systems SnapVault directories do not support local
backup.

•

How frequently do I need to execute a local backup?
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•

•
•

The less you can afford to lose recent data due to accidental deletion or data corruption, the more
frequently you need to execute local backup.
How long do I need to retain a local backup?
Typically Hourly local backups are retained for at least a 24-hour period, at least until a Daily
remote backup to secondary storage is executed.
Do I need to retain some local backups longer than others?
If you do, then you need to plan on scheduling both Hourly and Daily classes of backups.
Do I want to vary my local backup schedule on weekends?
If you do, then you want to apply at least a weekly schedule that includes a daily schedule of
frequent backups on weekdays and a daily schedule of infrequent backups on weekends.

Planning a schedule for a backup connection
For backup connections, schedules specify the times to perform remote backups from a source to the
secondary or tertiary backup storage.
Typically, schedules assigned to a backup connection specify times for one or two daily remote
backups after working hours or during periods of low data input activity. Daily remote data backup
ensures that data loss due to storage system damage at the backup source can be restored from
secondary or tertiary storage with only a day or less of data loss. Consider the following questions.
•

•

•
•

How frequently do I need to execute a remote backup?
The less you can afford to lose recent data due to damage of the primary data node, the more
frequently you need to backup.
How long do I need to retain a backup on the backup node?
Typically daily remote backups are retained for at least a seven-day period, at least until a
Weekly remote backup to secondary or tertiary storage is executed.
Do I need to retain some backups longer than others?
If you do, then you need to plan on scheduling both Daily and Weekly classes of backups.
Do I want to vary my remote backup schedule on weekends?
If you do, then you want to apply at least a weekly schedule that includes a daily schedule of
frequent backups on weekdays and a daily schedule of infrequent backups on weekends.

Planning a schedule for a mirror connection
For mirror connections, schedules specify the times to perform mirror operations from a source to the
destination storage.
Typically, schedules assigned to a mirror connection specify times for one or two daily mirror
operations after working hours or during periods of low data input activity. Daily mirror backup
ensures that data loss due to storage system damage at the source site can be quickly be restored or at
least made available from the mirror target site. Consider the following questions.
•

•

How frequently do I need to execute a mirror operation?
The less you can afford to lose recent data or have it unavailable, the more frequently you need to
execute mirror operations.
Do I want to vary my mirror schedule on weekends?
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If you do, then you want to apply at least a weekly schedule that includes a daily schedule of
frequent mirror operations on weekdays and a daily schedule of infrequent mirror operations on
weekends.
Throttle schedules and network bandwidth
A throttle schedule enables you to configure periods of unlimited, limited, or zero network
bandwidth availability for your data backup or mirror operations.
During times of heavy general network usage, you might want to limit the network bandwidth used
by your backup or mirror operations. Conversely, during times of light network usage, you might
want to leave unlimited bandwidth available for your protection operations.
If you want to stop all backup or mirror activity over a connection during a time period, use the
throttle schedule to assign zero availability to a backup or mirror connection during that period.
During a period of zero availability no backup or mirror operations can start and all backup or mirror
operations in progress when that period began are aborted and restarted at the end of the period of
zero availability.
Note: Backup or mirror operations that are in progress when a new period of limited bandwidth

begins continue to completion using their original bandwidth allotment. Backup or mirror
operations that start during a period of limited bandwidth allotment execute using that bandwidth
limit.
Note: When the NetApp Management Console data protection capability executes a mirror
operation that consists of multiple simultaneous data transfers, the NetApp Management Console
data protection capability divides the total bandwidth allotted to this operation and distributes it
equally to each transfer.

Throttle schedule properties
You can use the throttle schedule definitions when you configure or edit a throttle schedule.
Name

The name of the throttle schedule.

Start Time

The hour and minute that a bandwidth allotment period begins when this schedule is
applied. Click the up or down arrow to modify the start time. As you change the start
time, the throttle period displayed on the graphed schedule changes accordingly.

End Time

The hour and minute that a bandwidth allotment period ends when this schedule is
applied. Click the up or down arrow to modify the end time. As you change the end
time, the throttle period displayed on the graphed schedule changes accordingly.

Throughput The network bandwidth, in kilobytes per second, that are allotted to an assigned
backup operation during this throttle period. For graphing purposes, bandwidth
availability is rounded up to the nearest kilobyte per second. When the NetApp
Management Console data protection capability executes a mirror operation that
consists of multiple simultaneous data transfers, the NetApp Management Console
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data protection capability divides the total bandwidth allotted to this operation and
distributes it equally to each transfer.
•
•
•

The default setting is no limit on the bandwidth allotted the backup or mirror
operation.
Allotting zero megabytes per second to a throttle period stops any remote backup
or mirror operation in progress or scheduled to start during that throttle period.
Allotting limited bandwidth to a throttle period causes any backup or mirror
operations that start within the period to execute using the allotted bandwidth.
Backup or mirror operations that are in progress when a new period of limited
bandwidth begins, continue to completion using their original bandwidth
allotment.

Delete

Deletes a throttle period from the schedule.

Add

Adds a row of Start Time, End Time, and Throughput fields to specify an additional
throttle period for this schedule.

Protection schedules, time zones and datasets of physical storage objects
If the DataFabric Manager server that hosts the NetApp Management Console data protection
capability is located in a time zone different from the primary data node, backup node, or mirror
node, the difference in time zone settings for the dataset of physical storage objects or physical
resource pool elements of those nodes might affect the execution of the protection or throttle
schedules that you assign in your protection policy.
If a policy node's dataset or physical resource pool elements are not assigned a time zone setting,
then by default the NetApp Management Console data protection capability executes the protection
schedule for that node or its backup or mirror connection in accordance with the clock and time zone
setting on the DataFabric Manager server.
For example, without time zone settings on the primary data node datasets, a daily backup scheduled
for 9 p.m. (Eastern Standard Time) from a NetApp Management Console and a DataFabric Manager
server in New York will, by default, execute at 6 p.m. (Pacific Standard Time) on a primary data
node in Los Angeles, or at 2 a.m. (GMT) at a primary data node in London.
However, if those Los Angeles and London datasets are assigned Pacific Standard Time and GMT
time zone settings respectively, then the NetApp Management Console adjusts the schedule to
execute daily backups at 9 p.m. (Pacific Standard Time) in Los Angeles and at 9 p.m. (GMT) in
London.
Related concepts

Effect of time zones on schedules on page 220

Configuring protection schedules
In general, you use a wizard to configure schedules and you use an editing window to modify them.
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Decisions to make before adding a schedule
Before you use the Add Schedule wizard to add a new protection or throttle schedule to your list of
existing schedules, you must evaluate whether you really need a new schedule and, if so, what type it
should be.
Preliminary schedule decisions
•

•
•

Can the protection policies that you want to apply use their currently assigned schedules?
If not, do you want to apply different daily, weekly, monthly, or throttle schedules to the primary
node, backup connection, or mirror connection components of those protection policies?
If a policy requires a different daily, weekly, monthly, or throttle schedule, can you assign an
existing schedule of that type, or do you need to create a new schedule?
If you need to create a new schedule, what is its name and description?

Daily schedule creation decisions
If you need to add a daily schedule, make the following decisions before starting the Add Schedule
wizard:
•

•

•

•

Do you want to use this daily schedule for specifying hourly backup and mirror operations and, if
so, over which hours and at which time intervals?
A common practice is to schedule frequent hourly backup and mirror operations at the Primary
Data node during working hours or periods of heavy data input.
Do you want to schedule hourly backup operations at intervals shorter than an hour?
Protection configurations on which you plan to schedule backup operations at intervals of less
than an hour require that both the source and destination nodes are preconfigured with the
SnapMirror license.
Do you want daily backups for retention purposes and, if so, at what times of day?
When you apply this schedule to a protection policy node, you can assign different retention
durations to your hourly and daily backups. A common practice is to schedule one or two daily
backup operations per day, at least one of which is during nonworking hours.
Do you want to schedule daily mirror operations at unique times in addition to the regular hourly
mirror operations that you set up in this schedule?

Weekly schedule creation decisions
If you need to add a weekly schedule, make the following decisions before starting the Add Schedule
wizard:
•

•

Do you want to apply existing daily schedules to this weekly schedule?
If so, for which days of the week (for example, Daily schedule A: Saturday through Sunday,
Daily schedule B: Monday through Friday)?
The hourly and daily backups in the applied daily schedules are automatically included in the new
weekly schedule.
Do you want weekly backups for retention purposes?
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•
•

When you apply this schedule to a protection policy node, you can assign different retention
durations to your hourly, daily, and weekly backups.
Do you want to schedule weekly mirror operations at unique times in addition to the times
already specified for the hourly or daily mirror operations of the applied daily schedules?
Which days and times during the week do you want to schedule weekly backup or mirror
operations?
A common practice is to schedule one or two weekly backups per week.

Monthly schedule creation decisions
If you need to add a monthly schedule, make the following decisions before starting the Add
Schedule wizard:
•

•

•

•

Do you want to apply an existing daily or weekly schedule to this monthly schedule?
The hourly, daily, and weekly backup and mirror operations in the applied daily or weekly
schedule are automatically included in the new monthly schedule.
If you specify a daily schedule, that schedule applies to every day of the month; if you specify a
weekly schedule, that schedule applies to every week of the month.
Do you want monthly backups for retention purposes?
When you apply this schedule to a protection policy node, you can assign different retention
durations to your hourly, daily, weekly, and monthly backups.
Do you want to schedule monthly mirror operations at unique times outside the times already
specified for the hourly, daily, or weekly mirror operations of the applied daily or weekly
schedules?
Which days and times during the month do you want to schedule monthly backup or mirror
operations?
A common practice is to schedule one or two monthly backups per month.

Throttle schedule creation decisions
Data protection operations can consume large amounts of network bandwidth. If you need to create a
schedule to throttle the bandwidth availability used by these operations, make the following decisions
before starting the Add Schedule wizard:
•
•

Do you want to restrict the network bandwidth available for backup or mirror operations at
certain times of the day?
Do you want to prevent new backup or mirror operations completely, at certain times of the day?
Zero network bandwidth allotment prevents all new backup or mirror operations during the
period and on the connection in which it is in effect.
Note: When the NetApp Management Console data protection capability executes a mirror
operation that consists of multiple simultaneous data transfers, NetApp Management Console
divides the total bandwidth allotted to this operation and distributes it equally to each transfer.
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Adding a daily protection schedule
You can use the Add Schedule wizard to create new daily protection schedules. After you create a
daily schedule, you can apply it to protection policies to determine when hourly and daily backup or
mirror operations are executed.
Before you begin

Have the information available that you need to complete this task:
•
•
•

Time to perform the mirror or backup operation and how often (required)
Retention time of mirror or backup copies (optional)
Throttle schedule (optional)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Click Add to start the Add Schedule wizard.
3. In the wizard, select the Daily schedule option and complete the wizard to create the new Daily
schedule.
If you do not want to include hourly backup or mirror operations in this schedule, continue past
the Hourly Events property sheet without specifying a time.
Result

Your new schedule is listed on the Schedules tab.
Related concepts

Decisions to make before adding a protection policy on page 200
Related references

Administrator roles and capabilities on page 54
Adding a weekly protection schedule
You can use the Add Schedule wizard to create new weekly protection schedules. After you create a
weekly schedule, you can apply it to protection policies to determine when hourly, daily, and weekly
backup or mirror operations are executed.
Before you begin

Have the information available that you need to complete this task:
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•
•
•

Days and time to perform the mirror or backup operation and how often (required)
Retention time of mirror or backup copies (optional)
Throttle schedule (optional)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Click Add to start the Add Schedule wizard.
3. In the wizard, select the Weekly schedule option and complete the wizard to create the new
Weekly schedule.
If you do not want to schedule weekly backups, continue past the Weekly Events property sheet
without specifying a day or time.
Result

Your new schedule is listed on the Schedules tab.
Related concepts

Decisions to make before adding a protection policy on page 200
Related references

Administrator roles and capabilities on page 54
Adding a monthly protection schedule
You can use the Add Schedule wizard to create new monthly protection schedules. After you create a
monthly schedule, you can apply it to protection policies to determine when hourly, daily, weekly,
and monthly backup or mirror operations are executed.
Before you begin

Have the information available that you need to complete this task:
•
•
•

Days and time to perform the mirror or backup operation and how often (required)
Retention time of mirror or backup copies (optional)
Throttle schedule (optional)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
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2. Click Add to start the Add Schedule wizard.
3. In the wizard, select the Monthly schedule option and complete the wizard to create the new
monthly schedule.
Result

Your new schedule is listed on the Schedules tab.
Related concepts

Decisions to make before adding a protection policy on page 200
Related references

Administrator roles and capabilities on page 54
Adding a throttle schedule
You can use the Add Schedule wizard to create new throttle schedules. After you create a throttle
schedule, you can apply it to protection policies to schedule periods of unlimited, limited, or no
network bandwidth availability for remote backup or mirror operations.
Before you begin

Have the information available that you need to complete this task:
•
•

Days and time to restrict the network bandwidth for backup or mirror operations.
Days and times to prevent backup or mirror operations.

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Click Add to start the Add Schedule wizard.
3. In the wizard, select the Throttle schedule option and complete the wizard to create the new
throttle schedule.
Result

Your new schedule is listed on the Schedules tab.
Related concepts

Decisions to make before adding a protection policy on page 200
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Related references

Administrator roles and capabilities on page 54
Editing a daily schedule
You can edit a daily protection schedule to modify the hourly backup and mirror times and the daily
backup or mirror times.
Before you begin

Have the information available that you need to complete this task:
•
•

Times for hourly backup or mirror operations.
Times for daily backup or mirror operations.

If you plan to schedule backup operations at intervals of less than one hour, confirm that both the
source and destination nodes are configured with a SnapMirror rather than a SnapVault license.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Be aware that when you apply this schedule to a node or connection in a policy, the actual times of
your scheduled backup or mirror operations are affected by the time zone location of the source node
in relation to the time zone location of the DataFabric Manager server and the time zone setting of
the dataset or physical resource assigned to the source node.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Select the daily schedule that you want to edit and look at the Dependencies list to view all the
weekly schedules, monthly schedules, or protection policies that use this schedule.
Make sure that the edits that you plan to make to the schedule are appropriate for all the
dependencies in the list.
3. With the daily schedule that you want to edit still selected, click Edit.
The General tab on the Properties sheet displays a graph of the scheduled events. Depending upon
the protection policy and the policy node or connection to which you apply this schedule, the
times shown on the graph schedule either local backups (on the primary data node) or backup or
mirror copies (for backup connections or mirror connections).
4. To change the name or description of the schedule, edit the Name or Description parameters and
click Apply.
5. To configure hourly backup or mirror times, click Hourly Events, then click Add.
a) Double-click the Start Time and End Time columns, then use the up and down arrows in the
newly added time entry to specify a time period for hourly backup or mirror operations.
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The period timeline in the graph adjusts to display more or fewer hours according to the
changes you make.
b) Double-click Frequency and enter the frequency, in minutes, that an hourly backup will take
place within this time period.
c) Click Apply to confirm the changes to the schedule.
6. To configure daily backup or mirror times, click Daily Events, then click Add.
a) Use the up and down arrows in the newly added time entry to specify a time period for daily
backup or mirror operations.
The period timeline in the graph adjusts to display more or fewer hours according to the
changes you make.
b) Click Apply to confirm the changes to the schedule.
7. To delete an existing time period from this schedule, click Hourly Events or Daily Events, then
select the schedule and click Delete.
8. Click OK to finalize your changes to this daily schedule.
Result

You can include this daily protection schedule in a weekly or monthly protection schedule or you can
assign it directly to a protection policy's primary data node, backup connection, or mirror connection
elements. When you assign this schedule to a policy, you can assign different retention durations for
the hourly and daily backup copies produced by this schedule.
Related references

Administrator roles and capabilities on page 54
Editing a weekly schedule
You can edit a weekly protection schedule to modify the daily and weekly backup and mirror
operations.
Before you begin

Have the information available that you need to complete this task:
•
•

Times for weekly backup or mirror operations.
Changes to a daily schedule used by this weekly schedule.

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Be aware that when you apply this schedule to a node or connection in a policy, the actual times of
your scheduled backup or mirror operations are affected by the time zone location of the source node
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in relation to the time zone location of the DataFabric Manager server and the time zone setting of
the dataset or physical resource assigned to the source node.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Select the weekly schedule that you want to edit and look at the Dependencies list to view all the
monthly schedules or protection policies that use this schedule.
Make sure that the edits that you plan to make to the schedule are appropriate for all the
dependencies in the list.
3. With the weekly schedule that you want to edit still selected, click Edit.
The General tab on the Properties sheet displays a graph of the scheduled events.
4. To change the name or description of the schedule, edit the Name or Description parameters and
click Apply.
5. To configure or modify daily backup or mirror times, click Daily Events. To configure a new
daily backup or mirror schedule, click Add.
a) Double-click the Start Day and End Day columns and use the up or down arrows to specify
the first and last day of the week on which to apply an existing daily schedule (for example,
Monday and Friday).
b) Double-click Daily Schedule and select the daily schedule that you want to apply within these
weekly start and end days.
Your weekly schedule automatically schedules the hourly and daily backup or mirror
operations that are specified in the assigned daily schedule.
c) Click Apply to confirm the changes to the schedule.
6. To configure or modify weekly backup or mirror times, click Weekly Events. To configure a
new weekly backup or mirror schedule, click Add.
a) Double-click the Event Day and Event Time columns and use the up or down arrows to
specify a day and a time.
b) Click Apply to confirm the changes to the schedule.
7. To delete an existing time period from this schedule, click Daily Events or Weekly Events, then
select the schedule and click Delete.
8. Click OK to finalize your changes to this weekly schedule.
Result

You can include this weekly protection schedule in a monthly protection schedule or you can assign
it directly to a protection policy's primary data node, backup connection, or mirror connection
elements. When you assign this schedule to a policy, you can assign different retention durations for
the hourly, daily, and weekly backup copies produced by this schedule.
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Related references

Administrator roles and capabilities on page 54
Editing a monthly schedule
You can edit a monthly protection schedule to modify the daily, weekly, and monthly backup and
mirror operations.
Before you begin

Have the information available that you need to complete this task:
•
•

Times for monthly backup or mirror operations.
Changes to a daily or weekly schedule used by this monthly schedule.

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Be aware that when you apply this schedule to a node or connection in a policy, the actual times of
your scheduled backup or mirror operations are affected by the time zone location of the source node
in relation to the time zone location of the DataFabric Manager server and the time zone setting of
the dataset or physical resource assigned to the source node.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Select the monthly schedule that you want to edit and look at the Dependencies list to view all the
protection policies that use this schedule.
Make sure that the edits that you plan to make to the schedule are appropriate for all the
dependencies in the list.
3. With the monthly schedule that you want to edit still selected, click Edit.
The General tab on the Properties sheet displays a graph of the scheduled events.
4. To change the name or description of the schedule, edit the Name or Description parameters and
click Apply.
5. To edit the daily or weekly schedule assignments for this monthly schedule, click General, make
the changes, then click Apply.
6. To configure or modify daily or weekly schedule assignments, click Monthly Events. To
configure a new monthly backup or mirror schedule, click Add.
a) Double-click the entries you want to edit and use the up or down arrows to select new values.
b) Click Apply to confirm the changes to the schedule.
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7. To delete an existing entry from this schedule, click Monthly Events, then select the schedule
and click Delete.
8. Click OK to finalize your changes to this monthly schedule.
Result

You can assign this monthly protection schedule directly to a protection policy's primary data node,
backup connection, or mirror connection elements. When you assign this schedule to a policy, you
can assign different retention durations for the hourly, daily, and weekly, and monthly backup copies
produced by this schedule. You can assign this Monthly protection schedule directly to a protection
policy's primary node, backup connection, or mirror connection elements.
Related references

Administrator roles and capabilities on page 54
Editing a throttle schedule
You can edit an existing throttle schedule to increase or limit the connection bandwidth allotted to
remote backup or mirror operations.
Before you begin

Have the information available that you need to complete this task:
•
•

Days and time to restrict the network bandwidth for backup or mirror operations.
Days and times to prevent backup or mirror operations.

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Be aware that when you apply this throttle schedule to a backup connection or mirror connection in a
policy, the actual start and end times of your throttle periods are affected by the time zone location of
the backup or mirror source nodes in relation to the time zone location of the DataFabric Manager
server and the time zone setting of the datasets or physical resources assigned to the source nodes.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Select a throttle schedule and click Edit.
The throttle schedule Properties sheet displays a graph of the schedule that shows the periods of
limited or no network bandwidth availability. For graphing purposes, bandwidth availability is
rounded up to the nearest kilobyte per second.
3. To add a throttle time, click Add.
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4. To edit a new or existing throttle time, select the entry, then double click the entry in each column
and select or enter a new setting
5. Click OK to finalize your changes to this throttle schedule.
Result

You can assign this throttle schedule to a protection policy's backup connection or mirror connection
components.
Related references

Administrator roles and capabilities on page 54

Managing protection and throttle schedules
You can delete, modify, and copy protection and throttle schedules.
Deleting a protection or throttle schedule
You can delete daily, weekly, monthly or throttle schedules.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Select the schedule that you want to delete and look at the Dependencies list to view any
protection policies or other schedules to which this schedule is assigned.
Note: You cannot delete a schedule if it is used by protection policies or other schedules. If any
are listed in the Dependencies list, you must first stop this procedure and edit the listed policies
and schedules so that they no longer use this schedule.

3. If no dependencies are listed, click Delete, then click Yes.
The selected schedule is deleted.
Related references

Administrator roles and capabilities on page 54
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Assigning or changing schedules in a protection policy
You can assign or change protection and throttle schedules for the primary node, backup connection,
or mirror connection of a protection policy.
Before you begin

•
•

•

Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
Confirm that time zone differences and settings on the DataFabric Manager server, and the
dataset or physical resource pool elements of the policy nodes support the new schedule
assignment.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that has the local backup, remote backup, or mirror schedule
assignment you want to modify and click Edit > Nodes and Connections.
3. Select the primary node, backup connection, or mirror connection that you want to modify.
4. Locate the appropriate schedule in the Properties area (Local Backup Schedule, Backup Schedule
Name, Mirror Schedule Name, or Throttle Schedule Name) and select a new schedule from the
schedule drop-down list.
5. After you complete your modifications, click Preview.
6. Review the effects of your changes and do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the Properties sheet.

The modifications take effect immediately.
Related references

Administrator roles and capabilities on page 54
Copying a protection or throttle schedule
You can quickly create copies of your a daily, weekly, monthly or throttle schedule. After copying a
schedule, you can customize it to your particular needs.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Steps

1. From the menu bar, click Policies > Protection > Schedules.
2. Select the schedule that you want to copy and click Copy.
A copy of the selected schedule appears with "Copy of .." appended to the original schedule
name. The NetApp Management Console data protection capability selects and highlights the
new "Copy of.." schedule for editing.
3. Click Edit to rename and customize the new schedule copy as needed.
Related references

Administrator roles and capabilities on page 54

What a host is
A host is a computer system that accesses data on a storage system.

About hosts
The hosts that you can view in NetApp Management Console and use in your policy implementations
have been automatically discovered by DataFabric Manager or manually added to its database.
How hosts become visible to the console
When either the NetApp Management Console data protection capability or the NetApp Management
Console provisioning capability is enabled, Operations Manager automatically begins a host
discovery process. The discovered hosts automatically display in the lists of storage system, vFiler
unit, and Open Systems SnapVault client hosts in the interface.
When you add a host to NetApp Management Console, the host is incorporated into the DataFabric
Manager server database and is viewable in Operations Manager. You can add host systems from the
Storage Systems Hosts window, vFiler Units window, and Open Systems SnapVault window.
Some items that are viewable as hosts in Operations Manager are not listed as hosts in the NetApp
Management Console interface, because the console does not use items of that type to implement its
data management tasks. For example, Fibre Channel switches are considered hosts in Operations
Manager but are not included in the list of hosts in NetApp Management Console.
For more information about host discovery and management with the DataFabric Manager server
database, see the Operations Manager Administration Guide.
Related information

Operations Manager Administration Guide - http://support.netapp.com/NOW/knowledge/docs/
DFM_win/dfm_index.shtml
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Host monitoring
You can verify that a host is available and correctly configured by accessing the list in the
appropriate Hosts window for storage systems, vFiler units, and Open Systems SnapVault systems.
The NetApp Management Console data protection and provisioning capabilities regularly check for
updates to configuration information. This data is gathered from SNMP queries by system monitors.
The monitors update the DataFabric Manager server database at scheduled intervals. The NetApp
Management Console data protection and provisioning capabilities query the DataFabric Manager
server database for the information that is then displayed in NetApp Management Console.
Because the NetApp Management Console data protection and provisioning capabilities do not query
the hosts directly but rely on the scheduled monitors, the configuration information displayed in the
Hosts windows is not real-time data. Therefore, this data might not reflect recent changes made to a
storage system or configuration and could be outdated by a few minutes or a few hours, depending
on the changes made.
Ways to investigate problems with hosts
If you are investigating a policy failure, you can use the information displayed in the Hosts windows
to determine whether the cause is a problem with a host. This information can also help determine
the potential impact of any changes that you might make to a host.
Most problems that you might encounter with a host can be diagnosed and corrected by using the
host diagnostics wizards. The diagnostics wizards are located on the Storage Systems Hosts window
and the OSSV Hosts window. The wizards include steps to help you locate and fix issues with hosts.
You can also use the Edit hosts property sheets to make changes to host licenses and host and NDMP
credentials. You can access each of the wizards and property sheets in the following windows of the
interface.
Storage
Systems
Hosts
window

Provides information about storage systems that can help you verify whether a host is
up and accepting the NDMP credentials specified for it, as well as whether the
appropriate licenses are assigned to it.
Allows you to review path and relationship information about storage systems, as well
as to check host and NDMP status. The path and relationship information displayed for
each individually selected storage system helps you see the interdependencies between
hosts. For example, by reviewing the data flowing into and out of a selected storage
system, you can evaluate the impact of temporarily removing that storage system from
service for maintenance. You can also review information about input and output
relationships to determine whether lag times are within specified thresholds and which
datasets are impacted if the lag threshold has been or is about to be exceeded.
From this window, you can start the Add Storage System wizard and the Diagnose
Storage Systems wizard, or you can open the Edit property sheet for storage systems.
You can also refresh the information about a selected host in the window's host list.
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vFiler
Units
window

Allows you to review the status of vFiler units and to verify the IP address of the vFiler
unit and the name of the storage system that is hosting it.
Allows you to review path and relationship information about vFiler units. The path
and relationship information displayed for each individually selected vFiler unit helps
you see the interdependencies between hosts and datasets. For example, by reviewing
the data flowing into and out of a selected host, you can evaluate the impact of
temporarily removing that host from service for maintenance.
From this window, you can start the Add vFiler Unit wizard or the Setup vFiler Unit
wizard, and you can delete vFiler units.

OSSV
Hosts
window

Allows you to review the status of Open Systems SnapVault hosts (including VMware
ESX hosts) the port and credentials status of each NetApp Host Agent, and the status of
NDMP connections and credentials.
Allows you to investigate problems with an Open Systems SnapVault client.
Information in this window includes the host and NDMP status, the NDMP credentials
status, the operating system and version that each host is running, and path information
for each host.
From this window, you can start the Add OSSV Host wizard and the Diagnose OSSV
Host wizard, and open the Edit OSSV host property sheet for a host that contains an
Open Systems SnapVault agent.
From this window, you can also stop and start an Open Systems SnapVault 2.3 and
later agent on which NetApp Host Agent is installed. Stopping and starting the agent
stops and starts backup service on the selected client, which might resolve the problem.
After you restart the backup service, you can click Refresh to display current data for
the selected client and determine the effect of restarting the backup service.
Note: There is no Open Systems SnapVault plug-in for Solaris, so the NetApp Host
Agent cannot communicate with the Open Systems SnapVault agent. Therefore, the
Host Agent Status displays as Not Detected and management tasks such as start and
stop of the Open Systems SnapVault agent cannot be performed from the NetApp
Management Console.

Related tasks

Diagnosing a storage system on page 272
Diagnosing an Open Systems SnapVault host on page 273
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Data ONTAP licenses used for protecting or provisioning data
There are several Data ONTAP licensed options that you can use to protect or provision your data.
After you have purchased the software licenses you need, you can assign these licenses to your
primary and secondary storage from the Storage Systems Hosts window.
When you purchase a Data ONTAP option license, you receive a code composed of a string of
characters, such as ABCDEFG, that is unique to a particular service. You receive license codes for
every protocol and option, or service, that you purchase.
Not all purchased license codes are installed on a storage system before it is shipped from the
factory. Some licenses are installed after the system is set up. You can purchase license codes to
enable additional services at any time. If you misplace a license code, you can contact NetApp
technical support or log in to the NetApp Support Site to obtain a copy.
You must enter a software license code on a storage system to enable the corresponding service. You
do not need to indicate which license the code enables. The code is matched automatically to the
appropriate service license.
Note: The Licenses area is visible only when the selected host is a single storage system running
Data ONTAP. If you plan to use Open Systems SnapVault to back up data on a host that is not
running Data ONTAP, you select the secondary storage system to license the necessary Data
ONTAP services.

The following licenses are available for use with the DataFabric Manager server:
SnapMirror license You install a SnapMirror license on each of the source and destination
storage systems for the mirrored data. If the source and destination volumes
are on the same system, only one license is required.
SnapMirror replicates data to one or more networked storage systems.
SnapMirror updates the mirrored data to keep it current and available for
disaster recovery, offloading tape backup, read-only data distribution, testing
on nonproduction systems, online data migration, and so on. You can also
enable the SnapMirror license to use Qtree SnapMirror for backup.
To use SnapMirror software, you must update the
snapmirror.access option in Data ONTAP to specify the destination

systems that are allowed to access the primary data source system. For more
information about the snapmirror.access option, see the Data ONTAP
Data Protection Online Backup and Recovery Guide for 7-Mode.
SnapVault Data
ONTAP secondary
license

You install the SnapVault Secondary license on storage systems that host the
backups of protected data. SnapVault creates backups of data stored on
multiple primary storage systems and copies the backups to a secondary
storage system. If data loss or corruption occurs, backed-up data can be
restored to a primary or open storage system with little of the downtime and
uncertainty associated with conventional tape backup and restore operations.
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For versions of Data ONTAP 7.3 or later, a single storage system can
contain a SnapVault Data ONTAP Primary license and a SnapVault
Secondary license.
SnapVault Data
ONTAP primary
license

You install the SnapVault Data ONTAP Primary license on storage systems
running Data ONTAP that contain host data to be backed up. For versions of
Data ONTAP 7.3 or later, a single storage system can contain a SnapVault
Data ONTAP Primary license and a SnapVault Secondary license.

SnapVault
Windows Primary
License

You install the SnapVault Windows Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a
Windows-based primary storage system running the Open Systems
SnapVault agent. A Windows-based primary storage system running the
Open Systems SnapVault agent does not require a SnapVault license.

You install the SnapVault Open File Manager license on a secondary storage
SnapVault
Windows Open File system to enable the backup of open files on Windows primary storage
systems running the Open Systems SnapVault agent.
Manager license
You must install the SnapVault Windows Primary license and the
SnapVault Data ONTAP Secondary license on the secondary storage system
before installing the SnapVault Open File Manager license.
SnapVault UNIX
primary license

You install the SnapVault UNIX Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a UNIXbased primary storage system (AIX, HP-UX, or Solaris) running the Open
Systems SnapVault agent. A UNIX-based primary storage system running
the Open Systems SnapVault agent does not require a SnapVault license.

SnapVault Linux
primary license

You install the SnapVault Linux Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a Linuxbased primary storage system running the Open Systems SnapVault agent. A
Linux-based primary storage system running the Open Systems SnapVault
agent does not require a SnapVault license.

NearStore Option
license

The NearStore license enables your storage system to use transfer resources
as conservatively as if it were optimized as a backup system. This approach
is useful when the storage system on which you want to store backed-up data
is not a system optimized for storing backups, and you want to minimize the
number of transfer resources the storage system requires.
Storage systems using the NearStore license must meet the following
criteria:
•
•
•

The storage system must be a FAS30xx, FAS31xx, or FAS60xx system.
The version of Data ONTAP must be 7.1 or later.
If you plan to use the SnapVault service, the storage system must have a
SnapVault secondary license enabled.
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Deduplication
license

The deduplication license (a_sis) enables you to consolidate blocks of
duplicate data into single blocks to store more information using less storage
space.

SnapMirror Sync
license

The SnapMirror Sync license enables you to replicate data to the destination
as soon as it is written to the source volume. SnapMirror Sync is a feature of
SnapMirror.

MultiStore Option
license

The MultiStore Option license enables you to partition the storage and
network resources of a single storage system so that it appears as multiple
storage systems on the network. Each virtual "storage system" created as a
result of the partitioning is called a vFiler unit. A vFiler unit, using the
resources assigned, delivers file services to its clients as a storage system
does.
The storage resource assigned to a vFiler unit can be one or more qtrees or
volumes. The storage system on which you create vFiler units is called the
hosting storage system. The storage and network resources used by the
vFiler units exist on the hosting storage system.
Be sure the host on which you intend to install the MultiStore Option license
is running Data ONTAP 6.5 or later.

FlexClone license

The FlexClone license is necessary on storage systems that you intend to use
as resources for secondary nodes for datasets of virtual objects.

Single file restore
license

The Single file restore license is necessary on storage systems that you
intend to use as primary storage for datasets of virtual objects.

Related concepts

Process for determining when SnapVault and qtree SnapMirror are used to perform backups on
page 252
Related information

Documentation on the NetApp Support Site: support.netapp.com
Process for determining when SnapVault and qtree SnapMirror are used to perform
backups
When both SnapVault and qtree SnapMirror licenses are installed in your environment, the NetApp
Management Console data protection capability determines which technology to use based on the
licenses enabled on the source and destination hosts and the schedule applied to the backup
connection of the protection policy.
If you use only SnapVault licenses in your environment, the NetApp Management Console data
protection capability uses SnapVault for backups. However, if you use both SnapVault and
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SnapMirror licenses in your environment, the NetApp Management Console data protection
capability uses the following sequence to determine which one to use for backups:
1. If the data to be backed up is located on a host running the Open Systems SnapVault agent, the
NetApp Management Console data protection capability uses SnapVault for backups.
2. If either the source or destination host has the SnapMirror license enabled but not the SnapVault
license, the NetApp Management Console data protection capability uses qtree SnapMirror for
backups.
3. If both the source and destination host have the SnapVault license enabled but not the SnapMirror
license, the NetApp Management Console data protection capability uses SnapVault for backups.
4. If the schedule applied to the backup connection specifies that the data needs to be backed up
more frequently than once an hour, the NetApp Management Console data protection capability
uses qtree SnapMirror for backups.
5. If none of the previous conditions applies, by default, the NetApp Management Console data
protection capability uses SnapVault for backups.
Related references

Data ONTAP licenses used for protecting or provisioning data on page 68
vFiler unit configuration using a script
You can write a script to customize a vFiler unit configuration. When the script is specified in the
Setup vFiler Unit wizard, the NetApp Management Console provisioning capability executes the
script before and after a vFiler unit is set up. You must specify the full DataFabric Manager server
path of the script.
For example, if you want the new vFiler unit to use a vFiler unit configuration that was saved in
Operations Manager, you might write a script that runs the appropriate dfm config commands to
retrieve and execute that configuration.
For information on the environment variables you may need for a script, see the dfpm man pages in
Operations Manager.

Configuring hosts
In general, you use a wizard to configure hosts and you use an editing window to modify property
values.
Decisions to make before adding a storage system
Before running the Add Storage System wizard, it is useful to have all of the configuration
information available for the host that you are adding.
Host Name or
IP Address

What is the name or the IP address of the storage system that you want to add?
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Licenses

Which services do you want enabled on the storage system?
You must enter a software license code to enable each corresponding service on
the storage system or host. Licenses are set immediately upon entering the
information in the text field. License information cannot be removed or cancelled
once entered, so be sure that you are entering the correct storage system.
When you enable licenses, consider how you want to use each storage system to
protect data:
•
•
•

Login
Credentials

Can it be used to hold primary data, secondary data, or both?
Can it be used for backups or for mirroring?
Which operating system can it run on?

What are the user name and password for the storage system?

Access Control Which roles do you want to have access privileges to the storage system?
You can assign different access privileges for SnapVault and for SnapMirror.
NDMP
Credentials

What is the NDMP user name for the storage system that you want to add?
The DataFabric Manager server automatically manages the password based on the
user name provided. The DataFabric Manager server uses these credentials to
communicate with the selected host over NDMP.
To obtain an encrypted NDMP password for a storage system, type ndmpd
password username at the command line of the storage system.
For more information about how Operations Manager uses NDMP, see the Data
ONTAP 7-Mode Storage Management Guide. For more information about
NDMP credentials, see the Data ONTAP 7-Mode Data Protection Tape Backup
and Recovery Guide.

Related information

Data ONTAP Storage Management Guide - http://support.netapp.com/NOW/knowledge/docs/
ontap/ontap_index.shtml
Data ONTAP Data Protection Tape Backup and Recovery Guide - http://
support.netapp.com/NOW/knowledge/docs/ontap/ontap_index.shtml
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Adding a storage system
You can add storage systems to the hosts list to make them available for inclusion in data
management actions. When you add storage systems to NetApp Management Console, you also add
the storage to the DataFabric Manager database.
Before you begin

Have the following information available for the storage system that you want to add:
•
•
•
•
•
•

Host name or IP address
Host credentials (user name and password)
License code
SnapVault Access Control List, if licensed for SnapVault
SnapMirror Access Control List, if licensed for SnapMirror
NDMP credentials (user name and password)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > Storage Systems.
2. Click Add to start the Add Storage System wizard.
Enter or select information as requested in the wizard.
Note: In this wizard, clicking Next implements the operations on each page. Clicking Back or
Cancel does not undo operations performed on previous pages.

3. Verify that the storage system that you added is included in the hosts list in the Storage Systems
Hosts window.
You might need to update the window before you can view the new host in the host list.
Result

You can now manage data located on the new storage system or use the storage as a secondary
storage system for backups or mirror copies.
Related concepts

Decisions to make before adding a storage system on page 253
Related references

Administrator roles and capabilities on page 54
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Decisions to make before adding an Open Systems SnapVault host
Before adding an Open Systems SnapVault host using the Add OSSV Host wizard, it is useful to
have all of the host's configuration information available.
If the Open Systems SnapVault host that you are adding resides on a VMware ESX 3.5 server, you
should review the guidelines for adding an Open Systems SnapVault host on an VMware ESX 3.5
server.
Host Name or
IP Address

What is the name or the IP address of the Open Systems SnapVault host that you
want to add?

Host Agent
Credentials

•

•

What are the user name and password that the DataFabric Manager server
should use to authenticate to the host running NetApp Host Agent?
Operating system credentials for the host on which NetApp Host Agent is
running, if the DataFabric Manager server is managing the credentials for you
Credentials for NetApp Host Agent, if DataFabric Manager server is not
managing the credentials
Should the DataFabric Manager server set up and manage the host agent
password or will you do it manually?
For instructions describing how to set up credentials for hosts running
NetApp Host Agent, see the NetApp Host Agent Installation and
Administration Guide.

NetApp Host
Agent Port

What port number do you want to use for host agent access?

NDMP
Credentials

What are the NDMP user name, password, and port number for the host that you
want to add?

The default port is 4092.

The DataFabric Manager server uses these credentials to communicate with the
selected host over NDMP.
To obtain an encrypted NDMP password for the host, issue ndmpd password
username from the command line.
The default port number is 10000.
If the host runs the Open Systems SnapVault agent, specify the port number, if
other than the default, that the DataFabric Manager server should use when
communicating with the selected host over NDMP.
For more information about how Operations Manager uses NDMP, see the Data
ONTAP 7-Mode Storage Management Guide. For more information about
NDMP credentials, see the Data ONTAP 7-Mode Data Protection Tape Backup
and Recovery Guide.
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For more information about Open Systems SnapVault configurations, see the Open Systems
SnapVault Installation and Administration Guide.
Related concepts

Decisions to make before adding vFiler templates on page 628
Related references

Guidelines for adding and editing an Open Systems SnapVault host on an ESX server on page 257
Related information

Open Systems SnapVault Installation and Administration Guide: support.netapp.com/
documentation/productsatoz/index.html
Data ONTAP Storage Management Guide : support.netapp.com/documentation/productsatoz/
index.html
Data ONTAP Data Protection Tape Backup and Recovery Guide: support.netapp.com/
documentation/productsatoz/index.html
Guidelines for adding and editing an Open Systems SnapVault host on an ESX server
NetApp Management Console supports Open Systems SnapVault backups for virtual machines
(VMs) on VMware ESX servers. Before starting the Add OSSV Host wizard for VMware ESX 3.5, it
is useful to review the guidelines.
•
•
•
•
•

The Open Systems SnapVault software must be installed on each VMware ESX 3.5 server that
you want to back up.
The NetApp Host Agent is NOT needed for an Open Systems SnapVault installation on a
VMware ESX 3.5 server.
The DataFabric Manager server discovers only the virtual machines that are registered to the
VMware ESX 3.5 server that you have discovered.
NetApp Management Console backs up only the virtual machines on an VMware ESX 3.5 server.
File system backups on a VMware ESX 3.5 server are not supported.
The backup for the virtual machine is always through the VMware ESX 3.5 server that was
involved in creating the relationship.
If the virtual machine is moved to another server, the backup is still through the original VMware
ESX 3.5 server. If the original VMware ESX 3.5 server is offline, the virtual machine is not
backed up.

For more information about Open Systems SnapVault configurations, see the Open Systems
SnapVault Installation and Administration Guide.
Related information

Open Systems SnapVault Installation and Administration Guide - http://
support.netapp.com/NOW/knowledge/docs/client_filer_index.shtml
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Adding an Open Systems SnapVault host
You can add an Open Systems SnapVault host to make the host and its data available to the
DataFabric Manager server for inclusion in data management actions. When you add an Open
Systems SnapVault host to DataFabric Manager server, you also add the host to the DataFabric
Manager database.
Before you begin

•

Have the following information available:
•
•
•

Host name or IP address
Port number for NetApp Host Agent
Decision about whether DataFabric Manager should set up and manage the NetApp Host
Agent password:
•

•

•

If yes, provide the operating system credentials for the host on which NetApp Host Agent
is running.
• If no, provide the credentials for NetApp Host Agent.
• NDMP credentials (user name and password) and port number
If the Open Systems SnapVault host you are adding resides on a VMware ESX 3.5 server, you
must be familiar with the guidelines for adding an Open Systems SnapVault host on a VMware
ESX 3.5 server.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Hosts > OSSV.
2. Click Add to start the Add OSSV Host wizard.
Enter or select information as requested in the wizard.
3. Verify that the host you added is included in the hosts list in the OSSV Hosts window.
You might need to refresh the window before you can view the new host in the host list.
Related concepts

Decisions to make before adding an Open Systems SnapVault host on page 256
Related references

Guidelines for adding and editing an Open Systems SnapVault host on an ESX server on page 257
Administrator roles and capabilities on page 54

Protection Help | 259

Decisions to make before adding a vFiler unit
Before starting the Add vFiler Unit wizard, it is useful to have all of the configuration information
available for the unit that are you adding.
Name

What is the name of the vFiler unit that you want to add?
The vFiler unit name must be unique.

IP space

What is the IP space for the vFiler unit that you want to add?
An IP space defines an address in which the vFiler unit can participate. If no IP
space is defined for the vFiler unit, use default-ipspace. For more information
about vFiler IP space, see the Data ONTAP 7-Mode MultiStore Management
Guide.

Allowed
protocols

What protocols are assigned to the vFiler unit?
The following protocols are supported:
•
•
•

iSCSI
NFS
CIFS

Fibre Channel is not supported on vFiler units.
Attention: If you assign the CIFS protocol to the vFiler unit, you need to set up

CIFS before you can use the vFiler unit. Performing the setup stops and restarts
CIFS, interrupting the CIFS service.
Which storage system or resource pool is the vFiler unit assigned to?
Parent
storage
Be sure that the host on which you want to create a vFiler unit is running Data
system or
ONTAP 7.0 or later.
resource pool
IP address

What is the IP address of the vFiler unit that you want to add?
The IP address used by the vFiler unit must not be configured for use before you
create the vFiler unit.
Note: The IP address accepts both IPv4 and IPv6 address formats.

Network
mask

What is the network mask of the vFiler unit that you want to add?
The network mask is not required to create the vFiler unit, although you must
specify a network mask to set up the vFiler unit.
Note: The network mask accepts both IPv4 and IPv6 address formats. When
using IPv4 format, specify this value using either four-octet notation or the
network mask length (the number of bits, from 1 to 31). When using IPv6
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format, specify the value using the network mask length (the number of bits,
from 1 to 127).
Network
interface

What is the Ethernet interface for the vFiler unit?

VLAN ID

Will you use VLANs in the creation of the vFiler unit? What is the ID of the
VLAN that you will use?

The Ethernet interface is not required to create the vFiler unit, although you must
specify an interface before you can use the vFiler unit. If you plan to run scripts on
the vFiler unit, you might choose to wait to specify the Ethernet interface later, by
using the Setup option.

VLANs allow you to partition a physical network into multiple virtual networks
that are totally separate.
If the vFiler unit that you plan to add is created on a high-availability host, you can
use an existing VLAN ID or create a new VLAN ID for the vFiler unit. If a VLAN
ID is not entered, the partner interface field is disabled.
Partner
interface

What is the partner interface for the vFiler unit?
If you create a vFiler unit using a high-availability host, the partner interface is
selected automatically. If no partner interface is configured, then the option None
is selected automatically.
The storage system on which the vFiler unit is created must be configured as an
HA configuration before the creation of the vFiler unit.

vFiler
template

CIFS
workgroup
name

Which, if any, vFiler template do you want to use for the vFiler unit?
A vFiler template is a set of vFiler configuration settings and the corresponding
CIFS configuration settings. If you do not select a vFiler template, the network
settings are cleared.
What is the Windows workgroup name for the CIFS setup?
The Windows workgroup name specifies the name of the shared resources. The
workgroup name option is displayed if the following conditions apply:
•
•
•

You select to use the CIFS protocol
You select the Perform CIFS setup option
You do not select a vFiler template or the template you select does not include
CIFS settings

If you set up the vFiler unit to use the CIFS protocol, the vFiler units can use the
same computer names as the servers. This enables CIFS clients to share resources
without having to remap their drives or search for the new server.
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CIFS domain What is the login name and the password for administrative access to the Active
Directory system?
user and
domain
The domain user and domain password options are displayed if the following
password
conditions apply:
•
•
•

You select to use the CIFS protocol
You select the Perform CIFS setup option
You select a vFiler template that specifies Active Directory for CIFS
authentication

Root
password

What password will you use for the vFiler unit you are creating?

Script path

Do you want to use a custom script to help manage vFiler units? If so, what is the
full path of the script?
You can use the script while creating or setting up the vFiler unit.
Note: If the DataFabric Manager server is running on Windows, and if the postsetup script for the vFiler unit is on a network share, the script location must be
specified by the full UNC path (no drive letter mapping).

Related concepts

What vFiler templates are on page 391
Considerations for high-availability hosts on page 265
Related information

Data ONTAP MultiStore Management Guide - http://support.netapp.com/NOW/knowledge/docs/
ontap/ontap_index.shtml
Adding a vFiler unit
You can create and configure vFiler units to make them available for inclusion in data management
actions.
Before you begin

•
•
•
•

Ensure that the host on which you want to create a vFiler unit is running Data ONTAP 7.0 or
later.
Ensure that the resource group contains at least one host entry when creating a vFiler unit using a
resource group.
Ensure that the IP address used by the vFiler unit is not configured when you create the vFiler
unit.
Have the following information available for the vFiler unit that you want to create:
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•

• Name
• IP space
• Protocols assigned to the vFiler unit (NFS, CIFS, or iSCSI)
• IP address
• Name of the storage system or resource pool to be associated with the vFiler unit
• Network mask
• Network interface to use
• VLAN ID information (optional in an HA pair)
• Partner interface in an HA pair (disabled if VLAN ID is not provided)
• vFiler template name (optional)
• Windows workgroup name or CIFS domain user and password
• Root password (optional during vFiler creation)
• Script path (optional)
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

You can complete the entire vFiler unit configuration, or you can create an inactive vFiler unit and
complete the protocol or network setup later.
Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Click Add to start the Add vFiler Unit wizard.
3. Enter or select information as requested in the wizard, then click Finish.
You can verify that the vFiler unit you added is included in the hosts list in the vFiler Units
window.
Result

Providing all the information requested by the wizard enables you to protect or provision data that is
associated with the new vFiler unit.
If you did not specify all of this information, you can configure it later by using the Setup vFiler Unit
wizard on the Hosts > vFiler Units window.
Related concepts

Decisions to make before adding a vFiler unit on page 259
Related references

Administrator roles and capabilities on page 54
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Decisions to make before setting up vFiler unit properties
Before starting the Setup vFiler Unit wizard to configure vFiler storage unit properties, it is useful to
have all of the configuration information available for the unit that are you configuring.
Use the vFiler Setup option to add or modify vFiler unit attributes. For example, if you assigned but
did not configure the CIFS protocol when you created the vFiler unit, you can use the Setup vFiler
Unit wizard to perform the CIFS configuration.
Allowed
protocols

Which assigned protocols do you want to add or change on the vFiler unit?
The following protocols are supported:
•
•
•

NFS
CIFS
iSCSI

Fibre Channel is not supported on vFiler units.
Attention: If you assign the CIFS protocol to the vFiler unit, you must set up

CIFS before you can use the vFiler unit. Performing the setup stops and restarts
CIFS, interrupting the CIFS service.
IP address

Which IP address do you want for the vFiler unit?
The IP address accepts both IPv4 and IPv6 address formats.

Network
mask

Which network mask do you want for the vFiler unit?
Note: The network mask accepts both IPv4 and IPv6 address formats. When

using IPv4 format, specify using either four-octet notation or network mask
length (the number of bits, from 1 to 31). When using IPv6 format, specify using
the network mask length (the number of bits, from 1 to 127).
Network
interface

Which Ethernet interface do you want to add or change for the vFiler unit?

VLAN ID

Do you want to specify a VLAN ID?

The Ethernet interface is not required to create the vFiler unit, although you must
specify an interface before you can use the vFiler unit. If you plan to run scripts on
the vFiler unit, you might choose to wait to specify the Ethernet interface later, by
using the Setup option.

VLANs allow you to partition a physical network into multiple separate virtual
networks.
If the vFiler unit that you plan to add is created on a high-availability host, you can
use an existing VLAN ID or create a new VLAN ID for the vFiler unit.
Partner
interface

Which partner interface do you want?
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If you are using a high availability host in the setup of the vFiler unit, the partner
interface is selected automatically. If no partner interface is configured, then the
Partner interface column is not visible.
The storage system on which the vFiler unit is created must be configured as an
HA configuration before setting up the vFiler unit.
vFiler
template

Which vFiler template do you want?
You must reselect a vFiler template during setup. A vFiler template is a set of
vFiler configuration settings and the corresponding CIFS configuration settings.
Attention: The Setup vFiler Unit wizard does not remember the vFiler template

used during the vFiler unit creation. If you do not select the vFiler template you
originally used, the network settings are cleared.
CIFS
workgroup
name

What Windows workgroup name do you want for the CIFS setup?
The Windows workgroup name specifies the name of the shared resources. The
workgroup name option is displayed if the following apply:
•
•
•

You select the CIFS protocol.
You select the Perform CIFS setup option.
You do not select a vFiler template, or the template you select does not include
CIFS settings.

If you set up the vFiler unit to use the CIFS protocol, the vFiler units can use the
same computer names as the servers. This enables CIFS clients to share resources
without having to remap their drives or search for the new server.
CIFS domain What CIFS domain user ID and password do you want?
user and
You can enter a login name and password for administrative access to the Active
domain
Directory system. The Domain User and Domain Password options are displayed if
password
the following apply:
•
•
•
Root
password

Script path

You select the CIFS protocol.
You select the Perform CIFS setup option.
You select a vFiler template that specifies Active Directory for CIFS
authentication.

Which vFiler unit root password do you want?
If you did not choose a root password when you created the vFiler unit, you must
choose one before you can use the vFiler unit.
Do you want to use a custom script to help manage vFiler units? If so, what is the
full path of the script?
You can use the script while creating or setting up the vFiler unit.
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Note: If the DataFabric Manager server is running on Windows, and if the post-

setup script for the vFiler unit is on a network share, the script location must be
specified by the full UNC path (no drive letter mapping).
Considerations for high-availability hosts
When you use a high-availability host in the creation or setup of a vFiler unit, you must also
configure storage and a VLAN interface and be aware of other changes that result from the creation
or startup.
•
•
•

•

If you use a high-availability host in creating your vFiler unit, you must configure the storage
systems before creating the vFiler unit.
To ensure appropriate failover behavior, you must configure new IP space and VLAN interface
when creating the vFiler unit.
If you are creating a vFiler unit using nondefault IP space, the NetApp Management Console
provisioning capability moves the partner interface to the nondefault IP space of the primary
vFiler unit.
If you are creating a VLAN as part of the vFiler unit creation or setup, a corresponding VLAN is
set up on the partner interface.

Setting up vFiler unit properties
After you create a vFiler unit, you can configure the CIFS protocol, if you assigned one, or edit the
vFiler unit attributes by using the Setup vFiler Unit wizard.
Before you begin

Have the following information available for the vFiler unit that you want to configure:
•
•
•
•
•
•
•
•
•
•

Allowed protocols
IP address
Network mask
Network interface
VLAN ID information (optional in an HA configuration)
Partner interface to use in an HA configuration
vFiler template name
Root password
CIFS Windows Workgroup Name or Active Directory Domain User and Domain Password
Script path (optional)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > vFiler Units.
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2. Select a vFiler unit from the list and click Setup to open the Setup vFiler Unit wizard.
You can view the current configuration information of the vFiler to ensure that you do not
override any information you do not want to change.
3. Modify the vFiler attributes that you want to change.
If you assigned the CIFS protocol to the vFiler unit, select the Perform CIFS setup check box to
complete the CIFS domain authentication, then enter the appropriate information.
4. Click Finish.
You can see your changes in the details section of the vFiler Units window.
Related concepts

Decisions to make before setting up vFiler unit properties on page 263
Considerations for high-availability hosts on page 265
Migration operations on page 551
Dataset storage space management on page 81
Related references

Administrator roles and capabilities on page 54
Editing storage system properties
You can change the login or NDMP credentials of storage systems and you can add licenses to
storage systems that are managed by NetApp Management Console. The storage system properties
sheet is particularly useful for modifying the credentials for multiple systems at one time.
Before you begin

If you do not have the proper privileges, you cannot select the credentials or licenses in the storage
system property sheet.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > Storage Systems.
2. Select a host name from the host list.
If you have hosts that use the same user name and password, you can select multiple hosts to
configure the same credentials on all the selected hosts. License information can only be edited
on one host at a time.
3. Click Edit to open the properties sheet for the selected host.
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You can edit the login credentials and the NDMP credentials for the selected host or add licenses
to the host.
4. Verify that the changes you made to the storage system have been implemented.
You can view the properties information provided in the Storage Systems Hosts window.
Result

The host credentials are updated in the DataFabric Manager database. It might take several minutes
for the updated status to be reflected in the Login Credentials field for each selected host.
Related references

Administrator roles and capabilities on page 54
Editing Open Systems SnapVault properties
You can change the NetApp Host Agent password or the NDMP credentials for the Open Systems
SnapVault hosts that are managed by NetApp Management Console.
Before you begin

If you are editing an Open Systems SnapVault host that resides on a VMware ESX 3.5 server, see the
guidelines for editing an Open Systems SnapVault host on a VMware ESX 3.5 server.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select an Open Systems SnapVault host name from the host list.
If you have hosts that use the same user name and password, you can select multiple hosts to
configure the same credentials on all the selected hosts.
3. Click Edit to open the properties sheet for the selected host.
Note: The default NetApp Host Agent user name is "admin", which cannot be changed.

4. Verify that the changes you made to the host have been implemented.
You can view the properties information provided under Hosts > OSSV.
Result

The NDMP credentials for the selected host are updated in the DataFabric Manager database. It
might take several minutes for the updated status to be reflected in the NDMP Credentials field for
the selected host.
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Related references

Guidelines for adding and editing an Open Systems SnapVault host on an ESX server on page 257
Administrator roles and capabilities on page 54
Deleting a storage system
You can use the Storage Systems Hosts window to delete selected storage systems.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > Storage Systems.
2. Select the storage system that you want to delete and click Delete.
The Delete Storage System dialog box opens, requesting that you confirm the deletion.
Note: When you delete a storage system, the physical resources that compose the storage
system are not deleted.

3. Click Yes to confirm the delete request or No to cancel the request and close the dialog box.
Result

NetApp Management Console removes the storage system from the list in the Storage Systems Hosts
window.
Deleting an Open System SnapVault host
You can use the OSSV Hosts window to delete selected OSSV hosts.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select the OSSV host that you want to delete and click Delete.
The Delete OSSV dialog box opens, requesting that you confirm the deletion.
Note: When you delete an OSSV host, the physical resources that compose the OSSV host are

not deleted.
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3. Click Yes to confirm the delete request or No to cancel the request and close the dialog box.
Result

NetApp Management Console removes the OSSV host from the list in the OSSV Hosts window.
Deleting a vFiler unit
You can use the vFiler Units window to delete selected vFiler units.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Select the vFiler unit that you want to delete, click Delete, and select the Delete option from the
drop-down list.
The Delete vFiler Unit dialog box opens, requesting that you confirm the deletion.
3. Click Yes to confirm the delete request or No to cancel the request and close the dialog box.
Result

NetApp Management Console removes the vFiler unit from the list in the vFiler Units window.
Destroying and deleting a vFiler unit
You can use the vFiler Units window to destroy selected vFiler units from the DataFabric Manager
database and delete them.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Select the vFiler unit that you want to destroy and delete, click Delete, and select the Destroy
and Delete option from the drop-down list.
The Destroy and Delete vFiler Unit dialog box opens, requesting that you confirm the deletion.
3. Click Yes to confirm the delete request or No to cancel the request and close the dialog box.
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Result

NetApp Management Console destroys the vFiler unit from the DataFabric Manager database, and
removes the vFiler unit from the list in the vFiler Units window.

Managing hosts
You can start and stop host agents, refresh client data, and verify and change host configurations.
Stopping Open Systems SnapVault agents
You can stop the Open Systems SnapVault agent to perform maintenance on one or more selected
clients or to reconfigure Open Systems SnapVault. When troubleshooting protection errors on a
client running Open Systems SnapVault, stopping and then restarting the Open Systems SnapVault
agent might solve the problem.
Before you begin

The client must be running the Open Systems SnapVault 2.3 or later agent and NetApp Host Agent
2.3.1 or later.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

There is no Open Systems SnapVault plug-in for Solaris. Therefore, management tasks such as start
and stop of the Open Systems SnapVault agent cannot be performed from NetApp Management
Console on Solaris systems.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select one or more Open Systems SnapVault clients.
3. Click Stop.
Note: Stopping the Open Systems SnapVault agent on a client causes the backup service on
that client to stop. Be sure to restart the agent if you want to resume backup protection.

Starting Open Systems SnapVault agents
When you are troubleshooting protection errors on a client running Open Systems SnapVault,
stopping and then restarting the Open Systems SnapVault agent might solve the problem.
Before you begin

The client must be running the Open Systems SnapVault 2.3 or later agent and NetApp Host Agent
2.3.1 or later.
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You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

There is no Open Systems SnapVault plug-in for Solaris. Therefore, management tasks such as start
and stop of the Open Systems SnapVault agent cannot be performed from NetApp Management
Console on Solaris systems.
If you stop Open Systems SnapVault services to troubleshoot a problem or to perform maintenance,
be sure to restart the Open Systems SnapVault agent when you are ready to resume services.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select one or more Open Systems SnapVault clients.
3. Click Start.
Result

The Open Systems SnapVault agent starts on each selected client, and backup service starts or
resumes on each client according to its schedule.
Refreshing Open Systems SnapVault client data
Data shown in the list of Open Systems SnapVault clients is gathered at regular intervals. If you are
trying to troubleshoot a problem with an Open Systems SnapVault client, you can refresh the data for
that client as needed to view the most current status.
Before you begin

The client must be running the Open Systems SnapVault 2.3 or later agent and NetApp Host Agent
2.3.1 or later.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select one or more Open Systems SnapVault clients.
3. Click Refresh.
Related references

Administrator roles and capabilities on page 54
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Diagnosing a storage system
You can use the Diagnose Storage Systems wizard to verify the configuration for your storage
system. You can also make necessary changes to some of the storage system properties and enable
SnapMirror and SnapVault licenses from the diagnostics wizard.
Before you begin

When running the diagnostics wizard, it can be useful to have the following information available to
verify for the storage system that you want to diagnose:
•
•
•
•
•
•
•
•

Host Name
Domain Name
IP Address
Licenses that should be enabled for the storage system
SnapMirror Access Control List for the storage system, if licensed for SnapMirror
SnapVault Access Control List for the storage system, if licensed for SnapVault
Login Credentials (user name and password)
NDMP Credentials (user name and password)
Note: The credentials of a vFiler unit always have a status of Not Applicable. This status for a

vFiler unit does not indicate a problem.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > Storage Systems.
2. Click Diagnose to start the wizard, then verify or modify information as requested in the wizard.
The diagnostics wizard checks the configuration of hosts.
3. Verify that any changes that you made to your host configuration are displayed in the storage
systems list in the Storage Systems Hosts window.
Result

If configuration changes are made to a host from an interface other than NetApp Management
Console, you might need to use the Refresh button to pull those changes into the host list for viewing
in the console.
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Diagnosing an Open Systems SnapVault host
You can use the Diagnose OSSV Host wizard to verify your Open Systems SnapVault configuration
and to make necessary changes to some Open Systems SnapVault properties.
Before you begin

When running the diagnostics wizard, it can be useful to have the following information available to
verify for the Open Systems SnapVault host that you want to diagnose:
•
•
•
•
•
•

Host name
Domain name
IP address
NetApp Host Agent port number
Operating system credentials for the host on which NetApp Host Agent is running, if you would
like to use the DataFabric Manager server to update and manage the credentials for you
NDMP credentials (user name, password, and port number)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

When diagnosing issues on Solaris systems, note that there is no Open Systems SnapVault plug-in
for Solaris, so the NetApp Host Agent cannot communicate with the Open Systems SnapVault agent.
Therefore, Host Agent Status displays as Not Detected and management tasks such as start and stop
of the Open Systems SnapVault agent cannot be performed from NetApp Management Console.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Click Diagnose to start the wizard.
Verify or modify information as requested in the wizard.
3. Verify that any changes you made are displayed in the hosts list in the OSSV Hosts window.
You might need to refresh the window before you can view the changes in the hosts list.
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Dashboards > Protection
The protection dashboard panels provide cumulative at-a-glance status information for datasets,
resource pools, and external relationships. Further detail can be viewed on the Help page accessible
from each dashboard panel.
The following dashboard panels can be viewed by administrators who have been assigned the
appropriate privileges:
Failover
Readiness

Indicates the status of datasets regarding their availability for failover, should
failover action be required.

Failover Status

This panel is visible if a dataset has failed over.
Provides feedback on active or completed failover operations.

Top Five Events Displays the five most severe events from the Events window, ordered by time.
Dataset
Protection
Status

Displays the total number of datasets, grouped according to their current
protection status.

Protected Data

Displays the total number of objects that are protected and managed by the
NetApp Management Console data protection capability. Objects included in
this panel are datasets that have an assigned protection policy and have a
relationship created (the dataset has conformed to the protection policy at least
once), and volumes, qtrees, and Open Systems SnapVault (OSSV) directories
that are in a SnapVault or SnapMirror relationship which is managed by the
NetApp Management Console data protection capability, and are not in an
external relationship.
Note: Because the NetApp Management Console data protection capability
does not tally offline volumes and qtrees, it displays a different volume count
and qtree count from the volume and qtree counts displayed by Operations
Manager.

Unprotected
Data

Displays the total number of datasets, volumes, and qtrees that are not protected.
Datasets are unprotected if they do not have an assigned protection policy or if
they have an assigned protection policy but do not have a relationship created
(the dataset has never conformed to the protection policy). Volumes and qtrees
are unprotected if they are not in a SnapVault or SnapMirror relationship which
is managed by the NetApp Management Console data protection capability, and
are not in an external relationship.
Note: Because the NetApp Management Console data protection capability
does not tally offline volumes and qtrees, it displays a different volume count
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and qtree count from the volume and qtree counts displayed by Operations
Manager.
Dataset Lags

Displays the top five datasets with the longest lags. A dataset lag occurs when a
protection component is out of date with the primary data. This panel groups
relationships according to dataset, sorts relationships according to lag, selects
the longest lag for each dataset, and displays the datasets in decreasing order of
lag.

External
Relationship
Lags

Displays the top five external SnapVault or SnapMirror relationships with the
longest lags. These relationships are not managed by the NetApp Management
Console data protection capability.

Click
on the title bar of each dashboard panel to replace the work area with another window that
is related to the content of the panel.
Click
on a row of a dashboard panel to replace the work area with a window that is related to the
content of the panel, with information highlighted that is relevant to that specific row in the panel.
You can filter the content of the dashboard panels, to focus on specific groups of datasets or resource
pools by using the Group list on the console tool bar.
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Dashboards > Protection > Failover Readiness
You can use the Failover Readiness panel to view the readiness of datasets configured for disaster
recovery protection to successfully carry out failover operations should failover operations become
necessary. The panel lists the number of datasets whose failover support configurations are in ready
state, warning state, and error state.
Status Descriptions
Note: If a status value is zero, the status item does not display in the dashboard panel.

Failover
Readiness

•

•

•

Status: Normal.
Indicates that conditions in all datasets that are configured for disaster recovery
protection will support successful failover operations if such operations become
necessary. Nothing has changed in the configuration since the dataset was
configured for disaster recovery.
Status: Warning
Indicates that conditions have changed in one or more datasets that are
configured for disaster recovery protection so that failover operations might not
be completely successful, if such operations become necessary. The datasets
producing the warnings should be investigated and brought back into the
Normal state.
Status: Error
Indicates that conditions have significantly changed in one or more datasets that
have been configured for disaster recovery protection so that it is likely that
failover operations will not be completely successful, if such operations become
necessary, and data could be lost. The datasets producing the warnings should
be investigated and brought back into the Normal state.

Ready

Total number of datasets that have been configured for disaster recovery protection
whose conditions will support successful failover operations, if such operations
become necessary.

Ready Warnings

Total number of datasets that have been configured for disaster recovery protection
whose conditions might not support completely successful failover operations, if
such operations become necessary.

Error Warnings

Total number of datasets that have been configured for disaster recovery protection
to which significant changes have occurred to the configurations. Failover
operations can still occur but might not be completely successful, if such operations
become necessary.

Total
Datasets

The total datasets that have been configured for disaster recovery protection.
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Click
beside the dashboard panel title to replace the work area with the Disaster Recovery tab on
the Datasets window.
You can filter the content of the dashboard panels, to focus on specific groups of datasets or resource
pools, by using the Group selection list on the console tool bar.
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Dashboards > Protection > Failover Status
You can use the Failover Status panel to view the status of an in-progress failover operation. The
panel appears when a failover operation is invoked, listing the number of datasets in the process of
failing over and the number of datasets that have successfully failed over.
Status Descriptions
Note: If a status value is zero, the status item does not display in the dashboard panel.

Failover
Status

•

•

•

Status: Normal
Indicates that failover operations are either successfully completed or are
proceeding as expected in all datasets that have been configured for disaster
recovery protection.
Status: Warning
Indicates that failover operations have completed with a warning condition in
one or more of the datasets that have been configured for disaster recovery
protection.
Status: Error
Indicates that failover operations have completed with an error condition in
one or more of the datasets that have been configured for disaster recovery
protection.

Failing over

Total number of datasets that has been configured for disaster recovery protection
that are currently undergoing failover operations.

Failed over

Total number of datasets that has been configured for disaster recovery protection
that has successfully completed failover operations.

Failed over Warnings

Total number of datasets that have been configured for disaster recovery
protection that have completed failover operations with warning conditions.
Warnings can be encountered during the failover operation or warnings that exists
in the ready state, as shown in the Failover Readiness panel, can be propagated to
the Failed Over state.

Failed over Errors

Total number of datasets that have been configured for disaster recovery
protection that have completed failover operations with error conditions. Errors
can be encountered during the failover operation or errors that exists in the ready
state, as shown in the Failover Readiness panel, can be propagated to the Failed
Over state.

Total Datasets The total datasets that are issuing failover status events.
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Click
beside the dashboard panel title to replace the work area with the Disaster Recovery tab on
the Datasets window.
You can filter the content of the dashboard panels, to focus on specific groups of datasets or resource
pools, by using the Group selection list on the console tool bar.
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Dashboards > Protection > Dataset Protection
Status
You can use the Dataset Protection Status panel to view the overall status of each dataset protection
policy. The panel lists the number of datasets to which each protection status value currently applies.
Status Descriptions
The dashboard panel lists the status entries from most to least severe.
Lag Error

Status: Error (the status is displayed in red)
Total number of datasets for which the protection lag has exceeded the
configured threshold

Baseline Failed

Status: Error (the status is displayed in red)
Total number of datasets for which there is no initial baseline data transfer that
registered a backup version

Job Failure

Status: Warning (the status is displayed in amber)
Total number of datasets for which the most recent protection job did not
succeed

Lag Warning

Status: Warning (the status is displayed in amber)
Total number of datasets that have reached or exceeded the lag error threshold
specified in the assigned protection policy

Protection
Suspended

Status: Normal, paused
Total number of datasets for which an administrator has requested that
scheduled backups be put on hold until the administrator requests that they be
resumed

Uninitialized

Status: Normal
Total number of datasets that meet any of the following criteria:
•
•
•
•
•
•

Protected

The dataset has a protection policy that does not have any protection
operations scheduled.
The dataset does not contain any data to be protected.
The dataset does not contain storage for one or more destination nodes.
The single node dataset does not have any backup versions.
The application dataset does not have at least one backup version associated
with it.
The dataset does not contain any backup or mirror relationships.

Status: Normal
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Total number of datasets being protected according to their assigned policies
Click

beside the dashboard panel title to replace the work area with the Datasets window.

You can filter the content of the dashboard panels, to focus on specific groups of datasets or resource
pools, by using the Group selection list on the console tool bar.
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Dashboards > Protection > Dataset Lags
You can use the Dataset Lags panel to identify datasets that have a protection component that is out
of date with respect to the primary data. The panel displays relationships grouped according to their
dataset, sorts relationships according to each relationship's lag, selects the longest lag for each
dataset, and displays the datasets in decreasing order of lag time.
Click
beside the dashboard panel title to replace the work area with the Datasets window. You
can filter the content of the dashboard panels, to focus on specific groups of datasets or resource
pools, by using the Group selection list on the console tool bar.

283

Dashboards > Protection > Protected Data
You can use the Protected Data panel to view the number of objects that are protected and managed
by the NetApp Management Console data protection capability.
The types of data resources displayed in this dashboard panel include the following:
•

•

Datasets
The displayed total includes only datasets that have a protection policy assigned and a
relationship created (datasets that have conformed to their protection policy at least once). This
also includes datasets that are assigned either the "No protection" or "Local Snapshot copies
only" protection policy, and empty datasets (datasets with no data) if they have a protection
policy assigned.
Volumes, qtrees, OSSV directories (Open Systems SnapVault directories)
The displayed totals include only objects that are in a SnapVault or SnapMirror relationship
which is managed by the NetApp Management Console data protection capability, and are not in
an external relationship.
Volumes or qtrees are not included in this window if they have been added to a protected dataset
but no SnapVault or SnapMirror relationship has been created yet.

Click

beside the dashboard panel title to replace the work area with the Datasets window.

You can filter the content of the dashboard panels to focus on specific groups of datasets or resource
pools by using the Group list on the console tool bar.
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Dashboards > Protection > Unprotected Data
You can use the Unprotected Data panel to identify the number of data resources in the NetApp
Management Console data protection capability that are not protected.
The types of data resources displayed in this dashboard panel include the following:
•

•

Datasets
The displayed total includes datasets that do not have a protection policy assigned and datasets
that have a protection policy assigned but no relationship created (datasets that have not
conformed to their protection policy at least once).
Volumes and qtrees
The displayed totals include volumes and qtrees that are not in a SnapVault or SnapMirror
relationship which is managed by the NetApp Management Console data protection capability,
and are not in an external relationship. This also includes volumes and qtrees that have been
added to a protected dataset but no SnapVault or SnapMirror relationship has been created yet.

Click
beside the dashboard panel title to replace the work area with the Unprotected Data
window.
You can filter the content of the dashboard panels to focus on specific groups of datasets or resource
pools by using the Group list on the console tool bar.

285

Dashboards > Protection > External Relationship
Lags
You can use the External Relationship Lags panel to identify the five external relationships that have
the longest lags.
External relationships are not managed by the NetApp Management Console data protection
capability. They are SnapVault or SnapMirror relationships that are discovered by Operations
Manager and listed separately by the NetApp Management Console data protection capability. This
panel displays the state of each external relationship, in decreasing length of lag time.
Click
beside the dashboard panel title to replace the work area with the External Relationships
window.
You can filter the content of the dashboard panels to focus on specific groups of datasets or resource
pools by using the Group list on the console tool bar.
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Dashboards > Top Five Events
You can use the Top Five Events panel to view the five most severe events listed in the Events
window and the source to which each event applies. The columns are ordered first by severity, then
by time of the events.
Click
beside the dashboard panel title to replace the work area with the Events window.
Descriptions of the events are provided in the online Help page for that window.
Click
on a row of the Top Five Events panel to replace the work area with the Events window,
with information highlighted that is relevant to the selected row in the dashboard panel.
You can filter the content of some of the dashboard panels by using the Group selection list on the
console tool bar. This option allows you to focus on information about a particular group, such as
specific datasets or resource pools.

287

Dashboards > Resource Pools
You can use the Dashboards > Resource Pools to view the total space allocated to and the
percentage of space utilized by each resource pool, listed by resource pool name.
Total Size values are indicated in numbers, such as gigabytes or terabytes. Utilization is given in
percentages of the total allocated space per resource pool. Items are sorted in decreasing order of
available space.
Click

beside the dashboard panel title to replace the work area with the Resource Pools window.

on a row of a dashboard panel to replace the work area with the Resource Pools window,
Click
with information highlighted that is relevant to the selected row in the dashboard panel.
You can filter the content of some of the dashboard panels by using the Group selection list on the
console tool bar. This option allows you to focus on information about a particular group, such as
specific datasets or resource pools. When you select a group filter, only relationships originating or
terminating at an object in the selected group are listed.
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Data > Datasets > Overview
The Datasets window Overview tab provides a single location from which you can view a list of
datasets and their properties, and perform various actions on datasets.
From the Overview tab, you can monitor the status of all datasets, create and modify datasets, assign
physical resources manually or by using provisioning policies. You can back up a dataset's content
on demand, suspend or resume protection for it, and initiate restore operations to access backed-up
data from this page. You can also assign storage services that supply a dataset with a preconfigured
protection policy, provisioning policies, resource pools, and an optional vFiler template.
•
•
•
•
•

Command buttons on page 288
Datasets list on page 290
Graph area on page 294
Details area on page 294
Window customization on page 299

Command buttons
Add

•
•

Edit

If you select the Add sub-option, starts the Add Dataset wizard for adding a
dataset.
If you select the Using a storage service sub-option, starts the Add Dataset
Using Storage Service wizard for adding a dataset with a selected storage service
already attached.

Opens the Edit Dataset window, from which you can modify general properties of a
dataset, physical resources of a dataset, or how storage is provisioned on a dataset.
This button is not enabled for datasets of virtual objects.

Delete

Deletes the selected dataset and thereby removes the relationships among the storage
resources.

Protection
Policy

Starts the Dataset Policy Change wizard, from which you can select a protection
policy and destination storage to associate with your dataset.
This button is not enabled for datasets of virtual objects.

Storage
Service

•

If you select the Attach sub-option, the Attach Storage Service wizard enables
you to assign a storage service with a preconfigured protection policy,
provisioning policies, resource pools, and an optional vFiler unit template
configuration to the selected datasets and their nodes.
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•

If you select the Change sub-option, the Change Storage Service wizard enables
you to replace the current storage service on the selected datasets with an
alternative storage service.
Note: Attaching a storage service or changing the attached service to a dataset
prevents you from modifying that dataset's individual protection policy,
provisioning policies, resource pools, and optional vFiler unit configuration
without modifying the assigned storage service itself.

•

If you select Detach Storage Service, the Detach Storage Service wizard enables
you to detach a storage service from the selected datasets.
This button is not enabled for datasets of virtual objects.
Note: Detaching a storage service from a dataset does not alter that dataset's

current protection policy, provisioning policies, resource pools, and optional
vFiler unit configurations; however, with the storage service detached you can
change each of those elements directly.
Protect Now Opens the Protect Now dialog box, from which you can perform on-demand backup
or mirror protection operations on datasets that are protection policy-enabled for
those types of operations. This button is disabled for datasets that do not have a
protection policy assigned.
This button is not enabled for datasets of virtual objects.
If you click the box "Notify me on job progress," you receive desktop alerts about
this job's status after starting the Protect Now process.
Note: With application datasets, clicking Protect Now copies all new backups
that have not been copied to the secondary backup node. Protect Now does not
create new local backups on the primary nodes of application datasets.

Suspend

Suspends dataset protection or provisioning for one or more datasets.
During the time that NetApp Management Console suspends protection, it displays a
Protection Suspended status for the dataset.
This button is enabled only if a protection or provisioning policy is assigned to the
dataset.
Note: When you click the Suspend button to stop the protection for an application
dataset, a note is displayed, reminding you that local backups that are being
created by another application cannot be suspended.

This button is not enabled for datasets of virtual objects.
Resume

Resumes dataset backup protection or provisioning for one or more datasets.

Restore

Starts the Restore wizard for restoring backed-up copies of data.
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This button is not enabled for datasets of virtual objects.
Datasets list
Lists information about existing datasets. You can click a row in the list to view information in the
Details area about the selected dataset.
Name

The name of the dataset.

Dataset Type

Whether the dataset contains physical storage objects or virtual objects.
Physical A dataset type that can contain only physical storage objects
(aggregates, volumes, qtrees) as members. A dataset's type is
physical if one or both of the following conditions apply:
•
•

The dataset already contains a physical storage object as a
member.
A protection policy, resource pool, or provisioning policy is
directly attached.

Datasets of storage objects are configured and managed directly in
the NetApp Management Console.
Virtual

A dataset type that can contain only virtual objects (VMware
datastores, or VMware virtual machines) as members. A dataset's
type is virtual if one or both of the following conditions apply:
•
•

The dataset already contains a virtual object as a member.
A local policy is attached.

Datasets of virtual objects are configured and managed in the
OnCommand Unified Manager. The NetApp Management Console
edit, protect now, storage service detach, protection policy
configuration, and restore functions are disabled for datasets of
virtual objects.
Undefined

A dataset type that can contain either storage objects or virtual objects. A
dataset's type is undefined if both of the following conditions apply:
•

•

The dataset still contains no object of any type as a member. Adding one
object of either physical or virtual type as a member to an undefined dataset
defines the dataset as that same type and excludes assignment of any object
of the opposite type to that dataset.
No local policy, protection policy, resource pool, or provisioning policy is
directly attached.
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Overall Status

The status determined by evaluating the combined status conditions for disaster
recovery, protection, conformance, space, and resources. This item is not
included in the dataset list by default.
Overall status is computed based upon the following status values:
Overall
Status: Error

DR status condition: Error
Protection status condition: Lag error or Baseline failed
Conformance status condition: Nonconformant
Space status condition: Error
Resource status condition: Emergency, Critical, or Error

Overall
Status:
Warning

DR status condition: Warning
Protection status condition: Job failure, Lag warning,
Uninitialized, or No protection policy for a non-empty
dataset
Conformance status condition: NA
Space status condition: Warning
Resource status condition: Warning

Protection
Policy

The name of the protection policy currently assigned to the dataset.

Primary
Provisioning
Policy

The name of the provisioning policy currently assigned to the primary node of
the dataset. If a provisioning policy is assigned to a secondary node in the
dataset, that name is displayed in the details area when you select the secondary
node in the graph area.

Failed Over

Indicates whether a disaster recovery-capable dataset has failed over. This item is
not included in the dataset list by default. Valid values are the following:
Yes

Failover on the dataset was invoked and completed
successfully, completed with warnings, or completed with
errors.

No

Failover on the dataset has not been invoked.

In Progress

Failover on the dataset is currently in progress.

Not Applicable The dataset is not assigned a disaster recovery protection
policy and, therefore, is not capable of failover.
Storage Service Lists what storage service, if any, is attached to the dataset. A dataset that is
attached to a storage service uses the protection policy, provisioning policies,
resource pools, and vFiler unit configurations specified by that storage service.
This item is not included in the dataset list by default.
Description

A description of the dataset. This column is not shown by default.
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Protection
Status

Displays protection status. Information about a warning or error status can be
accessed from the Details Area of the window.
Valid status values, in alphabetical order, are as follows:
Baseline Failed There are no initial baseline data transfers that registered a
backup version.
Initializing

The dataset is conforming to the protection policy and the
initial baseline data transfer is in process.

Job Failure

The most recent protection job did not succeed.
This status might result for any of the following reasons:
•
•
•
•

Lag Error

A backup from a SnapVault or Qtree SnapMirror
relationship failed or could not be registered.
A mirror copy from a SnapMirror relationship failed or
could not be registered.
Local backups (Snapshot copies) failed on the primary
node.
The dataset does not have any backup versions.

The dataset has reached or exceeded the lag error threshold
specified in the assigned protection policy. This value
indicates that there has been no successful backup or mirror
copy of a node's data within a specified period of time.
This status might result for any of the following reasons:
•
•

•

Lag Warning

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror)
is older than the lag threshold setting or no backup jobs
have completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than
the lag threshold setting or no mirror jobs have completed
since the dataset was created.

The dataset has reached or exceeded the lag warning
threshold specified in the assigned protection policy. This
value indicates that there has been no successful backup or
mirror copy of a node's data within a specified period of
time.
This status might result for any of the following reasons:
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•
•

•

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror)
is older than the lag threshold setting or no backup jobs
have completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than
the lag threshold setting or no mirror jobs have completed
since the dataset was created.

No Local
Policy
Attached

No local policy is attached to a dataset of virtual objects.
This status does not apply to datasets of physical storage
objects.

No Protection
Policy

The dataset is managed by NetApp Management Console,
but no protection policy has been assigned to the dataset.

Protected

The dataset has an assigned policy and it has conformed to
that policy at least once.

Protection
Suspended

An administrator has requested that scheduled backups be
put on hold until the administrator requests that they be
resumed.

Uninitialized

This status might result for any of the following reasons:
•
•
•
•
•
•

The dataset has a protection policy that does not have any
protection operations scheduled.
The dataset does not contain any data to be protected.
The dataset does not contain storage for one or more
destination nodes.
The single node dataset does not have any backup
versions.
At least one backup version must be associated with the
application dataset.
The dataset does not contain any backup or mirror
relationships.

Space Status

Displays the status of the available space for the selected dataset node (OK,
Warning, Error, or Unknown).

Conformance
Status

For the NetApp Management Console data protection capability, indicates
whether the dataset is Conformant, Nonconformant, or In Progress.

Resource
Status

The most severe of all current events on all direct and indirect members of the
dataset nodes. Values can be Emergency, Critical, Error, Warning, or Normal.
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Application

The name of the application that created the application dataset, such as
SnapManager for Oracle. This item is not included in the dataset list by default.

Application
Version

The version of the application that created the application dataset. This item is
not included in the dataset list by default.

Application
Server

The name of the server that runs the application that created the application
dataset. This item is not included in the dataset list by default.

Graph area
The graphical representation of the nodes for the selected dataset are displayed in the lower section
of the page. Click the node or connection on which you want to view status and configuration details.
Details area
The details of the selected dataset node are displayed next to the graph area. Clicking a node or
connection in the graph area displays information about that item in the Details area.
Primary data If you select the Primary data node or the DR data node in the Graph area, the
details area displays status and configuration information about the selected node.
or Disaster
recovery data
You can click
to view member details, status details, or resource details about
node details
the node.
Valid values are as follows:
Protection

Displays protection status. This item is shown only if the
NetApp Management Console data protection capability is
installed. You can click
next to the status value to view
status details and a list of any jobs that are associated with the
status.
Baseline
Failed

There are no initial baseline data transfers
that registered a backup version.

Initializing

The dataset is conforming to the protection
policy and the initial baseline data transfer is
in process.

Job Failure

The most recent protection job did not
succeed.
This status might result for any of the
following reasons:
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•

•

•
•
Lag Error

A backup from a SnapVault or Qtree
SnapMirror relationship failed or could
not be registered.
A mirror copy from a SnapMirror
relationship failed or could not be
registered.
Local backups (Snapshot copies) failed
on the primary node.
The dataset does not have any backup
versions.

The dataset has reached or exceeded the lag
error threshold specified in the assigned
protection policy. This value indicates that
there has been no successful backup or
mirror copy of a node's data within a
specified period of time.
This status might result for any of the
following reasons:
•

•

•

Lag Warning

The most recent local backup (Snapshot
copy) on the primary node is older than
the threshold setting permits.
The most recent backup (SnapVault or
Qtree SnapMirror) is older than the lag
threshold setting or no backup jobs have
completed since the dataset was created.
The most recent mirror (SnapMirror)
copy is older than the lag threshold
setting or no mirror jobs have completed
since the dataset was created.

The dataset has reached or exceeded the lag
warning threshold specified in the assigned
protection policy. This value indicates that
there has been no successful backup or
mirror copy of a node's data within a
specified period of time.
This status might result for any of the
following reasons:
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•

•

•

The most recent local backup (Snapshot
copy) on the primary node is older than
the threshold setting permits.
The most recent backup (SnapVault or
Qtree SnapMirror) is older than the lag
threshold setting or no backup jobs have
completed since the dataset was created.
The most recent mirror (SnapMirror)
copy is older than the lag threshold
setting or no mirror jobs have completed
since the dataset was created.

No Local
Policy
Attached

No local policy is attached to a dataset of
virtual objects. This status does not apply to
datasets of physical storage objects.

No Protection
Policy

The dataset is managed by NetApp
Management Console, but no protection
policy has been assigned to the dataset.

Protected

The dataset has an assigned policy and it has
conformed to that policy at least once.

Protection
Suspended

An administrator has requested that
scheduled backups be put on hold until the
administrator requests that they be resumed.

Uninitialized

This status might result for any of the
following reasons:
•

•
•
•
•
•

The dataset has a protection policy that
does not have any protection operations
scheduled.
The dataset does not contain any data to
be protected.
The dataset does not contain storage for
one or more destination nodes.
The single node dataset does not have
any backup versions.
At least one backup version must be
associated with the application dataset.
The dataset does not contain any backup
or mirror relationships.
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Conformance

For the NetApp Management Console data protection
capability, indicates whether the dataset is conformant. If a
dataset is nonconformant, you can click
to evaluate errors
and warnings and to run the conformance checker.

Resource

For the NetApp Management Console data protection
capability, represents the most severe of all current events on all
direct and indirect members of the dataset nodes. Values can be
Emergency, Critical, Error, Warning, or Normal. For
Emergency, Critical, Error, or Warning conditions, you can
click
to evaluate the events and sources causing those
conditions.

Space

For the NetApp Management Console provisioning capability,
displays the status of the available space for the selected dataset
node (OK, Warning, Error, or Unknown). If any volume, qtree,
or LUN of a dataset has space allocation error or warning
conditions, the dataset's space status indicates that condition.
You can select the dataset to scan its volumes, LUNs, or qtrees
to determine which member is the cause of the warning or error
condition.

Failover

Uses color, icons, and text to display the state and status of a
dataset that is capable of disaster recovery. The colors and text
vary according to the status of the activity. The state of a
dataset can be Ready, Failing Over, or Failed Over. The status
of an activity can be Normal, Warning, or Error.

Physical
resources

Displays the physical resources assigned to the selected dataset

Resource
pools

node. You can click

to view details.

Displays the name of the resource pool. You can click
view details.

to

Exports

Displays information about the export settings applied to the
selected dataset.

Local backup
schedule

Displays the name of the local backup schedule assigned to the
protection policy of the selected dataset node.

Backup
versions

Lists local backups for a given dataset to help you select the
files or directories to restore, or, if a volume has more backup
versions than specified by its retention settings, which backup
versions to delete.
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Dataset
properties
details

Connection
details

Depending on the properties of the selected dataset, the NetApp
Management Console data protection capability displays some
or all of the following details.
Description

Description of the dataset.

Owner

Owner of the current dataset.

Contact

E-mail contact address for this dataset.

Time zone

Time zone in which the dataset is
located.

Application

(Displayed for application datasets) The
application that generated the dataset.

Application
version

(Displayed for application datasets) The
application version that generated the
dataset.

Application
server

(Displayed for application datasets) The
name of the application server that
generated the dataset.

Custom fields

User-defined custom fields that have
been configured for datasets.

If you select a backup or mirror connection in the Graph area, the details area
displays information about that connection. You can click

to view details.

Relationships Displays the number of existing relationships for the selected
connection.

Backup or
Mirror node
details

Schedule

Displays the name of the schedule that is assigned to the selected
backup connection.

Throttle

Displays the name of the throttle schedule, if any, that is assigned
to the selected connection.

Lag status

Displays the current lag status for the selected connection.

If you select a Backup node or a Mirror node in the Graph area, the details area
displays information about that node. You can click

to view details.

Provisioning policy Lists the provisioning policies, if any, that are assigned to
the selected node.
Physical resources

Lists the physical resources that are assigned to the
selected node.
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Resource pools

Lists the resource pools, if any, that are assigned to the
selected node.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Datasets > Disaster Recovery
You can use the Disaster Recovery tab to perform monitoring, update, testing, and failover tasks on
datasets.
•
•
•
•
•

Command buttons on page 300
Datasets list on page 300
Graph tab on page 302
Jobs tab on page 304
Window customization on page 304

Command buttons
Failover Starts the process for primary-to-disaster recovery node failover in the selected disaster
recovery enabled dataset.
Test

Tests the validity of user-defined failover scripts specified in the disaster recovery
protection policy that is assigned to the selected dataset.

Update

Starts an immediate primary-to-disaster recovery node update in the selected dataset.
This operation is most likely invoked in preparation for an impending event that can
potentially disable a primary storage facility and necessitate failover to a disaster
recovery-enabled backup site, but is still distant enough to allow completion of a final
backup of data from a primary storage node to its disaster recovery-enabled node.

Cancel

Cancels any update or failover operation in the selected dataset.

Datasets list
Displays a table of all datasets enabled for disaster recovery protection. Click on a row in the list to
view information in the Details area about the selected dataset.
Name

The name of the dataset.

Failover

The failover status of the dataset. Possible statuses include the following:
Ready

The dataset is ready for failover.

Failing over

The dataset is in the process of failover.

Failed over

The dataset has completed successful failover.

Failed over - Warning The dataset completed failover with warnings.
Failed over - Error

The dataset encountered errors during failover. Failover
is not successful.

Data > Datasets > Disaster Recovery | 301
Failover Lag
Status

The current status of the data backup between the primary data node and the
disaster recovery node. Valid values, in alphabetical order, are as follows:
Baseline
Failed

There are no initial baseline data transfers that registered a
backup version.

Initializing

The dataset is conforming to the protection policy and the
initial baseline data transfer is in process.

Job Failure

The most recent protection job did not succeed.
This status might result for any of the following reasons:
•
•
•
•

Lag Error

A backup from a SnapVault or Qtree SnapMirror
relationship failed or could not be registered.
A mirror copy from a SnapMirror relationship failed or
could not be registered.
Local backups (Snapshot copies) failed on the primary
node.
The dataset does not have any backup versions.

The dataset has reached or exceeded the lag error threshold
specified in the assigned protection policy. This value indicates
that there has been no successful backup or mirror copy of a
node's data within a specified period of time.
This status might result for any of the following reasons:
•
•

•

Lag Warning

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror) is
older than the lag threshold setting or no backup jobs have
completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than the
lag threshold setting or no mirror jobs have completed since
the dataset was created.

The dataset has reached or exceeded the lag warning threshold
specified in the assigned protection policy. This value indicates
that there has been no successful backup or mirror copy of a
node's data within a specified period of time.
This status might result for any of the following reasons:
•

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
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•

•

No Protection
Policy

The dataset is managed by the NetApp Management Console,
but no protection policy has been assigned to the dataset.

Protected

The dataset has an assigned policy and it has conformed to that
policy at least once.

Protection
Suspended

An administrator has requested that scheduled backups be put
on hold until the administrator requests that they be resumed.

Uninitialized

This status might result for any of the following reasons:
•
•
•
•
•
•

Description

The most recent backup (SnapVault or Qtree SnapMirror) is
older than the lag threshold setting or no backup jobs have
completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than the
lag threshold setting or no mirror jobs have completed since
the dataset was created.

The dataset has a protection policy that does not have any
protection operations scheduled.
The dataset does not contain any data to be protected.
The dataset does not contain storage for one or more
destination nodes.
The single node dataset does not have any backup versions.
At least one backup version must be associated with the
application dataset.
The dataset does not contain any backup or mirror
relationships.

A description of the dataset.

Graph tab
Displays a selectable topological representation of the primary node, disaster recovery node, backup
connections, and any other secondary node assigned to the selected dataset. Clicking a node or
connection displays failover status and resource information about that node that you might need to
evaluate prior to starting failover.
Primary
Data node
details

If the primary storage node is selected, the NetApp Management Console data
protection capability displays the following primary storage node data:
Protection

The status of the data protection scheme assigned to this
dataset (protected, uninitialized, suspended, lag warning, or
lag error).
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Conformance

Whether or not provisioning conformance errors exist in the
selected node. If error conditions exist, click
status value for details.

Resource

Whether or not error or critical conditions exist in the
resources assigned to the selected node.

Space

Whether or not space issues exist on the selected node. If
warning or error conditions exist, click
status value for details.

next to the

Failover

The failover state of the primary data node.

Physical resources

List of the physical systems assigned to the selected node.
Click

for details.

Resource pools

Resource pools, if any, that are assigned to provision the
selected node.

Local backup
schedule

The name of the local backup schedule, if any, that is

Backup versions
Dataset
properties
details

next to the

assigned to the selected node. Click
display of the exact backup times.

for a graphical

List of Snapshot copies stored on this node.

Depending on the properties of the selected dataset, the NetApp Management
Console data protection capability displays some or all of the following details.
Owner

Owner of the current dataset.

Contact

E-mail contact address for this dataset.

Time zone

Time zone in which the dataset is located.

Application

(Displayed for application datasets) The application that
generated the dataset.

Application version (Displayed for application datasets) The application
version that generated the dataset.
Application server

Connection
details

(Displayed for application datasets) The name of the
application server that generated the dataset.

If the connection element is selected, the NetApp Management Console data
protection capability displays the following data in connection with the data
protection connections:
Relationships The protection relationships between a source and target nodes.
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Schedules

The name of the protection schedule assigned to this protection
connection.

Throttle

The name of the throttle schedule assigned to this protection
connection.

Lag status

The current lag status (good, warning, or error) of successfully
completed protection backup or mirror operations between the
source and target nodes. If error or warning conditions exist, click
next to the status value for details.

Backup Node If the backup node is selected, the NetApp Management Console data protection
capability displays the following data in connection with the data protection backup
node:
Node name

The default or user-assigned name of the backup node.

Provisioning policy The provisioning policy, if any, that is assigned to the
backup node.
Physical resources

The physical resources assigned to the selected node. Click
for details.

Resource pools

The resource pools, if any assigned to the selected node.
Click

for details.

Jobs tab
Displays a list of the disaster recovery update and failover operations initiated on this dataset.
Job

A list of the jobs related to disaster recovery-related protection configuration or
execution that the NetApp Management Console data protection capability has
executed.

Step

A list of the phases or milestones that occurred or were attempted during the
execution of the listed jobs.

Time stamp The times and dates that the listed jobs and steps started or occurred.
Result

The Normal, Warning, or Error result status of the listed jobs or steps.

Note: You can select each listed job or step to display further details on that job or step in the pane
to the right.

Window customization
You can modify the layout of the window by using a variety of customization options.
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•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Datasets > Migration
You can use the Migration tab to start, complete, and clean up after a data migration.
•
•
•
•
•

Command buttons on page 306
Datasets list on page 307
Details area on page 309
Jobs tab on page 311
Window customization on page 312

Command buttons
The migration command buttons are disabled when a dataset or a vFiler unit migration is in progress.
Start
migration

Initiates the first phase of a dataset migration by starting the Dataset Migration
wizard, which begins a baseline transfer of the dataset. You must specify a
destination storage system and an interface for each of the source vFiler unit's IP
addresses. If VLANs need to be created, you must also specify the VLAN.

Update

Performs an on demand update of the SnapMirror relationships that were created as
part of the start migration operation. This button is enabled only when the start
migration operation has finished for the selected dataset.

Cancel

Cancels the migration in progress for the selected dataset. The dataset is returned to
the migration status that it had before the migration started. All ongoing data
transfers for the migration are aborted, and the provisioned destination storage and
destination vFiler unit are deleted. (You must manually delete VLANs and
IPspaces that were created during the migration process.) This button is enabled
during the migration start and migration update operations.

Cut over

Initiates the second phase of a migration, which performs a cutover (in other words,
switches the source from the old storage from which the data is served to the new
storage destination). This button is enabled only when the migration start operation
has finished for the selected dataset.

Roll back

Rolls back a migration for the selected dataset even after cutover operation is
complete. Active status is returned to the original source storage. That storage is
updated with any changes made to the destination storage since cutover, and then
the destination storage is made unavailable. Successful rollback must be carried out
before the cleanup operation has taken place.

Clean up

Initiates the deletion of the old storage from which the dataset was migrated. A
preview window lists which volumes are to be destroyed as part of cleanup
operation. VLANs and IPspaces used by the source vFiler unit are not
automatically destroyed. This button is enabled only when a migration cutover
operation has finished for the selected dataset.
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Relinquish
migration
capability

Deletes the vFiler unit that was created during provisioning, which makes the
dataset no longer capable of being migrated.

Datasets list
Displays a list of all the datasets in the selected group that are capable of data migration.
Name

The name of the dataset.

Migration
status

The status of datasets capable of migration. The description, source storage status,
destination storage status, permitted operations, and prohibited operations for each
status are described as follows:
Not started

The dataset meets the dataset migration requirements.
•
•
•
•

Source storage system: Online
Destination storage: Not provisioned
Operations permitted: All
Prohibited operations: Migration cutover, migration update,
migrate complete, migration cancel, migration cleanup

You can initialize the start migration operation on datasets having a
"Not started" or "Migrate failed" status.
In progress

The baseline transfer of this dataset has started.
•
•
•
•

Started,
cutover
required

The migration start operation baseline transfer to the new
destination storage system is finished. The dataset source needs to
be switched to the new destination storage system.
•
•
•
•

Migrated,
cleanup
required

Source storage system: Online
Destination storage: Provisioned for the dataset then offline
Operations permitted: Migration cancel
Prohibited operations: Add or delete dataset volumes, provision
storage for the dataset, edit provisioning or protection policies

Source storage system: Online
Destination storage: Online
Operations permitted: Edit provisioning or protection policies,
migration update, migration cutover, migration cancel
Prohibited operations: Migration cleanup

The migration cutover operation is finished and the dataset is
switched over to the destination storage system, including the data,
backup versions, backup relationships, and DataFabric Manager
history for the volumes. Old storage needs to be deleted.
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•
•
•

•
Migrated
with errors

The migration cutover operation successfully performed the switch
to the destination storage system. However, a failure occurred
during the migration of the backup version, backup relationships, or
history for the primary data. You must manually correct the errors,
change the migration status of the dataset using the Operations
Manager CLI, and resume the dataset.
•
•
•

•
Migrate
failed

Source storage system: Offline
Destination storage: Online
Operations permitted: Resize storage, delete Snapshot copies,
add and delete dataset volumes, provision storage for the
dataset, edit provisioning or protection policies, migration
rollback, migration cleanup
Prohibited operations: Migration start, migration cancel,
migration update, migration cutover

Source storage system: Offline
Destination storage: Online
Operations permitted: Resize storage, delete Snapshot copies,
add and delete dataset volumes, provision storage for the
dataset, edit provisioning or protection policies
Prohibited operations: Migration start, migration cancel,
migration update, migration cutover, migration cleanup

The migration cutover operation failed to bring the destination
vFiler unit online. The source vFiler unit is online again and the
destination storage system is destroyed.
•
•
•

•

Source storage system: Online
Destination storage: Offline
Operations permitted: Resize storage, delete Snapshot copies,
add and delete dataset volumes, provision storage for the
dataset, edit provisioning or protection policies, migration start,
migration cancel
Prohibited operations: Migration cutover, migration cleanup,
migration update

Rolled back The rollback operation succeeded. The source vFiler is online again
and its data is updated with any changes made since the migration
cutover.
•
•

Source storage system: Online
Destination storage: Offline
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•

•

Operations permitted: Resize storage, delete Snapshot copies,
add and delete dataset volumes, provision storage for the
dataset, edit provisioning or protection policies, migration
cutover (returns availability to the destination storage if the
problem that necessitated the rollback is fixed), migration
cleanup (cleans up the destination storage).
Prohibited operations: Migration start, migration update,
migration cancel

Rolled back The rollback operation successfully performed the switch back to
with errors the source storage system. However, a failure occurred during the
restoration of the backup version, backup relationships, or history
for the destination data. You must manually correct the errors,
change the migration status of the dataset using the Operations
Manager CLI, and resume the dataset.
•
•
•

•

vFiler Unit

Source storage system: Online
Destination storage: Offline
Operations permitted: Resize storage, delete Snapshot copies,
add and delete dataset volumes, provision storage for the
dataset, edit provisioning or protection policies
Prohibited operations: Migration start, migration cancel,
migration update, migration cutover, migration cleanup

The vFiler unit used by the dataset to export data.

Details area
This area displays detailed information about the migration of the selected dataset.
Source storage
system

The name of the storage system from which the data is migrated.

Destination
storage system

The name of the storage system into which the data is migrated.

Source
provisioning
policy

The name of the provisioning policy applied to the dataset before it is migrated.

Destination
provisioning
policy

The name of the provisioning policy applied to the dataset after it is migrated.

Volume

The volumes in the dataset.
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Lag

The length of time since the most recent successful migration of data to the
destination.

State

The state of the volume, SnapVault relationship, or SnapMirror relationship
created during the migration.
Uninitialized The destination storage volume or qtree is not yet initialized or
is being initialized.
Snapvaulted

The SnapVault relationship is created and the qtree is a
SnapVault secondary destination.

Mirrored

The destination volume or qtree is in a SnapMirror relationship.

Broken off

The destination was in a SnapMirror relationship, but a
snapmirror break command made the volume or qtree
writable.
This state is reported when the base Snapshot copy is still
present in the volume. If the Snapshot copy is deleted, the state
is reported as uninitialized while the destination is in the /etc/
snapmirror.conf file. The snapmirror resync command restores
the mirrored status.

Quiesced

SnapMirror is in a consistent internal state and no SnapMirror
activity is occurring.
In this state, you can create Snapshot copies with confidence
that all destinations are consistent. The snapmirror quiesce
command brings the destination into this state. The
snapmirror resume command restarts all SnapMirror dataset
activities.

Source

A snapvault status or snapmirror status command
was executed on the primary storage system.
When the destination is on another storage system, its status is
unknown and the NetApp Management Console provisioning
capability reports the status, "source." This status is also
reported for SnapVault relationships when a snapvault
status command is executed on secondary storage systems
after the snapvault restore command was executed on an
associated primary storage system.

Unknown

The destination volume or the volume that contains the
destination qtree is in an unknown state.
It might be offline or restricted.
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Restoring
Status

SnapVault relationships are being restored.

The status of the volume, SnapVault relationship, or SnapMirror relationship
created during the migration.
Idle

No data is being transferred. The volume has been migrated and
is now idle.

Transferring Data transfer is initiated but not yet finished, or is just finishing.
Pending

The secondary storage system cannot be updated because of a
resource issue; the data transfer is retried automatically.

Aborting

A data transfer operation is being aborted and cleaned up.

Migrating

Qtree SnapMirror or volume SnapMirror relationships are
being migrated.

Quiescing

The specified volume or qtree is waiting for all existing
transfers to complete. The destination is being brought into a
stable state.

Resyncing

The specified volume or qtree is being matched with data in the
common Snapshot copy.

Waiting

During the migration of qtree SnapMirror or volume
SnapMirror relationships, SnapMirror is waiting for a new tape
to be put in the tape device.

Syncing

Qtree SnapMirror or volume SnapMirror relationships are
being matched with each other.

In_sync

Qtree SnapMirror or volume SnapMirror relationships match
each other.

Paused

Qtree SnapMirror or volume SnapMirror relationships are
paused.

Jobs tab
Displays a log of the dataset migration operations initiated on this dataset and their associated steps.
Job Type The type of migration job, which is determined by the direct request initiated by a user.
The job types that might be listed are as follows:
Start migration

An operation that begins migrating a dataset or a vFiler unit to a
new storage system.

Cancel migration

An operation that cancels a dataset or a vFiler unit migration.
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Cleanup
migration

An operation that deletes the old storage after a dataset or a
vFiler unit migration cutover.

Cutover

A migration operation that switches the source of a dataset or a
vFiler unit from the old storage system to a new storage system.

Migration
rollback

A migration operation that reverses the migration and restores the
original source storage systems as the active accessible systems.

Migration one
step

A migration operation that begins migrating a dataset or a vFiler
unit to a new storage system and automatically performs the
cutover operation.

Migration update

A job that updates the SnapMirror relationships that were created
as part of the migration start operation.

Migration fix

A CLI-based migration repair operation whose occurrence is
nevertheless noted in the Jobs list.

Relinquish
migration

A job that relinquishes the migration capability of a dataset.

Step

Displays detailed information about each step that is run to complete the associated job.

Time
stamp

The date and time each step was started.

Result

The result of the step. Possible results are as follows:
Error

The step failed.

Warning

The step succeeded but with a possible problem.

Normal

The step succeeded.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
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•
•

You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Groups
You can use the Groups window to add, edit, and delete groups.
•
•
•
•

Command buttons on page 314
Group name on page 314
Details area on page 314
Window customization on page 314

Command buttons
Add

Starts the Add Group wizard for adding a new group.

Edit

Opens the properties window for the selected group. From the properties window you can
modify the group settings or membership.

Delete Deletes the selected group and all its subgroups, if any.
Group name
Displays the hierarchy of groups, beginning with the default group, Global. You can expand the list
to display parent and child groups. You select a group to view its settings.
Details area
Identifies the group owner, the e-mail address used to alert the owner about events for the group, and
the objects that are members of the group.
Owner

The name of the person who is to be sent e-mail or pager alerts regarding events for this
group.

E-mail

One or more e-mail addresses for the person who is to be sent e-mail or pager alerts
regarding events for this group.

Members The objects that are members of the group, sorted by object type.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
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•
•
•
•
•

You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Resource Pools
You can use the Resource Pools window to create, view, and modify collections of physical storage
resources, called resource pools.
•
•
•
•
•
•

Command buttons on page 316
Resource pools list on page 316
Space Breakout tab on page 318
Details tab on page 318
Dependencies tab on page 319
Window customization on page 319

When a resource pool is assigned to a dataset, data management applications use the resources in the
resource pool to provision storage containers as needed by the dataset and according to the settings
defined in policies assigned to the dataset.
Command buttons
Add

Starts a wizard that helps you create a new resource pool.

Edit

Opens the properties window for the selected resource pool. From the properties window
you can modify the settings (Name, Description, Contact, Owner), assigned resources,
labels, or space thresholds of an existing resource pool.

Delete Displays a dialog box that asks you to confirm that you want to delete the selected resource
pool. You can either proceed with deleting the selected resource pool or cancel the activity.
Deleting a resource pool currently assigned to a dataset also deletes any relationships
created in accordance with a policy assigned to that dataset. Deleting a resource pool does
not delete the physical resources that were in the resource pool.
Resource pools list
Displays key property settings and space management information for each resource pool.
Name

The name assigned to the resource pool.

Total Size

The total amount of storage space assigned to the resource pool.

Used Size

The space in the resource pool that is currently used, expressed in KB, MB, GB,
or TB. By default, this field is not displayed. You can click
column-display menu.

to select it from the

Available Size The amount of storage space available in the resource pool.
Note: Available Size does not include storage system spare disk capacity.

Data > Resource Pools | 317
Space Status

The status of the space in the resource pool and the members in the resource pool.
Valid values are as follows:
Full

Indicates the number of resource pools for which the used space
has reached the Full threshold set for that resource pool. The
amount of used space is determined based on the total used space
for all aggregates in each resource pool.

Member
Full

Indicates the number of resource pools that contain a storage
member for which the used space has reached the Full threshold
set for that storage member.

Nearly Full Indicates the number of resource pools for which the used space
has reached the Nearly Full threshold set for that resource pool.
The amount of used space is determined based on the total used
space for all aggregates in each resource pool.
Indicates the number of resource pools that contain a storage
Member
Nearly Full member for which the used space has reached the Nearly Full
threshold set for that storage member.
Normal

Indicates the number of resource pools for which the total used
space in the resource pools is below the Resource Pool Nearly
Full threshold and the used space for each storage member in the
resource pool is also below its Nearly Full threshold. Total used
space is the sum of used space of all aggregates in each resource
pool.

Utilization

The percentage of total storage space that is used in the resource pool.

Owner

The person who maintains or is responsible for the resource pool; for example, an
administrator. By default, this field is not displayed. You can click
from the column-display menu.

to select it

Description

A user-specified description that identifies the resource pool.

Time Zone

The time zone that is applied to the resource pool. By default, this field is not
displayed. You can click

to select it from the column-display menu.

Note: If a resource pool is assigned to a dataset using a protection policy, the
time zone you select can impact the protection schedule. Make sure that you
understand the potential impact to any of your schedules before changing the
Time Zone property.

Resource
Label

An optional text string that is used in provisioning requests as a filter for specific
resources. By default, this field is not displayed. You can click
the column-display menu.

to select it from
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Space breakout tab
Displays information about the aggregates in the selected resource pool. If you select one or more
resource pools, the aggregates associated with each selected resource pool are displayed.
Aggregates
list

The aggregates in the selected resource pool.
Aggregate

The aggregate name.

Total Size

The total size of the aggregate.

Used Size

The space in the aggregate that is currently used, expressed in
KB, MB, GB, or TB. By default, this field is not displayed.
You can click

to select it from the column-display menu.

Committed Size The space in the aggregate that is currently committed,
expressed in KB, MB, GB, or TB. By default, this field is not
displayed. You can click
display menu.

Aggregate
properties

Aggregate
datasets

to select it from the column-

Available Size

The amount of uncommitted space that is still available in the
aggregate. This value is expressed in KB, MB, GB, or TB.

Utilization

The percentage of the aggregate space that is used. Aggregates
with space problems are highlighted in red.

The properties of the selected aggregate in the selected resource pool.
Name

The name of the aggregate.

Committed
Size

The amount of space guaranteed to the volumes contained in the
aggregate. This value can be higher than the total size of the
aggregate If you are using the aggregate overcommitment
strategy. This value is expressed in KB, MB, GB, or TB.

Information about the datasets in the selected aggregate.
Dataset

The names of datasets in the selected aggregate. If an
aggregate is running out of space, you can use this list to
choose which dataset to migrate.

Used space from
aggregate

The amount of space on the aggregate that is used by the
dataset.

Details tab
Displays detailed information about the selected resource pool.
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Resource pool
properties

The properties of the selected resource pool.
Owner

The person who maintains or is responsible for the resource
pool.

Time zone

The time zone that is applied to the resource pool.

Total size

The total amount of space currently being used by the
resource pool.

Resource label The user-specified text string assigned to this resource pool.
Resource
diagram area

This area displays an expandable tree view of the physical resources assigned to
the selected resource pool.

Dependencies tab
Displays the datasets, if any, that use the selected resource pool and lists whether those datasets are
capable of migration.
Dataset

The datasets with which the selected resource pool is associated.

Migration capable

Whether the dataset configuration enables migration.

Remaining number of
migration-enabled datasets
allowed

The number of additional datasets in the selected resource pool that
can be configured for data migration.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Unprotected Data > Datasets
You can use the Unprotected Data window Datasets tab to view datasets that do not have an assigned
protection policy and datasets that have an assigned protection policy but do not have a relationship
created (the dataset has never conformed to the protection policy). You can also use this window to
initiate policy assignments for these datasets.
•
•
•

Command buttons on page 320
Datasets list on page 320
Window customization on page 322

Command buttons
Protect Opens the Dataset Policy Change wizard so that you can assign a protection policy to the
selected dataset.
This button is not enabled for datasets of virtual objects.
Datasets list
Displays some of the dataset properties that were configured when the dataset was created.
Name

The name of the dataset

Description

The description of the dataset

Owner

The owner of the dataset

Contact

The person to contact for issues with the dataset

Protection
Status

The status of the dataset. Valid values are as follows:
Protected

The dataset has an assigned policy and it has conformed to that
policy at least once.

Uninitialized

This status might result for any of the following reasons:
•
•
•
•
•

The dataset has a protection policy that does not have any
protection operations scheduled.
The dataset does not contain any data to be protected.
The dataset does not contain storage for one or more
destination nodes.
The single node dataset does not have any backup versions.
At least one backup version must be associated with the
application dataset.
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•

The dataset does not contain any backup or mirror
relationships.

Protection
Suspended

An administrator has requested that scheduled backups be put
on hold until the administrator requests that they be resumed.

Baseline
Failed

There are no initial baseline data transfers that registered a
backup version.

Job Failure

The most recent protection job did not succeed.
This status might result for any of the following reasons:
•
•
•
•

Lag Error

A backup from a SnapVault or Qtree SnapMirror
relationship failed or could not be registered.
A mirror copy from a SnapMirror relationship failed or
could not be registered.
Local backups (Snapshot copies) failed on the primary
node.
The dataset does not have any backup versions.

The dataset has reached or exceeded the lag error threshold
specified in the assigned protection policy. This value indicates
that there has been no successful backup or mirror copy of a
node's data within a specified period of time.
This status might result for any of the following reasons:
•
•

•

Lag Warning

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror)
is older than the lag threshold setting or no backup jobs
have completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than the
lag threshold setting or no mirror jobs have completed since
the dataset was created.

The dataset has reached or exceeded the lag warning threshold
specified in the assigned protection policy. This value indicates
that there has been no successful backup or mirror copy of a
node's data within a specified period of time.
This status might result for any of the following reasons:
•

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
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•

•

The most recent backup (SnapVault or Qtree SnapMirror)
is older than the lag threshold setting or no backup jobs
have completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than the
lag threshold setting or no mirror jobs have completed since
the dataset was created.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Unprotected Data > Resources > Hosts
You can use the Hosts button on the Resources tab of the Unprotected Data window to view the
unprotected hosts. A host is counted as unprotected if it is not in a dataset that has an assigned
protection policy, or it is not assigned to a resource pool. From this window, you can protect a host
by assigning it to a new or existing dataset of physical storage objects, assign or remove the Ignore
property, and view the details about unprotected objects within a host.
•
•
•
•
•

Command buttons on page 323
Host list on page 324
Host content hierarchy area on page 324
Host content details area on page 324
Window customization on page 325

Command buttons
Add to new
Dataset

Starts the Add Dataset wizard to create a new dataset to which you can add the
selected host. You can also initiate this action by right-clicking a host name.

Add to
existing
Dataset

Opens a dialog box from which you can select an existing dataset of physical
storage objects (datasets of virtual objects are not listed) to which you can add the
selected host. You can also initiate this action by right-clicking a host name.

Ignore

Identifies the selected host as an object to be ignored, for purposes of data
protection. This option filters the display so that the hosts marked "Ignore" do not
appear in the list of unprotected hosts.
When you set the Ignore option to Yes for a host, the host name is removed from
the host list. However, the host and its contents remain available to the NetApp
Management Console data protection capability. You can assign the Ignore property
only to a host; you cannot ignore specific volumes or aggregates. By default, the
hosts displayed in the Unprotected Data window are those that are not ignored, but
you can filter the list by using the
column filter.
You can also initiate this action by right-clicking a host name.
Note: If an administrator sets the data protection status of the hosts to Ignore, the
backup jobs stop working.

Undo Ignore Removes the Ignore property from the selected host.
This button also changes the Ignored column status for the selected host from Yes
to No. You can also initiate this action by right-clicking a host name.
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View
Resources
buttons

Selects the type of unprotected resource to display.
(Hosts)
(Aggregates)
(Volumes)
(Qtrees)

Displays only information about unprotected hosts.
Displays only information about unprotected aggregates.
Displays only information about unprotected volumes.
Displays only information about unprotected qtrees.

Host list
Displays only the hosts that meet the selected filter criteria.
Host Name The name of the host.
Type

The host type: storage system, vFiler unit, Open Systems SnapVault (displayed as
OSSV), or virtual machine.

Ignored

The Ignore status of each host. Valid values are Yes (ignored) and No (not ignored).
By default, only the hosts that are not ignored are listed.

Datasets

If the host is in an unprotected dataset, the name of the dataset.

Host content hierarchy area
Provides a hierarchical view of the objects contained in the selected host. The hierarchy includes
aggregates, volumes, qtrees, non-qtree files, Open Systems SnapVault folders, or virtual machines on
the host.
You can select an object in the hierarchy to view details about it.
Host content details area
Provides property details about the objects selected in the host content hierarchy.
For storage system
hosts

Host object properties: Host Name, Host Type, Ignored status
Aggregate object properties: Aggregate Name, Total Size
Volume object properties: Volume Name, Total Size, Unprotected
Qtrees, Protected Qtrees, Total Qtrees
Qtree object properties: QTree Name, Used Size
Non-qtree data file object properties: QTree Name, Used Size

For vFiler hosts

Host object properties: Host Name, Host Type, Ignored status
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Volume object properties: Volume Name, Total Size, Unprotected
Qtrees, Protected Qtrees, Total Qtrees
Qtree object properties: QTree Name, Used Size
Non-qtree data file object properties: QTree Name, Used Size
For OSSV (Open
Systems SnapVault)
hosts

Host object properties: Host Name, Host Type, Ignored status

For ESX server hosts

Host object properties: Host Name, Host Type, Ignored status

For OSSV (Open
Systems SnapVault)
ESX server hosts

VM (virtual machine) properties: Virtual machine, Virtual machine ID,
SnapVault Path, Application Type

Directory properties: Directory Name, Full Path

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
to display only the entries containing the information that you
You can use the filter arrow
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Unprotected Data > Resources >
Aggregates
You can use the Aggregates button on the Resources tab of the Unprotected Data window to view
the aggregates that are not in a dataset that has an assigned protection policy, are not in a resource
pool, and are not in a protected host. From this window, you can assign an aggregate to a new or
existing dataset of physical storage objects and view the details about unprotected aggregates.
•
•
•
•
•

Command Buttons on page 326
Aggregate list on page 326
Aggregate content hierarchy area on page 327
Aggregate content details area on page 327
Window customization on page 327

Command buttons
Add to new
Dataset

Starts the Add Dataset wizard to create a new dataset to which you can add the
selected aggregate. You can also initiate this action by right-clicking an
aggregate name.

Add to existing
Dataset

Opens a dialog box from which you can select an existing dataset of physical
storage objects (datasets of virtual objects are not listed) to which you can add
the selected aggregate. You can also initiate this action by right-clicking an
aggregate name.

Ignore

Disabled when the Aggregates button is selected.

Undo Ignore

Disabled when the Aggregates button is selected.

View Resources Selects the type of unprotected resource to display.
buttons
Displays only information about unprotected hosts.
(Hosts)
(Aggregates)
(Volumes)
(Qtrees)

Displays only information about unprotected aggregates.
Displays only information about unprotected volumes.
Displays only information about unprotected qtrees.

Aggregate list
Displays only the aggregates that meet the selected filter criteria.
Aggregate Name

The name of the aggregate
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Host

The name of the host to which the aggregate belongs

Total Size

The total size of the aggregate

Used Size

The amount of the aggregate that is currently used

Datasets

If the aggregate is in an unprotected dataset, the name of the dataset

Aggregate content hierarchy area
Provides a hierarchical view of the objects contained in the selected aggregate. The hierarchy
includes volumes and qtrees.
You can select an object in the hierarchy to view details about it.
Aggregate content details area
Provides property details about the objects selected in the aggregate content hierarchy.
•
•
•
•

Aggregate object properties: Aggregate Name and Total Size
Volume object properties: Volume Name, Total Size, Unprotected Qtrees, Protected Qtrees, Total
Qtrees
Qtree object properties: Qtree Name, Used Size
Non-qtree data file object properties: Qtree Name, Used Size

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Unprotected Data > Resources > Volumes
You can use the Volumes button on the Resources tab of the Unprotected Data window to view the
volumes that are not in a SnapVault or SnapMirror relationship which is managed by the NetApp
Management Console data protection capability, and are not in an external relationship. From this
window, you can assign a volume to a new or existing dataset of physical storage objects and view
the details about unprotected volumes.
•
•
•
•
•

Command buttons on page 328
Volume list on page 328
Volume content hierarchy area on page 329
Volume content details area on page 329
Window customization on page 329

Command buttons
Add to new
Dataset

Starts the Add Dataset wizard to create a new dataset to which you can add the
selected volume. You can also initiate this action by right-clicking a volume
name.

Add to existing Opens a dialog box from which you can select an existing dataset of physical
storage objects (datasets of virtual objects are not listed) to which you can add
Dataset
the selected volume. You can also initiate this action by right-clicking a volume
name.
Ignore

This button is disabled when the Volumes button is selected.

Undo Ignore

This button is disabled when the Volumes button is selected.

View Resources Selects the type of unprotected resource to display.
buttons
Displays only information about unprotected hosts.
(Hosts)
(Aggregates)
(Volumes)
(Qtrees)

Displays only information about unprotected aggregates.
Displays only information about unprotected volumes.
Displays only information about unprotected qtrees.

Volume list
Displays only the volumes that meet the selected filter criteria.
Volume Name

The name of the volume.
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Aggregate

The name of the aggregate to which the volume belongs.

Host

The name of the host to which the volume belongs.

Total Size

The total size of the volume.

Used Size

The amount of the volume that is currently used.

Unprotected Qtrees

The number of unprotected qtrees in the volume.

Datasets

If the volume is in an unprotected dataset, the name of the dataset.

Volume content hierarchy area
Provides a hierarchical view of the objects contained in the selected volume. The hierarchy includes
qtrees and non-qtree data.
You can select an object in the hierarchy to view details about it.
Volume content details area
Provides property details about the objects selected in the volume content hierarchy.
Volume object properties: Volume Name, Total Size, Unprotected Qtrees, Protected Qtrees, Total
Qtrees
Qtree object properties: Qtree Name, Used Size
Non-qtree data file object properties: Qtree Name, Used Size
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Unprotected Data > Resources > Qtrees
You can use the Qtrees button on the Resources tab of the Unprotected Data window to view the
qtrees that are neither in a SnapVault or SnapMirror relationship managed by the NetApp
Management Console data protection capability nor in an external relationship. From this window,
you can assign a qtree to a new or existing dataset of physical storage objects and view the details
about unprotected qtrees.
•
•
•

Command buttons on page 330
Qtree list on page 330
Window customization on page 331

Command buttons
Add to new
Dataset

Starts the Add Dataset wizard to create a new dataset to which you can add the
selected qtree. You can also initiate this action by right-clicking a qtree name.

Add to existing
Dataset

Opens a dialog box from which you can select an existing dataset of physical
storage objects (datasets of virtual objects are not listed) to which you can add
the selected qtree. You can also initiate this action by right-clicking a qtree
name.

Ignore

Disabled when the Qtrees button is selected.

Undo Ignore

Disabled when the Qtrees button is selected.

View Resources Selects the type of unprotected resource to display:
buttons
Displays information about unprotected hosts only.
(Hosts)
(Aggregates)
(Volumes)
(Qtrees)

Displays information about unprotected aggregates only.
Displays information about unprotected volumes only.
Displays information about unprotected qtrees only.

Qtree list
Displays only the qtrees that meet the selected filter criteria.
Qtree Name The name of the qtree.
Volume

The name of the volume to which the qtree belongs.

Host

The name of the host to which the qtree belongs.
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Used Size

The amount of used space in the qtree.
Note: This value reflects information only for qtrees that are in volumes with the

quota turned on. If the quota for a volume is turned off, no usage information is
collected by the storage system.
Datasets

If the qtree is in an unprotected dataset, the name of the dataset.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > External Relationships
You can use the External Relationships window to view information about the SnapVault and
SnapMirror relationships that are not managed by the NetApp Management Console data protection
capability. These relationships are discovered by Operations Manager and listed separately by the
NetApp Management Console data protection capability. From this window, you can import an
external relationship into an existing dataset of physical storage objects.
•
•
•

Command button on page 332
Unmanaged Relationships list on page 332
Window customization on page 333

Command button
Import Starts the Import Relationships wizard to add an external relationship to an existing dataset
of physical storage objects.
The wizard lists only datasets of physical storage objects, not datasets of virtual objects,
for you to add external relationships to.
External Relationships list
Displays information about the external relationships that Operations Manager discovered. The list
includes relationships for which the source volume, qtree, or Open Systems SnapVault directory is
not in a dataset and is not on the Backup Manager ignore list. Source storage system names display in
ascending order.
Source

The name of the source volume, qtree, or Open Systems SnapVault host.

Type

The type of relationship that Operations Manager discovered: SnapVault, Volume
SnapMirror, or Qtree SnapMirror.

Destination The name of the destination volumes and qtrees to which the source data is copied.
State

The state of the SnapVault relationship, or SnapMirror relationship.
Uninitialized The destination storage volume or qtree is not yet initialized or is
being initialized.
Snapvaulted

The SnapVault relationship is created and the qtree is a SnapVault
secondary destination.

Mirrored

The destination volume or qtree is in a SnapMirror relationship.

Broken off

The destination was in a SnapMirror relationship, but a
snapmirror break command made the volume or qtree writable.
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This state is reported when the base Snapshot copy is still present in
the volume. If the Snapshot copy is deleted, the state is reported as
uninitialized while the destination is in the /etc/snapmirror.conf file.
The snapmirror resync command restores the mirrored status.
Quiesced

SnapMirror is in a consistent internal state and no SnapMirror
activity is occurring.
In this state, you can create Snapshot copies with confidence that all
destinations are consistent. The snapmirror quiesce command
brings the destination into this state. The snapmirror resume
command restarts all SnapMirror dataset activities.

Source

A snapvault status or snapmirror status command was
executed on the primary storage system.
When the destination is on another storage system, its status is
unknown and the NetApp Management Console provisioning
capability reports the status, "source." This status is also reported for
SnapVault relationships when a snapvault status command is
executed on secondary storage systems after the snapvault
restore command was executed on an associated primary storage
system.

Unknown

The destination volume or the volume that contains the destination
qtree is in an unknown state.
It might be offline or restricted.

Restoring
Lag

SnapVault relationships are being restored.

The age of the mirrored copy, which is the difference between the current time and
the timestamp of the last Snapshot copy that was successfully transferred to the
destination.

Discovered The date that Operations Manager discovered the relationship.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
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•
•
•
•
•

You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Jobs
You can use the Jobs window to view status information for jobs initiated within NetApp
Management Console.
•
•
•
•
•
•

Command button on page 335
View Jobs buttons on page 335
Jobs list on page 336
Completed steps on page 339
Event description on page 340
Window customization on page 340

Command button
Cancel Stops the selected jobs. You can select multiple jobs and cancel them simultaneously. This
button is active only when the selected jobs are in progress.
View Jobs buttons
These buttons specify the range of jobs displayed in the summary list.
1 Day

Displays all jobs that were started between midnight of the previous day and now. (Jobs
that were started before this period are not included, even if they are still running.) This
period can cover up to 47 hours and 59 minutes.
For example, if you click 1 Day at 15:00 on February 14 (on a 24-hour clock), the list
includes all jobs that were started from 00:00 (midnight) on February 13 to the current
time on February 14. This list covers the full day of February 13 plus the partial current
day of February 14.

1 Week

Displays all jobs that were started between midnight of the same day in the previous
week (seven days ago) and now. (Jobs that were started before this period and are still
running are not included.) This period can cover up to seven days, 23 hours, and 59
minutes.
For example, if you click 1 Week at 15:00 on Thursday, February 14 (on a 24-hour
clock), the list includes all jobs that were started from 00:00 (midnight) the previous
Thursday (February 7) to the current time on February 14. This list covers seven full
days plus the partial current day.

1 Month Displays all jobs that were started between midnight of the same day in the previous
month and now. (Jobs that were started before this period and are still running are not
included.) This period can cover from 28 through 32 days, depending on the month.
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For example, if you click 1 Month at 15:00 on Thursday, February 14 (on a 24-hour
clock), the list includes all jobs that were started from 00:00 (midnight) on January 14 to
the current time on February 14.
All

Displays all jobs.

Note: On very large or very busy systems, the Jobs window might be unresponsive for long
periods while loading 1 Month or All data. If the NetApp Management Console appears
unresponsive for these large lists, select a shorter time period (such as 1 Day).

Jobs list
Displays a list of the jobs that occurred. The list of jobs is updated dynamically, as jobs start or
finish. You can customize the display using the filtering and sorting options in the jobs list.
Note: The lists of jobs that can be downloaded is limited to 25,000 records.

Jobs Id

The identification number of the job. The default jobs list includes this column.
The job identification number is unique and is assigned by the server when it starts
the job. You can search for a particular job by entering the job identification
number in the text box provided by the column filter.

Job Type

The type of job, which is determined by the policy assigned to the dataset or by
the direct request initiated by a user. The default jobs list includes this column.
The job types are as follows:
Create relationship

A protection relationship create operation based on
SnapMirror technology.

Dedupe volume

A deduplication space-saving operation initiated on a
selected volume.

Delete backup

A job that deletes backups of volumes of a dataset.

Delete Snapshot
copies

A job that deletes Snapshot copies of volumes of a
dataset.

Delete storage

A job that deletes a volume, qtree, or LUN from the
storage system.
Attention: This operation destroys the data in the

deleted volume, qtree, or LUN and cannot be reversed.
Destroy LUN

A job that deletes a LUN.

Destroy
relationship

A protection relationship delete operation based on
SnapMirror technology.
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Failover

A dataset failover of a primary node to a disaster recovery
node. Applies only if the dataset is enabled for disaster
recovery.

Local backup

A local scheduled backup protection operation based on
Snapshot technology.

Local backup
confirmation

A local scheduled backup protection operation based on
Snapshot technology. Applies if a dataset is an
application-generated dataset and if the application is
responsible for creating local backups.

Local then remote
backup

A local backup protection operation on the primary node
of the dataset followed by a transfer of the backup copies
to remote nodes of the dataset.

Migrate volume

A migration operation of a volume in secondary or
tertiary storage.

Mirror

A scheduled protection mirror operation based on
SnapMirror technology.

On-demand
protection

A backup or mirror operation that is initiated by the
Protect Now button in the Datasets window. The types of
tasks performed are determined by the policy configured
for the dataset.

Provision

A job that provisions containers into a dataset based on
the associated policy and dataset attributes.

Remote backup

A scheduled backup to secondary storage based on
SnapVault technology.

Resize LUN

A job that changes the LUN size.

Resize storage

A job that changes the storage size or quota limit. If the
selected container is a volume, this job type changes the
size, Snapshot reserve, and maximum size of the volume.
If the selected container is a qtree, this job type changes
the quota limit of the qtree.

Restore

A protection data restore job that is initiated by the
Restore button in the Datasets window.

Undedupe volume

A deduplicated volume has been converted to a normal
volume.

Unrecognized

A protection job of indeterminate type has been detected.
Often jobs executed on virtual objects such as VMware
virtual machines or datastores are detected but not
recognized by NetApp Management Console.
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Start migration

An operation that begins migrating a dataset or vFiler unit
to a new storage system.

Canceling

The job stopped because the Cancel button was clicked
to stop the job before it was completed.

Canceled

The Cancel button was clicked and the job is in the
process of stopping.

Cancel migration

An operation that cancels a dataset or vFiler unit
migration.

Cleanup migration

An operation that deletes the old storage after a dataset or
vFiler unit migration cutover.

Cutover

A migration operation that switches the source of a
dataset or vFiler unit from the old storage system to a
new storage system.

Migration rollback

A migration operation that reverses the migration and
restores the original source storage systems as the active
accessible systems.

Migration one step

A migration operation that begins migrating a dataset or
vFiler unit to a new storage system and automatically
performs the cutover operation.

Migration update

A job that updates the SnapMirror relationships that were
created as part of the migration start operation.

Migration fix

A CLI-based migration repair operation that is
nevertheless noted in the UI Jobs list.

Relinquish
migration

A job that relinquishes the migration capability of a
dataset.

Context

The name of the object on which the job was started. The default jobs list includes
this column.

Context Type

The type of object on which the job was started. The default jobs list includes this
column. The context types are Aggregate, Dataset, vFiler unit, and Unrecognized.
"Unrecognized" usually refers to virtual object types observable but not
manageable by NetApp Management Console, such as VMware virtual machines
or datastores.

Start

The date and time the job was started. The default jobs list includes this column.

Job Status

The running status of the job. The default jobs list includes this column. The
progress options are as follows:
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Failed

All tasks in the job failed.

Partially Failed One or more of the tasks in the job failed and one or more of
the tasks completed successfully.
Succeeded

All tasks completed successfully.

Running

The job is currently running.

Queued

The job is not running yet. However, it is scheduled to run
after other provisioning jobs on the same dataset are
completed.

Canceled

The job stopped because the Cancel button was clicked to
stop the job before it was completed.

Canceling

The Cancel button was clicked and the job is in the process of
stopping.

End

The date and time the job ended. The default jobs list includes this column.

Bytes
Transferred

The amount of data (in megabytes or gigabytes) that was transferred during the
job, as reported by the DataFabric Manager server. This column is not displayed
in the jobs list by default.
Note: This number is approximate; it is always less than the actual number of

bytes transferred. For jobs that take a short time to complete, no data transfer
size is reported.
Policy

The name of the policy associated with the job. This column is not displayed in
the jobs list by default.

Source Node

The name of the storage resource that contains the data being protected. This
column is not displayed in the jobs list by default.

Destination
Node

The name of the storage resource to which the data is transferred during the job.
This column is not displayed in the jobs list by default.

Submitted By

The policy that automatically started the job or the name of the user who started
the job. This column is not displayed in the jobs list by default.

Description

A description of the job taken from the policy configuration or the job description
entered when the job was manually started. This column is not displayed in the
jobs list by default.

Completed job steps
Detailed information about each task in the selected job. You can select a step to see its details.
Time stamp The date and time the step was completed.
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Step

A description of the step: for example, Start, In progress, or End.

Result

The result of the step. Result options are as follows:
Error

The step failed.

Warning

The step succeeded but with a possible problem.

Retry

The provisioning engine has performed undo and retry operations.

Normal

The step succeeded.

Event description
Displays detailed information about events and errors that occurred during each step of a job. The
information displayed in this area includes much of the same information that is provided in the
columns of the Details area. However, it also includes the unique items Job Description and Error
Message.
To view the details, select an item from the jobs list, then select an item from the Completed Steps
list. To view more information about the dataset, you can click
directly to the Datasets window.

next to the dataset name to go

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Custom Fields
You can use the Custom Fields window to add, edit, and delete custom fields that are assigned to
specified object types.
•
•

Command buttons on page 341
Custom Fields list on page 341

Command buttons
Add

Opens a dialog box for adding a new custom field.

Edit

Opens a properties sheet for modifying the selected custom field name or the object types
to which the custom field is assigned.

Delete Deletes the selected custom field from all object types.
Custom Fields list
Displays a list of all the custom fields.
Name

The name of the custom field.

Object Types The object types to which the selected custom field is assigned. Custom fields can
be assigned to multiple object types. Valid object types are datasets (including
application datasets), protection policies, and provisioning policies.
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Policies > Protection > Overview
You can use the Protection Policies window Overview tab to view current protection policies, add
new protection policies, or edit or copy existing protection policies.
Protection policies are assigned to datasets and specify the type of protection policy (local backup,
remote backup, mirror, disaster recovery capable, or a combination of types), the schedule, the
backup retention times, and permissible lag times to implement.
•
•
•
•
•

Command buttons on page 342
Policies list on page 342
Graph tab on page 344
Dependencies tab on page 345
Window customization on page 345

Command buttons
Add

Starts the Add Protection Policy wizard to create a new protection policy.

Edit

Opens a window that allows you to modify the selected policy.

Copy Copies a selected policy and displays the copy in the Names list as a "Copy of.." Use this
button to make customizable copies of selected existing policies in the Policies list.
Delete Deletes the selected policies.
Policies list
Displays the currently configured protection policies. Each policy is listed by name and description.
The DR capable column indicates whether the policy is disaster recovery capable. This list includes
the original preconfigured policies and all user-generated policies that were created by using the Add
button or by copying and customizing the originals with the Copy and Edit buttons.
Policies:
Not
disaster
recovery
capable

The following preconfigured policy types are displayed for all installations of the
NetApp Management Console data protection capability. Additional disaster
recovery-capable policies are also available.
Backup

Specifies local backup and remote backup of data in primary
storage.

No protection

Specifies no data protection whatever in primary storage.
Note: The property Local Backup Schedule Name for the
primary data node is preconfigured as blank and is disabled.
However, if you assign and enable a protection schedule for
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this policy, local backups will be scheduled despite the
property type.
Local backups
only

Specifies local backup protection only (no remote backup) on
primary storage.

Mirror

Specifies mirror-copy protection between primary and secondary
storage.

Remote backup
only

Specifies remote backup protection only from primary to
secondary storage (no local backup on primary storage). This
policy is appropriate for protecting data on open systems (that is,
Windows, UNIX, or Linux-based primary storage systems).
Note: The property Local Backup Schedule Name for the
primary data node is preconfigured as blank and is disabled,
which prevents you from assigning and enabling a Local
backup schedule on the primary data node if it contains Open
Systems SnapVault directories.

Policies:
Disaster
recovery
capable

Back up, then
Mirror

Specifies backup protection from primary storage to secondary
and mirror-copy protection between secondary storage and
tertiary storage.

Mirror, then
back up

Specifies mirror-copy protection between primary and secondary
storage and backup protection between secondary and tertiary
storage.

Mirror and
mirror

Specifies mirror-copy protection from primary storage to two
different secondary storage destinations.

Mirror, then
mirror

Specifies mirror-copy protection between primary and secondary
storage and mirror protection between secondary and tertiary
storage.

Mirror and
back up

Specifies mirror-copy protection from primary storage to one
secondary storage location and also backup protection from
primary to another secondary storage location.

The following additional disaster recovery capable preconfigured policy types are
displayed.
For each of these policies, if disaster or mishap disables or destroys primary storage,
the disaster recovery capable secondary storage is enabled to take over and provide
primary storage function and availability.
DR Back up

Specifies disaster recovery capable local and remote backup of
the data in primary storage.
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DR Mirror

Specifies disaster recovery capable mirror-copy protection
between primary and secondary storage.

DR Back up, then
mirror

Specifies disaster recovery capable backup protection from
primary storage to secondary and mirror-copy protection
between secondary storage and tertiary storage.

DR Mirror, then
back up

Specifies disaster recovery capable mirror-copy protection
between primary and secondary storage and backup protection
between secondary and tertiary storage.

DR Mirror and
mirror

Specifies disaster recovery capable mirror-copy protection
from primary storage to one secondary storage destination and
regular mirror-copy protection to another storage destination.

DR Mirror, then
mirror

Specifies disaster recovery capable mirror-copy protection
between primary and secondary storage and mirror-copy
protection between secondary and tertiary storage.

DR Mirror and
back up

Specifies disaster recovery capable mirror-copy protection
from primary storage to one secondary storage location and
also backup protection from primary to another secondary
storage location.

Graph tab
Displays a diagram of the node and connection components of the selected policy. The diagram
might include the following components:
Note: For a shortcut to directly edit the properties of a node or connection component for the
selected policy, click the node or connection in this diagram.

Primary Data
node
This icon represents the primary data storage node of the selected
policy. The default name for this node is Primary data. However, it can also
have a user-specified name, for example, ABCprimarydata.
Backup
Connection

This icon represents the backup connection component of the selected
policy.

Backup node
This icon along with the backup connection icon represents a
backup storage node component of the selected policy. The default name for this
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node is Backup. However, it can also have a user-specified name, for example,
ABCsecondarybackup.
Mirror
Connection
This icon represents the mirror connection component of the selected
policy.
Mirror node
This icon along with the mirror connection icon represents the
mirror node component of the selected policy. The default name for this node is
Mirror. However, it can also have a user-specified name, for example,
ABCsecondarymirror.
Dependencies tab
Lists the datasets to which the selected policy is assigned. Also displays the protection status for each
of the datasets listed.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Policies > Protection > Schedules
You can use the Schedules tab to add, edit, copy, or delete protection schedules and throttle
schedules.
•
•
•
•

Command buttons on page 346
Schedules list on page 346
Dependencies list on page 347
Window customization on page 347

Command buttons
Add

Starts the Add Schedule wizard for adding a throttle schedule or a daily, weekly, or
monthly protection schedule.

Edit

Modifies the configuration of the selected schedule.

Delete Deletes the selected schedule.
Copy Copies a selected schedule and displays it in the Schedules list as a "Copy of..".
Schedules list
Displays a list of all the existing daily, weekly, monthly, and throttle schedules. The following
schedule types are displayed.
Daily

A schedule that specifies the times for hourly and daily backup or mirror copy operations
over a single 24-hour period. When you assign this schedule to a protection policy, you
can assign different retention durations to the Hourly and Daily classes of backup.

Weekly

A schedule that specifies the times for hourly, daily, or weekly backup or mirror copy
operations over a seven-day period. It consists of one or more daily schedules applied
over that time period. When you assign this schedule to a protection policy, you can
assign different retention durations to the Hourly, Daily, and Weekly classes of backup.

Monthly A schedule that specifies the times for hourly, daily, weekly, or monthly backup and
mirror copy operations over a month-long period. It consists of a daily or weekly
schedule applied over a month-long period. When you assign this schedule to a
protection policy, you can assign different retention durations to the Hourly, Daily,
Weekly, and Monthly classes of backup.
Throttle A schedule that specifies periods of unlimited, limited, or zero network bandwidth
availability for the data backup or mirror operations.
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Dependencies list
Lists the policies or other schedules to which the selected schedule has been applied.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
to display only the entries containing the information that you
You can use the filter arrow
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Policies > Storage Services
The Storage Services window provides a location to create, edit, copy, delete, or survey your storage
services combinations.
•
•
•
•
•

Command buttons on page 348
Storage Services table on page 348
Overview tab on page 348
Dependancies tab on page 349
Window customization on page 349

Command buttons
Add

Starts the Add Storage Service wizard to create a new storage service object.

Edit

Opens a window that allows you to modify the selected storage service.

Delete

Deletes the selected storage service.

Storage services table
Lists information about existing storage services.
Name

The name of the selected storage service.

Primary provisioning
policy

The name of the provisioning policy that this storage service applies to
the primary node of the datasets to which it is attached.

Protection policy

The name of the protection policy that is provided by this service.

Description

A description of the storage service.

Overview tab
The overview tab displays a graphical representation of the nodes for the protection policy offered by
the selected storage service. On clicking the node for which you want to view status and
configuration details, the following information is displayed:
Provisioning policy The provisioning policy, if any, that is assigned to the selected node.
Resource pools

vFiler template

The resource pools, if any, that are assigned to the selected node. Click
for details.
The vFiler template, if any, for the storage service to use if you specify
creation of a vFiler unit attached to a node when you use the storage service
to create a new dataset.
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Owner

The owner of the selected storage service.

Contact

The contact email for the owner of the selected storage service.

Datasets

The datasets, if any, that are already using the selected storage service.

Dependencies tab
The Dependencies tab displays the datasets, if any, that are already using the selected storage service.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.

350 | Provisioning and Data Protection Online Help

Hosts > Storage Systems
You can use the Storage Systems Hosts window to view detailed information about storage systems
discovered by the DataFabric Manager server. From this window, you can add a storage system to
NetApp Management Console, edit the properties of existing storage, and diagnose a storage
system's configuration. You can also manage Data ONTAP service licenses.
•
•
•
•
•
•
•
•

Command buttons on page 350
Storage system host list on page 350
Details tab on page 351
Usage tab on page 355
Paths tab on page 355
Input Relationships tab on page 356
Output Relationships tab on page 356
Window customization on page 357

Command buttons
Add

Starts the Add Storage System wizard, which enables you to set up storage system hosts.

Edit

Opens a window in which you can modify the properties of the selected host.

Delete

Deletes the selected storage system from the NetApp Management Console storage
systems list.

Diagnose Starts the Diagnose Storage Systems wizard, which allows you to modify some aspects
of a storage system's configuration.
This button is disabled if more than one host is selected in the hosts list.
Refresh

Updates the host list for the selected host.

Storage system host list
Name

Displays the name of the storage system or the vFiler unit as it appears in the
DataFabric Manager database.

System Status Displays the current status of the storage system. Possible values are Online,
Offline, and Unknown.
The default monitoring interval is one minute. The interval is specified as the Ping
Monitoring Interval in Operations Manager.
You can use the Options page in Operations Manager to view or change the
interval. See the Operations Manager online Help for details.
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Login
Credentials

Displays the current status of the login credentials that the DataFabric Manager
server uses to log in to the host.
Possible values are Good, Bad, Read Only, Unknown, and Not Applicable. NDMP
credentials for vFiler units are designated Not Applicable because the DataFabric
Manager server uses the credentials of the hosting system.

NDMP Status Displays the Network Data Management Protocol (NDMP) availability of the
storage system as of the most recent NDMP monitoring check.
Possible values are Up, Down, and Unknown. The default interval for NDMP
monitoring is 30 minutes.
You can use the Backup Discovery Options page in Operations Manager to change
the NDMP monitoring interval. See the Operations Manager online Help for
instructions.
NDMP
Credentials

Displays the current status of the Network Data Management Protocol credentials
that the DataFabric Manager server uses to communicate with the host.
Possible values are Good, Bad, Unknown, and Not Applicable. NDMP credentials
for vFiler units are always designated Not Applicable because the DataFabric
Manager server uses the credentials of the hosting system.
You can use the NDMP Credentials page in Operations Manager to edit the
credentials for NDMP discovery. See the Operations Manager online Help for
details.

Details tab
The Details tab has four areas: General, Credentials, Service status, and Licenses.
General

IP Address

Specifies the IP address associated with the selected storage
system.

Model

Displays the model number of this storage system.

Mirrored

Indicates whether the SnapMirror license is enabled on this host.
Possible values are Yes and No.

Backup
Destination

Indicates whether a SnapVault Secondary license is enabled on
this host, making the host a potential destination for backups.
Possible values are Yes and No.

Backup
Source

Indicates whether the SnapVault Data ONTAP Primary license
is enabled on this host, making the host a potential source of
backups.
Possible values are Yes and No.
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Note: Other hosts might also be potential backup sources, but

the SnapVault Primary licenses for Linux, UNIX, and
Windows are installed on the secondary system. This list
confirms only whether the SnapVault Data ONTAP Primary
license is enabled on the host.
Credentials

Service
status

Login User
Name

Specifies the name that the DataFabric Manager server uses to
log in to the selected host.

NDMP User
Name

Specifies the name that the DataFabric Manager server uses to
log in to the selected host by using NDMP.

NFS Indicates whether the Network File System (NFS) service is Up or Down.
CIFS

Indicates whether the Common Internet File System (CIFS) service is Up
or Down.

iSCSI Indicates whether the iSCSI service is Up or Down.
FC
Licenses

Indicates whether the Fibre Channel (FC) protocol service is Up or Down.

The following licenses each enable a service of Data ONTAP.
You must enter a software license code on the storage system to enable the
corresponding service. You do not need to indicate which license the code enables;
the code is matched automatically to the appropriate service license.
SnapMirror

You install the SnapMirror licenses on both the source and
destination storage systems for the mirrored data.
If the source and destination volumes are on the same
system, only one license is required. SnapMirror replicates
data to one or more networked storage systems. SnapMirror
updates the mirrored data to keep it current and available for
disaster recovery, offloading tape backup, read-only data
distribution, testing on nonproduction systems, online data
migration, and so on. You can also enable the SnapMirror
license to use Qtree SnapMirror for backup.

SnapVault Data
ONTAP
Secondary

You install the SnapVault Secondary license on storage
systems hosting the backups of protected data.
SnapVault creates backups of data stored on multiple
primary storage systems and copies the backups to a
secondary storage system. If data loss or corruption occurs,
backed-up data can be restored to a primary or open storage
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system with little of the downtime and uncertainty
associated with conventional tape backup and restore
operations.
SnapVault Data
ONTAP Primary

You install the SnapVault Data ONTAP Primary license on
storage systems running Data ONTAP that contain host data
to be backed up.

SnapVault
Windows Primary

You install the SnapVault Windows Primary license on a
secondary storage system, in addition to the SnapVault
Secondary license, to support a Windows-based primary
storage system running the Open Systems SnapVault agent.
A Windows-based primary storage system running the Open
Systems SnapVault agent does not require a SnapVault
license.

SnapVault
Windows Open
File Manager

You install the SnapVault Open File Manager license on a
secondary storage system to enable the backup of open files
on Windows primary storage systems running the Open
Systems SnapVault agent.
You must install the SnapVault Windows Primary license
and the SnapVault Data ONTAP Secondary license on the
secondary storage system before installing the SnapVault
Open File Manager license.

SnapVault UNIX
Primary

You install the SnapVault UNIX Primary license on a
secondary storage system, in addition to the SnapVault
Secondary license, to support a UNIX-based primary storage
system (AIX, HP-UX, or Solaris) running the Open Systems
SnapVault agent.
A UNIX-based primary storage system running the Open
Systems SnapVault agent does not require a SnapVault
license.

SnapVault Linux
Primary

You install the SnapVault Linux Primary license on a
secondary storage system, in addition to the SnapVault
Secondary license, to support a Linux-based primary storage
system running the Open Systems SnapVault agent.
A Linux-based primary storage system running the Open
Systems SnapVault agent does not require a SnapVault
license.
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NearStore Option

The NearStore license enables your storage system to use
transfer resources as conservatively as if it were optimized
as a backup system.
This approach is useful when the storage system on which
you want to store backed-up data is not a system optimized
for storing backups, and you want to minimize the number
of transfer resources the storage system requires. Storage
systems using the NearStore license must meet the following
criteria:
•
•
•

Deduplication

The storage system must be a FAS30xx, FAS31xx, or
FAS60xx system.
The version of Data ONTAP software must be 7.1 or
later.
If you plan to use the SnapVault service, the storage
system must have a SnapVault secondary license
enabled.

The deduplication license enables you to consolidate blocks
of duplicate data into single blocks so that you can store
more information using less storage space.
The storage system must have the Deduplication license
enabled. If you want to run deduplication on FAS platforms,
the NearStore personality license must also be enabled.
Monitoring of the volume-level deduplication option is done
as part of the core license.

SnapMirror Sync

The SnapMirror Sync license enables you to replicate data to
the destination as soon as it is written to the source volume.
SnapMirror Sync is a feature of SnapMirror.

FCP

Fibre Channel (FC) protocol is a licensed service on the
storage system that enables you to export LUNs and transfer
block data to hosts using the SCSI protocol over a Fibre
Channel fabric.

CIFS

Common Internet File System (CIFS) protocol is a licensed
service for remote file access that runs over TCP/IP on the
Windows operating system.
CIFS enables application access and file sharing across the
Internet.

NFS

Network File System (NFS) is client/server application that
runs over TCP/IP on the UNIX operating system.
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NFS enables application access and file sharing across the
Internet.
iSCSI

The iSCSI protocol is a licensed service on the storage
system that enables you to transfer block data to hosts using
the SCSI protocol over TCP/IP.
iSCSI supports Gigabit Ethernet and is often used in a SAN
environment.

MultiStore

The MultiStore license enables you to partition the storage
and network resources of a single storage system so that it
appears as multiple storage systems, called vFiler units, on
the network.
Be sure that the host on which you intend to install the
MultiStore license is running Data ONTAP 6.5 or later.

Usage tab
The Usage tab provides information about the aggregates, volumes, and qtrees that are associated
with any host selected from the host list.
Resource Type Displays a tree of the storage system and the aggregates, volumes, and qtrees on
that system.
You can also select either aggregates, volumes, or qtrees to narrow the list of
resources associated with the storage system that you selected.
Dependencies

Displays the name of the resource pool or datasets associated with the storage
system, aggregate, or volume selected in the Resource Type menu.

Paths tab
The Paths tab provides information about data that is moving into and out of host paths on the
selected storage system. You can use this information to identify dependencies on a selected storage
system, aggregate, volume, or qtree.
Data coming
into host path

Displays an expandable list of locations from which data is being backed up or
mirrored to the selected host path.

Host path

Displays the host path for which incoming and outgoing data is shown.
You can view the flow of data into and out of the storage system as a whole or
expand the list to select a specific aggregate, volume, or qtree and view the flow
of data through the selected path. Using the Resource Type menu, you can also

356 | Provisioning and Data Protection Online Help
select aggregates, volumes, or qtrees to narrow the list of resources associated
with the storage system you selected.
Data coming
out of host
path

Displays an expandable list of locations to which data is being backed up or
mirrored from the selected host path.

Input Relationships tab
This tab displays information about systems that send backup or mirror-copy data to the selected
system.
You can use this information to identify dependencies on a selected storage system before shutting
the system down for maintenance or to assess the impact of an outage.
Lag Status Indicates whether the lag threshold specified for the relationship has been or is about
to be exceeded.
Lag

Displays the time elapsed since the last successful backup or mirror-copy update.

Source

Displays the location of the backup or mirror-copy data that is being sent to the
selected system.

Type

Displays the type of relationship that the system has with the selected storage system.
Possible values are SnapVault, Volume SnapMirror, and Qtree SnapMirror.

Dataset

Displays the name of the dataset to which the incoming data belongs.

Destination Displays where the incoming data is stored on the selected storage system.
Output Relationships tab
This tab displays information about systems that receive backup or mirror-copy data from the
selected system.
You can use this information to identify dependencies on a selected storage system before shutting
the system down for maintenance or to assess the impact of an outage.
Lag Status Indicates whether the lag threshold specified for the relationship has been or is about
to be exceeded.
Lag

Displays the time elapsed since the last successful backup or mirror-copy update.

Source

Displays the location of data on the system that is being backed up or mirrored to a
secondary system.

Type

Displays the type of relationship the system has with the selected storage system.
Possible values are SnapVault, Volume SnapMirror, and Qtree SnapMirror.
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Dataset

Displays the name of the dataset to which the outgoing data belongs.

Destination Displays where the outgoing data is stored on the destination system.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
to display only the entries containing the information that you
You can use the filter arrow
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Hosts > OSSV
You can use the OSSV Hosts window to add, edit, or diagnose the Open Systems SnapVault hosts
that are discovered by DataFabric Manager. From this window, you can manage host login or NDMP
credentials and Data ONTAP service licenses. You can also start, stop, and refresh Open Systems
SnapVault hosts.
•
•
•
•
•

Command buttons on page 358
Host list on page 358
Details tab on page 359
Paths tab on page 360
Window customization on page 361

Command buttons
Add

Starts the Add OSSV Host wizard, which allows you to set up Open Systems SnapVault
hosts.

Edit

Opens a window in which you can modify the properties of the selected host.

Delete

Deletes the selected Open Systems SnapVault host from the NetApp Management
Console OSSV list.

Diagnose Opens the Diagnose Storage Systems wizard, which allows you to modify some aspects
of a storage system's configuration.
This button is disabled if more than one host is selected in the hosts list.
Start

Starts the Open Systems SnapVault agent on the selected system.

Stop

Stops the Open Systems SnapVault agent on the selected system.

Refresh

Updates the host list for the selected host.

Host list
Displays information about Open Systems SnapVault hosts discovered by DataFabric Manager.
Name

Displays the name of the host as it appears in the DataFabric Manager database.

System Status

Displays the current status of the host.
Possible values are Up, Down, and Unknown. The default monitoring interval is
one minute.
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The interval is specified as the Ping Monitoring Interval in Operations Manager.
You can use the Options page in Operations Manager to view or change the
interval. See the Operations Manager online Help for details.
Displays the current status of NetApp Host Agent.

Host Agent
Status

Possible values are Detected and Not Detected.
Note: There is no Open Systems SnapVault plug-in for Solaris, so the NetApp
Host Agent cannot communicate with the Open Systems SnapVault agent.
Therefore, the Host Agent Status displays as Not Detected and management
tasks such as start and stop of the Open Systems SnapVault agent cannot be
performed from the management console.

Displays the current status of the login credentials that DataFabric Manager uses
to log in to NetApp Host Agent.

Host Agent
Credentials

Possible values are Good, Bad, and Unknown.
NDMP Status

Displays the current status of the Network Data Management Protocol (NDMP).
Possible values are Up, Down, and Unknown.
Displays the current status of the NDMP credentials that DataFabric Manager
uses to communicate with the host.

NDMP
Credentials

Possible values are Good, Bad, and Unknown.
Details tab
The details tab reflects information about the host selected in the hosts list. This tab contains three
sections: General, Host Agent Settings, and NDMP Settings.
General

Host Name

The name of the currently selected host.

IP Address

The IP address associated with the selected host.

System Status Whether the status of the Open Systems SnapVault host is Up, Down,
or Unknown.

Host
Agent
Settings

OS

The operating system running on the host.

Version

The version of the operating system running on the host.

Status

Whether NetApp Host Agent is Detected or Not Detected on the
assigned port.

Credentials
Status

Whether the status of the credentials for NetApp Host Agent on
the selected host is Good, Bad, or Unknown.
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User Name

The name that DataFabric Manager uses to log in to NetApp
Host Agent on the selected host.

Port

The port that DataFabric Manager uses to log in to NetApp Host
Agent.
The default port number is 4092.

NDMP
Settings

Status

Whether the status of the data management protocol for the
selected host is Up, Down, or Unknown.

Credentials
Status

Whether the status of the data management protocol for the
selected host is Good, Bad, or Unknown.

User Name

The name that DataFabric Manager uses to log in to the selected
host by using NDMP.

Port

The port that DataFabric Manager uses to log in to a host running
the Open Systems SnapVault agent.
The default port number is 10000. This port is not valid for other
types of host.

Paths tab
The Path area provides a way to browse host directories and to view which datasets the directories
are assigned to, if any.
Select any item in the pane to display information about that item.
Note: The paths on an Open Systems SnapVault client are filtered using the Operations Manager
Backup Discovery property, Directories to Ignore. If a path matches the settings specified for this
property, the path is ignored and new directories in that path are not protected automatically. For
more information, see the Operations Manager online Help.

Path

The path of the currently selected directory or file.

Status

The protection status of the currently selected path. Possible values are as follows:
Protected

The data is being protected according to policy (normal).

Unprotected

The data is not protected by a policy (warning).

Uninitialized

There are no registered backups of the data (normal).

Protection suspended An administrator has requested that all scheduled backups be
canceled until the administrator requests that the backups be
resumed (warning).
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Job failure

An error occurred while the data was being protected
(warning).

Lag warning

The dataset is nearing the lag threshold (warning).

Lag error

The protection lag has exceeded the configured lag threshold
(error).

Datasets The datasets to which the directory is assigned, if any.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.

362 | Provisioning and Data Protection Online Help

Hosts > vFiler Units
You can use the vFiler Units window to view detailed information about vFiler units discovered by
DataFabric Manager. From this window, you can add vFiler units to or delete them from the NetApp
Management Console host list. You can also access the Details tab, Paths tab, and the Relationships
tabs for vFiler units.
•
•
•
•
•
•
•
•
•

Command buttons on page 362
vFiler units list on page 363
Details tab on page 366
Network Settings tab on page 367
Paths tab on page 368
Input Relationships tab on page 369
Output Relationships tab on page 369
Migration tab on page 370
Window customization on page 371

Command buttons
The migration command buttons are disabled when a vFiler unit migration is in progress.
Add

Starts the Add vFiler Unit wizard, which allows you to create and to optionally
configure vFiler units.
You can choose to create the vFiler unit by using the Add button and then configure
it later by using the Setup button.

Setup

Starts the Setup vFiler Unit wizard, which allows you to configure or modify an
existing vFiler unit.

Delete

Presents you with two delete options:
Delete

Deletes the selected vFiler unit from the NetApp Management
Console vFiler list.

Destroy and
Delete

Destroys the selected vFiler unit on the DataFabric Manager
database, and deletes it from the NetApp Management Console
vFiler list.

Start
migration

Initiates the first phase of a vFiler unit migration by starting the vFiler Unit
Migration wizard, which begins a baseline transfer.

Update

Performs an on-demand update of the SnapMirror relationships that were created as
part of the "Start migration" operation. This button is enabled only when the "Start
migration" operation has finished for the selected vFiler unit.
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Cancel

Cancels the migration in progress for the selected vFiler unit. The vFiler unit is
returned to the migration status that it had before the migration started. All ongoing
data transfers for the migration are aborted, and the provisioned destination storage
and destination vFiler unit are deleted. (You must manually delete VLANs and
IPspaces that were created during the migration process.) This button is enabled
during the migration start and migration update operations.

Cut over

Initiates the second phase of a migration, which performs a cutover (switching the
source from the old storage from which the data is served to the new storage
destination). This button is enabled only when the migration start operation has
finished for the selected vFiler unit.

Roll back

Rolls back a migration for the selected vFiler unit, even after a cutover is done.
Active status is returned to the original source storage. That storage is updated with
any changes made to the destination storage since cutover, and then the destination
storage is made unavailable. To be successful, rollback must be completed before the
cleanup operation occurs.

Clean up

Initiates the third phase of a migration, which deletes the storage from which the
vFiler unit was migrated. A preview window lists which volumes are to be destroyed
as part of the cleanup operation. VLANs and IPspaces used by the source vFiler unit
are not automatically destroyed. This button is enabled only when a migration
cutover process for the selected vFiler unit has finished.

vFiler units list
Name

The name of the vFiler unit as it appears in the DataFabric Manager database

IP address

The IP address associated with the selected vFiler unit

IP Space

The name of the IPspace, if any, assigned to the vFiler unit

Hosting
Storage
System

The name of the storage system that hosts the vFiler unit

System
Status

The current status of the vFiler unit
Possible values are Online, Offline, and Unknown. The default monitoring interval
is five minutes.
The interval is specified as the Ping Monitoring Interval in Operations Manager.
You can use the Options page in Operations Manager to view or change the interval.
See the Operations Manager online Help for details.

Migration
Status

The status of a migrating source vFiler unit
The description, source storage status, destination storage status, permitted
operations, and prohibited operations for each status are described as follows:
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Not started

The vFiler unit meets the vFiler unit migration requirements.
•
•
•
•

Source storage system: Online
Destination storage: Not provisioned
Operations permitted: All
Prohibited operations: Migration cutover, migration update,
migrate complete, migration cancel, migration cleanup

You can initialize the start migration operation on vFiler units
having a "Not started" or "Migrate failed" status.
In progress

Migration of the vFiler unit has started.
•
•
•
•

Started,
cutover
required

The vFiler unit is completely migrated to the destination storage
system, including the data, backup versions, backup relationships,
and DataFabric Manager history for the volumes. The data source
must be switched to the new vFiler unit on the new destination
storage system.
•
•
•
•

Migrated,
cleanup
required

Source storage system: Online
Destination storage: Provisioned for the vFiler unit currently
offline
Operations permitted: Migration cancel
Prohibited operations: Add or delete volumes, provision storage
for the vFiler unit, edit provisioning or protection policies

Source storage system: Offline
Destination storage: Online
Operations permitted: Edit provisioning or protection policies,
migration update, migration cutover, migration cancel
Prohibited operations: Migration cleanup

The migration cutover operation is finished and the vFiler unit is
switched over to the destination storage system, including the data,
backup versions, backup relationships, and DataFabric Manager
history for the volumes. Old storage must be deleted.
•
•
•

•

Source storage system: Offline
Destination storage: Online
Operations permitted: Resize storage, delete Snapshot copies,
add and delete volumes, provision storage for the vFiler unit,
edit provisioning or protection policies, migration cleanup
Prohibited operations: Migration start, migration cancel,
migration update, migration cutover
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Migrated
with errors

The migration cutover operation successfully performed the switch
to the destination storage system. However, a failure occurred
during the migration of the backup version, backup relationships, or
history for the primary data. You must manually correct the errors.
•
•
•

•
Migrate
failed

The migration cutover operation failed to bring the destination
vFiler unit online. The source vFiler unit is online again and the
destination storage system is destroyed.
•
•
•

•

Rolled back

Source storage system: Online
Destination storage: Offline
Operations permitted: Resize storage, delete Snapshot copies,
add and delete volumes, provision storage for the vFiler unit,
edit provisioning or protection policies, migration start,
migration cancel
Prohibited operations: Migration cutover, migration cleanup,
migration update

The rollback operation succeeded. The source vFiler unit is online again and its data
is updated with any changes made since the migration cutover.
•
•
•

•
Rolled back
with errors

Source storage system: Offline
Destination storage: Online
Operations permitted: Resize storage, delete Snapshot copies,
add and delete volumes, provision storage for the vFiler unit,
edit provisioning or protection policies
Prohibited operations: Migration start, migration cancel,
migration update, migration cutover, migration cleanup

Source storage system: Online
Destination storage: Offline
Operations permitted: Resize storage, delete Snapshot copies, add and delete
volumes, provision storage for the vFiler unit, edit provisioning or protection
policies, migration cutover (returns availability to the destination storage if the
problem that necessitated the rollback is fixed), migration cleanup (cleans up the
destination storage)
Prohibited operations: Migration start, migration update, migration cancel

The rollback operation successfully performed the switch back to the source storage
system. However, a failure occurred during the restoration of the backup version,
backup relationships, or history for the destination data. You must manually correct
the errors, change the migration status of the dataset using the Operations Manager
CLI, and resume the dataset.
•

Source storage system: Online
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•
•

•

Destination storage: Offline
Operations permitted: Resize storage, delete Snapshot copies, add and delete
volumes, provision storage for the vFiler unit, edit provisioning or protection
policies
Prohibited operations: Migration start, migration cancel, migration update,
migration cutover, migration cleanup

Details tab
The Details tab has three areas: General, Service status, and Hosting Storage System Settings.
General

Protocols

Indicates the protocol type associated with the vFiler unit: CIFS,
NFS, or iSCSI.

Mirrored

Indicates whether the SnapMirror license is enabled on the hosting
storage system.
Possible values are Yes and No.

Backup
Destination

Indicates whether a SnapVault Secondary license is enabled on this
host, making the host a potential destination for backups.
Possible values are Yes and No.

Backup
Source

Indicates whether the SnapVault Data ONTAP Primary license is
enabled on the hosting storage system, making the host a potential
source of backups.
Possible values are Yes and No.
Note: Other hosts might also be potential backup sources, but the

SnapVault Primary licenses for Linux, UNIX, and Windows are
installed on the secondary system. This list confirms only
whether the SnapVault Data ONTAP Primary license is enabled
on the host.
Service
status

NFS

Indicates whether the Network File System (NFS) service is Up or Down.

CIFS

Indicates whether the Common Internet File System (CIFS) service is Up or
Down.

iSCSI Indicates whether the iSCSI service is Up or Down.
Hosting
Storage
System
Settings

These settings apply to the storage system that is hosting the vFiler unit that you
selected in the vFiler list.
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Host Name

The name that DataFabric Manager uses to log in to the storage
system

IP Address

The IP address of the hosting storage system that is associated
with the selected vFiler unit

System Status

Whether the status of the storage system is Online, Offline, or
Unknown

Login
Credentials
Status

The current status of the login credentials that DataFabric
Manager uses to log in to the hosting storage system. Possible
values are Good, Bad, Read Only, Unknown, and Not Applicable.

NDMP Status

The Network Data Management Protocol (NDMP) availability of
the storage system as of the most recent NDMP monitoring check.
Possible values are Up, Down, and Unknown. The default interval
for NDMP monitoring is 30 minutes.
You can use the Backup Discovery Options page in Operations
Manager to change the NDMP monitoring interval. See the
Operations Manager online Help for instructions.

NDMP
Credentials
Status

The current status of the Network Data Management Protocol
credentials that DataFabric Manager uses to communicate with the
hosting storage system.
Possible values are Good, Bad, Unknown, and Not Applicable.
You can use the NDMP Credentials page in Operations Manager
to edit the credentials for NDMP discovery. See the Operations
Manager online Help for details.

Network Settings tab
This tab provides information about vFiler unit administrative hosts and servers, and network
bindings.
Network
information
area

This area displays information about administrative hosts and servers for a
selected vFiler unit.
Administrative host

Indicates the IP address of the administrative host for
the selected vFiler unit.

DNS domain name

Indicates the domain name of the DNS server for the
selected vFiler unit.

DNS servers

Indicates the IP addresses of DNS servers for the
selected vFiler unit.
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NIS domain name

Indicates the domain name of the NIS server for the
selected vFiler unit.

NIS servers

Indicates the IP addresses of the NIS servers for the
selected vFiler unit.

CIFS authentication
type

Indicates the mode used to authenticate data requests
to or from a selected vFiler unit.
Values are Active directory or Windows workgroup.

CIFS security style

Indicates the security protocol to be used by a selected
vFiler unit.
Values are NTFS-only or Multiprotocol.

CIFS workgroup
name
Network
Bindings

Indicates the name of the CIFS Windows workgroup.

You can use network bindings to bind network cards, protocols, and services.
IP address

The IP address of a network card or port that you have bound to a
specific protocol or service.

Network
mask

The network mask of a network card or port that you have bound
to a specific protocol or service
The network mask value is displayed as prefix length rather than
in four-octet notation. For example, if the network mask is
255.255.255.0, the value of the network mask is displayed by the
equivalent prefix length, 24.

Network
interface
MTU (Bytes)

The protocol or service to which the corresponding IP address is
bound

The maximum unit of data transmission that you want to allow over the listed
network binding

Paths tab
The Paths tab displays information about data that is moving in to and out of host paths on the
selected vFiler unit. You can use this information to identify dependencies on a selected vFiler unit,
aggregate, volume, or qtree.
Data coming
into host path

A list of locations from which data is being backed up or mirrored to the
selected host path

Host path

The host path for which incoming and outgoing data is shown for the storage
system that is hosting the vFiler unit
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You can view the flow of data into and out of the storage system as a whole, or
you can expand the list to select a specific aggregate, volume, or qtree and view
the flow of data through the selected path.
Data coming out A list of locations to which data is being backed up or mirrored from the
selected host path
of host path
Input Relationships tab
This tab displays information about systems that send backup or mirror data to the storage system
that is hosting the vFiler unit.
You can use this information to identify dependencies on a selected storage system before shutting
down the system for maintenance or to assess the impact of an outage.
Lag Status Whether the lag threshold specified for the relationship has been or is about to be
exceeded
Lag

The time elapsed since the last successful backup or mirror update

Source

The location of the backup or mirror data that is being sent to the selected system

Type

The type of relationship that the system has with the hosting storage system
Possible values are SnapVault, Volume SnapMirror, and Qtree SnapMirror.

Dataset

The name of the dataset to which the incoming data belongs

Destination The name of the hosting storage system on which the incoming data is being stored
Output Relationships tab
This tab displays information about systems that receive backup or mirror data from the hosting
storage system.
You can use this information to identify dependencies on a selected storage system before shutting
down the system for maintenance or to assess the impact of an outage.
Lag Status Indicates whether the lag threshold specified for the relationship has been or is about
to be exceeded.
Lag

The time elapsed since the last successful backup or mirror update

Source

The location of data on the system that is being backed up or mirrored to a secondary
system

Type

The type of relationship the system has with the selected storage system
Possible values are SnapVault, Volume SnapMirror, and Qtree SnapMirror.

Dataset

The name of the dataset to which the outgoing data belongs
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Destination The name of the destination system on which the outgoing data is being stored
Migration tab
This tab displays detailed information about the data migration of the datasets attached to the selected
vFiler unit.
Source storage
system

The name of the storage system from which the data is migrated

Destination
storage system

The name of the storage system into which the data is migrated

Migration
Status

The same migration status as in the vFiler units list section of this window

Dataset(s)
attached

The datasets to which the selected vFiler unit is attached

Physical
resources

The volumes in the dataset.

Lag

The length of time since the successful migration of data to the destination

Error

The error that occurred during a migration operation
The value None indicates that no migration-related error occurred.

State

The state of the volume, SnapVault relationship, or SnapMirror relationship
created during the migration
Uninitialized The destination storage volume or qtree is not yet initialized or
is being initialized.
Snapvaulted

The SnapVault relationship is created and the qtree is a
SnapVault secondary destination.

Mirrored

The destination volume or qtree is in a SnapMirror relationship.

Broken off

The destination was in a SnapMirror relationship, but a
snapmirror break command made the volume or qtree
writable.
This state is reported when the base Snapshot copy is still
present in the volume. If the Snapshot copy is deleted, the state
is reported as uninitialized while the destination is in the /etc/
snapmirror.conf file. The snapmirror resync command
restores the mirrored status.

Quiesced

SnapMirror is in a consistent internal state and no SnapMirror
activity is occurring.
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In this state, you can create Snapshot copies with confidence
that all destinations are consistent. The snapmirror quiesce
command brings the destination into this state. The
snapmirror resume command restarts all SnapMirror
activities.
Source

A snapvault status or snapmirror status command was executed
on the primary storage system.
When the destination is on another storage system, its status is
unknown and the NetApp Management Console provisioning
capability reports the status "source." This status is also
reported for SnapVault relationships when a snapvault
status command is executed on secondary storage systems
after the snapvault restore command was executed on an
associated primary storage system.

Unknown

The destination volume or the volume that contains the
destination qtree is in an unknown state.
It might be offline or restricted.

Restoring

SnapVault relationships are being restored.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Events window
You can use the Events window to monitor, acknowledge, and delete events.
•
•
•
•
•

Command buttons on page 372
View Events buttons on page 372
Events list on page 372
Details area on page 374
Window customization on page 374

Command buttons
Acknowledge Acknowledges the selected events; your user name and the time are entered in the
Event List for the selected events. When you acknowledge an event, you take
responsibility for managing that event.
Deletes the selected events from the Events summary list so that the deleted events
are not considered when calculating the status of a dataset, volume, and so on. To
view a list of deleted events, you can use the Operations Manager console interface.

Delete

View Events buttons
These filter buttons specify the range of events displayed in the events list.
1 Day

Displays events that occurred today.

1 Week

Displays events that occurred in the past seven days.

1 Month Displays events that occurred in the past 30 days.
All

Displays all events related to the NetApp Management Console client you are using.
Note: On very large or very busy systems, the Events window might be unresponsive
for long periods while loading 1 Month or All data. If NetApp Management Console
appears unresponsive for these large lists, you must select a shorter time period (such
as 1 Day).

Events list
Displays a list of the events that occurred. The list of events is updated dynamically, as events occur.
You can select an event to see the details for that event.
Note: You can download a maximum of 25,000 records in the list of events.
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Severity

Displays the severity type. The default events list includes this column, which
can be filtered to show a severity type and all severity types worse than the
selected one.
The severity types are as follows.
Unknown

The event is in an unknown transitory state.

Unmanaged The event source is not managed by the NetApp Management
Console data protection and provisioning capabilities. No
action is required.
Normal

A previous abnormal condition for the resource returned to a
normal state and the resource is operating within the desired
thresholds. No action is required.

Information A normal resource event occurred. No action is required.
Warning

The resource experienced an occurrence that you should be
aware of. This event severity does not cause service
disruption, and corrective action might not be required.

Error

The resource is still performing, but corrective action is
required to avoid service disruption.

Critical

A problem occurred that might lead to service disruption if
you do not take immediate corrective action.

Emergency

The resource unexpectedly stopped working and experienced
unrecoverable data loss. You must take corrective action
immediately to avoid extended downtime.

Event

Displays the event names. You can select an event to display the event details.
The default events list includes this column.

Triggered

Displays the time and date the event was generated. The default events list
includes this column.

Acknowledged
By

Displays the name of the user who acknowledged the event. The field is blank
if the event is not acknowledged. The default events list includes this column.

Acknowledged
Time

Displays the time the event was acknowledged. The field is blank if the event
is not acknowledged. The default events list includes this column.

Source

Displays the full object name that triggered the event. The default events list
includes this column.

Deleted By

Displays the user name that deleted the event. This column is not displayed by
default.

Deleted Time

Displays the time the event was deleted. This column is not displayed by
default.
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Details area
The area below the event list displays detailed information about the selected event, as follows:
Event

Displays the event name.

Source

Displays the full object name to which the event is associated.

Source Type

Displays the object type that triggered the event.

Severity

Displays the severity type of the event.

About

Displays the status of the counters.

Triggered

The time and date the event occurred.

Acknowledged

Whether the event was acknowledged and by whom.

Deleted

Whether the event was deleted from the Events list.

Condition

A description of the condition that triggered the event.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Alarms window
You can use the Alarms window to view, create, configure, and disable or enable alarms.
•
•
•
•

Command buttons on page 375
Alarms list on page 375
Details area on page 376
Window customization on page 377

Command buttons
Add

Starts the Add Alarm wizard, which enables you to add alarms.

Edit

Opens the Properties sheet for modifying the configuration of the selected alarm.

Delete

Deletes the selected alarm.

Test

Tests the selected alarm by sending a test notification to all the recipients.

Alarms list
Displays a list of the configured alarms.
Event

If the alarm is configured for a specific event, displays the event that triggered the alarm.
If the alarm is configured for an event class, displays the event class for which all events
that occur in that class trigger the alarm.

Severity If the alarm is configured for a severity type, displays the severity type that marks the
lowest severity level that triggers the alarm. The default alarms list includes this column.
You can filter the column display a severity type and all the severity types worse than the
selected one.
Unknown

The event is in an unknown transitory state.

Unmanaged or
worse

The event source is not managed by NetApp Management
Console. No action is required.

Information or
worse

A normal resource event occurred. No action is required.

Warning or worse

The resource experienced an occurrence that you should be
aware of. This event severity does not cause service disruption,
and corrective action might not be required.

Error or worse

The resource is still performing, but corrective action is
required to avoid service disruption.
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Group

Critical or worse

A problem occurred that might lead to service disruption if you
do not take immediate corrective action.

Emergency

The resource unexpectedly stopped working and experienced
unrecoverable data loss. You must take corrective action
immediately to avoid extended downtime.

Displays the resource group the alarm is associated with. The default group is Global.
You can associate an alarm with any resource group that is defined.

Enabled Displays whether the alarm is enabled. The default is Yes (enabled).
Details area
Displays detailed information about the selected alarm.
Event class Displays the class of events for which the alarm is configured. Event classes can only
be selected; they are defined using the NetApp Management Console data protection
capability, the NetApp Management Console provisioning capability, or Operations
Manager.
Repeat
Notify
(minutes)

Active
range

Specifies whether an alarm notification is repeated until the event is acknowledged
and how often the notification is repeated. The default is no repeat notification.
minutes value
displayed

Repeats the event notification at the interval specified,
until the event is acknowledged.

no minutes value
displayed

Event notification is sent only once and is not repeated.

Specifies the time during which the alarm can be triggered. If a specific event or an
event of a specified severity type occurs at a time at which the alarm is not active, no
event notification occurs. For example, you might want an event notification to occur
only when a specific administrator is available.
Start Specifies the time at which the alarm becomes active, based on the time
zone of the storage set to which the event notification applies.
Stop

Recipients

Specifies the time at which the alarm becomes inactive, based on the time
zone of the storage set to which the event notification applies.

Specifies where the event notification is to be sent.
E-mails

Administrators

Displays the email address of the administrators
who receive the event notification.
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Pagers

NonAdministrators

Displays the email addresses of users to which
the event notification is sent.

Administrators

Displays the pager email address of the
administrators who receive the event
notification.

NonAdministrators

Displays the pager email addresses of users to
which the event notification is sent.

Traps

Displays the servers that contain an SNMP trap listener to receive the
event notification.

Script

Script

Displays the full path name of a script that is executed
when an alarm occurs.

Run script as Displays the user name to be used to run the script.
For more information about SNMP traps, see the OnCommand Unified Manager
Operations Manager Administration Guide.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.

Related information

OnCommand Unified Manager Operations Manager Administration Guide - http://
support.netapp.com/NOW/knowledge/docs/DFM_win/dfm_index.shtml
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Configuring your dataset for disaster recovery
protection
Configure your dataset for disaster recovery protection by assigning a disaster recovery policy to it.
In this example, to meet data replication requirements, you decide to mirror the primary data to the
disaster recovery node and then back up the data to a tertiary node.
Before you begin

Before beginning this procedure, you need to install the SnapMirror license on all storage systems in
the primary and secondary storage nodes.
About this task

This procedure assumes that you are protecting a new dataset, but you can start at step two if your
dataset set is already protected with a backup policy and you want to change the policy to one that is
disaster recovery capable.
Steps

1. Create a disaster recovery capable dataset using the Add Dataset wizard.
The wizard prompts you to create a primary node and provision it.
2. In the Datasets window, select the dataset and click Protection Policy to start the Dataset Policy
Change wizard.
3. Complete the steps in the wizard to assign the DR mirror, then backup policy to the dataset.
Result

The dataset can support failover, and the Protection Dashboards window displays failover readiness
and failover status panels. The green banners indicate normal states for both.
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Standard protection or disaster recovery
protection of datasets
Configuration of datasets for disaster recovery protection is similar to configuration of datasets for
standard data protection. However, the features provided by disaster recovery protection require
some additional dataset configurations.
Provisioning policies assigned to secondary storage
If you want to assign an optional provisioning policy to your secondary node, you have the following
options:
•
•

In datasets with disaster recovery protection, you can assign either a NAS, SAN, or Secondary
storage type provisioning policy to the secondary storage disaster recovery node.
In datasets with standard protection, you can only assign a Secondary storage type provisioning
policy to the secondary node.
Note: In all cases, you can chose not to assign a storage policy and assign physical resources

directly to each node as was necessary in previous versions of the NetApp Management Console
data protection capability.
Exporting data to secondary storage
If you are configuring disaster recovery protection, you have the option to assign an export protocol
to the disaster recovery node so that in case of failover, users can access data in the disaster recovery
node using the same protocols they used to access data in the original primary node.
•

•

If you assign a provisioning policy for NAS or SAN type storage to the disaster recovery node,
you can also enable export protocols to access that data: CIFS and NFS for NAS type storage;
iSCSI and FibreChannel protocol for SAN type storage.
The NetApp Management Console provisioning capability also exports secondary storage
through a vFiler unit if a disaster recovery node is associated with a vFiler unit.
If you are only configuring standard protection, not disaster recovery protection, you cannot
enable export protocols on the secondary storage node through the NetApp Management Console
provisioning capability.

SnapVault and SnapMirror backup protection requirements
•

In datasets configured for disaster recovery backup protection, SnapMirror licenses on the
primary and disaster recovery node systems are required to support the backup operation. The
NetApp Management Console data protection capability configures underlying Qtree SnapMirror
relationships that support backup and failover processes between the primary and disaster
recovery nodes.
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•

In datasets configured for standard backup protection, either SnapVault or SnapMirror licenses on
the primary and secondary storage systems will support the backup operation.

Changes in the user interface
The NetApp Management Console provisioning capability user interface differentiates datasets
configured for standard protection and disaster recovery protection.
Policy graph

The policy graph for a protection policy that is capable of disaster recovery looks
similar to a policy graph for a regular protection policy, except that the disaster
recovery node is designated with a disaster recovery flag (
) to indicate the
ability of that node to take over primary data node functions if failover is invoked.

New
dashboard
windows

The NetApp Management Console data protection capability dashboard reports on
disaster recovery state and status to provide information at-a-glance that all is well
or that something needs attention. In this illustration, the Failover Readiness panel
and Failover Status panel use color, icons, and text to display the state and status
for datasets that are capable of disaster recovery. The colors and text vary
according to the status of the activity.

Policy wizards, Disaster Recovery tab, and the Policy Overview tab have tables that include a
disaster recovery column to indicate whether a policy supports disaster recovery.
The disaster recovery policy uses a policy icon (
dataset for disaster recovery.

) to indicate that, if applied, it will protect the
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What is the difference between a backup and a
disaster recovery backup relationship?
The main difference between protection policies with "Backup" and "DR Backup" (disaster recovery
backup) in their labels is that disaster recovery backup protection enables you to perform failover and
failback operations.
However, to ensure the ability to perform such operations, disaster recovery backup protection is
subject to limitations placed on its underlying transfer protocol.
•

•
•
•

Disaster recovery backup protection always requires underlying qtree SnapMirror (QSM)
relationships between containers in the primary node and containers in the secondary disaster
recovery node. SnapVault relationships are not supported.
All relationships created under disaster recovery backup protection are at the Qtree level.
You cannot add Open Systems SnapVault clients to datasets configured for disaster recovery
backup protection.
Aggregates, volumes, or qtrees that are members of a dataset configured for disaster recovery
protection cannot also be members of other datasets.
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What happens during failover
When you start the failover process, the NetApp Management Console data protection capability
breaks the SnapMirror relationship between the source storage containers in the primary data node
and their destination storage containers in the disaster recovery node and activates the disaster
recovery node containers as the active systems that can be accessed by users.
When you invoke failover, the NetApp Management Console provisioning capability puts the dataset
into "failing over" state and carries out the following processes.
1. Runs a failover script (if one is specified by the protection policy) to stop applications writing
data to the primary storage systems.
2. Quiesces all SnapMirror related activity between the primary storage systems and their partners
in the disaster recovery node.
3. Breaks all SnapMirror relationships between the primary storage systems and their partners in the
disaster recovery node.
4. Puts any mirrored LUNs in the online state.
5. Runs a failover script (if one is specified by the protection policy) to restart applications writing
data to the secondary systems in the disaster recovery node.
6. Enables the same export protocols (CIFS, NFS, iSCSI, or FC) for the containers in the disaster
recovery node as were enabled for the containers in the primary storage systems.
7. After the above processes are complete, changes the dataset out of failing over state.
If the above processes complete successfully, the dataset state is changed to "failed over." You can
now direct or re-map users to access their data from storage in the disaster recovery node.
If one of the above processes failed, the state is changed to "failover error."
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Disaster management options
If disaster or mishap jeopardizes the operation of your disaster recovery-capable primary node
storage systems, you can use status and event information to assess your backup, failover, or
restoration options.
Events

Path: Dashboards > Protection > Top Five Events or Notifications > Events
Look for: Hosts down or Volume offline events, which indicate conditions in
primary storage that might require failover to storage systems in the disaster
recovery node.

Storage
systems status

Path: Hosts > Storage Systems
Look for: Storage systems whose System Status column indicates that they are
down and might require failover to storage systems in the disaster recovery node.
button to filter for Down status.
Use the System Status column

Disaster
recovery
failover status

Path: Data > Datasets > Disaster Recovery

Disaster
recovery
failover lag
status

Path: Data > Datasets > Disaster Recovery

Failover
readiness

Path: Dashboards > Protection > Failover Readiness

Look for: The Failover Ready status in the Failover column of the listed disaster
recovery capable datasets.

Look for: In Failover Lag status column, whether the last successful backup of
primary node data to the disaster recovery node in the listed datasets is
satisfactorily current enough for you to invoke failover without a final update.

Look for: Normal status, which indicates that all disaster recovery capable
datasets are ready to undergo failover if necessary.
A Warning or Error status indicates that conditions exist in one or more of your
disaster recovery capable datasets that jeopardize successful failover.
Disaster
recovery job
progress

Path: Data > Datasets > Disaster Recovery > Jobs
Look for: Among other information, the last successful backup or mirror
operation (including time started) in a dataset.
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Recovery from disaster
In the aftermath of a disaster and successful failover, you can assess whether you need to restore
primary storage functions to the storage elements on the original primary node and if so, whether
those storage elements need data updated from the current functioning primary storage systems.
Possible recovery actions after failover include the following.
•

•

•

•

Make the successful failover target node into the new permanent primary storage system
Maintain the temporary primary storage systems in the disaster recovery node as the permanent
primary storage systems.
Reactivate the original primary node without updating
Reactivate and resume forward mirroring from the original primary node without updating its
original data.
Resynchronize to undamaged storage in original primary node
Resynchronize data from the disaster recovery node to the undamaged storage in the original
primary node.
Resynchronize to destroyed and replaced storage in original primary node
Resynchronize data from the disaster recovery node to the destroyed and replaced storage in the
original primary node.
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Failback options
After successful failover, one of your disaster recovery options is to fail back, updating and restoring
primary storage function to the original primary storage node, either to undestroyed volumes and
qtrees, or to replaced volumes and qtrees.
•

•

If you want to fail back to volumes or qtrees that remain undestroyed in the original primary data
node, follow the instructions in the help topic titled "Recovery by resynchronizing data to
undestroyed containers" in the disaster recovery help.
If you want to fail back to replaced volumes or qtrees in the original primary data node, follow
the instructions in the help topic titled "Recovery by resynchronizing data to replaced containers"
in the disaster recovery help.

Related tasks

Recovering by resynchronizing data to undestroyed containers on page 398
Recovering by resynchronizing data to replaced containers on page 401

386 | Provisioning and Data Protection Online Help

How do I back up data?
You can back up data from an entire host, or from individual aggregates, volumes, qtrees, virtual
machines, or directories on the host.
About this task

Complete the following steps to back up data. Following each step is one or more online help topics
that describe how to perform the step. For links to each online help topic, see the related links below.
For an example workflow of setting up data protection in the NetApp Management Console data
protection capability, see the OnCommand Unified Manager Guide to Common Workflows for 7Mode.
Steps

1. Add the host.
•
•
•
•

How hosts become visible to the console
Adding a storage system
Adding an Open Systems SnapVault (OSSV) host
Guidelines for adding and editing an Open Systems SnapVault host on an VMware ESX 3.5
server

2. Configure a resource pool.
•

Adding a resource pool

3. Choose a protection policy.
•

Adding a protection policy

4. Create additional schedules as needed.
•

Decisions to make before adding a schedule

5. Assign the schedules to the protection policy.
•

Assigning or changing schedules in a protection policy

6. Create one or more groups.
•

Adding groups

7. Create a dataset.
•

Adding a dataset

8. Attach the protection policy to the dataset.
•

Applying or changing the protection policy to a dataset

9. Verify the protection of the dataset.
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•

Where to find logs

10. Configure alarms.
•

Adding alarms

Related concepts

How hosts become visible to the console on page 247
Decisions to make before adding a protection policy on page 200
Where to view reports and logs on page 179
Related tasks

Adding a storage system on page 255
Adding an Open Systems SnapVault host on page 258
Adding a resource pool on page 165
Assigning or changing schedules in a protection policy on page 209
Adding groups on page 182
Adding a dataset of physical storage objects on page 99
Assigning or changing a protection policy on page 102
Adding alarms on page 48
Related references

Guidelines for adding and editing an Open Systems SnapVault host on an ESX server on page 257
Related information

Documentation on the NetApp Support Site: support.netapp.com
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Protect Now details
Where it is appropriate, The NetApp Management Console data protection capability retains the
backup copies according to the assigned protection policy's settings for the retention type that you
select (Hourly, Daily, Weekly, Monthly, or "Retain until deleted manually").
Note: In some cases, the mode of back up or an application-defined retention schedule renders the
retention type that you specify here inapplicable.

If you have applied a throttle schedule to the dataset, that schedule will also apply to the on-demand
back up.
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How the NetApp Management Console data
protection capability supports deduplication
Deduplication is the consolidation of blocks of duplicate data into single blocks to store more
information using less storage space. The NetApp Management Console data protection capability
supports protection of volumes on which deduplication is enabled.
You can configure your provisioning policies to enable deduplication in on-demand, automated, and
scheduled modes for your protected volumes and dataset nodes.
For more information about CLI implementation of deduplication, see Data ONTAP 7-Mode Data
Protection Online Backup and Recovery Guide.
Related concepts

What deduplication is on page 405
Related information

Data ONTAP Data Protection Online Backup and Recovery Guide - http://
support.netapp.com/NOW/knowledge/docs/ontap/ontap_index.shtml
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"Warn about overwrite and out-of-space
conditions on the destination" option
The "Warn about overwrite and out-of-space conditions on the destination" option configures the
Restore wizard to warn about file overwrite or out-of-space conditions during a file-level restore
from a storage system backup.
Note: This option enables warnings only for file-level restores from storage system backups.
Restore wizard does not issue warnings for volume-level restores, qtree-level restores, folder-level
restores, restores from Open Systems SnapVault backups, or restores from ESX server backups.
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What vFiler templates are
A vFiler template is a set of vFiler configuration settings, including the corresponding CIFS, DNS,
NIS, and administrative host configuration settings, that you want to use as default settings for one or
more vFiler units that you plan to add as hosts. You can configure as many vFiler templates as you
need.
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What a policy is
A policy is a set of rules that specifies the intended management of dataset members. You can apply
the same policy to multiple datasets, leveraging your configuration of the policy across the datasets.
If you update a policy, the update is propagated across all the datasets to which the policy is applied.
Different types of policies address different data management issues.
The data management applications and capabilities provide the following types of policies:
•
•
•
•

Protection without disaster recovery
Protection with disaster recovery
Provisioning
vFiler templates
Note: The data management policies used by applications and capabilities running in NetApp
Management Console should not be confused with other kinds of policies, such as the file policies
used in Data ONTAP.
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Adding alarms
You can add an alarm when you want immediate notification that a specified event or event class or
event of a specified severity level occurred.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Have the following information available to complete this task:
•
•
•
•
•

The resource group with which you want the alarm associated.
The event name, event class, or severity type that triggers the alarm.
Who and what you want the event notification sent to.
The time period during which the alarm is active.
Whether you want the event notification repeated until the event is acknowledged and how often
the notification should be repeated.

Steps

1. For protection, provisioning, or disaster recovery alarms, from the menu bar, click Notifications
> Alarms. For Performance Advisor alarms, from the menu bar, click the Set Up Alarms
window.
2. Click Add to start the Add Alarm wizard.
3. On each page of the wizard, enter the appropriate information.
4. Click Finish to commit your choices and close the Add Alarm wizard.
5. Verify the creation and configuration of the alarm by viewing the results that are displayed in the
Alarms window.
After you finish

You can edit the alarm properties from the Alarms window.
Related concepts

Decisions to make before adding an alarm on page 47
Related references

Alarm properties on page 44
Administrator roles and capabilities on page 54
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Administrator roles and capabilities
The administrator roles determine the tasks you can perform. You must specify one or more
capabilities for every role, and you can assign multiple capabilities if you want the administrator to
have more control than a specific role provides. You can also customize a set of default global roles
and create new roles as necessary.
Default and custom roles
The following table lists the default global roles, descriptions, and capabilities associated with the
role.
Administrator role

Role description

Capabilities

GlobalAlarm

You can manage alarms.

DFMAlarmDelete
DFMAlarmRead
DFMAlarmWrite

GlobalDelete

You can view, modify, or
delete information in the
management server database,
including groups and members
of a group, monitored objects,
custom views, and primary and
secondary storage systems.

DFMAlarmDelete
DFMDatabaseDelete
DFMReportDelete

GlobalEvent

You can view, acknowledge,
and delete events and alerts.

DFMAlarmDelete
DFMAlarmRead
DFMAlarmWrite
DFMEventGenerate
DFMEventRead
DFMEventWrite

GlobalExecute

You can execute commands on
the storage system.

DFMConsoleExecute
DFMDatabaseRead
DFMDatabaseWrite
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Administrator role

Role description

Capabilities

GlobalFullControl

You can view and perform any DFMCoreControl
operation on any object in the
DFMCoreDelegate
management server database
and configure administrator
accounts. You cannot apply this
role to accounts with group
access control.

GlobalRead

You can view the management
server database, backup and
provisioning configurations,
events and alerts, performance
data, and policies.

DFMAlarmRead
DFMCoreAccessCheck
DFMDatabaseRead
DFMEventRead
DFMReportRead

GlobalReport

You can manage custom
reports and report schedules.

DFMReportDelete
DFMReportRead
DFMReportWrite

GlobalQuota

You can view user quota
reports and events.

DFMQuotaFullControl

GlobalWrite

You can view user quota
reports and events.

DFMAlarmWrite
DFMDatabaseWrite
DFMEventGenerate
DFMEventWrite
DFMReportWrite
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Disaster recovery capable protection policies
Disaster recovery capable protection policies are data protection policies that support supplemental
primary-to-disaster recovery node failover instructions, which you can invoke if the primary node is
disabled or destroyed. Failover quickly transfers primary node functions and availability to your
disaster recovery node, allowing your users to continue to access and input data as if the original
primary node were still operating.
The NetApp Management Console data protection capability provides policy templates for you to use
to configure the following types of backup setups.
DR Back up

A dataset is backed up from primary storage to secondary storage on a disaster
recovery node. If disaster or mishap disables or destroys primary storage, secondary
storage takes over and provides primary storage availability.

DR Back up, A dataset is backed up from primary storage to secondary storage on a disaster
then mirror recovery node and from there mirrored to a tertiary node. If disaster or mishap
disables or destroys primary storage, secondary storage is enabled to take over and
provide primary storage function and availability.
DR Mirror,
then mirror

A dataset is mirrored from primary storage to secondary storage on the disaster
recovery node and from there mirrored again to a tertiary node. If disaster or
mishap disables or destroys primary storage, the mirrored storage on the disaster
recovery node is enabled to take over and provide primary storage function and
availability.

DR Mirror

A dataset is mirrored from primary storage to secondary storage on the disaster
recovery node. If disaster or mishap disables or destroys primary storage, the
mirrored storage on the disaster recovery node is enabled to take over and provide
primary storage function and availability.

DR Mirror
and back up

A dataset is mirrored from primary storage to secondary storage on the disaster
recovery node and is also backed up to secondary storage on a SnapVault or
SnapMirror storage system. If mishap or disaster disables or destroys primary
storage, the secondary storage on the disaster recovery node takes over and
provides primary storage availability.

DR Mirror
and mirror

A dataset is mirrored from primary storage to secondary storage on two different
SnapMirror partners. If mishap or disaster disables or destroys primary storage, the
SnapMirror partner in the disaster recovery node takes over and provides primary
storage function and availability.

DR Mirror, A dataset is mirrored from primary storage to secondary storage on the destination
then back up recovery node and from there backed up to tertiary storage on a SnapVault or
SnapMirror storage system. If mishap or disaster disables or destroys primary
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storage, the secondary storage in the destination recovery node takes over and
provides primary storage function and availability.
Related references

Protection policy types (not disaster recovery capable) on page 193
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Recovering by resynchronizing data to
undestroyed containers
After a successful failover, you can use the dfpm and dfdrm commands on the DataFabric Manager
server to restore primary storage function to your original undestroyed primary storage systems and
containers and update their data with the most recent changes made to their failover partners in the
disaster recovery node.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. Log in to the command line interface of the DataFabric Manager server that you are using
NetApp Management Console to manage.
2. In the command line interface, enter the command:
dfpm dataset list -R dataset_name

This step finds the secondary storage elements for all primary storage elements. SnapMirror
relationships that were broken during the failover are indicated by the "broken_off" state.
3. If your protection policy is based on the DR Mirror and Mirror node mapping, enter the
command:
dfdrm mirror break non_dr_obj1 non_dr_obj2 non_dr_obj3 non_dr_obj...

This command breaks the SnapMirror relationships between source volumes and qtrees in the
primary node and destination volumes and qtrees in the nondisaster recovery node.
Skip to Step 5.
4. If your protection policy is based on the DR Mirror then Mirror node mapping, enter the
command:
dfdrm mirror break tertiary_obj1 tertiary_obj2 tertiary_obj3
tertiary_obj...

This command breaks the SnapMirror relationships between source volumes and qtrees in the
disaster recovery node and destination volumes and qtrees in the tertiary node.
5. Enter the command:
dfdrm mirror resync -r dr_obj1 dr_obj2 dr_obj3 dr_obj...

This command temporarily reverses the original SnapMirror relationships (which updates the
original primary storage containers as SnapMirror destinations).
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In this command, dr_obj... is all volumes and qtrees in the disaster recovery node, now
serving as primary storage, that you want to temporarily configure as a SnapMirror sources.
Wait for all relationships to be in the "mirrored" state before continuing to the next Step.
6. Enter the command:
dfdrm mirror break original_obj1 original_obj2 original_obj3
original_obj...

This command quiesces and breaks the temporary reversed mirror relationships.
In this command, original_obj.. is all original primary objects that are temporarily
configured as SnapMirror destinations.
7. After you break the reversed mirror relationship, inspect the data on the original primary objects
to verify validity.
8. Enter the command:
dfdrm mirror resync -r original_obj1 original_obj2 original_obj3
original_obj...

This command resyncs the mirror copies to reestablish the original SnapMirror relationships (in
other words, to reverse the relationships back to forward mirror).
9. If your protection policy is based on the DR Mirror and Mirror node mapping, enter the
command:
dfdrm mirror resync non_dr_obj1 non_dr_obj2 non_dr_obj3 non_dr_obj...

This command resyncs the mirror copies to reestablish the original primary node to nondisaster
recovery secondary node SnapMirror relationships.
Skip to Step 11.
10. If your protection policy is based on the DR Mirror then Mirror node mapping, enter the
command:
dfdrm mirror resync tertiary_obj1 tertiary_obj2 tertiary_obj3
tertiary_obj...

This command resyncs the mirror copies to reestablish the original disaster recovery node to
tertiary node SnapMirror relationships.
11. Confirm the success of the resync operation by noting its job list ID output and entering the
command:
dfdrm job list joblist_id

If the job list command indicates a resync job failure, then reinitialize the mirror relationship
between each volume or qtree by using the command
dfdrm mirror initialize dr_obj tertiary_obj

12. Enter the command:
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dfpm dataset failover state dataset-name ready

This command sets the dataset disaster recovery state to ready.
Related references

Administrator roles and capabilities on page 54
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Recovering by resynchronizing data to replaced
containers
After a successful failover, you can use the dfpm and dfdrm commands on the DataFabric Manager
server to restore primary storage function to destroyed and replaced original primary storage
containers and resynchronize primary storage data with the most recent updates.
Before you begin

•

At the original primary storage site, confirm that the destroyed storage systems, aggregates,
volumes, and qtrees are replaced with containers of the same name, capacity, and configuration.
Note: Configure the replacement volumes in restricted (not online or offline) state.

•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Attention: You cannot perform this task on relationships for which the original source is a non-

qtree and the associated failed-over dataset uses the DR-Backup policy. However, you can perform
this task on all the other relationships in the failed-over dataset.
Steps

1. Log in to the command line interface of the DataFabric Manager server that you are using
NetApp Management Console to manage.
2. In the command line interface, enter the command:
dfpm dataset list -R dataset_name

This step finds the secondary storage elements for all primary storage elements. SnapMirror
relationships that were broken during the failover are indicated by the "broken_off" state.
3. Enter the command:
dfpm dataset list -m -M dataset_name

This step lists the missing (destroyed) containers in the specified dataset.
4. For each system on the missing container list, use FilerView or the Data ONTAP CLI to recreate
the missing aggregates, volumes, or qtrees.
Configure the replacement volumes with restricted (not online or offline) state.
5. If your disaster recovery protection policy is based on DR Mirror and Mirror node mappings,
enter the command:
dfdrm mirror delete non_dr_obj1

This step deletes the non-disaster recovery node mirror destination objects.
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6. Enter the command:
dfdrm mirror initialize dr_obj_name1 replaced_obj_name

This command creates a new SnapMirror relationship to the replacement volumes and qtrees in
the original primary node from their source partner volumes and qtrees in the disaster recovery
node. It temporarily configures the disaster recovery node volumes and qtrees as SnapMirror
source objects and the replacement volumes and qtrees as destination objects. It then copies the
updated data from the volumes and qtrees in the disaster recovery node to the replacement
volumes and qtrees in the original primary node.
Note: Because you cannot create a SnapMirror relationship to a replacement aggregate, use
this command to create SnapMirror relationships to that aggregate's child volumes instead.

7. Repeat Step 6 for each disaster recovery node volume or qtree that has a replacement volume or
qtree.
8. After the mirror initialize operations are complete, enter the command:
dfdrm mirror quiesce replaced_obj1 replaced_obj2 replaced_obj3
replaced_obj...

This step quiesces these new mirror relationships prior to breaking and reversing them. In this
command, replaced_obj.. is all the replacement containers that you have just updated.
9. Enter the command:
dfdrm mirror break replaced_obj1 replaced_obj2 replaced_obj3
replaced_obj...

This command breaks the current mirror relationships prior to reversing them.
10. After you break the mirror relationship, inspect the data on the original primary objects to verify
validity.
11. Enter the command:
dfdrm mirror resync -r replaced_obj1replaced_obj2
replaced_obj3replaced_obj...

to reverse the mirror relationship.
This action establishes the replacement volumes and qtrees as the primary storage containers and
the volumes and qtrees in the disaster recovery node as the SnapMirror destination objects.
12. If your disaster recovery protection policy is based on DR Mirror and Mirror node mappings,
enter the command:
dfdrm mirror initialize replaced_obj...non_dr_obj...

This command creates a new SnapMirror relationship between the replacement volumes and
qtrees in the original primary node and their partner volumes and qtrees in the non-disaster
recovery node. It temporarily configures the disaster recovery node volumes and qtrees as
SnapMirror source objects and the replacement volumes and qtrees as destination objects.
Repeat this command for each replaced volume or qtree in the primary node.
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13. If your disaster recovery policy is based on DR Mirror and Mirror node mappings, enter the
command:
dfdrm mirror resyncnon_dr_obj1non_dr_obj2non_dr_obj..non_dr_obj3

This command updates the empty volumes and qtrees in the non-disaster recovery node with data
from their replaced partners in the primary node. In this command, non_dr_obj... is all the
volumes and qtrees in the non-disaster recovery node that you want to update.
Wait for all relationships to be in the "mirrored" state.
14. Enter the command:
dfpm dataset replace dataset-name

This command replaces the dataset reference to old primary volumes and qtrees with replaced
volumes and qtrees.
Note: This step carries out replacement of old with new volume and qtree references only. To
replace old with new aggregate references in the failed back dataset, see the next step.

15. If the failed-back dataset originally included aggregates, complete the following commands to
add reference to the replacement aggregates and delete reference to their child volumes in the
failed-back dataset.
Even though the failed aggregate was destroyed and replaced, you still need to complete the
following steps to reference the replacement aggregate in the failed-back dataset.
a) Enter the command:
dfpm dataset list -m dataset_name

This command lists the child members (volumes or qtrees) of the replacement aggregate.
b) Enter the command:
dfpm dataset remove dataset_name child_obj

.
This command removes reference to the child members of the replacement aggregates from
this dataset.
Even though references to the child replacement volumes are removed from the dataset, the
SnapMirror relationships and operations between these replacement volumes and their
disaster recovery node mirrors remain intact.
c) Enter the command:
dfm aggr list storage_system

This command lists the replacement aggregate at the primary site.
d) Enter the command:
dfpm dataset add dataset_name replacement_aggr

This command adds the replacement aggregate to the failed back dataset.
e) Enter the command:
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dfpm dataset list -m dataset_name

This command confirms the addition of the replacement aggregate to this dataset by
generating a list of the dataset contents.
16. Enter the command:
dfpm dataset list -R dataset_name

This step confirms the disaster recovery relationship between the replacement child volumes and
their destinations in the disaster recovery node.
17. Enter the command:
dfpm dataset failover state dataset_name ready

This step sets the dataset disaster recovery state to ready.
Related references

Administrator roles and capabilities on page 54
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What deduplication is
Deduplication is the NetApp Management Console provisioning capability option that you can
enable on your storage nodes to eliminate duplicate data blocks to reduce the amount of storage
space used to store active data.
You can enable your provisioning policies to support three modes of deduplication.
On-demand
deduplication

On-demand deduplication is executed on a selected volume that is enabled for
deduplication when you click the Dedupe Now button on your Provisioning
tab.

Automated

Automated deduplication, if enabled on a dataset node, is run automatically on
any volume in that node when the amount of new data written to that volume
reaches 20%.

Scheduled
deduplication

Scheduled deduplication, if enabled on a dataset node, is run automatically on
the volumes in that node on the days of the week, during a particular time
period, and at a frequency that you have specified.
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List of events and severity types
You should be aware of all the events generated by the NetApp Management Console data protection
and provisioning capabilities and Operations Manager and the associated event severity types.
You can use the links in the following table to move directly to the events for that object. Events are
listed in alphabetical order by object type.
Note: Performance Advisor uses only the Normal and Error events.
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Event categories

High Availability
Configuration Controller on
page 407
High Availability
Configuration Interconnect on
page 408
High Availability
Configuration Partner on page
408
Agent on page 408
Aggregate on page 409
Alarm on page 409
CFO Interconnect on page 410
CFO Partner on page 410
CFO Settings on page 410
Cluster on page 410
Cluster Port on page 411
Comment Field on page 411
Configuration Changed on page
411
CPU on page 411
Data Protection on page 411
Database on page 412
Dataset on page 412
Dataset Backup on page 413
Dataset Conformance on page
413
Disks on page 414
Enclosures on page 414

Fibre Channel Switch Port on
page 415
Fans on page 414
Filer Configuration on page
415
Global Status on page 415
HA State on page 415
HBA Port on page 416
Host on page 416
Host Agent on page 417
Inodes on page 417
Interface Status on page 417
Logical Interface on page 417
LUN on page 417
Management Station on page
418
Migration on page 418
NDMP on page 419
Network on page 419
Network Services on page 419
No Schedule Conflict on page
420
NVRAM Battery on page 420
OSSV on page 420
Performance Advisor on page
420
Power Supplies on page 421
Primary on page 421

HA configuration Controller
Event name

Severity

Can Take Over

Normal

Cannot Takeover

Error

Dead

Critical

Protection Policy on page 421
Protection Schedule on page
421
Provisioning Policy on page
421
Qtree on page 422
RPM on page 422
Resource Group on page 422
Resource Pool on page 422
SAN Host LUN on page 423
Script on page 423
SnapMirror on page 423
Snapshot(s) on page 424
SnapVault on page 425
SNMP Trap Listener on page
426
Space Management on page
426
Storage Services on page 426
Sync on page 427
Temperature on page 427
Unprotected Item on page 427
User on page 427
vFiler Unit on page 428
vFiler Unit Template on page
428
Vserver on page 428
Volume on page 429
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Event name

Severity

Takeover

Warning

HA configuration Interconnect
Event name

Severity

Down

Error

Not Present

Warning

Partial Failure

Error

Up

Normal

HA configuration Partner
Event name

Severity

Dead

Warning

May Be Down

Warning

OK

Normal

HA configuration Settings
Event name

Severity

Disabled

Normal

Enabled

Normal

Not Configured

Normal

Takeover Disabled

Normal

This Controller Dead

Warning

Agent
Event name

Severity

Down

Error

Login Failed

Warning

Login OK

Normal

Up

Normal
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Aggregate
Event name

Severity

64-bit Upgrade

Information

Almost Full

Warning

Almost Overcommitted

Warning

Deleted

Information

Discovered

Information

Failed

Error

Full

Error

Nearly Over Deduplicated

Warning

Not Over Deduplicated

Normal

Not Overcommitted

Normal

Offline

Error

Online

Normal

Overcommitted

Error

Over Deduplicated

Error

Restricted

Normal

Snapshot Reserve Almost Full

Warning

Snapshot Reserve Full

Warning

Snapshot Reserve OK

Normal

Space Normal

Normal

Alarm
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Test

Information

410 | Provisioning and Data Protection Online Help
CFO Interconnect
Event name

Severity

Down

Error

Not Present

Warning

Partial Failure

Error

Up

Normal

CFO Partner
Event name

Severity

Dead

Warning

May Be Down

Warning

OK

Normal

CFO Settings
Event name

Severity

Disabled

Normal

Enabled

Normal

Not Configured

Normal

Takeover Disabled

Normal

This Node Dead

Warning

Cluster
Event name

Severity

Cluster Discovered

Information

Cluster Reachable

Normal

Cluster Not Reachable

Critical

Cluster Renamed

Information

Cluster Node Added

Information

Cluster Node Removed

Information
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Cluster Port
Event name

Severity

Port Status Up

Normal

Port Status Down

Error

Port Status Undefined

Normal

Port Status Unknown

Normal

Port Role Changed

Information

Comment Field
Event name

Severity

Created

Information

Modified

Information

Destroyed

Information

Configuration Changed
Event name

Severity

Config Group

Information

CPU
Event name

Severity

Load Normal

Normal

Too Busy

Warning

Data Protection
Event name

Severity

Job Started

Information

Policy Created

Information

Policy Modified

Information

Schedule Created

Information

Schedule Modified

Information
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Database
Event name

Severity

Backup Failed

Error

Backup Succeeded

Information

Restore Failed

Error

Restore Succeeded

Information

Dataset
Event name

Severity

Backup Aborted

Warning

Backup Completed

Normal

Backup Deleted

Information

Backup Failed

Error

Backup Prematurely Deleted

Warning

Created

Information

Deleted

Information

DR State Ready

Information

DR State Failover Over

Warning

DR State Failed Over

Information

DR State Failover Error

Error

DR Status Normal

Information

DR Status Warning

Warning

DR Status Error

Error

Initializing

Information

Job Failure

Warning

Member Clone Snapshot Discovered

Information

Member Clone Snapshot Status OK

Information

Member Dedupe Operation Failed

Error

Member Dedupe Operation Succeeded

Normal
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Event name

Severity

Member Destroyed

Information

Member Destroy Operation Failed

Information

Member Resized

Information

Member Resize Operation Failed

Information

Modified

Information

Protected

Normal

Protection Failed

Error

Protection Lag Error

Error

Protection Lag Warning

Warning

Protection Suspended

Warning

Protection Uninitialized

Normal

Provisioning Failed

Error

Provisioning OK

Normal

Space Status: Normal

Normal

Space Status: Warning

Warning

Space Status: Error

Error

Write Guarantee Check - Member Resize Required

Warning

Write Guarantee Check - Member Size OK

Normal

Dataset Backup
Event name

Severity

Dataset Backup: Deleted

Information

Dataset Backup: Prematurely Deleted

Warning

Dataset Conformance
Event name

Severity

Conformant

Normal

Conforming

Information
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Event name

Severity

Initializing

Information

Nonconformant

Warning

Disks
Event name

Severity

No Spares

Warning

None Failed

Normal

None Reconstructing

Normal

Owner changed

Warning

Some Failed

Error

Some Reconstructing

Warning

Spares Available

Normal

Enclosures
Event name

Severity

Active

Information

Disappeared

Warning

Failed

Error

Found

Normal

Inactive

Warning

OK

Normal

Fans
Event name

Severity

Many Failed

Error

Normal

Normal

One Failed

Error
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FC (Fibre Channel) Switch Port
Event name

Severity

Faulty

Error

Offline

Warning

Online

Normal

Filer Configuration
Event name

Severity

Changed

Warning

OK

Normal

Push Error

Warning

Push OK

Normal

Global Status
Event name

Severity

Critical

Critical

Non Critical

Error

Non Recoverable

Emergency

OK

Normal

Other

Warning

Unknown

Warning

HA State
Event name

Severity

Can Take Over

Normal

Cannot Take Over

Error

Dead

Critical

Takeover

Warning
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HBA Port
Event name

Severity

Offline

Warning

Online

Normal

Port Error

Error

Traffic High

Warning

Traffic OK

Normal

Host
Event name

Severity

Cluster Configuration Error

Error

Cluster Configuration OK

Normal

Cold Start

Information

Deleted

Information

Discovered

Information

Down

Critical

Identity Conflict

Warning

Identity OK

Normal

Login Failed

Warning

Login OK

Normal

Modified

Information

Name Changed

Information

SNMP Not Responding

Warning

SNMP OK

Normal

System ID Changed

Information

Up

Normal
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Host Agent
Event name

Severity

Down

Error

Up

Normal

Host Agent: Login Failed

Warning

Inodes
Event name

Severity

Almost Full

Warning

Full

Error

Utilization Normal

Normal

Interface Status
Event name

Severity

Down

Error

Testing

Normal

Unknown

Normal

Up

Normal

Logical Interface
Event name

Severity

Logical Interface Status Up

Normal

Logical Interface Status Down

Error

Logical Interface Status Unknown

Normal

Logical Interface Migrated

Warning

LUN
Event name

Severity

Offline

Warning

Online

Normal
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Event name

Severity

Snapshot Not Possible

Warning

Snapshot Possible

Normal

Management Station
Event name

Severity

Enough Free Space

Normal

File System File Size Limit Reached

Error

License Expired

Error

License Nearly Expired

Warning

License Not Expired

Normal

Load OK

Normal

Load Too High

Warning

Node Limit Nearly Reached

Warning

Node Limit OK

Normal

Node Limit Reached

Error

Not Enough Free Space

Error

Provisioning Manager Node Limit Nearly Reached

Warning

Provisioning Manager Node Limit Ok

Normal

Provisioning Manager Node Limit Reached

Error

Protection Manager Node Limit Nearly Reached

Warning

Protection Manager Node Limit Ok

Normal

Protection Manager Node Limit Reached

Error

Migration
Event name

Severity

Dataset Not Migrating

Normal

Dataset Migrating

Normal

Dataset Migrated With Errors

Warning
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Event name

Severity

Dataset Migrated

Normal

Dataset Migrate Failed

Error

vFiler Unit Not Migrating

Normal

vFiler Unit Migrating

Normal

vFiler Unit Migrated With Errors

Warning

vFiler Unit Migrated

Normal

vFiler Unit Migrate Failed

Error

NDMP
Event name

Severity

Credentials Authentication Failed

Warning

Credentials Authentication Succeeded

Normal

Communication Initialization Failed

Warning

Communication Initialization Succeeded

Normal

Down

Warning

Up

Normal

Network
Event name

Severity

OK

Normal

Too Large

Warning

Network Services
Event name

Severity

CIFS Service - Up

Normal

CIFS Service - Down

Warning

NFS Service - Up

Normal

NFS Service - Down

Warning
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Event name

Severity

iSCSI Service - Up

Normal

iSCSI Service - Down

Warning

FCP Service - Up

Normal

FCP Service - Down

Warning

No Schedule Conflict
Event name

Severity

Between Snapshot and SnapMirror Schedules

Normal

Between Snapshot and SnapVault Schedules

Normal

NVRAM Battery
Event name

Severity

Discharged

Error

Fully Charged

Normal

Low

Warning

Missing

Error

Normal

Normal

Old

Warning

Overcharged

Warning

Replace

Error

Unknown Status

Warning

OSSV (Open Systems SnapVault)
Event name

Severity

Host Discovered

Information

Performance Advisor
Event name

Severity

Enough Free Space

Normal
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Event name

Severity

Not Enough Free Space

Error

Power Supplies
Event name

Severity

Many Failed

Error

Normal

Normal

One Failed

Error

Primary
Event name

Severity

Host Discovered

Information

Protection Policy
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Protection Schedule
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Provisioning Policy
Event name

Severity

Created

Information

Deleted

Information

Modified

Information
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Qtree
Event name

Severity

Almost Full

Warning

Files Almost Full

Warning

Files Full

Error

Files Utilization Normal

Normal

Full

Error

Growth Rate Abnormal

Warning

Growth Rate OK

Information

Space Normal

Normal

Remote Platform Management (RPM)
Event name

Severity

Online

Normal

Unavailable

Critical

Resource Group
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Resource Pool
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Space Full

Error

Space Nearly Full

Warning
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Event name

Severity

Space OK

Normal

SAN Host LUN Mapping
Event name

Severity

Changed

Warning

Script
Event name

Severity

Critical Event

Critical

Emergency Event

Emergency

Error Event

Error

Information Event

Information

Normal Event

Normal

Warning Event

Warning

SnapMirror
Event name

Severity

Abort Completed

Normal

Abort Failed

Error

Break Completed

Normal

Break Failed

Error

Date OK

Normal

Delete Aborted

Warning

Delete Completed

Information

Delete Failed

Error

Deleted

Information

Discovered

Information

Initialize Aborted

Warning
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Event name

Severity

Initialize Completed

Normal

Initialize Failed

Error

Modified

Information

Nearly Out of Date

Warning

Not Scheduled

Normal

Not Working

Error

Off

Normal

Out of Date

Error

Possible Problem

Warning

Quiesce Aborted

Warning

Quiesce Completed

Normal

Quiesce Failed

Error

Resume Completed

Normal

Resume Failed

Error

Resync Aborted

Warning

Resync Completed

Normal

Resync Failed

Error

Unknown State

Warning

Update Aborted

Warning

Update Completed

Normal

Update Failed

Error

Working

Normal

Snapshot(s)
Event name

Severity

Age Normal

Normal

Age Too Old

Warning

Count Normal

Normal
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Event name

Severity

Count OK

Normal

Count Too Many

Error

Created

Normal

Failed

Error

Full

Warning

Schedule Conflicts with the SnapMirror Schedule

Warning

Schedule Conflicts with the SnapVault Schedule

Warning

Schedule Modified

Information

Scheduled Snapshots Disabled

Information

Scheduled Snapshots Enabled

Normal

Space OK

Normal

SnapVault
Event name

Severity

Backup Aborted

Warning

Backup Completed

Information

Backup Failed

Error

Host Discovered

Information

Relationship Create Aborted

Warning

Relationship Create Completed

Information

Relationship Create Failed

Error

Relationship Delete Aborted

Warning

Relationship Delete Completed

Information

Relationship Delete Failed

Error

Relationship Discovered

Information

Relationship Modified

Information

Replica Date OK

Normal

Replica Nearly Out of Date

Warning
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Event name

Severity

Replica Out of Date

Error

Restore Aborted

Warning

Restore Completed

Normal

Restore Failed

Error

SNMP Trap Listener
Event name

Severity

Alert Trap Received

Information

Critical Trap Received

Information

Emergency Trap Received

Information

Error Trap Received

Information

Information Trap Received

Information

Notification Trap Received

Information

Warning Trap Received

Information

Start Failed

Warning

Start OK

Information

Space Management
Event name

Severity

Space Management Job Started

Information

Space Management Job Succeeded

Information

Space Management Job Failed

Information

Storage Services
Event name

Severity

Storage Service Created

Information

Storage Service Modified

Information

Storage Service Destroyed

Information
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Event name

Severity

Storage Service Dataset Provisioned

Information

Storage Service Dataset Attached

Information

Storage Service Dataset Detached

Information

Sync
Event name

Severity

SnapMirror In Sync

Information

SnapMirror Out of Sync

Warning

Temperature
Event name

Severity

Hot

Critical

Normal

Normal

Unprotected Item
Event name

Severity

Discovered

Information

User
Event name

Severity

Disk Space Quota Almost Full

Warning

Disk Space Quota Full

Error

Disk Space Quota OK

Normal

Disk Space Soft Limit Exceeded

Warning

Disk Space Soft Limit Not Exceeded

Normal

E-mail Address OK

Normal

E-mail Address Rejected

Warning

Files Quota Almost Full

Warning

Files Quota Full

Error
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Event name

Severity

Files Quota Utilization Normal

Normal

Files Soft Limit Exceeded

Warning

Files Soft Limit Not Exceeded

Normal

vFiler Unit
Event name

Severity

Deleted

Information

Discovered

Information

Hosting Storage System Login Failed

Warning

IP Address Added

Information

IP Address Removed

Information

Renamed

Information

Storage Unit Added

Information

Storage Unit Removed

Information

vFiler Unit Template
Event name

Severity

Created

Information

Deleted

Information

Modified

Information

Vserver
Event name

Severity

Vserver Discovered

Information

Vserver Deleted

Information

Vserver Renamed

Information

Vserver Status Down

Error

Vserver Status Up

Normal
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Volume
Event name

Severity

Almost Full

Warning

Automatically Deleted

Information

Clone Deleted

Information

Clone Discovered

Information

Destroyed

Information

First Snapshot OK

Normal

Full

Error

Growth Rate Abnormal

Warning

Growth Rate OK

Normal

Maxdirsize Limit Nearly Reached

Information

Maxdirsize Limit Reached

Information

Nearly No Space for First Snapshot

Warning

Nearly Over Deduplicated

Warning

New Snapshot

Normal

Next Snapshot Not Possible

Warning

Next Snapshot Possible

Normal

No Space for First Snapshot

Warning

Not Over Deduplicated

Normal

Offline

Warning

Offline or Destroyed

Warning

Online

Normal

Over Deduplicated

Error

Quota Almost Overcommitted

Warning

Quota Overcommitted

Error

Restricted

Normal

Snapshot Deleted

Normal

Space Normal

Normal
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Event name

Severity

Space Reserve Depleted

Error

Space Reserve Nearly Depleted

Warning

Space Reserve OK

Normal

Related references

Descriptions of severity types on page 15
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Disaster Recovery Help
About disaster recovery protection
The disaster recovery feature ensures that if disaster or other circumstance make critical protected
data at your primary storage sites unavailable to your users, that you can quickly provide those users
access to the backed up or mirrored copy of that data through your secondary storage sites.
Note: The NetApp Management Console data protection capability provides disaster recovery

protection of data handled by vFiler units; however, it does not support disaster recovery
protection as implemented by the Data ONTAP vFiler DR feature.

What disaster recovery protection is
Disaster recovery protection enables your secondary storage systems to provide primary data storage
access to your users with little or no interruption, until your disabled primary storage systems are
reenabled or replaced.
You can use either the NetApp Management Console data protection capability or Data ONTAP to
manage disaster recovery of vFiler units, but not both.
Attention: If you intend to use the disaster recovery capability in the NetApp Management

Console, do not add to datasets any vFiler units that were created outside of NetApp Management
Console if the vFiler is configured for Data ONTAP vFiler DR. Adding such vFiler units to
datasets could result in SnapVault relationships for identically named qtrees being incorrectly
removed during a disaster recovery event.

When you use disaster recovery
If a mishap or disaster disables or destroys the storage systems at a primary storage site, you can
invoke a failover process that breaks the SnapMirror relationship between the primary and secondary
partners and transfers primary storage site functions (including continued user access) to the mirror
partners at the secondary storage site.
In a typical disaster recovery protection implementation, the storage systems at the primary storage
site use underlying SnapMirror processes to maintain recent Snapshot copies and active copies of
their data. These copies are located on SnapMirror partners at a secondary site that is located a safe
distance from the primary storage site.
With sufficient warning of an impending event that threatens the primary storage site, the
administrator can invoke a final Snapshot copy transfer from the primary site to the secondary
storage site and can monitor the entire system for failover readiness in case there needs to be failover.
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Recovery strategies after failover
After storage systems at the original primary storage site are reenabled or replaced, you can
implement one of the available recovery strategies.
•
•
•

Resume forward mirroring from the original primary storage site, using the data still available at
that site.
Complete offline restoration of updated data from the failover site to the original primary storage
site and then resume forward mirroring.
Use the command-line interface to fail back primary storage site function from the failover site to
the original site, with little off-line time.

Overview of disaster recovery protection operations
Disaster recovery protection consists of one or more tasks.
•
•
•
•
•
•
•
•
•

Configure disaster recovery capable protection policies.
Assign disaster recovery capable protection policies to datasets.
Test disaster recovery capable protection policies.
Author optional failover scripts for managing data application tasks before and after
the SnapMirror relationship break.
Monitor primary and secondary storage for failover readiness.
Update secondary storage in preparation for failover.
In case of emergency, assess appropriate disaster recovery protection measures to implement.
In case of emergency, perform and monitor failover operations.
If necessary, perform failback recovery operations.

Disaster recovery concepts
It is helpful to have an understanding of the basic disaster recovery concepts.
The implementation of disaster recovery protection using the NetApp Management Console data
protection capability relies on the following concepts:
Failover

An automated process which, when invoked, transfers primary storage
capability and accessibility from threatened, disabled, or destroyed storage
systems in a primary node to secondary storage systems in the disaster recovery
node.

Failback

Command-line based procedures that restore primary storage function to the
original primary storage site after its storage systems are reenabled or replaced.

Describes a dataset that is configured with the protection policies and
Disaster
recovery capable provisioned with the primary storage and secondary storage resources to support
disaster recovery protection.
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Disaster
recovery node

The dataset secondary storage node that is configured to also provide failover
primary storage access to users in the event of mishap or disaster making the
original primary storage systems unavailable.

Disaster
recovery
relationship

The type of data protection and failover procedures configured between the
primary storage and secondary storage systems (in the disaster recovery node),
and between the secondary storage systems and any tertiary storage systems.

Qtree
SnapMirror

The technology that supports qtree-to-qtree disaster recovery capable backup
relationships using the NetApp Management Console data protection capability
and possible failover operations between primary storage systems and
secondary storage systems. In disaster recovery protection policies, secondary
storage is located in the disaster recovery node.

Volume
SnapMirror

The technology that supports volume-to-volume disaster recovery capable
mirror relationships managed by the NetApp Management Console data
protection capability and possible failover operations between primary storage
and secondary storage systems. In disaster recovery protection policies,
secondary storage is located in the disaster recovery node.

SnapMirror
relationship
break

The automated event during failover that breaks the SnapMirror relationship
between primary storage and secondary storage in the disaster recovery node.

Failover state

Dashboard status in NetApp Management Console that indicates the progress
and success of a failover operation if the failover process is invoked. Possible
states include: Ready, Failing over, Failed over, and Failover Error.

Failover
readiness

Dashboard status in NetApp Management Console that indicates the readiness
of the managed datasets to successfully carry out failover operations.

Failover script

An optional user-authored script that specifies data application-related
operations that might need to be performed before and after the failover invoked
SnapMirror relationship break between primary storage and secondary storage
in the disaster recovery node.

Rebaselining

The protection backup or mirroring of data by the transfer or copy of the entire
body of data from primary to secondary or secondary to tertiary storage. All
initial backup or mirror operations from primary to secondary or secondary to
tertiary storage are baseline operations and can be quite lengthy. Succeeding
backup or mirror operations can be incremental, involving only the transfer
from source to destination that has changed since the last backup or mirror
operation. When assigning a new protection policy (disaster recovery capable or
not) after a disaster and successful failover, the most preferable choice might be
to assign and set up a protection policy that minimizes rebaselining of data in
the primary, secondary, and tertiary storage.
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Disaster recovery capable protection policies
Disaster recovery capable protection policies are data protection policies that support supplemental
primary-to-disaster recovery node failover instructions, which you can invoke if the primary node is
disabled or destroyed. Failover quickly transfers primary node functions and availability to your
disaster recovery node, allowing your users to continue to access and input data as if the original
primary node were still operating.
The NetApp Management Console data protection capability provides policy templates for you to use
to configure the following types of backup setups.
DR Back up

A dataset is backed up from primary storage to secondary storage on a disaster
recovery node. If disaster or mishap disables or destroys primary storage, secondary
storage takes over and provides primary storage availability.

DR Back up, A dataset is backed up from primary storage to secondary storage on a disaster
then mirror recovery node and from there mirrored to a tertiary node. If disaster or mishap
disables or destroys primary storage, secondary storage is enabled to take over and
provide primary storage function and availability.
DR Mirror,
then mirror

A dataset is mirrored from primary storage to secondary storage on the disaster
recovery node and from there mirrored again to a tertiary node. If disaster or
mishap disables or destroys primary storage, the mirrored storage on the disaster
recovery node is enabled to take over and provide primary storage function and
availability.

DR Mirror

A dataset is mirrored from primary storage to secondary storage on the disaster
recovery node. If disaster or mishap disables or destroys primary storage, the
mirrored storage on the disaster recovery node is enabled to take over and provide
primary storage function and availability.

DR Mirror
and back up

A dataset is mirrored from primary storage to secondary storage on the disaster
recovery node and is also backed up to secondary storage on a SnapVault or
SnapMirror storage system. If mishap or disaster disables or destroys primary
storage, the secondary storage on the disaster recovery node takes over and
provides primary storage availability.

DR Mirror
and mirror

A dataset is mirrored from primary storage to secondary storage on two different
SnapMirror partners. If mishap or disaster disables or destroys primary storage, the
SnapMirror partner in the disaster recovery node takes over and provides primary
storage function and availability.

DR Mirror, A dataset is mirrored from primary storage to secondary storage on the destination
then back up recovery node and from there backed up to tertiary storage on a SnapVault or
SnapMirror storage system. If mishap or disaster disables or destroys primary
storage, the secondary storage in the destination recovery node takes over and
provides primary storage function and availability.
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Related references

Protection policy types (not disaster recovery capable) on page 193

Protection policy node prerequisites
Before you attempt to implement a protection policy on your dataset nodes, ensure that the storage
systems in the datasets or physical resource pools that make up that node meet the correct
configuration and licensing requirements.
•

•

•

Storage that is the source of a backup connection (to a NetApp storage system not disaster
recovery capable)
•

Configuration requirements are either of the following:

•

• Volume, qtree, or OSSV directory if it is not an application dataset
• A host, aggregate, or volume containing one of the above
Storage system licensing requirements are either of the following:

• SnapMirror
• SnapVault Data ONTAP Primary (for remote backup protection)
Storage that is the source of a backup connection configured for nondisruptive LUN restore (to a
NetApp storage system not disaster recovery capable)
•

Configuration requirements are either of the following:

•

• Volume or qtree
• A host, aggregate, or volume containing one of the above
Storage system licensing requires both of the following:

• Data ONTAP Primary
• Data ONTAP 7.3 or later
Storage that is the source of a disaster recovery capable backup connection (to a NetApp storage
system)
•

Configuration requirements are all of the following:

•

Qtree, volume (possibly containing qtrees), aggregate (possibly containing volumes) or an
entire storage unit (possibly containing aggregates or volumes)
• Dataset not configured for non-disruptive LUN restore
• Storage system licensing requirements: SnapMirror
Storage that is the source of a backup connection (Open System)

•

• Configuration requirements: Open Systems SnapVault directory
• Storage system licensing requirements: Open Systems SnapVault client
Storage that is the destination of a backup connection (not disaster recovery capable)

•

•

Configuration requirements are either of the following:
•
•

Volume
Qtree
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•

• Storage system or aggregate containing volumes and qtrees
Storage system licensing requirements are either of the following:
•
•

•

SnapMirror
SnapVault Data ONTAP Secondary (for remote backup protection)
If the source is Windows, Linux, or UNIX, then SnapVault Windows, SnapVault Linux, or
SnapVault UNIX is also required.
Storage that is the destination of a backup connection configured for nondisruptive LUN restore
(not disaster recovery capable)
•

Configuration requirements are either of the following:
•
•

•

•

Qtree or volume
Storage system or aggregate containing volumes and qtrees. Provisioning policy type
(SAN or NAS) matches primary provisioning policy type or does not export storage.
Storage system licensing requirements are all of the following:

• SnapVault
• Data ONTAP Secondary
• Data ONTAP 7.3 or later
Storage that is the destination of a disaster recovery capable backup connection (to a disaster
recovery node)
•

•

Configuration requirements:
Volume (possibly containing qtrees), aggregate (possibly containing volumes) or an entire
storage unit (possibly containing aggregates or volumes). No qtree on same storage system as
the primary qtree. Provisioning policy type (SAN or NAS) matches primary provisioning
policy type.
• Storage system licensing requirements: SnapMirror
Storage that is the source of a mirror connection (not disaster recovery capable)
•

•

Configuration requirements are any of the following:

• Volume
• Qtree
• Storage system, or aggregate, containing one of the above
• Storage system licensing requirements: SnapMirror
Storage that is the source of a disaster recovery capable mirror connection
•

Configuration requirements are all of the following:

Volume (possibly containing qtrees), aggregate (possibly containing volumes), or an entire
storage unit (possibly containing aggregates or volumes)
• Nothing that is in another dataset
• Storage system licensing requirements: SnapMirror
Storage that is the destination of a mirror connection (not disaster recovery capable)
•

•

•

Configuration requirements are any of the following:
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•

• Volume
• Qtree
• Storage system, aggregate, or volume containing volumes and qtrees
• Storage system licensing requirements: SnapMirror
Storage that is the destination of a disaster recovery capable mirror connection (to a disaster
recovery node)
•

Configuration requirements are any of the following:
•
•
•

•

Volume
Qtree
Storage system, aggregate, or volume containing volumes and qtrees. No volume on the
same storage system as the primary volume. Provisioning policy type (SAN or NAS)
matches primary provisioning policy type.
• Storage system licensing requirements: SnapMirror
Any node

•

• Configuration requirements: Nothing that is in a resource pool used by this dataset
• Storage system licensing requirements: None
Primary (root) node with local backup schedule
•

•

Configuration requirements: No Open Systems SnapVault directories or Open Systems
SnapVault hosts included
• Storage system licensing requirements: None
Non-root node
•
•

Configuration requirements: No Open Systems SnapVault directories or hosts and nothing
that is in a non-root node of any other dataset and nothing that is in any node of this dataset.
Storage system licensing requirements: None

Volumes unsuitable as mirror destinations
Some conditions make a volume unsuitable as a destination for volume SnapMirror-based mirror
relationships.
The following conditions make a volume unsuitable as a destination for volume SnapMirror-based
mirror relationships:
•
•
•
•
•
•
•

More than 10 percent of volume storage space is already in use (as reported by the CLI df
command).
More than 10% of volume inodes are already in use (as reported by the CLI df -i command).
The volume contains a qtree which is the root of a vFiler unit.
Source and destination volumes are running under mismatching versions of Data ONTAP.
The volume is already serving as a destination for other volume SnapMirror, qtree SnapMirror, or
SnapVault relationships.
The volume is also serving as a source for this volume SnapMirror relationship.
The potential destination volume is otherwise suitable, but is much larger than the source volume.
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The relationship will work, but space on the destination will be wasted.

What happens during failover
When you start the failover process, the NetApp Management Console data protection capability
breaks the SnapMirror relationship between the source storage containers in the primary data node
and their destination storage containers in the disaster recovery node and activates the disaster
recovery node containers as the active systems that can be accessed by users.
When you invoke failover, the NetApp Management Console provisioning capability puts the dataset
into "failing over" state and carries out the following processes.
1. Runs a failover script (if one is specified by the protection policy) to stop applications writing
data to the primary storage systems.
2. Quiesces all SnapMirror related activity between the primary storage systems and their partners
in the disaster recovery node.
3. Breaks all SnapMirror relationships between the primary storage systems and their partners in the
disaster recovery node.
4. Puts any mirrored LUNs in the online state.
5. Runs a failover script (if one is specified by the protection policy) to restart applications writing
data to the secondary systems in the disaster recovery node.
6. Enables the same export protocols (CIFS, NFS, iSCSI, or FC) for the containers in the disaster
recovery node as were enabled for the containers in the primary storage systems.
7. After the above processes are complete, changes the dataset out of failing over state.
If the above processes complete successfully, the dataset state is changed to "failed over." You can
now direct or re-map users to access their data from storage in the disaster recovery node.
If one of the above processes failed, the state is changed to "failover error."

What failover scripts are
If the failover process is invoked, an optional failover script, located on the DataFabric Manager
server, specifies tasks, affecting data in primary storage or in disaster recovery node storage, that
might need to be completed just before and just after the failover mirror relationship is broken.
Note: The Jobs window can display up to 2 KB of failover script output for the Mirror Break
Script End event. Output exceeding 2 KB is truncated and not recoverable.
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Failover script variables
A failover script can include multiple variables that are passed to it by the NetApp Management
Console data protection capability.
Variable

Description

DP_CONNECTION_ID

A tracking ID generated by the NetApp Management
Console data protection capability.

DP_DATASET_ID

A tracking ID generated by the NetApp Management
Console data protection capability.

DP_DATASET_NAME

The name of the dataset to which this script is to be
applied.

DP_FAILOVER_SCRIPT_TEST

Whether or not this failover script is being invoked as a
test. Starting a test failover by clicking test failover on
the Disaster Recovery tab sets this value to 1.

DP_FAILOVER_STATUS

Whether the failover process is currently in the stage
before or stage after the failover mirror relationship is
broken. Values are either:
•
•

DP_BEFORE_FAILOVER_MIRROR_BREAK
DP_AFTER_FAILOVER_MIRROR_BREAK

DP_JOB_ID

A tracking ID generated by the NetApp Management
Console data protection capability.

DP_POLICY_ID

A tracking ID generated by the NetApp Management
Console data protection capability.

DP_POLICY_NAME

The name of the disaster protection policy that is calling
this failover script.

DP_SERIAL_NUMBER

The serial number of the DataFabric Manager server
software.

Failover script example
This example script performs prefailover and postfailover tasks.
The following simple example script carries out the following functions:
•
•
•

Checks to see if the failover is a test failover or an actual failover.
Sends feedback to be displayed in the Job Summary field of the Jobs window.
Stops a data-producing application prior to the failover mirror relationship break.
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•

Restarts a data producing application after the failover mirror relationship break.
#!/bin/sh
if [ "$DP_FAILOVER_SCRIPT_TEST" = "1" ]
then
echo This is a TEST failover.
else
echo This is an ACTUAL failover.
fi
echo Script called with DP_FAILOVER_STATUS=$DP_FAILOVER_STATUS
# Perform different operations based on failover status
case "$DP_FAILOVER_STATUS" in
DP_BEFORE_FAILOVER_MIRROR_BREAK)
echo "Perform script operations before mirror break."
# stop mySQL server
rsh -l user_a r_host1 /etc/rc.d/init.d/mysqld stop
;;
DP_AFTER_FAILOVER_MIRROR_BREAK)
echo "Perform script operations after mirror break."
# start mySQL server
rsh -l user_a r_host1 /etc/rc.d/init.d/mysqld start
;;
*)
echo "Unknown DP_FAILOVER_STATUS: $DP_FAILOVER_STATUS"
exit 1
esac
# Return 0 for success.
# Return 1-255 for failure.
exit 0

Configuring disaster recovery protection
To configure disaster recovery protection you use the NetApp Management Console Add Protection
Policy wizard, Add Dataset wizard, and the Dataset Policy Change wizard.

Decisions to make before configuring disaster recovery protection
Before you configure disaster recovery protection for a dataset, use the following questions to plan
your disaster recovery capable dataset and protection policy.
Disaster recovery capable dataset considerations
When planning the configuration of the datasets on which you want to set up disaster recovery
protection, you need to consider the location of your storage nodes, the type of resources on storage
nodes, and how you want to assign storage.
Storage node
sites

Are your planned primary storage node and disaster recovery storage node sites
located a safe distance from one another?
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You should plan to locate the disaster recovery node storage site far enough away
from the primary storage site so that it is not affected by any event that can disable
the primary site.
Storage node
resources

Are your planned primary storage node and disaster recovery storage node
resources, storage systems with SnapMirror installed?
Disaster recovery protection can only be implemented on storage systems installed
with SnapMirror and failover features.

Storage node
resource
capacity

Storage
resource
assignment

Do your planned primary and disaster recovery storage node resources match up
in capacity and installed applications?
To support continuous user access, successful failover requires that the secondary
node storage systems be configured with the same environment settings and
applications as those on the primary node storage systems.
How do you plan to assign resources to your dataset primary and disaster recovery
nodes?
•

•

Manual resource assignment (that is, not use a provisioning policy)
Make sure the resources assigned to the primary and disaster recovery nodes
are matched in size and installed applications.
Using provisioning policies and resource pools
•

•

The assigned provisioning policies must specify the application
installations, system capacities, and export protocols that will enable a
functioning SnapMirror relationship between volumes and qtrees in the
primary and disaster recovery nodes.
The assigned resource pools must contain storage systems configured to
comply with the provisioning policies.

Disaster recovery protection policy considerations
Before you configure a disaster recovery protection policy, you must make some decisions about the
policy and connection component configuration.
Type of disaster What type of disaster recovery protection policy do you plan to provide?
recovery
A list of six disaster recovery protection policies (each labeled with a DR
protection policy
prefix) are displayed using the NetApp Management Console data protection
capability.
Failover script

In addition to failover, do you need to perform additional scripted shutdown
and restart processes before and after the SnapMirror relationship break is
invoked?
If so, you need to specify a path to a user-created failover script.
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Enabling disaster recovery protection
To configure disaster recovery protection you use the Add Protection Policy wizard, Add Dataset
wizard, and the Dataset Policy Change wizard.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. Select a disaster recovery protection policy.
Use the Add Protection Policy wizard to customize a disaster recovery protection policy to apply
to your data.
To customize a disaster recovery protection policy, select a base policy with a "DR" prefix. If
necessary, write a failover script and specify the path to it.
2. Create a disaster recovery capable dataset.
Use the Add Dataset wizard to create a dataset to contain your data.
The wizard guides you to create a single primary node dataset and to provision it, either by
directly assigning resources to it or by assigning a provisioning policy and resource pool.
3. Create an optional failover script.
If necessary, write a failover script that specifies data application-related tasks that need to be
performed before and after the SnapMirror relationship break in the failover process (for
example, stopping database writes to primary storage).
4. Assign a disaster recovery capable protection policy to your dataset.
Use the Dataset Policy Change wizard to assign the disaster recovery protection policy to a
dataset and create and provision any resulting secondary and tertiary nodes.
To make the secondary storage node in this dataset disaster recovery capable, assign it only
resources with storage systems that have SnapMirror installed.
After you finish

After enabling disaster recovery protection on a dataset, you can test the failover process and monitor
the failover readiness of your disaster recovery enabled datasets.
•
•
•

To test the optional failover script in the assigned disaster recovery capable protection policy use
the Test button on the Disaster Recovery tab.
To monitor all datasets in your authorized group for failover readiness issues, use the Failover
Readiness panel in the Dashboards window.
To monitor the failover readiness of specific datasets, check their status in the Failover column of
the Disaster Recovery tab.
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Related concepts

Decisions to make before configuring disaster recovery protection on page 440
What failover scripts are on page 438
Related tasks

Adding a protection policy on page 203
Adding a dataset of physical storage objects on page 99
Assigning or changing a protection policy on page 102
Testing failover scripts on page 444
Monitoring failover readiness on page 443

Managing disaster recovery protection
You can monitor and test your failover readiness, execute disaster procedures, and recover from
disaster.

Ensuring disaster recovery readiness
If disaster or mishap threatens to disable or destroy primary storage systems in a disaster recovery
capable dataset, you can invoke procedures to assess the need for, prepare for, and, if necessary,
execute failover processes.
Monitoring failover readiness
You can use the Failover Readiness panel to monitor the readiness of your disaster recovery capable
datasets to carry out successful failover operation.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Step

1. From the menu bar, click Dashboards > Protection > Failover Readiness.
The NetApp Management Console data protection capability displays the Disaster Recovery tab
which lists all datasets in the current group and a failover column which displays their current
failover statuses.
After you finish

The datasets that are ready for failover will have a failover status of ready.
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Related references

Administrator roles and capabilities on page 54
Testing failover scripts
You can use the Disaster Recovery tab to test the operation of your optional user-generated failover
scripts without conducting an actual failover.
Before you begin

•
•
•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
You must have started and stopped applications on the storage systems of the dataset being tested.
You must have ensured that the failover script flags are set to prevent actual failover operations
from proceeding.

Steps

1. From the menu bar, click Data > Datasets > Disaster Recovery.
The NetApp Management Console data protection capability lists all the datasets that have been
assigned disaster recovery capable protection policies.
2. Select the dataset on which you want to test the failover script and click Test.
The NetApp Management Console data protection capability begins testing the failover script that
is stored on the associated DataFabric Manager server and specified in the disaster recovery
capable protection policy assigned to the selected dataset.
Result

You can monitor the progress of the failover test job in the Jobs window.
Related references

Administrator roles and capabilities on page 54
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Executing disaster procedures
If disaster or mishap threatens to disable or destroy primary storage systems in a disaster recovery
capable dataset, you can invoke procedures to assess the need for, prepare for, and, if necessary,
execute failover processes.
Disaster management options
If disaster or mishap jeopardizes the operation of your disaster recovery-capable primary node
storage systems, you can use status and event information to assess your backup, failover, or
restoration options.
Events

Path: Dashboards > Protection > Top Five Events or Notifications > Events
Look for: Hosts down or Volume offline events, which indicate conditions in
primary storage that might require failover to storage systems in the disaster
recovery node.

Storage
systems status

Path: Hosts > Storage Systems

Disaster
recovery
failover status

Path: Data > Datasets > Disaster Recovery

Disaster
recovery
failover lag
status

Path: Data > Datasets > Disaster Recovery

Failover
readiness

Path: Dashboards > Protection > Failover Readiness

Look for: Storage systems whose System Status column indicates that they are
down and might require failover to storage systems in the disaster recovery node.
Use the System Status column
button to filter for Down status.

Look for: The Failover Ready status in the Failover column of the listed disaster
recovery capable datasets.

Look for: In Failover Lag status column, whether the last successful backup of
primary node data to the disaster recovery node in the listed datasets is
satisfactorily current enough for you to invoke failover without a final update.

Look for: Normal status, which indicates that all disaster recovery capable
datasets are ready to undergo failover if necessary.
A Warning or Error status indicates that conditions exist in one or more of your
disaster recovery capable datasets that jeopardize successful failover.
Disaster
recovery job
progress

Path: Data > Datasets > Disaster Recovery > Jobs
Look for: Among other information, the last successful backup or mirror
operation (including time started) in a dataset.
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Updating disaster recovery node storage before failover
You can use the Disaster Recovery tab to perform a final unscheduled Snapshot mirror update from
primary to disaster recovery node. You might perform this operation in anticipation of possible
failover operations necessitated by approaching mishap or disaster threatening your primary storage
site.
Before you begin

•
•

Ensure that enough time exists before the possible necessity of failover to complete a Snapshot
update.
You must be authorized to edit the protection schedules.

Steps

1. From the menu bar, click Data > Datasets > Disaster Recovery.
2. Select the dataset on which you might need to execute failover processes.
If the failover lag status displayed for that dataset is Error or Warning, and if you believe you
have enough time to complete it, you should complete the steps in this task.
3. Click Update and then click Update again in the confirmation dialog box to confirm your update
request.
The NetApp Management Console data protection capability displays a confirmation prompt.
Result

After the update operation is complete and if you invoke a successful failover process, the disaster
recovery node takes over as the functioning primary storage node, which provides users with access
to the updated data.
Starting failover
You can use the Disaster Recovery tab in NetApp Management Console to invoke the failover
process from primary to secondary storage.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. If the Disaster Recovery tab is not already displayed, from the menu bar, click Data > Datasets
> Disaster Recovery.
2. Select the dataset on which you plan to execute failover processes and confirm the failover status
for the selected dataset is Ready.
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Note: If the failover lag status displayed for the dataset is Error or Warning, and if you have
enough time, you should update the disaster recovery node storage before failover.

3. Click Failover.
4. If you want to check which volumes or qtrees will be affected by failover before executing
failover, click Details in the confirmation dialog box.
The NetApp Management Console data protection capability lists which Volume SnapMirror or
Qtree SnapMirror relationships will be broken, and which destination volumes or qtrees in the
disaster recovery node will assume primary storage function.
5. Click Update again in the confirmation dialog box to confirm your update request.
NetApp Management Console initiates the failover processes. A successful failover process
causes the disaster recovery node site volumes or qtrees to take over and provide primary storage
function and availability.
After you finish

After initiating the failover process, go to the Failover Status panel to monitor the progress of the
failover operation.
Monitoring failover status
After you start a failover process, you can use the Failover Status panel to monitor its progress.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Step

1. From the menu bar, click Dashboards > Protection > Failover Status.
After you finish

After a successful failover, consider your failback strategies.
Related concepts

Recovery from disaster on page 384
Related references

Administrator roles and capabilities on page 54
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Recovery from disaster
In the aftermath of a disaster and successful failover, you can assess whether you need to restore
primary storage functions to the storage elements on the original primary node and if so, whether
those storage elements need data updated from the current functioning primary storage systems.
Possible recovery actions after failover include the following.
•

•

•

•

Make the successful failover target node into the new permanent primary storage system
Maintain the temporary primary storage systems in the disaster recovery node as the permanent
primary storage systems.
Reactivate the original primary node without updating
Reactivate and resume forward mirroring from the original primary node without updating its
original data.
Resynchronize to undamaged storage in original primary node
Resynchronize data from the disaster recovery node to the undamaged storage in the original
primary node.
Resynchronize to destroyed and replaced storage in original primary node
Resynchronize data from the disaster recovery node to the destroyed and replaced storage in the
original primary node.

Making the disaster recovery node the new primary data storage
After a successful failover, you have the option of making the disaster recovery node storage, which
is currently serving the active data, to be the permanent primary data node.
Before you begin

•
•
•

Determine which protection policy you want to assign to the dataset. This policy can be either
disaster recovery capable or not.
Be sure you are familiar with the decisions you must make before assigning or changing policies.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

After successful failover, to maintain the now active volumes and qtrees in the disaster recovery node
as permanent primary storage, reassign the dataset a protection policy (either disaster recovery
capable or not) and designate the current disaster recovery node as the new primary data node.
Steps

1. From the menu bar, click Data > Datasets > Overview tab and then select the failed over dataset.
The Overview tab displays the failed-over dataset with the original primary data node offline and
inactive.
2. Click Protection Policy to start the Dataset Policy Change wizard.
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3. When the Dataset Policy Change wizard presents the option, click Yes, abandon the primary
nodes resources.
4. Select a disaster recovery capable protection policy.
You can select among possible node mappings for that protection policy that do not configure the
original primary node as the new primary node.
5. Select a node mapping that configures the current disaster recovery node as the new primary
node.
Note: The usual practice is to select a node mapping that requires the least amount establishing
a new baseline of backup or mirror copies.

6. Complete the wizard.
Recovering by resuming forward mirroring
After a successful failover, if the original primary storage site is not destroyed and no update of data
on the original primary storage site is required, you can use the dfpm and dfdrm commands on the
DataFabric Manager server to restore active primary storage function to the original primary storage
node.
Before you begin

•
•

Confirm that the change you want to make to this protection policy is acceptable for all datasets
using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Note: Necessary capabilities include the ability to restart storage systems on the primary and
secondary nodes in the dataset on which you want to resume forward mirroring.

Steps

1. Log in to the command line interface of the DataFabric Manager server that you are using
NetApp Management Console to manage.
2. In the command line interface, enter the command:
dfpm dataset list -m data_set_name

This command finds the primary volumes and qtrees of the specified dataset.
3. Enter the command:
dfpm dataset list -R

This command finds the disaster recovery volume and qtree partners for all primaries. SnapMirror
relationships that were broken during the failover are indicated by the "broken_off" state.
4. If your disaster recovery protection policy is based on DR Mirror and Mirror node mappings,
enter the command:
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dfdrm mirror resync dr_obj1 dr_obj2 dr_obj3 dr_obj... non_dr_obj1
non_dr_obj2 non_dr_obj3 non_dr_obj...

This command reinstates the SnapMirror relationships that were broken during the failover in the
disaster recovery node and in the non-disaster recovery secondary node. In this command,
dr_obj... and non_dr_obj.. are all volumes and qtrees in either the disaster recovery node
or the non-disaster recovery node in "broken_off" state that you want to restore to "mirrored"
state.
Wait for all relationships to be in the "mirrored" state, then skip to Step 7.
5. If your disaster recovery protection policy is based on DR Mirror then Mirror node mappings,
enter the command:
dfdrm mirror resync dr_obj1 dr_obj2 dr_obj3 dr_obj... tertiary_obj1
tertiary_obj2 tertiary_obj3 tertiary_obj...

This command reinstates the SnapMirror relationships that were broken during failover in the
disaster recovery node and the tertiary node. In this command, dr_obj... and
tertiary_obj... are all volumes and qtrees in either the disaster recovery node or the tertiary
node in "broken_off" state that you want to restore to "mirrored" state.
Wait for all relationships to be in the "mirrored" state, then skip to Step 7.
6. In all other cases, enter the command:
dfdrm mirror resync dr_obj1 dr_obj2 dr_obj3 dr_obj...

This command reinstates the SnapMirror relationships in the disaster recovery node that were
broken during failover. In this command, dr_obj... is all disaster recovery node volumes and
qtrees in "broken_off" state that you want to restore to "mirrored" state.
Wait for all relationships to be in the "mirrored" state before continuing to the next step.
7. Enter the command:
dfpm dataset failover state dataset_name ready

This command sets the dataset disaster recovery status back to ready.
Related references

Administrator roles and capabilities on page 54
Recovering by resynchronizing data to undestroyed containers
After a successful failover, you can use the dfpm and dfdrm commands on the DataFabric Manager
server to restore primary storage function to your original undestroyed primary storage systems and
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containers and update their data with the most recent changes made to their failover partners in the
disaster recovery node.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. Log in to the command line interface of the DataFabric Manager server that you are using
NetApp Management Console to manage.
2. In the command line interface, enter the command:
dfpm dataset list -R dataset_name

This step finds the secondary storage elements for all primary storage elements. SnapMirror
relationships that were broken during the failover are indicated by the "broken_off" state.
3. If your protection policy is based on the DR Mirror and Mirror node mapping, enter the
command:
dfdrm mirror break non_dr_obj1 non_dr_obj2 non_dr_obj3 non_dr_obj...

This command breaks the SnapMirror relationships between source volumes and qtrees in the
primary node and destination volumes and qtrees in the nondisaster recovery node.
Skip to Step 5.
4. If your protection policy is based on the DR Mirror then Mirror node mapping, enter the
command:
dfdrm mirror break tertiary_obj1 tertiary_obj2 tertiary_obj3
tertiary_obj...

This command breaks the SnapMirror relationships between source volumes and qtrees in the
disaster recovery node and destination volumes and qtrees in the tertiary node.
5. Enter the command:
dfdrm mirror resync -r dr_obj1 dr_obj2 dr_obj3 dr_obj...

This command temporarily reverses the original SnapMirror relationships (which updates the
original primary storage containers as SnapMirror destinations).
In this command, dr_obj... is all volumes and qtrees in the disaster recovery node, now
serving as primary storage, that you want to temporarily configure as a SnapMirror sources.
Wait for all relationships to be in the "mirrored" state before continuing to the next Step.
6. Enter the command:
dfdrm mirror break original_obj1 original_obj2 original_obj3
original_obj...
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This command quiesces and breaks the temporary reversed mirror relationships.
In this command, original_obj.. is all original primary objects that are temporarily
configured as SnapMirror destinations.
7. After you break the reversed mirror relationship, inspect the data on the original primary objects
to verify validity.
8. Enter the command:
dfdrm mirror resync -r original_obj1 original_obj2 original_obj3
original_obj...

This command resyncs the mirror copies to reestablish the original SnapMirror relationships (in
other words, to reverse the relationships back to forward mirror).
9. If your protection policy is based on the DR Mirror and Mirror node mapping, enter the
command:
dfdrm mirror resync non_dr_obj1 non_dr_obj2 non_dr_obj3 non_dr_obj...

This command resyncs the mirror copies to reestablish the original primary node to nondisaster
recovery secondary node SnapMirror relationships.
Skip to Step 11.
10. If your protection policy is based on the DR Mirror then Mirror node mapping, enter the
command:
dfdrm mirror resync tertiary_obj1 tertiary_obj2 tertiary_obj3
tertiary_obj...

This command resyncs the mirror copies to reestablish the original disaster recovery node to
tertiary node SnapMirror relationships.
11. Confirm the success of the resync operation by noting its job list ID output and entering the
command:
dfdrm job list joblist_id

If the job list command indicates a resync job failure, then reinitialize the mirror relationship
between each volume or qtree by using the command
dfdrm mirror initialize dr_obj tertiary_obj

12. Enter the command:
dfpm dataset failover state dataset-name ready

This command sets the dataset disaster recovery state to ready.
Related references

Administrator roles and capabilities on page 54
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Recovering by resynchronizing data to replaced containers
After a successful failover, you can use the dfpm and dfdrm commands on the DataFabric Manager
server to restore primary storage function to destroyed and replaced original primary storage
containers and resynchronize primary storage data with the most recent updates.
Before you begin

•

At the original primary storage site, confirm that the destroyed storage systems, aggregates,
volumes, and qtrees are replaced with containers of the same name, capacity, and configuration.
Note: Configure the replacement volumes in restricted (not online or offline) state.

•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Attention: You cannot perform this task on relationships for which the original source is a non-

qtree and the associated failed-over dataset uses the DR-Backup policy. However, you can perform
this task on all the other relationships in the failed-over dataset.
Steps

1. Log in to the command line interface of the DataFabric Manager server that you are using
NetApp Management Console to manage.
2. In the command line interface, enter the command:
dfpm dataset list -R dataset_name

This step finds the secondary storage elements for all primary storage elements. SnapMirror
relationships that were broken during the failover are indicated by the "broken_off" state.
3. Enter the command:
dfpm dataset list -m -M dataset_name

This step lists the missing (destroyed) containers in the specified dataset.
4. For each system on the missing container list, use FilerView or the Data ONTAP CLI to recreate
the missing aggregates, volumes, or qtrees.
Configure the replacement volumes with restricted (not online or offline) state.
5. If your disaster recovery protection policy is based on DR Mirror and Mirror node mappings,
enter the command:
dfdrm mirror delete non_dr_obj1

This step deletes the non-disaster recovery node mirror destination objects.
6. Enter the command:
dfdrm mirror initialize dr_obj_name1 replaced_obj_name

This command creates a new SnapMirror relationship to the replacement volumes and qtrees in
the original primary node from their source partner volumes and qtrees in the disaster recovery
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node. It temporarily configures the disaster recovery node volumes and qtrees as SnapMirror
source objects and the replacement volumes and qtrees as destination objects. It then copies the
updated data from the volumes and qtrees in the disaster recovery node to the replacement
volumes and qtrees in the original primary node.
Note: Because you cannot create a SnapMirror relationship to a replacement aggregate, use

this command to create SnapMirror relationships to that aggregate's child volumes instead.
7. Repeat Step 6 for each disaster recovery node volume or qtree that has a replacement volume or
qtree.
8. After the mirror initialize operations are complete, enter the command:
dfdrm mirror quiesce replaced_obj1 replaced_obj2 replaced_obj3
replaced_obj...

This step quiesces these new mirror relationships prior to breaking and reversing them. In this
command, replaced_obj.. is all the replacement containers that you have just updated.
9. Enter the command:
dfdrm mirror break replaced_obj1 replaced_obj2 replaced_obj3
replaced_obj...

This command breaks the current mirror relationships prior to reversing them.
10. After you break the mirror relationship, inspect the data on the original primary objects to verify
validity.
11. Enter the command:
dfdrm mirror resync -r replaced_obj1replaced_obj2
replaced_obj3replaced_obj...

to reverse the mirror relationship.
This action establishes the replacement volumes and qtrees as the primary storage containers and
the volumes and qtrees in the disaster recovery node as the SnapMirror destination objects.
12. If your disaster recovery protection policy is based on DR Mirror and Mirror node mappings,
enter the command:
dfdrm mirror initialize replaced_obj...non_dr_obj...

This command creates a new SnapMirror relationship between the replacement volumes and
qtrees in the original primary node and their partner volumes and qtrees in the non-disaster
recovery node. It temporarily configures the disaster recovery node volumes and qtrees as
SnapMirror source objects and the replacement volumes and qtrees as destination objects.
Repeat this command for each replaced volume or qtree in the primary node.
13. If your disaster recovery policy is based on DR Mirror and Mirror node mappings, enter the
command:
dfdrm mirror resyncnon_dr_obj1non_dr_obj2non_dr_obj..non_dr_obj3
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This command updates the empty volumes and qtrees in the non-disaster recovery node with data
from their replaced partners in the primary node. In this command, non_dr_obj... is all the
volumes and qtrees in the non-disaster recovery node that you want to update.
Wait for all relationships to be in the "mirrored" state.
14. Enter the command:
dfpm dataset replace dataset-name

This command replaces the dataset reference to old primary volumes and qtrees with replaced
volumes and qtrees.
Note: This step carries out replacement of old with new volume and qtree references only. To
replace old with new aggregate references in the failed back dataset, see the next step.

15. If the failed-back dataset originally included aggregates, complete the following commands to
add reference to the replacement aggregates and delete reference to their child volumes in the
failed-back dataset.
Even though the failed aggregate was destroyed and replaced, you still need to complete the
following steps to reference the replacement aggregate in the failed-back dataset.
a) Enter the command:
dfpm dataset list -m dataset_name

This command lists the child members (volumes or qtrees) of the replacement aggregate.
b) Enter the command:
dfpm dataset remove dataset_name child_obj

.
This command removes reference to the child members of the replacement aggregates from
this dataset.
Even though references to the child replacement volumes are removed from the dataset, the
SnapMirror relationships and operations between these replacement volumes and their
disaster recovery node mirrors remain intact.
c) Enter the command:
dfm aggr list storage_system

This command lists the replacement aggregate at the primary site.
d) Enter the command:
dfpm dataset add dataset_name replacement_aggr

This command adds the replacement aggregate to the failed back dataset.
e) Enter the command:
dfpm dataset list -m dataset_name

This command confirms the addition of the replacement aggregate to this dataset by
generating a list of the dataset contents.
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16. Enter the command:
dfpm dataset list -R dataset_name

This step confirms the disaster recovery relationship between the replacement child volumes and
their destinations in the disaster recovery node.
17. Enter the command:
dfpm dataset failover state dataset_name ready

This step sets the dataset disaster recovery state to ready.
Related references

Administrator roles and capabilities on page 54

457

Data > Datasets > Disaster Recovery
You can use the Disaster Recovery tab to perform monitoring, update, testing, and failover tasks on
datasets.
•
•
•
•
•

Command buttons on page 457
Datasets list on page 457
Graph tab on page 459
Jobs tab on page 461
Window customization on page 461

Command buttons
Failover Starts the process for primary-to-disaster recovery node failover in the selected disaster
recovery enabled dataset.
Test

Tests the validity of user-defined failover scripts specified in the disaster recovery
protection policy that is assigned to the selected dataset.

Update

Starts an immediate primary-to-disaster recovery node update in the selected dataset.
This operation is most likely invoked in preparation for an impending event that can
potentially disable a primary storage facility and necessitate failover to a disaster
recovery-enabled backup site, but is still distant enough to allow completion of a final
backup of data from a primary storage node to its disaster recovery-enabled node.

Cancel

Cancels any update or failover operation in the selected dataset.

Datasets list
Displays a table of all datasets enabled for disaster recovery protection. Click on a row in the list to
view information in the Details area about the selected dataset.
Name

The name of the dataset.

Failover

The failover status of the dataset. Possible statuses include the following:
Ready

The dataset is ready for failover.

Failing over

The dataset is in the process of failover.

Failed over

The dataset has completed successful failover.

Failed over - Warning The dataset completed failover with warnings.
Failed over - Error

The dataset encountered errors during failover. Failover
is not successful.
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Failover Lag
Status

The current status of the data backup between the primary data node and the
disaster recovery node. Valid values, in alphabetical order, are as follows:
Baseline
Failed

There are no initial baseline data transfers that registered a
backup version.

Initializing

The dataset is conforming to the protection policy and the
initial baseline data transfer is in process.

Job Failure

The most recent protection job did not succeed.
This status might result for any of the following reasons:
•
•
•
•

Lag Error

A backup from a SnapVault or Qtree SnapMirror
relationship failed or could not be registered.
A mirror copy from a SnapMirror relationship failed or
could not be registered.
Local backups (Snapshot copies) failed on the primary
node.
The dataset does not have any backup versions.

The dataset has reached or exceeded the lag error threshold
specified in the assigned protection policy. This value indicates
that there has been no successful backup or mirror copy of a
node's data within a specified period of time.
This status might result for any of the following reasons:
•
•

•

Lag Warning

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror) is
older than the lag threshold setting or no backup jobs have
completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than the
lag threshold setting or no mirror jobs have completed since
the dataset was created.

The dataset has reached or exceeded the lag warning threshold
specified in the assigned protection policy. This value indicates
that there has been no successful backup or mirror copy of a
node's data within a specified period of time.
This status might result for any of the following reasons:
•

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
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•

•

No Protection
Policy

The dataset is managed by the NetApp Management Console,
but no protection policy has been assigned to the dataset.

Protected

The dataset has an assigned policy and it has conformed to that
policy at least once.

Protection
Suspended

An administrator has requested that scheduled backups be put
on hold until the administrator requests that they be resumed.

Uninitialized

This status might result for any of the following reasons:
•
•
•
•
•
•

Description

The most recent backup (SnapVault or Qtree SnapMirror) is
older than the lag threshold setting or no backup jobs have
completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than the
lag threshold setting or no mirror jobs have completed since
the dataset was created.

The dataset has a protection policy that does not have any
protection operations scheduled.
The dataset does not contain any data to be protected.
The dataset does not contain storage for one or more
destination nodes.
The single node dataset does not have any backup versions.
At least one backup version must be associated with the
application dataset.
The dataset does not contain any backup or mirror
relationships.

A description of the dataset.

Graph tab
Displays a selectable topological representation of the primary node, disaster recovery node, backup
connections, and any other secondary node assigned to the selected dataset. Clicking a node or
connection displays failover status and resource information about that node that you might need to
evaluate prior to starting failover.
Primary
Data node
details

If the primary storage node is selected, the NetApp Management Console data
protection capability displays the following primary storage node data:
Protection

The status of the data protection scheme assigned to this
dataset (protected, uninitialized, suspended, lag warning, or
lag error).
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Conformance

Whether or not provisioning conformance errors exist in the
selected node. If error conditions exist, click
status value for details.

Resource

Whether or not error or critical conditions exist in the
resources assigned to the selected node.

Space

Whether or not space issues exist on the selected node. If
warning or error conditions exist, click
status value for details.

next to the

Failover

The failover state of the primary data node.

Physical resources

List of the physical systems assigned to the selected node.
Click

for details.

Resource pools

Resource pools, if any, that are assigned to provision the
selected node.

Local backup
schedule

The name of the local backup schedule, if any, that is

Backup versions
Dataset
properties
details

next to the

assigned to the selected node. Click
display of the exact backup times.

for a graphical

List of Snapshot copies stored on this node.

Depending on the properties of the selected dataset, the NetApp Management
Console data protection capability displays some or all of the following details.
Owner

Owner of the current dataset.

Contact

E-mail contact address for this dataset.

Time zone

Time zone in which the dataset is located.

Application

(Displayed for application datasets) The application that
generated the dataset.

Application version (Displayed for application datasets) The application
version that generated the dataset.
Application server

Connection
details

(Displayed for application datasets) The name of the
application server that generated the dataset.

If the connection element is selected, the NetApp Management Console data
protection capability displays the following data in connection with the data
protection connections:
Relationships The protection relationships between a source and target nodes.
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Schedules

The name of the protection schedule assigned to this protection
connection.

Throttle

The name of the throttle schedule assigned to this protection
connection.

Lag status

The current lag status (good, warning, or error) of successfully
completed protection backup or mirror operations between the
source and target nodes. If error or warning conditions exist, click
next to the status value for details.

Backup Node If the backup node is selected, the NetApp Management Console data protection
capability displays the following data in connection with the data protection backup
node:
Node name

The default or user-assigned name of the backup node.

Provisioning policy The provisioning policy, if any, that is assigned to the
backup node.
Physical resources

The physical resources assigned to the selected node. Click
for details.

Resource pools

The resource pools, if any assigned to the selected node.
Click

for details.

Jobs tab
Displays a list of the disaster recovery update and failover operations initiated on this dataset.
Job

A list of the jobs related to disaster recovery-related protection configuration or
execution that the NetApp Management Console data protection capability has
executed.

Step

A list of the phases or milestones that occurred or were attempted during the
execution of the listed jobs.

Time stamp The times and dates that the listed jobs and steps started or occurred.
Result

The Normal, Warning, or Error result status of the listed jobs or steps.

Note: You can select each listed job or step to display further details on that job or step in the pane
to the right.

Window customization
You can modify the layout of the window by using a variety of customization options.
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•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Dashboards > Protection > Failover Readiness
You can use the Failover Readiness panel to view the readiness of datasets configured for disaster
recovery protection to successfully carry out failover operations should failover operations become
necessary. The panel lists the number of datasets whose failover support configurations are in ready
state, warning state, and error state.
Status Descriptions
Note: If a status value is zero, the status item does not display in the dashboard panel.

Failover
Readiness

•

•

•

Status: Normal.
Indicates that conditions in all datasets that are configured for disaster recovery
protection will support successful failover operations if such operations become
necessary. Nothing has changed in the configuration since the dataset was
configured for disaster recovery.
Status: Warning
Indicates that conditions have changed in one or more datasets that are
configured for disaster recovery protection so that failover operations might not
be completely successful, if such operations become necessary. The datasets
producing the warnings should be investigated and brought back into the
Normal state.
Status: Error
Indicates that conditions have significantly changed in one or more datasets that
have been configured for disaster recovery protection so that it is likely that
failover operations will not be completely successful, if such operations become
necessary, and data could be lost. The datasets producing the warnings should
be investigated and brought back into the Normal state.

Ready

Total number of datasets that have been configured for disaster recovery protection
whose conditions will support successful failover operations, if such operations
become necessary.

Ready Warnings

Total number of datasets that have been configured for disaster recovery protection
whose conditions might not support completely successful failover operations, if
such operations become necessary.

Error Warnings

Total number of datasets that have been configured for disaster recovery protection
to which significant changes have occurred to the configurations. Failover
operations can still occur but might not be completely successful, if such operations
become necessary.

Total
Datasets

The total datasets that have been configured for disaster recovery protection.
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Click
beside the dashboard panel title to replace the work area with the Disaster Recovery tab on
the Datasets window.
You can filter the content of the dashboard panels, to focus on specific groups of datasets or resource
pools, by using the Group selection list on the console tool bar.
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Dashboards > Protection > Failover Status
You can use the Failover Status panel to view the status of an in-progress failover operation. The
panel appears when a failover operation is invoked, listing the number of datasets in the process of
failing over and the number of datasets that have successfully failed over.
Status Descriptions
Note: If a status value is zero, the status item does not display in the dashboard panel.

Failover
Status

•

•

•

Status: Normal
Indicates that failover operations are either successfully completed or are
proceeding as expected in all datasets that have been configured for disaster
recovery protection.
Status: Warning
Indicates that failover operations have completed with a warning condition in
one or more of the datasets that have been configured for disaster recovery
protection.
Status: Error
Indicates that failover operations have completed with an error condition in
one or more of the datasets that have been configured for disaster recovery
protection.

Failing over

Total number of datasets that has been configured for disaster recovery protection
that are currently undergoing failover operations.

Failed over

Total number of datasets that has been configured for disaster recovery protection
that has successfully completed failover operations.

Failed over Warnings

Total number of datasets that have been configured for disaster recovery
protection that have completed failover operations with warning conditions.
Warnings can be encountered during the failover operation or warnings that exists
in the ready state, as shown in the Failover Readiness panel, can be propagated to
the Failed Over state.

Failed over Errors

Total number of datasets that have been configured for disaster recovery
protection that have completed failover operations with error conditions. Errors
can be encountered during the failover operation or errors that exists in the ready
state, as shown in the Failover Readiness panel, can be propagated to the Failed
Over state.

Total Datasets The total datasets that are issuing failover status events.
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Click
beside the dashboard panel title to replace the work area with the Disaster Recovery tab on
the Datasets window.
You can filter the content of the dashboard panels, to focus on specific groups of datasets or resource
pools, by using the Group selection list on the console tool bar.
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Protection policy types (not disaster recovery
capable)
Protection policies are the backup instructions that you assign to your datasets. These policies
describe the type of backup to carry out, the Snapshot copy retention count, what preconfigured
Snapshot copy, backup, and throttle schedule to follow, and what scripts to execute. The same policy
can be assigned to multiple datasets.
The NetApp Management Console data protection capability provides templates for you to configure
the following types of backup setups. The Disaster Recovery feature on your protection server
provides additional disaster recovery capable protection policies.
Back up

A dataset is backed up locally and also backed up from primary storage to
secondary storage on a SnapVault or SnapMirror storage system.

Back up, then
Mirror

A dataset is backed up from primary storage to secondary storage on a
SnapVault or SnapMirror storage system and from there mirrored to a
SnapMirror partner.

Mirror then Mirror A dataset is mirrored from primary storage to secondary storage on a
SnapMirror partner and from there mirrored to an additional SnapMirror
partner.
Local Snapshot
copies only

A dataset uses only local Snapshot copies in primary storage to protect data.
No backup to secondary storage is implemented.

Mirror

A dataset is mirrored from primary storage to secondary storage on a
SnapMirror partner.

Mirror and back up A dataset is mirrored from primary storage to secondary storage on a
SnapMirror partner and is also backed up to secondary storage on a
SnapVault or SnapMirror storage system.
Mirror to two
destinations

A dataset is mirrored from primary storage to secondary storage on two
different SnapMirror partners.

Mirror then back
up

A dataset is mirrored from primary storage to secondary storage on a
SnapMirror partner and from there backed up to tertiary storage on a
SnapVault or SnapMirror storage system.

No protection

A dataset is left with no Snapshot copies, backups, or mirror-copy protection
of any kind.

Remote backup
only

Data on a storage system is backed up remotely to secondary storage on a
SnapVault or SnapMirror storage system. The NetApp Management
Console data protection capability carries out no local backup on the
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primary storage. This is the protection policy to assign to third party systems
with Open Systems SnapVault installed.
Related references

Disaster recovery capable protection policies on page 396
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Adding a protection policy
You can use the Add Protection Policy wizard to create new protection policies. After you create a
protection policy, you can apply it to datasets to manage the backup or mirror operations that are
executed on those datasets.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Have the information available that you need to complete this task:
•
•
•
•
•

Policy name, base configuration, name for each node
Custom field information
Primary node information
Backup or mirror connection information
Backup or mirror node information

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Click Add to start the Add Protection Policy wizard.
3. Type a policy name and description and click Next.
4. Select a base policy and click Next.
5. Complete the policy property sheets for the primary node and any backup connection, mirror
connection, secondary storage, or tertiary storage node that is required for the policy. After you
complete each property sheet, click Next.
After all property sheets are completed, the Add Protection Policy wizard displays a summary
sheet for the policy.
6. Confirm the details of the policy and click Finish.
Result

Your new policy is listed on the Protection Policies window Overview tab.
Related concepts

Decisions to make before adding a protection policy on page 200
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Related references

Administrator roles and capabilities on page 54
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Adding a dataset of physical storage objects
You can include multiple physical storage objects in a dataset for managing the protection
requirements or provisioning the storage space and hardware requirements of those objects as a
group.
Before you begin

•
•
•

You must have the protection information that you require to complete this task.
You must have the provisioning information that you require to complete this task.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
•
•

To assign a policy, you must be assigned a role that enables you to view policies.
To assign a provisioning policy, you also need a role that enables you to attach the resource
pools configured for the policy.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add to start the Add Dataset wizard.
If you want to provision your node by resource pool, click the Provision and attach resources
using a policy option when it is displayed.
If you want the dataset to have online migration capability, select a provisioning policy that is
configured for that capability.
If you receive a message that the maximum number of vFiler units has been reached, to configure
an IP address and network mask that enables the migration capability on an additional dataset,
you must first disable migration capability for one or more existing migration capable datasets.
3. Complete the steps in the Add Dataset wizard to create a dataset.
Result

The new dataset is listed in the Datasets tab.
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After you finish

To provide protection for your new dataset, assign it a protection policy or a disaster recoverycapable protection policy.
Related concepts

Decisions to make before adding datasets of physical storage objects (for protection) on page 94
Decisions to make before adding datasets of physical storage objects (for provisioning) on page 96
Effect of time zones on schedules on page 220
Related references

Administrator roles and capabilities on page 54
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Assigning or changing a protection policy
You can assign a policy to a dataset or change the policy assigned to it. The policy specifies how the
data is to be protected.
Before you begin

•

•

•

You must have gathered the protection information that you need to complete this task:
• Dataset properties
• Group membership
• Protection policy
Determine which policy you want to assign to the dataset. You can review available protection
policies on the Protection Policies window.
If no policy meets the requirements of your new dataset, you can create a new policy or modify a
copy of an existing policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

•

You can use this procedure after you have created a new dataset and want to assign a policy to it,
or when you want to change the protection policy assigned to a dataset. You can also use this
procedure to protect a dataset that is listed on the Datasets window
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Any dataset that you directly assign a protection policy or provisioning policies and resource
pools directly through NetApp Management Console is displayed as a dataset of physical storage
objects.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Protection Policy to start the Dataset Policy Change wizard.
If you want to provision your nodes by resource pool, click the Provision and attach resources
using a policy option when it is displayed.
3. Complete the steps in the wizard.
Related concepts

Decisions to make before assigning or changing policies on page 100
What a protection policy does on page 190
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Related references

Administrator roles and capabilities on page 54
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Administrator roles and capabilities
The administrator roles determine the tasks you can perform. You must specify one or more
capabilities for every role, and you can assign multiple capabilities if you want the administrator to
have more control than a specific role provides. You can also customize a set of default global roles
and create new roles as necessary.
Default and custom roles
The following table lists the default global roles, descriptions, and capabilities associated with the
role.
Administrator role

Role description

Capabilities

GlobalAlarm

You can manage alarms.

DFMAlarmDelete
DFMAlarmRead
DFMAlarmWrite

GlobalDelete

You can view, modify, or
delete information in the
management server database,
including groups and members
of a group, monitored objects,
custom views, and primary and
secondary storage systems.

DFMAlarmDelete
DFMDatabaseDelete
DFMReportDelete

GlobalEvent

You can view, acknowledge,
and delete events and alerts.

DFMAlarmDelete
DFMAlarmRead
DFMAlarmWrite
DFMEventGenerate
DFMEventRead
DFMEventWrite

GlobalExecute

You can execute commands on
the storage system.

DFMConsoleExecute
DFMDatabaseRead
DFMDatabaseWrite
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Administrator role

Role description

Capabilities

GlobalFullControl

You can view and perform any DFMCoreControl
operation on any object in the
DFMCoreDelegate
management server database
and configure administrator
accounts. You cannot apply this
role to accounts with group
access control.

GlobalRead

You can view the management
server database, backup and
provisioning configurations,
events and alerts, performance
data, and policies.

DFMAlarmRead
DFMCoreAccessCheck
DFMDatabaseRead
DFMEventRead
DFMReportRead

GlobalReport

You can manage custom
reports and report schedules.

DFMReportDelete
DFMReportRead
DFMReportWrite

GlobalQuota

You can view user quota
reports and events.

DFMQuotaFullControl

GlobalWrite

You can view user quota
reports and events.

DFMAlarmWrite
DFMDatabaseWrite
DFMEventGenerate
DFMEventWrite
DFMReportWrite

477

Decisions to make before adding or changing
resource assignments
Before you add or change the physical resources assigned to an existing dataset node, you need to
gather the required information.
•

•

•

•

For each node in the dataset, which resource pool meets its protection or provisioning
requirements?
For example, if you have the NetApp Management Console data protection capability, the
resource pool you assign to a mirror node should contain physical resources that are appropriate
for mirrored copies of the dataset.
If you have the provisioning or protection capabilities, the resource pool you assign to a dataset
node should contain physical resources that are appropriate and large enough for the provisioning
needs of the data contained in the dataset node.
What if there are no resource pools that meet the protection or provisioning requirements of the
dataset node?
If no resource pool meets the protection or provisioning requirements of a dataset node, you can
use the Resource Pools window to create a new resource pool for each node.
If you have the NetApp Management Console data protection capability with disaster recovery,
can you choose not to use resource pools?
You can select physical resources for the backup and mirror nodes of your dataset. If you choose
to select storage outside of a resource pool, the NetApp Management Console data protection
capability does not create volumes but instead uses the volumes you select for that dataset node.
You can manually provision your dataset. If you choose to provision your dataset on storage
outside of a resource pool, the NetApp Management Console provisioning capability does not
create volumes but instead uses the volumes that you select for that dataset node.
If you have the provisioning or disaster recovery, can you choose not to use resource pools?
You can manually provision your dataset. If you choose to provision your dataset on storage
outside of a resource pool, the NetApp Management Console provisioning capability does not
create volumes but instead uses the volumes that you select for that dataset node.
If you choose to associate a vFiler unit with a nonprimary node in a dataset, any volumes that are
provisioned for that dataset must be associated with the vFiler unit. (Therefore, when you view a
list of the dataset volumes, only volumes that are owned by the vFiler are displayed.)

478 | Provisioning and Data Protection Online Help

Provisioning Help
What the NetApp Management Console provisioning
capability is
the NetApp Management Console provisioning capability helps you simplify and automate the tasks
of provisioning and managing storage for the data in datasets.
The NetApp Management Console provisioning capability provides the following capabilities:
•
•
•
•
•
•
•
•
•

Provisioning policies that manage provisioning and exporting of storage
Automatic provisioning of a dataset when you assign a provisioning policy to it
Periodic checking of provisioned storage for conformance to the policy
Manual controls for adding volumes or qtrees to a dataset on existing storage and newly
provisioned storage
Manual controls for resizing volumes and for deleting old Snapshot copies on existing storage
and newly provisioned storage
Migration of datasets and vFiler units to new storage systems
Deduplication to eliminate duplicate data blocks to reduce storage space
Dashboard views of resource status, and space status, and error and warning messages to be
issued when user-set space usage and overcommitment thresholds are exceeded
Storage services support that lets you create preconfigured bundles of protection policies,
provisioning policies, resource pools, and vFiler templates (for vFiler unit creation and
attachment), that you can assign to a set of data in accordance with that data's provisioning and
protection needs

Dashboards
A dashboard is a window that contains multiple information panels that provide cumulative at-aglance information about your systems.

Overview of the NetApp Management Console dashboard
The NetApp Management Console provides an overview of various aspects of your data management
environment, including protection, provisioning, and monitoring information.
The specific dashboard panels that are displayed change according to the application or capability
that is currently selected.
Protection
dashboard

The Protection dashboard helps you to determine the current overall protection
status of your data and resources, such as the number of objects that are protected,
the number of objects that are unprotected, the longest lag times of external
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relationships, and system events to be addressed. You can also gather data for
evaluating system actions and to assist in determining how to set up datasets,
policies, and schedules for the future. Disaster recovery-related failover readiness
and status information is also displayed.
Provisioning
dashboard

The Provisioning dashboard helps you to determine the current overall status of
dataset and resource pool provisioning. In addition to listing system events to be
addressed, information provided for datasets includes conformance status,
resource status, and space status. Information provided for resource pools includes
space status and overall utilization. This information can help you determine when
you need to increase available space for your datasets or when you need to
investigate out-of-conformance issues.

Monitor
dashboard

The Monitor dashboard in Performance Advisor displays information about the
current overall performance status of your systems, such as performance events,
top storage systems by the total number of operations, top storage systems by
network throughput, top storage systems by CPU utilization, Top Nodes by CPU
Utilization and Top Vservers by Total Ops. You can modify the default settings to
configure any view on the global group as a dashboard.

You can filter the content of the Protection and Provisioning dashboard panels by using the Group
selection list on the console tool bar. This option enables you to focus on information about a
particular group, such as specific datasets or resource pools.
. In the Protection
Information about the dashboard can be viewed by clicking the Help menu or
and Provisioning dashboards, there is an additional Help icon available at the top of each dashboard
panel that brings up a Help page with information about the panel.

Dashboard panel descriptions
The dashboard panels provide a cumulative at-a-glance status information about your system.
Dashboards are provided for each application or capability available in NetApp Management
Console.
•

•
•

Protection dashboard on page 480: The individual panels in this dashboard provide status on data
that is protected and managed by the NetApp Management Console data protection capability,
data that is unprotected, and external relationships, which have protection configured but are not
managed by the NetApp Management Console data protection capability.
Provisioning dashboard on page 481: The individual panels in this dashboard provide space
management information related to datasets and resource pools.
Performance Advisor dashboard on page 481: The individual panels in this dashboard provide
information about performance.

You must be assigned the appropriate privileges to view the dashboard panels.
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Protection dashboard
You can view more information about each dashboard panel and its contents by clicking
dashboard panel title bar.

in the

Failover
Readiness

Displays the number of datasets that are configured for disaster recovery
protection and in the failover ready state. This indicates that the datasets can
successfully perform failover operations, if failover operations become
necessary.

Failover Status

Appears when a failover operation is invoked. This panel lists the number of
datasets in the process of failing over and the number of datasets that have
successfully failed over.

Top Five Events Displays the five events with the highest severity levels. Events are ordered first
by severity, then by time that they occurred.
Dataset
Protection
Status

Displays the total number of datasets, grouped according to their current
protection status.

Protected Data

Displays the total number of objects that are protected and managed by the
NetApp Management Console data protection capability. Objects included in
this panel are datasets that have an assigned protection policy and have a
relationship created (the dataset has conformed to the protection policy at least
once), and volumes, qtrees, and Open Systems SnapVault (OSSV) directories
that are in a SnapVault or SnapMirror relationship, which is managed by the
NetApp Management Console data protection capability, and are not in an
external relationship.

Unprotected
Data

Displays the total number of datasets, volumes, and qtrees that are not protected.
Datasets are unprotected if they do not have an assigned protection policy or if
they have an assigned protection policy but do not have a relationship created
(the dataset has never conformed to the protection policy). Volumes and qtrees
are unprotected if they are not in a SnapVault or SnapMirror relationship which
is managed by the NetApp Management Console data protection capability, and
are not in an external relationship.

Dataset Lags

Displays the top five datasets with the longest lags. A dataset lag occurs when a
protection component is out of date with the primary data. This panel groups
relationships according to dataset, sorts relationships according to lag, selects
the longest lag for each dataset, and displays the datasets in decreasing order of
lag.

External
Relationship
Lags

Displays the top five external SnapVault or SnapMirror relationships with the
longest lags. These relationships are not managed by the NetApp Management
Console data protection capability.
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Provisioning dashboard
You can view more information about each dashboard panel and its contents by clicking
dashboard panel title bar.

in the

Dataset
Conformance Status

Displays the total number of datasets that are conforming to associated
policies.

Top Five Events

Displays the five events with the highest severity levels. Events are ordered
first by severity, then by time that they occurred.

Dataset Resource
Status

Displays the number of datasets at different levels of resource status
severity. The status represents the worst event severity on all direct and
indirect members of the dataset nodes.

Dataset Space Status Displays the total number of datasets being managed by NetApp
Management Console, grouped according to their current space status
value. The status represents the worst space status of all members in all
nodes of the dataset. Events are generated at the dataset level when the
space status of a dataset changes.
Resource Pool Space Displays the total number of resource pools that currently meet or exceed
the space thresholds.
Status
Resource Pools

Displays, by resource pool name, the total space allocated to and the space
utilization of each resource pool. Items are sorted in increasing order of
available space.

Performance Advisor dashboard
You can view more details about the Performance Advisor dashboard by clicking
dashboard panel title bar.

in the

Dashboard panels
Top Performance
Events

Displays the five events with the highest severity levels. Items are ordered
first by severity, then by time that they occurred. More detail about each
event is provided in Monitor > Events.

Top Nodes by CPU
Utilization

Displays a bar chart of the top five nodes that are discovered and monitored
by the DataFabric Manager server, and sorted by the highest CPU
utilization. The vertical axis displays the percentage of CPU utilization for
that node. The horizontal axis displays the node name.

Top Vservers by
Total Ops

Displays a bar chart of the top five Vservers that are discovered and
monitored by the DataFabric Manager server, and sorted by the highest total
operations. The vertical axis displays the total operations per second for that
Vserver. The horizontal axis displays the Vserver name.
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Dashboard panels
Top Performance
Events

Displays the five events with the highest severity levels. Items are ordered
first by severity, then by time that they occurred. More detail about each
event is provided in Monitor > Events.

Displays a bar chart of the top five storage systems, sorted by the highest
Top Storage
Systems by Network network throughput. The number above each bar chart displays the exact
value of the throughput per second from that system. The vertical axis
Throughput
displays the megabytes of throughput per second. The horizontal axis
displays the name of the storage system.
Top Storage
Systems by Total
Ops

Displays a bar chart of the top five storage systems, sorted by the highest
total operations. The vertical axis displays the total operations per second
for that storage system. The horizontal axis displays the storage system
name.

Top Storage
Systems by CPU
Utilization

Displays a bar chart of the top five storage systems, sorted by the highest
average CPU utilization. The number above each bar chart displays the
exact value of the throughput per second from that system. The vertical axis
displays the percentage CPU usage of the storage system. The horizontal
axis displays the name of the storage system.

Related references

List of events and severity types on page 16

What datasets are
A dataset consists of a collection of storage sets along with configuration information associated with
their data. The storage sets associated with a dataset include a primary storage set used to export data
to clients, and the set of replicas and archives that exist on other storage sets. Datasets represent
exportable user data.

About datasets
You can use datasets to group data and use resource pools to group storage to simplify the
monitoring, provisioning, reporting, and access control of your SnapVault and SnapMirror
relationships, which enables flexible and efficient use of storage.
Dataset concepts
Associating data protection, disaster recovery, a provisioning policy, or a storage service with a
dataset enables storage administrators to automate tasks, such as assigning consistent policies to
primary data, propagating policy changes, and provisioning new volumes, qtrees, or LUNs on
primary and secondary dataset nodes.
Configuring a dataset combines the following objects:
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For protection purposes, a collection of physical resources on a primary node,
Dataset of
physical storage such as volumes, FlexVol volumes, and qtrees, and the physical resources for
copies of backed-up data on secondary and tertiary nodes.
objects
For provisioning purposes, a collection of physical resources, such as volumes,
FlexVol volumes, qtrees, and LUNs, that are assigned to a dataset node. If the
protection policy establishes a primary and one or more nonprimary nodes, each
node of the dataset is a collection of physical resources that might or might not
be provisioned from the same resource pool.
Dataset of
virtual objects

A collection of supported VMware virtual objects that reside on storage systems.
These virtual objects can also be backed up locally and backed up or mirrored on
secondary and tertiary nodes.

Application
dataset

A dataset managed by an application that is external to the protection and
provisioning capabilities, such as a dataset managed by SnapManager for Oracle.

Resource pool

A collection of physical resources from which storage is provisioned. Resource
pools can be used to group storage systems and aggregates by attributes, such as
performance, cost, physical location, or availability. Resource pools can be
assigned directly to the primary, secondary, or tertiary nodes of datasets of
physical storage objects.
They can be assigned indirectly both to datasets of virtual objects and to datasets
of physical storage objects through a storage service.

Data protection A set of rules that define how to protect primary data on primary, secondary or
tertiary storage, as well as when to create copies of data and how many copies to
policy
keep.
Protection policies can be assigned directly to datasets of physical storage
objects. They can be assigned indirectly to both datasets of virtual objects and to
datasets of physical storage objects through a storage service.
Provisioning
policy

A set of rules that define how to provision storage for the primary or secondary
dataset nodes, and provides rules for monitoring and managing storage space and
for allocating storage space from available resource pools.
Provisioning policies can be assigned directly to the primary, secondary, or
tertiary nodes of datasets of physical storage objects. They can be assigned
indirectly to both datasets of virtual objects and datasets of physical storage
objects through a storage service.

Storage service

A single dataset configuration package that consists of a protection policy,
provisioning policies, resource pools, and an optional vFiler template (for vFiler
unit creation). You can assign a single uniform storage service to datasets with
common configuration requirements as an alternative to separately assigning the
same protection policy, provisioning policies, and resource pools, and to setting
up similar vFiler unit attachments to each of them.
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The only way to configure a dataset of virtual objects with secondary or tertiary
backup and mirror protection and provisioning is by assignment of a storage
service. You cannot configure secondary storage vFiler attachments for datasets
of virtual objects.
Protection or
provisioning
related objects

Snapshot copies, primary volumes, secondary volumes, or secondary qtrees that
are generated as a result of protection policy or provisioning policy protection
jobs or provisioning jobs.

Naming settings Character strings and naming formats that are applied when naming related
objects that are generated as a result of protection policy or provisioning policy
protection jobs or provisioning jobs.
Related concepts

Overview of resource pools on page 64
What a policy is on page 392
Dataset guidelines on page 77
What groups are on page 67
About storage services on page 212
Dataset guidelines
These guidelines can help you optimize the advantages of using datasets.
•

•

•

Group similar data
For protection purposes, group primary volumes, LUNs, or qtrees that have identical data
protection requirements into one dataset.
Avoid provisioning loops
For provisioning purposes, a dataset cannot contain a storage system that is also in a resource
pool assigned to a dataset node. This constraint prevents a loop that attempts to provision an
infinite number of volumes.
Use dataset-level custom naming
When creating or editing a dataset, you can customize the naming rules that get applied to the
Snapshot copies, primary volumes, secondary volumes, and secondary qtrees that are created by
the NetApp Management Console protection and provisioning operations on that dataset.
Customized naming of these dataset-related objects offers the following management advantages:
•
•

•

Easy location of secondary and tertiary storage backup items for restore operations
Easy identification of backup data by priority, business unit, administrator, backup time,
physical container, or logical container
• Customization of formats to maintain naming used by imported protection relationships
• Easy identification of backup data related to protection, SnapManager, or SnapDrive
operations
• Easy identification of source and secondary volumes in case of application shutdown
Use custom fields
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When creating or editing a dataset, you can use user-defined custom fields to identify the dataset
for a specific purpose. For example, you might associate a cost center or chargeback code with
the dataset. To use a custom field, you must create the custom field before you add or edit a
dataset.
How the NetApp Management Console data protection capability uses datasets of physical
objects
The NetApp Management Console data protection capability uses the information in a dataset to
create Snapshot copies used for backups and mirror copies, to provision storage as needed for the
copies, and to transfer the copies to backup or mirror nodes.
After you set up a dataset of physical objects for protection, you can perform the following
operations using the NetApp Management Console data protection capability:
1. The NetApp Management Console data protection capability provisions volumes and qtrees on
the destination node in several ways. For storage systems that run Data ONTAP 7.0 or later, it
automatically provisions flexible volumes and qtrees when the resource pool contains an
aggregate. For storage systems that run Data ONTAP 6.5 or earlier, you manually add secondary
storage to the destination node. If you manually select storage without using resource pools for a
SnapMirror destination node, the NetApp Management Console data protection capability
provisions traditional volumes assigned to that destination node.
2. The NetApp Management Console data protection capability creates backup relationships (either
SnapVault or SnapMirror) between volumes and qtrees in the dataset with the newly provisioned
secondary storage.
3. The NetApp Management Console data protection capability runs the data protection schedules,
making Snapshot copies of the primary data and initiating SnapVault and SnapMirror baseline
transfers at the scheduled times.
4. The NetApp Management Console data protection capability periodically checks that the dataset
conforms to its data protection policy. If either the dataset membership or the policy changes, it
tries to bring the dataset back into conformance, or it notifies you that the conformance status
changed to nonconformant.
How the NetApp Management Console provisioning capability works with datasets of
physical objects
The NetApp Management Console provisioning capability simplifies and automates the tasks of
provisioning and managing storage for the data in datasets of physical objects.
After you add a dataset for provisioning, the NetApp Management Console provisioning capability
can provide the following services:
•

Provision the dataset of physical objects
The NetApp Management Console provisioning capability provisions volumes and qtrees (in
NAS environments) or volumes and LUNs (in SAN environments) for a dataset using the
resource pool assigned to the dataset. In SAN environments, a provisioned volume can be
delegated to SDx applications and used to create qtrees or LUNs.
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The NetApp Management Console provisioning capability can provision volumes, qtrees, or
LUNs on the backup and mirror dataset nodes.
Note: You are advised NOT to use SnapDrive for Windows versions earlier than 5.0 to connect
to mapped LUNs that are provisioned using the NetApp Management Console provisioning
capability. Doing so might result in an error requiring the LUNs to be manually unmapped.

•

•

•

•

•

Configure automatic storage using policies and templates
When you create a dataset for provisioning, you can assign a provisioning policy that provides
settings for automatically configuring storage for the dataset.
Allow manual addition of storage space
You can manually add additional volumes, qtrees, or LUNs, at any time, to a dataset that has a
provisioning policy assigned.
Handle dataset-managed protocols for exporting data
Protocols for exporting data are automatically handled by the dataset.
You can also assign a vFiler template to a vFiler host. When a vFiler host is created, the vFiler
template provides default settings for automatically configuring the vFiler host.
Check for conformance
The NetApp Management Console provisioning capability periodically checks that the dataset
conforms to its provisioning policy. For example, if the data in a dataset reaches a specified
threshold level, the NetApp Management Console provisioning capability tries to create
additional space according to the provisioning policy, either by increasing the storage container
size or deleting old Snapshot copies, or both. If it cannot bring the dataset back into conformance,
it notifies you that the conformance status changed to nonconformant.
Allow manual management of storage space
NetApp Management Console provides manual controls for viewing and resizing individual
volumes or qtrees and modifying volume data and Snapshot copy space allocations.

Overview of export protocols
You can configure NFS, CIFS, iSCSI, or Fibre Channel (FC) export protocols for client access to a
dataset. You can configure an export protocol for an entire dataset by assigning a provisioning policy
or for a specific dataset member.
You can specify support for export protocol access when you create a dataset, when you reconfigure
the primary, backup, or mirror nodes in your dataset, or when you provision a new volume, LUN, or
qtree into the dataset.
There are two ways that you can export storage in a dataset.
•

•

Enable one export protocol for an entire primary, backup, or mirror node of a dataset
Clients can access all of the storage, that is all volumes, qtrees, and LUNs, in a particular dataset
node by using the specified protocol.
To achieve this configuration, specify export settings for the primary node when completing the
Add Dataset wizard and for the backup and mirror nodes by using the Dataset Policy Change
wizard.
Assign different export protocols to each new volume, LUN, or qtree member
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You can assign different export protocols to each new volume, LUN, or qtree member when you
provision the member into a dataset, rather than specifying an export protocol for the entire
dataset node. Clients can selectively access dataset members, based on the protocols enabled for
each client and each dataset member.
To achieve this configuration, do not specify an export protocol when creating the dataset.
Instead, use the Provisioning wizard to provision a new member into a dataset and select the
option to export the new member.
Related concepts

Overview of export protocol properties on page 112
Related tasks

Configuring dataset nodes for NFS protocol access on page 114
Configuring dataset nodes for CIFS protocol access on page 113
Configuring dataset nodes for FC protocol access on page 115
Configuring dataset nodes for iSCSI protocol access on page 116
When to configure datasets
You should configure datasets when you have identified which data to group for protection or
provisioning.
You can also configure datasets in the following situations:
Protection

•
•

•

•
•
•
Provisioning •
•
•

You are setting up data protection for the first time.
You previously used Backup Manager or Disaster Recovery Manager and are
upgrading to the NetApp Management Console data protection capability, and
you want to import existing relationships that the NetApp Management Console
data protection capability discovered.
You never used Operations Manager to monitor or manage your SnapVault or
SnapMirror relationships and want to import existing relationships that the
NetApp Management Console data protection capability discovered.
A condition changed that affects the status of the dataset, and you want to change
the protection policy.
You are monitoring your storage resources by viewing the dashboard, which
displays all resources, including resources that are unprotected.
You added a storage system, or the DataFabric Manager server discovered it, and
you want to protect the data on that storage system.
You are setting up provisioning for the first time.
You want to provision an existing dataset that has not yet been provisioned.
You need to add another volume or LUN to an existing dataset.
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•
•

A condition changed that affects the status of the dataset, and you want to change
the provisioning policy.
You are monitoring your storage space usage by viewing the dashboard, and it
displays a warning for a dataset member that is running out of space.

Dataset storage space management
The NetApp Management Console provisioning capability enables you to view space allocations for
volumes, LUNs, and qtrees. You can also resize individual volumes or qtrees, and modify volume
data and Snapshot copy space allocations in response to space-usage generated error or warning
events.
The space allocation changes that you make apply only to the selected volume or qtree, not to any
other volumes or qtrees in the dataset. You can specifically edit the space allocation for data and
Snapshot copies as long as the space allocation remains compliant with the provisioning policy
assigned to the associated dataset primary, backup, or mirror node.
When to manually manage storage space for a dataset
In most cases, you perform space management tasks on a volume, or qtree when a space-usage
generated warning or error event alerts you to the fact that an individual storage container in one of
your managed datasets has reached, or is close to reaching, its configured maximum capacity to hold
new data.
At this point, in many cases, the simplest and most immediate remedy is to make more data space
available for those individual volumes or qtrees.
Note: The only management task that you can perform on a LUN is to delete the LUN.

How to view dataset storage space utilization
You can use the Resource Pools window Space breakout tab to see how much space each dataset is
currently using, which is helpful for determining when a dataset needs to be migrated to a larger
aggregate in another storage system.
The Space breakout tab lists the aggregates assigned to the resource pool that is selected in the
Resource Pools window. When you select an aggregate, all the datasets in the aggregate and the
percentage and amount of currently used space for each dataset are displayed.
Datasets that have a high percentage of utilization are good candidates for migration.

Provisioning Help | 489

Overview of tasks for managing storage space
You can perform different data protection and provisioning tasks to manage the storage space for a
dataset.
Survey your volumes
and qtrees

You can scan the tables on the Provisioning tab to pinpoint the volumes
and qtrees that are approaching their data and Snapshot copy space
limitation.

Diagnose your space
management warning
and error statuses

You can check the diagnosis of the volumes or qtrees whose space
status is Warning or Error.

In nodes containing volumes or qtrees, you can expand a volume to
Resize your volume or
qtree data and Snapshot claim more uncommitted aggregate space or you can increase a qtree
quota to claim more uncommitted volume space. You can also
space
reallocate the space in a volume specifically reserved for Snapshot
copies and specifically used for data.
Delete Snapshot copies

You can delete individual Snapshot copies in a volume to make more
space available for data.

Delete storage
containers

You can delete unneeded volumes and return the space that they used to
the containing aggregate for reallocation. You can delete LUNs and
qtrees and return the space they used to the containing volume for
reallocation.

Related concepts

Dataset migration versus volume migration on page 671
Volume migration configuration requirements on page 671
Space management resize options
The NetApp Management Console provisioning capability provides you with three options to resize
or reallocate space on existing volumes. It also enables you to expand hard quotas on existing qtrees.
Volume
resize
options

Depending on the type of volume (NAS or SAN), the NetApp Management Console
provisioning capability enables you to modify one or more of the following
parameters:
Total volume
size

You can increase the total space allowed for the selected NAS or
SAN volume within its containing aggregate. If you are not
allowing space overcommitment, you are limited by the amount of
space still available in the containing aggregate.

Snap reserve
%

The percentage of space in the selected flexible volumes reserved
for Snapshot copies. Snap reserve % is adjustable on NAS
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volumes. As you adjust the percentage up or down, the NetApp
Management Console provisioning capability displays the absolute
allocation of Snapshot copy reserve space in the Snap Reserve
field.
Maximum size
limit
Qtree
resize
option

If the Autogrow property is enabled on a SAN or NAS volume,
you can modify the Maximum size limit.

The NetApp Management Console provisioning capability enables you to enlarge the
hard quota for a qtree if the qtree is configured with a hard quota.

About naming settings for protection or provisioning related objects
To improve recognition and usability, you can customize the dataset-level naming settings for
protection or provisioning related objects, Snapshot copies, primary volumes, secondary volumes,
and secondary qtrees that are created by default by NetApp Management Console protection and
provisioning operations on datasets.

Differences between global and dataset-level naming settings
Global naming settings apply, by default, to all objects that are generated in datasets that are not
configured with dataset-level naming settings. Dataset-level naming settings are configured for
individual datasets and apply only to the objects that are generated in those datasets.
Global naming settings
Protection-related objects are, by default, automatically named using a global naming format for each
object type.
The OnCommand console enables you to customize the global naming settings for one or more
related object type. After you customize the global naming format for a particular object type, that
customization then applies by default to all newly generated objects of that type that do not belong to
a dataset with conflicting dataset-level naming settings.
However, if the newly generated object is part of a dataset that already has customized dataset-level
Snapshot copy, primary volume, secondary volume, or secondary qtree naming formats, then the
customized naming formats apply to that object.
Dataset-level naming settings
Both the OnCommand console and NetApp Management Console enable you to configure datasetlevel naming settings for one or more object types in a particular dataset. Those dataset-level naming
settings then apply to the naming of their object types within that dataset.
Within that dataset, dataset-level naming settings have priority over any conflicting global naming
settings.
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When to customize naming of protection-related objects
To support backup tasks, storage administration tasks, and application administration tasks, you can
customize naming of NetApp Management Console protection-related objects.
Custom naming and backup tasks
If you are a backup administrator, configuration of custom naming presents you with the following
advantages:
•

•

•

•

•

Easy location of secondary and tertiary storage backup items for restoration
Custom naming applied to Snapshot copies, secondary volumes, or secondary qtrees enables you
to easily identify the backup objects in which to locate files for restoration.
Easy identification of backup data by an assortment of criteria
Custom naming, configured with specific naming conventions and applied to the backup objects,
enables you to identify those objects by priority, business unit, administrator, backup time,
physical container, or logical container.
Customization of formats to maintain naming used by imported protection relationships
Custom naming can be used by NetApp Management Console to assign naming formats for
related objects that matches the related object naming conventions originally used by imported
protection relationships.
Easy identification of backup data related to protection, SnapManager, or SnapDrive operations
A consistent naming convention enables you to easily find the right data to restore even if that
backup data is related to such disparate activities as NetApp Management Console protection
operations, SnapManager activity, or SnapDrive activity.
Easy identification of source and secondary volumes in case of application shutdown
If the database application that is generating the backed up data shuts down, the naming formats
of the associated Snapshot copy, secondary volume, or secondary qtree objects, if set properly,
enable you to identify primary volumes from the names of the secondary volumes and Snapshot
copies that are associated with that application.

Custom naming and storage management tasks
If you are a storage administrator, configuration of custom naming enables you to specify a
company-wide naming convention for related objects at the global level or at the dataset level.
Custom naming and application management tasks
If you are an application administrator and have specified a particular dataset in which to store data
generated by a particular application, custom naming enables you to specify distinctive naming
conventions for that dataset's related object types. The distinctive naming enables you to track the
objects that are generated by that application more easily.
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Naming settings by format strings
The NetApp Management Console naming settings enable you to enter custom format strings that
contain letter attributes for identifying information to include in the names of protection-related
objects.
The attributes that you can include in the format strings cause such identifying characteristics as
timestamps, storage system names, custom labels, dataset names, and retention type to be included in
the name of a protection-related object type.
Snapshot copy naming settings
Snapshot copy naming settings determine how Snapshot copies that are generated by NetApp
Management Console protection jobs are named.
Default Snapshot copy naming format
The default global naming attribute format for Snapshot copies generated by NetApp Management
Console protection operations is %T_%R_%L_%H_%N_%A (Timestamp_Retention
type_Custom label_Storage system name_Volume name_Application field).
This format applies to the naming of all Snapshot copies generated by NetApp Management Console
protection operations.
Snapshot copy naming attributes
Snapshot copy names can be configured to contain the following attributes:
%T (Timestamp)

Indicates the year, month, date, and time of the Snapshot copy. Timestamp
is in the format yyyy-mm-dd_hhmm (along with UTC offset).

%R (Retention type) Indicates whether the Snapshot copy's retention class is hourly, daily,
weekly, monthly, or unlimited.
%L (Custom label)

Enables you to specify a custom alphanumeric character, . (period), _
(underscore), or - (hyphen), to include in the names of the related objects
that are generated by protection jobs that are run on this dataset. If the
naming format for a related object type includes the Custom label
attribute, then the value that you specify is included in the related object
names. If you do not specify a value, then the dataset name is used as the
custom label. If you include a blank space in the custom label string, the
blank space is converted to letter x in any Snapshot copy, volume, or qtree
object name that includes the custom label as part of its syntax.

%H (Storage system Indicates the name of the storage system that contains the volume from
which a Snapshot copy is made.
name)
%N (Volume name)

Indicates the name of the volume from which a Snapshot copy is made.
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%A (Application
fields)

Indicates application-inserted fields. For the NetApp Management Console
data protection capability, it is a list of qtrees present in the volume from
which a Snapshot copy is made.

%1 (One-digit
suffix), %2 (Twodigit suffix), or %3
(Three-digit suffix)

Specifies a one-digit, two-digit, or three-digit suffix if required to
distinguish Snapshot copies.

Example: Snapshot copy custom naming
If a dataset has a custom label of "my_data," includes a volume named "myVol" on a storage
system named "mgt-u35," and is configured for Hourly backup, then the following Snapshot
copy format strings result in the following names for the resulting Snapshot copies:
Format string

Resulting name

%L_%R_%T_%H

my_data_hourly_2010-03-04_0330+0430_mgt-u35

%T_myunit_%L-mysection-%R 2010-03-04_0330_myunit_my_data-mysection-hourly
myunit-mydept-%R_%H_%T

myunit-mydept-hourly_mgt-u35_2010-03-04_0403-0800

%R_%T_%N_%A

hourly_2010-03-04_0330_myVol_qtree1_qtree2_qtree3

%T

2010-03-04_0330 (if no UTC offset)
2010-03-04_0330+0530 (for IST)

%L_%R_%H_%2

my_data_hourly_mgt-u35_01
my_data_hourly_mgt-u35_02

Snapshot copy naming exceptions
The following are Snapshot copy naming exceptions:
•

•

•

When a SMHV plug-in creates a Snapshot copy in a host system, the plug-in creates two
Snapshot copies for every backup.
The second Snapshot copy has the string "_backup" appended to the end of the Snapshot copy
name irrespective of the order of attribute selection.
When a SMHV plug-in creates a Snapshot copy, and the Snapshot copy name exceeds the SMHV
Snapshot copy character limit, the SMHV plug-in does not truncate the name by removing the
characters of the Application fields attribute.
Instead, it truncates the name by removing characters before the Application fields
attribute, from right to left.
For Snapshot copies created by a SMHV plug-in, if the Application fields attribute is not
specified, it is added automatically at the end of the naming format.
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•
•

•

•

•

For Snapshot copies created by a SMVI plug-in, if the Application fields attribute is not
specified, it is not added to the naming format.
For Snapshot copies created by the NetApp Management Console data protection capability, if
the Application fields attribute is not mentioned, it is not added implicitly in the naming
format.
When SMVI plug-in creates a Snapshot copy, and the Snapshot copy name exceeds the SMVI
Snapshot copy character limit, SMVI plug-in does not truncate the name by removing the
characters of the Application fields attribute.
Instead, it truncates the name by removing characters before the Application fields
attribute, from right to left.
If you want to use scripts to generate the Snapshot copy name, and if the Snapshot copy is
generated by the SnapManager plug-in in the host system, the plug-in does not use the user script.
Instead, the plug-in uses the global naming format to create the Snapshot copy name. The user
script is used only if the Snapshot copy is created by the NetApp Management Console data
protection capability.
Snapshot copies created by the host system are in the local time zone of the host system.

Snapshot copy naming restrictions
The following are Snapshot copy naming restrictions:
•
•
•

•
•
•

The timestamp attribute is mandatory.
The Application fields attribute is mandatory in the custom Snapshot copy naming for all
application datasets controlled by the SMHV plug-in Host services.
The Snapshot copy name can only display ASCII alphanumeric characters, _ (underscore), (hyphen), + (plus sign), and . (dot).
Any other characters cause errors.
If there is no custom label for the dataset, the Snapshot copy name defaults to the dataset name.
UTF-8 encoded characters are not supported.
Including four digits reserved for suffixes, a Snapshot copy name cannot exceed 128 characters.
The Snapshot copy name, excluding the suffixes, can be no more than 124 characters. If the
generated Snapshot copy name exceeds 124 characters, then the name is truncated by removing
characters from right to left.
To avoid possible truncation of timestamp information from the Snapshot copy name, best
practice is to place the timestamp %T attribute at the left end of the format string.

Primary volume naming settings
Primary volume naming settings determine how primary storage volumes generated by NetApp
Management Console provisioning operations are named.
Default primary volume naming format
The default global naming format for primary volumes generated by NetApp Management Console
provisioning operations is %L (Custom label).
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The global format applies to the naming of all NAS primary volumes generated by NetApp
Management Console provisioning operations. The default global naming format does not apply to
SAN volumes, because they are named directly at the time of provisioning.
Primary volume naming attributes
Primary volume names can be configured to contain the following attributes:
%L (Custom
label)

Enables you to specify a custom alphanumeric character, . (period), _
(underscore), or - (hyphen) to include in the names of the related objects that
are generated by protection jobs that are run on this dataset. If the naming
format for a related object type includes the Custom label attribute, then the
value that you specify is included in the related object names. If you do not
specify a value, then the dataset name is used as the custom label. If you
include a blank space in the custom label string, the blank space is converted to
letter x in any Snapshot copy, volume, or qtree object name that includes the
custom label as part of its syntax.

%D (Dataset
name)

Indicates the actual name of the dataset in which a volume is created.

%1 (One-digit
suffix), %2
(Two-digit
suffix), or %3
(Three-digit
suffix)

Displays a one-digit, two-digit, or three-digit suffix if required to distinguish
primary volumes.

Example: Primary volume custom naming
If a dataset named "mydataset" has a custom label of "mydata", and a new volume is
provisioned through NetApp Management Console, then the following primary volume format
strings result in the following names for the resulting primary volumes:
Format string

Resulting name

%L_%D

mydata_mydataset

%L

mydata

pri_%L

pri_mydata

myunit-privol

myunit-privol

%L_%D_%3

mydata_mydataset_001
mydata_mydataset_002
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Primary volume naming exceptions
The following are primary volume naming exceptions:
•
•

If the primary volume's naming format in one or more datasets is customized, then the primary
volumes generated in those datasets are named according to the dataset-level format.
For a primary volume to be provisioned, if you specify the primary volume name from the
NetApp Management Console user interface, then the name that you specify in the user interface
takes precedence over the options for primary volume naming settings.

Primary volume naming restrictions
The following are the naming restrictions of primary volume:
•
•
•
•
•

•

All naming attributes are optional.
At least one attribute must be enabled at any point of time, or there should be some free-form
text.
In case of name conflict, numerical suffixes are appended to the names.
If the Custom label attribute is included in the naming format, but no custom name exists for a
dataset, the resulting names use the actual dataset name instead.
Including four digits reserved for suffixes, a primary volume name cannot exceed 64 characters.
The primary volume name, excluding the suffixes, can be no more than 60 characters. If the
generated primary volume name exceeds 60 characters, then the name gets truncated by removing
characters from left to right.
The primary volume name can only display ASCII alphanumeric characters and _ (underscore).
Any other characters cause errors. The primary volume name cannot start with a number.

Secondary volume naming settings
Secondary volume naming settings determine how secondary storage volumes that are generated by
NetApp Management Console protection operations are named.
Default secondary volume naming format
The default global naming format for secondary volumes generated by NetApp Management Console
protection operations is %V (Primary volume name).
This format applies to the naming of all secondary volumes generated by NetApp Management
Console protection operations.
Secondary volume naming attributes
Secondary volume names can be configured to contain the following attributes:
%L (Custom label)

Enables you to specify a custom alphanumeric character, . (period), _
(underscore), or - (hyphen) to include in the names of the related objects that
are generated by protection jobs that are run on this dataset. If the naming
format for a related object type includes the Custom label attribute, then

Provisioning Help | 497
the value that you specify is included in the related object names. If you do
not specify a value, then the dataset name is used as the custom label. If you
include a blank space in the custom label string, the blank space is converted
to letter x in any Snapshot copy, volume, or qtree object name that includes
the custom label as part of its syntax.
%C (Type)

Indicates the connection type (backup or mirror).

%S (Primary
storage system
name)

Indicates the name of the primary storage system.

%V (Primary
volume name)

Indicates the name of the primary volume.

%1 (One-digit
suffix), %2 (Twodigit suffix), or %3
(Three-digit suffix)

Displays a one-digit, two-digit, or three-digit suffix if required to distinguish
secondary volumes.

Example: Secondary volume custom naming
If a dataset has a custom label of "mydata," includes a primary volume named "myVol1" on a
primary storage system named "myhost1," and is configured for Hourly backup, then the
following secondary volume format strings result in the following names for the resulting
secondary volumes:
Format string

Resulting name

%L_C_%S_%V

mydata_backup_myhost1_myVol1

%C-%S-%L-destVol

backup_myhost1_mydata_destVol

%C_%L

backup_mydata

%V

myhost1

%C_%L_%1

backup_mydata_1
backup_mydata_2

Secondary volume naming exceptions
The following is secondary volume naming exception:
•

If secondary volume's naming format in one or more datasets is customized, then the secondary
volumes generated in those datasets are named accordingly.
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Secondary volume naming restrictions
The following are secondary volume naming restrictions:
•
•
•
•

•
•

•
•

All naming attributes are optional.
At least one attribute must be enabled at any point of time, or there must be some free-form text.
In case of name conflict, numerical suffixes are appended to the names.
If the Fan-in feature is enabled for a backup destination, and two or more qtrees from different
primary volumes are backed up into the same secondary volume, then the Primary storage
system name and Primary volume name attributes of the source volumes are randomly
selected to form the names of the secondary volumes.
For example, if host1:/vol1/qtr1, host2:/vol2/qtr2, and host3:/vol3/qt3 are backed up to one
secondary volume, then all the names for the secondary qtrees in that volume include one
common <Host name> and <Volume name> attribute combination character string. That
common string is either: "host1_vol1", "host2_vol2," or "host3_vol3."
If the Custom label attribute is included in the naming format, but no custom name exists for a
dataset, the resulting names use the actual dataset name instead.
Including four digits reserved for suffixes, a secondary volume name cannot exceed 64
characters.
The secondary volume name, excluding the suffixes, can be no more than 60 characters. If the
generated secondary volume name exceeds 60 characters, then the name gets truncated by
removing characters from left to right.
The secondary volume name can only display ASCII alphanumeric characters and _ (underscore).
Any other characters cause errors. The secondary volume name cannot start with a number.
When taking a backup of Open Systems SnapVault (OSSV) directories, if you include %V
(Primary volume name) attribute in the naming format, %V will be replaced with %S
(Primary storage system name).
This is because OSSV does not have the concept of volume.

Secondary qtree naming settings
Secondary qtree naming settings determine how secondary storage qtrees that are generated by
NetApp Management Console protection operations are named.
Default secondary qtree naming format
The default global naming format for secondary qtrees generated by NetApp Management Console
protection operations is %Q (Primary qtree name).
This format applies to the naming of all secondary qtrees generated by NetApp Management Console
protection operations.
Secondary qtree attributes
Secondary qtree names can be configured to contain the following attributes:
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%Q (Primary qtree The name of the primary qtree.
name)
%L (Custom label)

Enables you to specify a custom alphanumeric character, . (period), _
(underscore), or - (hyphen) to include in the names of the related objects
that are generated by protection jobs that are run on this dataset. If the
naming format for a related object type includes the Custom label
attribute, then the value that you specify is included in the related object
names. If you do not specify a value, then the dataset name is used as the
custom label. If you include a blank space in the custom label string, the
blank space is converted to letter x in any Snapshot copy, volume, or qtree
object name that includes the custom label as part of its syntax.

%S (Primary
storage system)

Indicates the name of the primary storage system.

%V (Primary
volume name)

Indicates the name of the primary storage volume.

%1 (One-digit
suffix), %2 (Twodigit suffix), or %3
(Three-digit suffix)

Displays a one-digit, two-digit, or three-digit suffix if required to distinguish
secondary qtrees.

Example: Secondary qtree custom naming
If a dataset has a custom label of "mydata," includes a primary qtree named "qtree1", and
primary volume named "myVol1" on a primary storage system named "myhost1," and is
configured for Hourly backup, then the following secondary qtree format strings result in the
following names for the resulting secondary qtrees:
Format string

Resulting name

%L_%S_%V_%Q

mydata_myhost1_myVol1_qtree1

%L_%S_%Q

mydata_myhost1_qtree1

%V_%Q

myVol1_qtree1

%L_%S_%V_%Q_%3

mydata_myhost1_myVol1_qtree1_001
mydata_myhost1_myVol1_qtree1_002

Secondary qtree naming exceptions
The following is secondary qtree naming exception:
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•

If secondary qtree naming format in one or more datasets is customized, the secondary qtrees
generated in those datasets are named accordingly.

Secondary qtree naming restrictions
The following are secondary qtree naming restrictions:
•
•
•
•
•

•

•

•

•

All naming attributes are optional.
At least one attribute must be enabled at any point of time, or there must be some free-form text.
In case of name conflict, numerical suffixes are appended to the names.
If the Custom label attribute is included in the naming format, but no custom name exists for a
dataset, the resulting names use the actual dataset name instead.
Including four digits reserved for suffixes, a secondary qtree name cannot exceed 64 characters.
The secondary qtree name, excluding the suffixes, can be no more than 60 characters. If the
generated secondary qtree name exceeds 60 characters, then the name gets truncated by removing
characters from left to right.
The secondary qtree name can only display ASCII alphanumeric characters, _ (underscore), (hyphen), and . (dot).
Any other characters cause errors.
When taking a backup of Open Systems SnapVault directories, if you include the Primary
volume name attribute in the naming format, it is replaced by the Primary storage system
attribute.
When taking a backup of Open Systems SnapVault directories, if you include the Primary
qtree name attribute in the naming format, it is replaced by the path of the root directory.
The characters of the root directory path that are not supported are converted to the letter x.
When taking a backup of Open Systems SnapVault directories, if you include the Primary
qtree name attribute in the naming format, and if the directory path contains non-ASCII
characters, or if the directory path is / (slash), then the Primary qtree name attribute is
replaced with the directory ID.

Configuring datasets
In general, you use a wizard to configure datasets and you use an editing window to modify property
values.
Decisions to make before adding datasets of physical storage objects (for protection)
Before you create a new dataset of physical storage objects, considering some preconfiguration
questions can help you choose a dataset name, how related objects generated for this dataset are
named, and what kind of protection and resources are assigned to the dataset's members.
Dataset
properties

•

Is there a dataset naming convention that you can use to help administrators
easily locate and identify datasets?
Dataset names can include the following characters but cannot be only
numeric:
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a to z
A to Z
0 to 9
. (period)
_ (underscore)
- (hyphen)
space

•

•
•

•

Dataset
naming
properties

•

•

Group
membership

•
•

Resources for
primary
storage

If you use any other characters when naming the dataset, they do not appear in
the name.
What is a good description of the dataset membership?
Use a description that helps someone unfamiliar with the dataset to understand
its purpose.
Who is the owner of the dataset?
If an event on the dataset triggers an alarm, who should be contacted?
You can specify one or more individual e-mail addresses or a distribution list
of people to be contacted.
If dataset members exist in multiple time zones, which time zone do you want
to use to schedule operations on the dataset?
You can specify a time zone in the wizard or use the default time zone, which
is the system time zone used by the DataFabric Manager server.
Do you want to use the actual dataset name or a custom label in your datasetlevel Snapshot copy, primary volume, secondary volume, or secondary qtree
naming?
For customizing the naming settings of object types, do you want the current
default naming format to apply to one or more object types that are generated
in this dataset?
If you want to customize the dataset-level naming formats for one or more
object types, in what order do you want to enter the naming attributes for
Snapshot copy, primary volume, secondary volume, or secondary qtree?
Do you need to create a group of datasets and resource pools based on
common characteristics, such as location, project, or owning organization?
Is there an existing group to which you want to add this dataset?

Will you assign a resource pool or individual physical resources as destinations
for your primary storage?
If using a resource pool, consider the following details:
•

For the primary node in the dataset, which resource pool meets its provisioning
requirements?
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•
•

If no resource pool meets the requirements of the primary node, you can create
a new resource pool for each node at the Resource Pools window.
Verify that you have the appropriate software licenses on the storage you
intend to use.

If using individual resources, consider the following details:
•
•
Protection
policy

After you create a new dataset of physical objects, you protect it by running the
NetApp Management Console Dataset Policy Change wizard to assign a
protection policy.
•

•

Resources for
secondary or
tertiary
storage

If you prefer not to use resource pools for automatic provisioning, you can
select individual physical resources as members of your dataset.
Verify that you have the appropriate software licenses on the storage you
intend to use.

Which protection policy meets the requirements of the dataset?
Review the policies listed on the Protection Policies window to see if any are
suitable for your new dataset.
If no protection policy meets the requirements of your new dataset, is there a
protection policy that would be suitable with minor modifications?
If so, you can copy that protection policy to create a new policy you can
modify as needed for the new dataset. If not, you can run the Add Protection
Policy wizard to create a new policy for the dataset.

When you assign a protection policy, will you assign a resource pool or individual
physical resources as destinations for your backups and mirror copies?
You do not have to assign a resource pool or physical resources to a node to create
a new dataset. However, the dataset will be nonconformant with its policy until
resources are assigned to each node, because the NetApp Management Console
data protection capability cannot perform the protection specified by the policy.
If using a resource pool:
•

•
•

For the secondary or tertiary nodes in the dataset, which resource pool meets
their provisioning requirements?
For example, the resource pool you assign to a mirror node should contain
only physical resources that would be acceptable destinations for mirror copies
created of the dataset members.
If no resource pool meets the requirements of a node, you can create a new
resource pool for each node at the Resource Pools window.
Verify that you have the appropriate software licenses on the storage you
intend to use.

If using individual resources:
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•

If you prefer not to use resource pools for automatic provisioning, you can
select individual physical resources as destinations for backups and mirror
copies of your dataset.
Verify that you have the appropriate software licenses on the storage you
intend to use.

•

Related concepts

Effect of time zones on schedules on page 220
What a protection policy does on page 190
Overview of resource pools on page 64
Protection policy node prerequisites on page 195
What a provisioning policy is on page 600
Related references

Administrator roles and capabilities on page 54
Decisions to make before adding datasets of physical storage objects (for provisioning)
You must gather certain provisioning information before you use the Add Dataset wizard to create a
new dataset of physical storage objects. A dataset can have a single node or, if you assign a
protection policy to it, a dataset can have a primary and one or more nonprimary nodes. When you
first create a dataset, you configure the provisioning for the primary node only.
Provisioning
policy for
primary node

Do you want to assign a provisioning policy to manage the storage resources, or
do you want to manually assign resources?
•

•

•

If you want to use a provisioning policy, have you already configured a
policy that meets the requirements of the data in the dataset primary node?
Review any existing policies that are listed in the Provisioning Policies
window to see if any are suitable for your new dataset.
If no current provisioning policy meets the requirements of your new dataset,
is there a policy that would be suitable with minor modifications?
If so, you can copy that policy and then modify it as needed. If no suitable
provisioning policy exists, you can run the Add Provisioning Policy wizard to
create a new policy.
If you do not want to assign a provisioning policy at the time the dataset is
created, you can assign a provisioning policy to the primary node later.
Note: After the dataset is added, whether or not it has a provisioning policy
assigned, you can also provision new members for the dataset by using the
Provisioning wizard.
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•

•

If you assign a NAS-based provisioning policy, do you want to enable CIFS
or NFS export protocol access to the members of this dataset node?
You can enable one or both export protocols for all members of this node
when you configure the dataset. You can also decline to enable export
protocols at the dataset node level and later enable export protocols for
individual members as you provision them into this dataset.
However, you cannot enable CIFS export protocol access if the assigned
provisioning policy is configured for the options "Guarantee space for dataset
and Snapshot copies" (which is displayed in the Provisioning Policies
window as "Guarantee space for dataset") and ""Guarantee initial size,
allocate maximum size on-demand and allow automatic deletion of Snapshot
copies" (which is displayed in the Provisioning Policies window as "Increase
container size automatically").
If you assign a SAN-based provisioning policy, do you want to enable FC or
iSCSI export protocol access to the members of this dataset node?
You can enable either protocol for all members of this node when you
configure the dataset, or you can decline to enable export protocols at the
dataset node level and later enable export protocols for individual members as
you provision them into this dataset.

Do you want to attach a vFiler unit to the dataset to enable data migration?
vFiler unit
assignment and
Attaching a vFiler unit is necessary to support both offline migration and online
data migration
migration.
capability
• If you want to create a new vFiler unit for this purpose, what IP address and
network mask do you want to assign to it?
If you want to assign an existing vFiler unit to the dataset for this purpose,
what is the name of that unit?
• Do you want to enable online migration on the dataset?
Online migration is migration of data from source to destination without
disrupting user access to the data being migrated.
Nonprimary
dataset nodes

After the dataset is created, if the dataset has a secondary backup or mirror node,
you can edit the dataset node to assign a provisioning policy to a nonprimary
node.
•

If you want to create a new vFiler unit, what IP address and network mask do
you want to assign to it?
Note: A vFiler unit created on secondary or tertiary nodes does not support
migration.

•

If you associate a vFiler unit with a nonprimary node in a dataset, any
volumes that are provisioned for that dataset must be also associated with the
vFiler unit.
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Therefore, when you view a list of the dataset volumes, only volumes that are
owned by the vFiler unit are displayed.
Note: You cannot associate a vFiler unit with a nonprimary node unless it
is a disaster recovery-capable nonprimary node.

•

•
•

•

If you want to assign a NAS or SAN type provisioning policy instead of a
secondary type policy to a nonprimary node, the dataset must be disaster
recovery-capable.
The dataset must have a protection policy assigned that supports disaster
recovery, and the nonprimary node must be a disaster recovery-capable node.
The policy type (NAS or SAN) on the primary dataset node must match the
policy type assigned to the nonprimary node.
If you assign a NAS-based provisioning policy, do you want to enable CIFS
or NFS export protocol access to the members of this dataset node?
You can enable one or both export protocols for all members of this node
when you configure the dataset. Alternatively, you can decline to enable
export protocols at the dataset node level and later enable export protocols for
individual members as you provision them into this dataset.
If you assign a SAN-based provisioning policy, do you want to enable FC or
iSCSI export protocol access to the members of this dataset node?
You can enable either export protocol for all members of this node when you
configure the dataset. Alternatively, you can decline to enable export
protocols at the dataset node level and later enable export protocols for
individual members as you provision them into this dataset.

Note: You should not use a version earlier than SnapDrive for Windows 5.0 to connect to mapped
LUNs that are provisioned through the NetApp Management Console provisioning capability.
Doing so might result in an error, after which you must manually unmap the LUNs.
Related concepts

Effect of time zones on schedules on page 220
What a protection policy does on page 190
What a provisioning policy is on page 600
Overview of resource pools on page 64
Protection policy node prerequisites on page 195
What gets migrated with a dataset on page 548
Overview of export protocol properties on page 112
Related references

Dataset migration requirements on page 547
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Adding a dataset of physical storage objects
You can include multiple physical storage objects in a dataset for managing the protection
requirements or provisioning the storage space and hardware requirements of those objects as a
group.
Before you begin

•
•
•

You must have the protection information that you require to complete this task.
You must have the provisioning information that you require to complete this task.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
•
•

To assign a policy, you must be assigned a role that enables you to view policies.
To assign a provisioning policy, you also need a role that enables you to attach the resource
pools configured for the policy.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add to start the Add Dataset wizard.
If you want to provision your node by resource pool, click the Provision and attach resources
using a policy option when it is displayed.
If you want the dataset to have online migration capability, select a provisioning policy that is
configured for that capability.
If you receive a message that the maximum number of vFiler units has been reached, to configure
an IP address and network mask that enables the migration capability on an additional dataset,
you must first disable migration capability for one or more existing migration capable datasets.
3. Complete the steps in the Add Dataset wizard to create a dataset.
Result

The new dataset is listed in the Datasets tab.
After you finish

To provide protection for your new dataset, assign it a protection policy or a disaster recoverycapable protection policy.
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Related concepts

Decisions to make before adding datasets of physical storage objects (for protection) on page 94
Decisions to make before adding datasets of physical storage objects (for provisioning) on page 96
Effect of time zones on schedules on page 220
Related references

Administrator roles and capabilities on page 54
Decisions to make before assigning or changing policies
Before you assign or change a policy, you need to gather information about the dataset and policies
that you want the dataset to have.
You need to gather the following information:
Protection
policy

•

•

Disaster
recovery
policy

•

Which protection policy meets the requirements of the dataset?
Review the policies listed on the Protection Policies window to see if any is
suitable for your new dataset.
If no protection policy meets the requirements of your new dataset, is there a
protection policy that would be suitable with minor modifications?
If so, you can copy that protection policy to create a new policy you can
modify as needed for the new dataset. If no suitable protection policy exists,
you can run the Add Protection Policy wizard to create a new policy for the
dataset.
What type of disaster recovery capable protection policy do you need?
The NetApp Management Console data protection capability provides disaster
recovery capable protection policies that function similarly to the backup
policies.
Note: When you change a policy from backup to mirror or mirror to backup,
the Dataset Policy Change wizard prompts you to establish a new baseline
for the relationship. If you do, old data is retained, and the NetApp
Management Console data protection capability makes a new copy of the
entire dataset and transfers the active file system on the secondary. After
reinitialization, you can manually delete the Snapshot copy.

•

•

If you are changing the protection policy to a disaster recovery policy, do you
want to map the settings from a node in the old dataset to a node in the new
dataset?
You should copy the settings only if the path from the primary node is the same
in the new policy as it was in the old policy.
Do you plan to use a failover script to shut down processes before the NetApp
Management Console data protection capability invokes failover?
If so, you need to define the path to a failover script.
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Backup and
mirror node
resources

•

•

•

Provisioning
policy

•

•

•

If you are changing the protection policy for a dataset with backup and mirror
nodes, do you want to use the same resource assignments that were used in the
previous policy?
For example, if you have a dataset using the Mirror policy and you want to
change to the Chain of two mirrors policy, you can choose to copy resources
used for the single mirror node in the current policy to one of the two mirror
nodes in the new policy. After you have copied resources from a node in the
current policy, you cannot copy resources from that same node to any other
node in the new policy.
If you are assigning a policy for the first time or if you do not want to copy
resources used in the current policy, is there a resource pool that meets the
provisioning requirements of the dataset?
For example, the resource pool you assign to a mirror node should contain
physical resources that would all be acceptable destinations for mirror copies
created of the dataset members. If no resource pool meets the requirements of a
nonprimary node, you can create a new resource pool for each backup and
mirror node using the Add Resource Pool wizard.
If you prefer to not use resource pools for automatic provisioning, which
physical resources would be suitable as destinations for backups and mirror
copies of the dataset?
You do not have to assign a resource pool or physical resources to a destination
node to assign or change a policy. However, the dataset will be nonconformant
with its new policy until resources are assigned to each destination node,
because the NetApp Management Console data protection capability cannot
carry out the protection specified by the policy.
On which node do you want to assign or change the provisioning policy?
Your dataset might have a primary and one or more nonprimary nodes. You
can assign the same provisioning policy to every node in the dataset, or you can
assign a different provisioning policy to each node.
Which provisioning policy meets the requirements of the dataset node?
Review the policies listed on the Provisioning Policies window to see if any is
suitable for the dataset node.
If you are changing the provisioning policy, the policy type (NAS or SAN) on
the primary dataset node must match the policy type assigned to the
nonprimary node. If you want to assign a NAS or SAN type provisioning
policy instead of a secondary type policy to a nonprimary node, the dataset
must be disaster recovery capable. This means that it must also have a
protection policy assigned that supports disaster recovery, and the node must be
the disaster recovery capable node.
If no provisioning policy meets the requirements of the dataset node, is there a
provisioning policy that would be suitable with minor modifications?
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If so, you can copy that policy to create a new policy that you can modify as
needed. If not, you can run the Add Provisioning Policy wizard to create a new
policy for the dataset node.
Related concepts

What a protection policy does on page 190
Overview of resource pools on page 64
Assigning or changing a protection policy
You can assign a policy to a dataset or change the policy assigned to it. The policy specifies how the
data is to be protected.
Before you begin

•

•

•

You must have gathered the protection information that you need to complete this task:
• Dataset properties
• Group membership
• Protection policy
Determine which policy you want to assign to the dataset. You can review available protection
policies on the Protection Policies window.
If no policy meets the requirements of your new dataset, you can create a new policy or modify a
copy of an existing policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

•

You can use this procedure after you have created a new dataset and want to assign a policy to it,
or when you want to change the protection policy assigned to a dataset. You can also use this
procedure to protect a dataset that is listed on the Datasets window
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Any dataset that you directly assign a protection policy or provisioning policies and resource
pools directly through NetApp Management Console is displayed as a dataset of physical storage
objects.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Protection Policy to start the Dataset Policy Change wizard.
If you want to provision your nodes by resource pool, click the Provision and attach resources
using a policy option when it is displayed.
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3. Complete the steps in the wizard.
Related concepts

Decisions to make before assigning or changing policies on page 100
What a protection policy does on page 190
Related references

Administrator roles and capabilities on page 54
Assigning or changing a provisioning policy
You can assign a provisioning policy to a dataset node or change the currently assigned provisioning
policy assigned to a dataset node.
Before you begin

•

Have the provisioning information available that you need to complete this task:

•

• Provisioning policy for primary node
• Migration capability
• vFiler unit assignment
• Provisioning policy for nonprimary dataset nodes
Determine which policy you want to assign to the dataset node. You can review available
provisioning policies listed in the Provisioning Policies window.
If no provisioning policy meets the requirements of your dataset node, you can create and modify
a copy of an existing policy or create a new policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

•

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Any dataset that you directly assign a protection policy or provisioning policies and resource pools
directly through NetApp Management Console is displayed as a dataset of physical storage objects.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset to which you want to assign or change the provisioning policy and click Edit.
3. In the Edit Dataset window, click Provisioning/Resource Pools for the node to which you want
to assign or change the provisioning policy.
4. On the Edit Provisioning and Resource Pools page, select a provisioning policy and click Next.
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5. Continue to click Next until you reach the Preview Details page.
NetApp Management Console performs a trial run of your requested changes and generates a
report describing the impact of those changes.
6. After you are satisfied with the preview results, click Next to apply your changes to the dataset,
then click Finish.
7. Close the Edit Dataset window.
Related references

Administrator roles and capabilities on page 54
Decisions to make before provisioning additional containers for a dataset
Before you use the Provisioning wizard to provision an additional volume, qtree, or LUN to an
existing primary dataset node, you need to gather the information required to complete the wizard.
Prerequisites

Does the dataset that you are trying to provision have a resource pool assigned to
it?
If not, you need to assign a resource pool before provisioning the node. You can
check the resource pool assignment on the Datasets window Overview tab.
Does the dataset that you are trying to provision have a provisioning policy
assigned to it?
If not, you need to assign a provisioning policy before provisioning the node. You
can check the provisioning policy assignment on the Datasets window Overview
tab.
Note: You are advised not to use SnapDrive for Windows versions earlier than

5.0 to connect to mapped LUNs that are provisioned through the NetApp
Management Console provisioning capability. Doing so might result in an error
that requires the LUNs to be manually unmapped.
Name

What is the export name of the volume or LUN that you want to provision?
The export name (NFS or CIFS protocol for NAS storage, or iSCSI or FC protocol
for SAN storage) is created with the name you specify.

Description

What is the description of this provisioning request?
This information can be useful later: for example, if you want to track
provisioning requests against IT helpdesk tickets.

Size

What is the size of the qtree, volume or LUN?
•

The minimum LUN size for Windows is 32 MB. For other operating systems it
is 4 MB.
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•

The actual size that is provisioned is determined by the size that you specify in
the wizard and by the provisioning policy that is assigned to the dataset node.
•

•

NAS storage example
If you enter a maximum size of 20 GB in the wizard and the provisioning
policy that is assigned to the dataset enables the Reserve space for Snapshot
copies option, then the NetApp Management Console provisioning
capability allocates 24 GB for the newly provisioned storage. If the
provisioning policy does not enable the option for guaranteed space for
data and Snapshot copies, the NetApp Management Console provisioning
capability does not allocate space until the space is actually used. In this
case, the total size refers only to the potential size that can be used, but the
space is not guaranteed.
SAN storage example
If you enter 50 GB for the data size and 50 GB for the maximum Snapshot
copy size, and if the provisioning policy that is assigned to the dataset
enables the option to guarantee space for data and Snapshot copies, the
NetApp Management Console provisioning capability adds 50 GB for the
overwrite reserve space and allocates a total of 150 GB for the volume.

What is the maximum space for Snapshot copies?
•
•

Override
exports

If you are provisioning a LUN, what is the maximum amount of space in the
volume that Snapshot copies can use?
If you are provisioning a volume or qtree, what is the maximum amount of
space in the resource pool that the volume or qtree can use?
When calculating the amount, include all of the LUNs, space reserves, and
Snapshot copy space that the resource pool contains.

Which, if any, export protocol access do you want to enable for the volume, LUN,
or qtree that you are provisioning?
This decision applies only if you have not already enabled an export protocol on
the entire dataset into which you are provisioning the volume, LUN, or qtree.
•
•

Resource
selection

If you are provisioning NAS storage, do you want to enable NFS export
access, CIFS export access, or both?
If you are provisioning SAN storage, do you want to enable iSCSI export
access or FC export access?

How do you want to select the resource to provision into this dataset?
•
•

Do you want the NetApp Management Console provisioning capability to
automatically provision a resource from the assigned resource pool?
Do you want to manually select the resource from the assigned resource pool?
For example, when provisioning LUNs in a SAN environment, you might need
to manually select a specific storage system from the resource pool if the host
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for which you are provisioning the LUNs has access only to that particular
storage system.
Related concepts

Overview of export protocol properties on page 112
Provisioning additional containers for a primary dataset node
You can provision an additional volume, qtree, or LUN to the primary dataset node when you need to
add more containers to an existing dataset.
Before you begin

•

•

You must have gathered the provisioning information that that you need to complete this task:
• Provisioning policy for primary node
• Migration capability
• vFiler unit assignment
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. From the menu bar, click Data > Datasets > Provisioning.
2. Select the dataset that you want to provision with additional containers.
3. Click Provision to start the Provisioning wizard.
•

•

If you want to manually select a specific aggregate to provision the additional containers,
click "Manually select a resource from the attached resource pool(s)" when the wizard
displays the Resource selection panel, and select a specific storage system or aggregate from
the resource pool trees display.
If you want the wizard to automatically provision the additional containers, click "Allow the
system to automatically select a resource from the attached resource pool(s)".

4. On the Preview page, if any errors are displayed, click Back to return to previous pages in the
wizard and correct the errors.
The Preview page displays the results of a trial run of your provisioning request. Any potential
errors are described and suggestions for resolving them are provided.
5. Complete the steps in the wizard and click Next in the Preview page to commit the provisioning
request.
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The provisioning request is sent to the server. The progress of the job is shown in the progress
bar. When the job completes, the Provisioning to the dataset summary page on the wizard
confirms the completion.
Result

If you do not want to wait for the job to complete, you can close the wizard and processing continues
in the background. You can monitor the progress of the provisioning job in the Jobs window.
When the job is done and the new volume is added, the NetApp Management Console provisioning
capability compares the attributes of the volume to the provisioning policy assigned to the node, if
any. If the new dataset member is out of conformance, the dataset status changes to Error and the
conformance status for the dataset member changes to Nonconformant.
Related concepts

Decisions to make before provisioning additional containers for a dataset on page 104
Related references

Administrator roles and capabilities on page 54
When to provision an additional container with a specific aggregate or storage system
When using the Provisioning wizard to add a new volume, qtree, or LUN container in the primary
node of an existing dataset, you can provision that container with a specific aggregate or storage
system from its assigned resource pool rather than having the Provisioning wizard automatically
provision aggregates or storage systems from that resource pool.
For example, when provisioning additional LUNs in a SAN environment, you might need to
manually select a specific storage system from resource pool if the host that you are provisioning the
LUNs for has access to only that specific storage system.
Related concepts

Decisions to make before provisioning additional containers for a dataset on page 104
Related tasks

Provisioning additional containers for a primary dataset node on page 106
Related references

Administrator roles and capabilities on page 54
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Decisions to make before adding or changing resource assignments
Before you add or change the physical resources assigned to an existing dataset node, you need to
gather the required information.
•

•

•

•

For each node in the dataset, which resource pool meets its protection or provisioning
requirements?
For example, if you have the NetApp Management Console data protection capability, the
resource pool you assign to a mirror node should contain physical resources that are appropriate
for mirrored copies of the dataset.
If you have the provisioning or protection capabilities, the resource pool you assign to a dataset
node should contain physical resources that are appropriate and large enough for the provisioning
needs of the data contained in the dataset node.
What if there are no resource pools that meet the protection or provisioning requirements of the
dataset node?
If no resource pool meets the protection or provisioning requirements of a dataset node, you can
use the Resource Pools window to create a new resource pool for each node.
If you have the NetApp Management Console data protection capability with disaster recovery,
can you choose not to use resource pools?
You can select physical resources for the backup and mirror nodes of your dataset. If you choose
to select storage outside of a resource pool, the NetApp Management Console data protection
capability does not create volumes but instead uses the volumes you select for that dataset node.
You can manually provision your dataset. If you choose to provision your dataset on storage
outside of a resource pool, the NetApp Management Console provisioning capability does not
create volumes but instead uses the volumes that you select for that dataset node.
If you have the provisioning or disaster recovery, can you choose not to use resource pools?
You can manually provision your dataset. If you choose to provision your dataset on storage
outside of a resource pool, the NetApp Management Console provisioning capability does not
create volumes but instead uses the volumes that you select for that dataset node.
If you choose to associate a vFiler unit with a nonprimary node in a dataset, any volumes that are
provisioned for that dataset must be associated with the vFiler unit. (Therefore, when you view a
list of the dataset volumes, only volumes that are owned by the vFiler are displayed.)

Adding resources to a dataset
You can add physical resources to an existing dataset. Any protection, disaster recovery, and
provisioning policy assigned to the dataset node is automatically extended to the newly added
resources.
Before you begin

•

You must have gathered the resource information that you need to complete this task:
•
•

Whether or not you want to use resource pools
The node's protection or provisioning requirements
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•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Any dataset that you directly assign a protection policy or provisioning policies and resource pools
directly through NetApp Management Console is displayed as a dataset of physical storage objects.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Properties sheet, click Physical Resources for the node to which you want to add physical
resources.
The Edit property sheet Overview page is the starting point for several different types of tasks.
Each option on the menu starts an in-place property sheet or a wizard. Canceling or completing
an option returns you to the Edit Overview page.
4. In the Edit Physical Resources page, select each new member from the Available Resources list,
move it to the Resources in this Node list, and click Next.
Adding resources to a dataset generates a report detailing the impact of the changes to the dataset.
5. After you are satisfied with the preview results, click Next to apply your changes, then click
Finish to return to the property sheet Overview page.
Result

NetApp Management Console adds the physical resources to the dataset.
Related references

Administrator roles and capabilities on page 54
Changing dataset node resource assignments
If the protection, failover, or provisioning requirements of your dataset change, you can add physical
resources to a dataset node or change the resources currently assigned to a dataset node.
Before you begin

•

You must have gathered the resource information that you need to complete this task:
•
•

Whether or not you want to use resource pools
The node's protection or provisioning requirements
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•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•
•

If your dataset is attached to a storage service, you cannot directly change a dataset node's
individual resource pool. See "Changing a storage service on datasets."
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Edit Dataset window, click Physical Resources for the node to which you want to change
the physical resources.
4. In the Edit Physical Resources page, add or remove the physical resource.
a) Add a new physical resource by selecting a resource from the Available Resources list and
moving it to the Resources in this Node list.
b) Remove a resource by selecting a resource from the Resources in this Node list and moving it
to the Available Resources list.
5. Click Next.
NetApp Management Console performs a trial run of your requested changes and generates a
report describing the impact of those changes.
6. After you are satisfied with the preview results, click Next to apply your changes to the dataset,
then click Finish.
Result

If no resources were previously assigned to the dataset node, the dotted outline in the graph area of
the Datasets window Overview tab is replaced by an icon representing assigned storage.
Related concepts

What groups are on page 67
Related references

Administrator roles and capabilities on page 54
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Removing resources from a dataset
You can remove physical resources from an existing dataset when you no longer want to protect, fail
over, or provision its data using the assigned policy.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Edit Dataset window, click Physical Resources for the node from which you want to
remove physical resources.
4. In the Edit Physical Resources page, select each resource you want to remove from the list, move
it to the Available Resources list, and click Next.
The NetApp Management Console data protection capability performs a trial run of your
requested changes and generates a report describing the impact of those changes.
5. After you are satisfied with the preview results, click Next to apply your changes to the dataset,
then click Finish.
6. Close the Edit Dataset window.
Result

The NetApp Management Console data protection capability removes the physical resources from
the dataset.
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Overview of export protocol properties
You can configure access for clients using NFS, CIFS, iSCSI, or Fibre Channel (FC) protocols when
you create or reconfigure the primary, backup, or mirror nodes in your datasets or when you
provision new volumes, LUNs, or qtrees as members into your datasets.
CIFS
access

To configure support for CIFS client access to the primary, backup, or mirror nodes in
your dataset, you enable that access when you configure each node and specify the
following:
•
•

NFS
access

To configure support for NFS client access to the primary, backup, or mirror nodes in
your dataset, you enable that access when you configure each node in the dataset and
specify the following:
•
•
•
•
•

Fibre
Channel
access

Default permissions (Read only, read write, or root access) for all NFS hosts to
access the selected node in this dataset
Specific permissions for specific NFS hosts to access the selected node in this
dataset
The NFS security protocol (Kerberos v5 Integrity, Kerberos v5, Kerberos v5
Privacy, UNIX style, or None) that you want enforced
A default mapping for anonymous users to the selected node
Whether or not to enable superuser ID access to the selected node in this dataset

To configure support for FC client access to the SAN-based volumes, or LUNs in the
primary, backup, or mirror nodes in your dataset, you enable that access when you
configure each node and specify the following:
•
•

iSCSI
access

The Windows domain of the target nodes in this dataset
Specific permissions (full control, no access, or read and change) for specific users
to access the nodes in this dataset

The operating system (Solaris, Windows, HP-UX, AIX, Linux, VMware,
NetWare) of the accessing host
The World Wide Port Names for the FC nodes, if the accessing host does not have
NetApp Host Agent installed

To configure support for FC client access to the SAN-based volumes or LUNs in the
primary, backup, or mirror nodes in your dataset, you enable that access when you
configure each node and specify the following:
•
•

The operating system (Solaris, Windows, HP-UX, AIX, Linux, VMware,
NetWare) of the accessing host
The initiator ID for the iSCSI nodes, if the accessing host does not have a NetApp
Host Agent installed

520 | Provisioning and Data Protection Online Help

Configuring dataset nodes for CIFS protocol access
You can configure Windows client CIFS access to all NAS volumes or qtrees contained in a dataset's
primary, backup, or mirror node if the dataset is configured to support CIFS access.
Before you begin

•
•

You must have confirmed that the dataset node on which you want to enable CIFS access is
assigned a NAS-type provisioning policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Note: Do not complete this task if you want to enable unique sets of export protocols on individual
LUNs when you provision them into this dataset node; leave this dataset node with no export
protocol enabled.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. Click Data > Datasets > Overview.
2. In the Datasets window, select the dataset you want to configure and click Edit.
3. In the Edit Dataset window, click Provisioning/Resource Pools under the name of the node for
which you want to enable or modify CIFS access.
If no provisioning policy has been assigned to this dataset, specify a NAS-type provisioning
policy.
NetApp Management Console displays the provisioning policy assigned to the dataset node, and
if that policy is a NAS-type policy, displays a CIFS Settings bar.
4. If the CIFS settings are not displayed, click the down arrow button on the CIFS Export Settings
bar to expand the display.
5. Configure the CIFS settings. If CIFS is turned off, click Turn CIFS On to enable the settings.
6. Modify any other CIFS protocol or resource pool settings. When you are finished, click Next.
7. Modify the vFiler unit configurations, as needed, and click Next.
8. If the Preview Details page shows no warnings or errors, click Next, then click Finish.
If the Preview Details page shows errors, follow the suggestions to fix the problems. You can
click Back to change the settings on any page of the wizard.
9. Close the Edit Dataset window.
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Configuring dataset nodes for NFS protocol access
You can configure NFS host access to all NAS volumes or qtrees contained in a dataset's primary,
backup, or mirror node if the dataset is configured to support NFS access.
Before you begin

•
•

You must have confirmed that the dataset node on which you want to enable NFS access is
assigned a NAS-type provisioning policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Note: Do not complete this task if you want to enable unique sets of export protocols on individual
volumes or qtrees when you provision them into this dataset node; leave this dataset node with no
export protocol enabled.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. Click Data > Datasets > Overview.
2. In the Datasets window, select the dataset that you want to configure and click Edit.
3. In the Properties sheet, click Provisioning/Resource Pools under the name of the node for
which you want to enable or modify NFS access.
If no provisioning policy is assigned to this dataset, specify a NAS-type provisioning policy.
NetApp Management Console displays the provisioning policy assigned to the dataset node, and,
if that policy is a NAS-type policy, displays an NFS Settings bar.
4. If the NFS settings are not displayed, click the down arrow button on the NFS Export Settings bar
to expand the display.
5. Configure the NFS settings. If NFS is turned off, click Turn NFS On to enable the settings.
6. Modify any other NFS protocol or resource pool settings. When you are finished, click Next.
7. Modify the vFiler unit configurations, as needed, then click Next.
8. If the Preview Details page shows no warnings or errors, click Next, then click Finish.
If the Preview Details page shows errors, follow the suggestions to fix the problems. You can
click Back to change the settings on any page of the wizard.
9. Close the Edit Dataset window.
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Related references

Administrator roles and capabilities on page 54
Configuring dataset nodes for FC protocol access
You can configure Fibre Channel protocol (FC) client access to all SAN LUNs contained in a
dataset's primary, backup, or mirror node if the dataset is configured to support FC access.
Before you begin

•

You must have confirmed that the dataset node on which you want to enable FC access is
assigned a SAN-type provisioning policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

•

Note:

•
•

FC is not supported on vFiler units.
Do not complete this task if you want to enable unique sets of export protocols on individual
LUNs when you provision them into this dataset node; leave this dataset node with no export
protocol enabled.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. Click Data > Datasets > Overview.
2. In the Datasets window, select the dataset that you want to configure and click Edit.
3. In the Properties sheet, click Provisioning/Resource Pools under the name of the node for
which you want to enable or modify FC access.
If no provisioning policy has been assigned to this dataset, specify a SAN-type provisioning
policy.
NetApp Management Console displays the provisioning policy assigned to the dataset node. If
that policy is a SAN-type policy, it displays an FCP Settings bar.
4. If the FC settings are not displayed, click the down arrow button on the FCP Export Settings bar
to expand the display.
5. Configure the FC settings. If FC is turned off, click Turn FCP On to enable the settings.
If iSCSI is turned on, it is automatically turned off when you click Turn FCP on.
6. Modify any other protocol and resource pool settings. When you are finished, click Next.
7. Modify the vFiler unit configurations, as needed, then click Next.
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8. If the Preview Details page shows no warnings or errors, click Next, then click Finish.
If the Preview Details page shows errors, follow the suggestions to fix the problems. You can
click Back to change the settings on any page of the wizard.
9. Close the Edit Dataset window.
Configuring dataset nodes for iSCSI protocol access
You can configure iSCSI client access to all SAN LUNs contained in a dataset's primary, backup, or
mirror node if the dataset is configured to support iSCSI access.
Before you begin

•
•

Confirm that the dataset node on which you want to enable iSCSI access is assigned a SAN-type
provisioning policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Note: Do not complete this task if you want to enable unique sets of export protocols on individual
LUNs when you provision them into this dataset node; leave this dataset node with no export
protocol enabled.

About this task

The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.
Steps

1. Click Data > Datasets > Overview.
2. In the Datasets window, select the dataset that you want to configure and click Edit.
3. In the Properties sheet, click Provisioning/Resource Pools under the name of the node for
which you want to enable or modify iSCSI access.
If no provisioning policy has been assigned to this dataset, specify a SAN-type provisioning
policy.
NetApp Management Console displays the provisioning policy assigned to the dataset node. If
that policy is a SAN-type policy, it displays an iSCSI Settings bar.
4. If the iSCSI settings are not displayed, click the down arrow button on the iSCSI Export Settings
bar to expand the display.
5. Configure the iSCSI settings. If iSCSI is turned off, click Turn iSCSI On to enable the settings.
If FC protocol is turned on, it is automatically turned off when you click Turn iSCSI on.
6. Modify any other resource pool settings. When you are finished, click Next.
7. Modify the vFiler unit configurations, as needed, then click Next.
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8. If the Preview Details page shows no warnings or errors, click Next, then click Finish.
If the Preview Details page shows errors, follow the suggestions to fix the problems. You can
click Back to change the settings on any page of the wizard.
9. Close the Edit Dataset window.
Related references

Administrator roles and capabilities on page 54
Enabling an unprovisioned dataset for migration through a new vFiler unit
You can enable data migration on an unprovisioned dataset by editing that dataset and generating a
new vFiler unit.
Before you begin

•
•
•
•

Verify that your dataset meets the requirements for the type of automated migration (online or
offline) that you want to enable.
Verify that your dataset does not yet have any existing members provisioned to it.
Be ready to assign an IP address and netmask source location for the dataset that you want to
migrate.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•
•

The alternative method of enabling a dataset for migration is to attach an existing vFiler unit.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Edit Dataset window, select Provisioning/Resource pool.
4. Select Enable automated migration and enter the IP address and netmask for the migration
source.
5. Specify online or offline migration.
•
•

To enable automated online data migration, select Enable automated online migration.
To enable offline data migration only, leave the "Enable automated online migration" option
unselected.

6. Click Next.
7. If your edits pass the dataset conformance check, click Finish.
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Result

After the dataset is enabled for automated migration, it is listed on the Migration tab.
Enabling an unprovisioned dataset for migration through an existing vFiler unit
You can enable automated migration on an existing unprovisioned dataset by editing that dataset and
attaching an existing vFiler unit.
Before you begin

•
•
•
•

Verify that your dataset meets the requirements for the type of automated migration (online or
offline) that you want to enable.
Verify that your dataset does not yet have any existing members provisioned to it.
Be ready to assign an existing vFiler unit to your dataset.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•
•

The alternative method of enabling a dataset for migration is to automatically generate a new
vFiler unit and attach it to your dataset.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select a dataset and click Edit.
3. In the Edit Dataset window, select Provisioning/Resource pool.
4. In the vFiler unit pane, select one of the listed vFiler units.
Selecting a vFiler unit to attach enables this dataset for automated migration.
5. Specify online or offline migration.
•
•

To enable automated online data migration, select Enable automated online migration.
To enable offline data migration only, leave the "Enable automated online migration" option
unselected.

6. Click Next.
7. If your edits pass the dataset conformance check, click Finish.
Result

After the dataset is enabled for automated migration, it is listed on the Migration tab.
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Decisions to make before configuring dataset-level custom naming for related objects
Before you create a dataset or edit a dataset to apply dataset-level custom naming to its protection or
provisioning job-generated related objects (Snapshot copies, primary volumes, secondary volumes,
and secondary qtrees), you must make some decisions about the related object types that you are
considering for custom naming.
Do your related object types require dataset-level name customization?
NetApp Management Console applies default or customized global naming formats to the protection
or provisioning job-generated Snapshot copies, primary volumes, secondary volumes, and secondary
qtrees. If the default global naming of these object types causes no problems, dataset-level
customization of the naming settings is not necessary.
Do you want to use a custom label in related object naming?
A custom label is an alphanumeric string that you can specify to include in a dataset-level name if the
naming when NetApp Management Console applies custom naming to Snapshot copies, primary
volumes, secondary volumes, or secondary qtrees that are generated by protection or provisioning
operations. If the name of the dataset to whose objects you want to apply custom naming is very
long, you might consider specifying a shorter custom label to include in the names of its Snapshot
copies, volumes, or qtrees.
Are you custom naming by attribute selection and ordering?
The most common method of customizing global naming of your Snapshot copy, primary volume,
secondary volume, or secondary qtree objects is by specifying their naming attributes in the order
that you want those attributes to appear. Each object type for which custom naming is supported
supports a different set of attributes.
Snapshot
copy naming
attributes

Attributes that can be specified and ordered to customize Snapshot copy naming
include the following:
•
•
•
•
•
•
•

%T (Timestamp) (required)
%R (Retention type) (retention class of the Snapshot copy)
%L (Custom label) (custom label of the containing dataset, if one exists)
%H (Storage system name) (storage system of the containing volume)
%N (Volume name) (the containing volume)
%A (Application fields)
%1 (One-digit suffix), %2 (Two-digit suffix), or %3 (Threedigit suffix) (applied as necessary if naming differentiation is required)
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Primary
volume
naming
attributes

Secondary
volume
naming
attributes

Attributes that can be specified and ordered to customize primary volume naming
include the following:
•
•
•

%L (Custom label) (custom label of the containing dataset, if one exists)
%D (Dataset name) (actual name of the containing dataset)
%1 (One-digit suffix), %2 (Two-digit suffix), or %3 (Threedigit suffix) (applied as necessary if naming differentiation is required)

Attributes that can be specified and ordered to customize secondary volume
naming include the following:
•
•
•

%L (Custom label) (custom label of the containing dataset, if one exists)
%C (Type) (the connection type: backup or mirror).
%S (Primary storage system name) (storage system of the volume being

backed up or mirrored)
•
•

%V (Primary volume name) (volume being backed up or mirrored)
%1 (One-digit suffix), %2 (Two-digit suffix), or %3 (Threedigit suffix) (applied as necessary if naming differentiation is required)

Attributes that can be specified and ordered to customize secondary qtree naming
Secondary
qtree naming include the following:
attributes
• %Q (Primary qtree name) (qtree being backed up)
• %L (Custom label) (custom label of the containing dataset, if one exists)
• %S (Primary storage system name) (storage system of the volume being
backed up or mirrored)
• %V (Primary volume name) (volume being backed up or mirrored)
• %1 (One-digit suffix), %2 (Two-digit suffix), or %3 (Threedigit suffix) (applied as necessary if naming differentiation is required)
Adding a dataset of physical storage objects with dataset-level custom naming
When you create a new dataset of physical storage objects, to improve recognition and usability, you
can customize the naming formats that are applied to the Snapshot copies, primary volumes,
secondary volumes, or secondary qtrees that are generated by protection and provisioning jobs run on
that dataset.
Before you begin

•

You must have custom naming information available:
•
•

The protection-related and provisioning-related object types whose naming you want to
customize
If you want to include a custom label for your dataset in your custom naming formats, the
character string that you want to use
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•

•
•
•

If you want to customize naming settings by selecting and ordering NetApp Management
Console-supplied attributes in the Add Dataset wizard Naming Properties page, the naming
attributes that you want to include in the naming format
If you plan to assign a policy, you must to be assigned a role that enables you to view policies.
If you plan to assign a provisioning policy, you must be assigned a role that enables you to attach
the resource pools configured for the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

If customized for the protection-related or provisioning-related object types in a dataset, datasetlevel naming properties override the global naming settings for those object types in that dataset.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add to start the Add Dataset wizard.
3. When the wizard displays the Naming Properties panel, specify how you want the dataset
reference displayed in the names for your object types:
•

•

If you want NetApp Management Console to include the name of the dataset in the names of
its generated Snapshot copy, primary volume, secondary volume, or secondary qtree objects,
select Use dataset name.
If you want NetApp Management Console to use a custom character string in place of the
dataset name in the names of its protection-related or provisioning-related object, select Use
custom label and enter the character strings that you want to use.

4. Customize the naming settings for your related object types:
•
•

If you want the current global naming format to apply to one or more object types that are
generated in this dataset, select the Use global naming format option for those object types.
If you want to customize the dataset-level naming formats for one or more object types that
are generated in this dataset, select the Use custom format option for those object types, and
type the naming attributes in the order that you want those attributes to appear.

5. When you complete your naming configuration, click Next and complete the dataset creation.
Result

After dataset creation is complete, NetApp Management Console applies the custom dataset-level
naming formats to all objects created by protection and provisioning jobs for that dataset.
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Editing a dataset of physical storage objects for dataset-level custom naming
To improve recognition and usability, you can edit an existing dataset to customize the naming
format that is applied to the Snapshot copies, primary volumes, secondary volumes, or secondary
qtrees that are generated by protection and provisioning jobs run on that dataset.
Before you begin

•

You must have the following custom naming information available:
•
•
•

•
•
•

The name of the dataset for which you want to configure custom naming
The protection or provisioning-generated object types whose naming you want to customize
If you want to include a custom name for your dataset in your custom naming format, the
character string that you want to use
• If you want to customize naming settings by selecting and ordering attributes from the
Naming Properties page, the naming attributes that you want to include in the naming format
• If you want to customize naming settings by naming a pre-authored naming script, the name
and location of that script.
If you plan to assign a policy, you must be assigned a role that enables you to view policies.
If you plan to assign a provisioning policy, you also need a role that enables you to attach the
resource pools configured for the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

•

Dataset-level naming properties customized for the protection-related objects override any
conflicting global naming settings that might be configured.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset whose naming settings you want to customize and click Edit to display the Edit
Dataset window.
3. Click the Naming Properties option and customize the naming settings for your selected object
type.
4. When you complete your naming configuration, click OK and complete the dataset edit.
Result

After the dataset edit is complete, the DataFabric Manager server applies the custom dataset-level
naming format that you specified to all future objects of that type that are generated by that dataset's
protection and provisioning jobs.
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Adding a dataset with dataset-level naming by using a storage service
When you create a new dataset by using a storage service, you can customize the naming formats
that are applied to the related objects (Snapshot copies, primary volumes, secondary volumes, or
secondary qtrees that are generated in that dataset by protection jobs run on that dataset).
Before you begin

•

Have the custom naming information available to complete this task:
•
•

•
•
•

The related object whose naming you want to customize
If you want to include a custom label for your dataset in your custom naming formats, the
character string that you want to use
• If you want to customize by typing naming format strings in the Add Dataset Using Storage
Service wizard Naming Properties page, the naming format strings that you want to include
If you plan to assign a policy, you must be assigned a role that enables you to view policies.
If you plan to assign a provisioning policy, you also need a role that enables you to attach the
resource pools configured for the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

Dataset-level naming properties customized for the related objects in a dataset override any
conflicting global naming settings for those objects that might be configured.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add dataset by using a storage service to start the Add Dataset Using Storage Service
wizard.
3. When the wizard displays the Naming Properties panel, specify how you want the reference
displayed in the names for your related objects:
•

•

If you want the DataFabric Manager server to include the name of the dataset in the names of
its generated Snapshot copy, primary volume, secondary volume, or secondary qtree objects,
select Use dataset name.
If you want the DataFabric Manager server to use a custom character string in place of the
dataset name in the names of its generated Snapshot copy, primary volume, secondary
volume, or secondary qtree objects, select Use custom label and enter the character strings
that you want to use.

4. Customize the naming settings for your related objects (Snapshot copy, primary volume,
secondary volume, or secondary qtree).
•

If you want the current global naming format to apply to one or more object types that are
generated in this dataset, select the Use global format option for those object types.
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•

If you want to customize the dataset-level naming formats for one or more object types that
are generated in this dataset, select the Use custom format option for those object types, and
type the naming attributes in the order that you want those attributes to appear.

5. When you complete your naming configuration, click Next and complete the dataset creation.
Result

After dataset creation is complete, the DataFabric Manager server applies the custom dataset-level
naming formats to all dataset protection job generated objects of the associated type.
Editing a dataset
You can edit the general properties of an existing dataset, as well as the dataset's physical resources,
provisioning policy, export settings, and resource pools.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

•
•

If the dataset that you want to edit is assigned a storage service, the procedure is different. See
"Changing a storage service on datasets."
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Any dataset that you directly assign a protection policy or provisioning policies and resource
pools directly through NetApp Management Console is displayed as a dataset of physical storage
objects.

Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that you want to modify, then click Edit.
3. In the Edit Dataset window, use the menu to click the property that you want to modify.
If you want to modify...

Then do this...

The name, description, owner, contact, and time zone

Click General Properties.

The custom label, custom naming formats (Snapshot copy,
Primary volume, Secondary volume, Secondary qtree)

Click Naming properties.

The physical resources of the dataset's primary data

Under Primary data, click Physical
Resources.
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If you want to modify...

Then do this...

The provisioning policy, export settings, or resource pools of Under Primary data, click Provisioning/
the dataset's primary data
Resource Pools.
The physical resources of the dataset's backup data

Under Backup, click Physical
Resources.

The provisioning policy, export settings, or resource pools of Under Backup, click Provisioning/
the dataset's backup data
Resource Pools.
The physical resources of the dataset's mirror data

Under Mirror, click Physical
Resources.

The provisioning policy, export settings, or resource pools of Under Mirror, click Provisioning/
the dataset's mirror data
Resource Pools.

4. Modify the dataset properties as needed, then click Finish to return to the Edit Dataset window.
Result

NetApp Management Console saves your changes. If you modified the dataset name, the new name
is displayed on the Datasets window.
Deleting a dataset
You can delete a dataset if you want to stop protection or disaster recovery for all of its members and
stop conformance checking against its assigned protection and disaster recovery policies.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that you want to delete and click Delete.
The Delete Dataset dialog box opens, requesting that you confirm the deletion.
Note: When you delete a dataset, the physical resources that compose the dataset are not
deleted.

3. Click Yes to confirm the delete request or No to cancel the request and close the dialog box.
Result

NetApp Management Console removes the dataset from the list in the Datasets window.

Provisioning Help | 533
Related references

Administrator roles and capabilities on page 54
Backup of multiple primary volumes to a single secondary volume
You can configure the NetApp Management Console data protection capability to support
SnapVault-based or Qtree SnapMirror-based backup of multiple volumes in primary storage to a
single volume in secondary storage.
By default, the NetApp Management Console data protection capability automatically sets up one-toone backup relationships between primary and secondary volumes when provisioning secondary
nodes in datasets. But in circumstances in which the 500-volume limit for storage systems might not
allow a one-to-one ratio of primary volumes to secondary volumes, you can configure the NetApp
Management Console data protection capability through the Operations Manager global option
dpMaxFanInRatio option (to support backup relationships between multiple volumes in primary
storage and a single volume in secondary storage).
The following limitations apply to the NetApp Management Console data protection capability
support for automatically configuring backup relationships of multiple primary volumes to a single
secondary volume when provisioning secondary storage:
•
•
•

The NetApp Management Console data protection capability does not support volume
SnapMirror-based mirroring from multiple primary volumes to a single secondary volume.
All the primary volumes and the secondary volume must be members of the same dataset.
The NetApp Management Console data protection capability implementation of Open Systems
SnapVault backup is not affected by the dpMaxFanInRatio option.

For more information on the dpMaxFanInRatio option global option, see the Operations
Manager online Help.

Configuring datasets using storage services
You can use the storage service related wizards on the Datasets window Overview tab to quickly
create or modify datasets with protection policy, provisioning policy, resource pool, and vFiler
template combinations that are specified by an administrator-defined storage service.
Decisions to make before adding a dataset by using a storage service
You can use the Add Dataset Using Storage Service wizard to create a dataset that is preconfigured
with the protection policy, provisioning policies, resource pools and template-based vFiler unit
attachment that are specified by a selected storage service. Before you begin, you must have the
relevant information required by the wizard.
Dataset
Properties

•
•

Naming
Properties

Do you want to use preconfigured global naming formats, or do you want to
customize naming formats to name related objects (Snapshot copies, primary

What is the name and description of the dataset that you want to create?
What time zone do you want to specify for this dataset?
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volumes, secondary volumes, and secondary qtrees generated by protection jobs
on this dataset)?
•
•

Do you want the names of the related objects to include a custom label
instead of the dataset name?
If you want to customize naming for related objects in this dataset, do you
want to use naming scripts or do you want to use for this, or do you want to
use Add Dataset Using Storage Service wizard settings to do so?

Service
Selection

What is the name of the storage service that you want to assign to this dataset?

Dataset level
export

What export protocol do you want to enable for this dataset?
The supportable protocols are NFS or CIFS.

Dataset Node
vFiler unit
configuration

For the primary node, take the following decisions about vFiler units:

If you are configuring a dataset of physical objects, the storage service that you
select for the task must already have a provisioning policy specified for the
primary node.

•
•

•
•

•

Do you want to attach a vFiler unit to your primary node?
If you want to attach a vFiler unit to your primary node, do you want to
attach an existing vFiler unit or specify the creation and attachment of a new
vFiler unit by the storage services feature?
If you want to attach an existing vFiler unit, which vFiler unit do you want
to attach?
If you want to specify the creation of a new vFiler unit for attachment to
your primary node, what IP address and network mask do you want to
assign?
If you attach a vFiler unit to your primary node, do you want to enable
online migration of data?

For each secondary or tertiary node that is included in the dataset, take the
following decisions about vFiler units:
•
•

•

Do you want to attach a vFiler unit to your secondary or tertiary node?
If you want to attach a vFiler unit to your secondary or tertiary node, do you
want to attach an existing vFiler unit, or create and attach a new vFiler unit
using the storage services feature?
If you want to create a new vFiler unit for attachment to your secondary or
tertiary node, what IP address and network mask do you want to assign?
Note: A vFiler unit created on secondary or tertiary nodes does not
support migration.

•

If you want to attach an existing vFiler unit, which vFiler unit do you want
to attach?
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Dataset member •
provisioning
•

Do you want to provision the dataset with volumes at the time you create it?
If you do not provision the dataset at the time you create it, you can do so
later.
If you want to provision the dataset when you create it, then for each volume
you provision what do you want to specify for the following properties:
Volume name
Volume description
Space for data

Adding a dataset by using a storage service
You can use the Add Dataset Using Storage Service wizard to create new datasets that are already set
up with a storage service specified protection policy, provisioning policies, resource pools, and
template-based vFiler unit attachments.
Before you begin

•
•

If you are creating a dataset of physical objects, the storage service that you use for this task must
have a provisioning policy assigned to its primary node configuration.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

After you create a dataset with an attached storage service, you cannot directly edit that dataset to
change its individual protection policy selection, provisioning policy selections, or resource pool
selections as long as that storage service is attached. You can only edit the attached storage service to
change the protection policy, provisioning policy, or resource pool selections for all datasets attached
to that storage service.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Click Add > Using Storage Service to start the Add Dataset Using Storage Service wizard.
3. After you complete each property sheet in the wizard, click Next.
4. Confirm the details of the storage service and click Finish.
Result

•

The new dataset is listed in the datasets table with its attached storage service named in its storage
service column.

536 | Provisioning and Data Protection Online Help
•

If you also selected the option to create a new vFiler unit when you created the new dataset, that
new vFiler unit is listed in the vFiler Units window with the same name as the dataset with which
it was created.
For example, if the new dataset name is "eng_acct", then the name of the new vFiler unit that you
created with it is also "eng_acct", unless an earlier vFiler unit with that exact name already exists.
In such a case, the new vFiler unit that you just created is named "eng_acct_1". Similarly, if you
are creating a new vFiler unit on secondary or tertiary node, the new vFiler unit is named
"eng_acct_<nodename>". However, if another vFiler unit named "eng_acct_<nodename>" exists,
then the wizard names the new vFiler unit "eng_acct_<nodename>_1".

Related concepts

Decisions to make before adding a dataset by using a storage service on page 126
About storage services on page 212
Attaching a storage service to existing datasets of storage objects
You can use the Attach Storage Service wizard to attach a storage service to existing datasets.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Confirm that all datasets to which you want to attach the storage service currently use the same
protection policy or no protection policy.
About this task

The Attach Storage Service wizard allows you to select from a list of possible storage services,
presents you with possible node remappings and associated rebaselining requirements for the storage
service that you select, carries out a dry run of your request, and then implements your request upon
your approval.
After you attach a storage service to an existing dataset, you cannot directly edit that dataset to
change its individual protection policy selection, provisioning policy selections, or resource pool
selections as long as that storage service is attached. You can only edit the attached storage service to
change the protection policy, provisioning policy, or resource pool selections for all datasets attached
to that storage service.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select one or more datasets to which you want to assign a common storage service.
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For successful attachment, select datasets that currently use a common protection policy or none
at all.
3. Click Storage Service > Attach to start the Attach Storage Service wizard.
4. After you complete each property sheet in the wizard, click Next.
5. Confirm the details of the storage service and click Finish.
Result

The selected datasets are listed in the datasets table with their newly attached storage service named
in their storage service column.
Detaching a storage service from datasets
You can use the Detach Storage Service wizard to detach storage services that are currently assigned
to datasets.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Even after a storage service is detached from a dataset, the protection policy, provisioning policies,
resource pools, and optional vFiler templates that were assigned as part of that storage service remain
in effect for that dataset, although you can now directly edit the dataset to replace one or more of
those components with alternative elements or you can attach another storage service.
The NetApp Management Console operations described in this topic do not apply to virtual object
type datasets. To carry out similar operations on virtual object type datasets, use the OnCommand
console.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select one or more datasets that you want to detach from their storage services.
They do not need to be attached to the same storage service.
3. Click Storage Service > Detach to start the Detach Storage Service wizard.
4. Click Yes to confirm the detachment action.
Result

After detachment is complete, the selected datasets are listed in the datasets table with no storage
service named in their storage service column. After detachment is complete, you can edit the
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individual protection policy assignment, provisioning policy assignments and resource pool
assignments of the selected datasets.
Related concepts

About storage services on page 212
Related references

Administrator roles and capabilities on page 54
Changing a storage service for datasets
You can use the Change Storage Service wizard to change a storage service for datasets that already
have another storage service attached.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
The following conditions must exist:
•
•

The new storage service that you want to attach is available in the group in which you want to
locate that dataset.
All datasets to which you want to attach the new storage service are currently attached to the
same current storage service.

About this task

The Change Storage Service wizard allows you to select an alternative storage service, presents you
with possible node remapping alternatives along with rebaselining requirements for each alternative,
carries out a dry run of your request, and then implements your request upon your approval.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. In the datasets table, select one or more datasets whose attached storage service you want to
change.
For successful change, select only datasets that are attached to the same current storage service.
3. Click Storage Service > Change to start the Change Storage Service wizard.
4. After you complete each property sheet in the wizard, click Next.
5. Confirm the details of the storage service and click Finish.
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Result

The selected datasets are listed in the datasets table with their newly attached storage service named
in the storage service column.
Related concepts

About storage services on page 212
Related references

Administrator roles and capabilities on page 54

Managing space allocation
You can view and resize space allocation, diagnose space status, and delete Snapshot copies,
volumes, LUNs, and qtrees.
Related concepts

Space management for volumes and aggregates on page 670
Viewing volume, LUN, or qtree space allocation
You can use the Datasets window Provisioning tab to view current space usage for individual
volume, LUN, or qtree members and historical space usage for individual volumes of a selected
dataset.
Before you begin

You must be authorized to edit the volume, LUN, or qtree configurations.
Steps

1. If the Provisioning tab is not already displayed, from the menu bar, click Data > Datasets >
Provisioning to display it.
2. Select the dataset that contains the volume, LUN, or qtree whose space allocations you want to
view.
3. Select the volume, LUN, or qtree whose space usage you want to view.
The NetApp Management Console provisioning capability displays the space allocation
information for the selected volume, LUN, or qtree.
•
•

Current space allocation is displayed on the Space breakout tab.
Historical space allocation is displayed on the Space usage history tab.
Note: Historical space allocation is displayed for volumes and qtrees only.
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Diagnosing volume or qtree space status
You can use the Provisioning tab to view troubleshooting information and suggested actions for
volumes or qtrees that display a Warning or Error space status.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. If the Provisioning tab is not already displayed, from the menu bar, click Data > Datasets >
Provisioning to display it.
The Provisioning tab displays a table of all datasets that you are authorized to administer.
2. Click the filter arrow on the Space Status column to list datasets with Warning or Error Space
statuses.
The listed datasets are likely to require space allocation diagnosis and reconfiguration.
3. Select a listed dataset.
The Provisioning tab displays the volumes and qtrees contained in the selected dataset.
4. Select the volume or qtree displaying Warning or Error space status.
The Provisioning tab displays the space allocation information for the selected volume or qtree.
5. In the Volume section on the Current space breakout tab, click
Status Warning, or Space Status Error icon.

to the right of the Space

The Provisioning tab displays the Space Status Details dialog box for the Warning or Error status
in question.
6. View or copy the details.
•
•

To view more information click Expand Errors and Warnings.
To copy the troubleshooting information click Copy to Clipboard.

7. Click OK to exit the Space Status Details dialog box.
Related concepts

Dataset storage space management on page 81
Related references

Administrator roles and capabilities on page 54
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Resizing volume space
You can use the Provisioning tab to resize or reallocate data and Snapshot copy space in selected
volumes.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. If the Provisioning tab is not already displayed, from the menu bar, click Data > Datasets >
Provisioning to display it.
2. Select the dataset that contains the volume whose space allocations you want to view.
The Provisioning tab displays the volumes and qtrees contained in the selected dataset .
3. Select the volume that you want to resize and click the Resize Storage button.
Note: You cannot resize an imported storage element unless that element is imported from a
resource pool that is already assigned to the containing dataset.

Depending on the type (NAS or SAN) of volume, the following parameters might be displayed
for modification:
•
•
•

Total volume size
Snap reserve %
Auto grow limit

4. Modify the Total volume size or Snap reserve % values by selecting new values or by dragging
the related graph lines up or down in the space allocation simulation graph.
5. After you specify your resizing, click Resize to finalize the new allocation.
Resizing qtree space
You can use the space management feature to resize individual qtree quotas.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. If the Provisioning tab is not already displayed, from the menu bar, click Data > Datasets >
Provisioning to display it.
2. Select the dataset that contains the qtree whose group quota you want to view.
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The Provisioning tab displays the volumes and qtrees contained in the selected dataset
3. Select the qtree that you want to resize and click the Resize Storage button.
Note: You cannot resize an imported storage element unless that element is imported from a
resource pool that is already assigned to the containing dataset.

4. Specify a new size, either in the Quota for Qtree parameter or by dragging the related graph line
up or down in the space allocation simulation graph.
5. After you specify your resizing, click Resize.
Related concepts

Dataset storage space management on page 81
Related references

Administrator roles and capabilities on page 54
Deleting Snapshot copies
You can use the Provisioning tab Delete Snapshot feature to scan and delete Snapshot copies from
individual volumes to make more volume space available for data.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

For each Snapshot copy associated with a volume, the Delete Snapshot Copies feature displays the
following criteria for you to consider when selecting copies for deletion:
•
•
•

•

•
•

Size
Deleting larger copies frees more space.
Time created
Older Snapshot copies might be more disposable than recent copies.
State: Normal
Normal Snapshot copies (Snapshot copies that are generated by an application other than using
the NetApp Management Console data protection capability) might be more deletable.
State: Backup.
Backup Snapshot copies (Snapshot copies that are generated using the NetApp Management
Console data protection capability) might be the safest copies to delete.
State: Cannot be deleted.
Some Snapshot copies cannot be deleted for space-saving purposes.
Dependency
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Best practice is to avoid deleting Snapshot copies that are in use by more than one volume or
qtree.
Steps

1. If the Provisioning tab is not already displayed, from the menu bar, click Data > Datasets >
Provisioning to display it.
2. Select the dataset that contains the volume on which you want to delete Snapshot copies.
The Provisioning tab displays the volumes, LUNs and qtrees contained in the selected dataset.
3. Select the volume whose Snapshot copies you want to manage and click the Delete Snapshot
Copies button.
The Delete Snapshot Copies dialog lists the Snapshot copies on the selected volume and displays
the deletion criteria for each copy.
4. Select the Snapshot copies that you want to delete. To select more than one, hold down Ctrl
while selecting your Snapshot copies with your cursor.
5. To view the amount of space that deleting your selected Snapshot copies frees in the selected
volume, click Calculate.
The Delete Snapshot Copies dialog displays the amount of space to be freed.
Note: If the amount of space to be freed is insufficient, select additional Snapshot copies to

delete and click Calculate again.
6. When the amount of space to be freed is sufficient, click Delete to execute deletion of the
selected Snapshot copies.
Related concepts

Dataset storage space management on page 81
Related references

Administrator roles and capabilities on page 54
Destroying a volume, LUN, or qtree
You can use the Datasets window Provisioning tab to destroy volumes, LUNs, or qtrees on the
storage controller, returning the space they use to their containing aggregates or volumes.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Steps

1. If the Provisioning tab is not already displayed, from the menu bar, click Data > Datasets >
Provisioning to display it.
2. Select the dataset that contains the volume, LUN, or qtree that you want to destroy.
3. Select the volume, LUN, or qtree that you want to destroy.
The application displays the space allocation information for the selected dataset member.
4. Click Destroy Storage.
The Preview Results dialog box opens, displaying information about objects to be deleted and
requesting you to confirm it.
5. Click Yes to confirm.
The Confirm Delete dialog box opens, requesting you to confirm the deletion.
6. Click Yes to confirm the delete request or No to cancel the request and close the dialog box.
Result

•
•
•

If you destroy a volume, the application returns the space used by that volume to its containing
aggregate.
If you destroy a LUN, the application returns the space used by that LUN to its containing
volume or containing qtree.
If you destroy a qtree, the application returns the space used by that qtree to its containing
volume.

Related concepts

Dataset storage space management on page 81

About data migration
You can use the NetApp Management Console provisioning capability either to migrate vFiler units
or to migrate datasets provisioned by vFiler units from one storage system or set of storage systems
to another.
•
•

You migrate a specific vFiler unit when your storage strategy is focused on vFiler units.
You migrate a specific dataset when your storage strategy is focused on datasets.
To support dataset migration, the source dataset must be provisioned through a single vFiler unit.
In addition, that vFiler unit must contain all the volumes for the dataset and the root volume or
root qtree.

Both vFiler unit and dataset migration operations are transparent. The hosts and applications that
access the migrated storage do not require reconfiguration.
Note: Online migration of vFiler units is supported in Data ONTAP 8.1 7-Mode.
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Data availability during migration cutover
Depending on the availability requirements of the data that you are migrating, and the configuration
of your source and destination storage systems, you can perform the cutover operation of your data
migration in either online or offline mode.
•

•

Online migration
Online migration, if enabled, allows users who need to access the data that is in migration to
experience no availability disruption for up to 120 seconds at any time during the migration
workflow.
Online migration is a component of the DataMotion for vFiler data storage and migration
solution.
Offline migration
Offline migration, which is the default mode of migration, requires that the data that you are
migrating be unavailable to users during the migration cutover operation.

Data migration also enables you to automatically start the migration cutover operation when the
migration start operation is complete. Online migration operation is transparent. The hosts and
applications that access the migrated data do not require reconfiguration due to migration.
What NetApp DataMotion for vFiler is
NetApp DataMotion for vFiler is a data migration solution that integrates virtual storage, mirroring,
and provisioning software technologies so that you can perform migrations nondisruptively in both
physical and virtual environments.
By using the NetApp Management Console provisioning capability interface, you can migrate data
from one storage system to another, as long as the data is contained in vFiler units and associated
with datasets. Migration operations are performed transparently, so users are unaware of the
migration operation being performed. The operations are also nondisruptive, so users retain access to
migrated data, and the hosts and applications that access the migrated data do not require
reconfiguration.
The application interfaces and documentation commonly refer to the DataMotion for vFiler
capability as "online migration," "online dataset migration," "transparent migration", or "online
vFiler unit migration."
Licenses required for online migration of vFiler units
Online migration of vFiler unit, also called DataMotion for vFiler, requires licenses to
nondisruptively migrate data from one storage system to another if the data is contained in vFiler
units and associated with datasets.
DataMotion for vFiler requires the following licenses:
•
•
•

HTTP
MultiStore
SnapMirror
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•

Synchronous SnapMirror

Limitations of online migration
You must be aware of certain limitations when performing online migration.
The limitations of online migration are as follows:
•
•

•

•

Does not support migration of data from Data ONTAP 7.3.3 to Data ONTAP 8.1 and from Data
ONTAP 8.1 to Data ONTAP 7.3.3.
Does not support migration of data from 64-bit source volume to 32-bit destination volume, and
32-bit source volume to 64-bit destination volume.
If the migrating vFiler unit contains both 32-bit volume and 64-bit volume, online migration is
supported only when the following occur:
• 32-bit source volume mirrors to 32-bit volume on the destination storage system.
• 64-bit source volume mirrors to 64-bit volume on the destination storage system.
Does not support migration of data from source volume to conversion volume on the destination
storage system.
A conversion volume is an in-progress upgrade mode (32-bit to 64-bit) volume.
Does not support migration of data from source volume that is in conversion mode.
If the migrating source volume is in conversion mode, the NetApp Management Console
provisioning capability performs the following actions:
•

•

•

•

If a migrating vFiler unit is in conversion mode before the migration start operation, the
NetApp Management Console provisioning capability depends on MultiStore to get
confirmation on the status of migration.
If a migrating vFiler unit is in conversion mode during the migration start operation, the
NetApp Management Console provisioning capability depends on MultiStore to get
confirmation on the status of migration.
If the migration start operation completes successfully, then the NetApp Management Console
provisioning capability changes the migration status to "Migrating, cutover required".
Otherwise, the NetApp Management Console provisioning capability reverts all migration
start changes done so far, and changes the status to "Not started".
If a migrating vFiler unit is in conversion mode after the migration start operation and before
the migration cutover operation, the NetApp Management Console provisioning capability
reverts all the changes done so far, and changes the status back to "Migrating, cutover
required".
If a migrating vFiler unit is in conversion mode during the migration cutover operation, the
NetApp Management Console provisioning capability depends on MultiStore to get
confirmation on the status of migration.
If the migration cutover operation completes successfully, then the NetApp Management
Console provisioning capability changes the migration status to "Migrated, cleanup required".
Otherwise, the NetApp Management Console provisioning capability reverts all migration
cutover changes done so far, and changes the status to "Migrating, cutover required".
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Strategies for enabling a dataset for migration
Any dataset that is assigned a vFiler unit is enabled for automated migration. There are two strategies
for enabling a dataset for automated migration.
Strategy 1: When adding a new dataset, allow the wizard to create a vFiler unit
1. When you add a new dataset, you can enter an IP address and a network mask on the Transparent
Migration page of the Add Dataset wizard. The NetApp Management Console provisioning
capability creates a new vFiler unit and assigns it to the dataset.
2. Export all provisioned storage for the dataset through that single vFiler unit.
Strategy 2: Assign an existing vFiler unit to a dataset
1. Create a vFiler unit and add it as a host.
2. Assign the vFiler unit to the dataset.
•
•

If you are adding a new dataset, you can assign an existing vFiler unit on the vFiler unit page
of the Add Dataset wizard.
If the dataset already exists, you can assign an existing vFiler unit by editing the Provisioning
and Resource Pools configuration of the dataset.

3. Export all provisioned storage for the dataset through that single vFiler unit.
Related references

Dataset migration requirements on page 547
Administrator roles and capabilities on page 54
Dataset migration requirements
A dataset must meet a minimum set of vFiler provisioning, membership, export protocol, Data
ONTAP version, and failover status requirements before you can migrate its primary data to a
another storage system location.
Basic automated migration requirements for all datasets
The following requirements apply to any dataset that you want to enable for migration:
•

The dataset undergoing migration must be enabled for migration by vFiler unit attachment.
•

•
•
•

The attachment can be to a new vFiler unit that is automatically created by the NetApp
Management Console provisioning capability when you select the option to enable migration.
• The attachment can also be to an existing vFiler unit selected by you.
The attached vFiler unit must have no other dataset attached to it.
All storage owned by the vFiler unit, except for the root storage, must belong to the dataset.
Volumes and qtrees owned by another storage system cannot be members of the dataset.
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•
•
•
•
•
•
•

Aggregates, other storage systems, Open Systems SnapVault hosts, and directories cannot be
members of the dataset.
The dataset cannot be failed over.
Both source and destination storage systems must be configured to support migration.
The vFiler unit limits for the destination storage system cannot be at a maximum level.
No name conflict can exist between a source volume and any volume on the destination storage
system.
Space must be available for all the source volumes on the destination storage system.
The dataset export protocol must be either NFS or iSCSI.

Automated migration requirements for datasets enabled for offline migration only
In addition to the basic requirements, the following requirements apply for offline migration:
•
•
•

The source and destination storage systems must run Data ONTAP 7.3.1 or later.
The source and destination storage systems must be licensed for SnapMirror and MultiStore.
The dataset must not contain qtree-level NFS exports for qtrees in a volume that belongs to the
hosting storage system.

Automated migration requirements for datasets enabled for online migration
In addition to the basic requirements, the following requirements apply for online migration:
•
•
•

•
•
•

The attached vFiler unit must contain volume members only.
The source and destination storage systems must run Data ONTAP 7.3.3 or later.
The source and destination storage systems must be licensed for synchronous SnapMirror and
MultiStore.
A special license key to support synchronous SnapMirror must be enabled by the license add
<license-key> command on the source and destination storage systems.
All volumes must be 10 GB or larger.
Root volume can be less than 10 GB.
The maximum number of volumes that can be provisioned into a dataset or the vFiler unit that
contains it depends on the storage system model on which it resides.
No unbroken synchronous SnapMirror relationships can exist on the source volumes at the start
of migration.

What gets migrated with a dataset
When a dataset is migrated, other information associated with that dataset is migrated also.
•

•

NFS exports
After migration cutover, you must remount the qtree-level exports for qtrees that are assigned to
the vFiler unit when the vFiler unit contains a volume that belongs to the hosting storage system
CIFS shares
CIFS share migration is supported for offline migration only. During migration cutover, CIFS
clients experience the equivalent of a reboot.
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•
•
•
•
•
•
•

igroups
LUN mappings
Quota settings for the associated vFiler unit
Backup and mirror relationships
Backup versions
DataFabric Manager history
vFiler unit network routes (if migration is online)

Dataset migration and failover
If failover occurs in a disaster-recovery capable dataset that is also undergoing migration, the failover
operation takes precedence over the data migration operation.
•
•
•

A failed-over node of a dataset cannot be migrated.
Failover operations are allowed on a dataset at any time, regardless of whether data migration is
in progress.
If a data migration is in progress when a dataset node fails over, the data migration operation is
automatically canceled.

Dataset migration limitations
Limits exist on the configuration of the dataset objects that can be migrated, the type of dataset object
and schedule data that can be migrated, and automatic clean up of data in event of migration failure.
•
•

•

•
•

Primary storage
Only a dataset's primary node can be migrated.
vFiler units owning secondary storage
Only datasets that are provisioned through vFiler units that own no secondary storage (no
volumes that are the destination of a SnapVault or SnapMirror relationship) can be migrated.
SnapMirror schedules
The migration update process does not manage the SnapMirror schedules of the relationships.
Instead, it relies on the default schedules created by the migration start operation, which causes
the subsequent SnapMirror updates to be controlled by the target storage system. The default for
scheduled migration updates is every three minutes. The migration cutover operation optionally
modifies the SnapMirror relationships to synchronous mode.
If you want to use a different schedule, use the Operations Manager Disaster Recovery tab to
modify the schedule.
Throttle schedules
Throttle schedules are not migrated and are not supported.
VLANs and IPspaces
•

•

The NetApp Management Console provisioning capability does not configure partner
interfaces for preexisting interfaces.
• VLANs and IPspaces of the source vFiler unit are not deleted automatically during the
migration cleanup operation. You must manually delete any VLANs and IPspaces.
Failure of the migration cutover operation
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•

•
•

•
•

•

•

If the migration cutover operation fails, the source vFiler unit is left in a stopped state. When the
NetApp Management Console provisioning capability automatically starts the source vFiler unit,
some clients might be disrupted.
vFiler units with qtree root storage
The migration process can successfully migrate a vFiler unit that has the root storage in a qtree
that is contained in a volume that is not owned by that vFiler unit. However, the backup versions
of that root storage qtree are not migrated.
vFiler units with IPv6 addresses
vFiler units with IPv6 address cannot be migrated.
qtree-level NFS exports
After a migration is finished, you must remount any qtree-level NFS exports that were configured
on the source vFiler unit for qtrees that were assigned to the vFiler unit and were contained by a
volume that belonged to the hosting storage system.
vFiler unit quotas
Quotas enforced on the source vFiler unit from the hosting storage system are not migrated.
vFiler unit routes in offline migration
If migration is offline, the process does not migrate routes configured on the vFiler unit. You
must manually configure the routes on the destination storage system.
Maximum number of vFiler units on a storage system
Each storage system has a maximum number of vFiler units allowed; this limits the number of
migration-capable datasets that can be provisioned from the storage system. On high-end storage
system models, the hard limit is approximately 64.
Role-based access control (RBAC)
Roles created for the source vFiler unit are not migrated. You must manually create the roles on
the target vFiler unit.

Related concepts

Migration operations on page 551
When to relinquish the migration capability of a dataset on page 551
Related tasks

Adding a custom field on page 185
Related references

Dataset migration requirements on page 547
Administrator roles and capabilities on page 54
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When to relinquish the migration capability of a dataset
When provisioning a dataset or starting a dataset migration, you might encounter a message that the
maximum number of vFiler units has been reached. When this occurs, you might need to relinquish
the migration capability of one or more datasets.
Each storage system imposes a limit on the number of vFiler units it can support, and that limit can
be very low (maximum of 64 on high-end storage systems). Because the NetApp Management
Console provisioning capability creates additional vFiler units when a migration-capable dataset is
provisioned or migrated, you might quickly reach the maximum allowed when provisioning or
migrating a dataset with that capability. To resolve the problem, you might need to relinquish the
migration capability of some older or less important datasets.
You can only relinquish the migration capability of datasets for which a vFiler unit was created when
the dataset was first added. When you select a dataset in the Datasets window Migration tab, the
"Relinquish migration capability" button is enabled for datasets that meet this requirement.
Note: When you relinquish the migration capability of a dataset, the NetApp Management Console
provisioning capability destroys the vFiler unit assigned to the dataset and reexports all of the data
to the storage systems associated with the dataset.
Related concepts

About storage services on page 212
Related tasks

Relinquishing migration capability of a dataset on page 564
Related references

Administrator roles and capabilities on page 54
Migration operations
The data migration workflow includes multiple operations. You can initiate each operation manually
on the Datasets window Migration tab or on the vFiler Units window.
Related concepts

What gets migrated with a dataset on page 548
Managing vFiler unit migration on page 673
Related references

Administrator roles and capabilities on page 54
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Migration start operation
The migration start operation is initiated by starting the Dataset Migration wizard or the vFiler Unit
Migration wizard, either of which start the migration process and execute a baseline transfer of the
data to a new destination.
During the migration start operation, the NetApp Management Console provisioning capability
performs the following tasks:
•
•
•
•

•
•

•

Prompts you to choose whether to run migration in online or offline mode.
Checks the destination storage system for the necessary SnapMirror, synchronous SnapMirror
transfers, or MultiStore license support.
Checks the destination storage system for sufficient vFiler unit capacity and sufficient available
space.
Provisions destination storage according to the destination provisioning policy.
For vFiler unit migrations in which the vFiler unit is a container of one or more datasets, the
destination is provisioned according to the respective provisioning policies for each dataset.
Creates the required IPspace and VLANs on the destination storage system.
Starts the vFiler unit migration by executing the baseline transfer of the vFiler unit volumes.
Depending on the available bandwidth and the amount of data to migrate, the baseline transfer
can take from minutes to weeks to complete.
Polls for the SnapMirror transfers to complete.

If the NetApp Management Console provisioning capability encounters a failure at any point in this
operation, it reports the error and reverts all migration start changes done to that point.
Migration update (optional)
This operation performs an on-demand incremental update of the SnapMirror relationships that were
created during the migration start operation.
You can start this operation to update the destination storage systems one last time before starting the
migration cutover operation. The migration update operation is useful if a scheduled update fails and
thus causes the lag time between successful updates of the SnapMirror relationships to increase to an
undesirable length.
Migration cutover operation
After the migration start operation is complete, the migration cutover operation can be performed.
You can access the vFiler unit on the new destination storage system. You will no longer have access
to the vFiler unit on the source storage system. If you initiate data migration, you can enable the
cutover operation to occur automatically rather than manually at the end of the start migration
operation.
Before performing the data source cutover to the new destination, the NetApp Management Console
provisioning capability verifies that the following is true:
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•
•
•
•

•
•
•
•

•

The IP addresses of the source vFiler unit are not in use in the same IP space in the destination
storage system.
No error occurred in the last update on any of the SnapMirror or synchronous SnapMirror
relationships involved in migration.
If online migration is not enabled, all applications that use the dataset or vFiler unit are shut
down.
If the online migration option is enabled, both the source storage system and the destination
storage system have the snapmirror_sync license and are running compatible Data ONTAP
versions. (The snapmirror_sync license is free if the SnapMirror license is installed.)
The destination storage system has the licenses for all allowed protocols on the vFiler unit.
The aggregates hosting the destination volumes have enough space.
All the volumes that belong to the source vFiler units have SnapMirror or synchronous
SnapMirror relationships to the destination volumes.
Current CPU utilization on the source storage system and the destination storage system does not
exceed 65 percent.
If CPU utilization is between 65 percent and 90 percent, the following condition should be
satisfied to proceed with the cutover operation:
(1-V)*U + C*V < 90
where, V is the percentage of CPU utilization for the migrating vFiler unit, U is the CPU
utilization of system, and C is the cost factor. The default value for cost factor is 2, and minimum
value is 1.
If CPU utilization exceeds 90 percent, then the NetApp Management Console provisioning
capability reverts all changes, and you have to perform the cutover operation to the new
destination storage system again.
Current disk utilization of the selected aggregates on the destination storage system does not
exceed 70 percent.
Note: If any of these items is not true, the migration cutover operation is not performed and an
error message is displayed.

When all checks have passed, using the NetApp Management Console provisioning capability, the
following tasks are performed:
•

•

Changes the corresponding SnapMirror relationships to synchronous mode if the vFiler volumes
belong to datasets with the online migration option enabled, and waits for the relationships to
synchronize.
Runs the specified script
If a script is specified as part of the destination switch operation and it contains premigration
operations, they are executed before the cutover is performed.
If a script is specified as part of the destination switch operation and it contains cutover
operations, they are executed during the cutover operation. (This is useful when you have a script
to quiesce an application.)
If the script contains postmigration operations, they are executed after the cutover is performed.
(This is useful when you have a script to resume an application.)
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•

•
•

•
•
•
•

Switches data access from the original source vFiler unit to the new destination vFiler unit and
deletes the source vFiler unit.
The new destination vFiler unit becomes active, writable, and online.
Suspends the datasets to prevent new backups from starting during the migration.
Removes volumes from the source dataset
As each volume is added to the new destination, the source volume is removed from the source
dataset. Dynamic references in the source dataset are not removed; you must remove them after
the migration cleanup operation finishes.
Modifies the backup version tables to point to the new primary storage.
Modifies all backup and mirror relationships to point to the new primary storage.
Copies the history data in Operations Manager to reflect the new primary storage.
Resumes the dataset operation.

When the cutover operation is finished, you can restart any application that was shut down before the
migration.
The NetApp Management Console provisioning capability responds to failures as follows:
•

•

•

If the data migration succeeds but the backup relationship migration fails, the dataset remains in
suspended mode with the status "Migrated with errors."
You must manually correct the errors. When the errors are corrected, you can use the Operations
Manager CLI commands to change the migration status to Normal and then resume dataset
operation.
If the migration cutover operation fails, the source vFiler unit is brought back online, the status of
the source dataset and vFiler unit is set to "Migrate failed," and the destination storage is
destroyed.
If either the source vFiler unit or the destination vFiler unit crashes, cutover operation is aborted,
all the changes done so far are reverted, and performance monitoring is stopped.

Migration rollback (optional)
The optional migration rollback operation reverses a migration after the cutover phase and restores
the original source storage systems as the active accessible systems.
You can roll back a migration that is in the "Migrated, cleanup required" status after the migration
start and migration cutover operations are complete, but before migration cleanup. When you roll
back a dataset migration, the NetApp Management Console provisioning capability restores the
availability of the original source storage, updates it with any data changes made since cutover, and
deletes the destination vFiler unit.
Migration cleanup operation
During this operation the NetApp Management Console provisioning capability deletes the old
source volumes left in the old source storage system from before migration.
Usual practice is to start this operation several days after successful migration cutover from source to
target location, after the system administrator is satisfied that the results of migration are satisfactory,
and no roll back operations are necessary.
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During this operation, a preview window allows you to see which volumes will be destroyed.
VLANs and IPspaces used by the old vFiler unit are not automatically destroyed; you must remove
them manually after the migration cleanup operation finishes.
Manual cleanup after migration
After the migration cleanup operation is finished, and the source dataset or vFiler unit status is "Not
started," you must use an application like FilerView to manually delete dynamic references in the old
source dataset and VLANs and IPspaces used by the old source vFiler unit.

Managing dataset migration
You can start a dataset migration, initiate all the operations required for a complete migration, view
migration status, and relinquish migration capability for a dataset.
Decisions to make before starting dataset migration
Before starting a dataset migration operation by using the Dataset Migration wizard, it is useful to
have ready all the migration information for the dataset and associated vFiler unit.
Dataset
migration
commands or
vFiler unit
migration
commands

Are you migrating a dataset or a vFiler unit?
•

•
•

Online or
offline
migration

If there is a direct one-to-one correspondence between a dataset and a vFiler
unit, you may use either the dataset migration commands or the vFiler unit
migration commands.
If a vFiler unit contains more than one dataset, you should use the vFiler unit
migration commands.
If a vFiler unit contains more than one dataset, but the storage for at least one
of the datasets is owned by more than one vFiler unit, you should use the
dataset migration commands for each separate dataset.

Are you performing online or offline migration?
•

•

If you perform online migration, the complete migration of data from the
source to destination locations can be carried out non-disruptively, with no
shutdown required during the migration cutover operation.
If you perform offline migration, the data undergoing migration is
unavailable during the cutover phase of the migration process.
Note: Online migration requires additional configuration compatibility.

Destination
storage system

What is the destination storage system for the migrated dataset?
You can select a resource pool or a storage system as a destination.
•

If the vFiler unit attached to the dataset was created automatically when the
dataset was added, then you can select a resource pool and the NetApp
Management Console provisioning capability selects the best storage system.
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•

Destination
provisioning
policy
Interface
selections

If the vFiler unit attached to the dataset was not created automatically when
the dataset was added (it was assigned after the dataset was created), then
you must select a storage system and provide the network binding
information.

Which provisioning policy do you want applied to the migrated dataset?
By default, the currently assigned provisioning policy for the source dataset is
selected; however you can select a different one.
If the vFiler unit for the dataset was assigned after the dataset was created, then
you need to provide interface information.
•

What vFiler unit interface and VLAN ID do you want to use?
If the vFiler unit associated with the dataset was not created using the default
Interface settings and if the destination storage system has a default Interface
configured, then which interfaces do you want configured? You can select
from a list of already-populated IP addresses that displays the associated
network mask and Interface values, and the already-populated VLAN ID of
each. You can also modify the VLAN ID. You can customize the MTU size
for the VLAN.
Note:

The value for network mask is displayed as its prefix length. If you want to
change the value, you can enter it as prefix length (for example: 24) or as
dotted notation (for example: 255.255.255.0)
Valid prefix length values are 1-31 for IPv4 and 1-127 for IPv6.
Valid dotted notation values are the dotted notation equivalents of the
valid prefix lengths.
Note: If you provisioned the vFiler unit automatically when you added the
dataset (using the Add Dataset wizard) but now you want to associate the
vFiler unit to a VLAN and configure the interface IP failover, you must
first use the Setup vFiler Unit wizard to edit the configuration of the vFiler
unit before starting the Dataset Migration wizard.

•

Bandwidth
limit

What vFiler unit interface and VLAN ID do you want to use in the partner
storage system?
If the destination storage system is configured for high availability, you also
need to specify an IP address in case IP failover occurs.

Do you want to limit the network bandwidth used by the NetApp Management
Console provisioning capability to carry out the dataset or vFiler unit migration?
The default is no bandwidth limit.
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Automatic
cutover

If performing online migration, do you want to enable the option to start
automatic cutover at the end of the migration start operation?

Migration of
network routes
(If you enable
automatic
cutover)

If you enable automatic cutover, how do you want to migrate the network route
information of the vFiler unit associated with your dataset?
The associated vFiler unit's network route information is contained in its IPspace
and in its /etc/rc file.
Migration of the network route information of the associated vFiler unit is
necessary to maintain undisrupted client connectivity after automatic cutover.
If you enable automatic cutover, the Dataset Migration wizard allows you to
select from the following alternatives to migrate the network route information:
•

•

•

Migrate all static routes that are present in the IPspace of the associated
vFiler unit.
This alternative requires no manual procedures to maintain vFiler unit
connectivity with all clients after automatic cutover.
Migrate only the persistent routes that are stored in the attached vFiler
unit's /etc/rc file.
This alternative requires that you manually add any non-persistent route
through which you want to maintain an undisrupted client connection to
the /etc/rc file of the associated vFiler unit prior to running the Dataset
Migration wizard.
Migrate none of the associated vFiler unit's network route information.
You might select this alternative if you are migrating to an existing dataset
destination that you know already has the necessary network route
information for its associated vFiler unit configured or if you are migrating a
dataset with an associated vFiler unit whose network route information you
wish to configure manually after migration.

The wizard also allows you to store all migrated static routes as persistent routes
in associated vFiler unit's /etc/rc file of the destination dataset.
Related concepts

Migration operations on page 551
Related references

Dataset migration requirements on page 547
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Starting a dataset migration
You can begin data migration for a dataset by initiating the migrate start operation, which starts the
Dataset Migration wizard and begins a baseline data transfer.
Before you begin

Have the information available that you need to complete this task:
•
•
•
•

•
•
•
•

Destination storage system (required)
Provisioning policy for destination storage system (optional)
Interface to which the IP address will be bound to the destination storage system and the VLAN
ID (required only for a dataset with a vFiler unit that was assigned after the dataset was created)
Physical VLAN interface on which the VLAN will be created if VLANs are created during
migration for the partner of the destination storage system (required if the destination storage
system has a HA configuration)
The amount of available network bandwidth to make available for the baseline data transfer from
the source to target locations.
Online or offline mode of migration to use.
If using online migration mode, whether or not to use automatic cutover at the end of the
migration start operation.
If enabling automatic cutover, whether to migrate all network route information or just persistent
network route information of the associated vFiler unit.

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Dataset migration is not the same as volume migration. You can only migrate individual volumes by
using the Secondary Space Management wizard to plan and automatically perform volume migration.
You can cancel a dataset migration anytime during the migration start operation.
Steps

1. From the menu bar, click Data > Datasets > Migration.
2. Select a dataset and click Start migration to start the Dataset Migration wizard.
3. Complete the pages of the wizard then confirm the details of the migration and click Finish to
complete the wizard.
You can check the job progress displayed in the Tracking Dataset Migration Job display popup
window or in the Jobs tab on the Datasets window Migration tab.
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Result

The Dataset Migration wizard executes the migration start baseline transfer of data from the
migration source location to the migration target location.
Note: This operation might be completed in a few minutes to a few weeks depending upon the
amount of data to be migrated and the available bandwidth to carry it out.

•

•

If you are running migration in offline mode, or in online mode with automatic cutover disabled,
the NetApp Management Console provisioning capability pauses when the baseline transfer is
complete and assigns the migrating dataset the status "Started, cutover required."
If you are running migration in online mode and with automatic cutover enabled, the NetApp
Management Console provisioning capability will automatically begin the cutover operation
when the migration baseline transfer finishes.

After you finish

•
•
•

If you are running migration in offline mode or if you are running migration in online mode but
with automatic cutover disabled, you must manually initiate the migration cutover operation.
If after the baseline data transfer is complete, you feel that you need to run an incremental update
to the migration destination, you can do so before you start migration cutover.
If you are running migration in online mode with automatic cutover enabled, the next action after
automatic cutover is complete is to consider cleanup of the source location.

Related concepts

Decisions to make before starting dataset migration on page 555
Migration operations on page 551
Related tasks

Updating dataset migration SnapMirror relationships on page 559
Cutting over to the new dataset storage destination on page 561
Rolling back a dataset migration on page 563
Cleaning up a dataset migration on page 562
Related references

Administrator roles and capabilities on page 54
Updating dataset migration SnapMirror relationships
If you are migrating offline, or migrating online with automatic cutover not enabled, after the
migration start operation finishes, you can initiate an on-demand update of the SnapMirror
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relationships that were created as part of the migration start operation. This is an optional step in the
dataset migration workflow.
Before you begin

Verify that the dataset's migration status is "Started, cutover required."
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

This operation is useful if a scheduled update fails, which causes the lag time of the SnapMirror
relationships to increase to an undesirable length.
Steps

1. From the menu bar, click Data > Datasets > Migration.
2. Select a dataset and click Update to update the SnapMirror relationships that were created as part
of the migration start operation.
3. Click Yes in the confirmation dialog box to begin the operation.
You can track the progress of the operation in the Datasets window Migration tab Jobs tab, or in
the Jobs window.
After you finish

To continue the migration, you must manually initiate the migration cutover operation at a
convenient time.
Related concepts

Migration operations on page 551
Related tasks

Cutting over to the new dataset storage destination on page 561
Related references

Administrator roles and capabilities on page 54

Provisioning Help | 561

Cutting over to the new dataset storage destination
After the migration start operation finishes, you can initiate the migration cutover operation to switch
the source from which the data is served to the destination and update the SnapMirror or synchronous
SnapMirror relationships.
Before you begin

•
•
•
•

Verify that the dataset's migration status is "Started, cutover required."
If you are performing offline migration, you must shut down all applications that use the dataset
during the migration cutover operation.
Ensure that you are not initiating an on-demand backup operation during the migration cutover
operation.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

You might want to initiate this operation at a time when the dataset has a very low level of activity.
Steps

1. From the menu bar, click Data > Datasets > Migration.
2. Select a dataset and click Cut over.
3. (Optional) In the Cut over wizard, you can enter the name of a script to be executed.
For example, a script might quiesce an application and then resume the application after the
cutover is performed.
4. Click Cutover in the Cut over wizard to begin the operation.
The SnapMirror relationships are converted to synchronous mode before the cutover begins.
Result

After the dataset is switched over to the destination storage system, the backup versions, backup
relationships, and DataFabric Manager history for the volumes are transferred to the destination
storage system.
After you finish

•
•
•

If you perform offline migration and quiesce your applications before starting cutover, you must
now restart all applications that use the migrated dataset.
Wait a few days to verify the viability of the migrated data at its destination location before
starting the cleanup operation.
If you decide to keep the migrated data at its destination location, you can initiate migration
cleanup at the original source location.
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•

If you decide to reverse the migration and restore data availability to the former location, you can
start the rollback operation.

Related concepts

Migration operations on page 551
Related tasks

Cleaning up a dataset migration on page 562
Related references

Administrator roles and capabilities on page 54
Cleaning up a dataset migration
After the migration cutover operation finishes, and you have waited a few days to verify the viability
of the data migrated to its new location, you can initiate the migration cleanup operation to delete the
original volumes still on the old data storage system.
Before you begin

Verify that the dataset's migration status is "Migrated, cleanup required."
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Start migration cleanup only after you verify that the newly migrated data is viable at its destination
location, and you are certain that migration rollback to its original source location is not necessary.
Steps

1. From the menu bar, click Data > Datasets > Migration.
2. Select a dataset and click Cleanup.
The Migration Cleanup confirmation dialog box lists the volumes on the old destination that will
be deleted.
3. Click Apply to begin the operation.
After you finish

To complete the migration process, you must manually perform the following cleanup tasks using an
application like FilerView (if the VLANs and IPspaces are not shared):
•
•

Dynamic references in the old source dataset
VLANs and IPspaces used by the old source vFiler unit
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Rolling back a dataset migration
You can roll back a dataset migration after it is completed but not cleaned up. is "migrated, cleanup
required." When you roll back a dataset migration, the NetApp Management Console provisioning
capability aborts all ongoing transfers and deletes all the provisioned storage on the destination
storage system and on the destination vFiler unit.
Before you begin

•
•

Verify that the dataset's migration status is "Migrated, cleanup required."
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Data > Datasets > Migration.
2. Select a dataset and click Roll back to start the Roll back wizard.
3. After you complete the wizard, click Finish.
Related references

Administrator roles and capabilities on page 54
Viewing dataset migration status
You can view the status of a dataset migration operation in the Datasets window Migration tab.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Step

1. From the menu bar, click Data > Datasets > Migration.
The status is displayed in the "Migration status" column.
Environment variables for data migration scripts
Use the following environment variables when you write premigration and postmigration scripts for
dataset and vFiler unit migration.
•

•

PM_CUTOVER_MODE
This variable indicates whether the script is to be executed before or after the switch to the new
destination. Valid values are as follows: PM_BEFORE_CUTOVER and
PM_AFTER_CUTOVER.
Information about the source dataset or vFiler unit:
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•

• PM_SOURCE_VFILER_ID
• PM_SOURCE_VFILER_NAME
• PM_SOURCE_FILER_ID
• PM_SOURCE_FILER_NAME
Information about the destination dataset or vFiler unit:

•

• PM_DEST_VFILER_ID
• PM_DEST_VFILER_NAME
• PM_DEST_FILER_ID
• PM_DEST_FILER_NAME
Information about the dataset:
•
•

PM_DATASET_ID
PM_DATASET_NAME

Relinquishing migration capability of a dataset
You can relinquish the migration capability of a dataset by removing the vFiler unit assignment for
the dataset.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

When provisioning a dataset, or starting a dataset migration, you might encounter a message that the
maximum number of vFiler units has been reached. When this occurs, you might need to relinquish
the migration capability of one or more datasets.
Note: This operation destroys the attached vFiler unit and relinquishes the contained resources (for
example, the volumes, the qtrees, the quotas, and the NFS, CIFS, and ISCSI exports to the hosting
storage system).
Steps

1. From the menu bar, click Data > Datasets > Migration.
You can also relinquish the migration capability of a dataset in the Edit Dataset window.
2. Select a dataset that has a vFiler unit assigned and for which you want to remove the migration
capability, and click Relinquish migration capability.
The "Relinquish migration capability" button is enabled only for datasets that have an attached
vFiler unit that was created when the dataset was first added.
The NetApp Management Console provisioning capability performs a test of the modification and
lists all resulting errors and warnings in the Preview Details window.
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3. In the confirmation dialog box, click Relinquish.
Related concepts

When to relinquish the migration capability of a dataset on page 551
Related references

Administrator roles and capabilities on page 54

Managing FlexClone volume migration
The NetApp Management Console provisioning capability supports FlexClone volume migration by
ensuring that FlexClone volume relationships remain intact. The capability also ensures that the data
does not expand (by creating an identical clone hierarchy as on the source volume) after migration.
Support for FlexClone volume migration
To support FlexClone volume migration, both the source storage system and the destination storage
system should be running Data ONTAP 8.1 or later.
To support FlexClone volume migration, the NetApp Management Console provisioning capability
performs the following operations:
•
•
•

•

•
•

Ensures that the FlexClone license is installed on the destination storage system.
Displays an error message if all the parent volumes and the corresponding FlexClone volumes do
not belong to the migrating vFiler unit.
Ensures that the destination volumes for all non-FlexClone volumes (base volume) are
provisioned.
The NetApp Management Console provisioning capability starts baseline transfer for all these
provisioned volumes and waits till the baseline transfer is complete.
Creates destination FlexClone volumes for all source FlexClone volumes that complete parent
volume transfer.
The NetApp Management Console provisioning capability uses the corresponding Snapshot copy
to create the destination FlexClone volume from which the source FlexClone volume was
provisioned.
Ensures that the FlexClone volumes are provisioned on the same parent volume aggregate on the
destination storage system.
Performs a SnapMirror resync between the source FlexClone volume and the destination
FlexClone volume in parallel, and waits till the operation is complete.
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FlexClone split operation during migration start operation
During migration start operation, if you initiate the FlexClone split operation, the migration start
operation might complete successfully. In case an error is detected, the cutover operation is aborted,
and migration start operation is repeated.
After the FlexClone split operation, the corresponding FlexClone does not have any relationship with
its parent volume on the source storage system. This is because the FlexClone volume hierarchy on
the source storage system and the destination storage system differs. However, the FlexClone volume
remains intact on the destination storage system.
The NetApp Management Console provisioning capability detects these errors during the migration
cutover operation, and aborts the cutover operation. In such a situation, you should remove the
provisioned volumes on the destination storage system by either canceling the migration operation,
or manually clearing the data from the destination storage system, and then restart migration.
FlexClone split operation during migration cutover operation
During migration cutover operation, if you initiate the FlexClone split operation, the NetApp
Management Console provisioning capability cannot detect whether FlexClone split has occurred.
The cutover operation completes, but you cannot roll back changes or perform rapid-entry operation.

About deduplication
Deduplication allows you to reduce the amount of space used to store active data, or even allows you
to purposely over deduplicate and store more bytes of data than the capacity of the available physical
storage.
What deduplication is
Deduplication is the NetApp Management Console provisioning capability option that you can
enable on your storage nodes to eliminate duplicate data blocks to reduce the amount of storage
space used to store active data.
You can enable your provisioning policies to support three modes of deduplication.
On-demand
deduplication

On-demand deduplication is executed on a selected volume that is enabled for
deduplication when you click the Dedupe Now button on your Provisioning
tab.

Automated

Automated deduplication, if enabled on a dataset node, is run automatically on
any volume in that node when the amount of new data written to that volume
reaches 20%.

Scheduled
deduplication

Scheduled deduplication, if enabled on a dataset node, is run automatically on
the volumes in that node on the days of the week, during a particular time
period, and at a frequency that you have specified.
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Deduplication configuration requirements
You must ensure that the storage systems on which SAN or NAS containers reside meet certain
requirements before you enable deduplication for them.
To support deduplication, managed storage systems must meet the following configuration
requirements:
•

Data ONTAP 7.2.4 or later is installed.
Note: Data ONTAP 7.3 or later is required to support deduplication on of volumes on a vFiler

unit.
•
•

The Deduplication license is installed.
The NearStore personality license is installed.
Note: This license is not required for R200 storage systems or storage systems running Data
ONTAP 7.3.1 or later.

•

Storage system-specific and Data ONTAP version-specific maximum volume sizes for
deduplication are observed.
Attention:

•
•

•

Scheduled deduplication is not supported on SnapVault or volume SnapMirror destinations.
If deduplication is enabled on a volume on which Autogrow and Snapshot autodelete
capabilities are enabled and fractional reserve is disabled, writes cannot be guaranteed on that
volume.
To ensure against partial failure of SnapVault-based or Qtree SnapMirror-based backup
operations from an over-deduplicated primary volume to a secondary volume of the same size,
you can enable the global dpDynamicSecondarySizing option of the NetApp Management
Console data protection capability in Operations Manager.
Enabling the NetApp Management Console data protection capability for dynamic resizing of
backup volumes allows a backup volume to dynamically resize its physical capacity in the
event that the logical amount of over-deduplicated data being transferred from its primary
volume exceeds the secondary volume's original physical size.

For more information about deduplication-supported maximum volume sizes on various storage
systems running various versions of Data ONTAP, see the latest version of the NetApp
Deduplication for FAS and V-Series Deployment and Implementation Guide (TR-3505).
Related information

NetApp Deduplication for FAS and V-Series Deployment and Implementation Guide - http://
media.netapp.com/documents/tr-3505.pdf
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What happens during deduplication
After deduplication is enabled and started, the NetApp Management Console provisioning capability
performs a full or incremental consolidation of duplicate data blocks on the volumes on which
deduplication has been applied.
•

How the deduplication process starts
The deduplication process is triggered by one of three possible events:
•
•

•

If the "On-demand deduplication" mode is enabled on a dataset node, deduplication is run ondemand by the user on a selected volume.
If the "Automated deduplication" mode is enabled on a dataset node, deduplication begins
automatically on a volume residing on that dataset node when the amount of new or changed
data on that volume reaches 20 percent.
If the "Scheduled deduplication" mode is enabled on a dataset node, deduplication begins
automatically according to a user-customized schedule on all volumes in a dataset node.
Note: In "Scheduled deduplication" mode, deduplication starts on Disaster Recoverycapable Mirror destinations only after the SnapMirror relationship between primary storage
and the secondary storage nodes on which they reside is broken.

•

Initial deduplication operation on a volume
The initial deduplication operation on a volume is a full volume run. All blocks of data on the
volume are scanned for deduplication and the duplicate blocks are consolidated (or deduplicated).
Attention: Because the initial deduplication operation is a full volume run, in which all data is

scanned, it requires more time to complete than subsequent operations.
•

Subsequent deduplication operations
Subsequent deduplication operations are usually incremental scans. Only the new or changed
blocks of data on the target volume or volumes are scanned for deduplication and possible
consolidation.
Note: In "On-demand deduplication" mode, you have the option of starting a full volume or

partial volume run every time you click Dedupe Now.
•

Deduplication on a SnapMirror destination volume
You might also perform deduplication on a SnapMirror destination volume in the following
circumstances:
•
•
•

After a dataset or vFiler unit migration
After a secondary or tertiary volume migration as part of a plan to reclaim space on an
aggregate
After a failover, if the volume is in secondary disaster recovery storage

In these situations, the fingerprint database file is not copied with the volume data. (A
deduplication fingerprint database file contains a digital signature for every 4-KB data block in a
FlexVol volume. The fingerprint database and the change logs form the deduplication metadata.)
Therefore, if you perform only an incremental deduplication scan, the new data blocks are not
consolidated with the existing data in the volume and potential matches cannot be found.
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•

However, if you perform a full deduplication scan directly after a migration or failover, the
fingerprint database is rebuilt, which enables subsequent scans to find the greatest number of
matches.
Deduplication-enabled volumes and corresponding fingerprint database
If a migrating vFiler unit has a deduplication-enabled volume, the corresponding fingerprint
database does not migrate during the migration cutover operation. It has to be rebuilt after the
migration cutover operation. However, in Data ONTAP 8.1 and later, the fingerprint database is
not generated immediately after the migration cutover operation. It is generated during the next
sis scan.

Over deduplication
Over deduplication is the effective deduplication-enabled storage of more logical bytes of data in a
volume or aggregate container than are actually allotted to that container. The measure of over
deduplication can be expressed as a percentage of volume capacity or as a percentage of aggregate
capacity.
Over
deduplication
in a volume

Over deduplication in a volume is expressed as a percentage of the
deduplication-enabled logical stored data in a volume over the actual physical
capacity of that volume.
This percentage is calculated as: 100 × (logical stored data ÷ total volume size)
Note: Logical stored data = used volume space + deduplication saved space

As an example of over deduplication on a volume, consider a deduplicationenabled volume of 100GB with no Snapshot reserve. If the user fills that volume
with 80GB of data (consisting of eight common files of 10GB each) and runs
deduplication on that volume, the user sees a deduplication space saving of
70GB and a used volume space of 10GB.
If the user fills the volume with an additional 70GB of data (again consisting
seven 10GB files consisting of the same common data as above), and
deduplication is re-run, the second deduplication run gives the user an additional
deduplication space savings of 70GB, and the used space in volume is still
10GB.
In this case: used volume space = 10GB; deduplication saved space = 140GB
So the logical stored data = 150GB on a total volume size of 100GB.
Over deduplication for the volume = 100 × (150GB ÷ 100) which is 150%
Over
Over deduplication in an aggregate is expressed as a percentage of total logical
deduplication
stored data over the total aggregate size.
in an aggregate
This percentage is calculated as: 100 × (total logical stored data ÷ total aggregate
size)
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Note:

•
•
•

•
•

Total logical stored data is the sum of the logical stored data of each
deduplication-enabled volume in the aggregate.
The logical stored data on a volume is calculated differently for volumes
with different space guarantees.
On volumes with volume space guarantee, the logical stored data is
calculated as the total volume size or as used space plus deduplication
saved space, whichever is greater.
On volumes with file guarantee enabled, logical stored data is calculated as
the sum of used space and deduplication saved space.
On volumes with no space guarantee enabled, the logical stored data is
calculated as the sum of the used space and the deduplication saved space.

As an example of over deduplication for an aggregate, consider a 1TB aggregate
consisting of 5 volumes, 3 of those volumes deduplication-enabled, with
deduplication-enabled space savings as follows:
•
•
•

Volume A (volume guarantee): 200GB Total size, 50GB Used space, 100GB
Saved Space
Volume B (file guarantee): 200GB Total size, 150GB Used space, 500GB
Saved Space
Volume C (none guarantee): 200GB Total size, 150GB Used space, 400GB
Saved Space

So the total logical stored data is 200GB + 650GB + 550GB or 1400GB located
on an aggregate of one TB or 1024GB.
The over deduplication for the aggregate is 100 × (1400GB ÷ 1024GB) or 136%
Note: For calculating over deduplication percentage the Snapshot reserve is
not counted since the data in the Snapshot reserve cannot be deduplicated.

Over
deduplication
and backup
protection

To ensure against partial failure of SnapVault-based or Qtree SnapMirror-based
backup operations from an over deduplicated primary volume to a secondary
volume of the same physical size, you can enable the global
dpDynamicSecondarySizing option in Operations Manager
Enabling the NetApp Management Console data protection capability for
dynamic resizing of backup volumes allows a backup volume to dynamically
resize its physical capacity in the event that the logical amount of over
deduplicated data being transferred from its primary volume exceeds the
secondary volume's original physical size.
Do not enable dynamic resizing of backup volumes if you enable deduplication
and use a "Mirror, then backup" type protection policy.
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Deduplication space savings percentage
Deduplication enables you to store more logical data using less physical storage space. The
deduplication space savings percentage is the deduplication space savings over the logical used space
on the volume or aggregate container minus that used space that is claimed for Snapshot reserve or
overwrite reserve functions and cannot be deduplicated.
Deduplication
space savings

Deduplication space savings is the absolute amount of space that is saved in a
volume or aggregate because of deduplication.
As an example of deduplication space savings on a volume, consider a
deduplication-enabled volume of 100GB with no Snapshot reserve. If the user
fills that volume with 80GB of data, which happens to consist of eight 10GB files
consisting of the same common data, and runs deduplication on that volume, the
user sees an actual used volume space of only 10GB and a deduplication space
saving of 70GB.
If the user fills the volume with an additional 70GB of data (again consisting
seven 10GB files consisting of the same common data as above), and
deduplication is re-run, the second deduplication run gives the user an additional
deduplication space savings of 70GB, and the used space in volume is still 10GB.
So in total the deduplication space savings for that volume is 140GB.

Volume Space
Savings
percentage

The deduplication space savings percentage for a volume is expressed as a
percentage of the deduplication space savings against the logical used volume
data space.
The formula for calculating the deduplication space savings percentage for a
volume is:
100 × (deduplication space savings ÷ logical used volume data space)
The logical used volume data space is calculated as follows:
•

In NAS volumes, logical used volume data space = deduplication space
savings + total volume space used – Snapshot reserve space – Snapshot
overflow
Note: Snapshot reserve space and Snapshot overflow space cannot be

deduplicated and so do not enter into the percentage calculation.
•

In SAN volumes, logical used volume data space = deduplication space
savings + total volume space used – Snapshot overflow - available overwrite
reserve - the reserve hole..
Note: The Snapshot reserve space for SAN volumes is generally 0.

Therefore, all the Snapshot data gets counted as Snapshot overflow. In
addition to Snapshot overflow, the available overwrite reserve and the hole
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reserve are deducted from the total volume space used because these
reserves cannot be deduplicated.
As an example, if NAS volume A, experiences a deduplication space saving of
50GB, an actual volume space usage of 75GB, a Snapshot reserve space of
10GB, a Snapshot overflow of 5GB, then the deduplication space savings
percentage is 100 × 50GB ÷ (50GB + 75GB - 10GB - 5GB) which calculates as
45%.
Aggregate
Space Savings
percentage

Aggregate space savings percentage is the percentage of total deduplication space
savings in the aggregate against the logical used space of the aggregate.
The aggregate space savings percentage is calculated as follows:
100 × aggregate deduplication space savings ÷ aggregate logical space used.
•
•

aggregate deduplication space savings = the total deduplication space savings
in all the volumes contained in an aggregate.
aggregate logical space used = the aggregate deduplication space savings +
the total used space in all the volumes that have been enabled for
deduplication in an aggregate.

For example, if Aggregate B, experiences an aggregate deduplication space
saving of 500GB, an actual aggregate space usage of 750GB, a Snapshot reserve
space usage of 50GB, a Snapshot overflow of 25GB, then the aggregate
deduplication space savings percentage is 100 × 500GB ÷ (500GB + 750GB 50GB - 25GB) which calculates as 42%.

Configuring deduplication
You can enable and disable deduplication.
Enabling deduplication on your dataset nodes
You can enable deduplication on a new or existing provisioning policy and then assign that policy to
one or more dataset nodes. All volumes on that node are then enabled for deduplication.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

If you enable automated deduplication or scheduled deduplication in the provisioning policy that you
assign to a dataset's secondary or tertiary node, any NetApp Management Console assigned backup
relationship from source to target is implemented as a qtree SnapMirror relationship rather than as a
SnapVault relationship.
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Steps

1. Enable deduplication on a new or existing provisioning policy.
•

•

If you are enabling deduplication while creating a new provisioning policy, start and complete
the Add Provisioning Policy wizard.
While completing the wizard, enable deduplication and specify the mode of deduplication
(On-demand deduplication, Automated deduplication, or Scheduled deduplication) that you
want to enable.
If you are enabling deduplication on an existing provisioning policy, select, edit, and save that
policy.
While editing the policy, enable deduplication and specify the mode of deduplication (Ondemand deduplication, Automated deduplication, or Scheduled deduplication) that you want
to enable.

2. Assign the provisioning policy on which you have enabled deduplication to the dataset node that
contains the volumes or will contain the volumes on which you want to execute deduplication.
Result

Depending on the mode of deduplication that you enabled, initial deduplication starts differently on
the target volumes.
•

•
•

If you enabled On-demand deduplication, deduplication starts when you navigate to the
Provisioning tab, select the dataset and the volume on which you want to run deduplication, and
click Dedupe Now.
If you enabled Automated deduplication, deduplication starts on a volume when the amount of
new data written to that volume since the last deduplication reaches 20% of volume capacity.
If you enabled Scheduled deduplication, deduplication starts on the volumes in a dataset node on
the days of the week, during a particular time period, and at a frequency that you have specified.

After you finish

After deduplication is started, you can view the Deduplication tab to monitor the space saved on the
volumes due to deduplication.
Disabling deduplication on dataset nodes
You can disable deduplication for a set of volumes by editing the provisioning policy assigned to the
storage node on which they reside.
Before you begin

•

•

Confirm that the provisioning policy that is assigned to the dataset node on which you want to
disable deduplication is not also assigned to other dataset nodes on which you do not want to
disable deduplication.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
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Step

1. To disable deduplication for a storage node, select, edit and save the provisioning policy assigned
to that node. While editing the policy, deselect the deduplication option.
Result

After deduplication is disabled on a dataset node, all deduplication on the volumes that reside on that
node stops. Data blocks already deduplicated remain deduplicated, but no further deduplication is
carried out.
Note: Later changes to currently deduplicated data blocks causes those blocks to unconsolidate
and lose deduplication.
Related tasks

Editing a provisioning policy on page 624

Managing deduplication
You can start and stop an on-demand deduplication and view the amount of space saved on a
volume.
Starting on-demand deduplication
You can start on-demand deduplication on any volume that resides on a dataset node that has been
enabled for deduplication.
Before you begin

•
•

Ensure that the volume on which you want to start on-demand deduplication resides on a dataset
node on which deduplication is enabled.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Data > Datasets > Provisioning.
2. Select the dataset that contains the volume on which you want to start deduplication.
3. Select the volume and click Dedupe Now.
4. When prompted specify whether to execute full-volume deduplication or partial volume
deduplication.
•
•

Full volume deduplication scans all the data in the volume for possible deduplication.
Partial volume deduplication scans the new data since the last deduplication scan for possible
deduplication.
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Result

Either full-volume or partial volume deduplication starts on the selected volume.
Related references

Administrator roles and capabilities on page 54
Stopping an in-progress deduplication
You can stop deduplication that is in progress on a selected volume.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Datasets > Provisioning.
2. Select the dataset that contains the volume on which you want to stop an in-progress
deduplication.
3. Select the volume.
If deduplication is in progress, the Abort deduplication button is active.
4. Click Abort dedupe.
Result

Further deduplication on the selected volume stops. Data blocks already deduplicated by the stopped
job remain deduplicated.
Note:

•
•

Later changes to the deduplicated data blocks unconsolidates those blocks, and the spacesavings related to that deduplication is lost.
Unless deduplication on the dataset node has been disabled, later on-demand, automated, or
scheduled deduplication will restart or resume the deduplication on the selected volume.

Viewing volume-level deduplication space-saving
You can view graphs that indicate the space saving that deduplication enables on selected volumes.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.

576 | Provisioning and Data Protection Online Help
Steps

1. From the menu bar, click Data > Datasets > Provisioning.
2. Select the dataset that contains the volume on which you want to view deduplication-related
space savings.
3. Select the volume and click the Deduplication tab.
The NetApp Management Console provisioning capability displays a chart and explanation
comparing storage space currently used by the selected volume with the storage space it would be
using without deduplication enabled.

What a resource pool is
A resource pool is a collection of unused physical storage resources, such as aggregates and disks,
grouped together based on a user-defined set of common attributes.

About resource pools
You might pool your resources based on attributes such as performance, cost, physical location, or
availability. By grouping related resources into a pool, you can treat the pool as a single unit for
monitoring, provisioning, reporting, and role based access control (RBAC). This simplifies the
management of these resources and allows for a more flexible and efficient use of the storage.
Overview of resource pools
You create resource pools by using the Add Resource Pool wizard, which is accessible from the
Resource Pools window. The wizard lets you select aggregates, entire storage systems, or groups of
physical resources from which to create your resource pool.
After you create a resource pool, you can associate it with one or more datasets. You can also
associate datasets with provisioning and protection policies. These tasks can be accomplished when
you add or edit datasets from the Datasets window.
When you assign a data protection policy, the NetApp Management Console data protection
capability applies the policy settings to automatically provision destination volumes from the
assigned resource pool. It then creates backup and mirror relationships from each volume and qtree
in the dataset to the newly provisioned secondary storage.
When you assign a provisioning policy to a dataset node, the NetApp Management Console
provisioning capability applies the availability characteristics and space settings in the policy to
automatically select the resources needed to fulfill a request for storage space for the primary data of
a dataset.
These relationships between physical storage units, resource pools, and datasets mean that you must
consider carefully what the impact might be of changes made to the system.
Related concepts

Dataset concepts on page 65
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What groups are on page 67
Ways you might combine resources in resource pools on page 157
Related references

Advantages of using resource pools on page 157
Advantages of using resource pools
Resource pools enable you to simplify physical storage resource management.
Creation and use of resource pools gives you the following advantages:
•
•
•
•
•
•
•

You can group various resources with similar attributes, providing a quick view of similar storage
objects.
Resource pools provide a single logical unit for provisioning.
You can simplify physical resource management by managing a pool of resources as a single
entity.
You can configure your system to automatically provision storage from resource pools, without
your intervention.
You can create resource pools in advance of allocating them to datasets, so that the resource pools
are available when needed.
You can enable event generation on resource pools so that when a set threshold is crossed, an
event is generated to alert the resource pool owner.
You can assign a label to resource pools or members of resource pools.
This allows you to filter the resources available for provisioning to only those that have a specific
label assigned to them.

Ways you might combine resources in resource pools
Prior to creating resource pools, consider how you will be using the available storage. This will help
you to determine how you want to combine those resources into resource pools to meet your setup's
replication needs.
Following are examples of ways that you might combine your physical resources to make the most
efficient use of your resource pools:
•

•

•
•

A set of aggregates composed of inexpensive, slow, ATA drives
This pool is suitable for archival or compliance purposes, but it is not appropriate for missioncritical, high-performance database applications.
A set of high-performance aggregates composed of 15K Fibre Channel disk drives in a RAID-DP
configuration
This pool is suitable for enterprise-critical applications.
A set of resources categorized based on cost or performance
This pool might be given a simple designation, such as Gold, Silver, or Bronze.
A set of storage systems that are suitable for provisioning for certain departments within an
organization
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•

A set of homogenous resources grouped together as a way of restricting access to highperformance storage

Sequence for selecting backup destination volumes
If an existing backup relationship already has a volume assigned to contain backup data, the NetApp
Management Console data protection capability tries to use it. Otherwise, the NetApp Management
Console data protection capability selects an existing volume that meets certain requirements or, if
necessary, provisions a new destination volume.
By default, the size requirement for destination volumes that are provisioned by the NetApp
Management Console data protection capability are dynamically sized either to 1.1 x 2 x the
currently used primary volume storage or to 1.1 x 1.2 x the primary volume size, whichever is
greater. However, if the DataFabric Manager server dynamic secondary sizing option,
dpDynamicSecondarySizing, is disabled, the new volume is thin provisioned to be the same size as
the aggregate in which it resides.
Note: Whenever possible, the NetApp Management Console data protection capability uses

FlexVol volumes when provisioning backup destination volumes. The NetApp Management
Console data protection capability implements aggregate overcommitment, observing the
Aggregate Overcommitted and Aggregate Nearly Overcommitted thresholds specified in
Operations Manager. For more information about aggregate overcommitment, see the Operations
Manager Administration Guide and the Data ONTAP 7-Mode Storage Management Guide. For
information about the aggregate overcommitment thresholds, see the Operations Manager online
Help.
For data residing on Open Systems SnapVault clients, the NetApp Management Console data
protection capability uses a projected size of 10 GB for the destination volume.
To be considered as a destination for backups, a volume must be on a storage system configured with
the appropriate Data ONTAP licensing to store backups.
From the pool of volumes that meet these requirements, the NetApp Management Console data
protection capability takes the following steps to select a destination volume for backups:
1. The NetApp Management Console data protection capability looks for secondary volumes
associated with the dataset that already have a relationship originating from the primary volume.
However, if a secondary volume has too many relationships, the NetApp Management Console
data protection capability excludes that volume from the selection process. The default maximum
number of relationships is 50.
2. Of the secondary volumes associated with the dataset that have a preexisting relationship with the
primary volume, the NetApp Management Console data protection capability looks for a
destination that has enough space to satisfy the projected space requirement of the primary data.
3. If none of the secondary volumes with preexisting relationships with the primary volume can
satisfy the space requirement, the NetApp Management Console data protection capability scans
the destination systems for an existing FlexVol volume with adequate space and no SnapVault or
Qtree SnapMirror relationships.
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4. If the NetApp Management Console data protection capability cannot locate an existing FlexVol
volume with adequate space and no SnapVault or Qtree SnapMirror relationships, it scans the
destination systems for existing traditional volumes with adequate space and no SnapVault or
Qtree SnapMirror relationships.
5. For systems running Data ONTAP 7.0 or later, if the NetApp Management Console data
protection capability cannot find a volume with adequate space and no existing SnapVault
relationships, it attempts to provision a FlexVol volume.
6. If the NetApp Management Console data protection capability cannot provision a FlexVol
volume, it generates an error.
Related information

Operations Manager Administration Guide - http://support.netapp.com/NOW/knowledge/docs/
DFM_win/dfm_index.shtml
Sequence for selecting mirror destination volumes
To find a suitable destination to contain mirrored data, the NetApp Management Console data
protection capability tries to use the same volume used for an existing mirror relationship, if there is
one. Otherwise, the NetApp Management Console data protection capability selects an existing
volume that meets certain requirements or, if necessary, provisions a new destination volume.
If the NetApp Management Console data protection capability needs to provision a new volume to
contain mirrored data, by default the new volume is provisioned to be the same size as the source
volume being protected. However, if the DataFabric Manager server dynamic secondary sizing
option, dpDynamicSecondarySizing, is disabled, the new volume is thin provisioned to be the same
size as the aggregate in which it resides.
Note: If the NetApp Management Console data protection capability provisions a mirror
destination volume on a tertiary node, the new volume is provisioned to be the same size as the
secondary volume even if the secondary volume is larger than the tertiary aggregate. Space
guarantees for the new volume are disabled.

The NetApp Management Console data protection capability takes the following actions to select a
destination volume for mirror copies:
1. If there is no existing mirror relationship, the NetApp Management Console data protection
capability scans the destination systems for an existing volume that meets the following
requirements:
•
•
•
•
•

It is located on a storage system running the same version as or a later Data ONTAP version
of the storage system containing the data to be mirrored.
It is located on a storage system on which the SnapMirror license is enabled.
It is of the same type (FlexVol or traditional volume) as the volume containing the data to be
mirrored.
It is the same size as or larger than the source volume
It has no SnapVault or SnapMirror relationships.
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•

It is within an aggregate of the same block type as the aggregate containing the source volume
unless both source and destination storage systems use Data ONTAP-v8.1 or later.
If both source and destination volumes are on systems using Data ONTAP-v8.1 or later,
matching block types are not required.

2. If the NetApp Management Console data protection capability cannot locate an existing volume
that meets the preceding requirements, it attempts to use available space in the resource pool to
provision a new volume of the same type as the volume containing the data to be mirrored.
For the NetApp Management Console data protection capability to provision a new volume, the
aggregate or spare disk where the new volume is created must meet the following requirements:
•
•
•
•

It belongs to a storage system running the same version as or a later Data ONTAP version of
the storage system containing the data to be mirrored.
It belongs to a storage system on which the SnapMirror license is enabled.
It has adequate space to contain the data in the source volume.
It is within an aggregate of the same block type as the aggregate containing the source volume
unless both source and destination storage systems use Data ONTAP-v8.1 or later.
If both source and destination volumes are on systems using Data ONTAP-v8.1 or later,
matching block types are not required.

3. If the NetApp Management Console data protection capability cannot provision a new volume for
the data to be mirrored, it generates an error.
Resource pool guidelines
Before adding or modifying a resource pool, you should make sure your plans follow the guidelines
that can help you optimize the advantages of using resource pools.
The status of a resource pool is equivalent to the worst status of any event associated with any
member of that resource pool.
Guidelines for the content and structure of resource pools
Resource pools cannot nest and cannot overlap (that is, storage in one resource pool cannot be in
another resource pool).
The following guidelines can help you optimize the advantages of using resource pools:
•
•
•

•
•
•

Resource pools can be members of DataFabric Manager groups, but resource pools cannot
contain DataFabric Manager groups.
Resource pools can be created from entire storage systems or from aggregates.
Adding a storage system to a resource pool implies that all existing aggregates and spare disks on
the storage system are included as part of that pool, along with any new aggregates that are
created.
Members of a resource pool do not all need to reside on the same storage system or HA pair.
A storage system can be designated as a resource pool that contains a mixture of resources with
various attributes.
A storage system or an aggregate can only belong to one resource pool at a time.
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•

Individual aggregates within the same storage system can belong to different resource pools as
long as the storage system as a whole has not been assigned to a resource pool.

Guidelines for selecting storage to include in resource pools
When creating a resource pool, you determine which storage elements to include in the pool based on
one or more common properties, such as "all storage in the same building" or "all storage delivering
the same level of performance."
The following guidelines can help you optimize the advantages of using resource pools:
•

•

•

•

Adding an aggregate to a resource pool allows the NetApp Management Console provisioning
capability to create new volumes by using the aggregate's free space.
When provisioning resources, the aggregate's preexisting volumes are not used.
When provisioning resources for primary data, you can choose to increase the available space in
an existing volume by deleting Snapshot copies or by assigning additional space for the volume.
LUNs cannot be resized.
In a NAS environment, you can grow space and delete Snapshot copies only manually. In a SAN
environment, these tasks can be done manually, but they can also be done automatically by using
a provisioning policy.
Access to a resource pool is controlled via role-based access control (RBAC).
Therefore, in some deployments you might want to group homogeneous resources together as a
way of restricting access to high performance storage. In other deployments you might construct
resource pools with a mix of storage attributes as a means of providing better storage utilization
across an organization.
Systems running on Data ONTAP versions earlier than 7.0 cannot use the aggregate or flexible
volume features.
This impacts how you assign destination resources for mirrored copies and backups.
Mirrors If you are mirroring data, you can only select entire storage systems to include in
resource pools. The NetApp Management Console data protection capability uses the
spare disks on the storage systems to provision traditional volumes for the mirrored
copies.
Backups The NetApp Management Console data protection capability cannot provision
resources for backup jobs. You must, manually create the volumes to add to the
dataset's secondary node. When you assign resources to a dataset, only the volumes
are available for selection.

Guidelines for provisioning from resource pools
When a resource pool contains a storage system, all aggregates on the storage system are available
for provisioning.
The following guidelines can help you optimize the advantages of using resource pools:
•

Both traditional and flexible volumes can be created from a resource pool.
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•

•

However, flexible volumes are available only on storage systems that are running Data ONTAP
7.0 or later.
Aggregates are used for provisioning of flexible volumes for Data ONTAP 7.0 or later. Spare
disks are used for provisioning of traditional volumes by the administrator, for Data ONTAP
versions prior to 7.0.
When using the NetApp Management Console data protection capability, you cannot control how
specific volumes are provisioned from resource pools.
The NetApp Management Console provisioning capability evaluates available resources for a
number of criteria, such as valid login credentials, working NDMP, Data ONTAP version, and so
forth. From the aggregates that pass those filters, the NetApp Management Console provisioning
capability picks the aggregate with the most free bytes as the one to hold the backup.

Guidelines for naming and labeling resource pools
You should name resource pools according to the characteristics of the storage each resource pool
contains.
The following guidelines can help you optimize the advantages of using resource pools:
•

•

The name is limited to 64 characters.
However, for readability, it is advised that names be no longer than 25 characters. You can use
any combination of letters, numbers, or special characters in resource pool names.
Use a label name that has significant meaning.
A label should only be used when you want to more narrowly control the resources being
provisioned. For example, if you want to restrict the provisioned resources by their cost and
performance, you might assign a label of Tier-1, Tier-2, or Tier-3. If a Tier-1 resource label is
selected for a provisioning policy and a provisioning action occurs, only those resources assigned
to the dataset and labeled as Tier-1 is considered for provisioning.

How resource labels work
You can assign a resource label as a way to narrow the available resources to be considered for a
provisioning request.
The resource label can be assigned when you create a resource pool. This is an optional custom
property that you can assign to a resource pool or to the individual storage systems or aggregates that
comprise the resource pool. You might assign a resource label based on factors such as cost,
reliability, or specific configurations. The resource label essentially functions as a filter. It allows you
to identify specific resources to be used to fulfill a provisioning request, so that only those resources
that have the label assigned to them are considered. This allows finer control when matching
provisioning requests with available resources.
When you create a provisioning policy, you can specify a resource label to be associated with the
policy. If a label is specified for a policy, only the resource pools and resource pool members that
match the label are used when a provisioning request is fulfilled using that policy. However, storage
that has an assigned resource label can still be used to fulfill provisioning requests that do not specify
a label.
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For example, assume an administrator assigns a resource label of Tier-1 to a resource pool
containing the highest-cost, most reliable storage. The administrator also creates a provisioning
policy named prov-pol-1, with the resource label Tier-1 specified. When a provisioning request is
made on a dataset that has the prov-pol-1 policy assigned to it, the NetApp Management Console
provisioning capability searches for storage that uses the Tier-1 label. If no resources with that
resource label are available, the provisioning request fails. For this reason, you should use resource
labels with care.

Configuring resource pools
In general, you use a wizard to configure resource pools and you use an editing window to modify
property values.
Decisions to make before configuring a resource pool
Before creating a resource pool by using the Add Resource Pool wizard, or modifying a resource
configuration by using the Edit properties option, is useful to have all the resource pool configuration
information ready.
Name
(required)

What name do you want to assign to the resource pool?
•

•

Description
(optional)

How do you want to describe the resource pool, so the intended use of the resource
pool is clear?
•

•
Owner
(optional)

Provide a meaningful description of the resource pool, such as an explanation of
the intended use of the resource pool, the type of storage contained in the
resource pool, or some other common attribute that identifies why the storage
was grouped into a resource pool.
The limit is 255 characters, but for readability, it is advised that you keep the
description under 40 characters.

Who should be contacted regarding problems with the resource pool?
•
•

Contact
(optional)

Provide a meaningful name that briefly describes the storage or the intended use
of the storage in the resource pool.
An example of a name that describes the storage path is: server1_homedirs,
tier1_mktg, or china_eng.
Special characters and spaces are permitted in names.
The limit is 64 characters, but for readability, it is advised that you keep the
name under 25 characters.

Provide the name of the person or people responsible for maintaining this
resource pool.
You can list multiple owners, delimited by commas. There is no formatting
restriction.

Who should be alerted regarding problems with the resource pool?
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•
•
•

Provide the e-mail addresses or e-mail aliases to which notifications, alerts, and
so forth should be sent concerning the resource pool.
The e-mail addresses listed here might be the same ones used for receiving
alerts regarding the resource pool.
You can have multiple e-mail contacts, delimited by commas.

Time Zone
(required)

Will you use the default time zone for the resource pool or change the time zone?

Physical
Resources
(required)

How will you determine which storage to include in the resource pool from the list
of physical resources available?

•

•
•
•

•

The resource pool must have a time zone selected. You can retain the default
setting or change it.
To select a time zone, you can either scroll through the entire list or type a time
zone designation in the Filter Time Zone text box.

Decide on which properties you want to base the creation of the resource pool:
for example, location, cost, performance, reliability, or access privileges.
Decide whether the resource pool will contain individual aggregates, an entire
storage system (all the aggregates in a storage system), or a combination.
Decide which version of Data ONTAP will run on the systems in this resource
pool.
Systems running Data ONTAP versions earlier than 7.0 cannot use the
aggregate or flexible volume features. This impacts how you later assign
destination resources for mirror copies and backups.
Decide if you want to use traditional volumes or flexible volumes in the
resource pool.
•
•

•
•
Labels
(optional)

Flexible volumes are available only when running Data ONTAP 7.0 or later.
Aggregates are used for provisioning of flexible volumes, and spare disks
are used for provisioning of traditional volumes.
• If you intend to associate a resource pool with a dataset in a mirror
relationship, the volumes on the primary node and those on the secondary
nodes must be of the same type. You cannot combine traditional volumes
and FlexVol volumes on nodes that are part of a mirror relationship.
Decide how much available storage space you need for the resource pool, based
on the resource pool's intended use.
Verify that you have the appropriate software licenses on the storage you intend
to use.

When a provisioning request is processed, do you want to restrict the resources
available for provisioning to only those with a specific label assigned to them?
•

A label set on an individual member of a resource pool takes priority over a
label applied to the entire resource pool. It essentially functions as a filter,
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•

Space
Thresholds
(optional to
modify
default)

allowing you to identify specific resources to be considered when fulfilling a
provisioning request.
The labels can be edited inline in the table. For both resource pool and
members, an existing label can be selected from the drop-down list or a new
label can be typed in. A resource label is a text string of any length.

At what point do you want to receive notification regarding consumption of space
in the resource pool?
•

•

Resource Pool Nearly Full threshold and Resource Pool Full Threshold
These thresholds can be used to track the amount of space that is consumed in a
resource pool. Events are generated when these thresholds are reached. The
default thresholds are: Nearly Full = 80%, Full = 90%.
Aggregate Nearly Overcommitted threshold and Aggregate Overcommitted
threshold
These thresholds can be used to track the sum of committed space of all the
aggregates that belong to the resource pool. Events are generated when these
thresholds are reached.
Tracking these thresholds in an environment in which the aggregates are
overcommitted (thin provisioning) is particularly important, because in such an
environment administrators commit more storage than is physically available.
The default thresholds are: Nearly Overcommitted = 300%, Overcommitted =
400%.

Related concepts

Effect of time zones on schedules on page 220
Protection policy node prerequisites on page 195
Decisions to make before adding or changing resource assignments on page 108
Related references

Resource pool guidelines on page 160
Adding a resource pool
You can create resource pools from collections of unused physical storage resources. Resource pools
are associated with one or more datasets, providing the physical resources for provisioning primary
storage by using a provisioning policy and also for backup or mirror protection on nonprimary nodes.
Before you begin

•
•

Ensure that the hosts you are adding to the resource pool have the proper configuration and
licensing for their intended use.
Have the information available that you need to complete this task:
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•

• Resource pool name (required)
• Description (optional)
• Owner (optional)
• Contact e-mail address for alerts (optional)
• Time Zone (optional)
• Physical Resources (required)
• Resource Pool Label (optional)
• Space Thresholds (optional to modify the default)
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Data > Resource Pools.
2. Click Add to open the Add Resource Pool wizard and then complete the wizard.
3. Verify the creation and content of the resource pool by viewing the results that are displayed in
the Resource Pools window.
After you finish

You can use the Datasets window to associate the new resource pool with a new or existing dataset.
•
•

If you want to associate a resource pool with a new dataset, use the Add Dataset wizard.
If you want to associate a resource pool with an existing dataset, use the Edit Dataset window.

If you want to modify any of the properties of a resource pool, click Edit in the Resource Pools
window.
Related concepts

Decisions to make before configuring a resource pool on page 163
Effect of time zones on schedules on page 220
Related references

Data ONTAP licenses used for protecting or provisioning data on page 68
Resource pool guidelines on page 160
Administrator roles and capabilities on page 54
Impact of modifying resource pool properties
Before making changes to the properties of a resource pool, you need to understand the potential
impact of those changes on your data protection setup.
Editing the Name, Description, Owner, or Contact properties for a resource pool does not impact the
functioning of a resource pool; it only modifies the information viewed about the resource pool.
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However, editing the members or the time zone of a resource pool can have a significant impact on
your data. The impact of modifying the membership of an existing resource pool depends on whether
the resource pool is already associated with a dataset.
Modifying a resource pool that is not associated with a dataset
Editing any of the properties of a resource pool that is not associated with a dataset does not impact
any protected data. However, if you are modifying the resources or time zone of a resource pool,
consider the potential result before making the change.
•
•

Will the new size and number of aggregates be adequate for the intended use of the resource
pool?
Will a time zone change affect the schedule synchronization between the primary storage data
and the secondary storage backup or mirror copy?

Modifying a resource pool that is associated with a dataset
Modifying the
members of a
resource pool

•

•

•

Modifying the
time zone of a
resource pool

•
•

Adding or removing the resources of a resource pool might affect the size
and number of aggregates available for provisioning, once the resource pool
is associated with a dataset.
Removing resources: If an entire storage system is assigned to a resource
pool, as aggregates are added to or removed from that storage system, the
aggregates are automatically added to or removed from the resource pool
that the storage system is associated with. You do not need to perform any
additional tasks to have the aggregates available for provisioning.
Adding resources: Verify that any resource you plan to add to a resource
pool is online, properly configured, and licensed for the purpose you intend
for it.
Adding a resource that is not available for provisioning can result in lack of
conformance. For example, if an aggregate you plan to add is nearly full, the
NetApp Management Console data protection and provisioning capabilities
cannot provision from that aggregate and jobs involving that aggregate will
fail.
Does not affect data that is already protected.
Might affect whether the replication schedule on the primary dataset
synchronizes as expected with the schedule on secondary or tertiary
destination storage in the resource pool.

Related concepts

Effect of time zones on schedules on page 220
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Editing resource pool properties
You can edit the properties of an existing resource pool by using the Edit properties option,
accessible from the Resource Pools window.
Before you begin

Have the information available that you need to complete this task, depending on which properties
you intend to edit.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Resource Pools.
2. In the list of available resource pools, select the resource pool that you want to modify.
3. Click Edit to open the Properties sheet.
4. Modify the properties that you want changed.
5. Click OK.
6. Verify the changes to the resource pool properties.
You can verify the changes by viewing the information displayed in the Resource Pools window.
Result

The resource pool's properties configuration is modified and saved.
After you finish

Verify that any dataset associated with the modified resource pool is still in conformance with any
assigned provisioning or protection policies.
Related concepts

Impact of modifying resource pool properties on page 166
Decisions to make before configuring a resource pool on page 163
Related references

Resource pool guidelines on page 160
Administrator roles and capabilities on page 54
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What jobs are
In the context of the NetApp Management Console, a job is any operation that is initiated within the
NetApp Management Console.

Managing jobs
You can view the current status and other information about all jobs that are currently running as
well as jobs that have completed in the Jobs panel.
Monitoring jobs
You can monitor for job status and other job details using the Jobs window.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Jobs.
Only jobs for the selected resource group are displayed.
2. (Optional) Customize the Jobs window in any of the following ways:
•
•
•
•
•

Select a resource group to see the jobs for that group.
Select a job in the jobs list to see the details about that job.
Use the View Jobs filter buttons to control the range of jobs you want displayed.
Click
in a column header to control which job entries you want displayed.
Click the sort arrows in a column header to change the sort order of the entries in that column.

•
•

in the upper-right corner of the list to select which columns are displayed.
Click
Drag the bottom of the jobs list area up or down to resize that area.

Canceling jobs
You might need to stop a job: for example, if a job is taking too long to complete, if a job is
encountering too many errors, or if a job was started manually but is no longer needed.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Steps

1. From the menu bar, click Data > Jobs.
Only jobs for the selected resource group are displayed.
2. From the list of jobs, select one or more jobs that are currently running.
The status in the Progress column must be Running.
3. Click Cancel.
4. In the Cancel Jobs dialog box, click Yes to stop the selected job.
Result

The Cancel Job Request Process Monitor window displays the progress of your cancel request and
detailed information about any errors that occurred during the cancellation process.
Related references

Administrator roles and capabilities on page 54
Where to view reports and logs
In general, you use your NetApp Management Console to monitor jobs, events, and alarms
associated with that application, and you use Operations Manager to monitor logs.
•
•

•

•

To view reports of jobs, events, or alarms associated with most NetApp Management Console
capabilities, use the NetApp Management Console System window.
To view jobs, events, or alarms associated with your NetApp Management Console disaster
recovery feature, use the Operations Manager Reports menu.
After displaying the disaster recovery report, you can use the spreadsheet or print buttons to
export the report to .XLS format or send it to the printer.
To view DataFabric Manager or Operations Manager logs, use Operations Manager Reports
menu.
After displaying the report, you can use the spreadsheet or print buttons to export the report
to .XLS format or send it to the printer.
To view syslog HA pair messages, use the tools available on the Operations Manager Cluster
Console.

What groups are
A group is a collection of objects with common characteristics, such as location, project, or owning
organization.
Related concepts

Overview of resource pools on page 64
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Dataset concepts on page 65

About groups
Combining objects in groups allows you to filter data for the objects in the group. Grouping datasets
and resource pools also enables you to see consolidated reports of information in Operations
Manager.
You can create single-type groups of objects, or you can create groups that include combinations of
object types. You can create groups of objects such as datasets, resource pools, storage services,
storage systems, hosts, vFiler units, aggregates, volumes, and qtrees. Objects can be members of
more than one group.
The groups you create using the protection and provisioning capabilities are the same as the resource
groups you create in Operations Manager. See the Operations Manager online Help for detailed
descriptions of the default views for datasets and resource pools and the custom catalogs you can use
to create your own reports.
If necessary, you can use Operations Manager to specify chargeback settings or to create groups
containing other types of objects such as LUNs.

What the Global group is
By default, a group called Global exists in the DataFabric Manager database. All objects in the
database (datasets, resource pools, storage services, agents, aggregates, volumes, qtrees, Open
Systems SnapVault hosts, and NetApp storage systems) belong to the Global group, whether they are
discovered, like storage systems, or created, like resource pools.
If you create a new group, you assign objects to the new group from the Global group. If an object is
reassigned from one group to another, the object is still a member of the Global group.
You cannot delete or rename the Global group. However, you can use Operations Manager to delete
objects from the Global group and add previously deleted objects to the Global group. When you
delete an object from the Global group, the DataFabric Manager server stops monitoring and
reporting data for the object. Data collection and reporting is not resumed until the object is added
back into the database (“undeleted”).

Configuring groups
You can add, modify, and delete groups.
Decisions to make before adding groups
Before you use the Add Provisioning Policy wizard to create a new group, you need to decide what
storage objects to include in this group and which people you want to give access to these storage
objects.
Note: This topic applies only to the NetApp Management Console data protection and
provisioning capabilities. You cannot add groups with Performance Advisor.
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Group
properties

•

•

•
•

Group
membership

•
•

What is the name of the new group?
Group names can contain any printable ASCII character except the forward
slash character. The maximum name length is 64 characters. Group names
cannot be the reserved names "all" or "global" or fully numeric. If a group has a
parent group, the name of the group must be unique only among the subgroups
of its parent.
Who is the owner of the group?
Determine the name and the e-mail address of the person who should be copied
on all e-mail or pager alerts for this group.
What is the parent group of the group?
Determine the name of the group that is the parent to this group.
Who are the members of the group?
Obtain the e-mail address of each individual or group that you want to have
access to the storage objects in this group.
What storage objects do you want accessed by the same person or group?
How granular do you want to be in selecting storage elements for membership
in your group?
You can add specific aggregates, volumes, qtrees, storage services, storage
systems, LUNs, resource pools, datasets, and so on to a group. If you add a
storage element to a group, all the elements contained in that storage element
can be accessed by the owner of this group.
Note: To assign any of the objects mentioned, you need view permission for
those objects.

Adding groups
You can add a group directly under the Global group or create a subgroup to a parent group you
already created.
Before you begin

When you add a group, you can add an object to the group membership only if you have permission
to view that object. You must be authorized to perform all the steps of this task; your RBAC
administrator can confirm your authorization in advance.
Have the information available that you need to complete this task:
•
•
•
•

Name of the group
Owner of the group
E-mail address of the owner
Members to add to the group
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About this task

You cannot add groups using Performance Advisor.
Steps

1. From the menu bar, click Data > Groups.
2. Click Add to start the Add Group wizard.
3. Complete the steps in the wizard to create the new group.
Result

The new group appears in the Group Name list.
Related concepts

Decisions to make before adding groups on page 181
Related references

Administrator roles and capabilities on page 54
Editing groups
You can edit the name, membership, or contact information for a group. This topic applies only to
the NetApp Management Console data protection and provisioning capabilities.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

If you rename a group, you are also changing the names of its subgroups, if any. The full name of
any subgroup includes the names of groups in its parentage, so changes to the names of parent groups
affect their subgroups as well.
You cannot edit groups with Performance Advisor.
Steps

1. From the menu bar, click Data > Groups.
2. In the Groups window, select the group you want to edit.
You might need to expand the Group Name list to select the group you want.
Current information about the selected group appears in the Details area.
3. Click Edit.
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4. In the group's Properties sheet, modify the group as needed.
5. Click Apply to save your changes or OK to save your changes and exit the dialog box.
Result

The modified information about the selected group appears in the "Group name" or "Details" areas.
Related concepts

Decisions to make before adding groups on page 181
Related references

Administrator roles and capabilities on page 54
Deleting groups
You can delete groups that you no longer find useful. Deleting a group removes only the group
container from the DataFabric Manager database. The objects contained in the deleted group are not
removed from the database.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

This topic applies only to the NetApp Management Console data protection and provisioning
capabilities. You cannot delete groups using Performance Advisor.
When you delete a group, you also delete all its subgroups, if any. If you want to preserve the
subgroups, you must move them to a different parent group before deleting the current parent group.
You can move one subgroup at a time using the NetApp Management Console data protection and
provisioning capabilities, or you can use Operations Manager to move multiple subgroups
simultaneously. See the Operations Manager online Help for instructions.
Steps

1. From the menu bar, click Data > Groups.
2. In the Group Name list, select one or more groups that you want to delete.
3. Move any subgroups you want to retain.
Use the edit properties dialog box to move one subgroup at a time, or use Operations Manager to
move multiple groups.
4. Click Delete to remove the group.
A confirmation dialog box appears, asking whether you want to delete the selected groups.
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5. Click OK.
Result

Each selected group (and any subgroups) is deleted from the DataFabric Manager database. The
Group name list is refreshed and no longer displays the deleted groups.
Related tasks

Editing groups on page 183
Related references

Administrator roles and capabilities on page 54

What custom fields are
Custom fields are user-defined fields that provide space for you to input custom information for
individual objects.

About custom fields
When you add a custom field, it is automatically added to the properties page of each object of the
type that is configured for the custom field.
Valid object types are datasets, protection policies, and provisioning policies. For any given
individual object, you can enter values that are appropriate for the custom fields to provide additional
information for managing your data.
For example, you might create a custom field named "Cost Center" and assign it to all datasets.
When you create a new dataset, you can specify the cost center code number for that dataset. You
can also add the cost center code to an existing dataset by editing the dataset properties.
Or, you might create a custom field named "Chargeback" and assign it to all protection policies to
help you track mirror copy costs for a particular backup schedule. You can then create a new
protection policy or edit existing policies and enter the appropriate chargeback codes.

Configuring and managing custom fields
You can add, modify, and delete custom fields.
Adding a custom field
You can use the Custom Fields window to add custom fields to specified object types.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Steps

1. From the menu bar, click Data > Custom Fields.
2. Click Add to open the Add Custom Field dialog box.
3. In the Name field, type a name for the custom field.
A maximum of 255 characters is allowed; however, only the first 64 characters are displayed.
Names that exceed what is displayed in the window are displayed in a popup window when you
hold the cursor over the name. Names can include any characters but cannot be positive or
negative numbers (for example, the string "2ab" is valid but the strings "23" and "-23" are not
valid).
4. In the Object Types list, select one or more object types to which you want this custom field to be
assigned.
5. Click OK to create and add the custom field.
After you finish

After you create a custom field, it is automatically added to the properties page of all of the objects of
the type that you specified. To enter a value in the new custom field for an object, you must edit the
object properties. When adding a new object, you can specify a custom field value in the appropriate
wizard.
Related concepts

What custom fields are on page 185
Related tasks

Adding a value in a dataset custom field on page 188
Adding a value in a protection policy custom field on page 188
Adding a value in a provisioning policy custom field on page 189
Related references

Administrator roles and capabilities on page 54
Provisioning policy properties on page 603
Editing custom fields
You can use the Custom Fields window to make global modifications to custom fields.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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About this task

Changes made to a custom field name or the object types in which it is allowed globally affect that
custom field in all the current object types, regardless of whether a value is entered in the field. For
example, if you change the name of a custom field, that name is changed in every object of the type
for which the custom field is configured. Values entered in that custom field for a given object do not
change.
Steps

1. From the menu bar, click Data > Custom Fields.
2. Select a custom field and click Edit to open the properties page.
3. Modify the custom field properties, as needed.
If you modify the custom field name, a maximum of 255 characters is allowed; however, only the
first 64 characters are displayed. Names that exceed what is displayed in the window are
displayed in a popup window when you hold the cursor over the name. Names can include any
characters but cannot be positive or negative numbers (for example, the string "2ab" is valid but
the strings "23" and "-23" are not valid).
4. Click Apply to apply the changes and continue making additional changes or click OK to apply
the changes and close the window.
5. In the confirmation dialog box, click OK to apply the changes. and close the properties window.
After you finish

The changes to the custom field are applied to all object types that are configured for that custom
field.
Related references

Administrator roles and capabilities on page 54
Deleting custom fields
You can use the Custom Fields window to globally delete custom fields.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Custom Fields.
2. Select a custom field and click Delete.
3. Click Yes in the confirmation dialog box.
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After you finish

The custom field is deleted from all objects.
Related references

Administrator roles and capabilities on page 54
Adding a value in a dataset custom field
After a custom field is created, you can edit a dataset to enter an appropriate value in that custom
field.
Before you begin

The custom field must be already configured for datasets.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Data > Datasets > Overview.
2. Select the dataset that you want to modify, then click Edit.
3. In the Edit Dataset window, click General Properties.
4. Type the information in the appropriate custom field, then click Finish to apply the changes.
You can enter a maximum of 1024 characters.
5. Click Close to close the Edit Dataset window.
After you finish

You can view the custom field values for all datasets in the Datasets window Overview tab.
Related tasks

Adding a custom field on page 185
Related references

Administrator roles and capabilities on page 54
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Adding a value in a protection policy custom field
After a custom field is created, you can edit a protection policy to enter an appropriate value in that
custom field.
Before you begin

•
•
•

The custom field must be already configured for protection policies.
If the custom field value applies to datasets that use the protection policy, confirm that the
information you want to enter is acceptable for all the datasets that use the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Protection > Overview.
2. Select the protection policy that you want to modify, then click Edit.
3. In the Properties sheet, click General Properties.
4. Type the information in the appropriate custom field, then click OK to apply your changes and
close the Properties sheet.
You can enter a maximum of 1024 characters.
Related tasks

Adding a custom field on page 185
Adding a value in a provisioning policy custom field
After a custom field is created, you can edit a provisioning policy to enter an appropriate value in that
custom field.
Before you begin

•
•
•

The custom field must be already configured for provisioning policies.
Confirm that the information you want to enter in a custom field for a provisioning policy is
acceptable for all the datasets that use the policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > Provisioning.
2. Select the provisioning policy that you want to modify, then click Edit.
3. In the Properties sheet, click General Properties.
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4. Type the information in the appropriate custom field, then click OK to apply your changes and
close the Properties sheet.
You can enter a maximum of 1024 characters.
Related tasks

Adding a custom field on page 185
Related references

Administrator roles and capabilities on page 54

What a policy is
A policy is a set of rules that specifies the intended management of dataset members. You can apply
the same policy to multiple datasets, leveraging your configuration of the policy across the datasets.
If you update a policy, the update is propagated across all the datasets to which the policy is applied.
Different types of policies address different data management issues.
The data management applications and capabilities provide the following types of policies:
•
•
•
•

Protection without disaster recovery
Protection with disaster recovery
Provisioning
vFiler templates
Note: The data management policies used by applications and capabilities running in NetApp
Management Console should not be confused with other kinds of policies, such as the file policies
used in Data ONTAP.

About provisioning policies
A provisioning policy applies to all volumes, qtrees, or LUNs in a dataset node; you cannot assign
different policies to individual members within a dataset. This is different from protection policies
which can be assigned to individual volumes, qtrees, or LUNs in a dataset node.
What a provisioning policy is
Provisioning policies define the desired features of NAS or SAN storage for datasets, including
reliability/availability, space management settings, and appropriate actions when a storage container
needs more space. The policy settings specify how you want to have storage provisioned, exported
and managed for the datasets to which you apply the policy.
A dataset can have a single node or, if you assign a multi-node protection policy to it, a dataset can
have a primary and secondary (or even tertiary) node. If the dataset has a mirror or backup node, you
can create and assign policies that define the provisioning of storage on the secondary and tertiary
node.
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Related concepts

Difference between provisioning policy and provisioning wizard on page 602
Related references

Administrator roles and capabilities on page 54
Preconfigured provisioning policies
The preconfigured provisioning policies are specific to virtual application environments such as
VMware and Hyper-V. They can be accessed using the CLI or the NetApp Management Console
interface.
To simplify the task of provisioning storage for virtual objects in a dataset, the NetApp Management
Console provisioning capability lists the following options:
Thin Provisioned Space for
VMFS Datastores

Provides thin provisioning for VMFS datastore objects. With
deduplication and thin provisioning, maximized space saving is
achieved.

Thin Provisioned Space for
NFS Datastores

Provides thin provisioning for NFS datastore objects. With
deduplication and thin provisioning, maximized space saving is
achieved.

Thin Provisioned Space for
Hyper-V Storage

Provides thin provisioning for backing up storage LUNs in HyperV environments.

Thin Provisioned Space for
Hyper-V Delegated Storage

Provides thin provisioning for backing up storage in Hyper-V
environments. This option supports a delegation model in which
the volume is provisioned according to best practices. The LUNs
are provisioned by SnapDrive for Windows on the Hyper-V
parent.

Reserved Data Space for
VMFS Datastores

Provides provisioning for write-guaranteed VMFS datastores.

Reserved Data Space for
NFS Datastore

Provides thick provisioning for NFS datastores.

Reserved Data Space for
Hyper-V Storage

Provides thick provisioning for backing up LUNs in Hyper-V
environments. The LUNs serve as backup storage for Cluster
Shared Volumes.

Reserved Data Space for
Hyper-V Delegated Storage

Provides thick provisioning for backing up storage for Hyper-V
environments. This option supports a delegation model in which
the volume is provisioned according to best practices. The LUNs
are provisioned using SnapDrive for Windows on a Hyper-V
parent.
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What a protection policy does
When a protection policy is applied to a dataset, it defines how data stored in dataset members should
be backed up or mirrored. You can configure a protection policy that specifies a single protection
method (local backup, remote backup, or mirroring) or a combination of those methods.
For example, a protection policy might specify that the primary data is backed up to a secondary
location and that the secondary copies are mirrored to a tertiary location.
Disaster Recovery capable protection policies that use Qtree SnapMirror to back up data can also
invoke your site's disaster recovery script. After the problem is resolved, you can move dataset
member access manually from the secondary storage back to the primary storage.
Related concepts

Types of data protection on page 191
Protection policy nodes and connections on page 192
Protection policy node prerequisites on page 195
Allowable lag times on page 199
Protection schedules, time zones and datasets of physical storage objects on page 199
Migration operations on page 551
Related references

Protection policy types (not disaster recovery capable) on page 193
Administrator roles and capabilities on page 54
Difference between provisioning policy and provisioning wizard
A provisioning policy governs the out-of-space actions, export protocols, and so on for a dataset. The
Provisioning wizard adds new volumes, qtrees, or LUNs to an existing dataset.
When a storage container runs out of space, the actions taken are determined by the provisioning
policy: the NetApp Management Console provisioning capability might send space warning
messages and, for SAN storage, might try to increase the container size or delete old Snapshot
copies, or both. The policy does not direct the NetApp Management Console provisioning capability
to create new volumes, qtrees, or LUNs.
When you create a dataset for provisioning and assign a provisioning policy, a single storage
container is created in the associated resource pool using the NetApp Management Console
provisioning capability, according to the policy settings.
You can create and add new volumes or LUNs to a dataset by using the Provisioning wizard.

Provisioning Help | 603
Example scenario
•

A storage administrator needs to create a dataset for the home directories of all the users in
the accounting department. The home directories are CIFS shares; each user is allowed 50
GB.
•

•

The administrator creates a dataset named AccountingUserDirectories and assigns a
provisioning policy that has the correct CIFS export settings.
• The NetApp Management Console provisioning capability creates one container for the
dataset from the associated resource pool, according to the properties in the
provisioning policy.
When a new employee joins the accounting department, the administrator needs to add
another volume on the existing dataset and assign a CIFS share for that employee.
•

•

The administrator uses the Provisioning wizard to add a new volume in the resource
pool associated with the dataset.
As the data in the user directories fills up the assigned storage, the administrator needs to
provision more storage space.
•
•

When the data reaches a Nearly Full or Full threshold, the provisioning policy
automatically sends an event message, if that action is configured.
The administrator can manually change the volume size or can use the Provisioning
wizard to add additional volumes to the dataset.

Related concepts

What a provisioning policy is on page 600
Provisioning policy properties
With certain exceptions and caveats, you can specify, view, and modify property values to suit your
needs.
•
•
•
•
•
•
•
•
•

Where to view and modify property values on page 603
General properties on page 604
Availability properties on page 604
NAS container properties on page 605
SAN container properties on page 606
Provisioning script on page 606
Resource label on page 606
Deduplication Properties on page 606
Space utilization thresholds on page 607

Where to view and modify property values
You can specify, view, and modify property values as follows:
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•
•

You can initially set a value for a property in the Add Provisioning Policy wizard.
You can view a policy property in the Provisioning Policies window. To display a hidden

•

column, click
in the upper-right corner of the jobs list and select the column.
You can modify a policy property in the Properties sheet, which is accessed by clicking Edit in
the Provisioning Policies window.

General properties
Name

The name assigned to a provisioning policy. Name is a required property.
Special characters and spaces are permitted in names. The limit is 64 characters, but
for readability, you are advised to keep the name under 25 characters.

Description

A description of the provisioning policy. It might include the intended use of the
provisioning policy or some other common attribute that identifies why the
provisioning policy was created. Description is an optional property.

Storage Type The type of storage the policy is configured to support. Storage type is a required
property and cannot be modified:
NAS

The NetApp Management Console provisioning capability
provisions NAS storage on a primary node and exports storage for
NAS access. NFS and CIFS protocols are supported.

SAN

The NetApp Management Console provisioning capability
provisions SAN storage on a primary node and exports storage for
SAN access. FC and iSCSI protocols are supported.

Secondary The NetApp Management Console provisioning capability
provisions storage on a secondary node for use as destinations for
backup and mirror operations.

Availability properties
The storage availability properties are related to various aggregate and storage controller
configurations. These properties are optional; if none is configured then a provisioning request
provisions from any available storage resource in the resource pool. The availability levels that
datasets might require are as follows:
RAID-DP (Double disk
failure)

The NetApp Management Console provisioning capability looks for
storage resources configured using RAID-DP aggregates to protect
data from double disk failures. This is the default value.

RAID4 (Single disk
failure)

The NetApp Management Console provisioning capability looks for
storage resources configured using RAID4 aggregates to protect data
from single disk failures. This option is the default if no reliability
level is specified.
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Storage subsystem failure The NetApp Management Console provisioning capability looks for
(aggregate SyncMirror) storage resources using SyncMirror aggregates to protect data from
failures of adapters, cables, and shelves.
Storage controller failure The NetApp Management Console provisioning capability looks for
storage resources using a HA configuration to protect data from
(HA configuration )
controller failures.
NAS container properties
Quota
settings

The default size of user quotas and group quotas. Quotas limit resource usage and
provide notification when resource usage reaches specified levels. Quota sizes can
be specified in units of KB, MB, GB, or TB. Quotas are an optional property.

Space
utilization
properties

The actions the NetApp Management Console provisioning capability takes to
manage space for dataset members and Snapshot copies. Space utilization is an
optional property.
Guarantee
space for data
and Snapshot
copies

If this option is enabled, the space is guaranteed for data and for
Snapshot copies and guaranteed from the resource pool(s)
associated with the dataset. Writes to a specified FlexVol
volume or writes to files with space reservations enabled do not
fail due to a lack of available space in the containing aggregate.
If this option is disabled, the space is allocated on-demand as
data or Snapshot copies are written to datasets; some write
requests might fail.

Reserve space
for Snapshot
copies

If this option is enabled, an additional 20 percent of the
requested space is provisioned from the resource pool(s) for
Snapshot copies for every provisioned member in the dataset.
This guarantees that Snapshot copies do not fail because of a
lack of disk space.
If this option is disabled, no additional Snapshot copy space is
provisioned and Snapshot copies might fail if there is not
enough space available.

Auto grow
capacity

If this option is enabled, the provisioned volume size grows to
the predefined maximum volume limit, when required. This
option is available only on storage systems that run Data
ONTAP 7.3.1 or later.

Auto delete
Snapshot
copies

If this option is enabled, the old Snapshot copies are deleted to
provide sufficient free space. This option is available only on
storage systems that run Data ONTAP 7.3.1 or later.
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SAN container properties
Type of containers
to provision as
dataset members

The SAN container type to be used for provisioning: Volume or LUN.
Container type is a required property.

Space for data

Guaranteed Space for data is guaranteed on the SAN container.
On demand Space for data is not guaranteed on the SAN container.
Space might need to be allocated manually.

Space for Snapshot
copies

Guaranteed Space for Snapshot copies is guaranteed on the SAN
container.
On demand Space for data is not guaranteed on the SAN container; the
container is automatically increased when additional space
for Snapshot copies is needed.

Delete oldest
Snapshot copies
automatically

If this option is enabled and a SAN container needs more space, the Data
ONTAP autosize option is used to automatically delete Snapshot copies to
make more space available. To use these option, your storage must be using
Data ONTAP 7.2.4 or later.
If this option is disabled, Snapshot copies are not automatically deleted
when a SAN container needs more space, therefore, you might need to
delete them manually.

Provisioning script
The full path on the DataFabric Manager server of a provisioning script that performs custom tasks
after storage is provisioned. Provisioning script is an optional property.
Resource label
A text string that is used to match provisioning requests with available resources. Only storage
resources that match the label are used for provisioning. Because resource labels limit the available
resources for provisioning requests, you should use them sparingly. Resource label is an optional
property.
Deduplication Properties
Whether you want to enable block-level deduplication on the volumes that reside of the dataset node
to which this policy is assigned and if so which deduplication mode that you want to apply.
On-demand
deduplication

Deduplication runs only when you select a volume on the dataset node on
which this mode is selected and click Dedupe Now.
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Automated
deduplication

Deduplication runs automatically on any volume that resides on the current
dataset node after that volume contains 20 percent new data written to it since
the last deduplication run.

Scheduled
deduplication

Deduplication runs automatically on a custom schedule that you have
specified for all volumes that reside on the current dataset node. You can
schedule deduplication to run on which days of the week, during what time
period, and at what frequency.

Space utilization thresholds
Whether the NetApp Management Console provisioning capability generates space utilization events
when a threshold is reached. The NetApp Management Console provisioning capability uses these
thresholds to compute dataset space status and generate events. Space thresholds are optional
properties.
Generate space If this option is enabled, event notifications are generated when a space threshold
is reached.
utilization
events
If this option is disabled, no event notifications are generated when a space
threshold is reached.
Full threshold

The percentage of the maximum size of a dataset at which a Full threshold event
notification is generated. You can enter the percentage number or slide the
indicator up or down to the appropriate percentage. The default is 90 percent.

Nearly Full
threshold

The percentage of the maximum size of a dataset at which a Nearly Full
threshold event notification is generated. You can enter the percentage number or
slide the indicator up or down to the appropriate percentage. The default is 80
percent.

Configuring provisioning policies
In general, you use a wizard to configure provisioning policies and you use an editing window to
modify property values
Viewing a provisioning policy
You can view all the provisioning policies and their properties in the Provisioning Policies window.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > Provisioning.
2. Click the Details tab at the bottom of the window.
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Decisions to make before adding a provisioning policy
Before you start the Add Provisioning Policy wizard, you need to gather the information required to
complete the wizard.
The NetApp Management Console provisioning capability can manage a
How many
maximum of 50 volumes in a dataset. If a dataset currently has a storage
volumes are
currently in the resource that contains more than 50 volumes, the provisioning request fails.
dataset?
General policy
information

•
•

•

Storage
availability
(optional)

What is the name and description of the policy?
What is the type of storage you want to provision with this policy?
Will the policy be used to provision and export storage for NAS access (NFS
or CIFS protocols) on a primary node, or for SAN access (FC or iSCSI
protocols) on a primary node? You can use the policy to provision storage for
a secondary node (backup or mirror destination).
What custom field information do you need?
If one or more custom fields have been configured for provisioning policies
and if you want to use those fields, what information do you need to enter in
those fields? You can view the list of custom fields that are configured for
provisioning policies in the Custom Fields window.
Custom fields can contain a maximum of 1024 characters and can include
any character.

Does the dataset require a specific level of storage availability?
If so, the NetApp Management Console provisioning capability tries to find
resources that provide the specified availability. (Only the specified availability
is selected; storage with a higher level of availability will not be selected.) The
default is to protect or provision data from any available storage resource. The
choices are:
•

•

•

•

RAID-DP (Double disk failure)
The NetApp Management Console provisioning capability provisions from
storage resources that are configured using aggregate RAID-DP.
RAID4 (Single disk failure)
The NetApp Management Console provisioning capability provisions from
storage resources that are configured using aggregate RAID4.
Externally managed RAID
The NetApp Management Console provisioning capability provisions from
resources on third-party disk arrays that compose V-Series storage.
Therefore, the level of RAID protection is determined by the external
configuration of those arrays.
Storage subsystem failure (aggregate SyncMirror)
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•

Resource label
(optional)

Deduplication

The NetApp Management Console provisioning capability provisions from
storage resources that use aggregate SyncMirror.
Storage controller failure (HA configuration)
The NetApp Management Console provisioning capability provisions from
storage resources that have a HA configuration.

Do you need to filter for specific resources for provisioning?
If so, what text string do you want to use for the resource filter? The NetApp
Management Console provisioning capability uses that text string (the resource
label) to match provisioning requests with available resources that are
configured with the same resource label. (Resource labels should be used
sparingly because they limit the available resources for provisioning requests.)
Do you want data deduplication enabled on the volumes residing in the dataset
node to which this provisioning policy is applied? If so, what kind of
deduplication do you want to enable?
•

•

•

Do you want only to run deduplication manually?
If you decide to configure this option, deduplication starts only when you
manually select a volume and click the Dedupe Now button.
Do you want enable auto deduplication?
If you decide to enable auto deduplication, deduplication automatically starts
on a volume that resides on this dataset node when that volume contains 20%
new data written to it since the last deduplication run.
Do you want to attach a custom schedule for deduplication?
If you decide to schedule deduplication, you can specify deduplication to
start on which days of the week, during what time period, at what frequency,
and during that time period.
Note: If you enable auto deduplication or scheduled deduplication in the
provisioning policy that you assign to a dataset's secondary or tertiary node,
any NetApp Management Console assigned backup relationship from source
to target is implemented as a qtree SnapMirror relationship rather than as a
SnapVault relationship.

NAS container
properties

•
•

Quotas
What is the default user quota size? What is the default group quota size?
Space utilization
Do you want to guarantee space for data and Snapshot copies? Do you want
to reserve space for Snapshot copies? (If so, the default is 20 percent of the
total volume size. You can manually resize the Snapshot reserve space later.)
Do you want the provisioned volume size to grow to the maximum size
limit? Do you want to delete the old Snapshot copies?
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SAN container
properties

•
•

Type of container: Do you want dataset members to be provisioned in
volumes or LUNs?
Space settings:
•
•

•

•
Space
thresholds

Do you want to guarantee space for the container and Snapshot copies?
Do you want to guarantee space for the container and automatically grow
space for Snapshot copies on demand by preserving the existing Snapshot
copies during write activity? This option requires more space.
Do you want to guarantee space for the container and increase the space
for Snapshot copies on demand by automatically deleting Snapshot
copies when necessary? This option requires the storage systems to run
Data ONTAP 7.2.4 or later. This is the default option.
Do you not want to guarantee space for the container or Snapshot copies?

Do you want to set threshold levels for space utilization and receive event
notifications when those thresholds are reached? If so, at what percentage of the
dataset maximum size do you want the following to occur:
•
•

A Nearly Full threshold event warning message generated?
A Full threshold event error message generated?
Note: Aggregate "Nearly full" and "Full" threshold settings are not used to
determine whether an aggregate should be excluded as a resource in a
dataset. To determine this issue, the dataset conformance check references
the global "Aggregate Nearly Full threshold" or "Aggregate Full
threshold" settings in Operations Manager to possibly exclude that
aggregate.

Provisioning
script

Do you want to use a custom provisioning script to perform tasks after storage is
provisioned? If so, what is the full path of the script on the DataFabric Manager
server?
Note: The NetApp Management Console provisioning capability only
supports native executables or batch files (.bat, .cmd) on Windows. If you
want to specify a backup script that is not in a native Windows language, you
must enclose it inside a batch file.

Types of provisioning policies
A NAS provisioning policy can provision and export storage for NFS/CIFS access on a primary
node; a SAN provisioning policy can provision and export storage for FC/iSCSI access. A
provisioning policy can also provision storage for backup and mirror destinations on a secondary
node.
When you create a new provisioning policy, the policy settings describe the desired storage in terms
of availability, performance, and exports. The policy settings also describe how the storage should be
provisioned, exported, and managed.
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Storage used for different purposes requires different sets of settings, so there is more than one type
of provisioning policy you can create.
NAS

Choose the NAS provisioning policy type to provision storage that will be exported as
NFS or CIFS shares. NAS provisioning policies also enable you to set default quotas
for each user or UNIX group that writes data to the storage and to manage the space
reserved for storing Snapshot copies.

SAN

Choose the SAN provisioning policy type to provision storage to be accessed using FC
or iSCSI protocols. SAN provisioning policies also enable you to manage the space
needed for Snapshot copies.

Secondary Choose the Secondary provisioning policy type to provision volumes for backups and
mirror copies on the secondary nodes of a dataset.
What storage availability levels are
You can select the level of availability of the storage resources that is required for datasets. When the
NetApp Management Console provisioning capability uses a provisioning policy to provision
datasets, it searches the resource pool for a storage resource that provides only the availability level
specified and no higher.
The storage availability properties are related to various aggregate and storage controller
configurations. The availability levels that datasets might require are as follows:
•

•

Double-disk failure
The NetApp Management Console provisioning capability looks for storage resources configured
using RAID-DP aggregates to protect data from double disk failures. This is the default value.
Single-disk failure
The NetApp Management Console provisioning capability looks for storage resources configured
using RAID4 aggregates to protect data from single-disk failures. This option is the default if no
reliability level is specified.
Note: V-Series storage is assumed to be single-disk failure protection because some resiliency
properties might not be detectable by NetApp Management Console.

•

•

•

Externally managed RAID
RAID protection is determined by the external configuration of the third-party disk arrays that
compose V-Series storage.
Storage subsystem failure
The NetApp Management Console provisioning capability looks for storage resources using
SyncMirror aggregates to protect data from failures of adapters, cables, and shelves.
Storage controller failure
The NetApp Management Console provisioning capability looks for storage resources using an
HA configuration to protect data from controller failures.
Note: If the NetApp Management Console provisioning capability does not find a resource that
provides the specified availability level, then the provisioning request fails.
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What RAID4 protection is
RAID4 provides single-parity disk protection against single-disk failure within a RAID group. If an
aggregate is configured for RAID4 protection, Data ONTAP reconstructs the data from a single
failed disk within a RAID group and transfers that reconstructed data to a spare disk.
The minimum number of disks in a RAID4 group is two: at least one data disk and one parity disk.
If there is a single data or parity disk failure in a RAID4 group, Data ONTAP replaces the failed disk
in the RAID group with a spare disk and uses the parity data to reconstruct the failed disk’s data on
the replacement disk. If no spare disks are available, Data ONTAP goes into degraded mode and
alerts you of this condition.
Attention: With RAID4, if there is a second disk failure before data can be reconstructed from the

data on the first failed disk, there will be data loss. To avoid data loss when two disks fail, you can
select RAID-DP. This provides two parity disks to protect you from data loss when two disk
failures occur in the same RAID group before the first failed disk can be reconstructed.
What RAID-DP protection is
If an aggregate is configured for RAID-DP protection, Data ONTAP reconstructs the data from one
or two failed disks within a RAID group and transfers that reconstructed data to one or two spare
disks as necessary.
RAID-DP provides double-parity disk protection when the following conditions occur:
•
•

There is a single-disk failure or double-disk failure within a RAID group.
There are media errors on a block when Data ONTAP is attempting to reconstruct a failed disk.

The minimum number of disks in a RAID-DP group is three: at least one data disk, one regular parity
disk, and one double-parity (dParity) disk.
If there is a data-disk failure or parity-disk failure in a RAID-DP group, Data ONTAP replaces the
failed disk in the RAID group with a spare disk and uses the parity data to reconstruct the data of the
failed disk on the replacement disk. If there is a double-disk failure, Data ONTAP replaces the failed
disks in the RAID group with two spare disks and uses the double-parity data to reconstruct the data
of the failed disks on the replacement disks.
RAID-DP is the default RAID type for all aggregates.
What SyncMirror is
SyncMirror is an optional feature of Data ONTAP. It is used to mirror data to two separate
aggregates. It allows for real-time mirroring of data to matching aggregates physically connected to
the same storage system.
SyncMirror provides for synchronous mirroring of data, implemented at the RAID level. You can use
SyncMirror to create aggregates that consist of two copies of the same WAFL file system. The two
copies, known as plexes, are simultaneously updated. Therefore, the copies are always identical. The
two plexes are directly connected to the same system.
The following provides information about the activities of SyncMirror:
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•
•
•

SyncMirror can be used to mirror aggregates and traditional volumes. (A traditional volume is
essentially an aggregate with a single volume that spans the entire aggregate.)
SyncMirror cannot be used to mirror FlexVol volumes. However, FlexVol volumes can be
mirrored as part of an aggregate.
SyncMirror is different from synchronous SnapMirror.

For more information about aggregates and volumes, see the Data ONTAP Storage Management
Guide for 7-Mode.
Related information

Data ONTAP Information Library page: support.netapp.com//documentation/productsatoz/
index.html
Advantages of using SyncMirror
A SyncMirror aggregate has two plexes. This setup provides a high level of data availability because
the two plexes are physically separated.
For a system using disks, the two plexes are on different shelves connected to the system with
separate cables and adapters. Each plex has its own collection of spare disks. For a system using
third-party storage, the plexes are on separate sets of array LUNs, either on one storage array or on
separate storage arrays.
Note: You cannot set up SyncMirror with disks in one plex and array LUNs in the other plex.

Physical separation of the plexes protects against data loss if one of the shelves or the storage array
becomes unavailable. The unaffected plex continues to serve data while you fix the cause of the
failure. Once fixed, the two plexes can be resynchronized.
Another advantage of mirrored plexes is faster rebuild time.
In contrast, if an aggregate using SnapMirror for replication becomes unavailable, you can use one of
the following options to access the data on the SnapMirror destination (secondary).
•
•

The SnapMirror destination cannot automatically take over the file serving functions. However,
you can manually set the SnapMirror destination to allow read-write access to the data.
You can restore the data from the SnapMirror destination to the primary (source) storage system.

An aggregate mirrored using SyncMirror requires twice as much storage as an unmirrored aggregate.
Each of the two plexes requires an independent set of disks or array LUNs. For example, you need
2,880 GB of disk space to mirror a 1,440-GB aggregate—1,440 GB for each plex of the mirrored
aggregate.
What an HA pair is
An HA pair is two storage systems (nodes) whose controllers are connected to each other either
directly or, in the case of a fabric-attached MetroCluster, through switches and FC-VI interconnect
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adapters. In this configuration, one node can take over its partner's storage to provide continued data
service if the partner goes down.
You can configure the HA pair so that each node in the pair shares access to a common set of
storage, subnets, and tape drives, or each node can own its own distinct set of storage.
The controllers are connected to each other through an HA interconnect. This allows one node to
serve data that resides on the disks of its failed partner node. Each node continually monitors its
partner, mirroring the data for each other’s nonvolatile memory (NVRAM or NVMEM). The
interconnect is internal and requires no external cabling if both controllers are in the same chassis.

Takeover is the process in which a node takes over the storage of its partner. Giveback is the process
in which that storage is returned to the partner. Both processes can be initiated manually or
configured for automatic initiation.
How HA pairs support nondisruptive operations and fault tolerance
HA pairs provide fault tolerance and let you perform nondisruptive operations, including hardware
and software upgrades, and hardware maintenance.
•

•

Fault tolerance
When one node fails or becomes impaired and a takeover occurs, the partner node continues to
serve the failed node’s data.
Nondisruptive software upgrades or hardware maintenance
During hardware maintenance or upgrades, when you halt one node and a takeover occurs
(automatically, unless you specify otherwise), the partner node continues to serve data for the
halted node while you upgrade or perform maintenance on the node you halted.
During nondisruptive upgrades of Data ONTAP, the user manually enters the cf takeover
command to take over the partner node to allow the software upgrade to occur. The takeover node
continues to serve data for both nodes during this operation.

The HA pair supplies nondisruptive operation and fault tolerance due to the following aspects of its
configuration:
•

•

The controllers in the HA pair are connected to each other either through an HA interconnect
consisting of adapters and cables, or, in systems with two controllers in the same chassis, through
an internal interconnect.
The nodes use the interconnect to perform the following tasks:
• Continually check if the other node is functioning
• Mirror log data for each other’s NVRAM or NVMEM
The nodes use two or more disk shelf loops, or storage arrays, in which the following conditions
apply:
•
•

Each node manages its own disks or array LUNs.
In case of takeover, the surviving node provides read/write access to the partner's disks or
array LUNs until the failed node becomes available again.
Note: Disk ownership is established by Data ONTAP or the administrator; it is not based on
which disk shelf the disk is attached to.
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For more information about disk ownership, see the Data ONTAP Storage Management Guide
for 7-Mode.
•
•

They own their spare disks, spare array LUNs, or both, and do not share them with the other
node.
They each have mailbox disks or array LUNs on the root volume that perform the following
tasks:
•
•
•

Maintain consistency between the pair
Continually check whether the other node is running or whether it has performed a takeover
Store configuration information

What a resource label is
Resource labels act as filters. You can add an identifying label to storage resources and then
configure a provisioning policy to provision storage only from resources that match that label.
When a provisioning policy is configured with a resource label, all provisioning requests using that
policy are matched with available resources configured with the same resource label.
A resource label is a text string of any length.
Use resource labels sparingly because they restrict the amount of available resources from which
additional storage can be provisioned. They are useful for targeting specific resources: for example,
resources in a particular geographic area, or resources of a particular type, such as high-speed
storage.
Why you use quotas
You can use quotas to limit resource usage, to provide notification when resource usage reaches
specific levels, or to track resource usage.
You specify a quota for the following reasons:
•
•
•

To limit the amount of disk space or the number of files that can be used by a user or group, or
that can be contained by a qtree
To track the amount of disk space or the number of files used by a user, group, or qtree, without
imposing a limit
To warn users when their disk usage or file usage is high

Overview of the quota process
Quotas can be soft or hard. Soft quotas cause Data ONTAP to send a notification when specified
thresholds are exceeded, and hard quotas prevent a write operation from succeeding when specified
thresholds are exceeded.
When Data ONTAP receives a request to write to a volume, it checks to see whether quotas are
activated for that volume. If so, Data ONTAP determines whether any quota for that volume (and, if
the write is to a qtree, for that qtree) would be exceeded by performing the write operation. If any
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hard quota is exceeded, the write operation fails, and a quota notification is sent. If any soft quota is
exceeded, the write operation succeeds, and a quota notification is sent.
Quota targets and types
Quotas have a type: they can be either user, group, or tree. Quota targets specify the user, group, or
qtree for which the quota limits are applied.
The following table lists the kinds of quota targets, what types of quotas each quota target is
associated with, and how each quota target is represented.
How target is
represented

Quota target

Quota type

user

user quota

User quotas can be
UNIX user name
applied for a specific
UNIX UID
volume or qtree.
A file or directory
whose UID matches
the user
Windows user name in
pre-Windows 2000
format
Windows SID
A file or directory with
an ACL owned by the
user's SID

group

group quota

UNIX group name
UNIX GID
A file or directory
whose GID matches
the group

Group quotas can be
applied for a specific
volume or qtree.

path name to the qtree
For example, vol/

Tree quotas are applied
to a particular volume
and do not affect qtrees
in other volumes.

qtree

tree quota

vol1/qtree2

*

user quota
group quota
tree quota

The asterisk character
(*)

Notes

Note: Data ONTAP
does not apply group
quotas based on
Windows IDs.

A quota target of *
denotes a default
quota. For default
quotas, the quota type
is determined by the
value of the type field.
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How you use space management capabilities
To use the storage provided by FlexVol volumes as effectively as possible, you need to understand
the space management capabilities that help you balance overall available storage against required
user and application storage needs.
Data ONTAP enables space management using the following capabilities:
•

•

•

•

Volume (space) guarantee
The volume guarantee, also called space guarantee or just guarantee, determines how much space
for the volume is preallocated from the volume's associated aggregate when the volume is
created.
Reservations
Reservations, also called space reservations, file reservations, or LUN reservations, determine
whether space for a particular file or LUN is preallocated from the volume.
Fractional reserve
Fractional reserve, also called fractional overwrite reserve or LUN overwrite reserve, enables you
to control the size of the overwrite reserve for a FlexVol volume.
Automatic free space preservation
Automatic free space preservation can either increase the size of a volume or delete Snapshot
copies to prevent a volume from running out of space—all without operator intervention.

These capabilities are used together to enable you to determine, on a volume-by-volume basis,
whether to emphasize storage utilization, ease of management, or something in between.
How volume guarantees work with FlexVol volumes
Volume guarantees (sometimes called space guarantees) determine how space for a volume is
allocated from its containing aggregate--whether the space is preallocated for the entire volume or for
only the reserved files or LUNs in the volume, or whether space for user data is not preallocated.
The guarantee is an attribute of the volume.
You set the guarantee when you create a new volume; you can also change the guarantee for an
existing volume by using the vol options command with the guarantee option. You can view
the guarantee type and status by using the vol status command.
Volume guarantee types can be volume (the default type), file, or none
•

A guarantee type of volume allocates space in the aggregate for the volume when you create the
volume, regardless of whether that space is used for data yet.
This approach to space management is called thick provisioning. The allocated space cannot be
provided to or allocated for any other volume in that aggregate.
When you use thick provisioning, all of the space specified for the volume is allocated from the
aggregate at volume creation time. The volume cannot run out of space before the amount of data
it contains (including Snapshot copies) reaches the size of the volume. However, if your volumes
are not very full, this comes at the cost of reduced storage utilization.
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•

•

A guarantee type of file allocates space for the volume in its containing aggregate so that any
reserved LUN or file in the volume can be completely rewritten, even if its blocks are being
retained on disk by a Snapshot copy.
However, writes to any file in the volume that is not reserved could run out of space.
Before configuring your volumes with a guarantee of file, you should refer to Technical Report
3965.
A guarantee of none allocates space from the aggregate only as it is needed by the volume.
This approach to space management is called thin provisioning. The amount of space consumed
by volumes with this guarantee type grows as data is added instead of being determined by the
initial volume size, which might leave space unused if the volume data does not grow to that size.
The maximum size of a volume with a guarantee of none is not limited by the amount of free
space in its aggregate.
Writes to LUNs or files (including space-reserved files) contained by that volume could fail if the
containing aggregate does not have enough available space to accommodate the write. If you
configure your volumes with a volume guarantee of none, you should refer to Technical Report
3965 for information about how doing so can affect storage availability.

When space in the aggregate is allocated for the guarantee for an existing volume, that space is no
longer considered free in the aggregate. Operations that consume free space in the aggregate, such as
creation of aggregate Snapshot copies or creation of new volumes in the containing aggregate, can
occur only if there is enough available free space in that aggregate; these operations are prevented
from using space already allocated to another volume.
When the free space in an aggregate is exhausted, only writes to volumes or files in that aggregate
with preallocated space are guaranteed to succeed.
Guarantees are honored only for online volumes. If you take a volume offline, any allocated but
unused space for that volume becomes available for other volumes in that aggregate. When you try to
bring that volume back online, if there is insufficient available space in the aggregate to fulfill its
guarantee, it will remain offline. You must force the volume online, at which point the volume's
guarantee will be disabled.
Related information

Technical Report: Thin Provisioning Deployment and Implementation Guide: media.netapp.com/
documents/tr-3965.pdf
Technical Report: Thin Provisioning in a NetApp SAN or IP SAN Enterprise Environment:
media.netapp.com/documents/tr3483.pdf
How file and LUN reservations work
When reservations are enabled for one or more files or LUNs, Data ONTAP reserves enough space
in the volume so that writes to those files or LUNs do not fail because of a lack of disk space.
Reservations are an attribute of the file or LUN; they are persistent across storage system reboots,
takeovers, and givebacks. Reservations are enabled for new LUNs by default, but you can create a
file or LUN with reservations disabled or enabled. After you create a LUN, you change the
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reservation attribute by using the lun set reservation command. You change the reservation
attribute for files by using the file reservation command.
When a volume contains one or more files or LUNs with reservations enabled, operations that
require free space, such as the creation of Snapshot copies, are prevented from using the reserved
space. If these operations do not have sufficient unreserved free space, they fail. However, writes to
the files or LUNs with reservations enabled continue to succeed.
You can enable reservations for files and LUNs contained by volumes with volume guarantees of any
value. However, if the volume has a guarantee of none, reservations do not provide protection
against out-of-space errors.
Example
If you create a 100-GB space-reserved LUN in a 500-GB volume, that 100 GB of space is
immediately allocated, leaving 400 GB remaining in the volume. In contrast, if space
reservation is disabled on the LUN, all 500 GB in the volume remain available until writes are
made to the LUN.
Considerations for setting fractional reserve
Fractional reserve, also called LUN overwrite reserve, enables you to control the size of the
overwrite reserve for reserved LUNs and files in a volume. By using this volume attribute correctly
you can maximize your storage utilization, but you should understand how it interacts with other
technologies.
The fractional reserve setting is expressed as a percentage; the only valid values are 0 and 100
percent. You use the vol options command to set fractional reserve.
Setting fractional reserve to 0 increases your storage utilization. However, an application accessing
data residing in the volume could experience a data outage if the volume is out of free space, even
with the volume guarantee set to volume, when any of the following technologies and Data ONTAP
features are in use:
•
•
•
•
•

Deduplication
Compression
FlexClone files
FlexClone LUNs
Virtual environments

If you are using one or more of these technologies with no fractional reserve, and you need to prevent
errors due to running out of space, you must use all of the following configuration settings for the
volume:
•
•
•
•

Volume guarantee of volume
File or LUN reservations enabled
Volume Snapshot copy automatic deletion enabled with a commitment level of destroy
Autogrow feature enabled
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In addition, you must monitor the free space in the associated aggregate. If the aggregate becomes
full enough that the volume is prevented from growing, then data modification operations could fail
even with all of the other configuration settings in place.
If you do not want to monitor aggregate free space, you can set the volume's fractional reserve setting
to 100. This requires more free space up front, but guarantees that data modification operations will
succeed even when the technologies listed above are in use.
The default value and allowed values for the fractional reserve setting depend on the guarantee of the
volume:
Volume guarantee

Default fractional reserve

Allowed values

Volume

100

0, 100

None

0

0, 100

File

100

100

For more information about using fractional reserve, see the following Technical Reports:
•
•

TR-3965: Thin Provisioning Deployment and Implementation Guide
TR-3483: Thin Provisioning in a NetApp SAN or IP SA Enterprise Environment

Related information

Technical Report: Thin Provisioning Deployment and Implementation Guide: media.netapp.com/
documents/tr-3965.pdf
Technical Report: Thin Provisioning in a NetApp SAN or IP SAN Enterprise Environment:
media.netapp.com/documents/tr3483.pdf
Space utilization thresholds
Provisioning policies enable you to set thresholds indicating the points at which a dataset member is
considered full or nearly full, such as a volume running out of space or a qtree running out of quota.
These thresholds are used to generate warning and error events and to compute the overall space
status of the dataset.
Nearly full This threshold generates a warning event when the used space in a dataset member
meets or exceeds a specified percentage. The setting for this threshold must be lower
than the setting of the Full threshold to generate meaningful events. The default setting
is 80%.
Full

This threshold generates an error event when the used space in a dataset member meets
or exceeds a specified percentage. The default setting is 90%.

You can enable or disable space utilization thresholds for the datasets to which a provisioning policy
is applied by editing the policy properties.
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Notification use only
The "Nearly full threshold" and "Full threshold" parameters only specify the thresholds at which the
NetApp Management Console provisioning capability generates warning and error events regarding
used space on aggregates in a resource pool. The settings are not used to determine whether an
aggregate should be excluded as a resource in a dataset.
For example, if a resource pool contains an aggregate whose used space exceeds the "Nearly full
threshold" or "Full threshold" settings, and you attempt to add that resource pool to a dataset, the
conformance check performed when adding the resource pool will not exclude that aggregate as a
resource based on this condition.
Instead, the conformance check references the global "Aggregate Nearly Full threshold" or
"Aggregate Full threshold" settings in Operations Manager to possibly exclude that aggregate.
Similarly, the NetApp Management Console provisioning capability flags the need for relationship
migration based on the Operations Manager settings, rather than on the NetApp Management
Console data protection capability "Nearly full threshold" and "Full threshold" settings of the
assigned resource pool.
What provisioning scripts are
After NetApp Management Console provisions storage for a dataset, you might want the NetApp
Management Console provisioning capability to automatically run a custom script that performs
additional configuration operations on the newly provisioned storage.
For example, you might use a script to set advanced volume options (like flexshare priority or
security style) or, if you are using an older version of SnapDrive with SAN datasets, to export the
provisioned volume using CIFS. When processing a provisioning scripts, the NetApp Management
Console provisioning capability exports all objects associated with containers in a dataset as ENV
variables (volume, qtree, LUN names, storage system or aggregate name on which the containers
reside, and CIFS or NFS export names).
For information on how to write and execute a custom script, see the Operations Manager
Administration Guide.
Related information

Operations Manager Administration Guide - http://support.netapp.com/NOW/knowledge/docs/
DFM_win/dfm_index.shtml
Adding a provisioning policy
Use the Add Provisioning Policy wizard to add new provisioning policies. After you create a
provisioning policy, you can assign it to dataset nodes to automatically manage their provisioning.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Have the information available that you need to complete this task:
•
•
•
•
•
•
•
•
•

Name of the policy (required)
Storage type: NAS, SAN (required)
Custom field information (optional)
Level of storage availability required (optional)
Resource label (optional)
Deduplication type and schedule (optional)
NAS or SAN settings (required)
Nearly Full and Full thresholds (optional)
Provisioning script (optional)

Steps

1. From the menu bar, click Policies > Provisioning.
2. Click Add to start the Add Provisioning Policy wizard.
3. After you complete each property page in the wizard, click Next.
4. Confirm the details of the policy and click Finish.
After you finish

Your new policy is listed in the Provisioning Policies window.
Related concepts

Decisions to make before adding a provisioning policy on page 608
Related references

Provisioning policy properties on page 603
Administrator roles and capabilities on page 54
Decisions to make before editing a provisioning policy
Before you modify a provisioning policy, you need to gather the information required to complete
the Edit pages.
General
properties

You can modify the name, description, and custom field information of a
provisioning policy, but you cannot change the storage type.

Storage
availability
properties

You can modify the level of reliability required by dataset members using this
policy. (Only the specified availability is selected; storage with a higher level
of availability will not be selected.) The choices are:
•

RAID-DP (Double disk failure)
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•

NetApp Management Console provisions from storage resources that are
configured using aggregate RAID-DP.
RAID4 (Single disk failure)
NetApp Management Console provisions from storage resources that are
configured using aggregate RAID4.
Note: V-Series storage is assumed to be single-disk failure protection

because some resiliency properties might not be detectable by NetApp
Management Console.
•

•

•

Externally managed RAID
NetApp Management Console provisions from resources on third-party
disk arrays that compose V-Series storage. Therefore, the level of RAID
protection is determined by the external configuration of those arrays.
Storage subsystem failure (aggregate SyncMirror)
NetApp Management Console provisions from storage resources that use
aggregate SyncMirror.
Storage controller failure (HA configuration)
NetApp Management Console provisions from storage resources that have
an HA configuration.

Resource label
(optional)

You can add or modify the resource label used to match provisioning requests
with available resources.

NAS container
properties

You can modify the quota settings and the space utilization properties.

SAN container
properties

You can modify which container types to provision for datasets and the space
utilization properties.

Space thresholds

You can modify the threshold levels for space utilization and whether you
want to receive event notifications when those thresholds are reached.

Provisioning
script

You can modify the name or the path of a provisioning script that is run after
storage is provisioned.

Preview

You can use this page to test your modifications. NetApp Management
Console displays a message describing the results of the test.

Deduplication
settings

Do you want data deduplication enabled on the volumes residing in the dataset
node to which this provisioning policy is applied? If so, what kind of
deduplication do you want to enable?
•

•

Do you want only to run Manual deduplication?
If you decide to configure this option, deduplication starts only when you
manually select a volume and click the Dedupe Now button.
Do you want enable Auto deduplication?
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•

If you decide to enable auto deduplication, deduplication automatically
starts on a volume that resides on this dataset node when that volume
contains 20% new data written to it since the last deduplication run.
Do you want to attach a Custom schedule for deduplication?
If you decide to schedule deduplication, you can specify deduplication to
start on which days of the week, during what time period, at what
frequency, and during that time period.

Related references

Provisioning policy properties on page 603
Editing a provisioning policy
You can edit a provisioning policy property by selecting it on the Provisioning Policies window and
clicking Edit.
Before you begin

•
•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Confirm that the change you want to make to this provisioning policy is acceptable for all
datasets currently using this policy.

Steps

1. From the menu bar, click Policies > Provisioning.
2. Click the Dependencies tab at the bottom of the window.
3. Select the provisioning policy that you want to modify and note the datasets that are dependent on
that policy. If any of the dependent datasets will be negatively affected by the policy modification
you plan to make, first unassign the policy from the dataset.
4. Click the Details tab.
5. Select the provisioning policy that you want to modify and click Edit.
6. In the Properties sheet for the selected policy, click the page for the properties you want to
modify and enter the new property values.
At any time while in the Properties sheet, you can click the Preview page to see an updated
summary of your changes before they are applied.
7. When you are finished, do one of the following:
•
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the window.
Click Cancel to discard the changes you have made to the current policy.
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Related concepts

Decisions to make before editing a provisioning policy on page 622
Related references

Provisioning policy properties on page 603
Administrator roles and capabilities on page 54
Copying a provisioning policy
Instead of creating a completely new provisioning policy, you can make a copy of a provisioning
policy and modify it.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > Provisioning Overview tab.
2. Select the provisioning policy that most closely resembles the policy you want to add and click
Copy.
The new policy is added to the list with the name "Copy of policy-name".
3. Select the new copy and click Edit.
4. In the Properties sheet, click the tab for the properties you want to modify and enter the new
property values.
5. When you are finished, do one of the following:
•
•
•

Click Apply to apply your changes and continue to edit the current policy.
Click OK to apply your changes and close the window.
Click Cancel to discard the changes you have made to the current policy.

Deleting a provisioning policy
You can delete an existing provisioning policy if that policy is not currently applied to any dataset.
Before you begin

•
•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Make sure that each provisioning policy you want to delete is no longer assigned to any existing
storage sets.
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Steps

1. From the menu bar, click Policies > Provisioning.
2. Click the Dependencies tab at the bottom of the window.
3. Select a provisioning policy that you want to delete and confirm in the dependencies list that there
are no datasets dependent on that policy.
4. If a selected policy has dependent dataset members, click Data > Datasets > Overview and
assign another provisioning policy to the dependent dataset members.
The dependencies list for the provisioning policy must be empty before you continue to the next
step.
5. Click the Details tab in the Provisioning Policies window.
6. Select one or more provisioning policies that you want to delete and click Delete.
Note: The Delete button is not enabled for policies that are still attached to datasets.

7. Click OK in the confirmation dialog box to delete the selected policy, or click Cancel to cancel
the delete request.
Result

The selected policy is deleted from the policies list.
Related references

Administrator roles and capabilities on page 54

What vFiler templates are
A vFiler template is a set of vFiler configuration settings, including the corresponding CIFS, DNS,
NIS, and administrative host configuration settings, that you want to use as default settings for one or
more vFiler units that you plan to add as hosts. You can configure as many vFiler templates as you
need.

About vFiler templates
When adding a vFiler unit as a host, you can specify a vFiler template that provides the default
configuration settings for that vFiler unit. In addition to the configuration settings provided by the
vFiler template, you also must specify those values that are unique to the vFiler unit, such as name
and IP address.

vFiler template properties
With certain exceptions and caveats, you can specify, view, and modify property values to suit your
needs.
You can specify, view, and modify property values as follows:
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•
•
•

You can provide a value for a property in the Add vFiler Template wizard.
You can view a property in the vFiler Templates window.
You can modify a property in the Properties sheet, which is accessed by clicking Edit in the
vFiler Templates window.

You can specify, view, or modify the following vFiler template attributes:
Name

The name assigned to a vFiler template. Name is a required property.
Special characters and spaces are permitted in names. The limit is 64
characters, but for readability, you should keep the name under 25 characters.

Description

A description of the vFiler template. It might include the intended use of the
vFiler template or some other common attribute that identifies why the vFiler
template was created. Description is an optional property.

Administrative
Host

The IP address of the host that has root access to the files needed for system
administration for a vFiler unit using the selected vFiler template.
Administrative Host is an optional property.

DNS domain

Name

The name of the DNS domain to which a vFiler unit using the
selected vFiler template belongs. DNS domain is a required
property.

Servers The IP addresses of the DNS domain servers. Domain server is a
required property.
NIS domain

Name

The name of the NIS domain to which a vFiler unit using the
selected vFiler template belongs. NIS domain is a required
property.

Servers The IP addresses of the NIS domain servers. Domain server is a
required property.
CIFS Settings

Security protocol

The security protocol to be used by a vFiler unit using
this vFiler template. This is a required property only for
CIFS protocol users. Valid values are NTFS-only and
Multiprotocol.

Authentication
mode

Authentication type used by CIFS clients. This is a
required property only for CIFS protocol users. Valid
values are Active Directory and Windows Workgroup.

Domain name

The name of the CIFS domain to which a vFiler unit
using the selected vFiler template belongs. This is a
required property only for CIFS protocol users when the
authentication mode is active directory.
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Configuring vFiler templates
In general, you use a wizard to configure vFiler templates and you use an editing window to modify
property values.
Viewing vFiler templates
You can view all the vFiler templates and their properties on the vFiler Templates window
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Step

1. From the menu bar, click Policies > vFiler Templates.
Related references

Administrator roles and capabilities on page 54
Decisions to make before adding vFiler templates
Before you start the Add vFiler Template wizard, you need to gather the information required to
complete the wizard.
Name and
description

What name do you want to use for the new template? Do you want to add a
description? Descriptions are helpful when you need to select the appropriate
vFiler template when you are adding a vFiler host.

Administrative
host

What is the address of the administrative host that will be used by all vFiler
hosts to which this template is assigned?

DNS domain
settings

If vFiler hosts using this template will use DNS protocol, gather the
following information:
•
•

NIS domain
settings

If vFiler hosts using this template will use NIS protocol, gather the following
information:
•
•

CIFS settings

What is the domain name?
What are the addresses of the domain servers?

What is the domain name?
What are the addresses of the domain servers?

If vFiler hosts using this template will use CIFS protocol, gather the
following information:
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•
•
•

Security protocol: Will the vFiler host use NTFS-only or will it use other
protocols (multiprotocol)?
Authentication mode: What is the authentication mode that will be used:
the active directory or the Windows workgroup?
What is the domain name? By default, the CIFS domain name is the same
as the DNS domain name that you entered.

Related concepts

What vFiler templates are on page 391
Related references

vFiler template properties on page 626
Adding a vFiler template
You can use the Add vFiler Template wizard to create and add new vFiler templates. After you
create a vFiler template, you can apply it to vFiler hosts to automatically configure them with the
default settings specified in the template.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > vFiler Templates.
2. Click Add to start the Add vFiler Template wizard .
3. After you complete each property sheet in the wizard, click Next.
4. Confirm the details of the policy and click Finish.
Result

Your new policy is listed in the vFiler Templates window.
Related concepts

Decisions to make before adding vFiler templates on page 628
Related references

vFiler template properties on page 626
Administrator roles and capabilities on page 54
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Editing a vFiler template
You can edit a vFiler template property by selecting it on the vFiler Templates window and clicking
Edit.
Before you begin

•
•

Confirm that the change that you want to make to this vFiler template is acceptable for all vFiler
units that are using this policy.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Policies > vFiler Templates.
2. Select the vFiler template that you want to modify and click Edit.
3. In the Properties sheet for the selected template, click the tab for the properties that you want to
modify and enter the new property values.
4. When you are finished, do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current template.
Click OK to apply your changes and close the window.

Related references

vFiler template properties on page 626
Administrator roles and capabilities on page 54
Copying a vFiler template
You can make a copy of a vFiler template and modify it rather than creating a completely new vFiler
template.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Policies > vFiler Templates.
2. Select the vFiler template that most closely resembles the template that you want to add and click
Copy.
The new template is added to the list with the name Copy of template-name.
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3. Select the new copy and click Edit.
4. In the Properties sheet, click the tab for the properties that you want to modify and enter the new
property values, including a new name.
5. When you are finished, do one of the following:
•
•

Click Apply to apply your changes and continue to edit the current template.
Click OK to apply your changes and close the window.

Deleting a vFiler template
You can delete an existing vFiler template if that template is not currently applied to an existing
dataset.
Before you begin

•
•

You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.
Make sure that the vFiler template that you want to delete is no longer assigned to any storage
sets.

Steps

1. From the menu bar, click the Policies > vFiler Templates tab.
2. Select one or more vFiler templates that you want to delete.
3. Click Delete, then click OK in the confirmation dialog box to delete the selected policy or click
Cancel to cancel the delete request.
Result

The selected template is deleted from the vFiler template list.
Related references

Administrator roles and capabilities on page 54

What storage services are
Storage services are combinations of protection policies, provisioning policies, resource pools, and
vFiler templates (for vFiler unit creation and attachment) that you can preconfigure, then apply as a
packages to different datasets with different storage needs.
For example, a corporation's two types of storage needs could be supported by two different storage
services.
•

A corporation's employee work directory storage needs might be adequately supported by Storage
Service Package A, which includes the following:
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•
•

•

A simple primary to secondary storage backup protection policy, carried out once a day.
Primary storage with a provisioning policy that specifies mid-range performance storage
systems and with a resource pool containing sufficient numbers of those storage systems to
meet the provisioning need.
• Secondary storage with a provisioning policy specifying high storage capacity low-end
performance storage units and with a resource pool containing sufficient numbers of those
units to meet the provisioning need.
That corporation's commercial transaction data, on the other hand might require Storage Service
Package Z, which includes the following:
•
•

•

A disaster-recovery capable mirror protection policy, carried out hourly to one site.
The primary site and mirror site with a provisioning policy that specifies high-performance
storage systems capable of functioning as primary storage systems in an emergency and with
a resource pools that contain the physical resources to fulfill those provisioning needs.
Regular but frequent backup from the mirror site to a tertiary backup site.

About storage services
A storage service is a user-defined combination of a protection policy, provisioning policies, resource
pools, and an optional vFiler template that you can assign as a package to a dataset or a class of
datasets with common protection, provisioning, or vFiler unit attachment needs.
You can preconfigure one or more combinations of protection, provisioning, resource pool, and
vFiler unit attachment services into specialized bundles that authorized administrators can readily
assign to datasets that require those specific bundles of storage service.
What you can do with storage services
By preconfiguring frequently used combinations of protection policies, provisioning policies,
resource pools, and optional vFiler templates for your datasets, you can simplify configuration of
new datasets and their administration for yourself, your co-workers, or outside storage service
subscribers.
•
•
•
•
•
•

Dataset creation is simplified because your protection, provisioning, and vFiler information is
mostly predesignated.
You can preconfigure different levels of storage services for different classes of applications to
support.
You can preconfigure different levels of storage services for different levels of storage service
subscribers.
You can edit an existing storage service configuration and apply that single change to all the
datasets to which this storage service is attached.
You can use the storage service feature to test the validity of the changes that you want to make,
before you actually implement them.
You can support automatic assignment of appropriate storage service configurations through
subscriber-friendly orchestration tools.
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Storage services example
For example, a storage administrator might want to configure several classes of storage
services to support different types of applications.
•

•

•

Storage Service A might provide support for applications that require high-end data update
and retrieval performance, and disaster recovery capable mirror protection and data
availability.
The administrator, therefore configures Storage Service A with a "DR Mirror, then mirror"
protection policy, a provisioning policy that specifies high performance storage systems,
and resource pools that contains high performance storage systems in sufficient numbers.
Storage Service B might provide support for applications that require mid-range data
update and retrieval performance and remote backup protection.
The administrator therefore configures Storage Service B with a "Backup" protection
policy, a provisioning policy that specifies mid-range storage systems, and a resource pool
that contains mid-range storage systems in sufficient numbers.
Storage Service C might provide support for applications producing a lot of primary data
that might require frequent migration to other physical storage sites.
The administrator therefore configures Storage Service C with a "Backup" protection
policy, and a vFiler template that supports the creation of a vFiler unit that accommodates
migration of data to other physical storage sites.

Related concepts

About protection policies on page 190
About provisioning policies on page 600
About resource pools on page 156
About vFiler templates on page 626
Preconfigured storage services supplied by the OnCommand console
To simplify the task of provisioning storage and providing remote protection to virtual objects, the
OnCommand console provides preconfigured storage services, which are combinations of protection
policies, provisioning policies, and resource pools specifically designed to facilitate remote
protection of virtual objects.
The preconfigured storage services are optimal for use in storage facilities with five or fewer storage
systems in single resource pools. You can copy, clone, or modify these storage services with other
protection policies using NetApp Management Console.
The preconfigured storage services include the following provisioning, protection policies, and
resource pools:
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Thin Provisioned
Space for VMFS
Datastores with
Mirror

This storage service is configured to provide thin provisioning and mirror
protection for VMFS datastore objects.
•

•
•
Thin Provisioned
Space for NFS
Datastores with
Mirror

Provisioning policy: Thin Provisioned Space for VMFS Datastores
This policy enables deduplication and thin provisioning. It facilitates
maximized space savings. It is required for the 50% guarantee program.
Protection policy: Mirror
Resource pools: default storage service primary pool; default storage
service mirror pool

This storage service is configured to provide thin provisioning and mirror
protection for NFS datastore objects.
•

•
•

Provisioning policy: Thin Provisioned Space for NFS Datastores
This policy enables deduplication and thin provisioning. It facilitates
maximized space savings. It is required for the 50% guarantee program.
Protection policy: Mirror
Resource pools: default storage service primary pool; default storage
service mirror pool

This storage service is configured to provide thin provisioning and mirror
Thin Provisioned
Space for Hyper-V protection for backing storage LUNs in Hyper-V environments.
Storage with Mirror
• Provisioning policy: Thin Provisioned Space for Hyper-V Storage
This policy is required for the 50% guarantee program.
• Protection policy: Mirror
• Resource pools: default storage service primary pool; default storage
service mirror pool
Thin Provisioned
Space for Hyper-V
Delegated Storage
with Mirror

This storage service is configured to provide thin provisioning and mirror
protection in Hyper-V environments. It supports a delegation model in
which the volume is provisioned according to best practices. The LUNs are
provisioned by SnapDrive for Windows on the Hyper-V parent.
•

•
•
Reserved Data
Space for VMFS
Datastores with
Mirror

Provisioning policy: Thin Provisioned Space for Hyper-V Delegated
Storage
This policy is required for the 50% guarantee program.
Protection policy: Mirror
Resource pools: default storage service primary pool; default storage
service mirror pool

This storage service is configured to provide provisioning and mirror
protection for write-guaranteed VMFS datastores.
•
•

Provisioning policy: Reserved Data Space for VMFS Datastores
Protection policy: Mirror
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•
Reserved Data
Space for NFS
Datastores with
Mirror

Resource pools: default storage service primary pool; default storage
service mirror pool

This storage service is configured to provide thick provisioning and mirror
protection for NFS datastores.
•
•
•

Provisioning policy: Reserved Data Space for NFS Datastores
Protection policy: Mirror
Resource pools: default storage service primary pool; storage service
mirror pool

This storage service is configured to provide thick provisioning and mirror
Reserved Data
Space for Hyper-V protection for backing LUNs in Hyper-V environments. The LUNs might
Storage with Mirror be backing storage for cluster shared volumes.
•
•
•
Reserved Data
Space for Hyper-V
Delegated Storage
with Mirror

This storage service is configured to provide thick provisioning and mirror
protection for backing storage for Hyper-V environments. It supports a
delegation model in which the volume is provisioned according to best
practices. The LUNs are provisioned using SnapDrive for Windows on a
Hyper-V parent.
•
•
•

Thin Provisioned
Space for VMFS
Datastores

Thin Provisioned
Space for NFS
Datastores

Provisioning policy: Reserved Data Space for Hyper-V Storage
Protection policy: Mirror
Resource pools: Default storage service primary pool; Default storage
service mirror pool

Provisioning policy: Reserved Data Space for Hyper-V Delegated
Storage
Protection policy: Mirror
Resource pools: Default storage service primary pool; Default storage
service mirror pool

This storage service is configured to provide thin provisioning for VMFS
datastore objects.
•
•
•

Provisioning policy: Thin Provisioned Space for VMFS Datastores
Protection policy: None
Resource pools: Default storage service primary pool

This storage service is configured to provide thin provisioning for NFS
datastore objects.
•
•
•

Provisioning policy: Thin Provisioned Space for NFS Datastores
Protection policy: None
Resource pools: Default storage service primary pool
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Thin Provisioned
Space for Hyper-V

This storage service is configured to provide thin provisioning for backing
storage LUNs in Hyper-V environments.
•
•
•

Thin Provisioned
Space for Hyper-V
Delegated Storage

This storage service is configured to provide thin provisioning in Hyper-V
environments. It supports a delegation model in which the volume is
provisioned according to best practices. The LUNs are provisioned by
SnapDrive for Windows on the Hyper-V parent.
•
•
•

Reserved Data
Space for VMFS
Datastores

Provisioning policy: Thin Provisioned Space for Hyper-V Storage
Protection policy: Storage
Resource pools: Default storage service primary pool

Provisioning policy: Thin Provisioned Space for Hyper-V Delegated
Storage
Protection policy: None
Resource pools: Default storage service primary pool

This storage service is configured to provide provisioning for writeguaranteed VMFS datastores.
•
•
•

Provisioning policy: Reserved Data Space for VMFS Datastores
Protection policy: None
Resource pools: Default storage service primary pool

Reserved Data
Space for NFS
Datastores

This storage service is configured to provide thick provisioning for NFS
datastores.

Reserved Data
Space for Hyper-V
Storage

This storage service is configured to provide thick provisioning for backing
LUNs in Hyper-V environments. The LUNs might be backing storage for
cluster shared volumes.

•
•
•

•
•
•
Reserved Data
Space for Hyper-V
Delegated Storage

Provisioning policy: Reserved Data Space for NFS Datastores
Protection policy: None
Resource pools: Default storage service primary pool

Provisioning policy: Reserved Data Space for Hyper-V Storage
Protection policy: None
Resource pools: Default storage service primary pool

This storage service is configured to provide thick provisioning for backing
storage for Hyper-V environments. It supports a delegation model in which
the volume is provisioned according to best practices. The LUNs are
provisioned using SnapDrive for Windows on a Hyper-V parent.
•
•

Provisioning policy: Reserved Data Space for Hyper-V Delegated
Storage
Protection policy: None
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•

Resource pools: Default storage service primary pool

Ways that storage services might be selected and attached
After you have configured a range of storage service configurations, the NetApp Management
Console provisioning capability enables alternative means to select and attach those configurations to
your datasets.
•

•

•

You can select a storage service through which to create a new dataset.
The NetApp Management Console provisioning capability interface allows you to select a storage
service and create a dataset with that service's protection policy, provisioning policies, resource
pools, and vFiler template already applied.
You can attach a storage service to an existing dataset.
If a protection policy, provisioning policies, resource pools, and a vFiler template is already
assigned to that dataset, the storage services feature suggests the most efficient ways to remap
your dataset nodes to the new protection policy.
Orchestration tools can be enabled to select your storage services. The NetApp Management
Console provisioning capability supports storage service selection through properly enabled and
authorized third-party orchestration tools. In a cloud service provider environment, this feature
might enable a cloud service subscriber to request a storage service offering that is automatically
implemented by the NetApp Management Console provisioning capability.

Storage services support for vFiler unit creation and attachment
The storage services feature allows you to specify creation of a template-based vFiler unit attached to
a node when you create a dataset using the Add Dataset Using Storage Service wizard. It also allows
you to attach an existing vFiler unit to the dataset's primary, secondary, or tertiary nodes.
Uses of storage services supported vFiler unit creation and attachment
When you use a storage service to create a dataset, you might want to attach vFiler units to your
dataset's primary nodes for purposes of multi-tenancy support or automated data migration support.
•

•

Multi-tenancy support
Specifying vFiler unit creation for your dataset's primary, secondary, or tertiary node enables you
to provide storage services for multiple subscribers on separate virtual storage systems that share
common physical storage.
For example, an administrator can create multiple datasets for Subscriber_X (named x_data,
x_data_2, x_data_3) that are accessed through a subscriber-specific vFiler unit (also named
x_data) attached to their primary nodes.
Then, on the same physical storage systems, the administrator can create multiple datasets for
Subscriber_Y (named y_data, y_data_2, y_data_3) that are accessed through another subscriberspecific vFiler unit (also named y_data) attached to their primary nodes.
Automated online or offline data migration support
Creating a vFiler unit and attaching it to a dataset's primary node also allows you to enable
automated online or offline migration of that dataset's primary data.
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Related concepts

About vFiler templates on page 626
Storage services vFiler unit creation
Configuring a storage service to include a vFiler template enables you or other authorized operators
to specify automatic creation of a vFiler unit attached to primary, secondary, and tertiary nodes
respectively when you use that storage service to create a dataset.
To support template-based vFiler unit creation on a node, you first assign an existing vFiler template
when you use the Add Storage Service wizard or Edit Storage Service wizard to create or edit a
storage service.
Later, if you or other authorized operators use this storage service to create a dataset and an optional
vFiler unit at the same time, the Add Dataset Using Storage Service wizard uses the storage services
assigned vFiler template to configure the NIS, DNS and admin host information for the new vFiler
unit. All you need to specify is an IP address (and network mask, if necessary).
Note: If the storage service specifies no vFiler template on a node, then the new vFiler unit set up
is determined by the hosting storage system.

The wizard attempts to give the new vFiler unit the same name as the dataset that it is concurrently
creating. For example, if the wizard is creating a new vFiler unit on primary node as part of creating
a dataset named "eng_acct", it attempts to name the new vFiler unit "eng_acct" also. However, if
another vFiler unit named "eng_acct" exists, then the wizard names the new vFiler unit "eng_acct_1".
Similarly, when creating a new vFiler unit on secondary or tertiary node, it attempts to name the new
vFiler unit "eng_acct_<nodename>". However, if another vFiler unit named
"eng_acct_<nodename>" exists, then the wizard names the new vFiler unit
"eng_acct_<nodename>_1".
After that vFiler unit is created, you or other authorized operators can attach it as an existing vFiler
unit to the nodes of succeeding datasets that you create using this storage service.
Related concepts

About vFiler templates on page 626
Storage services attachment of existing vFiler units
You can attach vFiler units that you created when using the Add Dataset Using Storage Service
wizard to any new dataset that you create. For example, if you previously used the wizard to create
dataset "eng_acct" and vFiler unit "eng_acct," you can use the wizard again to create the dataset
"eng_acct_b" and attach its primary node to the previously created vFiler unit "eng_acct."

Configuring storage services
You use the Add Storage Service wizard to specify the protection policy, provisioning policy,
resource pool, and vFiler template components of a new storage service. You use the Edit Storage
Service wizard to change those components in an existing storage service.
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Decisions to make before adding a storage service
Before you start the Add Storage Service wizard you must gather the information that you need to
complete the wizard.
Service
Properties

•
•

What is the name and description of the storage service?
What is the name and email address of the owner of this storage service?

Group Selection To which user groups do you want this storage service available?
Assignment of a storage service to a particular group makes that storage service
available to all storage administrators who have access to that group. Including
the storage service in the global group makes it available to all users of the
NetApp Management Console provisioning capability.
Which protection policy do you want this storage service to support?
Protection
Policy Selection
The storage services feature can offer any protection policy or disaster-recovery
capable policy that is supported by the NetApp Management Console data
protection capability.
No Protection is also an option if you do not want to use this storage service to
provide data protection.
Service Node
configuration

For each primary, secondary, or tertiary node that is included in the protection
policy that you want, decide the following:
•

•

Which provisioning policies do you want to assign to your primary,
secondary, or tertiary nodes?
If you are configuring a storage service to assign to a dataset of physical
storage objects, you must assign either a NAS or SAN type provisioning
policy to the primary node.
Storage services assigned to datasets of virtual objects require no
provisioning policy assigned to the primary node.
If you want to assign a provisioning policy to a disaster recovery node, the
policy type must either be default or the same as that assigned to the primary
node.
If you want to assign a provisioning policy to a non-disaster recovery
secondary node, the policy type must either be secondary or default.
Any storage service that you select for the task of creating a dataset through
that storage service must already have a provisioning policy specified for the
primary node.
Which resource pools do want your primary, secondary, or tertiary nodes
provisioned from?
Except for the primary nodes of datasets of virtual objects, each node
requires one or more resource pools assigned to it.
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•

Which vFiler template do you want to assign to your primary, secondary, or
tertiary nodes?
You have the option of specifying the vFiler template on which the optional
vFiler unit creation will be based.
Later, if you or other authorized operators use this storage service to create a
dataset and select the Add Dataset Using Storage Service wizard option to
create a new vFiler unit, the wizard uses the assigned vFiler template to
configure the NIS, DNS, and administrator host information for the new
vFiler unit. All you need to specify is an IP address (and network mask, if
necessary).
Note: If the storage service specifies no vFiler template, then the new
vFiler unit set up is determined by the hosting storage system.

The wizard attempts to give the new vFiler unit the same name as the dataset
that it is concurrently creating. For example, if the wizard is creating a new
vFiler unit on the primary node as part of creating a dataset named
"eng_acct," it attempts to name the new vFiler unit "eng_acct" also.
However, if another vFiler unit named "eng_acct" already exists, then the
wizard names the new vFiler unit "eng_acct_1". Similarly, when creating a
new vFiler unit on secondary or tertiary node, it attempts to name the new
vFiler unit "eng_acct_<nodename>". However, if another vFiler unit named
"eng_acct_<nodename>" already exists, then the wizard names the new
vFiler unit "eng_acct_<nodename>_1".
Related concepts

About protection policies on page 190
About provisioning policies on page 600
About resource pools on page 156
About vFiler templates on page 626
Related references

Administrator roles and capabilities on page 54
Adding a storage service
You can use the Add Storage Service wizard to create and add new combinations of storage services.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
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Confirm that the protection policy, provisioning policy, resource pools, or vFiler template that you
want to specify for the new storage service are available in the group in which you intend to add that
storage service.
About this task

After you create a storage service, you can apply it as follows:
•

•

You can use it to quickly create datasets with the protection policy, provisioning policies,
resource pools, and template-based optional attached vFiler units that are specified by the storage
service.
You can also apply it to existing datasets, automatically assigning them a predefined
configuration.

Steps

1. From the menu bar, click Policies > Storage Services.
2. Click Add to start the Add Storage Service wizard.
3. After you complete each property sheet in the wizard, click Next.
4. Confirm the details of the storage service and click Finish.
Result

Your new storage set is listed in the Storage Services window.
Related concepts

Decisions to make before adding a storage service on page 216
Related references

Administrator roles and capabilities on page 54
Decisions to make before editing a storage service
Before you start the Edit Storage Service wizard you need to gather the information to complete the
wizard.
Service
Properties

•
•

Protection
•
Policy Selection

Do you want to change the name or description of the storage service?
Do you want to change the name and email address of the owner of this
storage service?
Do you want to change the protection policy that this storage service
supports?
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•

•
Service Node
configuration

•

If you change the protection policy, how do you want to map the data in the
current policy's secondary or tertiary nodes to the replacement policy's
secondary or tertiary nodes?
In case of node remapping, the storage service feature applies the original
node's assigned provisioning policy, resource pools, and vFiler template to
the new node whenever possible.
Are you prepared for rebaselining of data to newly mapped secondary or
tertiary nodes if the new protection policy requires that?
For each node (primary, secondary, or tertiary) that is included in the new
protection policy, do you want to change the provisioning policy, resource
pool, or vFiler template assignment?
Note: Some protection policy node remappings require you to modify
provisioning policy and resource pool assignments.

•

If you are configuring a storage service to assign to a dataset of physical
storage objects, you must assign either a NAS or SAN type provisioning
policy to the primary node.
Storage services assigned to datasets of virtual objects require no
provisioning policy assigned to the primary node.

Related concepts

About protection policies on page 190
About provisioning policies on page 600
About resource pools on page 156
About vFiler templates on page 626
Editing a storage service
You can use the Edit Storage Service wizard to edit the protection policy, provisioning policy,
resource pool, or vFiler template selections of an existing storage service.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Confirm that any new protection policy, provisioning policy, resource pool, or vFiler template that
you want to include in the modified storage service are available in the group in which that storage
service is located.
Confirm that you want the changes to apply to all the datasets that currently use this storage service.
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About this task

If you change the protection policy, the Edit Storage Service wizard shows you alternative ways to
remap your secondary or tertiary nodes and the rebaselining effort required for each alternative. After
you edit the storage service, all the changes that you made to that service will apply to every dataset
that uses that storage service.
Steps

1. From the menu bar, click Policies > Storage Services.
2. In the Storage Services list, select the storage service you want to edit.
3. Click Edit to start the Edit Storage Service wizard.
4. After you complete each property sheet in the wizard, click Next.
5. Confirm the details of the storage service and click Finish.
Related concepts

Decisions to make before editing a storage service on page 218
Related references

Administrator roles and capabilities on page 54

What a host is
A host is a computer system that accesses data on a storage system.

About hosts
The hosts that you can view in NetApp Management Console and use in your policy implementations
have been automatically discovered by DataFabric Manager or manually added to its database.
How hosts become visible to the console
When either the NetApp Management Console data protection capability or the NetApp Management
Console provisioning capability is enabled, Operations Manager automatically begins a host
discovery process. The discovered hosts automatically display in the lists of storage system, vFiler
unit, and Open Systems SnapVault client hosts in the interface.
When you add a host to NetApp Management Console, the host is incorporated into the DataFabric
Manager server database and is viewable in Operations Manager. You can add host systems from the
Storage Systems Hosts window, vFiler Units window, and Open Systems SnapVault window.
Some items that are viewable as hosts in Operations Manager are not listed as hosts in the NetApp
Management Console interface, because the console does not use items of that type to implement its
data management tasks. For example, Fibre Channel switches are considered hosts in Operations
Manager but are not included in the list of hosts in NetApp Management Console.
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For more information about host discovery and management with the DataFabric Manager server
database, see the Operations Manager Administration Guide.
Related information

Operations Manager Administration Guide - http://support.netapp.com/NOW/knowledge/docs/
DFM_win/dfm_index.shtml
Host monitoring
You can verify that a host is available and correctly configured by accessing the list in the
appropriate Hosts window for storage systems, vFiler units, and Open Systems SnapVault systems.
The NetApp Management Console data protection and provisioning capabilities regularly check for
updates to configuration information. This data is gathered from SNMP queries by system monitors.
The monitors update the DataFabric Manager server database at scheduled intervals. The NetApp
Management Console data protection and provisioning capabilities query the DataFabric Manager
server database for the information that is then displayed in NetApp Management Console.
Because the NetApp Management Console data protection and provisioning capabilities do not query
the hosts directly but rely on the scheduled monitors, the configuration information displayed in the
Hosts windows is not real-time data. Therefore, this data might not reflect recent changes made to a
storage system or configuration and could be outdated by a few minutes or a few hours, depending
on the changes made.
Ways to investigate problems with hosts
If you are investigating a policy failure, you can use the information displayed in the Hosts windows
to determine whether the cause is a problem with a host. This information can also help determine
the potential impact of any changes that you might make to a host.
Most problems that you might encounter with a host can be diagnosed and corrected by using the
host diagnostics wizards. The diagnostics wizards are located on the Storage Systems Hosts window
and the OSSV Hosts window. The wizards include steps to help you locate and fix issues with hosts.
You can also use the Edit hosts property sheets to make changes to host licenses and host and NDMP
credentials. You can access each of the wizards and property sheets in the following windows of the
interface.
Storage
Systems
Hosts
window

Provides information about storage systems that can help you verify whether a host is
up and accepting the NDMP credentials specified for it, as well as whether the
appropriate licenses are assigned to it.
Allows you to review path and relationship information about storage systems, as well
as to check host and NDMP status. The path and relationship information displayed for
each individually selected storage system helps you see the interdependencies between
hosts. For example, by reviewing the data flowing into and out of a selected storage
system, you can evaluate the impact of temporarily removing that storage system from
service for maintenance. You can also review information about input and output
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relationships to determine whether lag times are within specified thresholds and which
datasets are impacted if the lag threshold has been or is about to be exceeded.
From this window, you can start the Add Storage System wizard and the Diagnose
Storage Systems wizard, or you can open the Edit property sheet for storage systems.
You can also refresh the information about a selected host in the window's host list.
vFiler
Units
window

Allows you to review the status of vFiler units and to verify the IP address of the vFiler
unit and the name of the storage system that is hosting it.
Allows you to review path and relationship information about vFiler units. The path
and relationship information displayed for each individually selected vFiler unit helps
you see the interdependencies between hosts and datasets. For example, by reviewing
the data flowing into and out of a selected host, you can evaluate the impact of
temporarily removing that host from service for maintenance.
From this window, you can start the Add vFiler Unit wizard or the Setup vFiler Unit
wizard, and you can delete vFiler units.

OSSV
Hosts
window

Allows you to review the status of Open Systems SnapVault hosts (including VMware
ESX hosts) the port and credentials status of each NetApp Host Agent, and the status of
NDMP connections and credentials.
Allows you to investigate problems with an Open Systems SnapVault client.
Information in this window includes the host and NDMP status, the NDMP credentials
status, the operating system and version that each host is running, and path information
for each host.
From this window, you can start the Add OSSV Host wizard and the Diagnose OSSV
Host wizard, and open the Edit OSSV host property sheet for a host that contains an
Open Systems SnapVault agent.
From this window, you can also stop and start an Open Systems SnapVault 2.3 and
later agent on which NetApp Host Agent is installed. Stopping and starting the agent
stops and starts backup service on the selected client, which might resolve the problem.
After you restart the backup service, you can click Refresh to display current data for
the selected client and determine the effect of restarting the backup service.
Note: There is no Open Systems SnapVault plug-in for Solaris, so the NetApp Host
Agent cannot communicate with the Open Systems SnapVault agent. Therefore, the
Host Agent Status displays as Not Detected and management tasks such as start and
stop of the Open Systems SnapVault agent cannot be performed from the NetApp
Management Console.

Related tasks

Diagnosing a storage system on page 272
Diagnosing an Open Systems SnapVault host on page 273
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Data ONTAP licenses used for protecting or provisioning data
There are several Data ONTAP licensed options that you can use to protect or provision your data.
After you have purchased the software licenses you need, you can assign these licenses to your
primary and secondary storage from the Storage Systems Hosts window.
When you purchase a Data ONTAP option license, you receive a code composed of a string of
characters, such as ABCDEFG, that is unique to a particular service. You receive license codes for
every protocol and option, or service, that you purchase.
Not all purchased license codes are installed on a storage system before it is shipped from the
factory. Some licenses are installed after the system is set up. You can purchase license codes to
enable additional services at any time. If you misplace a license code, you can contact NetApp
technical support or log in to the NetApp Support Site to obtain a copy.
You must enter a software license code on a storage system to enable the corresponding service. You
do not need to indicate which license the code enables. The code is matched automatically to the
appropriate service license.
Note: The Licenses area is visible only when the selected host is a single storage system running
Data ONTAP. If you plan to use Open Systems SnapVault to back up data on a host that is not
running Data ONTAP, you select the secondary storage system to license the necessary Data
ONTAP services.

The following licenses are available for use with the DataFabric Manager server:
SnapMirror license You install a SnapMirror license on each of the source and destination
storage systems for the mirrored data. If the source and destination volumes
are on the same system, only one license is required.
SnapMirror replicates data to one or more networked storage systems.
SnapMirror updates the mirrored data to keep it current and available for
disaster recovery, offloading tape backup, read-only data distribution, testing
on nonproduction systems, online data migration, and so on. You can also
enable the SnapMirror license to use Qtree SnapMirror for backup.
To use SnapMirror software, you must update the
snapmirror.access option in Data ONTAP to specify the destination

systems that are allowed to access the primary data source system. For more
information about the snapmirror.access option, see the Data ONTAP
Data Protection Online Backup and Recovery Guide for 7-Mode.
SnapVault Data
ONTAP secondary
license

You install the SnapVault Secondary license on storage systems that host the
backups of protected data. SnapVault creates backups of data stored on
multiple primary storage systems and copies the backups to a secondary
storage system. If data loss or corruption occurs, backed-up data can be
restored to a primary or open storage system with little of the downtime and
uncertainty associated with conventional tape backup and restore operations.
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For versions of Data ONTAP 7.3 or later, a single storage system can
contain a SnapVault Data ONTAP Primary license and a SnapVault
Secondary license.
SnapVault Data
ONTAP primary
license

You install the SnapVault Data ONTAP Primary license on storage systems
running Data ONTAP that contain host data to be backed up. For versions of
Data ONTAP 7.3 or later, a single storage system can contain a SnapVault
Data ONTAP Primary license and a SnapVault Secondary license.

SnapVault
Windows Primary
License

You install the SnapVault Windows Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a
Windows-based primary storage system running the Open Systems
SnapVault agent. A Windows-based primary storage system running the
Open Systems SnapVault agent does not require a SnapVault license.

You install the SnapVault Open File Manager license on a secondary storage
SnapVault
Windows Open File system to enable the backup of open files on Windows primary storage
systems running the Open Systems SnapVault agent.
Manager license
You must install the SnapVault Windows Primary license and the
SnapVault Data ONTAP Secondary license on the secondary storage system
before installing the SnapVault Open File Manager license.
SnapVault UNIX
primary license

You install the SnapVault UNIX Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a UNIXbased primary storage system (AIX, HP-UX, or Solaris) running the Open
Systems SnapVault agent. A UNIX-based primary storage system running
the Open Systems SnapVault agent does not require a SnapVault license.

SnapVault Linux
primary license

You install the SnapVault Linux Primary license on a secondary storage
system, in addition to the SnapVault Secondary license, to support a Linuxbased primary storage system running the Open Systems SnapVault agent. A
Linux-based primary storage system running the Open Systems SnapVault
agent does not require a SnapVault license.

NearStore Option
license

The NearStore license enables your storage system to use transfer resources
as conservatively as if it were optimized as a backup system. This approach
is useful when the storage system on which you want to store backed-up data
is not a system optimized for storing backups, and you want to minimize the
number of transfer resources the storage system requires.
Storage systems using the NearStore license must meet the following
criteria:
•
•
•

The storage system must be a FAS30xx, FAS31xx, or FAS60xx system.
The version of Data ONTAP must be 7.1 or later.
If you plan to use the SnapVault service, the storage system must have a
SnapVault secondary license enabled.
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Deduplication
license

The deduplication license (a_sis) enables you to consolidate blocks of
duplicate data into single blocks to store more information using less storage
space.

SnapMirror Sync
license

The SnapMirror Sync license enables you to replicate data to the destination
as soon as it is written to the source volume. SnapMirror Sync is a feature of
SnapMirror.

MultiStore Option
license

The MultiStore Option license enables you to partition the storage and
network resources of a single storage system so that it appears as multiple
storage systems on the network. Each virtual "storage system" created as a
result of the partitioning is called a vFiler unit. A vFiler unit, using the
resources assigned, delivers file services to its clients as a storage system
does.
The storage resource assigned to a vFiler unit can be one or more qtrees or
volumes. The storage system on which you create vFiler units is called the
hosting storage system. The storage and network resources used by the
vFiler units exist on the hosting storage system.
Be sure the host on which you intend to install the MultiStore Option license
is running Data ONTAP 6.5 or later.

FlexClone license

The FlexClone license is necessary on storage systems that you intend to use
as resources for secondary nodes for datasets of virtual objects.

Single file restore
license

The Single file restore license is necessary on storage systems that you
intend to use as primary storage for datasets of virtual objects.

Related concepts

Process for determining when SnapVault and qtree SnapMirror are used to perform backups on
page 252
Related information

Documentation on the NetApp Support Site: support.netapp.com
Process for determining when SnapVault and qtree SnapMirror are used to perform
backups
When both SnapVault and qtree SnapMirror licenses are installed in your environment, the NetApp
Management Console data protection capability determines which technology to use based on the
licenses enabled on the source and destination hosts and the schedule applied to the backup
connection of the protection policy.
If you use only SnapVault licenses in your environment, the NetApp Management Console data
protection capability uses SnapVault for backups. However, if you use both SnapVault and
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SnapMirror licenses in your environment, the NetApp Management Console data protection
capability uses the following sequence to determine which one to use for backups:
1. If the data to be backed up is located on a host running the Open Systems SnapVault agent, the
NetApp Management Console data protection capability uses SnapVault for backups.
2. If either the source or destination host has the SnapMirror license enabled but not the SnapVault
license, the NetApp Management Console data protection capability uses qtree SnapMirror for
backups.
3. If both the source and destination host have the SnapVault license enabled but not the SnapMirror
license, the NetApp Management Console data protection capability uses SnapVault for backups.
4. If the schedule applied to the backup connection specifies that the data needs to be backed up
more frequently than once an hour, the NetApp Management Console data protection capability
uses qtree SnapMirror for backups.
5. If none of the previous conditions applies, by default, the NetApp Management Console data
protection capability uses SnapVault for backups.
Related references

Data ONTAP licenses used for protecting or provisioning data on page 68
vFiler unit configuration using a script
You can write a script to customize a vFiler unit configuration. When the script is specified in the
Setup vFiler Unit wizard, the NetApp Management Console provisioning capability executes the
script before and after a vFiler unit is set up. You must specify the full DataFabric Manager server
path of the script.
For example, if you want the new vFiler unit to use a vFiler unit configuration that was saved in
Operations Manager, you might write a script that runs the appropriate dfm config commands to
retrieve and execute that configuration.
For information on the environment variables you may need for a script, see the dfpm man pages in
Operations Manager.

Configuring hosts
In general, you use a wizard to configure hosts and you use an editing window to modify property
values.
Decisions to make before adding a storage system
Before running the Add Storage System wizard, it is useful to have all of the configuration
information available for the host that you are adding.
Host Name or
IP Address

What is the name or the IP address of the storage system that you want to add?
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Licenses

Which services do you want enabled on the storage system?
You must enter a software license code to enable each corresponding service on
the storage system or host. Licenses are set immediately upon entering the
information in the text field. License information cannot be removed or cancelled
once entered, so be sure that you are entering the correct storage system.
When you enable licenses, consider how you want to use each storage system to
protect data:
•
•
•

Login
Credentials

Can it be used to hold primary data, secondary data, or both?
Can it be used for backups or for mirroring?
Which operating system can it run on?

What are the user name and password for the storage system?

Access Control Which roles do you want to have access privileges to the storage system?
You can assign different access privileges for SnapVault and for SnapMirror.
NDMP
Credentials

What is the NDMP user name for the storage system that you want to add?
The DataFabric Manager server automatically manages the password based on the
user name provided. The DataFabric Manager server uses these credentials to
communicate with the selected host over NDMP.
To obtain an encrypted NDMP password for a storage system, type ndmpd
password username at the command line of the storage system.
For more information about how Operations Manager uses NDMP, see the Data
ONTAP 7-Mode Storage Management Guide. For more information about
NDMP credentials, see the Data ONTAP 7-Mode Data Protection Tape Backup
and Recovery Guide.

Related information

Data ONTAP Storage Management Guide - http://support.netapp.com/NOW/knowledge/docs/
ontap/ontap_index.shtml
Data ONTAP Data Protection Tape Backup and Recovery Guide - http://
support.netapp.com/NOW/knowledge/docs/ontap/ontap_index.shtml
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Adding a storage system
You can add storage systems to the hosts list to make them available for inclusion in data
management actions. When you add storage systems to NetApp Management Console, you also add
the storage to the DataFabric Manager database.
Before you begin

Have the following information available for the storage system that you want to add:
•
•
•
•
•
•

Host name or IP address
Host credentials (user name and password)
License code
SnapVault Access Control List, if licensed for SnapVault
SnapMirror Access Control List, if licensed for SnapMirror
NDMP credentials (user name and password)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > Storage Systems.
2. Click Add to start the Add Storage System wizard.
Enter or select information as requested in the wizard.
Note: In this wizard, clicking Next implements the operations on each page. Clicking Back or
Cancel does not undo operations performed on previous pages.

3. Verify that the storage system that you added is included in the hosts list in the Storage Systems
Hosts window.
You might need to update the window before you can view the new host in the host list.
Result

You can now manage data located on the new storage system or use the storage as a secondary
storage system for backups or mirror copies.
Related concepts

Decisions to make before adding a storage system on page 253
Related references

Administrator roles and capabilities on page 54
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Decisions to make before adding an Open Systems SnapVault host
Before adding an Open Systems SnapVault host using the Add OSSV Host wizard, it is useful to
have all of the host's configuration information available.
If the Open Systems SnapVault host that you are adding resides on a VMware ESX 3.5 server, you
should review the guidelines for adding an Open Systems SnapVault host on an VMware ESX 3.5
server.
Host Name or
IP Address

What is the name or the IP address of the Open Systems SnapVault host that you
want to add?

Host Agent
Credentials

•

•

What are the user name and password that the DataFabric Manager server
should use to authenticate to the host running NetApp Host Agent?
Operating system credentials for the host on which NetApp Host Agent is
running, if the DataFabric Manager server is managing the credentials for you
Credentials for NetApp Host Agent, if DataFabric Manager server is not
managing the credentials
Should the DataFabric Manager server set up and manage the host agent
password or will you do it manually?
For instructions describing how to set up credentials for hosts running
NetApp Host Agent, see the NetApp Host Agent Installation and
Administration Guide.

NetApp Host
Agent Port

What port number do you want to use for host agent access?

NDMP
Credentials

What are the NDMP user name, password, and port number for the host that you
want to add?

The default port is 4092.

The DataFabric Manager server uses these credentials to communicate with the
selected host over NDMP.
To obtain an encrypted NDMP password for the host, issue ndmpd password
username from the command line.
The default port number is 10000.
If the host runs the Open Systems SnapVault agent, specify the port number, if
other than the default, that the DataFabric Manager server should use when
communicating with the selected host over NDMP.
For more information about how Operations Manager uses NDMP, see the Data
ONTAP 7-Mode Storage Management Guide. For more information about
NDMP credentials, see the Data ONTAP 7-Mode Data Protection Tape Backup
and Recovery Guide.
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For more information about Open Systems SnapVault configurations, see the Open Systems
SnapVault Installation and Administration Guide.
Related concepts

Decisions to make before adding vFiler templates on page 628
Related references

Guidelines for adding and editing an Open Systems SnapVault host on an ESX server on page 257
Related information

Open Systems SnapVault Installation and Administration Guide: support.netapp.com/
documentation/productsatoz/index.html
Data ONTAP Storage Management Guide : support.netapp.com/documentation/productsatoz/
index.html
Data ONTAP Data Protection Tape Backup and Recovery Guide: support.netapp.com/
documentation/productsatoz/index.html
Guidelines for adding and editing an Open Systems SnapVault host on an ESX server
NetApp Management Console supports Open Systems SnapVault backups for virtual machines
(VMs) on VMware ESX servers. Before starting the Add OSSV Host wizard for VMware ESX 3.5, it
is useful to review the guidelines.
•
•
•
•
•

The Open Systems SnapVault software must be installed on each VMware ESX 3.5 server that
you want to back up.
The NetApp Host Agent is NOT needed for an Open Systems SnapVault installation on a
VMware ESX 3.5 server.
The DataFabric Manager server discovers only the virtual machines that are registered to the
VMware ESX 3.5 server that you have discovered.
NetApp Management Console backs up only the virtual machines on an VMware ESX 3.5 server.
File system backups on a VMware ESX 3.5 server are not supported.
The backup for the virtual machine is always through the VMware ESX 3.5 server that was
involved in creating the relationship.
If the virtual machine is moved to another server, the backup is still through the original VMware
ESX 3.5 server. If the original VMware ESX 3.5 server is offline, the virtual machine is not
backed up.

For more information about Open Systems SnapVault configurations, see the Open Systems
SnapVault Installation and Administration Guide.
Related information

Open Systems SnapVault Installation and Administration Guide - http://
support.netapp.com/NOW/knowledge/docs/client_filer_index.shtml
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Adding an Open Systems SnapVault host
You can add an Open Systems SnapVault host to make the host and its data available to the
DataFabric Manager server for inclusion in data management actions. When you add an Open
Systems SnapVault host to DataFabric Manager server, you also add the host to the DataFabric
Manager database.
Before you begin

•

Have the following information available:
•
•
•

Host name or IP address
Port number for NetApp Host Agent
Decision about whether DataFabric Manager should set up and manage the NetApp Host
Agent password:
•

•

•

If yes, provide the operating system credentials for the host on which NetApp Host Agent
is running.
• If no, provide the credentials for NetApp Host Agent.
• NDMP credentials (user name and password) and port number
If the Open Systems SnapVault host you are adding resides on a VMware ESX 3.5 server, you
must be familiar with the guidelines for adding an Open Systems SnapVault host on a VMware
ESX 3.5 server.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Hosts > OSSV.
2. Click Add to start the Add OSSV Host wizard.
Enter or select information as requested in the wizard.
3. Verify that the host you added is included in the hosts list in the OSSV Hosts window.
You might need to refresh the window before you can view the new host in the host list.
Related concepts

Decisions to make before adding an Open Systems SnapVault host on page 256
Related references

Guidelines for adding and editing an Open Systems SnapVault host on an ESX server on page 257
Administrator roles and capabilities on page 54
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Decisions to make before adding a vFiler unit
Before starting the Add vFiler Unit wizard, it is useful to have all of the configuration information
available for the unit that are you adding.
Name

What is the name of the vFiler unit that you want to add?
The vFiler unit name must be unique.

IP space

What is the IP space for the vFiler unit that you want to add?
An IP space defines an address in which the vFiler unit can participate. If no IP
space is defined for the vFiler unit, use default-ipspace. For more information
about vFiler IP space, see the Data ONTAP 7-Mode MultiStore Management
Guide.

Allowed
protocols

What protocols are assigned to the vFiler unit?
The following protocols are supported:
•
•
•

iSCSI
NFS
CIFS

Fibre Channel is not supported on vFiler units.
Attention: If you assign the CIFS protocol to the vFiler unit, you need to set up

CIFS before you can use the vFiler unit. Performing the setup stops and restarts
CIFS, interrupting the CIFS service.
Which storage system or resource pool is the vFiler unit assigned to?
Parent
storage
Be sure that the host on which you want to create a vFiler unit is running Data
system or
ONTAP 7.0 or later.
resource pool
IP address

What is the IP address of the vFiler unit that you want to add?
The IP address used by the vFiler unit must not be configured for use before you
create the vFiler unit.
Note: The IP address accepts both IPv4 and IPv6 address formats.

Network
mask

What is the network mask of the vFiler unit that you want to add?
The network mask is not required to create the vFiler unit, although you must
specify a network mask to set up the vFiler unit.
Note: The network mask accepts both IPv4 and IPv6 address formats. When
using IPv4 format, specify this value using either four-octet notation or the
network mask length (the number of bits, from 1 to 31). When using IPv6
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format, specify the value using the network mask length (the number of bits,
from 1 to 127).
Network
interface

What is the Ethernet interface for the vFiler unit?

VLAN ID

Will you use VLANs in the creation of the vFiler unit? What is the ID of the
VLAN that you will use?

The Ethernet interface is not required to create the vFiler unit, although you must
specify an interface before you can use the vFiler unit. If you plan to run scripts on
the vFiler unit, you might choose to wait to specify the Ethernet interface later, by
using the Setup option.

VLANs allow you to partition a physical network into multiple virtual networks
that are totally separate.
If the vFiler unit that you plan to add is created on a high-availability host, you can
use an existing VLAN ID or create a new VLAN ID for the vFiler unit. If a VLAN
ID is not entered, the partner interface field is disabled.
Partner
interface

What is the partner interface for the vFiler unit?
If you create a vFiler unit using a high-availability host, the partner interface is
selected automatically. If no partner interface is configured, then the option None
is selected automatically.
The storage system on which the vFiler unit is created must be configured as an
HA configuration before the creation of the vFiler unit.

vFiler
template

CIFS
workgroup
name

Which, if any, vFiler template do you want to use for the vFiler unit?
A vFiler template is a set of vFiler configuration settings and the corresponding
CIFS configuration settings. If you do not select a vFiler template, the network
settings are cleared.
What is the Windows workgroup name for the CIFS setup?
The Windows workgroup name specifies the name of the shared resources. The
workgroup name option is displayed if the following conditions apply:
•
•
•

You select to use the CIFS protocol
You select the Perform CIFS setup option
You do not select a vFiler template or the template you select does not include
CIFS settings

If you set up the vFiler unit to use the CIFS protocol, the vFiler units can use the
same computer names as the servers. This enables CIFS clients to share resources
without having to remap their drives or search for the new server.
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CIFS domain What is the login name and the password for administrative access to the Active
Directory system?
user and
domain
The domain user and domain password options are displayed if the following
password
conditions apply:
•
•
•

You select to use the CIFS protocol
You select the Perform CIFS setup option
You select a vFiler template that specifies Active Directory for CIFS
authentication

Root
password

What password will you use for the vFiler unit you are creating?

Script path

Do you want to use a custom script to help manage vFiler units? If so, what is the
full path of the script?
You can use the script while creating or setting up the vFiler unit.
Note: If the DataFabric Manager server is running on Windows, and if the postsetup script for the vFiler unit is on a network share, the script location must be
specified by the full UNC path (no drive letter mapping).

Related concepts

What vFiler templates are on page 391
Considerations for high-availability hosts on page 265
Related information

Data ONTAP MultiStore Management Guide - http://support.netapp.com/NOW/knowledge/docs/
ontap/ontap_index.shtml
Adding a vFiler unit
You can create and configure vFiler units to make them available for inclusion in data management
actions.
Before you begin

•
•
•
•

Ensure that the host on which you want to create a vFiler unit is running Data ONTAP 7.0 or
later.
Ensure that the resource group contains at least one host entry when creating a vFiler unit using a
resource group.
Ensure that the IP address used by the vFiler unit is not configured when you create the vFiler
unit.
Have the following information available for the vFiler unit that you want to create:
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•

• Name
• IP space
• Protocols assigned to the vFiler unit (NFS, CIFS, or iSCSI)
• IP address
• Name of the storage system or resource pool to be associated with the vFiler unit
• Network mask
• Network interface to use
• VLAN ID information (optional in an HA pair)
• Partner interface in an HA pair (disabled if VLAN ID is not provided)
• vFiler template name (optional)
• Windows workgroup name or CIFS domain user and password
• Root password (optional during vFiler creation)
• Script path (optional)
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

You can complete the entire vFiler unit configuration, or you can create an inactive vFiler unit and
complete the protocol or network setup later.
Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Click Add to start the Add vFiler Unit wizard.
3. Enter or select information as requested in the wizard, then click Finish.
You can verify that the vFiler unit you added is included in the hosts list in the vFiler Units
window.
Result

Providing all the information requested by the wizard enables you to protect or provision data that is
associated with the new vFiler unit.
If you did not specify all of this information, you can configure it later by using the Setup vFiler Unit
wizard on the Hosts > vFiler Units window.
Related concepts

Decisions to make before adding a vFiler unit on page 259
Related references

Administrator roles and capabilities on page 54
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Decisions to make before setting up vFiler unit properties
Before starting the Setup vFiler Unit wizard to configure vFiler storage unit properties, it is useful to
have all of the configuration information available for the unit that are you configuring.
Use the vFiler Setup option to add or modify vFiler unit attributes. For example, if you assigned but
did not configure the CIFS protocol when you created the vFiler unit, you can use the Setup vFiler
Unit wizard to perform the CIFS configuration.
Allowed
protocols

Which assigned protocols do you want to add or change on the vFiler unit?
The following protocols are supported:
•
•
•

NFS
CIFS
iSCSI

Fibre Channel is not supported on vFiler units.
Attention: If you assign the CIFS protocol to the vFiler unit, you must set up

CIFS before you can use the vFiler unit. Performing the setup stops and restarts
CIFS, interrupting the CIFS service.
IP address

Which IP address do you want for the vFiler unit?
The IP address accepts both IPv4 and IPv6 address formats.

Network
mask

Which network mask do you want for the vFiler unit?
Note: The network mask accepts both IPv4 and IPv6 address formats. When

using IPv4 format, specify using either four-octet notation or network mask
length (the number of bits, from 1 to 31). When using IPv6 format, specify using
the network mask length (the number of bits, from 1 to 127).
Network
interface

Which Ethernet interface do you want to add or change for the vFiler unit?

VLAN ID

Do you want to specify a VLAN ID?

The Ethernet interface is not required to create the vFiler unit, although you must
specify an interface before you can use the vFiler unit. If you plan to run scripts on
the vFiler unit, you might choose to wait to specify the Ethernet interface later, by
using the Setup option.

VLANs allow you to partition a physical network into multiple separate virtual
networks.
If the vFiler unit that you plan to add is created on a high-availability host, you can
use an existing VLAN ID or create a new VLAN ID for the vFiler unit.
Partner
interface

Which partner interface do you want?
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If you are using a high availability host in the setup of the vFiler unit, the partner
interface is selected automatically. If no partner interface is configured, then the
Partner interface column is not visible.
The storage system on which the vFiler unit is created must be configured as an
HA configuration before setting up the vFiler unit.
vFiler
template

Which vFiler template do you want?
You must reselect a vFiler template during setup. A vFiler template is a set of
vFiler configuration settings and the corresponding CIFS configuration settings.
Attention: The Setup vFiler Unit wizard does not remember the vFiler template

used during the vFiler unit creation. If you do not select the vFiler template you
originally used, the network settings are cleared.
CIFS
workgroup
name

What Windows workgroup name do you want for the CIFS setup?
The Windows workgroup name specifies the name of the shared resources. The
workgroup name option is displayed if the following apply:
•
•
•

You select the CIFS protocol.
You select the Perform CIFS setup option.
You do not select a vFiler template, or the template you select does not include
CIFS settings.

If you set up the vFiler unit to use the CIFS protocol, the vFiler units can use the
same computer names as the servers. This enables CIFS clients to share resources
without having to remap their drives or search for the new server.
CIFS domain What CIFS domain user ID and password do you want?
user and
You can enter a login name and password for administrative access to the Active
domain
Directory system. The Domain User and Domain Password options are displayed if
password
the following apply:
•
•
•
Root
password

Script path

You select the CIFS protocol.
You select the Perform CIFS setup option.
You select a vFiler template that specifies Active Directory for CIFS
authentication.

Which vFiler unit root password do you want?
If you did not choose a root password when you created the vFiler unit, you must
choose one before you can use the vFiler unit.
Do you want to use a custom script to help manage vFiler units? If so, what is the
full path of the script?
You can use the script while creating or setting up the vFiler unit.
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Note: If the DataFabric Manager server is running on Windows, and if the post-

setup script for the vFiler unit is on a network share, the script location must be
specified by the full UNC path (no drive letter mapping).
Considerations for high-availability hosts
When you use a high-availability host in the creation or setup of a vFiler unit, you must also
configure storage and a VLAN interface and be aware of other changes that result from the creation
or startup.
•
•
•

•

If you use a high-availability host in creating your vFiler unit, you must configure the storage
systems before creating the vFiler unit.
To ensure appropriate failover behavior, you must configure new IP space and VLAN interface
when creating the vFiler unit.
If you are creating a vFiler unit using nondefault IP space, the NetApp Management Console
provisioning capability moves the partner interface to the nondefault IP space of the primary
vFiler unit.
If you are creating a VLAN as part of the vFiler unit creation or setup, a corresponding VLAN is
set up on the partner interface.

Setting up vFiler unit properties
After you create a vFiler unit, you can configure the CIFS protocol, if you assigned one, or edit the
vFiler unit attributes by using the Setup vFiler Unit wizard.
Before you begin

Have the following information available for the vFiler unit that you want to configure:
•
•
•
•
•
•
•
•
•
•

Allowed protocols
IP address
Network mask
Network interface
VLAN ID information (optional in an HA configuration)
Partner interface to use in an HA configuration
vFiler template name
Root password
CIFS Windows Workgroup Name or Active Directory Domain User and Domain Password
Script path (optional)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > vFiler Units.
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2. Select a vFiler unit from the list and click Setup to open the Setup vFiler Unit wizard.
You can view the current configuration information of the vFiler to ensure that you do not
override any information you do not want to change.
3. Modify the vFiler attributes that you want to change.
If you assigned the CIFS protocol to the vFiler unit, select the Perform CIFS setup check box to
complete the CIFS domain authentication, then enter the appropriate information.
4. Click Finish.
You can see your changes in the details section of the vFiler Units window.
Related concepts

Decisions to make before setting up vFiler unit properties on page 263
Considerations for high-availability hosts on page 265
Migration operations on page 551
Dataset storage space management on page 81
Related references

Administrator roles and capabilities on page 54
Editing storage system properties
You can change the login or NDMP credentials of storage systems and you can add licenses to
storage systems that are managed by NetApp Management Console. The storage system properties
sheet is particularly useful for modifying the credentials for multiple systems at one time.
Before you begin

If you do not have the proper privileges, you cannot select the credentials or licenses in the storage
system property sheet.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > Storage Systems.
2. Select a host name from the host list.
If you have hosts that use the same user name and password, you can select multiple hosts to
configure the same credentials on all the selected hosts. License information can only be edited
on one host at a time.
3. Click Edit to open the properties sheet for the selected host.
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You can edit the login credentials and the NDMP credentials for the selected host or add licenses
to the host.
4. Verify that the changes you made to the storage system have been implemented.
You can view the properties information provided in the Storage Systems Hosts window.
Result

The host credentials are updated in the DataFabric Manager database. It might take several minutes
for the updated status to be reflected in the Login Credentials field for each selected host.
Related references

Administrator roles and capabilities on page 54
Editing Open Systems SnapVault properties
You can change the NetApp Host Agent password or the NDMP credentials for the Open Systems
SnapVault hosts that are managed by NetApp Management Console.
Before you begin

If you are editing an Open Systems SnapVault host that resides on a VMware ESX 3.5 server, see the
guidelines for editing an Open Systems SnapVault host on a VMware ESX 3.5 server.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select an Open Systems SnapVault host name from the host list.
If you have hosts that use the same user name and password, you can select multiple hosts to
configure the same credentials on all the selected hosts.
3. Click Edit to open the properties sheet for the selected host.
Note: The default NetApp Host Agent user name is "admin", which cannot be changed.

4. Verify that the changes you made to the host have been implemented.
You can view the properties information provided under Hosts > OSSV.
Result

The NDMP credentials for the selected host are updated in the DataFabric Manager database. It
might take several minutes for the updated status to be reflected in the NDMP Credentials field for
the selected host.
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Related references

Guidelines for adding and editing an Open Systems SnapVault host on an ESX server on page 257
Administrator roles and capabilities on page 54

Managing hosts
You can start and stop host agents, refresh client data, and verify and change host configurations.
Stopping Open Systems SnapVault agents
You can stop the Open Systems SnapVault agent to perform maintenance on one or more selected
clients or to reconfigure Open Systems SnapVault. When troubleshooting protection errors on a
client running Open Systems SnapVault, stopping and then restarting the Open Systems SnapVault
agent might solve the problem.
Before you begin

The client must be running the Open Systems SnapVault 2.3 or later agent and NetApp Host Agent
2.3.1 or later.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

There is no Open Systems SnapVault plug-in for Solaris. Therefore, management tasks such as start
and stop of the Open Systems SnapVault agent cannot be performed from NetApp Management
Console on Solaris systems.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select one or more Open Systems SnapVault clients.
3. Click Stop.
Note: Stopping the Open Systems SnapVault agent on a client causes the backup service on
that client to stop. Be sure to restart the agent if you want to resume backup protection.

Starting Open Systems SnapVault agents
When you are troubleshooting protection errors on a client running Open Systems SnapVault,
stopping and then restarting the Open Systems SnapVault agent might solve the problem.
Before you begin

The client must be running the Open Systems SnapVault 2.3 or later agent and NetApp Host Agent
2.3.1 or later.
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You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

There is no Open Systems SnapVault plug-in for Solaris. Therefore, management tasks such as start
and stop of the Open Systems SnapVault agent cannot be performed from NetApp Management
Console on Solaris systems.
If you stop Open Systems SnapVault services to troubleshoot a problem or to perform maintenance,
be sure to restart the Open Systems SnapVault agent when you are ready to resume services.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select one or more Open Systems SnapVault clients.
3. Click Start.
Result

The Open Systems SnapVault agent starts on each selected client, and backup service starts or
resumes on each client according to its schedule.
Refreshing Open Systems SnapVault client data
Data shown in the list of Open Systems SnapVault clients is gathered at regular intervals. If you are
trying to troubleshoot a problem with an Open Systems SnapVault client, you can refresh the data for
that client as needed to view the most current status.
Before you begin

The client must be running the Open Systems SnapVault 2.3 or later agent and NetApp Host Agent
2.3.1 or later.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Select one or more Open Systems SnapVault clients.
3. Click Refresh.
Related references

Administrator roles and capabilities on page 54
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Diagnosing a storage system
You can use the Diagnose Storage Systems wizard to verify the configuration for your storage
system. You can also make necessary changes to some of the storage system properties and enable
SnapMirror and SnapVault licenses from the diagnostics wizard.
Before you begin

When running the diagnostics wizard, it can be useful to have the following information available to
verify for the storage system that you want to diagnose:
•
•
•
•
•
•
•
•

Host Name
Domain Name
IP Address
Licenses that should be enabled for the storage system
SnapMirror Access Control List for the storage system, if licensed for SnapMirror
SnapVault Access Control List for the storage system, if licensed for SnapVault
Login Credentials (user name and password)
NDMP Credentials (user name and password)
Note: The credentials of a vFiler unit always have a status of Not Applicable. This status for a

vFiler unit does not indicate a problem.
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > Storage Systems.
2. Click Diagnose to start the wizard, then verify or modify information as requested in the wizard.
The diagnostics wizard checks the configuration of hosts.
3. Verify that any changes that you made to your host configuration are displayed in the storage
systems list in the Storage Systems Hosts window.
Result

If configuration changes are made to a host from an interface other than NetApp Management
Console, you might need to use the Refresh button to pull those changes into the host list for viewing
in the console.
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Diagnosing an Open Systems SnapVault host
You can use the Diagnose OSSV Host wizard to verify your Open Systems SnapVault configuration
and to make necessary changes to some Open Systems SnapVault properties.
Before you begin

When running the diagnostics wizard, it can be useful to have the following information available to
verify for the Open Systems SnapVault host that you want to diagnose:
•
•
•
•
•
•

Host name
Domain name
IP address
NetApp Host Agent port number
Operating system credentials for the host on which NetApp Host Agent is running, if you would
like to use the DataFabric Manager server to update and manage the credentials for you
NDMP credentials (user name, password, and port number)

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

When diagnosing issues on Solaris systems, note that there is no Open Systems SnapVault plug-in
for Solaris, so the NetApp Host Agent cannot communicate with the Open Systems SnapVault agent.
Therefore, Host Agent Status displays as Not Detected and management tasks such as start and stop
of the Open Systems SnapVault agent cannot be performed from NetApp Management Console.
Steps

1. From the menu bar, click Hosts > OSSV.
2. Click Diagnose to start the wizard.
Verify or modify information as requested in the wizard.
3. Verify that any changes you made are displayed in the hosts list in the OSSV Hosts window.
You might need to refresh the window before you can view the changes in the hosts list.

About secondary space management
You can monitor the space usage in your aggregates and use a wizard to plan and implement tasks to
resolve space issues, including secondary volume migration, backup and Snapshot copy deletion,
volume resizing, and deduplication.
When to use secondary space management
You use the Secondary Space Management wizard to resolve aggregate space shortages when you
are alerted by events, job failure notices, and space status indicators that are displayed in other
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windows of the NetApp Management Console. You can also use the Aggregates window to monitor
and resolve your aggregate space issues before they reach warning level status.
The following windows display warnings and statuses that alert you to aggregate space issues and
provide links to the Aggregates window, from which you can plan and resolve those issues:
•
•

•

Events window
Lists "Aggregate Full" and "Aggregate Almost Full" events.
Resource Pools window Space breakout tab
Lists resource pools that have aggregate space issues and aggregates with "Full" or "Nearly Full"
space status conditions.
Jobs window
Lists protection jobs that have failed due to aggregate space issues.

How the Secondary Space Management wizard works
Before you use the Secondary Space Management wizard to plan and resolve your space
management issues, it is helpful to understand how the wizard works.
Summary of the wizard workflow
The wizard is iterative, which means that instead of moving through all the wizard pages in a linear
path, you move through some of the pages to plan a task for a selected volume. Then the wizard
returns you to the starting page to plan another task.
At any time in the iterative planning process, you can review your planned tasks to see the estimated
space savings in the aggregate. When you have planned all the tasks you want, you can have the
wizard implement all your planned tasks or choose to copy the plan to use later.
Summary of how to create a space management plan
1. Select a volume and task
The Volume and Tasks page displays information about the aggregate space usage, lists the
volumes in the aggregate and space usage information about each volume, and lists the tasks that
are allowed for the selected volume. You select a volume and the task that you want to plan.
2. Provide details for the task and view estimated space reclaimed
The wizard moves you through a series of pages that help you to enter specific information that is
needed to implement the task that you selected. On the Task Summary page, the wizard displays
the estimated amount of space in the aggregate that the task can reclaim.
3. View list of tasks planned and plan another task
When you click Next at the end of a task summary, the task is added to the space management
plan and the wizard returns to the Volume and Tasks page. The aggregate space usage
information is updated to reflect the projected results of the task you just planned. You can plan
as many tasks as you want by adding each additional task to the space management plan.
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Summary of how to implement your space management plan
1. Review all tasks (and optionally revert a task)
When the estimated aggregate space usage resulting from your planned tasks reaches your goal,
you can click Review and Commit on the Volume and Tasks page. This option displays your
entire space management plan and the estimated total amount of space that will be reclaimed.
You can revert any of the planned tasks.
2. Implement all tasks
You can click Finish to have the wizard implement all the tasks in the plan. If you do not want to
implement the plan immediately, you can copy the list of tasks to your management station
clipboard and save it to re-create the space management plan at another time.
Description of secondary space management tasks
The Secondary Space Management wizard enables one or more types of tasks, based on the storage
system configuration and capacities, dataset configuration, protection and provisioning policy
requirements, and vFiler unit configuration of the volumes contained in the selected aggregate.
Delete backups This option deletes selected backups and Snapshot copies on the selected
and/or Snapshot volumes.
copies
The option is enabled for volumes in primary storage and volumes in secondary
storage that are destinations for SnapVault or qtree SnapMirror relationships.
This option is not enabled for volumes that are destinations for volume
SnapMirror relationships because the volumes are read-only.
Resize

This option increases or decreases the size of a volume, within the capacity of
the aggregate. For imported volumes with a space guarantee setting, decreasing
the size of the volume can reclaim space when the volume capacity is under
utilized.
The option is enabled for volumes in primary storage and volumes in secondary
storage that are destinations for SnapVault or qtree SnapMirror relationships.
For volumes in secondary storage that are destinations for volume SnapMirror
relationships, you can only change the actual size of the volume, which is the
size specified when the volume was created.

Deduplication

This option performs deduplication of the data on the selected volumes.
The option is enabled only for volumes in primary storage.

Migrate

This option migrates volumes in secondary or tertiary storage from the selected
aggregate to another aggregate.
Note: This option migrates physical volumes in secondary or tertiary storage.
In contrast, dataset migration migrates the primary node of a dataset (in
primary storage).

The option is enabled for volumes that meet the volume migration criteria.
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Related concepts

Dataset storage space management on page 81
Dataset migration versus volume migration on page 671
Space management for volumes and aggregates
The NetApp Management Console data protection and provisioning capabilities provide several
methods for managing space for volumes and aggregates.
•

•

•

•

Deleting backups and Snapshot copies
As part of a plan to reclaim space on an aggregate, you can use the Secondary Space Management
wizard that you start on the Aggregates window to delete selected backups and Snapshot copies.
Resizing volumes
As part of a plan to reclaim space on an aggregate, you can use the Secondary Space Management
wizard that you start on the Aggregates window, to resize or reallocate data and Snapshot copy
space in selected volumes.
You can also use the Secondary Space Management wizard to plan and implement volume
resizing tasks as part of a space management plan for an aggregate.
Deduplication
As part of a plan to reclaim space on an aggregate, you can use the Secondary Space Management
wizard that you start on the Aggregates window, to perform deduplication on one or more
selected volumes.
You can also perform on-demand deduplication on a volume that you start on the Datasets
window Provisioning tab.
Secondary volume migration
As part of a plan to reclaim space on an aggregate, you can use the Secondary Space Management
wizard that you start on the Aggregates window, to migrate one or more selected volumes (in
secondary or tertiary storage) to another location. After you plan the migration task, the wizard
performs the migration operations.
Secondary volume migration differs from dataset migration because it migrates entire datasets
and vFiler units in primary storage, not individual volumes. You start a dataset migration on the
Datasets window Migration tab) and a vFiler unit migration on the vFiler Units window.

Related concepts

Dataset storage space management on page 81
Overview of tasks for managing storage space on page 82
Related tasks

Editing a provisioning policy on page 624
Adding a provisioning policy on page 621
Assigning or changing a provisioning policy on page 103
Starting on-demand deduplication on page 574
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Related references

Administrator roles and capabilities on page 54
Dataset migration versus volume migration
Dataset migration is different from volume migration in several ways.
If the configuration of the storage elements contained in the specified aggregate support online data
migration, the Secondary Space Management wizard might enable either dataset migration or volume
migration as a possible solution.
Dataset
migration

Dataset migration is an operation that migrates a dataset primary node from one
aggregate to another. You start dataset migration on the Datasets window Migration
tab. Because dataset migration is a logical migration of data and the Secondary Space
Management wizard enables only physical migration of volumes, dataset migration is
not a task in the space management plan created by the Secondary Space
Management wizard.
For your convenience, the Aggregates window provides a link to the Datasets
window Migration tab to allow you to select and migrate datasets that are migration
capable.

Volume
migration

Volume migration is an operation that migrates one or more selected volumes on
secondary or tertiary storage from one aggregate to another, as part of a plan to
reclaim space on an aggregate. You cannot migrate volumes in primary storage. You
start volume migration on the Aggregates window.

Related concepts

Volume migration configuration requirements on page 671
Related references

Dataset migration requirements on page 547
Administrator roles and capabilities on page 54
Volume migration configuration requirements
To enable volume migration as a task in a space management plan for an aggregate, the Secondary
Space Management wizard must discover potential destination aggregates and storage systems that
meet the volume migration requirements.
•

Source volume requirements
Migration source volumes must meet all of the following criteria:
•
•
•
•

No NFS exports on the volume or any of its qtrees
No CIFS shares on the volume or any of its qtrees
No LUNs that are mapped to storage clients exist on the volume or any of its qtrees.
No child clone volumes on the volume
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•
•
•
•
•

No incoming and outgoing protection relationships that are not managed by the NetApp
Management Console data protection capability
The volume is not the root storage of a storage system or vFiler unit.
The volume is a flex vol type.
No pending actions (such as deleting Snapshot copies, resizing, deduplication) are planned on
the source volume during migration.

Destination aggregate requirements
Migration destination aggregates must meet all of the following criteria:
•
•
•
•
•
•

Reside in a resource pool that is associated with the dataset.
Reside on a storage system that meets the necessary license requirements to support the
protection policy.
Reside on a storage system that meets the secondary or tertiary storage provisioning policy
requirements.
Reside on the same storage system as the source volume if the source volume is attached to a
vFiler unit.
Have enough space to accommodate the migrated volume.
If the migration source volume is an Open Systems SnapVault secondary volume, reside on a
storage system that is enabled with the appropriate licenses (for example, sv_vi_pri).

Managing secondary space
You can use the Aggregates window to identify aggregates that have space shortage issues. From this
window you can start the Secondary Space Management wizard, which allows you to plan one or
more tasks for resolving those issues and view the estimated amount of space in the aggregate that
can be reclaimed by implementing those tasks.
Starting secondary space management
You can identify volumes that have space issues, plan actions to resolve those issues, and implement
the selected actions by using the Secondary Space Management wizard.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Steps

1. From the menu bar, click Hosts > Aggregates.
2. Select an aggregate and click Manage space to start the Secondary Space Management wizard.
3. Complete the steps in the wizard to plan and implement tasks to reclaim space on the selected
aggregate.
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Related concepts

How the Secondary Space Management wizard works on page 668
Starting secondary volume migration
As part of a plan to reclaim space on an aggregate, you can use the Secondary Space Management
wizard to migrate volumes in secondary or tertiary storage.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Secondary volume migration is a different process from dataset migration (which you start on the
Datasets window Migration tab) and vFiler unit migration (which you start on the vFiler Units
window).
Steps

1. From the menu bar, click Hosts > Aggregates.
2. Select an aggregate and click Manage space to start the Secondary Space Management wizard.
3. Select Migration and complete the steps in the wizard to plan and implement migration tasks.
Note: The Migration task is enabled only for volumes that meet the secondary volume

migration requirements.
Related concepts

How the Secondary Space Management wizard works on page 668
Volume migration configuration requirements on page 671
Related references

Administrator roles and capabilities on page 54

Managing vFiler unit migration
You can migrate a vFiler unit to another storage system. If your storage strategy is focused on vFiler
units as containers for datasets; you can migrate a vFiler unit when one or more datasets are
completely contained by that vFiler unit.
Related concepts

Migration operations on page 551
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vFiler unit migration requirements
A vFiler unit must meet certain requirements before you can migrate its data to another vFiler unit.
Basic automated migration requirements for all vFiler units
The following requirements apply to any vFiler unit that you want to migrate.
•
•
•
•
•
•
•

The vFiler unit cannot own volumes that are destinations of backup or mirror relationships.
All qtrees contained by the vFiler unit must be in a volume that belongs to the vFiler unit. The
exception is a qtree that contains root storage for the vFiler unit.
A vFiler unit that has its root storage as a qtree in a volume that is not owned by the vFiler unit
can be migrated. However, the backup Snapshot copies of that qtree cannot be migrated.
Both source and destination storage systems must be configured to support migration.
The vFiler unit limits for the destination storage system cannot be at a maximum level.
A name conflict cannot exist between a source volume and any volume on the destination storage
system.
Space must be available for all the source volumes on the destination storage system.

Automated migration requirements for vFiler units enabled for offline migration only
In addition to the basic requirements, the following requirements apply for offline migration:
•
•

The source and destination storage systems must run Data ONTAP 7.3.1 or later.
The source and destination storage systems must be licensed for SnapMirror and MultiStore.

Automated migration requirements for vFiler units enabled for online migration
In addition to the basic requirements, the following requirements apply for online migration:
•
•
•

•
•
•
•
•

The vFiler unit must contain volume members only.
The source and destination storage systems must run Data ONTAP 7.3.3 or later.
The source and destination storage systems must be licensed for synchronous SnapMirror and
MultiStore.
A special license key to support synchronous SnapMirror, must be enabled by the command
license add KZZTWOJ command on the source and destination storage systems.
All volumes to be migrated (except for vFiler root volume) must be 10 GB or larger.
The maximum number of volumes that a vFiler unit enabled for online migration can contain
depends on the storage system model on which it resides.
The vFiler unit cannot be in a non-default IPspace.
None of the migrated data can reside on storage systems that use ATA type disks.
No unbroken synchronous SnapMirror relationships can exist on the source volumes at the start
of migration.
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Decisions to make before starting vFiler unit migration
Before you start a vFiler unit migration by using the vFiler Unit Migration wizard, it is useful to have
ready all the migration information for the vFiler unit.
Dataset
migration
commands or
vFiler unit
migration
commands

Are you migrating a dataset or a vFiler unit?
•

•

•

Online or
offline
migration

If there is a direct one-to-one correspondence between a dataset and a vFiler
unit, you may use either the dataset migration commands or the vFiler unit
migration commands.
If a vFiler unit contains more than one dataset, and the storage for each dataset
is completely owned by the vFiler unit, you should use the vFiler unit
migration commands.
If a vFiler unit contains more than one dataset, but the storage for at least one
of the datasets is owned by more than one vFiler unit, you should use the
dataset migration commands for each separate dataset.

Are you performing online or offline migration?
•

•

If you perform online migration, the complete migration of data from the
source to target locations can be carried out non-disruptively, with no
shutdown required during the migration cutover operation.
If you perform offline migration, the data undergoing migration is unavailable
during the cutover phase of the migration process.
Note: Online migration requires additional configuration compatibility.

What is the destination storage system for the migrated vFiler unit?
Destination
storage system
The wizard displays a list of the storage systems, from which you can select the
destination storage system.
Note: Because you can select storage systems that are not in the resource pool,
the vFiler unit might not be in conformance after the migration. To avoid
nonconformance, you can add the storage system to the resource pool before
starting the migration.

Volume
aggregate
mappings

How many volumes do you want to migrate to the specific aggregate of the
destination storage system?

Interface
selections

What interfaces do you want to use?

By default, the system maps the volumes to be migrated to the aggregates of the
destination storage system.

You can select from a list of prepopulated IP addresses that displays the
associated network mask and Interface values and the prepopulated VLAN ID for
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each. Or you can modify the IP addresses, network mask values, and VLAN IDs,
or you can add additional ones. You can customize the MTU size for the VLAN.
Note:

The value for network mask is displayed as its prefix length. If you want to
change the value, you can enter it as prefix length (for example: 24) or as
dotted notation (for example: 255.255.255.0)
Valid prefix length values are 1-31 for IPv4 and 1-127 for IPv6.
Valid dotted notation values are the dotted notation equivalents of the valid
prefix lengths.
Bandwidth
limit

Do you want to limit the network bandwidth used by the NetApp Management
Console provisioning capability to carry out the vFiler unit migration?
The default is no bandwidth limit.

Automatic
cutover

If performing online migration, do you want to enable the option to start
automatic cutover at the end of the migration start operation?

Migration of
network routes
(If you enable
Automatic
cutover)

If you enable automatic cutover, how do you want to migrate your vFiler unit's
network route information?
The vFiler unit's network route information is contained in its IPspace and in
its /etc/rc file.
Migration of the source vFiler unit's network route information to destination
vFiler unit is necessary to maintain undisrupted client connectivity after
automatic cutover.
If you enable automatic cutover, the vFiler Unit Migration wizard allows you to
select from the following alternatives to migrate the network route information:
•

•

•

Migrate all static routes that are present in the source vFiler unit's IPspace.
This alternative requires no manual procedures to maintain vFiler unit
connectivity with all clients during migration and cutover.
Migrate only the persistent routes that are stored in the source vFiler
unit's /etc/rc file.
This alternative requires that you manually add any non-persistent route
through which you want to maintain an uninterrupted client connection to the
etc/rc file of the source vFiler prior to running the vFiler Unit Migration
wizard.
Migrate none of the source vFiler unit's network route information.
You might select this alternative if you are migrating to an existing vFiler unit
destination that you know already has the necessary network route
information configured or if you are migrating a vFiler unit whose network
route information you wish to configure manually after migration.
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The wizard also allows you to store all migrated static routes as persistent routes
in the destination vFiler unit's /etc/rc file.
Related concepts

Migration operations on page 551
Starting a vFiler unit migration
You can begin migration of a vFiler unit by initiating the migration start operation, which starts the
vFiler Unit Migration wizard and begins a baseline transfer of data from the source to destination
location.
Before you begin

Have available the information that you need to complete this task:
•
•
•
•

•
•
•
•

Destination storage system (required)
If mapping the volumes to the aggregates of the destination storage system, have the mapping
ready.
Interface to which the IP address will be bound to the destination storage system and the VLAN
ID (required)
Physical VLAN interface on which the VLAN will be created if VLANs are created during
migration for the partner of the destination storage system (required if the destination storage
system has an HA configuration)
The amount of available network bandwidth to make available for the baseline data transfer from
the source to destination locations.
Online or offline mode of migration to use.
If using online migration mode, whether or not to use automatic cutover at the end of the
Migration start operation.
If enabling automatic cutover, whether to migrate all network route information or just persistent
network route information to the destination vFiler unit.

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

You can cancel a vFiler unit migration anytime during the migration start operation.
Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Select a vFiler unit and click Start migration to start the vFiler Unit Migration wizard.
3. Complete the steps in the wizard to start the migration.
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On the Interface Selection page of the wizard, you can specify a VLAN ID to create a tagged
interface. However, you can tag only the base interfaces that are down.
Note: If you modify the prepopulated interfaces, you might cause the vFiler unit migration to
be offline instead of online.

To add more interfaces, click Add. To delete an interface, select it and click Delete.
You can check the job progress displayed in the Tracking Dataset Migration Job display popup
window or you can move the popup window to the background and track the job progress in the
Jobs window.
Result

The vFiler Unit Migration executes the migration start baseline transfer of data from the migration
source location to the migration target location.
Note: This process might be completed within a few minutes to a few weeks depending upon the
amount of data to be migrated and the available bandwidth to carry it out.

•

•

If you are running migration in offline mode, or in online mode with automatic cutover disabled,
the NetApp Management Console provisioning capability pauses when the baseline transfer is
complete and assigns the migrating dataset the status "Started, cutover required."
If you are running migration in online mode and with automatic cutover enabled, the NetApp
Management Console provisioning capability will automatically begin the cutover operation
when the migration baseline transfer finishes.

After you finish

•
•
•

If you are running migration in offline mode or if you are running migration in online mode but
with automatic cutover disabled, you must manually initiate the migration cutover operation.
If after the baseline data transfer is complete, you feel that you need to run an incremental update
to the migration destination, you can do so before you start migration cutover.
If you are running migration in online mode with automatic cutover enabled, the next action after
automatic cutover is complete is to consider cleanup of the source location.

Related concepts

Decisions to make before starting vFiler unit migration on page 675
Migration operations on page 551
Related tasks

Updating vFiler unit migration SnapMirror relationships on page 679
Cutting over to the new vFiler unit destination on page 680
Rolling back a vFiler unit migration on page 682

Provisioning Help | 679
Related references

Administrator roles and capabilities on page 54
Updating vFiler unit migration SnapMirror relationships
If you are migrating in offline mode, or in online mode with automatic cutover not enabled, after the
migration start operation finishes, you can initiate an on-demand update of the SnapMirror
relationships that were created as part of the migration start operation. This is an optional step in the
vFiler migration process.
Before you begin

Verify that the vFiler unit's migration status is "Started, cutover required."
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

This operation is useful if a scheduled update fails, which causes the lag time of the SnapMirror
relationships to increase to an undesirable length.
Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Select a vFiler unit and click Update to update the SnapMirror relationships that were created as
part of the migration start operation.
3. Click Yes in the confirmation dialog box to begin the operation.
You can track the progress of the operation in the Jobs window.
After you finish

To continue the migration, you must manually initiate the migration cutover operation at a
convenient time.
Related concepts

Migration operations on page 551
Dataset storage space management on page 81
Space management resize options on page 83
Related tasks

Cutting over to the new vFiler unit destination on page 680
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Related references

Administrator roles and capabilities on page 54
Cutting over to the new vFiler unit destination
After the migration start operation finishes, you can initiate the migration cutover operation to switch
the old destination from which the data is served to the new destination and update the SnapMirror or
synchronous SnapMirror relationships.
Before you begin

•
•
•

Verify that the vFiler unit's migration status is "Started, cutover required."
If you are executing migration in offline mode, you must shut down all applications that use the
dataset during the cutover process.
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

About this task

You might want to initiate this operation at a time when the vFiler unit has a very low level of
activity.
Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Select a vFiler unit and click Cut over.
3. (Optional) In the Cut over wizard, you can enter the name of a script to be executed.
For example, a script might quiesce an application and then resume the application.
4. Click Cutover in the confirmation dialog box to begin the operation.
The SnapMirror relationships are converted to synchronous mode before the migration complete
operation begins.
Result

After access to the data is switched over to the vFiler unit on the destination storage system, the
backup versions, backup relationships, and DataFabric Manager history for the volumes are
transferred to the destination storage system.
After you finish

•
•

If you performed offline migration in offline mode and quiesced your applications before starting
cutover, you must now restart all applications that use the migrated dataset.
Wait a few days to verify the viability of the migrated data at its destination location before
starting the cleanup operation.
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•
•

If you decide to keep the migrated data at its destination location, you can initiate migration
cleanup at the original source location.
If you decide to reverse the migration restore data availability it to the former location, you can
start the rollback operation.

Related concepts

Migration operations on page 551
Related tasks

Cleaning up a vFiler unit migration on page 681
Related references

Administrator roles and capabilities on page 54
Cleaning up a vFiler unit migration
After the migration cutover operation finishes, and you have waited a few days to verify the viability
of the data migrated to its new location, you can initiate the migration cleanup operation to delete the
old storage.
Before you begin

Verify that the vFiler unit's migration status is "Migrated, cleanup required."
You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
About this task

Start migration cleanup only after you verify that the newly migrated data is viable at the destination
location and you are certain that migration rollback to the original source location is not necessary.
Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Select a vFiler unit and click Cleanup.
The Migration Cleanup confirmation dialog box lists the volumes on the old destination that will
be deleted.
3. Click Apply in the confirmation dialog box to begin the operation.
After you finish

To complete the migration process, you must manually perform the following cleanup tasks using an
application like FilerView (if the VLANs and IPspaces are not shared):
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•
•

Delete dynamic references in the old source dataset.
Delete VLANs and IPspaces used by the old source vFiler unit.

Related concepts

Migration operations on page 551
Related references

Administrator roles and capabilities on page 54
Rolling back a vFiler unit migration
You can roll back a vFiler unit migration at any time when the status is "migrated, cleanup required."
When you roll back a vFiler unit migration, the NetApp Management Console provisioning
capability aborts all ongoing transfers and deletes all the provisioned storage on the destination
storage system and on the destination vFiler unit.
Before you begin

•
•

Verify that the vFiler unit's migration status is "Migrated, cleanup required."
You must be authorized to perform all the steps of this task; your RBAC administrator can
confirm your authorization in advance.

Steps

1. From the menu bar, click Hosts > vFiler Units.
2. Select a vFiler unit and click Roll back to start the Roll back wizard.
3. After you complete the wizard, click Finish.
Viewing vFiler unit migration status
You can view the status of a vFiler migration operation in the vFiler Units window.
Before you begin

You must be authorized to perform all the steps of this task; your RBAC administrator can confirm
your authorization in advance.
Step

1. From the menu bar, click Hosts > vFiler Units.
The status is displayed in the "Migration status" column.
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Dashboards > Provisioning
The Provisioning Dashboards window provides cumulative at-a-glance status information for space
management issues related to datasets and resource pools. You can view further detail on the Help
page accessible from each dashboard panel.
You must be assigned the appropriate privileges to view the dashboard panels.
Dataset
Conformance
Status

Displays the total number of dataset members that are conforming to
associated policies. Values can be Conformant or Nonconformant.

Top Five Events

Displays the five events with the highest severity levels, ordered by time.
More detail about each event is provided in the Events window.

Dataset Resource
Status

Displays the number of datasets at different levels of resource status severity.
The status represents the worst event severity of all current events on all
direct and indirect members of the dataset nodes. Values are Emergency,
Critical, Error, Warning, or Normal.

Dataset Space
Status

Displays the total number of datasets being managed by NetApp
Management Console, grouped according to their current space status value.
The status represents the worst space status of all members in all nodes of the
dataset. Events are generated at the dataset level when the space status of a
dataset changes. Values can be Error, Warning, Normal, or Unknown.

Resource Pool
Space Status

Displays the total number of resource pools that currently meet or exceed the
space thresholds. Values are Full, Nearly Full, Overcommitted, and Nearly
Overcommitted.

Resource Pools

Displays, by resource pool name, the total space allocated to and the space
utilization for each resource pool. Total Size values are indicated in numbers,
such as gigabytes or terabytes. Utilization is indicated in percentage of the
Total Size. Items are sorted by utilization percentage.

on the title bar of each dashboard panel to replace the work area with another window
Click
related to the content of the panel.
Click
on a row of a dashboard panel to replace the work area with a window related to the
content of the panel, with information highlighted that is relevant to that specific row in the panel.
You can filter the content of the dashboard panels, to focus on specific groups of datasets or resource
pools, by using the Group selection list on the console tool bar.
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Dashboards > Provisioning > Dataset
Conformance Status
You can use the Dataset Conformance Status panel to view how many datasets are either conformant
or nonconformant with their policies.
Status descriptions
Conformance status indicates if all members of a dataset are conforming to all of the policies
associated with the dataset.
Conformant

Status is normal. The dataset is conformant with all associated policies.
A dataset is considered conformant if it is configured according to the dataset's
protection policy and the provisioning policies attached to nodes of the dataset.

Conforming

Status is warning. The dataset is not in conformance with all associated policies.
The NetApp Management Console provisioning capability is performing actions
to bring the dataset into conformance.

Nonconformant Status is in error. The NetApp Management Console provisioning capability
cannot bring the dataset into conformance with all associated policies and might
require your approval or intervention to complete this task.
Click

beside the dashboard panel title to replace the work area with the Datasets window.

You can filter the content of some of the dashboard panels by using the Group selection list on the
NetApp Management Console tool bar. This option allows you to focus on information about a
particular group, such as specific datasets or resource pools.
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Dashboards > Provisioning > Dataset Resource
Status
You can use Dataset Resource Status panel to view the overall status of all resources in a dataset.
Status Descriptions
This dashboard panel displays the number of datasets that are at different levels of resource status
severity. The status represents the worst event severity of all current events on all direct and indirect
members of the dataset nodes.
Note: If a status value is zero, the status item does not display in the dashboard panel.

Severity levels include the following.
Emergency The resource unexpectedly stopped working and experienced unrecoverable data loss.
You must take corrective action immediately to avoid extended downtime.
Critical

A problem occurred that might lead to service disruption if you do not take immediate
corrective action.

Error

The resource is still performing, but corrective action is required to avoid service
disruption.

Warning

The resource experienced an occurrence that you should be aware of. This event
severity does not cause service disruption, and corrective action might not be required.

Normal

A previous abnormal condition for the resource returned to a normal state and the
resource is operating within the desired thresholds. No action is required.

Unknown

Qtrees without quotas and non-qtree data will have resource status as Unknown.

Click

beside the dashboard panel title to replace the work area with the Datasets window.

You can filter the content of some of the dashboard panels by using the Group selection list on the
console tool bar. This option allows you to focus on information about a particular group, such as
specific datasets or resource pools.
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Dashboards > Provisioning > Resource Pool
Space Status
You can use the Resource Pool Space Status panel to view the number of resource pools that have
exceeded or are about to exceed assigned space thresholds.
Status Descriptions
Note: If a status value is zero, the status item does not display in the dashboard panel.

Full

Indicates the number of resource pools for which the used space has reached the Full
threshold set for that resource pool. The amount of used space is determined based
on the total used space for all aggregates in each resource pool.

Member
Full

Indicates the number of resource pools that contain a storage member for which the
used space has reached the Full threshold set for that storage member.

Nearly Full

Indicates the number of resource pools for which the used space has reached the
Nearly Full threshold set for that resource pool. The amount of used space is
determined based on the total used space for all aggregates in each resource pool.

Member
Nearly Full

Indicates the number of resource pools that contain a storage member for which the
used space has reached the Nearly Full threshold set for that storage member.

Normal

Indicates the number of resource pools for which the total used space in the resource
pools is below the Resource Pool Nearly Full threshold and the used space for each
storage member in the resource pool is also below its Nearly Full threshold. Total
used space is the sum of used space of all aggregates in each resource pool.

Click

beside the dashboard panel title to replace the work area with the Resource Pools window.

You can filter the content of some of the dashboard panels by using the Group selection list on the
console tool bar. This option allows you to focus on information about a particular group, such as
specific datasets or resource pools.
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Dashboards > Top Five Events
You can use the Top Five Events panel to view the five most severe events listed in the Events
window and the source to which each event applies. The columns are ordered first by severity, then
by time of the events.
Click
beside the dashboard panel title to replace the work area with the Events window.
Descriptions of the events are provided in the online Help page for that window.
Click
on a row of the Top Five Events panel to replace the work area with the Events window,
with information highlighted that is relevant to the selected row in the dashboard panel.
You can filter the content of some of the dashboard panels by using the Group selection list on the
console tool bar. This option allows you to focus on information about a particular group, such as
specific datasets or resource pools.
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Dashboards > Resource Pools
You can use the Dashboards > Resource Pools to view the total space allocated to and the
percentage of space utilized by each resource pool, listed by resource pool name.
Total Size values are indicated in numbers, such as gigabytes or terabytes. Utilization is given in
percentages of the total allocated space per resource pool. Items are sorted in decreasing order of
available space.
Click

beside the dashboard panel title to replace the work area with the Resource Pools window.

on a row of a dashboard panel to replace the work area with the Resource Pools window,
Click
with information highlighted that is relevant to the selected row in the dashboard panel.
You can filter the content of some of the dashboard panels by using the Group selection list on the
console tool bar. This option allows you to focus on information about a particular group, such as
specific datasets or resource pools. When you select a group filter, only relationships originating or
terminating at an object in the selected group are listed.
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Dashboards > Provisioning > Dataset Space
Status
You can use the Dataset Space Status panel to view how many datasets are at different levels of
severity based on space available for the dataset.
Status Descriptions
The dataset space status indicates if there are any dataset members with volumes that are running out
of space, qtrees that are running out of quota, Snapshot copies that are exceeding the reserved space,
and so forth. The status represents the worst space status of all members in all nodes of the dataset.
Events are generated at the dataset level when the space status of a dataset changes. Space status is
calculated for a dataset only if a provisioning policy has been associated with the dataset node.
Note: If a status value is zero, the status item does not display in the dashboard panel.

Error

The event source is still performing, but corrective action is required to avoid service
disruption.

Warning The event source experienced an occurrence that you should be aware of. Events of this
severity do not cause service disruption and corrective action might not be required.
Normal

A previous abnormal condition for the event source returned to a normal state and the
event source is operating within the desired thresholds.

Unknown The space status is not known. A number of conditions result in an Unknown state,
including:
•
•
•

No provisioning policy attached to the dataset node
Non-qtree data and qtrees without hard disk limits
LUNs in a SAN environment, because there are no usage statistics for LUNs

Click
beside the dashboard panel title to replace the work area with the Provisioning tab on the
Datasets window.
You can filter the content of some of the dashboard panels by using the Group selection list on the
console tool bar. This option allows you to focus on information about a particular group, such as
specific datasets or resource pools.
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Data > Resource Pools
You can use the Resource Pools window to create, view, and modify collections of physical storage
resources, called resource pools.
•
•
•
•
•
•

Command buttons on page 690
Resource pools list on page 690
Space Breakout tab on page 692
Details tab on page 692
Dependencies tab on page 693
Window customization on page 693

When a resource pool is assigned to a dataset, data management applications use the resources in the
resource pool to provision storage containers as needed by the dataset and according to the settings
defined in policies assigned to the dataset.
Command buttons
Add

Starts a wizard that helps you create a new resource pool.

Edit

Opens the properties window for the selected resource pool. From the properties window
you can modify the settings (Name, Description, Contact, Owner), assigned resources,
labels, or space thresholds of an existing resource pool.

Delete Displays a dialog box that asks you to confirm that you want to delete the selected resource
pool. You can either proceed with deleting the selected resource pool or cancel the activity.
Deleting a resource pool currently assigned to a dataset also deletes any relationships
created in accordance with a policy assigned to that dataset. Deleting a resource pool does
not delete the physical resources that were in the resource pool.
Resource pools list
Displays key property settings and space management information for each resource pool.
Name

The name assigned to the resource pool.

Total Size

The total amount of storage space assigned to the resource pool.

Used Size

The space in the resource pool that is currently used, expressed in KB, MB, GB,
or TB. By default, this field is not displayed. You can click
column-display menu.

to select it from the

Available Size The amount of storage space available in the resource pool.
Note: Available Size does not include storage system spare disk capacity.
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Space Status

The status of the space in the resource pool and the members in the resource pool.
Valid values are as follows:
Full

Indicates the number of resource pools for which the used space
has reached the Full threshold set for that resource pool. The
amount of used space is determined based on the total used space
for all aggregates in each resource pool.

Member
Full

Indicates the number of resource pools that contain a storage
member for which the used space has reached the Full threshold
set for that storage member.

Nearly Full Indicates the number of resource pools for which the used space
has reached the Nearly Full threshold set for that resource pool.
The amount of used space is determined based on the total used
space for all aggregates in each resource pool.
Indicates the number of resource pools that contain a storage
Member
Nearly Full member for which the used space has reached the Nearly Full
threshold set for that storage member.
Normal

Indicates the number of resource pools for which the total used
space in the resource pools is below the Resource Pool Nearly
Full threshold and the used space for each storage member in the
resource pool is also below its Nearly Full threshold. Total used
space is the sum of used space of all aggregates in each resource
pool.

Utilization

The percentage of total storage space that is used in the resource pool.

Owner

The person who maintains or is responsible for the resource pool; for example, an
administrator. By default, this field is not displayed. You can click
from the column-display menu.

to select it

Description

A user-specified description that identifies the resource pool.

Time Zone

The time zone that is applied to the resource pool. By default, this field is not
displayed. You can click

to select it from the column-display menu.

Note: If a resource pool is assigned to a dataset using a protection policy, the
time zone you select can impact the protection schedule. Make sure that you
understand the potential impact to any of your schedules before changing the
Time Zone property.

Resource
Label

An optional text string that is used in provisioning requests as a filter for specific
resources. By default, this field is not displayed. You can click
the column-display menu.

to select it from
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Space breakout tab
Displays information about the aggregates in the selected resource pool. If you select one or more
resource pools, the aggregates associated with each selected resource pool are displayed.
Aggregates
list

The aggregates in the selected resource pool.
Aggregate

The aggregate name.

Total Size

The total size of the aggregate.

Used Size

The space in the aggregate that is currently used, expressed in
KB, MB, GB, or TB. By default, this field is not displayed.
You can click

to select it from the column-display menu.

Committed Size The space in the aggregate that is currently committed,
expressed in KB, MB, GB, or TB. By default, this field is not
displayed. You can click
display menu.

Aggregate
properties

Aggregate
datasets

to select it from the column-

Available Size

The amount of uncommitted space that is still available in the
aggregate. This value is expressed in KB, MB, GB, or TB.

Utilization

The percentage of the aggregate space that is used. Aggregates
with space problems are highlighted in red.

The properties of the selected aggregate in the selected resource pool.
Name

The name of the aggregate.

Committed
Size

The amount of space guaranteed to the volumes contained in the
aggregate. This value can be higher than the total size of the
aggregate If you are using the aggregate overcommitment
strategy. This value is expressed in KB, MB, GB, or TB.

Information about the datasets in the selected aggregate.
Dataset

The names of datasets in the selected aggregate. If an
aggregate is running out of space, you can use this list to
choose which dataset to migrate.

Used space from
aggregate

The amount of space on the aggregate that is used by the
dataset.

Details tab
Displays detailed information about the selected resource pool.
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Resource pool
properties

The properties of the selected resource pool.
Owner

The person who maintains or is responsible for the resource
pool.

Time zone

The time zone that is applied to the resource pool.

Total size

The total amount of space currently being used by the
resource pool.

Resource label The user-specified text string assigned to this resource pool.
Resource
diagram area

This area displays an expandable tree view of the physical resources assigned to
the selected resource pool.

Dependencies tab
Displays the datasets, if any, that use the selected resource pool and lists whether those datasets are
capable of migration.
Dataset

The datasets with which the selected resource pool is associated.

Migration capable

Whether the dataset configuration enables migration.

Remaining number of
migration-enabled datasets
allowed

The number of additional datasets in the selected resource pool that
can be configured for data migration.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Custom Fields
You can use the Custom Fields window to add, edit, and delete custom fields that are assigned to
specified object types.
•
•

Command buttons on page 694
Custom Fields list on page 694

Command buttons
Add

Opens a dialog box for adding a new custom field.

Edit

Opens a properties sheet for modifying the selected custom field name or the object types
to which the custom field is assigned.

Delete Deletes the selected custom field from all object types.
Custom Fields list
Displays a list of all the custom fields.
Name

The name of the custom field.

Object Types The object types to which the selected custom field is assigned. Custom fields can
be assigned to multiple object types. Valid object types are datasets (including
application datasets), protection policies, and provisioning policies.
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Policies > Provisioning
You can use the Provisioning Policies window to view, add, edit, copy, or delete provisioning
policies.
•
•
•
•
•

Command buttons on page 695
Policies list on page 695
Details tab on page 696
Dependencies tab on page 698
Window customization on page 698

Command buttons
Add

Starts the Add Provisioning Policy wizard, which allows you to configure and add a new
provisioning policy.

Edit

Opens a window in which you can modify the properties of the selected provisioning
policy.

Copy Copies the selected provisioning policy and adds the copy as a new provisioning policy.
Delete Opens a confirmation dialog box that you use to verify whether you want to delete the
selected policies. You can delete a provisioning policy only if it has no dependencies: in
other words, if the policy is not assigned to any datasets.
Policies list
Displays the currently configured provisioning policies. The list is updated dynamically when the
status changes. You can customize the display as follows:
Name

The name assigned to a provisioning policy.

Storage Type

The type of storage that the policy is configured to support:
NAS

The policy provisions NAS storage and exports storage for NAS
access. NFS and CIFS protocols are supported.

SAN

The policy provisions SAN storage and exports storage for SAN
access. FC and iSCSI protocols are supported.

Secondary The policy provisions storage for secondary (backup or mirror)
node.
Description

An optional description of the provisioning policy. It might include the intended
use of the provisioning policy or some other common attribute that identifies why
the provisioning policy was created.
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Resource
Label

An optional text string that is used in provisioning requests as a filter for specific
resources. Only storage resources that match the label are used for provisioning.
To display this column, click

in the upper-right corner of the policies list.

Details tab
Displays detailed configuration information about the selected policy. Only the properties applicable
to the selected policy are displayed.
Name

The name assigned to the selected provisioning policy.

Space
utilization
properties (for
NAS storage
only)

The space and capacity settings for NAS storage.

Quota settings
(for NAS
storage only)

Guarantee space
for dataset

If this option is enabled, the requested space is guaranteed
for data and for Snapshot copies and guaranteed from the
resource pool or pools associated with the dataset.
Therefore, writes to a specified FlexVol volume or writes
to files with space reservations enabled cannot fail because
of a lack of available space in the containing aggregate.
If this option is disabled, the space is allocated on demand
as data or Snapshot copies are written to datasets; some
write requests might fail.

Reserve space
for Snapshot
copies

If this option is enabled, an additional 20 percent of the
requested space is provisioned from the resource pool or
pools for Snapshot copies for every provisioned member
in the dataset. This guarantees that Snapshot copies cannot
fail because of a lack of disk space.
If this option is disabled, no additional Snapshot copy
space is provisioned and Snapshot copies might fail if
there is not enough space available.

Guarantee
maximum size

If this option is enabled, the maximum size of the
requested space is guaranteed from the resource pool or
pools associated with the dataset.

Increase
container size
automatically

If this option is enabled, the initial space is guaranteed
from the resource pool or pools associated with the
dataset; the maximum space is allocated when needed.
Snapshot copies are automatically deleted when additional
space is needed. This option is available only for storage
systems that are running Data ONTAP 7.3.1 or later.

The default size of user quotas and group quotas. Quotas limit resource usage
and provide notification when resource usage reaches specified levels.
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SAN container
properties (for
SAN storage
only)

The SAN container type to be used for provisioning, as well as additional
provisioning details:
Type of container The SAN container type to be used for provisioning:
Volume or LUN.
to provision
Space for data

Guaranteed Space for data is guaranteed on the SAN
container.
On demand Space for data is not guaranteed on the
SAN container. Space might need to be
allocated manually.

Space for
Snapshot copies

Guaranteed Space for Snapshot copies is guaranteed
on the SAN container.
On demand Space for data is not guaranteed on the
SAN container; the container is
automatically increased when additional
space for Snapshot copies is needed.

Delete oldest
Snapshot copies
automatically

Space
utilization
thresholds

If this option is enabled and a storage container needs
more space, the Data ONTAP autosize option is used
to automatically delete Snapshot copies to make more
space available. To use this option, your storage must be
using Data ONTAP 7.2.4 or later.
If this option is disabled, Snapshot copies are not
automatically deleted when a storage container needs
more space; therefore, you might need to delete them
manually.

Whether the NetApp Management Console provisioning capability generates
space utilization events when a threshold is reached and, if so, the threshold
settings for the Full and Nearly Full thresholds. The NetApp Management
Console provisioning capability uses the thresholds to compute dataset space
status and generate events.
Generate space
utilization
events

If this option is enabled, event notifications are generated
when a space threshold is reached.
If this option is disabled, no event notifications are
generated when a space threshold is reached.

Nearly Full
threshold

The percentage of the maximum size of a dataset at which
a Nearly Full threshold event notification is generated.
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Full threshold

Provisioning
Script
Deduplication
properties

The percentage of the maximum size of a dataset at which
a Full threshold event notification is generated.

The full DataFabric Manager server path of a provisioning script that performs
custom tasks after storage is provisioned.
Deduplication
status

Whether or not deduplication is enabled on the dataset node
that is assigned the selected provisioning policy.

Deduplication
schedule

The mode of deduplication, if any, that is enabled for the
selected policy.
Manual Indicates that on-demand deduplication mode
(in which deduplication is not scheduled but is
carried out only when you click Dedupe Now)
is enabled on the dataset node that is assigned
the selected provisioning policy.
Auto

Indicates that automated deduplication mode (in
which deduplication is started automatically
based on the amount of new data in the volume)
is enabled on the dataset node that is assigned
the selected provisioning policy.

Custom Indicates that scheduled deduplication mode (in
which deduplication is implemented on a
customized schedule) is enabled on the dataset
node that is assigned the selected provisioning
policy.

Dependencies tab
Displays all of the datasets that are provisioned using the selected policy.
Dataset Name The name of a dataset or dataset member to which the selected provisioning policy
is assigned.
Dataset Node The type of storage node: primary storage node or secondary storage node.
Window customization
You can modify the layout of the window by using a variety of customization options.
•

You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.

and

), and then use the
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•

You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.

•

You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.

•
•
•
•
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Policies > vFiler Templates
You can use the vFiler Templates window to view, add, edit, copy, or delete vFiler templates.
•
•
•
•
•

Command buttons on page 700
vFiler Templates list on page 700
Details area: General on page 700
Details area: CIFS Settings on page 701
Window customization on page 701

Command buttons
Add

Starts the Add vFiler Template wizard which allows you to configure and add a new vFiler
template.

Edit

Opens a property sheet in which you can modify the properties of the selected vFiler
template.

Copy Copies the selected vFiler template and adds the copy as a new vFiler template.
Delete Deletes the selected vFiler templates.
vFiler Templates list
Name

The name of the vFiler template.

Description

The description provided when the vFiler template was configured.

CIFS Authentication
Mode

The name of the CIFS domain to which a vFiler unit using the selected
vFiler template belongs. Valid values are:
•
•

Active directory
Windows workgroup

The name of the domain or the IP address of the PDC.

DNS Domain
Details area: General

Displays additional general configuration information about the selected vFiler template. Options
marked with a checkmark (

) are configured; options marked with an X are not configured.

Name

The name of the selected vFiler template.

Description

The description provided when the vFiler template was configured.
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Administrative Host The host name or the IP address of the host that has root access to the files
needed to manage a vFiler unit using the selected vFiler template.
DNS Domain

The name of the DNS domain to which a vFiler unit using the selected
vFiler template belongs.

NIS Domain

The name of the NIS domain to which a vFiler unit using the selected vFiler
template belongs.

Details area: CIFS Settings
Displays detailed CIFS configuration information about the selected vFiler template.
Authentication Mode The mode used to authenticate data requests to or from a vFiler unit using
this vFiler template. Valid values are:
•
•
Security Protocol

The security protocol to be used by a vFiler unit using this vFiler template.
Valid values are:
•
•

CIFS Domain

Active directory
Windows workgroup

NTFS-only
Multiprotocol

The name of the CIFS domain to which a vFiler unit using the selected
vFiler template belongs.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Policies > Storage Services
The Storage Services window provides a location to create, edit, copy, delete, or survey your storage
services combinations.
•
•
•
•
•

Command buttons on page 702
Storage Services table on page 702
Overview tab on page 702
Dependancies tab on page 703
Window customization on page 703

Command buttons
Add

Starts the Add Storage Service wizard to create a new storage service object.

Edit

Opens a window that allows you to modify the selected storage service.

Delete

Deletes the selected storage service.

Storage services table
Lists information about existing storage services.
Name

The name of the selected storage service.

Primary provisioning
policy

The name of the provisioning policy that this storage service applies to
the primary node of the datasets to which it is attached.

Protection policy

The name of the protection policy that is provided by this service.

Description

A description of the storage service.

Overview tab
The overview tab displays a graphical representation of the nodes for the protection policy offered by
the selected storage service. On clicking the node for which you want to view status and
configuration details, the following information is displayed:
Provisioning policy The provisioning policy, if any, that is assigned to the selected node.
Resource pools

vFiler template

The resource pools, if any, that are assigned to the selected node. Click
for details.
The vFiler template, if any, for the storage service to use if you specify
creation of a vFiler unit attached to a node when you use the storage service
to create a new dataset.
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Owner

The owner of the selected storage service.

Contact

The contact email for the owner of the selected storage service.

Datasets

The datasets, if any, that are already using the selected storage service.

Dependencies tab
The Dependencies tab displays the datasets, if any, that are already using the selected storage service.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Hosts > Storage Systems
You can use the Storage Systems Hosts window to view detailed information about storage systems
discovered by the DataFabric Manager server. From this window, you can add a storage system to
NetApp Management Console, edit the properties of existing storage, and diagnose a storage
system's configuration. You can also manage Data ONTAP service licenses.
•
•
•
•
•
•
•
•

Command buttons on page 704
Storage system host list on page 704
Details tab on page 705
Usage tab on page 709
Paths tab on page 709
Input Relationships tab on page 710
Output Relationships tab on page 710
Window customization on page 711

Command buttons
Add

Starts the Add Storage System wizard, which enables you to set up storage system hosts.

Edit

Opens a window in which you can modify the properties of the selected host.

Delete

Deletes the selected storage system from the NetApp Management Console storage
systems list.

Diagnose Starts the Diagnose Storage Systems wizard, which allows you to modify some aspects
of a storage system's configuration.
This button is disabled if more than one host is selected in the hosts list.
Refresh

Updates the host list for the selected host.

Storage system host list
Name

Displays the name of the storage system or the vFiler unit as it appears in the
DataFabric Manager database.

System Status Displays the current status of the storage system. Possible values are Online,
Offline, and Unknown.
The default monitoring interval is one minute. The interval is specified as the Ping
Monitoring Interval in Operations Manager.
You can use the Options page in Operations Manager to view or change the
interval. See the Operations Manager online Help for details.
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Login
Credentials

Displays the current status of the login credentials that the DataFabric Manager
server uses to log in to the host.
Possible values are Good, Bad, Read Only, Unknown, and Not Applicable. NDMP
credentials for vFiler units are designated Not Applicable because the DataFabric
Manager server uses the credentials of the hosting system.

NDMP Status Displays the Network Data Management Protocol (NDMP) availability of the
storage system as of the most recent NDMP monitoring check.
Possible values are Up, Down, and Unknown. The default interval for NDMP
monitoring is 30 minutes.
You can use the Backup Discovery Options page in Operations Manager to change
the NDMP monitoring interval. See the Operations Manager online Help for
instructions.
NDMP
Credentials

Displays the current status of the Network Data Management Protocol credentials
that the DataFabric Manager server uses to communicate with the host.
Possible values are Good, Bad, Unknown, and Not Applicable. NDMP credentials
for vFiler units are always designated Not Applicable because the DataFabric
Manager server uses the credentials of the hosting system.
You can use the NDMP Credentials page in Operations Manager to edit the
credentials for NDMP discovery. See the Operations Manager online Help for
details.

Details tab
The Details tab has four areas: General, Credentials, Service status, and Licenses.
General

IP Address

Specifies the IP address associated with the selected storage
system.

Model

Displays the model number of this storage system.

Mirrored

Indicates whether the SnapMirror license is enabled on this host.
Possible values are Yes and No.

Backup
Destination

Indicates whether a SnapVault Secondary license is enabled on
this host, making the host a potential destination for backups.
Possible values are Yes and No.

Backup
Source

Indicates whether the SnapVault Data ONTAP Primary license
is enabled on this host, making the host a potential source of
backups.
Possible values are Yes and No.
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Note: Other hosts might also be potential backup sources, but

the SnapVault Primary licenses for Linux, UNIX, and
Windows are installed on the secondary system. This list
confirms only whether the SnapVault Data ONTAP Primary
license is enabled on the host.
Credentials

Service
status

Login User
Name

Specifies the name that the DataFabric Manager server uses to
log in to the selected host.

NDMP User
Name

Specifies the name that the DataFabric Manager server uses to
log in to the selected host by using NDMP.

NFS Indicates whether the Network File System (NFS) service is Up or Down.
CIFS

Indicates whether the Common Internet File System (CIFS) service is Up
or Down.

iSCSI Indicates whether the iSCSI service is Up or Down.
FC
Licenses

Indicates whether the Fibre Channel (FC) protocol service is Up or Down.

The following licenses each enable a service of Data ONTAP.
You must enter a software license code on the storage system to enable the
corresponding service. You do not need to indicate which license the code enables;
the code is matched automatically to the appropriate service license.
SnapMirror

You install the SnapMirror licenses on both the source and
destination storage systems for the mirrored data.
If the source and destination volumes are on the same
system, only one license is required. SnapMirror replicates
data to one or more networked storage systems. SnapMirror
updates the mirrored data to keep it current and available for
disaster recovery, offloading tape backup, read-only data
distribution, testing on nonproduction systems, online data
migration, and so on. You can also enable the SnapMirror
license to use Qtree SnapMirror for backup.

SnapVault Data
ONTAP
Secondary

You install the SnapVault Secondary license on storage
systems hosting the backups of protected data.
SnapVault creates backups of data stored on multiple
primary storage systems and copies the backups to a
secondary storage system. If data loss or corruption occurs,
backed-up data can be restored to a primary or open storage
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system with little of the downtime and uncertainty
associated with conventional tape backup and restore
operations.
SnapVault Data
ONTAP Primary

You install the SnapVault Data ONTAP Primary license on
storage systems running Data ONTAP that contain host data
to be backed up.

SnapVault
Windows Primary

You install the SnapVault Windows Primary license on a
secondary storage system, in addition to the SnapVault
Secondary license, to support a Windows-based primary
storage system running the Open Systems SnapVault agent.
A Windows-based primary storage system running the Open
Systems SnapVault agent does not require a SnapVault
license.

SnapVault
Windows Open
File Manager

You install the SnapVault Open File Manager license on a
secondary storage system to enable the backup of open files
on Windows primary storage systems running the Open
Systems SnapVault agent.
You must install the SnapVault Windows Primary license
and the SnapVault Data ONTAP Secondary license on the
secondary storage system before installing the SnapVault
Open File Manager license.

SnapVault UNIX
Primary

You install the SnapVault UNIX Primary license on a
secondary storage system, in addition to the SnapVault
Secondary license, to support a UNIX-based primary storage
system (AIX, HP-UX, or Solaris) running the Open Systems
SnapVault agent.
A UNIX-based primary storage system running the Open
Systems SnapVault agent does not require a SnapVault
license.

SnapVault Linux
Primary

You install the SnapVault Linux Primary license on a
secondary storage system, in addition to the SnapVault
Secondary license, to support a Linux-based primary storage
system running the Open Systems SnapVault agent.
A Linux-based primary storage system running the Open
Systems SnapVault agent does not require a SnapVault
license.
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NearStore Option

The NearStore license enables your storage system to use
transfer resources as conservatively as if it were optimized
as a backup system.
This approach is useful when the storage system on which
you want to store backed-up data is not a system optimized
for storing backups, and you want to minimize the number
of transfer resources the storage system requires. Storage
systems using the NearStore license must meet the following
criteria:
•
•
•

Deduplication

The storage system must be a FAS30xx, FAS31xx, or
FAS60xx system.
The version of Data ONTAP software must be 7.1 or
later.
If you plan to use the SnapVault service, the storage
system must have a SnapVault secondary license
enabled.

The deduplication license enables you to consolidate blocks
of duplicate data into single blocks so that you can store
more information using less storage space.
The storage system must have the Deduplication license
enabled. If you want to run deduplication on FAS platforms,
the NearStore personality license must also be enabled.
Monitoring of the volume-level deduplication option is done
as part of the core license.

SnapMirror Sync

The SnapMirror Sync license enables you to replicate data to
the destination as soon as it is written to the source volume.
SnapMirror Sync is a feature of SnapMirror.

FCP

Fibre Channel (FC) protocol is a licensed service on the
storage system that enables you to export LUNs and transfer
block data to hosts using the SCSI protocol over a Fibre
Channel fabric.

CIFS

Common Internet File System (CIFS) protocol is a licensed
service for remote file access that runs over TCP/IP on the
Windows operating system.
CIFS enables application access and file sharing across the
Internet.

NFS

Network File System (NFS) is client/server application that
runs over TCP/IP on the UNIX operating system.
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NFS enables application access and file sharing across the
Internet.
iSCSI

The iSCSI protocol is a licensed service on the storage
system that enables you to transfer block data to hosts using
the SCSI protocol over TCP/IP.
iSCSI supports Gigabit Ethernet and is often used in a SAN
environment.

MultiStore

The MultiStore license enables you to partition the storage
and network resources of a single storage system so that it
appears as multiple storage systems, called vFiler units, on
the network.
Be sure that the host on which you intend to install the
MultiStore license is running Data ONTAP 6.5 or later.

Usage tab
The Usage tab provides information about the aggregates, volumes, and qtrees that are associated
with any host selected from the host list.
Resource Type Displays a tree of the storage system and the aggregates, volumes, and qtrees on
that system.
You can also select either aggregates, volumes, or qtrees to narrow the list of
resources associated with the storage system that you selected.
Dependencies

Displays the name of the resource pool or datasets associated with the storage
system, aggregate, or volume selected in the Resource Type menu.

Paths tab
The Paths tab provides information about data that is moving into and out of host paths on the
selected storage system. You can use this information to identify dependencies on a selected storage
system, aggregate, volume, or qtree.
Data coming
into host path

Displays an expandable list of locations from which data is being backed up or
mirrored to the selected host path.

Host path

Displays the host path for which incoming and outgoing data is shown.
You can view the flow of data into and out of the storage system as a whole or
expand the list to select a specific aggregate, volume, or qtree and view the flow
of data through the selected path. Using the Resource Type menu, you can also
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select aggregates, volumes, or qtrees to narrow the list of resources associated
with the storage system you selected.
Data coming
out of host
path

Displays an expandable list of locations to which data is being backed up or
mirrored from the selected host path.

Input Relationships tab
This tab displays information about systems that send backup or mirror-copy data to the selected
system.
You can use this information to identify dependencies on a selected storage system before shutting
the system down for maintenance or to assess the impact of an outage.
Lag Status Indicates whether the lag threshold specified for the relationship has been or is about
to be exceeded.
Lag

Displays the time elapsed since the last successful backup or mirror-copy update.

Source

Displays the location of the backup or mirror-copy data that is being sent to the
selected system.

Type

Displays the type of relationship that the system has with the selected storage system.
Possible values are SnapVault, Volume SnapMirror, and Qtree SnapMirror.

Dataset

Displays the name of the dataset to which the incoming data belongs.

Destination Displays where the incoming data is stored on the selected storage system.
Output Relationships tab
This tab displays information about systems that receive backup or mirror-copy data from the
selected system.
You can use this information to identify dependencies on a selected storage system before shutting
the system down for maintenance or to assess the impact of an outage.
Lag Status Indicates whether the lag threshold specified for the relationship has been or is about
to be exceeded.
Lag

Displays the time elapsed since the last successful backup or mirror-copy update.

Source

Displays the location of data on the system that is being backed up or mirrored to a
secondary system.

Type

Displays the type of relationship the system has with the selected storage system.
Possible values are SnapVault, Volume SnapMirror, and Qtree SnapMirror.
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Dataset

Displays the name of the dataset to which the outgoing data belongs.

Destination Displays where the outgoing data is stored on the destination system.
Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
to display only the entries containing the information that you
You can use the filter arrow
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Hosts > Aggregates
You can use the Aggregates window to view information about space usage in aggregates and you
can start the Secondary Space Management wizard to create a set of tasks for resolving space usage
issues.
•
•
•
•
•
•
•

Command button on page 712
Aggregates list on page 712
Space Usage tab on page 712
Volumes tab on page 713
Datasets tab on page 713
Jobs tab on page 713
Window customization on page 713

Command button
Manage Space Starts the Secondary Space Management wizard, which suggests actions to resolve
space issues in the selected aggregate and then performs the actions that you
select.
Aggregates list
Name

The name of the aggregate.

Host

The name of the host on which the aggregate resides.

Utilization

The percentage of the aggregate space that is used. Aggregates with space
problems are highlighted in red.

Total Size

The total space allocated to the aggregate.

Resource Pool

The name of the resource pool, if any, that provisions the volumes in the
aggregate.

Datasets Affected The dataset or datasets that use space on the aggregate.
Time to Full

The estimated amount of time until all available space on the aggregate is
completely used, based on the current rate of space usage.

Space Usage tab
This tab displays a graph that shows the amount of space used by the volumes in the selected
aggregate over the selected period of time. You can use this graph to see when space usage
periodically increases. You can select any one of the following time periods: 1 day, 1 week, 1
month, 3 months, 1 year.
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Volumes tab
This tab displays space information about each volume in the selected aggregate.
Volume

The name of the volume.

Space Status

The availability of free space on the volume. Valid values are Normal,
Nearly Full, and Full.

Aggregate Space Used The amount of space in the aggregate that the volume uses.
Growth Rate

The amount of daily growth of used space on the volume.

Datasets tab
This tab displays space information about each dataset that is associated with the selected aggregate.
Dataset

The name of the dataset.

Aggregate Space
Used

The amount of space in the aggregate that the dataset uses.

In Primary

Whether the dataset uses the selected aggregate for primary storage. Values are
Yes and No.

Migration
Capable

Whether the dataset is configured for dataset migration. Values are Yes and
No.
Note: If a dataset is configured for migration, a link to the Datasets
window Migration tab is provided to allow you to migrate datasets.

Jobs tab
This tab displays the space management jobs on the selected aggregate that were started by the
Secondary Space Management wizard or the Dataset Migration wizard. Detailed information about a
selected job is displayed in the View Job Details area.
Jobs Id

The identification number that is assigned to the job.

Job Type

The type of job. Possible job types include Dedupe volume, Delete Snapshot copies,
Migrate volume, and Resize storage.

Start

The date and time that the job started.

Job Status The status of the job. Possible job status values are Failed, Partially Failed, Succeeded,
Running, Queued, Canceling, and Canceled.
End

The date and time that the job ended.

Window customization
You can modify the layout of the window by using a variety of customization options.
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•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Datasets > Provisioning
You can use the Provisioning tab on the Datasets window to add provisioning policy-compliant
volumes, LUNs, or qtrees to a dataset node. You can also survey available data and Snapshot copy
space allocation on individual volumes, LUNs, or qtrees, and resize the volumes and qtrees or delete
Snapshot copies on the volumes.
•
•
•
•
•
•
•

Command buttons on page 715
Datasets list on page 716
Current space breakout tab on page 716
Space Usage History tab on page 719
Deduplication tab on page 721
Exports tab on page 722
Window customization on page 723

Command buttons
Provision

Starts the Provisioning wizard to add new provisioning policy-compliant
volumes, LUNs, or qtrees to a primary node of the dataset. The dataset node
must have an assigned resource pool.
This button is not enabled for datasets of virtual objects.

Resize Storage
(volumes or
qtrees only)

Opens the Resize Storage window, which allows you to increase or decrease the
space allocated to the selected volume or qtree dataset member.

Destroy Storage Destroys the selected volume, qtree, or LUN on the storage controller. You can
select and destroy one or more volumes, qtrees, or LUNs at a time by holding
(volumes,
down Shift or Ctrl and selecting the data members you want to destroy.
qtrees, and
LUNs)
• When you destroy a volume, the NetApp Management Console provisioning
capability returns the space used by that volume to its containing aggregate.
• When you destroy a LUN, the NetApp Management Console provisioning
capability returns the space used by that LUN to its containing volume or
containing qtree.
• When you destroy a qtree, the NetApp Management Console provisioning
capability returns the space used by that qtree to its containing volume.
Delete Snapshot Opens the Delete Snapshot Copies window, which allows you to make more
copies (volumes space available for data storage on the selected volume by deleting the selected
Snapshot copies.
only)
Dedupe Now

If deduplication is enabled on a selected volume's dataset node, opens a dialog to
run an unscheduled on-demand deduplication on that volume.
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Abort Dedupe

If deduplication is currently in progress on a selected volume, stops that
deduplication operation. This button appears only if deduplication is in progress.

Datasets list
Displays the information about datasets and the volumes, qtrees, or LUNs in each dataset.
Dataset list Displays a list of all the datasets in your group.

Dataset
members
list

Dataset

The name of the dataset.

Failed Over

The failover status of the dataset (Ready, Failing over, or Failed
over).

Space
Status

The status of the available space for the dataset (Normal, Warning,
Error, Unknown).
If any member of a dataset has space allocation error or warning
conditions, that dataset's space status indicates that condition. You
can select a dataset to see which of its volumes, LUNs, or qtrees is
the cause of a space warning or error condition.

Displays the volume, LUN, and qtree members of the selected dataset.
Storage

The name and path of the volume, LUN, or qtree dataset
member.

Node Name

The name of the dataset node on which a volume is located.

Space Status

The status of the available space for the dataset member
(Normal, Warning, Error, or Unknown).
The space status for dataset members that are assigned a
provisioning policy is considered "Unknown."

Total Space

The total storage space allotted to the selected dataset member.

Available Space The amount of allocated storage space still available on the
dataset member.

Current space breakout tab
Displays information about the current space allocation for the selected volume, LUN, or qtree
dataset member. The graph on the left side illustrates the information provided on the right side.
This section displays information about the data space allocation and usage for the
Data
(displayed for selected data member.
NAS storage)
The space that is currently used on the selected dataset
Used space
member.
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The unused space that is available for data on the selected
dataset member.

Free space

Snapshot overflow The space used for Snapshot copies on the volume beyond
the space reserved for them (does not apply to qtrees).
Total data space

The total data space capacity on the selected dataset
member.

This section displays information about the data space allocation and usage for the
Data
(displayed for selected data member.
SAN storage)
The space that is currently used on the selected dataset
Used space
member. In SAN storage, this value normally represents
the LUNs in the volume.
Data in overwrite
reserve

The amount of data, if any, that is in the SAN storage
overwrite reserve space.

Total data space

The total data space capacity on the selected dataset
member.

This section displays information about the space allocation for Snapshot copies
Snapshot
(displayed for and the usage for the selected data member.
NAS storage)
The space that is currently used for Snapshot copies on the
Used Snapshot
selected volume (does not apply to qtrees).
space
The space that is available for Snapshot copies on the
selected volume (does not apply to qtrees).

Free Snapshot
space

Snapshot reserve The total space capacity for Snapshot copies on the selected
volume (does not apply to qtrees).
The space used for Snapshot copies on the volume beyond
the space reserved for them (does not apply to qtrees).

Snapshot
overflow

This section displays information on the overwrite reserve set aside in SAN
Overwrite
volumes for LUN or Snapshot copy overflow.
Reserve
(displayed for
The amount of data, if any, that is spilled into the
SAN storage) Data in overwrite
SAN storage overwrite reserve space.
reserve
Overwrite reserve
available
Parent
Aggregate

The amount of overwrite reserve space that remains
available.

This section displays information about the aggregate that contains the selected
dataset.
Name

The name of the aggregate.
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Space Status The status of the available space on the aggregate. Possible values
are Normal, Full, and Nearly Full.
Total Size

The total space allocated to the aggregate.

This section displays information about the total space allocation for the selected
Volume
(displayed for volume.
NAS volumes)
The total combined space for data and Snapshot copies
Total volume
allocated to the selected volume.
size
Snapshot reserve

The total Snapshot copy space capacity on the selected
volume.

Nearly Full
threshold

The maximum amount of data space that can be used before
the NetApp Management Console provisioning capability
generates a Nearly Full event message.

Full threshold

The maximum amount of data space that can be used before
the NetApp Management Console provisioning capability
generates a Full event message.

Space Guarantee

The type of space guarantee configured for the selected
flexible volume (None, File, or Volume).

Space Status

The status of the available space for the selected volume
(Normal, Warning, Error, or Unknown). For explanations for
Warning or Error status, click

to the right.

This section displays information about the total space allocation for the selected
Volume
(displayed for SAN volume.
SAN storage)
The total combined space for data and Snapshot copies
Total volume size
allocated to the selected volume.
Nearly Full
threshold

The maximum amount of data space that can be used
before the NetApp Management Console provisioning
capability generates a Nearly Full event warning message.

Full threshold

The maximum amount of data space that can be used
before the NetApp Management Console provisioning
capability generates a Full event error message.

Used Snapshot
space

The amount of used Snapshot space on the selected SAN
volume.

Data and
overwrite reserve
size

The total combined space set aside for data and the
overwrite reserve.
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Volume used

The total amount of SAN volume space used.

Volume available

The total volume space available.

Space Guarantee

The type of space guarantee configured for the selected
SAN volume (None, File, or Volume).

Space Status

The status of the available space for the selected SAN
volume (Normal, Warning, Error, Unknown). For
explanations for Warning or Error status, click
right.

Qtree space

to the

This section displays information about the total space allocation for the selected
qtree.
Qtree used
space

The space on the selected qtree currently used for data.

Qtree free
space

The space allocated to the selected qtree that is currently not
used.

Qtree quota

The space currently allocated to the selected qtree.

Space Status

The status of the available space for the selected qtree
(Normal, Warning, Error, Unknown). For explanations for
Warning or Error status, click

to the right.

Space usage history tab
Graphically displays the history of space allocation and use on the selected volume or qtree over the
selected period of time. This applies only to qtrees that have quotas settings configured.
To display space allocation data for a specific date and time, place your cursor at that date and time
along the graph's time axis. The information for the cursor-selected date and time is displayed to the
right of the graph.
Time-period
tabs

Displays the space usage history on the selected volume or qtree during the
selected time period (1 day, 1 week, 1 month, 3 months, or 1 year).

Displays the space usage history for data on the selected volume or qtree during
Data
(displayed for the selected time period.
NAS storage)
The total combined space for data and Snapshot copies
Total volume
allocated to the selected volume at or during the selected time
size
period.
Used space

The space used for data storage on the selected volume or qtree
at or during the selected time period.
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Free space

The unused space that is available for data on the selected
volume or qtree at or during the selected time period.

Total data
space

The total data space capacity on the selected volume or qtree at
or during the selected time period.

Displays the space usage history for data on the on the selected volume or qtree
Volume
(displayed for during the selected time period.
SAN storage)
The combined space used by data and the overwrite
Data and
overwrite reserve reserve at or during the selected time period.
size
Used Snapshot
space

Space on the selected volume used for Snapshot copies at
or during the selected time period.

Volume used

The amount of the selected volume that was used at or
during the selected time period.

Volume available

The amount of space on the selected volume that was
available at or during the selected time period.

Total volume size

The total combined space for data and Snapshot copies
allocated to the selected volume at or during the selected
time period.

Displays the space usage history for Snapshot copies on the selected volume
Snapshot
(displayed for during the selected time period.
NAS volumes)
The space used for Snapshot copies on the selected volume
Used Snapshot
at or during the selected time period.
space

Qtree space
(qtrees with
quotas only)

Free Snapshot
space

The unused space that is available for Snapshot copies on the
selected volume at or during the selected time period.

Snapshot
reserve

The total space capacity for Snapshot copies on the selected
volume at or during the selected time period.

Snapshot
overflow

The space used for Snapshot copies on the volume at or
during the selected time period beyond the space reserved for
them.

Displays the space usage history for the selected qtree during the selected time
period.
Qtree used
space

The amount of qtree space that was used during the selected
time period.

Qtree free space

The amount of qtree space that was available during the
selected period.
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The amount of space that was allotted by quota to the qtree
during the selected period.

Qtree quota

Deduplication tab
Graphically displays the deduplication-related space savings on a selected volume if deduplication
has been enabled and run for that volume. The information on deduplication savings is displayed to
the right of the graph.
Note: If deduplication is enabled but has never been run on the selected volume, the Deduplication
tab displays "Dedupe has not been run on the volume."

With dedupe Graphs the current space usage with deduplication applied on the selected volume.
(Current
state)
Without
dedupe

Graphs what space usage would be without deduplication applied on the selected
volume.

Volume

Displays a legend for the space usage components that are displayed in the
"Without deduplication" and "With deduplication" graphs and also displays
numerical values for those components.
Used space

•

•
Free space

•

•

In the "With dedupe" column, the amount of space used to
store data with deduplication applied.
In typical circumstances the amount of used space with
deduplication applied is less than the amount of used space
without deduplication applied.
In the "Without dedupe" column, the amount of space that
would be used to store data without deduplication applied.
In the "With dedupe" column: The amount of free space
remaining in the volume with deduplication applied.
In typical circumstances the amount of free space with
deduplication applied is less than the amount of free space
without deduplication applied.
In the "Without dedupe" column: The amount of free space that
would be remaining in the volume without deduplication
applied.

Snapshot
overflow

The amount of space used for Snapshot copies in addition to the
Snapshot reserve space in the selected volume.

Snapshot
reserve

The amount of Snapshot reserve space used in the selected
volume.

722 | Provisioning and Data Protection Online Help

Total
volume size

•
•

In the "With dedupe" column: The total amount of used space
in the selected volume.
In the "Without dedupe" column: The total amount of logical
space that would be used without deduplication applied.

In cases of over-deduplication, the logical total volume size might
exceed the actual physical space allotted to the volume.
Displays numerical values for deduplication-related space savings.

Dedupe
space saved

Used data space
without dedupe

The space that data would occupy on this volume without
deduplication applied.

Used data space with The space that data occupies on this volume with
deduplication applied.
dedupe
Space saved

The space that is saved on this volume because
deduplication is applied.

Space saved %

The deduplication-enabled space saved, expressed as a
percentage of the logical total volume size.

Displays the results of the last or current deduplication job run on the selected
volume.

Dedupe
properties

Last run start time The time the last completed deduplication run started.
Last run end time

The time the last completed deduplication run ended.

Current progress

The progress of the current deduplication run or the time
passed since the last deduplication run.

Last run scan

The amount of new data scanned for deduplication in the
last deduplication run.

Status

The status of the current deduplication activity (idle or
active).

Exports tab
Displays information about the export settings applied to the selected dataset volume, LUN, or qtree.
NFS
Settings

Displays NFS export settings if NFS export is enabled for the selected dataset volume,
or qtree.
Anonymous users
mapped to

Displays the port to which to map anonymous users.
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CIFS
Settings

FCP
Settings

iSCSI
Settings

Do not allow UID option
set

Displays whether or not the option to set the UID is
enabled.

Security settings

Displays the types of security protocols assigned to the
selected dataset member.

All hosts

Displays NFS permissions granted to all hosts.

Specific Hosts

Displays NFS permissions specific to each host name.

Host

Displays the name of the host for which specific NFS
permissions are listed.

Displays CIFS export settings if CIFS export is enabled for the selected dataset
volume, or qtree.
Windows
Domain

Displays the Windows Domain in which the selected volume is
contained.

User

Displays the name of the user configured to access a CIFS share.

Permission

Displays specific permissions (full control, no access, or read
and change) for specific users to access the nodes in this dataset.

Displays FC export settings if FC export is enabled for the selected dataset volume,
LUN, or qtree.
The operating
system

The operating system (Solaris, Windows, HP-UX, AIX,
Linux, VMware, or NetWare) of the accessing host.

The World Wide
Port Names

The worldwide port names for the FC nodes if the accessing
host does not have NetApp Host Agent installed.

Displays iSCSI export settings if iSCSI export is enabled for the selected dataset
volume, LUN, or qtree
Operating
system

The operating system (Solaris, Windows, HP-UX, AIX, Linux,
VMware, NetWare) of the accessing host

Initiator ID

The initiator ID for the iSCSI nodes if the accessing host does
not have a NetApp Host Agent installed

Window customization
You can modify the layout of the window by using a variety of customization options.
•

You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.

and

), and then use the
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•

You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.

•

You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.

•
•
•
•
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Hosts > vFiler Units
You can use the vFiler Units window to view detailed information about vFiler units discovered by
DataFabric Manager. From this window, you can add vFiler units to or delete them from the NetApp
Management Console host list. You can also access the Details tab, Paths tab, and the Relationships
tabs for vFiler units.
•
•
•
•
•
•
•
•
•

Command buttons on page 725
vFiler units list on page 726
Details tab on page 729
Network Settings tab on page 730
Paths tab on page 731
Input Relationships tab on page 732
Output Relationships tab on page 732
Migration tab on page 733
Window customization on page 734

Command buttons
The migration command buttons are disabled when a vFiler unit migration is in progress.
Add

Starts the Add vFiler Unit wizard, which allows you to create and to optionally
configure vFiler units.
You can choose to create the vFiler unit by using the Add button and then configure
it later by using the Setup button.

Setup

Starts the Setup vFiler Unit wizard, which allows you to configure or modify an
existing vFiler unit.

Delete

Presents you with two delete options:
Delete

Deletes the selected vFiler unit from the NetApp Management
Console vFiler list.

Destroy and
Delete

Destroys the selected vFiler unit on the DataFabric Manager
database, and deletes it from the NetApp Management Console
vFiler list.

Start
migration

Initiates the first phase of a vFiler unit migration by starting the vFiler Unit
Migration wizard, which begins a baseline transfer.

Update

Performs an on-demand update of the SnapMirror relationships that were created as
part of the "Start migration" operation. This button is enabled only when the "Start
migration" operation has finished for the selected vFiler unit.
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Cancel

Cancels the migration in progress for the selected vFiler unit. The vFiler unit is
returned to the migration status that it had before the migration started. All ongoing
data transfers for the migration are aborted, and the provisioned destination storage
and destination vFiler unit are deleted. (You must manually delete VLANs and
IPspaces that were created during the migration process.) This button is enabled
during the migration start and migration update operations.

Cut over

Initiates the second phase of a migration, which performs a cutover (switching the
source from the old storage from which the data is served to the new storage
destination). This button is enabled only when the migration start operation has
finished for the selected vFiler unit.

Roll back

Rolls back a migration for the selected vFiler unit, even after a cutover is done.
Active status is returned to the original source storage. That storage is updated with
any changes made to the destination storage since cutover, and then the destination
storage is made unavailable. To be successful, rollback must be completed before the
cleanup operation occurs.

Clean up

Initiates the third phase of a migration, which deletes the storage from which the
vFiler unit was migrated. A preview window lists which volumes are to be destroyed
as part of the cleanup operation. VLANs and IPspaces used by the source vFiler unit
are not automatically destroyed. This button is enabled only when a migration
cutover process for the selected vFiler unit has finished.

vFiler units list
Name

The name of the vFiler unit as it appears in the DataFabric Manager database

IP address

The IP address associated with the selected vFiler unit

IP Space

The name of the IPspace, if any, assigned to the vFiler unit

Hosting
Storage
System

The name of the storage system that hosts the vFiler unit

System
Status

The current status of the vFiler unit
Possible values are Online, Offline, and Unknown. The default monitoring interval
is five minutes.
The interval is specified as the Ping Monitoring Interval in Operations Manager.
You can use the Options page in Operations Manager to view or change the interval.
See the Operations Manager online Help for details.

Migration
Status

The status of a migrating source vFiler unit
The description, source storage status, destination storage status, permitted
operations, and prohibited operations for each status are described as follows:
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Not started

The vFiler unit meets the vFiler unit migration requirements.
•
•
•
•

Source storage system: Online
Destination storage: Not provisioned
Operations permitted: All
Prohibited operations: Migration cutover, migration update,
migrate complete, migration cancel, migration cleanup

You can initialize the start migration operation on vFiler units
having a "Not started" or "Migrate failed" status.
In progress

Migration of the vFiler unit has started.
•
•
•
•

Started,
cutover
required

The vFiler unit is completely migrated to the destination storage
system, including the data, backup versions, backup relationships,
and DataFabric Manager history for the volumes. The data source
must be switched to the new vFiler unit on the new destination
storage system.
•
•
•
•

Migrated,
cleanup
required

Source storage system: Online
Destination storage: Provisioned for the vFiler unit currently
offline
Operations permitted: Migration cancel
Prohibited operations: Add or delete volumes, provision storage
for the vFiler unit, edit provisioning or protection policies

Source storage system: Offline
Destination storage: Online
Operations permitted: Edit provisioning or protection policies,
migration update, migration cutover, migration cancel
Prohibited operations: Migration cleanup

The migration cutover operation is finished and the vFiler unit is
switched over to the destination storage system, including the data,
backup versions, backup relationships, and DataFabric Manager
history for the volumes. Old storage must be deleted.
•
•
•

•

Source storage system: Offline
Destination storage: Online
Operations permitted: Resize storage, delete Snapshot copies,
add and delete volumes, provision storage for the vFiler unit,
edit provisioning or protection policies, migration cleanup
Prohibited operations: Migration start, migration cancel,
migration update, migration cutover
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Migrated
with errors

The migration cutover operation successfully performed the switch
to the destination storage system. However, a failure occurred
during the migration of the backup version, backup relationships, or
history for the primary data. You must manually correct the errors.
•
•
•

•
Migrate
failed

The migration cutover operation failed to bring the destination
vFiler unit online. The source vFiler unit is online again and the
destination storage system is destroyed.
•
•
•

•

Rolled back

Source storage system: Online
Destination storage: Offline
Operations permitted: Resize storage, delete Snapshot copies,
add and delete volumes, provision storage for the vFiler unit,
edit provisioning or protection policies, migration start,
migration cancel
Prohibited operations: Migration cutover, migration cleanup,
migration update

The rollback operation succeeded. The source vFiler unit is online again and its data
is updated with any changes made since the migration cutover.
•
•
•

•
Rolled back
with errors

Source storage system: Offline
Destination storage: Online
Operations permitted: Resize storage, delete Snapshot copies,
add and delete volumes, provision storage for the vFiler unit,
edit provisioning or protection policies
Prohibited operations: Migration start, migration cancel,
migration update, migration cutover, migration cleanup

Source storage system: Online
Destination storage: Offline
Operations permitted: Resize storage, delete Snapshot copies, add and delete
volumes, provision storage for the vFiler unit, edit provisioning or protection
policies, migration cutover (returns availability to the destination storage if the
problem that necessitated the rollback is fixed), migration cleanup (cleans up the
destination storage)
Prohibited operations: Migration start, migration update, migration cancel

The rollback operation successfully performed the switch back to the source storage
system. However, a failure occurred during the restoration of the backup version,
backup relationships, or history for the destination data. You must manually correct
the errors, change the migration status of the dataset using the Operations Manager
CLI, and resume the dataset.
•

Source storage system: Online
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•
•

•

Destination storage: Offline
Operations permitted: Resize storage, delete Snapshot copies, add and delete
volumes, provision storage for the vFiler unit, edit provisioning or protection
policies
Prohibited operations: Migration start, migration cancel, migration update,
migration cutover, migration cleanup

Details tab
The Details tab has three areas: General, Service status, and Hosting Storage System Settings.
General

Protocols

Indicates the protocol type associated with the vFiler unit: CIFS,
NFS, or iSCSI.

Mirrored

Indicates whether the SnapMirror license is enabled on the hosting
storage system.
Possible values are Yes and No.

Backup
Destination

Indicates whether a SnapVault Secondary license is enabled on this
host, making the host a potential destination for backups.
Possible values are Yes and No.

Backup
Source

Indicates whether the SnapVault Data ONTAP Primary license is
enabled on the hosting storage system, making the host a potential
source of backups.
Possible values are Yes and No.
Note: Other hosts might also be potential backup sources, but the

SnapVault Primary licenses for Linux, UNIX, and Windows are
installed on the secondary system. This list confirms only
whether the SnapVault Data ONTAP Primary license is enabled
on the host.
Service
status

NFS

Indicates whether the Network File System (NFS) service is Up or Down.

CIFS

Indicates whether the Common Internet File System (CIFS) service is Up or
Down.

iSCSI Indicates whether the iSCSI service is Up or Down.
Hosting
Storage
System
Settings

These settings apply to the storage system that is hosting the vFiler unit that you
selected in the vFiler list.
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Host Name

The name that DataFabric Manager uses to log in to the storage
system

IP Address

The IP address of the hosting storage system that is associated
with the selected vFiler unit

System Status

Whether the status of the storage system is Online, Offline, or
Unknown

Login
Credentials
Status

The current status of the login credentials that DataFabric
Manager uses to log in to the hosting storage system. Possible
values are Good, Bad, Read Only, Unknown, and Not Applicable.

NDMP Status

The Network Data Management Protocol (NDMP) availability of
the storage system as of the most recent NDMP monitoring check.
Possible values are Up, Down, and Unknown. The default interval
for NDMP monitoring is 30 minutes.
You can use the Backup Discovery Options page in Operations
Manager to change the NDMP monitoring interval. See the
Operations Manager online Help for instructions.

NDMP
Credentials
Status

The current status of the Network Data Management Protocol
credentials that DataFabric Manager uses to communicate with the
hosting storage system.
Possible values are Good, Bad, Unknown, and Not Applicable.
You can use the NDMP Credentials page in Operations Manager
to edit the credentials for NDMP discovery. See the Operations
Manager online Help for details.

Network Settings tab
This tab provides information about vFiler unit administrative hosts and servers, and network
bindings.
Network
information
area

This area displays information about administrative hosts and servers for a
selected vFiler unit.
Administrative host

Indicates the IP address of the administrative host for
the selected vFiler unit.

DNS domain name

Indicates the domain name of the DNS server for the
selected vFiler unit.

DNS servers

Indicates the IP addresses of DNS servers for the
selected vFiler unit.
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NIS domain name

Indicates the domain name of the NIS server for the
selected vFiler unit.

NIS servers

Indicates the IP addresses of the NIS servers for the
selected vFiler unit.

CIFS authentication
type

Indicates the mode used to authenticate data requests
to or from a selected vFiler unit.
Values are Active directory or Windows workgroup.

CIFS security style

Indicates the security protocol to be used by a selected
vFiler unit.
Values are NTFS-only or Multiprotocol.

CIFS workgroup
name
Network
Bindings

Indicates the name of the CIFS Windows workgroup.

You can use network bindings to bind network cards, protocols, and services.
IP address

The IP address of a network card or port that you have bound to a
specific protocol or service.

Network
mask

The network mask of a network card or port that you have bound
to a specific protocol or service
The network mask value is displayed as prefix length rather than
in four-octet notation. For example, if the network mask is
255.255.255.0, the value of the network mask is displayed by the
equivalent prefix length, 24.

Network
interface
MTU (Bytes)

The protocol or service to which the corresponding IP address is
bound

The maximum unit of data transmission that you want to allow over the listed
network binding

Paths tab
The Paths tab displays information about data that is moving in to and out of host paths on the
selected vFiler unit. You can use this information to identify dependencies on a selected vFiler unit,
aggregate, volume, or qtree.
Data coming
into host path

A list of locations from which data is being backed up or mirrored to the
selected host path

Host path

The host path for which incoming and outgoing data is shown for the storage
system that is hosting the vFiler unit
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You can view the flow of data into and out of the storage system as a whole, or
you can expand the list to select a specific aggregate, volume, or qtree and view
the flow of data through the selected path.
Data coming out A list of locations to which data is being backed up or mirrored from the
selected host path
of host path
Input Relationships tab
This tab displays information about systems that send backup or mirror data to the storage system
that is hosting the vFiler unit.
You can use this information to identify dependencies on a selected storage system before shutting
down the system for maintenance or to assess the impact of an outage.
Lag Status Whether the lag threshold specified for the relationship has been or is about to be
exceeded
Lag

The time elapsed since the last successful backup or mirror update

Source

The location of the backup or mirror data that is being sent to the selected system

Type

The type of relationship that the system has with the hosting storage system
Possible values are SnapVault, Volume SnapMirror, and Qtree SnapMirror.

Dataset

The name of the dataset to which the incoming data belongs

Destination The name of the hosting storage system on which the incoming data is being stored
Output Relationships tab
This tab displays information about systems that receive backup or mirror data from the hosting
storage system.
You can use this information to identify dependencies on a selected storage system before shutting
down the system for maintenance or to assess the impact of an outage.
Lag Status Indicates whether the lag threshold specified for the relationship has been or is about
to be exceeded.
Lag

The time elapsed since the last successful backup or mirror update

Source

The location of data on the system that is being backed up or mirrored to a secondary
system

Type

The type of relationship the system has with the selected storage system
Possible values are SnapVault, Volume SnapMirror, and Qtree SnapMirror.

Dataset

The name of the dataset to which the outgoing data belongs
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Destination The name of the destination system on which the outgoing data is being stored
Migration tab
This tab displays detailed information about the data migration of the datasets attached to the selected
vFiler unit.
Source storage
system

The name of the storage system from which the data is migrated

Destination
storage system

The name of the storage system into which the data is migrated

Migration
Status

The same migration status as in the vFiler units list section of this window

Dataset(s)
attached

The datasets to which the selected vFiler unit is attached

Physical
resources

The volumes in the dataset.

Lag

The length of time since the successful migration of data to the destination

Error

The error that occurred during a migration operation
The value None indicates that no migration-related error occurred.

State

The state of the volume, SnapVault relationship, or SnapMirror relationship
created during the migration
Uninitialized The destination storage volume or qtree is not yet initialized or
is being initialized.
Snapvaulted

The SnapVault relationship is created and the qtree is a
SnapVault secondary destination.

Mirrored

The destination volume or qtree is in a SnapMirror relationship.

Broken off

The destination was in a SnapMirror relationship, but a
snapmirror break command made the volume or qtree
writable.
This state is reported when the base Snapshot copy is still
present in the volume. If the Snapshot copy is deleted, the state
is reported as uninitialized while the destination is in the /etc/
snapmirror.conf file. The snapmirror resync command
restores the mirrored status.

Quiesced

SnapMirror is in a consistent internal state and no SnapMirror
activity is occurring.
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In this state, you can create Snapshot copies with confidence
that all destinations are consistent. The snapmirror quiesce
command brings the destination into this state. The
snapmirror resume command restarts all SnapMirror
activities.
Source

A snapvault status or snapmirror status command was executed
on the primary storage system.
When the destination is on another storage system, its status is
unknown and the NetApp Management Console provisioning
capability reports the status "source." This status is also
reported for SnapVault relationships when a snapvault
status command is executed on secondary storage systems
after the snapvault restore command was executed on an
associated primary storage system.

Unknown

The destination volume or the volume that contains the
destination qtree is in an unknown state.
It might be offline or restricted.

Restoring

SnapVault relationships are being restored.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Datasets > Overview
The Datasets window Overview tab provides a single location from which you can view a list of
datasets and their properties, and perform various actions on datasets.
From the Overview tab, you can monitor the status of all datasets, create and modify datasets, assign
physical resources manually or by using provisioning policies. You can back up a dataset's content
on demand, suspend or resume protection for it, and initiate restore operations to access backed-up
data from this page. You can also assign storage services that supply a dataset with a preconfigured
protection policy, provisioning policies, resource pools, and an optional vFiler template.
•
•
•
•
•

Command buttons on page 735
Datasets list on page 737
Graph area on page 741
Details area on page 741
Window customization on page 746

Command buttons
Add

•
•

Edit

If you select the Add sub-option, starts the Add Dataset wizard for adding a
dataset.
If you select the Using a storage service sub-option, starts the Add Dataset
Using Storage Service wizard for adding a dataset with a selected storage service
already attached.

Opens the Edit Dataset window, from which you can modify general properties of a
dataset, physical resources of a dataset, or how storage is provisioned on a dataset.
This button is not enabled for datasets of virtual objects.

Delete

Deletes the selected dataset and thereby removes the relationships among the storage
resources.

Protection
Policy

Starts the Dataset Policy Change wizard, from which you can select a protection
policy and destination storage to associate with your dataset.
This button is not enabled for datasets of virtual objects.

Storage
Service

•

If you select the Attach sub-option, the Attach Storage Service wizard enables
you to assign a storage service with a preconfigured protection policy,
provisioning policies, resource pools, and an optional vFiler unit template
configuration to the selected datasets and their nodes.

736 | Provisioning and Data Protection Online Help
•

If you select the Change sub-option, the Change Storage Service wizard enables
you to replace the current storage service on the selected datasets with an
alternative storage service.
Note: Attaching a storage service or changing the attached service to a dataset
prevents you from modifying that dataset's individual protection policy,
provisioning policies, resource pools, and optional vFiler unit configuration
without modifying the assigned storage service itself.

•

If you select Detach Storage Service, the Detach Storage Service wizard enables
you to detach a storage service from the selected datasets.
This button is not enabled for datasets of virtual objects.
Note: Detaching a storage service from a dataset does not alter that dataset's

current protection policy, provisioning policies, resource pools, and optional
vFiler unit configurations; however, with the storage service detached you can
change each of those elements directly.
Protect Now Opens the Protect Now dialog box, from which you can perform on-demand backup
or mirror protection operations on datasets that are protection policy-enabled for
those types of operations. This button is disabled for datasets that do not have a
protection policy assigned.
This button is not enabled for datasets of virtual objects.
If you click the box "Notify me on job progress," you receive desktop alerts about
this job's status after starting the Protect Now process.
Note: With application datasets, clicking Protect Now copies all new backups
that have not been copied to the secondary backup node. Protect Now does not
create new local backups on the primary nodes of application datasets.

Suspend

Suspends dataset protection or provisioning for one or more datasets.
During the time that NetApp Management Console suspends protection, it displays a
Protection Suspended status for the dataset.
This button is enabled only if a protection or provisioning policy is assigned to the
dataset.
Note: When you click the Suspend button to stop the protection for an application
dataset, a note is displayed, reminding you that local backups that are being
created by another application cannot be suspended.

This button is not enabled for datasets of virtual objects.
Resume

Resumes dataset backup protection or provisioning for one or more datasets.

Restore

Starts the Restore wizard for restoring backed-up copies of data.
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This button is not enabled for datasets of virtual objects.
Datasets list
Lists information about existing datasets. You can click a row in the list to view information in the
Details area about the selected dataset.
Name

The name of the dataset.

Dataset Type

Whether the dataset contains physical storage objects or virtual objects.
Physical A dataset type that can contain only physical storage objects
(aggregates, volumes, qtrees) as members. A dataset's type is
physical if one or both of the following conditions apply:
•
•

The dataset already contains a physical storage object as a
member.
A protection policy, resource pool, or provisioning policy is
directly attached.

Datasets of storage objects are configured and managed directly in
the NetApp Management Console.
Virtual

A dataset type that can contain only virtual objects (VMware
datastores, or VMware virtual machines) as members. A dataset's
type is virtual if one or both of the following conditions apply:
•
•

The dataset already contains a virtual object as a member.
A local policy is attached.

Datasets of virtual objects are configured and managed in the
OnCommand Unified Manager. The NetApp Management Console
edit, protect now, storage service detach, protection policy
configuration, and restore functions are disabled for datasets of
virtual objects.
Undefined

A dataset type that can contain either storage objects or virtual objects. A
dataset's type is undefined if both of the following conditions apply:
•

•

The dataset still contains no object of any type as a member. Adding one
object of either physical or virtual type as a member to an undefined dataset
defines the dataset as that same type and excludes assignment of any object
of the opposite type to that dataset.
No local policy, protection policy, resource pool, or provisioning policy is
directly attached.
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Overall Status

The status determined by evaluating the combined status conditions for disaster
recovery, protection, conformance, space, and resources. This item is not
included in the dataset list by default.
Overall status is computed based upon the following status values:
Overall
Status: Error

DR status condition: Error
Protection status condition: Lag error or Baseline failed
Conformance status condition: Nonconformant
Space status condition: Error
Resource status condition: Emergency, Critical, or Error

Overall
Status:
Warning

DR status condition: Warning
Protection status condition: Job failure, Lag warning,
Uninitialized, or No protection policy for a non-empty
dataset
Conformance status condition: NA
Space status condition: Warning
Resource status condition: Warning

Protection
Policy

The name of the protection policy currently assigned to the dataset.

Primary
Provisioning
Policy

The name of the provisioning policy currently assigned to the primary node of
the dataset. If a provisioning policy is assigned to a secondary node in the
dataset, that name is displayed in the details area when you select the secondary
node in the graph area.

Failed Over

Indicates whether a disaster recovery-capable dataset has failed over. This item is
not included in the dataset list by default. Valid values are the following:
Yes

Failover on the dataset was invoked and completed
successfully, completed with warnings, or completed with
errors.

No

Failover on the dataset has not been invoked.

In Progress

Failover on the dataset is currently in progress.

Not Applicable The dataset is not assigned a disaster recovery protection
policy and, therefore, is not capable of failover.
Storage Service Lists what storage service, if any, is attached to the dataset. A dataset that is
attached to a storage service uses the protection policy, provisioning policies,
resource pools, and vFiler unit configurations specified by that storage service.
This item is not included in the dataset list by default.
Description

A description of the dataset. This column is not shown by default.
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Protection
Status

Displays protection status. Information about a warning or error status can be
accessed from the Details Area of the window.
Valid status values, in alphabetical order, are as follows:
Baseline Failed There are no initial baseline data transfers that registered a
backup version.
Initializing

The dataset is conforming to the protection policy and the
initial baseline data transfer is in process.

Job Failure

The most recent protection job did not succeed.
This status might result for any of the following reasons:
•
•
•
•

Lag Error

A backup from a SnapVault or Qtree SnapMirror
relationship failed or could not be registered.
A mirror copy from a SnapMirror relationship failed or
could not be registered.
Local backups (Snapshot copies) failed on the primary
node.
The dataset does not have any backup versions.

The dataset has reached or exceeded the lag error threshold
specified in the assigned protection policy. This value
indicates that there has been no successful backup or mirror
copy of a node's data within a specified period of time.
This status might result for any of the following reasons:
•
•

•

Lag Warning

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror)
is older than the lag threshold setting or no backup jobs
have completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than
the lag threshold setting or no mirror jobs have completed
since the dataset was created.

The dataset has reached or exceeded the lag warning
threshold specified in the assigned protection policy. This
value indicates that there has been no successful backup or
mirror copy of a node's data within a specified period of
time.
This status might result for any of the following reasons:
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•
•

•

The most recent local backup (Snapshot copy) on the
primary node is older than the threshold setting permits.
The most recent backup (SnapVault or Qtree SnapMirror)
is older than the lag threshold setting or no backup jobs
have completed since the dataset was created.
The most recent mirror (SnapMirror) copy is older than
the lag threshold setting or no mirror jobs have completed
since the dataset was created.

No Local
Policy
Attached

No local policy is attached to a dataset of virtual objects.
This status does not apply to datasets of physical storage
objects.

No Protection
Policy

The dataset is managed by NetApp Management Console,
but no protection policy has been assigned to the dataset.

Protected

The dataset has an assigned policy and it has conformed to
that policy at least once.

Protection
Suspended

An administrator has requested that scheduled backups be
put on hold until the administrator requests that they be
resumed.

Uninitialized

This status might result for any of the following reasons:
•
•
•
•
•
•

The dataset has a protection policy that does not have any
protection operations scheduled.
The dataset does not contain any data to be protected.
The dataset does not contain storage for one or more
destination nodes.
The single node dataset does not have any backup
versions.
At least one backup version must be associated with the
application dataset.
The dataset does not contain any backup or mirror
relationships.

Space Status

Displays the status of the available space for the selected dataset node (OK,
Warning, Error, or Unknown).

Conformance
Status

For the NetApp Management Console data protection capability, indicates
whether the dataset is Conformant, Nonconformant, or In Progress.

Resource
Status

The most severe of all current events on all direct and indirect members of the
dataset nodes. Values can be Emergency, Critical, Error, Warning, or Normal.
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Application

The name of the application that created the application dataset, such as
SnapManager for Oracle. This item is not included in the dataset list by default.

Application
Version

The version of the application that created the application dataset. This item is
not included in the dataset list by default.

Application
Server

The name of the server that runs the application that created the application
dataset. This item is not included in the dataset list by default.

Graph area
The graphical representation of the nodes for the selected dataset are displayed in the lower section
of the page. Click the node or connection on which you want to view status and configuration details.
Details area
The details of the selected dataset node are displayed next to the graph area. Clicking a node or
connection in the graph area displays information about that item in the Details area.
Primary data If you select the Primary data node or the DR data node in the Graph area, the
details area displays status and configuration information about the selected node.
or Disaster
recovery data
You can click
to view member details, status details, or resource details about
node details
the node.
Valid values are as follows:
Protection

Displays protection status. This item is shown only if the
NetApp Management Console data protection capability is
installed. You can click
next to the status value to view
status details and a list of any jobs that are associated with the
status.
Baseline
Failed

There are no initial baseline data transfers
that registered a backup version.

Initializing

The dataset is conforming to the protection
policy and the initial baseline data transfer is
in process.

Job Failure

The most recent protection job did not
succeed.
This status might result for any of the
following reasons:
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•

•

•
•
Lag Error

A backup from a SnapVault or Qtree
SnapMirror relationship failed or could
not be registered.
A mirror copy from a SnapMirror
relationship failed or could not be
registered.
Local backups (Snapshot copies) failed
on the primary node.
The dataset does not have any backup
versions.

The dataset has reached or exceeded the lag
error threshold specified in the assigned
protection policy. This value indicates that
there has been no successful backup or
mirror copy of a node's data within a
specified period of time.
This status might result for any of the
following reasons:
•

•

•

Lag Warning

The most recent local backup (Snapshot
copy) on the primary node is older than
the threshold setting permits.
The most recent backup (SnapVault or
Qtree SnapMirror) is older than the lag
threshold setting or no backup jobs have
completed since the dataset was created.
The most recent mirror (SnapMirror)
copy is older than the lag threshold
setting or no mirror jobs have completed
since the dataset was created.

The dataset has reached or exceeded the lag
warning threshold specified in the assigned
protection policy. This value indicates that
there has been no successful backup or
mirror copy of a node's data within a
specified period of time.
This status might result for any of the
following reasons:
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•

•

•

The most recent local backup (Snapshot
copy) on the primary node is older than
the threshold setting permits.
The most recent backup (SnapVault or
Qtree SnapMirror) is older than the lag
threshold setting or no backup jobs have
completed since the dataset was created.
The most recent mirror (SnapMirror)
copy is older than the lag threshold
setting or no mirror jobs have completed
since the dataset was created.

No Local
Policy
Attached

No local policy is attached to a dataset of
virtual objects. This status does not apply to
datasets of physical storage objects.

No Protection
Policy

The dataset is managed by NetApp
Management Console, but no protection
policy has been assigned to the dataset.

Protected

The dataset has an assigned policy and it has
conformed to that policy at least once.

Protection
Suspended

An administrator has requested that
scheduled backups be put on hold until the
administrator requests that they be resumed.

Uninitialized

This status might result for any of the
following reasons:
•

•
•
•
•
•

The dataset has a protection policy that
does not have any protection operations
scheduled.
The dataset does not contain any data to
be protected.
The dataset does not contain storage for
one or more destination nodes.
The single node dataset does not have
any backup versions.
At least one backup version must be
associated with the application dataset.
The dataset does not contain any backup
or mirror relationships.
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Conformance

For the NetApp Management Console data protection
capability, indicates whether the dataset is conformant. If a
dataset is nonconformant, you can click
to evaluate errors
and warnings and to run the conformance checker.

Resource

For the NetApp Management Console data protection
capability, represents the most severe of all current events on all
direct and indirect members of the dataset nodes. Values can be
Emergency, Critical, Error, Warning, or Normal. For
Emergency, Critical, Error, or Warning conditions, you can
click
to evaluate the events and sources causing those
conditions.

Space

For the NetApp Management Console provisioning capability,
displays the status of the available space for the selected dataset
node (OK, Warning, Error, or Unknown). If any volume, qtree,
or LUN of a dataset has space allocation error or warning
conditions, the dataset's space status indicates that condition.
You can select the dataset to scan its volumes, LUNs, or qtrees
to determine which member is the cause of the warning or error
condition.

Failover

Uses color, icons, and text to display the state and status of a
dataset that is capable of disaster recovery. The colors and text
vary according to the status of the activity. The state of a
dataset can be Ready, Failing Over, or Failed Over. The status
of an activity can be Normal, Warning, or Error.

Physical
resources

Displays the physical resources assigned to the selected dataset

Resource
pools

node. You can click

to view details.

Displays the name of the resource pool. You can click
view details.

to

Exports

Displays information about the export settings applied to the
selected dataset.

Local backup
schedule

Displays the name of the local backup schedule assigned to the
protection policy of the selected dataset node.

Backup
versions

Lists local backups for a given dataset to help you select the
files or directories to restore, or, if a volume has more backup
versions than specified by its retention settings, which backup
versions to delete.
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Dataset
properties
details

Connection
details

Depending on the properties of the selected dataset, the NetApp
Management Console data protection capability displays some
or all of the following details.
Description

Description of the dataset.

Owner

Owner of the current dataset.

Contact

E-mail contact address for this dataset.

Time zone

Time zone in which the dataset is
located.

Application

(Displayed for application datasets) The
application that generated the dataset.

Application
version

(Displayed for application datasets) The
application version that generated the
dataset.

Application
server

(Displayed for application datasets) The
name of the application server that
generated the dataset.

Custom fields

User-defined custom fields that have
been configured for datasets.

If you select a backup or mirror connection in the Graph area, the details area
displays information about that connection. You can click

to view details.

Relationships Displays the number of existing relationships for the selected
connection.

Backup or
Mirror node
details

Schedule

Displays the name of the schedule that is assigned to the selected
backup connection.

Throttle

Displays the name of the throttle schedule, if any, that is assigned
to the selected connection.

Lag status

Displays the current lag status for the selected connection.

If you select a Backup node or a Mirror node in the Graph area, the details area
displays information about that node. You can click

to view details.

Provisioning policy Lists the provisioning policies, if any, that are assigned to
the selected node.
Physical resources

Lists the physical resources that are assigned to the
selected node.
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Resource pools

Lists the resource pools, if any, that are assigned to the
selected node.

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

You can click the column headings to display the sort arrows (
and
), and then use the
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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Data > Jobs
You can use the Jobs window to view status information for jobs initiated within NetApp
Management Console.
•
•
•
•
•
•

Command button on page 747
View Jobs buttons on page 747
Jobs list on page 748
Completed steps on page 751
Event description on page 752
Window customization on page 752

Command button
Cancel Stops the selected jobs. You can select multiple jobs and cancel them simultaneously. This
button is active only when the selected jobs are in progress.
View Jobs buttons
These buttons specify the range of jobs displayed in the summary list.
1 Day

Displays all jobs that were started between midnight of the previous day and now. (Jobs
that were started before this period are not included, even if they are still running.) This
period can cover up to 47 hours and 59 minutes.
For example, if you click 1 Day at 15:00 on February 14 (on a 24-hour clock), the list
includes all jobs that were started from 00:00 (midnight) on February 13 to the current
time on February 14. This list covers the full day of February 13 plus the partial current
day of February 14.

1 Week

Displays all jobs that were started between midnight of the same day in the previous
week (seven days ago) and now. (Jobs that were started before this period and are still
running are not included.) This period can cover up to seven days, 23 hours, and 59
minutes.
For example, if you click 1 Week at 15:00 on Thursday, February 14 (on a 24-hour
clock), the list includes all jobs that were started from 00:00 (midnight) the previous
Thursday (February 7) to the current time on February 14. This list covers seven full
days plus the partial current day.

1 Month Displays all jobs that were started between midnight of the same day in the previous
month and now. (Jobs that were started before this period and are still running are not
included.) This period can cover from 28 through 32 days, depending on the month.
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For example, if you click 1 Month at 15:00 on Thursday, February 14 (on a 24-hour
clock), the list includes all jobs that were started from 00:00 (midnight) on January 14 to
the current time on February 14.
All

Displays all jobs.

Note: On very large or very busy systems, the Jobs window might be unresponsive for long
periods while loading 1 Month or All data. If the NetApp Management Console appears
unresponsive for these large lists, select a shorter time period (such as 1 Day).

Jobs list
Displays a list of the jobs that occurred. The list of jobs is updated dynamically, as jobs start or
finish. You can customize the display using the filtering and sorting options in the jobs list.
Note: The lists of jobs that can be downloaded is limited to 25,000 records.

Jobs Id

The identification number of the job. The default jobs list includes this column.
The job identification number is unique and is assigned by the server when it starts
the job. You can search for a particular job by entering the job identification
number in the text box provided by the column filter.

Job Type

The type of job, which is determined by the policy assigned to the dataset or by
the direct request initiated by a user. The default jobs list includes this column.
The job types are as follows:
Create relationship

A protection relationship create operation based on
SnapMirror technology.

Dedupe volume

A deduplication space-saving operation initiated on a
selected volume.

Delete backup

A job that deletes backups of volumes of a dataset.

Delete Snapshot
copies

A job that deletes Snapshot copies of volumes of a
dataset.

Delete storage

A job that deletes a volume, qtree, or LUN from the
storage system.
Attention: This operation destroys the data in the

deleted volume, qtree, or LUN and cannot be reversed.
Destroy LUN

A job that deletes a LUN.

Destroy
relationship

A protection relationship delete operation based on
SnapMirror technology.
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Failover

A dataset failover of a primary node to a disaster recovery
node. Applies only if the dataset is enabled for disaster
recovery.

Local backup

A local scheduled backup protection operation based on
Snapshot technology.

Local backup
confirmation

A local scheduled backup protection operation based on
Snapshot technology. Applies if a dataset is an
application-generated dataset and if the application is
responsible for creating local backups.

Local then remote
backup

A local backup protection operation on the primary node
of the dataset followed by a transfer of the backup copies
to remote nodes of the dataset.

Migrate volume

A migration operation of a volume in secondary or
tertiary storage.

Mirror

A scheduled protection mirror operation based on
SnapMirror technology.

On-demand
protection

A backup or mirror operation that is initiated by the
Protect Now button in the Datasets window. The types of
tasks performed are determined by the policy configured
for the dataset.

Provision

A job that provisions containers into a dataset based on
the associated policy and dataset attributes.

Remote backup

A scheduled backup to secondary storage based on
SnapVault technology.

Resize LUN

A job that changes the LUN size.

Resize storage

A job that changes the storage size or quota limit. If the
selected container is a volume, this job type changes the
size, Snapshot reserve, and maximum size of the volume.
If the selected container is a qtree, this job type changes
the quota limit of the qtree.

Restore

A protection data restore job that is initiated by the
Restore button in the Datasets window.

Undedupe volume

A deduplicated volume has been converted to a normal
volume.

Unrecognized

A protection job of indeterminate type has been detected.
Often jobs executed on virtual objects such as VMware
virtual machines or datastores are detected but not
recognized by NetApp Management Console.
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Start migration

An operation that begins migrating a dataset or vFiler unit
to a new storage system.

Canceling

The job stopped because the Cancel button was clicked
to stop the job before it was completed.

Canceled

The Cancel button was clicked and the job is in the
process of stopping.

Cancel migration

An operation that cancels a dataset or vFiler unit
migration.

Cleanup migration

An operation that deletes the old storage after a dataset or
vFiler unit migration cutover.

Cutover

A migration operation that switches the source of a
dataset or vFiler unit from the old storage system to a
new storage system.

Migration rollback

A migration operation that reverses the migration and
restores the original source storage systems as the active
accessible systems.

Migration one step

A migration operation that begins migrating a dataset or
vFiler unit to a new storage system and automatically
performs the cutover operation.

Migration update

A job that updates the SnapMirror relationships that were
created as part of the migration start operation.

Migration fix

A CLI-based migration repair operation that is
nevertheless noted in the UI Jobs list.

Relinquish
migration

A job that relinquishes the migration capability of a
dataset.

Context

The name of the object on which the job was started. The default jobs list includes
this column.

Context Type

The type of object on which the job was started. The default jobs list includes this
column. The context types are Aggregate, Dataset, vFiler unit, and Unrecognized.
"Unrecognized" usually refers to virtual object types observable but not
manageable by NetApp Management Console, such as VMware virtual machines
or datastores.

Start

The date and time the job was started. The default jobs list includes this column.

Job Status

The running status of the job. The default jobs list includes this column. The
progress options are as follows:
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Failed

All tasks in the job failed.

Partially Failed One or more of the tasks in the job failed and one or more of
the tasks completed successfully.
Succeeded

All tasks completed successfully.

Running

The job is currently running.

Queued

The job is not running yet. However, it is scheduled to run
after other provisioning jobs on the same dataset are
completed.

Canceled

The job stopped because the Cancel button was clicked to
stop the job before it was completed.

Canceling

The Cancel button was clicked and the job is in the process of
stopping.

End

The date and time the job ended. The default jobs list includes this column.

Bytes
Transferred

The amount of data (in megabytes or gigabytes) that was transferred during the
job, as reported by the DataFabric Manager server. This column is not displayed
in the jobs list by default.
Note: This number is approximate; it is always less than the actual number of

bytes transferred. For jobs that take a short time to complete, no data transfer
size is reported.
Policy

The name of the policy associated with the job. This column is not displayed in
the jobs list by default.

Source Node

The name of the storage resource that contains the data being protected. This
column is not displayed in the jobs list by default.

Destination
Node

The name of the storage resource to which the data is transferred during the job.
This column is not displayed in the jobs list by default.

Submitted By

The policy that automatically started the job or the name of the user who started
the job. This column is not displayed in the jobs list by default.

Description

A description of the job taken from the policy configuration or the job description
entered when the job was manually started. This column is not displayed in the
jobs list by default.

Completed job steps
Detailed information about each task in the selected job. You can select a step to see its details.
Time stamp The date and time the step was completed.
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Step

A description of the step: for example, Start, In progress, or End.

Result

The result of the step. Result options are as follows:
Error

The step failed.

Warning

The step succeeded but with a possible problem.

Retry

The provisioning engine has performed undo and retry operations.

Normal

The step succeeded.

Event description
Displays detailed information about events and errors that occurred during each step of a job. The
information displayed in this area includes much of the same information that is provided in the
columns of the Details area. However, it also includes the unique items Job Description and Error
Message.
To view the details, select an item from the jobs list, then select an item from the Completed Steps
list. To view more information about the dataset, you can click
directly to the Datasets window.

next to the dataset name to go

Window customization
You can modify the layout of the window by using a variety of customization options.
•
•

•
•
•
•
•

and
), and then use the
You can click the column headings to display the sort arrows (
sort arrows to specify the sort order of the entries.
You can use the filter arrow
to display only the entries containing the information that you
specify. You can select one or more values to use as a filter.
The column heading is highlighted if a filter is applied.
You can click the column display icon , located at the corner of the list, to select or deselect
columns for viewing.
You can drag the bottom of the list area up or down to resize the main areas of the window.
You can drag vertical dividers to resize the width of columns or other areas of the window.
You can reorder columns in the list by dragging the column headings to another location.
You can also filter the list content by using the Group selector on the console tool bar.
When you select a group filter, only relationships originating from or terminating at an object in
the selected group are listed.
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What groups are
A group is a collection of objects with common characteristics, such as location, project, or owning
organization.
Related concepts

Overview of resource pools on page 64
Dataset concepts on page 65
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Effect of time zones on schedules
You determine the time zone to be used for a protection schedule when you set up your resource
pools and your datasets. You have a choice of using the DataFabric Manager server's default time
zone, creating a new default for datasets and resource pools, or selecting a different time zone each
time you create or edit a dataset or resource pool.
Before selecting a schedule for a replication job, you need to know the time zones associated with the
primary data and destination storage for that job. That information helps you determine when you
want your local backups to occur, and when you want the remote replication to take place to achieve
your data protection goals.
When the NetApp Management Console data protection capability interprets a scheduled replication
from primary data in a dataset to secondary destination storage, it uses the time zone of the primary
data. When interpreting a scheduled replication from secondary storage to tertiary storage, the
NetApp Management Console data protection capability uses the time zone of the secondary node.
If you misapply time zones, unexpected and unwanted results could occur. For example, a weekly
mirror copy to tertiary storage might occur before completion of the daily backup that you want to
capture, or replication jobs might occur at a time of day when network bandwidth is already servicing
a heavy load, and so forth.
Note: Some time zones observe daylight saving time (DST) and some do not. The NetApp

Management Console data protection capability automatically observes the local time zone and
adjusts for daylight saving when appropriate. As a result, backups scheduled during the DST
transition, between 1:00 am and 3:00 am local time, might not perform as intended.

Related concepts

Impact of modifying resource pool properties on page 166
Protection schedules, time zones and datasets of physical storage objects on page 199
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Protection policy node prerequisites
Before you attempt to implement a protection policy on your dataset nodes, ensure that the storage
systems in the datasets or physical resource pools that make up that node meet the correct
configuration and licensing requirements.
•

•

•

Storage that is the source of a backup connection (to a NetApp storage system not disaster
recovery capable)
•

Configuration requirements are either of the following:

•

• Volume, qtree, or OSSV directory if it is not an application dataset
• A host, aggregate, or volume containing one of the above
Storage system licensing requirements are either of the following:

• SnapMirror
• SnapVault Data ONTAP Primary (for remote backup protection)
Storage that is the source of a backup connection configured for nondisruptive LUN restore (to a
NetApp storage system not disaster recovery capable)
•

Configuration requirements are either of the following:

•

• Volume or qtree
• A host, aggregate, or volume containing one of the above
Storage system licensing requires both of the following:

• Data ONTAP Primary
• Data ONTAP 7.3 or later
Storage that is the source of a disaster recovery capable backup connection (to a NetApp storage
system)
•

Configuration requirements are all of the following:

•

Qtree, volume (possibly containing qtrees), aggregate (possibly containing volumes) or an
entire storage unit (possibly containing aggregates or volumes)
• Dataset not configured for non-disruptive LUN restore
• Storage system licensing requirements: SnapMirror
Storage that is the source of a backup connection (Open System)

•

• Configuration requirements: Open Systems SnapVault directory
• Storage system licensing requirements: Open Systems SnapVault client
Storage that is the destination of a backup connection (not disaster recovery capable)

•

•

Configuration requirements are either of the following:
•
•

Volume
Qtree
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•

• Storage system or aggregate containing volumes and qtrees
Storage system licensing requirements are either of the following:
•
•

•

SnapMirror
SnapVault Data ONTAP Secondary (for remote backup protection)
If the source is Windows, Linux, or UNIX, then SnapVault Windows, SnapVault Linux, or
SnapVault UNIX is also required.
Storage that is the destination of a backup connection configured for nondisruptive LUN restore
(not disaster recovery capable)
•

Configuration requirements are either of the following:
•
•

•

•

Qtree or volume
Storage system or aggregate containing volumes and qtrees. Provisioning policy type
(SAN or NAS) matches primary provisioning policy type or does not export storage.
Storage system licensing requirements are all of the following:

• SnapVault
• Data ONTAP Secondary
• Data ONTAP 7.3 or later
Storage that is the destination of a disaster recovery capable backup connection (to a disaster
recovery node)
•

•

Configuration requirements:
Volume (possibly containing qtrees), aggregate (possibly containing volumes) or an entire
storage unit (possibly containing aggregates or volumes). No qtree on same storage system as
the primary qtree. Provisioning policy type (SAN or NAS) matches primary provisioning
policy type.
• Storage system licensing requirements: SnapMirror
Storage that is the source of a mirror connection (not disaster recovery capable)
•

•

Configuration requirements are any of the following:

• Volume
• Qtree
• Storage system, or aggregate, containing one of the above
• Storage system licensing requirements: SnapMirror
Storage that is the source of a disaster recovery capable mirror connection
•

Configuration requirements are all of the following:

Volume (possibly containing qtrees), aggregate (possibly containing volumes), or an entire
storage unit (possibly containing aggregates or volumes)
• Nothing that is in another dataset
• Storage system licensing requirements: SnapMirror
Storage that is the destination of a mirror connection (not disaster recovery capable)
•

•

•

Configuration requirements are any of the following:
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•

• Volume
• Qtree
• Storage system, aggregate, or volume containing volumes and qtrees
• Storage system licensing requirements: SnapMirror
Storage that is the destination of a disaster recovery capable mirror connection (to a disaster
recovery node)
•

Configuration requirements are any of the following:
•
•
•

•

Volume
Qtree
Storage system, aggregate, or volume containing volumes and qtrees. No volume on the
same storage system as the primary volume. Provisioning policy type (SAN or NAS)
matches primary provisioning policy type.
• Storage system licensing requirements: SnapMirror
Any node

•

• Configuration requirements: Nothing that is in a resource pool used by this dataset
• Storage system licensing requirements: None
Primary (root) node with local backup schedule
•

•

Configuration requirements: No Open Systems SnapVault directories or Open Systems
SnapVault hosts included
• Storage system licensing requirements: None
Non-root node
•
•

Configuration requirements: No Open Systems SnapVault directories or hosts and nothing
that is in a non-root node of any other dataset and nothing that is in any node of this dataset.
Storage system licensing requirements: None
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Administrator roles and capabilities
The administrator roles determine the tasks you can perform. You must specify one or more
capabilities for every role, and you can assign multiple capabilities if you want the administrator to
have more control than a specific role provides. You can also customize a set of default global roles
and create new roles as necessary.
Default and custom roles
The following table lists the default global roles, descriptions, and capabilities associated with the
role.
Administrator role

Role description

Capabilities

GlobalAlarm

You can manage alarms.

DFMAlarmDelete
DFMAlarmRead
DFMAlarmWrite

GlobalDelete

You can view, modify, or
delete information in the
management server database,
including groups and members
of a group, monitored objects,
custom views, and primary and
secondary storage systems.

DFMAlarmDelete
DFMDatabaseDelete
DFMReportDelete

GlobalEvent

You can view, acknowledge,
and delete events and alerts.

DFMAlarmDelete
DFMAlarmRead
DFMAlarmWrite
DFMEventGenerate
DFMEventRead
DFMEventWrite

GlobalExecute

You can execute commands on
the storage system.

DFMConsoleExecute
DFMDatabaseRead
DFMDatabaseWrite
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Administrator role

Role description

Capabilities

GlobalFullControl

You can view and perform any DFMCoreControl
operation on any object in the
DFMCoreDelegate
management server database
and configure administrator
accounts. You cannot apply this
role to accounts with group
access control.

GlobalRead

You can view the management
server database, backup and
provisioning configurations,
events and alerts, performance
data, and policies.

DFMAlarmRead
DFMCoreAccessCheck
DFMDatabaseRead
DFMEventRead
DFMReportRead

GlobalReport

You can manage custom
reports and report schedules.

DFMReportDelete
DFMReportRead
DFMReportWrite

GlobalQuota

You can view user quota
reports and events.

DFMQuotaFullControl

GlobalWrite

You can view user quota
reports and events.

DFMAlarmWrite
DFMDatabaseWrite
DFMEventGenerate
DFMEventWrite
DFMReportWrite
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A
access protocols
overview of configuring for 112, 519
support for 80, 486
access roles (RBAC)
See RBAC
Add Alarm wizard
decisions to make 47
task 48, 393
Add Dataset wizard
decisions to make for protection 94, 500
decisions to make for provisioning 96, 503
Add Group dialog
decisions to make 181, 591
Add Group wizard
task 182, 592
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Add vFiler Unit wizard
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See also RBAC
aggregates
on Data ONTAP 7.0 or earlier systems 161, 581
properties 712
resource pool guidelines 161, 581
Aggregates button
Unprotected Data window, Resources tab 326
Aggregates window 712
alarms
adding 48, 393
comparison to user alerts 42
configuration guidelines for 43
decisions to make before adding 47
definition of 42
deleting 50
disabling 53
enabling 53
management tasks for, infrequent 52
management tasks for, typical 51
modifying 50
monitoring 53
monitoring and managing tasks for 51
pausing 53
properties 58, 375
properties, described 44
responding to 52
testing 49
triggered by related objects 43
viewing 53
Alarms window 58, 375
alerts, comparison to alarms 42
application datasets, definition of 65, 76, 482
applications in NetApp Management Console 9
attachment, storage services 215, 638
AutoSupport 56

B
backup
of data 386
backup connections
description 192
editing in a protection policy 206
lag times 199
planning a schedule assignment 232
backup nodes
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changing resources for 110, 516
decisions to make before changing resource
assignments 108, 477, 515
description 192
editing in a protection policy 206
selecting volumes for 158, 578
backup relationships
decisions to make before importing 170
enabling multiple 126, 533
implications of existing 170
importing 172
when to import 170
backups
of datasets on-demand 141
resource pool guidelines 161, 581

C
CIFS data access protocol
configuring 113, 520
overview of configuring for 112, 519
support for 80, 486
client platforms 9
conformance
conditions for datasets 137
dataset status 134
datasets, failure to conform 135
evaluating for datasets 135
how dataset conformance is monitored 136
monitor intervals 136
conformance checking
suspending for the primary dataset node 142
console
adjusting column widths 11
applications and capabilities supported 9
applications, toggling 10
filtering data display 12
Get Started feature 10
Help, accessing 10
logging out 10
moving backward and forward 10
rearranging column order 11
selecting columns to display 11
Tasks bar, hiding and redisplaying 11
credentials
editing for Open Systems SnapVault properties 267,
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editing for storage systems 266, 662
custom fields
about 185, 595

adding 185, 595
adding a value to datasets 188, 598
adding a value to protection policies 188, 599
adding a value to provisioning policies 189, 599
configuring and managing 185, 595
definition of 185, 595
deleting 187, 597
editing 186, 596
Custom Fields window 341, 694
custom label 94, 500

D
daily backups
description of 194
scheduling 240
strategies for use 195
daily schedules
adding 237
editing 240
dashboard panels
described 72, 478
dashboards
definition of 71, 478
panels, descriptions of 72, 479
dashboards, performance
descriptions of panels 72, 479
dashboards, protection
Dataset Lags panel 282
Dataset Protection Status panel 280
descriptions of 72, 274, 479
External Relationship Lags panel 285
Failover Readiness panel 276, 463
Failover Status panel 278, 465
Protected Data panel 283
Resource Pools panel 287, 688
Top Five Events panel 286, 687
Unprotected Data panel 284
dashboards, provisioning
Dataset Conformance Status panel 684
Dataset Resource Status panel 685
Dataset Space Status panel 689
described 683
descriptions of 72, 479
Resource Pool Space Status panel 686
Resource Pools panel 287, 688
Top Five Events panel 286, 687
data
adding unprotected data to a new dataset 176
adding unprotected data to an existing dataset 175

Index | 765
external relationships, definition of 169
how to back up 386
monitoring external relationship lags 285
protected versus unprotected 173
protecting unprotected datasets 177
restore overview 145
restoring a backed-up virtual machine 153
restoring a virtual machine to its original location
through another ESX server 154
restoring backup to a new location 147
restoring backup to current location 149
restoring guidelines 147
unprotected 173
data access protocols
overview of configuring for 112, 519
support for 80, 486
Data Groups window 314
Data Jobs window 335, 747
Data ONTAP
Data ONTAP 7.0, impact of on resource pools 161,

581
licenses, described 68, 250, 646
data protection
backup compared to disaster recovery 381
resuming for datasets 143
suspending for datasets 142
data protection capability
definition of 71
DataFabric Manager
client platform for 9
DataFabric Manager database
Global group 180, 591
DataMotion for vFiler
online migration component 545
Dataset Conformance Status dashboard panel 684
Dataset Lags dashboard panel 282
dataset migration
cleanup task 562
cleanup, description of 554
cleanup, manual after migration 555
configuring strategies 547
cutover operation 561
cutover, description of 552
deleting old storage 562
description of operations for 551
enabling by attaching a new vFiler unit 117, 524
enabling by attaching an existing vFiler unit 118,
525
environment variables for scripts 563
errors 551

failover interactions 549
failures 551
how to view space utilization 82, 488
limitations 549
managing 555
Migration tab, Datasets window 306
online and offline differences 545
overview for datasets 544
relinquishing migration capability 564
requirements for online and offline migration 547
rollback task 563
rollback, description of 554
start operation, description of 552
start task 558
start task, decisions to make 555
update task 559
update, description of 552
viewing status 563
what gets migrated with a dataset 548
when to relinquish migration capability 551
See also vFiler unit migration
Dataset Migration wizard
decisions to make 555
task 558
Dataset Policy Change wizard
decisions to make 100, 507
task 102, 473, 509
Dataset Protection Status dashboard panel 280
Dataset Resource Status dashboard panel 685
Dataset Space Status dashboard panel 689
datasets
adding a value in custom fields 188, 598
adding by using a storage service 128, 535
adding resource assignments, decisions to make 108,
477, 515
adding storage resources to 109, 515
adding to manage physical storage objects 99, 471,

506
adding unprotected data to a new 176
adding unprotected data to an existing 175
adding, decisions to make for protection 94, 500
adding, decisions to make for provisioning 96, 503
assigning a protection policy 102, 473, 509
assigning a provisioning policy 103, 510
attaching storage services to 129, 536
backing up on-demand 141
changing resource assignments, decisions to make
108, 477, 515
changing resources 110, 516
changing storage services 131, 538
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configuring for migration 547
conformance conditions 137
conformance status values 134
conformance to policy, evaluating 135
conformance to protection policies 78, 485
conformance to provisioning policies 79, 485
Custom Fields window 341, 694
decisions to make before adding 94, 500
decisions to make before adding by using a storage
service 126, 533
decisions to make before importing discovered
relationships 170
decisions to make before provisioning 104, 511
defined 75, 482
deleting 125, 532
detaching from a storage service 130, 537
editing general properties 124, 531
editing naming properties 124, 531
editing to specify naming settings 122, 529
functionality 78, 485
general concepts 65, 76, 482
grouping 180, 591
how conformance is monitored 136
how they are used 76, 482
importing external relationships into 172
managing storage space, overview 81, 488
managing storage space, tasks for 82, 489
monitoring backup and mirror relationships 140
monitoring conformance 684
monitoring conformance to policy 135
monitoring number of protected 283
monitoring number of unprotected 284
monitoring protection status 280
monitoring resource status 685
monitoring space status 689
monitoring status 139
names, acceptable characters 94, 500
policies, decisions to make before changing 100, 507
properties of, for protection 94, 500
properties of, for provisioning 96, 503
protecting unprotected 177
protection status values 132
provisioning 79, 485
provisioning resources for primary node 106, 513
reasons for failure to conform to policy 135
removing resources from 111, 518
resource status values 134
restoring portions of 151
resuming protection of 143

status types 132
suspending protection of 142
time zone guidelines 223
time zones, effect on schedules 220, 754
types of conformance status, defined 134
types of protection status, defined 132
types of resource status, defined 134
Unprotected Data window, Aggregates button 326
Unprotected Data window, Hosts button 323
Unprotected Data window, Qtrees button 330
Unprotected Data window, Volumes button 328
when to configure 80, 487
when to manage storage space for 81, 488
Datasets tab
Aggregates window 712
Unprotected Data window 320
Datasets window
Current Space Breakout tab 715
Disaster Recovery tab, Datasets window 300, 457
Migration tab 306
Overview tab 288, 735
Provisioning tab 715
Space Usage History tab 715
deduplication
about 566
definition of 405, 566
disabling 573
enabling 572
license, described 68, 250, 646
modes of 405, 566
over deduplication 569
process overview 568
space savings percentage 571
starting an on-demand job 574
stopping a job in progress 575
storage system configuration requirements 567
support by protection and provisioning capabilities

389
Dependencies tab
Protection Policies window, Overview tab 342
Provisioning Policies window 695
Details tab
OSSV (Open Systems SnapVault) window 358
Provisioning Policies window 695
Resource Pools window 316, 690
Storage Systems Hosts window 350, 704
vFiler Units window 362, 725
dfm option set timezone command 221
dfpm commands, inclusion in backup scripts 205
Diagnose OSSV Host wizard 273, 667
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Diagnose Storage Systems wizard 272, 666
disaster recovery
about 431
applying in a disaster situation 445
assessing options 383, 445
backups, comparison to 381
by failback to replaced containers 401, 453
by failback to undestroyed containers 398, 450
configuration, dataset decisions to make 440
configuration, policy decisions to make 441
configuring datasets for 379
definition of 431
enabling protection 442
failover scripts, about 438
failover scripts, example 439
failover scripts, variables 439
making the disaster recovery node the permanent
primary data node 448
nonsupport of Data ONTAP vFiler units 431
overview of tasks 432
recovering after failover 384, 448
relationship, definition of 432
resuming forward mirroring 449
starting failover 446
stopping disaster recovery protection 125, 532
strategies after failover 432
updating before failover 446
volumes unsuitable as mirror destinations 437
when to use 431
disaster recovery capable
definition of 432
ensuring readiness 443
protection policy node requirements 195, 435, 755
protection policy types 396, 434
disaster recovery node
converting to permanent primary node 448
definition of 432
disaster recovery node storage
updating before failover 446
disaster recovery policies
decisions to make before applying to datasets 100,

507
discovered relationships
decisions to make before importing 170
importing 172
dpMaxFanInRatio option 126, 533

E
environment variables for data migration scripts 563

ESX server guidelines
for adding or editing an Open Systems SnapVault
host 257, 653
events
definition of 15
deleting from event log 41
how to know when events occur 16
list of, and severity types 16, 406
list of, complete 16, 406
responding when an event occurs 41
severity type descriptions 15
top five events in dashboard 286, 687
viewing the list of 40
where to find logs for 179, 590
Events window
properties 61, 372
export protocols
displaying dataset member properties 144
displaying for a dataset node 143
specifying for individual dataset members 104, 511
External Relationship Lags dashboard panel 285
external relationships
about 169
decisions to make before importing 170
definition of 169
importing 172
when to import 170
where to view details about 170
External relationships window 332

F
failback
to replaced containers 401, 453
to undestroyed containers 398, 450
failover
assessing the need for 383, 445
dashboard for monitoring readiness 276, 463
failover readiness, definition of 432
failover state, definition of 432
failover, definition of 432
monitoring readiness 443
monitoring status 447
process description 382, 438
scripts, testing 444
starting 446
updating disaster recovery node storage before 446
Failover Readiness dashboard panel 276, 463
failover scripts
definition of 432
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description of 438
example of 439
invoked during the failover process 382, 438
variables in 439
failover status
dashboards for monitoring 278, 465
monitoring 447
Failover Status dashboard panel 278, 465
fault tolerance 614
FC (Fibre Channel) data access protocol
configuring 115, 522
overview of configuring for 112, 519
support for 80, 486
file reservations
how they work 618
filtering data display 12
FlexClone
license, described 68, 250, 646
FlexClone split operation
during migration cutover 566
during migration start 566
FlexClone volume migration
support for 565
FlexVol volumes
fractional reserve
considerations for setting 619
how volume guarantees work with 617
thick provisioning for 617
thin provisioning for 617
fractional reserve
considerations for setting 619
FTP data access protocol, support for 80, 486
Full threshold 620

G
Get Started feature 10
Global group 180, 591
Graph tab
Datasets window, Disaster Recovery tab 300, 457
Protection Policies window, Overview tab 342
groups
adding 182, 592
decisions to make before creating 181, 591
definition of 67, 180, 590, 753
deleting 184, 594
editing 183, 593
Global group 180, 591
impact of RBAC settings 182, 592
renaming 183, 593

Groups window 314

H
HA configurations
benefits of 614
definition of 613
provisioning policy option 611
HA interconnect 614
Help
accessing 10
printing topics 14
high-availability hosts 265, 661
hosts
aggregate properties 712
Data ONTAP licenses, described 68, 250, 646
discovery by Operations Manager 247, 643
investigating problems 248, 644
monitoring 247, 643
Open Systems SnapVault properties 358
storage system properties 350, 704
vFiler unit properties 362, 725
visibility in protection application 248, 644
visibility in protection console 247, 643
visibility in provisioning application 248, 644
visibility in provisioning console 247, 643
Hosts button
Unprotected Data window, Resources tab 323
hourly backups
description of 194
scheduling 240
strategies for use 195

I
Import Relationships wizard
decisions to make 170
task 172
Input Relationships tab
Storage Systems Hosts window 350, 704
vFiler Units window 362, 725
iSCSI data access protocol
configuring 116, 523
overview of configuring for 112, 519
support for 80, 486

J
jobs
canceling 179, 589
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definition of 178, 589
managing 178, 589
monitoring 178, 589
properties 335, 747
where to find logs for 179, 590
Jobs tab
Aggregates window 712
Datasets window, Disaster Recovery tab 300, 457
Jobs window 335, 747

L
label
resource pool, for filtering 162, 582
lag times
about 199
assigning limits on backup connections 206
assigning limits on mirror connections 207
changing in a protection policy 210
monitoring 282
licenses
Data ONTAP 68, 250, 646
deduplication 68, 250, 646
FlexClone 68, 250, 646
MultiStore Option 68, 250, 646
NearStore Option 68, 250, 646
SnapMirror 68, 250, 646
SnapMirror Sync 68, 250, 646
SnapVault 68, 250, 646
local time zone, example 224
logging out 10
login credentials
editing Open Systems SnapVault 267, 663
storage system, editing 266, 662
logs
for viewing the events list 40
where to find for jobs 179, 590
LUN reservations
how they work 618
LUNs
destroying 543
provisioning 79, 485
viewing space allocation for 539

M
mailbox disks in the HA pair 614
Management console provisioning capability
definition of 478
managing

alarms 51
manual cleanup after migration 555
migration
offline 545
online 545
secondary volume 671
starting secondary volume migration 673
migration cleanup operation
dataset task 562
description of 554
vFiler units task 681
migration cutover operation
data availability while performing 545
dataset 561
description of 552
online migration and the automatic option 552
vFiler units task 680
migration rollback operation
datasets task 563
description of 554
vFiler units task 682
migration start operation
dataset task 558
description of 552
of secondary volumes, task 673
vFiler units task 677
Migration tab
Datasets window 306
vFiler Units window 362, 725
migration update operation
dataset task 559
description of 552
vFiler units task 679
mirror connections
description 192
editing in a protection policy 207
lag times 199
planning a schedule assignment 232
mirror nodes
changing resources for 110, 516
decisionsto make before changing resource
assignments 108, 477, 515
description 192
selecting volumes for 159, 579
mirror protection
definition of 191
description 192
mirror relationships
decisions to make before importing 170
importing 172
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resource pool guidelines 161, 581
mirroring, NVMEM or NVRAM log 614
monitoring
alarms 51
dashboard panel, 72, 478
dashboard panels, overview of 72, 479
dataset conformance to policy 135
events 40
protection dashboards 274
provisioning dashboards 683
monthly backups
desription of 194
scheduling 243
strategies for use 195
monthly schedules
adding 238
editing 243
MultiStore Option
license, described 68, 250, 646

N
naming properties
custom label 94, 500
naming settings
configuring naming settings using the Add Dataset
wizard 120, 527
decisions to make before configuring for datasets of
physical storage objects 119, 526
definition of 65, 76, 482
descriptions for primary volumes 88, 494
descriptions for secondary qtrees 92, 498
descriptions for secondary volumes 90, 496
descriptions for Snapshot copies 85, 492
editing a dataset to specify dataset level custom
naming 122, 529
global and dataset-level differences 83, 490
reasons for 83, 490
specifying using the Add Dataset Using Storage
Service wizard 123, 530
use of format strings 85, 492
when to customize for related objects 84, 491
NAS
storage system deduplication requirements 567
NAS provisioning policies 610
NDMP credentials
diagnosing for Open Systems SnapVault host 273,

667
diagnosing for storage systems 272, 666
editing Open Systems SnapVault 267, 663

storage systems, editing 266, 662
NDMP status
diagnosing for Open Systems SnapVault host 273,

667
diagnosing for storage systems 272, 666
Nearly Full threshold 620
NearStore Option
license, described 68, 250, 646
NetApp Host Agent
diagnosing 273, 667
editing credentials 267, 663
verifying presence in database 247, 248, 643, 644
NetApp Management Console
about 9
applications supported 9
defined 9
See also console
Network Settings tab
vFiler Units window 362, 725
NFS data access protocol
configuring 114, 521
overview of configuring for 112, 519
support for 80, 486
nondisruptive operations 614
NVMEM log mirroring 614
NVRAM log mirroring 614

O
offline migration
definition of 545
storage services feature support 214, 637
on-demand backup, datasets 141
online migration
definition of 545
license requirements 545
limitations 546
storage services feature support 214, 637
supporting DataMotion for vFiler 545
Open Systems SnapVault
adding a host 258, 654
credentials, diagnosing 273, 667
decisions to make before adding a host 256, 652
diagnosing problems 273, 667
editing properties 267, 663
guidelines for ESX servers 257, 653
investigating problems 248, 644
NDMP status, diagnosing 273, 667
properties 358
refreshing status data 271, 665
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starting the agent 270, 664
stopping the agent 270, 664
updating client data 271, 665
verifying client presence in database 247, 248, 643,

644
Operations Manager
consolidated reports for 180, 591
logs, where to find 179, 590
OSSV (Open Systems SnapVault) Hosts window 358
OSSV, see Open Systems SnapVault 258, 654
Output Relationships tab
Storage Systems Hosts window 350, 704
vFiler Units window 362, 725
over deduplication 569
Overview tab
Datasets window 288, 735
Protection Policies window 342

P
Paths tab
OSSV (Open Systems SnapVault) window 358
Storage Systems Hosts window 350, 704
vFiler Units window 362, 725
Performance Advisor
application described 9
Performance dashboard 72, 478
physical storage objects
adding datasets for 99, 471, 506
policies
adding protection 203, 469
adding provisioning 621
definition of 392, 600
evaluating dataset conformance to 135
monitoring dataset conformance to 135
protection, description of 190, 602
provisioning, about 600
provisioning, definition of 600
vFiler templates, about 626
vFiler templates, definition of 391, 626
Policies Provisioning window 695
primary data components
description 192
primary data nodes
about 192
editing in a protection policy 205
lag times 199
planning a schedule assignment 231
primary volumes
dataset-level custom naming 120, 527

naming settings descriptions 88, 494
printing Help topics 14
properties
editing for datasets 124, 531
impact of modifying resource pools 166, 586
of alarms 58, 375
of datasets 94, 96, 500, 503
of datasets for protection 288, 735
of datasets with disaster recovery 300, 457
of groups 314
of jobs 335, 747
of protection policies 342
of protection policy schedules 346
of provisioning policies 603
of resource pools 316, 690
of unprotected data, aggregates 326
of unprotected data, hosts 323
of unprotected data, qtrees 330
of unprotected data, volumes 328
of vFiler templates 626
Open Systems SnapVault, editing 267, 663
storage system, editing 266, 662
protected data
comparison with unprotected data 173
dataset conformance conditions 137
dataset conformance status, described 134
dataset protection status, described 132
dataset resource status, described 134
evaluating conformance to policy 135
how dataset conformance is monitored 136
reasons for failure to conform to policy 135
Protected Data dashboard panel 283
protection
adding unprotected data to a dataset 175, 176
dashboards, overview of 274
decisions before adding a dataset of physical storage
objects 94, 500
monitoring jobs for 178, 589
of external relationships 172
provisioning sequences 78, 485
resuming dataset 143
stopping protection for a dataset 125, 532
suspending for a dataset 142
volumes unsuitable as mirror destinations 437
Protection capability
information for AutoSupport 56
Protection dashboard 72, 478
Protection Dashboards window 274
protection or provisioning related objects
definition of 65, 76, 482
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protection policies
adding 203, 469
adding a value in custom fields 188, 599
assigning to datasets 102, 473, 509
backup schedule classes 194
changing a node name 211
changing lag time settings 210
changing retention duration 209
dataset dependencies on 342
decisions to make before adding 200
decisions to make before applying to datasets 100,

507
definition of 190
deleting 212
description of 190, 602
editing 204
editing a backup connection 206
editing a backup node 206
editing a mirror connection 207
editing a primary data node 205
effects of time zones on schedules 199, 234
guidelines 198
mirror protection 191
node prerequisites 195, 435, 755
nodes and connections 192
overview 65, 76, 482
Protection Policies window Overview tab 342
remote backup protection 191
retention strategies 195
schedules 346
types of data protection 191
types of disaster recovery capable 396, 434
types of, not disaster recovery capable 193, 467
Protection Policies window Overview tab 342
Protection Policies window Schedules tab 346
provisioning
a specific aggregate or storage system 108, 514
adding a volume to a primary node 106, 513
comparision of policy and wizard 602
dashboards, overview of 683
decisions to make before adding a dataset 96, 503
decisions to make before provisioning 104, 511
monitoring jobs for 178, 589
provisioning scripts for 621
working with datasets 79, 485
Provisioning capability
information for AutoSupport 56
Provisioning dashboard 72, 478
Provisioning Dashboards window 683
provisioning policies

about 600
adding 621
adding a value in custom fields 189, 599
assigning to datasets 103, 510
changing for a dataset 103, 510
comparision to provisioning wizard 602
copying 625
datasets rebaselining after changing policies 100,

507
decisions to make before adding 608
decisions to make before applying to datasets 100,
507
definition of 600
deleting 625
editing 624
editing, decisions to make before 622
overview 65, 76, 482
properties of 603
Provisioning Policies window 695
provisioning scripts 621
resource label, definition of 615
storage availability levels 611
types of 610
vFiler Templates window 700
viewing 607
provisioning sequences
for backup destination volumes 158, 578
for mirror destination volumes 159, 579
Provisioning tab 715
Provisioning wizard
decisions to make 104, 511
selecting a specific aggregate or storage system 108,
514
task 106, 513

Q
Qtree SnapMirror, definition of 432
qtrees
destroying 543
provisioning 79, 485
provisioning by the protection capability 78, 485
resizing 541
viewing space allocation for 539
Qtrees button
Unprotected Data window, Resources tab 330
quotas
how they work 615
targets 616
types 616
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why you use 615

R
RAID-DP
described 612
RAID4
described 612
RBAC
definition 54
how RBAC is used 54
RBAC (role-based access control)
table of roles 54, 394, 475, 758
rebaselining
about 100, 507
definition of 432
regular expressions, filtering examples 12
related objects
configuring naming settings by using the Add
Dataset Using Storage Service wizard 123, 530
configuring naming settings using the Add Dataset
wizard 120, 527
datasets
configuring naming settings using the Add
Dataset wizard 120, 527
global and dataset-level naming settings 83, 490
primary volume naming settings 88, 494
secondary qtrees naming settings 92, 498
secondary volume naming settings 90, 496
Snapshot copy naming settings 85, 492
specifying naming by editing a dataset 122, 529
when to customize naming for 84, 491
remote backups, defininition of 191
reports
in Operations Manager using groups 180, 591
reservations
how they work 618
reserves
considerations for setting fractional 619
resource labels
description of 615
how they work 162, 582
Resource Pool Space Status dashboard panel 686
resource pools
adding 165, 585
advantages of using 157, 577
changing dataset assignment 110, 516
configuring 165, 585
decisions to make before adding 163, 583

decisions to make before changing assignments 108,
477, 515
editing properties 168, 588
editing, impact of 166, 586
examples of 157, 577
filtering 162, 582
grouping 180, 591
guidelines 160, 580
guidelines for content and structure 160, 580
guidelines for selecting storage 161, 581
how they are used 76, 482
labels for filtering 162, 582
modifying properties 168, 588
modifying, impact of 166, 586
monitoring 287, 688
monitoring space status 686
on Data ONTAP 7.0 or earlier systems 161, 581
overview of 64, 156, 576
provisioning sequence for backups 158, 578
provisioning sequence for mirrored copies 159, 579
time zone guidelines 222
time zone, effect on schedules 220, 754
Resource Pools dashboard panel 287, 688
Resource Pools window 316, 690
resource status
dataset 134
resources
adding to datasets 109, 515
removing from datasets 111, 518
Resources tab
Unprotected Data window, Aggregates button 326
Unprotected Data window, Hosts button 323
Unprotected Data window, Qtrees button 330
Unprotected Data window, Volumes button 328
restore
enabling file overwrite and out-of-space warnings
145, 146, 390
guidelines for 147
locations for virtual machines 146
of a backed-up a virtual machine as files to any
location 153
of a virtual machine to original location 152
of backed-up data over current data 149
of backed-up data to new location 147
portions of a dataset 151
restore_symboltable file 147
restoring a virtual machine to its original location
through another ESX server 154
supported data operations, list of 145
Restore wizard
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enabling file overwrite and out-of-space warnings

390
guidelines 147
restoring a virtual machine to its original location
through another ESX server 154
restoring backed-up data over current data 149
restoring backed-up data to a new location 147
restoring portions of a dataset 151
restoring virtual machine to current location 152
retention
assigning duration on a backup node 206
assigning duration on a primary data node 205
changing duration in a protection policy 209
duration 194
of backups 194
strategies 195
role-based access control
See RBAC
roles, administrator (RBAC)
table of 54, 394, 475, 758

S
SAN
storage system deduplication requiremens 567
SAN host
provisioning for 108, 514
SAN provisioning policies 610
schedules
adding daily 237
adding monthly 238
adding throttle 239
adding weekly 237
applying to a backup connection 232
applying to policy nodes and connections 231
assigning or switching in a protection policy 209,

246
assigning to a backup connection 206
assigning to a backup node 206
assigning to a primary data node 205
backup retention classes 195
backup schedule classes 194
baseline transfers in 78, 485
copying 246
decisions to make before creating 235
definition of 220
deleting 245
editing a throttle schedule 244
editing daily 240
editing monthly 243

editing weekly 241
features 230
for throttling bandwidth 233
overview 230
planning for a mirror connection 232
planning on a primary data node 231
time zones, effect on schedules 220, 754
Schedules tab, Protection Policies window 346
scripts
failover, testing 444
secondary provisioning policies 610
secondary qtrees
dataset-level custom naming 120, 527
naming settings descriptions 92, 498
secondary space management
about 667
dataset migration compared to volume migration 671
how the wizard works 668
managing 672
overview of solutions 669
starting the wizard 672
strategies for volumes versus aggregates 670
volume migration requirements 671
when to use this feature 667
Secondary Space Management wizard
how it works 668
secondary volume migration 671
secondary volumes
dataset-level custom naming 120, 527
naming settings descriptions 90, 496
Set Up Alarms window 58, 375
Setup vFiler Unit wizard
decisions to make 263, 659
task 265, 661
severity types
list of events and 16, 406
severity types for events 15
SnapMirror
determining when to use for backups 252, 648
license, described 68, 250, 646
SnapMirror relationship break
definition of 432
invoked during the failover process 382, 438
SnapMirror relationships
updating during dataset migration 559
updating during vFiler unit migration 679
SnapMirror Sync
license, described 68, 250, 646
Snapshot copies
dataset-level custom naming 120, 527
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deleting 542
naming settings descriptions 85, 492
overview of storage space management 81, 488
reallocating space for in a volume 541
SnapVault
determining when to use for backups 252, 648
provisioning sequence for backups 158, 578
provisioning sequence for mirrored copies 159, 579
SnapVault Data
primary license, described 68, 250, 646
secondary license, described 68, 250, 646
SnapVault Linux
license, described 68, 250, 646
SnapVault UNIX
license, described 68, 250, 646
SnapVault Windows Open File Manager
license, described 68, 250, 646
Space Breakout tab, Resource Pools window 316, 690
space guarantees
See volume guarantees
space management
deleting Snapshot copies 542
description of 81, 488
destroying volumes, LUNs, and qtrees 543
diagnosing space status 540
how to view space utilization 82, 488
how you use 617
overview of resize options 83, 489
reallocating volume space 541
resizing qtree space 541
Resource Pool Space Status panel 686
space utilization thresholds 620
task overview 82, 489
viewing space allocations 539
when to use 81, 488
space reservations
See reservations
Space Usage tab
Aggregates window 712
spare disks in the HA pair 614
status definitions
dataset conformance 134
dataset protection 132
dataset resource 134
storage availability levels 611
storage objects
adding datasets for 99, 471, 506
storage services
about 212, 632
adding 217, 640

attaching to existing datasets 129, 536
attachment of existing vFiler units 215, 638
changing for datasets 131, 538
decisions to make before adding 216, 639
decisions to make before editing 218, 641
decisions to make before using to add a dataset 126,

533
detaching a dataset from 130, 537
editing 219, 642
multi-tenancy support 214, 637
online or offline migration support 214, 637
overview 65, 76, 482
supplied with the product 633
uses of vFiler unit creation and attachment 214, 637
using to add a dataset 128, 535
vFiler unit creation 215, 638
storage systems
adding 255, 651
Data ONTAP licenses, described 68, 250, 646
decisions to make before adding 253, 649
deduplication configuration requirements 567
diagnosing credentials 272, 666
diagnosing licenses 272, 666
diagnosing NDMP status 272, 666
investigating problems 248, 644
properties 350, 704
properties, editing 266, 662
verifying presence in database 247, 248, 643, 644
viewing interdependencies 248, 644
Storage Systems Hosts window 350, 704
SyncMirror
advantages 613
description 612
provisioning policy option 611
syslog HA pair messages, where to find 179, 590

T
tasks bar, hiding and redisplaying 11
thick provisioning
for FlexVol volumes 617
thin provisioning
for FlexVol volumes 617
thresholds
for space utilization 620
throttle schedules
adding 239
definition 233
editing 244
time zones
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effect on schedules 220, 754
effects on schedule execution 199, 234
example using default value 227
example using local time 224
guidelines with datasets 223
guidelines with resource pools 222
setting in DataFabric Manager 221
setting in the NetApp Management Console 221
setting the default 221
understanding 220, 754
Top Five Events dashboard panel 286, 687
troubleshooting
dataset conformance conditions 137
dataset failure to conform 135
evaluating dataset conformance 135
restore_symboltable file 147

U
unprotected data
assigning a protection policy 102, 473, 509
comparison with protected data 173
decisions to make before importing 170
definition of 173
where to view details about 174
Unprotected Data dashboard panel 284
Unprotected Data window
Datasets tab 320
Resources tab, Aggregates button 326
Resources tab, Hosts button 323
Resources tab, Qtrees button 330
Resources tab, Volumes button 328
update operation
assessing the need before failover 383, 445
Usage tab
Storage Systems Hosts window 350, 704
user alerts, comparison to alarms 42
Users and Roles capability
See RBAC

V
vFiler templates
about 626
adding 629
copying 630
decisions to make before adding 628
definition of 391, 626
deleting 631
editing 630

inclusion and use in storage services 215, 638
properties of 626
viewing 628
vFiler Templates window 700
vFiler unit migration
cleanup task 681
cleanup, description of 554
cleanup, manual after migration 555
cutover task 680
cutover, description of 552
decisions to make before starting 675
deleting old storage 681
description of operations for 551
environment variables for scripts 563
failures 551
overview 673
requirements 674
rollback task 682
rollback, description of 554
start operation, description of 552
start task 677
update task 679
update, description of 552
viewing status 682
See also dataset migration
vFiler unit Migration wizard
decisions to make before starting 675
task 677
vFiler units
adding 261, 657
creation for storage services 215, 638
Data ONTAP-managed disaster recovery 431
decisions before setting up properties 263, 659
decisions to make before adding unit 259, 655
existing, storage services attachment 215, 638
high-availability hosts 265, 661
investigating problems 248, 644
properties 362, 725
setting up properties for 265, 661
template window for 700
using a script to customize 253, 649
verifying presence in database 247, 248, 643, 644
vFiler Units Hosts window 362, 725
vFiler units, and data management 261, 657
virtual machine
restoring file system to any location 153
restoring to original location 152
restoring to original location thru ESX server 154
VMware ESX server
guidelines 257, 653
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volume guarantees
effect on maximum FlexVol volume size 617
how they work with FlexVol volumes 617
volume migration
comparison to dataset migration 671
starting the wizard 673
Volume SnapMirror
definition of 432
volumes
adding to primary node 106, 513
deleting Snapshot copies 542
destroying 543
fractional reserve
considerations for setting 619
maximum number supported 608
provisioning 79, 485
provisioning by the protection capability 78, 485
resizing 81, 488, 541

viewing space allocation for 81, 488, 539
Volumes button
Unprotected Data window, Resources tab 328
Volumes tab
Aggregates window 712

W
WebDev data access protocol, support for 80, 486
weekly backups
description of 194
scheduling 241
strategies for use 195
weekly schedules
adding 237
editing 241

